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About this Manual 

This User's Guide provides developers and system integrators with the necessary 
information for building process and control applications with this software product. 
If you are using this application for the first time, you may proceed in one of the following 
ways: 

o     Read this guide from cover to cover, exactly as it is presented. 
o     Read Chapters 1 through 6. These chapters provide you with basic information 

on the installation procedure, guidelines for designing an application, and a 
description of the Application Studio. Then, read the chapters you need, depending 
on the tasks you want to perform. 

o     If you are an experienced user, read Chapter 2 to learn about the available 
features, and then use the Table of Contents to find the information you need. 

Note:     In this manual the names WizSQL, WizLanguage, WizDDE and WizDDES have 
been named: Application SQL, Application Language, Application DDE and Application 
DDES. When writing code substitute the word application for Wiz. 

What You Should Know 

Before you start using the application and working through this guide, you should be 
familiar with the Windows operating systems. You should also know how to operate an 
IBM-PC or compatible. 

Registering Your Product 

You are important to us, and it's important for us to know who our customers are. 
Registering your product enables us to provide you with better services and important 
notifications about the product. Please take a minute to complete the Licensing Agreement 
included with your product and send it to Wizcon Systems.  

Customer Support 

You can receive technical support by contacting your Sauter agency. 
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About this chapter 

This chapter describes the application and its features. 
Introduction to the Application discusses this software program and the SCADA 
concept. 
Main Features discusses the main features of this application. 

 

 

 
 

 

  

Introduction to the Application 

 
 
 
 
 

Introduction to the Application 
This software program is an advanced Supervisory Control and Data Acquisition (SCADA) 
system used as an applications development tool that enables system integrators to create 
sophisticated supervisory and control applications for a variety of industries. 
This system is an application generator. This means that all the control and monitoring 
facilities are already built into the system, and only project definitions need to be provided 
by the system integrator. Minimal computer or programming skills are required. 
The application takes advantage of the powerful, preemptive, multi-tasking capabilities of 
the latest Windows operating systems and a built-in event-driven mechanism to achieve 
utmost performance and data integrity. It also uses its interface mechanisms to implement 
clear and efficient visualization of its components. 
The software enables you to integrate your application with your Internet/Intranet network, 
promoting real-time supervisory and control using real-time graphics and event-driven 
information updates from any computing platform. It combines the benefits of SCADA, 
Java, HTML and Internet. 
The production floor can be safely monitored and controlled through a standard web 
browser. Both factory data and corporate information can be viewed through a common 
interface, from any desktop or laptop.  

8 
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An application communicates with control equipment in the field such as Programmable 
Logic Controllers (PLCs), measuring instruments, and other devices. As the equipment is 
monitored and data is recorded, the application responds according to system logic 
requirements or operator requests. 

 
 

 
 

  
 
 
 
 

Typical Application SCADA Configuration 
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Main Features 

 
 
 
 
 

Main Features 
This section describes the application's main features and concepts. A Glossary appears 
at the back of this book in which you can find descriptions of additional terms and 
concepts. 

 
 

 

 
  
 
 
 
 

Advanced Alarm Management  
Advanced Alarm Management (AAM) uses a multi-service communications platform 
providing alarm transmission over various communication channels including Internet, 
SMS, email, fax and voice.  
Alarms can be defined according to hierarchy, be filtered, appear on the user's screen as a 
pop-up message with/without voice, sent to a single user or when defined sent to groups 
and teams or to a backup user. Additionally, alarms can be defined as system alarms, be 
delayed, inhibited, locked or defined according to zones.  
Authorized users can add comments or instructions to an alarm for future reference. 
Alarms can be imported/exported to/from previous versions or other files.  
Operators can acknowledge the reception of alarms and automatically receive instructions 
for handling them. Alarms can also be recorded to a history file for reference purposes. 
See Chapter 17, Advanced Alarm Management. 
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Alarms 
Alarms are configured application messages used to notify operators of exceptional 
conditions at the workplace. The application generates automatic system messages that 
provide operators with information about internal system events, such as communication 
driver failure, network communication errors and others.  
Application alarms can be targeted to and be displayed in the Events Summary, appear in 
a popup window, or be printed out.  
Alarms can be defined in order of hierarchy. New alarms can be added (or existing alarms 
modified) to different levels of the hierarchy tree. Alarms can be defined according to 
attributes, inhibited, delayed, have Help messages containing instructions on how to 
handle the cause of the alarm and have comments attached to them. They can also be 
recorded to history for report purposes. See Chapter 15, Alarms. 
 

 
 

 
 

  

 
 

 
 
 

Alarm Filters 
The Alarm Filters module filters alarms and reports before they are printed out or written 
to the Events Summary. Alarm filters are displayed in the Alarm Filters table and defined or 
modified in the Filter Properties dialog box. Filter properties can be updated, however the 
name of a filter cannot be changed.  
The Alarm Filter filters the alarms sent when parameters defined in tag variants are not 
met.  
After alarms and reports outside the defined categories have been filtered out by the 
Alarms Filter, the remaining alarms are sent to the Printers defined in the Printer Targets 
module. (See Chapter 16, Alarm Filters, Printers & Printer Targets. Defining Alarm 
Filters). 
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Automatic Network Optimization 
When there are very fast tag changes at the workstation and the server is too loaded to 
send all tag changes, this functionality sends the newest tag values to the web client.  
If the web client cannot keep up with tag changes from the application for the Internet 
station it will process the latest tag thereby insuring that the information displayed is always 
updated.  
  

 
 

 

 
  
 
 
 
 

Background Processing 
The application enables you to process heavy jobs without temporarily disabling the 
system. While background processing is in progress other operations can be performed.  
Background processing operates when: 

o     Loading an image file that is larger than 30K  
o     Printing an image  
o     Generating Events Summary and History Viewer reports  
o     Using MultiAdd, List, and Use functions in the Tag Definition dialog box. See 

Chapter 9, Tags. 
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Built-in Report Generator 
The built-in report generator keeps you continuously informed and up to date on all plant 
activities.  
Designed specifically for supervisory and control systems, the report generator can 
produce customized daily shift reports, periodical reports, and event-driven reports.  

 
 

 
 

  
 
 
 
 

Charts and Reports  
The system's charts provide graphical views of process behavior and operational trends 
over a period of time. A single chart can display historical and real-time trends in distinctive 
colors and styles. Charts can also be defined to display a tag's bit. 
An X-Y chart can be configured with up to 16 related process parameters. The user can 
scroll along the X and Y axis while zooming in and out to view the required details. See 
Chapter 26, Charts and Chapter 34, Reports. 
 

 
 

 
 

  

 
 
 

 
 

Database Connectivity 
The application’s SQL module allows application designers to build event driven SQL 
queries to read and write system data from and to database tables. This simplifies the 
exchange of information with other applications. See Chapter 37, Application SQL 
Support. 
Note:     The application's database files are saved in Microsoft Access where they can be 
opened and modified. 
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Easy Maintenance 
 reduces operating costs by enabling users to build a single 

s the 
l 

n each station. Updates can be 

oduce new configuration, resource or 
 for each 

 

 

 
 

The software program
application instead of a network solution of multiple applications. In addition, it ease
administrative burden tremendously, since it is Java based and Java is already an integra
part of the web browser installed on most desktops. 
The application does not need to be installed locally o
distributed centrally through web servers. 
The application's functionality does not intr
compatibility issues; nor does it require extra administrative or maintenance effort
machine. In addition, the application relies on Java's portability and eliminates the need to 
support different versions of applications on different platforms. The system can be viewed 
online with a browser. 

 

 

 
  
 

Events Summaries 
s interface displays alarms according to the user's specifications. 

e, 

Summaries also provides multi filtering and alarm inhibition. The Go to Zone 
 

 

 
 
 

The Events Summarie
The user can apply filters to display only alarms from a defined zone range, severity rang
family prefix, station, class and more. Alarms such can also be sorted in the Events 
Summary.  
The Events 
feature enables connecting predefined zones to alarms. This means that an alarm can be
attached to an image of a problematic zone enabling the user receiving the alarm to easily 
identify the alarm's whereabouts. See Chapter 24, Event Summaries. 
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Events Summary Profiles 
Events Summary Profiles determine how active alarms and history are displayed in a 
browser according to the definitions defined by the System Integrator. See Chapter 25, 
Events Summary Profiles & Popups. 
 

 
 

 
 

  

 
 

 
 
 

Events Summaries Viewer  
The Events Summary Viewer features real-time monitoring of alarms and history according 
to the definitions specified in the Events Summary Profile. This enables the user to monitor 
and acknowledge alarms in real-time, adjust alarm display, resize columns, change alert 
sorting and view alarm history. 
Alarm filters can also be changed to view only specific alarms, for example, from a certain 
zone or according to priority. Filters can also be added and removed without affecting the 
server side. Html alarm files can be used and the alarm background and text colors can be 
set according to alert severity and zone. 
Similar to the Events Summary display, this viewer shows the following lists; In History 
Mode, Load Picture, Inhibit, Ack Selected, Force End, Assist, Columns, Filter List and Add 
Comments. 

 
 

 

 
  
 
 
 
 

Hot Backup Support 
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e station to serve as a backup to other stations. If the main SCADA 

 

The system enables on
system fails, the backup station immediately takes over and continues to function.  

 

 
 

  
 

Image 
lication uses the most advanced techniques for presenting images. They include:  

o field change, so do graphical 

used to navigate through the various application's 

 image as a trigger, so that whenever the object is 

o ng the powerful, Image Editor that includes a variety of 

 

 
o s, 

o  are predefined built-in macros that enable you to 

o  (font 

See ule, Chapter 21, Image Editor and 

 

 
 
 

The app
o     Drawing a single large image representing the entire plant and then zooming in 

on a selected area to obtain detailed views of small and even hidden elements. An 
image can consist of more than 64 layers, with each layer representing specific 
information. Operators can then choose and mix layers, accessing only the 
information they need and are authorized to see. 
    Defining dynamics so that as parameters in the 
drawings and textual displays. 

o     Zone Navigator which an be 
image zones. 

o     Defining any object in the
selected, one of several operations, such as activating a macro will be 
automatically performed. 
    Designing an image usi
drawing tools designed specifically for the application's requirements. This unique 
editing feature enables you to easily modify any object and simultaneously apply 
the changes to all the applications' diagrams.  
Objects in an image file can be locked (and unlocked) to prevent them from being
modified or deleted. 
   In addition to drawing images within the application framework, graphic files 
generated using other software programs can be imported to the Image Editor.
    The Clusters Library holds a variety of prebuilt objects, including valves, pump
and other industry-standard components. The user can define or change the 
parameters of each object and save the changes in the application's database. 
When a new library is created it can be saved to the Global Cluster Library and 
used in other applications. 
    The Fast Actions triggers
easily trigger routine operations. Among the available actions are: load/close 
window, load/close image, load/close chart, load/close events summary. 
    Copy and Paste attributes supporting object (line and fill color) and text
style, size, color and background).  

 Chapter 20, Introduction to the Image Mod
Chapter 22, Image Animation. 
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Language 
anguage is a built in control language, which can be used to automate plant 

 

 

 
 

Application L
tasks, augment control capabilities, and enhance system flexibility. 
This language enables application engineers with little programming expertise to write 
useful command programs. Each system function, such as access to control devices, can 
be expressed in symbolic form in application Language, so that any application engineer 
can customize the application to meet specific plant design requirements. See Chapter 30,
Application Language. 
 

 

 
 

  

 

 

Macros 
re shortcuts that can be used to execute predefined actions, commands, or 
, whenever designated keys or key combinations are activated. This enhances 

 

 
 

 

Macros a
programs
overall application functionality, and saves you the time and effort of having to execute 
operations in several stages. 
Up to 65 535 application macros can be defined. See. 
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Milli-second Time Stamping 
p to a 50 milliseconds resolution and can receive data with 

 

The system samples PLCs at u
a time stamp of up to 1 millisecond resolution. This data is registered in the application's 
history files according to the time stamp. It allows operators to trace the sequence of plant 
events exactly as they occur. 

 

 
 

  

Networking 
n provides a smooth growth path from a standalone workstation through the 

e application can be connected to 

k. 

 

 
 
 
 

The applicatio
plant floor configuration to plant-wide network architecture connecting the plant floor with 
existing file servers and other management systems.  
The system network uses client-server architecture. Th
other workstations or stations using NetBIOS or TCP/IP protocol that have the software 
program installed. Thus, tags and alarms defined on any application workstation can be 
used on the same network as the application. See Chapter 19, The Application Networ
 

 

 
 

  

 

 

Network Application Update 
e module enables an application developer to quickly and 

 

 

 
 

 

The Network Application Updat
easily update far station application files remotely. To the station operator this action is 
invisible. However a record of the update will appear in the station's error.dat file.  
An unlimited number of network stations using the application can be defined in the
Remote Update Settings dialog box. This dialog box, by default, holds all the files within 
the application. See Chapter 36, Network Application Update. 
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Online Design 
Changes can be made during runtime and the user can view the results immediately. 

 
 

 

 
  
 
 
 
 

Open Architecture 
The system integrates seamlessly with existing databases, spreadsheet s or other 
customized applications, allowing you to focus on productivity rather than compatibility.  

o    The application's Virtual File Interfaces (VFIs) enable the designer to select 
different file formats to be used for application historical data logging and report 
generation. The system engineer can use a combination of different file systems 
and databases with the application, for data manipulation convenience and 
optimum performance.  

o    A comprehensive Application Programming Interface (API) is included with every 
application package to enable smooth integration with customized programs and 
application modules.  

o    The application supports two-way Dynamic Data Exchange (DDE) links for 
exchanging data with other DDE-compatible applications. 

o    The application’s SQL interface enables application designers to build event-
driven SQL queries to read and write system data from and to database tables, 
simplifying the exchange of information with other applications. 

o    The application is managed by a real-time, event-driven kernel. This module 
includes an API that can be used to write supplemental application programs in C 
and Visual Basic language, to meet the specific requirements of any project. For 
further information, refer to the Read Me file in the Toolkit. 

o    The application is compatible with a wide variety of PLCs and other control 
system components. Custom adaptation is supported through a fully documented 
toolkit. 

o    All definitions of alarms and tags are saved in a Microsoft Access Database 
(MDB). A database can be opened and modified by the user in MS Access. 

o    A history of tag changes can be saved and viewed/opened in a database that 
supports ODBC.  

19 
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ith hardware field devices or other software that can be reused 
o 

o 
o 

 
 

o    OPC capabilities enable system integrators to create a common interface for 
exchanging data w
by this client program, and other HMI, SCADA and custom applications. novaPr
Open can be now OPC DA Server & Client, OPC HDA Server and OPC AE Client. 
   A complete BACnet driver with a totally integrated user interface. 
   A Centralized User Management option is enabled with a SQL Server database. 

 
 

  
 
 

PLCs Sampler 
The application samples PLCs at up to a 50 milliseconds resolution and can receive data 

 of up to 1 millisecond resolution. Up to 32 networks of PLCs and other 

 
 

 
 

with a time stamp
field devices can be sampled. 

 

 
  
 
 

Printers 
Alarms and their history, tag history, AHP formatted Help files and reports can be printed 

cal and network printers. Printing definitions such as color or different text fonts 

 can appear as a page holding a list of events or 
t is printed on a separate page.  

 is 

See
 

 
 

 
 

both on lo
and backgrounds can be defined. 
There are two printing modes: 

o     Graphical printout, which
alternatively, each even

o     Line mode printing where each alarm is printed separately in real-time and
added to the list already printed on the page. 

 Chapter 16, Alarm Filters, Printers & Printer Targets. 
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Printer Target 
 is a collection of predefined filters and printers specifying the conditions 
 targeted printer is activated. The Printer Target dialog box holds a list of all 

 

 
 
 
 

A Printer Target
under which the
the printer targets that have been defined. Each printer target is identified by a unique 
name and description. See Chapter 16, Alarm Filters, Printers & Printer Targets 
page 2. 
 

 

 
 

  

 

 
 

Recipes 
re lists of tag values that are applied to specific control processes such as 

s can edit, load and save recipes for convenient handling of production processes 

 

 

 

Recipes a
groups. 
Operator
and setting control programs. Recipe management and downloading production recipes 
from management systems is simple and straightforward. See Chapter 32, Recipes. 
 

 

 

  

 
 

 

RePlay Module  
The RePlay module is used to display/view previous history tag values in images. 
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 is activated a screen opens displaying an image and its tag values as 
s from 

 
 

When this module
they appeared at a selected time. The application reads and displays the tag value
the application's history. 
Only tags that have Write to History defined during Tag Definition can be used. 
Chapter 23, RePlay Module. 
 

 

  

 
 

 
 

Security 
The system integrator responsible for the application can, using the User Management 

rant access permission to users. Users can have full or partial access to the 
dules. Access can be defined according to users, groups and teams. 

d 

 
 

 

 

module, g
various mo
A user password can hold up to 20 characters that can be changed by the user (if define
so the system integrator). Access to the system can also be through a token or PIN 
number. See Chapter 7, Security and User Management, Security Overview. 
 

 
 

  

 
 

 
 

Security on the Web 
The application takes full advantage of the security features provided by the web server, 

rol according to selected web pages. In addition, an Internet 
limit access according to IP addresses. The TCP port 3028 should 

 
 

 

enabling user access cont
firewall can be used to 
be open to enable dynamic control from remote. 
The program also offers the system integrator the power to limit the operations that the 
user is able to perform. Only authorized users with specific access permission can login to 
the application. 
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Scheduler 
The Internet based Scheduler enables you to easily create daily or weekly task orientated 
schedules remotely. Accessed through an Internet browser or by clicking on an icon, the 
Scheduler is extremely user friendly, efficient and economical. 
Being both task and time orientated the Scheduler can be used to create unlimited tasks, 
actions and states. Tasks can be modified, enabled/disabled and have many states such 

tached to them. An unlimited number of actions, which are basic operations, 

 
 

as On/Off at
can be attached to each task. See Chapter 31, Scheduler. 
 

 
 

  

 

 
 
 

Tags 
An application tag is used as an internal variable for calculations and display and 
communication with PLCs to represent data from PLC memory, or to send commands to 
PLCs.  
Tag values can be scanned and recorded to historical files according to several 
parameters specified by the user. Tags can also be assigned an application DDE link 

on and can therefore receive or send data to/from other applications. 
 provide 

, 
 parameters. The list of System tags can be viewed in the All Container tree. 

uring 
from 

-time.  

 
 

 

definiti
Predefined built-in System Tags (see Appendix G, System Tags - Overview) that
information about the system can be created. System tags can be for example, time, date
hour etc
A tag can also be locked/unlocked according to pre-defined time. This is useful d
maintenance enabling the system integrator to lock tags and prevent irrelevant alarms 
being sent. A list of all the tags defined in the Lock Tag can be viewed in run
Tags can be imported/exported to/from other applications or previous versions. See 
Chapter 9, Tags. 
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Tag Filter  
The Tag Filter module holds a list of tag filters that can be selected and used for tag lock 
visualization. This option is accessed in the Application Studio Control Panel or from the 
Tag Lock dialog box. Tag filters can be selected or created, saved and loaded.  
Tag filters are stored in the application in the file TFM.XML that is created in the Docs or 

directory of the application and can be accessed through Java applets. Up to 
 can be selected simultaneously. See Chapter 10, Tag Filter Module. 

 
 

 

appropriate 
10 tag filters
 

 
 

  

 
 
 

 
 

Tag Generator 
The Tag Generator module is an engineering tool designed to quickly and easily generate 
or update tags in the  novaPro Open database.  
The Tag Generator allows you to update any existing Wizcon PLC or dummy tags into 
adressed PLC tags through a mapping process. If tags do not exist in Wizcon database, 

ill create them. 
 
 

the Tag Generator w
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Tag Mapper  
The Tag Mapper is a data file of tags and tag values that can be used to considerably 
reduce workload during application creation. Tag values of tags held in a Tag Mapper table 
are mapped by the Tag Mapper into a list of other tags. 
There are two types of Tag Mapper tags: 

o     Source: These are tags whose values are directed to target tags. More than one 
source tag can be pointed to the same target tag. 

o     Target: This tag type receives the values of the source tag. All target tags must 
he WIZTGM_ prefix. 

 
 

have t
An unlimited number of tags can be mapped. The Tag Mapper is bidirectional. All Tag 
Mapper dialog boxes are resizeable. See Chapter 11, Tag Mapper. 
 

 
 

  

 
 

 
 
 

Trend Profiles  
The Trend module provides a real time and historical graphical view of tag values over 
time. 
System architecture provides additional benefits for remote control applications and 
applications where frequent causal access is required. For these applications historical 
display of data is critical. The Trend features include: 

o    Historical cache mechanism: Offers improved performance with minimum load 
on the server. 

ronous historical data download: As a result the Trend is always 

   Performance: On a local area network, trends can be used over a dial-up 

 
 

o    Asynch
responsive to the user.  

o 
connection. 

o    Display of multiple tags over time. 
o    Historical and on-line data support.  
o    X and Y axis labeling. 
o    Different line colors and line types. 
o    The Trend component takes less than 800kb. 
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Trend Viewer 
A Trend Viewer displays online activities and history recorded by the application system 
according to definitions specified in the Trend Profile. 
The Trend Viewer functionality enables modification of the chart's tag setup over the 
Internet without affecting the server side. The Setup menu enables updates to Tags, Time 
and the Grid, whereas the Options menu enables Axis Orientation, Print and Show Grid. 

, Trends. 

 
 

See Chapter 27
 

 
 

  

 
 
 

 
 

User Management  
The User Management module enables management of all the users of the application 
both locally and remotely. This module enables definition of user groups and teams and 
their access permission to the various application modules. A timetable can be set for each 
user/group/team and alarms, when necessary can be sent to the appropriate personnel. 
This management methodology allows for easy scheduling of personnel for various tasks. 

atabase, the User Management module can be centralized for a 
access between several Wizcon stations. 

 
 

Linked to a SQL Server d
common and unique 
Alternatively, you can link the user management to a corporate IT network, using Active 
Directory to handle setting up of users and groups and password management. 
Providing full backwards compatibility, User Management enables import/export of groups 
created in/for previous/new versions. See User Management - Overview. 
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Zone Navigator  
The Zone Navigator window enables quick and efficient navigation through the list of zones 
defined in the application's various image objects. Using the Zone Navigator you can 
define a number of navigators each of which can contain a number of zones from one or 
more different image files. 
The Zone Navigator can be applied to images through either Button or Action type triggers 

n Action type macro. A digital tag representing the zone's status can be 

r. 

 
 

or by configuring a
added to each Zone Navigator. Additionally, color indicators can also be defined. The 
multi-image zone navigator can be activated from the Application Studio control panel, 
from the Studio Design menu or at runtime from the image using a button or action trigge
See Chapter 21, Image Editor, Zone Navigator. 
 

 
 

  

Other Topics 

 
 
 
 
 

Application SCADA Station 
  
Application SCADA station is an operations station that can communicate with up to 16 
networks of PLCs simultaneously. This station performs functions such as sampling PLCs, 
generating alarms, collecting historical data and performing control operations. The 
operator can view the process through the Application user-interface and interact with on-

n SCADA station can receive and send data to other 

 
 

going activities. The Applicatio
network stations.  

 

  
 
 
 
 

Application SCADA View Station 
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The Application SCADA View station is a full operational station that allows operators to 
view and control the process. This station automatically receives all the online and 
historical data from the SCADA stations, as required. The operator can transparently 
interact with the process using Application’s Images, Charts and other standard modules. 
The Application SCADA View serves as a mirror of the real-time and historical data from 
one or more SCADA stations. The SCADA View Station is not connected to a PLC, it is 

network 
 
 

connected to SCADA Stations via a 

 
 

  
 
 
 
 

Management View Station 
  
The Application’s Management View stations are stations that bring real-time and historical 
data from the plant floor to any desktop in the organization. Management View stations can 
display data collected by one or more SCADA stations. In addition to displaying the data in 
forms of images, graphs and reports, Management View stations provide the necessary 
functions for interacting with on-going activities. Each command for changing process 
parameters or downloading a recipe is immediately transferred to the appropriate 
Application SCADA stations. Since the Application Server handles the communication, this 

critical operations on the plant-floor. A Management View 
t a Server station. 

 
 

process does not affect time-
Station cannot operate withou

 

  
 
 
 
 

Management View Station Configuration 
Note: Management View Station is not supported on the Web. 
To configure your station as a management view station load the Application without a 
plug, follow the same procedure as when defining a SCADA station Then in the local 
station definition dialog box set the Management View station check box, and Select A 
Server station to indicate that requests for data from the local station will be directed to 
the Application Server. 
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About this chapter: 
This chapter describes system requirements and the installation procedure.  
System Requirements discusses the requirements of the system.  
Installation instructs you how to install the application and lists the additional software 
components installed during application installation. 
Starting the Application instructs you how to start the application. 
 
 
 
 

 
 

 
 

   

 

System Requirements 

 
 
 
 
 

System Requirements 
Before you install the application verify that you have at least the following: 
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Hardware 
Computer: Pentium III 800 MHz (recommended 2 GHz and up).  
Memory: 256MB (recommended 512MB).  
Hard Disk: 500MB minimum free (recommended 3 Go). This is required for both installing 
the program and for developing an application. 
Monitor Adapter: 8MB (Recommended 32MB) 
Monitor: Resolution 800X600 or higher. 
Display: VGA, SVGA, or any graphic adaptor that supports the operating system desktop. 
The display should be set at 65000 colors (16 bits) or higher and the screen resolution 
should be set at 800 x 600 or higher. 
Mouse: Any PC compatible mouse. 
Parallel or USB Port: Required for the system's security plug. 

Software 
Operating System: Microsoft's Windows 2000 SP4, Windows XP SP2, Windows 2003 
Server SP1, and Windows Vista. Please check the release notes for any updates.  
Correctly configured TCP/IP: IP address can be fixed or provided by a DHCP server, 
except for HotBackup stations which should have a fix IP address set manually 
Web server: A web server that owns an ASP engine is required for publishing the 
application. It is strongly recommended to use Microsoft IIS version 5.0 and higher 
(Internet Information Server). 
Browser: Microsoft Internet Explorer 6 SP1 (or higher). 
Java enabled browser is required. Sun Java 6 Update 2 (1.6.0_02 ) is installed with the 
product. 
HTML Editor: Any HTML editor may be used. (Optional) 

 
 

 
 

   

Installation 

 
 
 
 
 

Caution 
It is strongly recommended that Microsoft IIS 5.0 or higher be installed on the computer 
prior to installation. 
If the above software components are not installed, a dialog box opens informing you that 
Setup has detected that the version of Internet Information Server required have not been 
installed. Click Yes to exit system setup so that you can install the missing IIS. On 
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Microsoft Windows Vista system, IIS7 can be automatically installed by setup if end-user 
click on the corresponding option. 

Previous Versions 
If you have a previous version of the product installed a message box opens reminding you 
to uninstall it. 

Additional Installations 
The following components are installed during the system's installation if they are not 
already installed. 

o     MDAC (Microsoft Data Access Component) 2.7 / 2.8 SP1 
o     JET40 SP3 
o     MFC 6.0 
o     MFC 7.0 
o     MFC 7.1 
o     VC 80 SP1 
o     Sun Java 6 Update 2 
o     Microsoft .NET Framework 2.0 
o     HASP driver version 5.22 
o     OPC Core Components 3.00 

Installation 
It is strongly recommended that you close and exit all Windows programs before running 
the installation procedure.  

o To install the application: 
1.    Insert the CD-ROM into the CD-ROM drive. The Requirements dialog box is displayed. 
Click Install 

  
2.    The Welcome dialog box is displayed. 
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3.    Click Next to open the License Agreement window.  

  
4.    Read and accept the Agreements and then click Next. 

The Installation parameters dialog box opens enabling you select the Destination 
Folder location and the Application language. 
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5.    Click Next to open the Setup Type dialog box.  

 
The Setup Type dialog box has the following options: 

Typical     If Typical is selected the product will be installed with the 
most common features. 
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Custom    
If Custom is selected a new Custom Setup dialog box 
opens where the user can select only the relevant 
components required for the installation. 

  
6.    Make your selection and then click Install to perform the installation procedure. 

  
7.    The installation process is performed ... 
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8.    Once the installation procedure is finished, a final dialog box is displayed. Click the 
Finish button to end setup 
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Uninstall / Modify / Repair the program 
The Uninstall function can be used to remove the program from your computer. Only the 
directories, files, folders, icons and registration originally created by the system's 
installation program will be removed. 
To achieve the best results, exit the application and make sure that the system is not 
running in the background before using the Uninstall program. If it is working, some files 
and icons may not be removed. 
To launch the application uninstall program: 
1.    Click the Start button on your desktop, point to Settings and then click on Control 
Panel. The Control Panel folder is displayed. 
2.    Double-click on the Add/Remove Programs icon. The Add/Remove Program 
Properties dialog is displayed.  
3.    Select the application from the list of available programs and click the Add/Remove 
button. The Modify or Remove Program dialog box opens. Click Next 

  
 
4.    Make your selection to Modify/Repair/Uninstall and then click Next to perform the 
selected option. 
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Modify     If Modify is selected the product can be modified and 
features can be installed / uninstalled on demand. 

Repair    
If Repair is selected all corrupted or deleted files are 
automatically repaired by installation procedure. Ihis option 
avoid reinstalling the product. 

Uninstall    If Uninstall is selected the product ic uninstalled 

7.    Once the operation is finished, click on Finish button 
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Starting the Application 

To start the application, click on the Start button on your desktop, point to Programs, to 
NovaPro Open and then to the application. Click on the application to open the Studio. 
Or, Double-click on the shortcut application icon on your desktop. 

o To create a shortcut to your application (without going through the Project Wizard): 
1.   Right-click on your desktop, and select New/ Folder from the popup menu. 
2.   Type in the name of the application and select Shortcut from the popup menu.  
3.   Type the location and name of your application (*.Wpj) or search for the application by 
clicking on the Browse button. 
4.   Click Next and select a name for the shortcut. 
5.   Click Finish to complete the operation. 
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   About this chapter: 
This chapter describes how to access the system and also suggests a workflow for building 
an application. 
Accessing the Application describes how to open the application and the Application 
Studio and also describes the Quick Access bar. 
User Login describes how to log in to the application. 
Designing an Application describes what to do before you begin designing an 
application, as well as typical application requirements. 
Workflow describes a typical workflow for application design. 
Shutting Down describes how to logout of the system and how exit the application. 
 
 

 
 

 
 

 

  

Accessing the Application 
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Accessing the Application 
You can access the application and all its working components by either: 

o     Clicking the  application icon. 
o     Opening the Application Studio that holds all the components you need to 

design as application. 
o    To open the application, do the following:  

1.    Click on Start and point to Programs/NovaPro Open, and then to the Application and 
select it from the popup menu. The Getting Started Wizard is displayed. This wizard 
enables you to open applications from the Application Studio. 

  
The Getting Started window has three tabs: 

o     New - creates a new application or opens a template application 
o     Existing - searches and opens an existing application 
o     Recent - lists recently used applications 

2.    After you select and open your application the Quick Access Bar appears on your 

screen. Click the Application Studio icon in the Quick Access bar to access the 
Application Studio.  
Note:     For further details on the Wizard see Chapter 6, Building a Project. 
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Application Getting Started Wizard 
  
The Application Getting Started Wizard is a simple way of organizing applications and 
creating new ones. 
  
From the Application Getting Started Wizard you can: 
Create a new application.
Create a template application. 
Open an existing application 
Select one of the recently used applications.
  
Double click on the application’s .exe file or lauch the application from the Windows Start 
menu. 
The Application Getting Started Wizard dialog appears. 

 
 

 
 

   
 
 
 
 

Application On-Line Help 
  
You are now in the Studio Application  
To get started with application design or to use an existing application, click on the desired 
menu title, or press the Alt key together with the key of the underlined letter of that menu.  
  
To obtain help for any menu title at any time, simply click on the desired menu title and 
press F1.  
For help with any menu item, click on the desired menu, move down to the item you want, 
and, while still holding down the mouse button, press F1.  
  
Alternatively, open the desired menu by pressing the Alt key together with the key of the 
underlined letter in the menu that you want to open, move to the item you want using the 
arrow keys, and then press F1. 
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Quick Access Bar 
The Quick Access Bar holds the following icon options: 

  Show Studio 

  Load Layout  

  Capture Layout  

  Load Image  

  Load Events Summary  

  Load Chart 

  Load History Viewer 

  Load Recipe 

  Save Recipe 

  Multiple Tags 
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  Single Tag 

  WizPLC Development 

  WizPLC Runtime 

  Advanced Alarm Management 

  Users Timetable 

  Shift Management Timetable 

  Users/Groups 

  Scheduler Configuration 

  Login to the Application 

  Logout of the Application 

  Exit the Application 
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Application Quick Access Bar 
 
The developer can minimize or hide this window and thus obtain true run time behavior. 

ck Access Bar for various actions made available to 

er that belongs to a group authorized to use the specific task.  

t 

how/Hide Application Studio Window 

er 

rm Management 

s 

 
 

The operator can use Application's Qui
him during run time. 
 
The Quick Access Bar has various icons from which the operator can activate different 
dialogs. The Access Bar is customized based on Group Authorization. Each action is 
available only for a us
 
The Application Quick Access Bar provides access to a set of Application actions tha
are customizable such as: 
 
S
Load Layout 

apture Layout C
Load Image 
Load Events Summary 
Load Chart 

ViewLoad History 
Load Recipe 
Save Recipe 
Multiple Tags 
Single Tag 
Advanced Ala
Users Timetable 
Users / Group
Scheduler 
Login 
Logout 

ion Exit Applicat
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Show or hide the Quick Access Bar 
  
Selecting the Show Quick Access Bar determines whether or not the Quick Access Bar 
appears when the Application is loaded. 

is is useful in applications where there is one layout, and no operator login/logout activity 

 
 

  
Th
is required, except for a default user. 

 

   
 
 
 
 

Show/Hide Application Studio Window 
  
Press the application icon from the Application's Quick Access Bar to show or hide 
Application's Studio. 

 
 

 

 
 

   

User Login 

 
 

User Login 

Local User Login 
To login to the system locally, click the Login icon in the Quick Access Bar. The User 
Login dialog box will open on your screen. 
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 you know your user name and password type them in the relevant fields and click OK. 

 login name and password can be defined by the System Integrator and used by 

 a group or team. In which case the group/team login name 

Th  users to login and access application options in much the 

he same group-assigned options available when logged in as a 

led or disabled. Users can then 

    Login using their user name and password and access their group assigned 

Or, 
o     Login using a default user name and password and access the options specified 

 

Web Smart Card Login 

Presentation
 

his features aims to support the Smart Card Login on the Web. The LDAP/smartcard 

 

ns 
 

 order to use the web smart card authentication you need to open the login dialog (by 
t 

 

If
Note:     
A default
all users to login to the system. 
A user can also be a member of
and password are used. (See Chapter 7, Security and User Management). 

Remote User Login 
e system enables remote

same way as local users.  
A remote user can access t
local user. The definitions behind these options are stored on the server, enabling remote 
users to access their application from any computer.  
The login option has the added flexibility of being enab
either: 

o 
options 

for default users  

 
  
T
login Documentation defines the prerequisits of this features.  
  

Access mea
  
In
clicking on the applet or on the login button). This dialog offers a new button called Smar
card if the smart card authentication is allowed.  
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How To 
   

First insert the smart card then click on the Smart card button. A few seconds later, the 
Aladdin eToken dialog is opened, it asks for the smart card pin number. The connection 
will be established if:  

• There is a valid certificate on the smart card  
• The user is defined inside NovaPro Open  
• The user is allowed to connect to the web.  

   

 
 
 

 
 

   

 
 
 

 
 

Operator Login 
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This dialog box is used to enter your operator name and password to log into the 
Application.  
  
After you select this item, the Login User dialog box will appear for you to specify the name 
and password of the operator.  
The name and password must be identical to those defined by the system engineer in the 
User Setup definition procedure.  
Note that when you enter the password, it will appear as asterisks (*) to maintain secrecy.  
  
The fields in this box are as follows: 
Name The operator name defined by the system engineer in the User Setup dialog box.  
The User Setup dialog box is invoked by selecting the Authorization item from the Design 
menu in the Application manager, and then selecting the Users item from the Authorization 
menu.  
Password The corresponding operator password. Note that when a password is entered, it 
appears as asterisks (*) to maintain secrecy.  
When an operator name is entered and confirmed, that name will appear in the Manager 
Banner. 

 
 

 
 

   
 
 
 
 

Login 
 
Press the Login icon to login to the Application. 
 
To log in to the Application the first time 
1. Click on the Login Icon. The Login User dialog opens. 
2. Enter in the Name field: User 
3. Enter in the Password field: Password 
4. Click OK to activate. 
To log in to the Application from the Start Programs Menu 
The User name and Password are: 
The user’s name  
The user’s password 
 
Remote users can login through their browser. 

 
 

 
 

49 



Chapter 4 Getting Started 

   

 
 
 
 
 

Remote User Login 
The application now supports the login of remote users through a browser so they can 
access Application options in much the same way as local users.  
A remote user can access all the same group-assigned options as available when logged 
in as a local user. The definitions behind these options are stored on the server, enabling 
remote users to access their application from any computer.  
This login option has the added flexibility of being enabled or disabled. Users can then: 

o Login using their user name and password and access their group-assigned 
options, or 

o Login using a default user name and password and access the options specified 
for default users. 

Login/Logout Quick Access Bar 
The Application provides the Login/Logout Quick Access bar to enable you to quickly 
login and out of the system. This Quick Access bar appears when the browser is opened. 
 
The Application enables you to replace the Login/Logout Quick Access bar, and design 
your own login/logout interface using HTML script. Remote user options will still run in the 
background. 
 

o To login: 
1.Start the system and access your application. The browser is launched. A typical browser 
will display the icon which you can click to begin login. You can also click Login on the 
Login/Logout Quick Access bar displayed in the top left corner of the window. The Login 
user window is displayed: 
 
2.Enter your user name in the Name field. 
3.Enter your password in the Password field. 
4.Click OK. Login is initiated and your application is accessed.  
 

o To logout: 
Click the Logout button on the Login/Logout Quick 
Access bar, or close your browser. 
 
See also:
Specifying Remote User Login Parameters
Customizing the Login/Logout Procedure 
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Login/Logout Quick Access Bar 
The Login/Logout Quick Access Bar, which appears when the browser is opened, enables 
you to quickly login and out of the system.  
The application enables you to replace the Login/Logout bar, and design your own 
login/logout interface using HTML script. Remote user options will still run in the 
background. 

o To login: 
1.    Start the system and access your web application. The browser is launched.  
2.    A typical browser will display the application icon, which you can click to begin login.  
 

 
 
3.    You can also click Login on the Login/Logout Quick Access bar displayed in the top 
left corner of the window to open the User Login.  
4.    If you know your user name and password type them in the relevant fields and click 
OK. 
Note:     A user can also be a member of a group or team. In which case the group/team 
login name and password are used. 

o To logout: 
Click the Logout button, or close your browser. 
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Default User 
The application enables you to create a default user. When a Default User is assigned, 
after a user logs out of the application, the application automatically opens using the name 
and password of the Default User. 
A default user is created in the User Management module (see Chapter 7, Security and 
User Management, Creating Users) by selecting Users to open the List of Users and 
then right clicking on a specific user name and selecting the Default User option. The 

Users icon will appear next to the selected user name.  
Note:     Only users that are members of the Administrator group can add users to the 
application. 
 

 
 

 
 

   

 
 
 

 
 

Default User Dialog 
This tab is used to define the name of the user that is automatically logged in whenever the 
application is opened. 
1. 1. In the User field type in the User’s name. Enter an (*) to specify the last user that 
logged out. Changes are implemented online. 
2. 2. In the Password field type in the user’s unique password. 
3. 3. Click OK to confirm and then reset the application. 
  
Note: Remote users login parameters are defined by right clicking Html/Properties/Users 
and then checking either:Enable login Quick Access Bar, Automatically login with default 
user. 
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Specifying Remote User Login Parameters 
ge the properties of the Html module (see 

x, do the following 
ck HTML and select 

n specify whether or not a Popup Event Summary window 

o er login parameters are defined 
trends.  

The

 

The Html Properties dialog box is used to chan
Chapter 28, Generating HTML Pages). 
u To access the Html Properties Dialog Bo
In the All Containers section of the Application Studio, right-cli
Properties from the popup menu. The HTML Properties dialog box is displayed. 
This dialog box has three tabs: 

o     Popup - where you ca
is displayed in a browser  
    Users - where remote us

o     Trend - where you can specify information related to web 
 Popup and Trend tabs will be treated further in the user guide. 

 

 

 
 

   

 

 
 

 
 

Specifying Remote User Login Parameters 
You can specify the following remote user login parameters:  
Enable only authorized users remote access. 
Enable all users remote access by enabling them to login in as a default user. This way 
any user can login and access the options specified for default users. 
  
To specify remote user login parameters: 
1. In the All Containers list, right-click on HTML and select Properties from the popup 
menu. The HTML Properties dialog is displayed.  
2. Select the Users tab.  
3. Select Enable Login Quick Access Bar in browser so that a user must enter a user 
name and password to login.  
4. Select Automatically login with default user to enable any user to login with a default 
user name and password. This means that any user can access the application and use 
the options that are assigned to default users. 
5. Click OK to save your options and close the dialog. 
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Users 

 
This dialog box enables you to define remote user login parameters. 
1.   Check the Enable Login Quick Access Bar in Browser checkbox to enable this option. 
The user can then login to the Web application by pressing the Login button.  
2.   Check the Automatically Login with Default User checkbox to enable any user to login 
with a default user name and password. This means that any user can access the 
application and use the options that are assigned to default users. When this option is not 
checked the user will be forced to login with a user name and password. 
3.   Check the Auto-logout to enable the automatic disconnection of a web client from the 
web server. The Auto-logout period can be set in minutes. 
4.   Click OK to save these definitions. 

 
 

 

 
   
 
 
 
 

Customizing the Login/Logout Procedure 
Experienced HTML users can customize the login/logout procedure on their computers by 
creating buttons in HTML and attaching HTML script, as follows: 
 

HTML Script Action 
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scriptLoginUser() Displays the Login user dialog box 
used to login to the system 

scriptLoginUser(user,password) 

Login automatically with the user 
and password specified between 
the bracketsA. User name and 
password can be provided by a 
Java Script form.  

scriptLogoutUser() Logout 

scriptGetCurrentUserName() Displays the currently logged in 
user 

AIt is possible to make the login dialog box visible or not by setting the size 
(height and width) in the applet to 0. 
After customizing the login/logout procedure, deselect the remote user login parameters 
described on the previous page, so that the Login/Logout Quick Access bar is replaced by 
your own login interface. See Custom Web Login interface
Note:     Remote system mechanisms will continue to run in the background. 
 

 
 

 
 

   

Designing an 

Application 

 
 
 
 
 

Designing an Application 
Before you start designing your application, you need to know some basic, but necessary 
details about the process for which you are creating the application:  

o     Obtain a list of variables that the application will read and write from and to a 
PLC (I/O list or Tag list). 

o     Look at the control drawings to study the design and use of certain equipment. 
o     Look at the plant drawings to examine the layout of the plant for which you are 

designing the system. 
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o     Find out the type of reports users and managers wish to receive, in what format 
and in which fields.  

o     Find out the type of network you have, if it uses the NetBIOS or TCP/IP protocol, 
and the name of your network station.  

o     Determine any authorization definitions. 
o     Determine PLC definitions, such as blocks and addresses. 

Once you have this background information, you can build an application that fully uses the 
resources of the plant's equipment. Remember that if you are not aware of the limitations 
of the equipment, you may cause damage. 
If you are creating an application for a networking environment, refer to Chapter 19, The 
Application Network before you start designing the application.  
 

 
 

 
 

   

 
 

 
 
 

Designing Multiple Applications 
If you are designing multiple applications, you need to decide where to store your history 
files this could be on the local disk or on the server. 
Using system network tags, the same application can run on many stations. The 
application can be designed on one station and copied to another station. The only 
difference will be the station name definition (and number).  
Note:    The tag, alarm and communication driver definitions should not be copied. 
It is recommended to define the station name and number before you begin to build your 
application (Images, Charts and so on). 

 
 

 

 
   
 
 
 
 

Typical Application Requirements 
A successful application takes into account the following:  

Consistent Display Design 
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Process visualization accurately represents an on-going plant process, enabling a user to 
clearly understand the process status at any given time. 
It is recommended that displays in the visualization remain consistent throughout the 
application. For example, if a tank's fill status is represented in percentage form, then all fill 
status should be represented in percentages. See Chapter 20, Introduction to the Image 
Module, Chapter 21, Image Editor and Chapter 22, Image Animation. 

Alarm Design 
Alarms represent one of the most significant occurrences in a process. It is important to 
design alarms with different severity levels, zones and characteristics. This way, a user will 
recognize each alarm and react quickly and correctly. It is important to mark all alarms that 
are not targeted to an Events Summary with an Auto Ack attribute so that they will not have 
to be acknowledged by the operator. See Chapter 24, Event Summaries. 

Charts Design 
Charts visually represent the process’s progress. When designing charts, you should take 
into account user requirements. For example, if a user needs to compare two tags to 
perform a certain task, it is recommended to include both tags on the same chart. Up to 16 
tags may be represented on a single chart. See Chapter 26, Charts. 

Tag Naming Conventions 
Make sure that the name you assign to each tag clearly indicates what the tag represents. 
For example, all the tags that represent Flow Transmitters may be called FTxxx. This 
naming method is also convenient when adding a list of tags that are of the same type. 
It is also recommended to name the stations in a predetermined manner. For example, 
according to plant area. See Chapter 9, Tags. 

Logic 
You can use the system's Application Language (see Chapter 30, Application Language) 
to create an application that can enhance the capabilities of control equipment working with 
the software program such as PLCs, and establish the connectivity interface between the 
system and external computer applications.  
Compound tags can also be defined in the system. A compound tag is a linear calculation 
based on values of other tags. 
WizPLC, the NovaPro Open softlogic component can be used for application which 
requires PLC language programming.  
Application scripting language can also be used to implement logic. In addition to providing 
connectivity to SQL databases, Application SQL (see Chapter 37, Application SQL 
Support) has powerful language functions and its event driven architecture provides 
excellent performance. 
 

 
 

 
 

   

Workflow 
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Workflow 
This section describes the workflow for building an application. 
1.   Building a project: The application wizard and Station Properties 
2.   Defining network 
3.   Defining Communication Drivers and Blocks 
4.   Defining User Management 
5.   Defining Tags, Alarms, Event Summaries 
6.   Building the application Image 
7.   Defining application logic 
8.   Testing the application 
9.   Defining Charts, Reports, Recipes, Printers 
10.   Fine Tuning 
You can merge steps 3 and 4 into one, and complete the step in four stages, define some 
of the tags, build part of the image, complete the image, define the remaining tags. 

 
 

 
 

   

 

Step 1: Building a Project, the Wizard and Station Properties 
sing a template or blank 

s either as a blank application or a template 

  listing all projects created in the application 

A n p pplication Studio opens on your 

 

In th ame and select Station Properties 
from the popup menu. 

 
 

 
 

The Getting Started Wizard enables you to create projects either u
application. The Wizard has three tabs: 

o     New - for building new project
application  

o     Existing -
o     Recent - listing the most recently used projects 

ew roject file is saved with the suffix *.Wpj. When the A
screen the name of the project appears at the route of the All Containers pane.  
After the project is saved, Station Properties, which enable your to adjust system
parameters to optimize your application working environment can be defined.  

o To open the Station Properties dialog box: 
e All Containers pane right clicking the project n

58 



Chapter 4 Getting Started 

   
 
 
The Station Properties dialog box has the following tabs: 

eneral  Used to customize the application workplace 

rmat 

ual File Interface DLL 

t Trail source  

ODBC Connectivity application historical data to be saved to various 
databases through ODBC drivers 

Advanced Alarm 
Management 

multi service communication 
platform providing alarm transmission over various channels 

Scheduler  
states can be created and modified over the Internet 

 

G

User    Defines the default user name and password 

Date Fo Defines the date style and separator used 

VFI Defines history files format by selecting Virt

Audi Used to log operator actions to a database via an ODBC data 

Enables 

Enables connection to the AAM, a 

Enables connection to the Scheduler where tasks, actions and
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User Management 

S 
onization 

properties. This tab will be used for Centralized User Management 

Files t) and Historical log file (errors) 

r detai t. 

 
 

Enables you to select the User Management database source (M
ACCESS or MS SQL Server) and to define the synchr

settings. 

Allows you to define the file size limits for the Online log file 
(errors.da

Limitation of Log 

Note:     For furthe
 

ls on Station Properties see the Chapter 6, Building a Projec

 
 

   

Station Properties 
 
 
 

Station Properties - Advanced Alarm Management 
Advanced Alarm Management (AAM) uses a multi-service communication platform to 
provide alarm transmission over various communication channels including SMS, email, 
fax

 a runtime component  

M are already defined then do the following: 
rs list of the Application Studio to open 

ation. 
 
 

 
 

 and vocal messages. 
AAM is comprised of two design mode components: 
AAM channels and AAM pager services 
Advanced Alarm Viewer –
To enable Advanced Alarm Management: 
1. 1. If the communication lines used by AA
2. 2. Right-click New Application in the All Containe
the Station Properties dialog box. 
3. 3. Using the arrows scroll to open the Advanced Alarm Management tab. 
4. 4. Check the Enable Advanced Alarm Management checkbox and click OK. 
5. 5. lick OKestartRestart the applic
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Station Properties - Audit Trail 
The application enables you to log operator actions to a database via an ODBC data 
source. The operator actions are stored in a system file in the form of tag values. The file 
can be accessed and the values viewed. This option is called Audit Trail.  
Audit Trail is a useful security feature for applications. For example, when a user operates 
a trigger or logs in, you can access the database file and view the user name of the user, 
where the action took place (in an Image or through a browser) and at what time. 
The application logs all manual operations, but not those made using Add-on programs, 
such as script language and application PLC. In addition, the application does not record 
Smooth Type trigger actions. 
Audit Trail provides data recovery for users connected to a remote ODBC data source in 
instances of network failure. 
When a network problem is discovered, the Applicatio ends the session with the remote 
database and creates a temp file in the temp directory of Windows NT in text format. The 
file, a CSV type file, is called BCK*.tmp. 
The Application then scans the network connection once a minute, and when connection to 
the server is re-established, writes the temp file to the audit trail file. If the information is 
written correctly, the Application then deletes the temp file. If the information is not written 
correctly, the Application will notify you of possible data loss. 
Note: It is not recommended to work with a remote database due to possible connection 
failures. 
  
To enable audit trail: 
1. 1. Right-click Station Properties in the All Containers list of the Application Studio. 
The Station Properties dialog is displayed. Select the Audit Trail tab  
1. 2. Select Audit Trail Enable. 
1. 3. To save to a predefined database, enter the name of the predefined database in the 
Current Data Source field or click to the right of the field and select a database from a list 
of predefined sources. 
1. 4. To set up a new database, click the Add Data Source button. The standard Windows 
Create New Data Source wizard window is displayed, in which you can define a database. 
The data source can be any valid predefined ODBC data source.  
Caution: The application does not support the File Data Source (Machine independent) 
option. 
3. A table (named AuditTrail) is added to the database. The fields in this table are 
described on the following page.  
4. Click Apply to select the data source as the default source, then click OK to close the 
dialog. 
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Station Properties - Default user    
Note: Not applicable on the Web. 
The instructions below apply to both Default User and Logout User fields: 
1. 1. In the User field type in the user’s name. Enter an asterisk (*) to specify the last user 
that logged out. Changes are implemented online. 
2. 2. In the Password field type in a unique password for the user.  
3. 3. Click OK to confirm and reset the application to actually save the changes. 
  
Activate the option, "Auto Logout on Inactivity" if you want the current user to be logged out 
from the application after a defined period of inactivity. Inactivity is defined as no keyboard 
or touch-screen presses and no mouse movement during the specified time. 
  
Use the text box or the buttons to define the logout time. Note that this is expressed in 
minutes. 

 
 

 

 
   
 
 
 
 

Station Properties - General   
The application workplace can be customized in the General tab of the Station Properties 
dialog box.  
The following options are available: 
Show Quick Access Bar Determines whether or not the Quick Access bar 

appears when the program is loaded. 

Show done bar Displays a background processing dialog box 
when large tasks such as loading a large image 
are being executed. Changes are made online. 

Auto Restart after an illegal 
shutdown 

Specifies if the application automatically recovers 
its last state. For example after power failure. 
Changes are implemented online. 

Display untitled windows icons in 
task bar 

When checked the word untitled appears in the 
task bar for new items that have not been saved. 

Display windows icons in the task 
bar 

When this option is checked and after reset, no 
icons are displayed in the task bar. 
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Station Properties - ODBC Connectivity 
The ODBC connectivity dialog box enables you to save Application historical data to 
various databases through Microsoft's ODBC (Open Database Connectivity). 
  
To enable and configure Application ODBC connectivity 
1. Right-click Station Properties in the All Containers list of the Application Studio. The 
Station Properties dialog is displayed. Select the ODBC Connectivity tab to display the 
ODBC Connectivity page: 
2. Select the Enable ODBC connectivity checkbox. 
3. In the Current Data Source field, select the database type to which you want to save 
Application historical data. 
4. Click the Add Data Source button to open the Create New Data Source wizard, where 
you can select and configure additional databases. 
5. To create a cross reference table including tag definition parameters, type the name of 
the table and click the Create cross reference table button. 
6. If you intend to use a protected database, such as Oracle, type the user name and 
password in the Identification field. 
7. Under History table, type the name of the historical data table. Select the Enable tag 
name logging checkbox to write tag names to the historical data table as well. 

 
 

 
 

   
 
 
 
 

Station Properties - Scheduler 
  
The Internet based Scheduler enables you to easily create daily or weekly task orientated 
schedules remotely. Being both task and time orientated the Scheduler can be used to 
create unlimited tasks, actions and states. Tasks can be modified, enabled/disabled and 
have many states attached to them. An unlimited number of actions, which are basic 
operations, can be attached to each task.  
Before the Scheduler is accessed the Scheduler module must first be enabled in the 
Station Properties dialog box. 
To enable the Scheduler module: 
1. 1. In the All Containers side of the Application Studio right click the application’s name to 
open the Station Properties dialog box. 
1. 2. Using the arrow, scroll and open the Scheduler tab. 
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1. 3. Check the Enable Scheduler checkbox and then click OK to actually define this 
option. 
1. 4. Restart the application. 

 
 

 
 

   
 
 
 
 

Station Properties - VFI     
Setting a Format for History Files 
The format for history files is set in the VFI tab of the Station Properties dialog box.  
VFI enables the designer to select different file formats to be used by the application for 
historical data logging and report generation. The system engineer can use a combination 
of different file systems and databases with the application for data manipulation 
convenience and optimum performance.  
VFI uses a unique driver for each database, thereby taking advantage of the database’s 
structure and characteristics. The application supplies drivers to support specific 
databases.  
 
This dialog box Tags and Alarms fields have the following options:  
VFI5CB, that enables writing/reading tag and alarm historical files in FoxPro format. This 
format is readable by most database programs. This is the default option and can be used 
for both tag and alarm history files. 
Note: Restart the application for changes to take affect. 

   
 
 
VFI FAST Mode (VFI5FST) does the following: 
Records values with old time stamps. This enables backup to complete data to the Master. 
All values can be read, and displayed in a Chart. To enable this option, set the following 
environment parameter. 
VFI5FST_MODE_TIMESTAMP=YES  
This parameter should be set in the Master only. It can also be set in the backup, however 
from a performance point of view it is better to set it only in the Master. 
Note: This option affects the performance of the Fast VFI. The more scattered the 
recording means that values will not be written in order of time.  
Concurrent writing of history from more than one client.  
There is a gap in logging data between the time the Master is up, and when the Backup 
starts updating it until the Master logger starts working. This gap is between 20 sec to 2 
min depending on the overall load of the system.  
Updating from the Backup to the Master may take a few minutes (if it logged a few Mb 
while it was active). Updating is performed while the Master is already active and sampling 
or logging the current process. 
Custom which when selected enables you to enter a customized format for history files. 
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Station Properties - Date Format    
The Date Format option allows you to set the date style and date separator you wish to 
use. 
  
  
To Set Date Format
1. In the Stations Properties dialog select the Date Format tab. The Date Format Dialog 
opens. 
2. From the Date Style list select a predefined date style. 
3. From the Date Separator list select the way you want the date to be separated. 
4. Press OK key to enter your selection. 
  
When loading for the first time, the Application sets default values for these parameters 
using country code, defined in Control Panel Regional Settings. 

 
 

 
 

   

 
 
 

 
 

Station Properties - User Management  
 
This dialog box allows you to choose whether to use WizUM.mdb or SQL Server for 
centralized user management.  
 
Centralized user management using SQL Server allows all stations on the application 
network to be immediately informed when there is a change in user/group profiles. 
 
If you select to use SQL Server, you can also choose to keep the local Access database 
(WizUM.mdb) synchronized with this database (the "Synchronize" checkbox). The 
advantage of this is that, if for any reason you are unable to connect to the central 
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database, the application will automatically switch to using the local WizUM.mdb and you 
can carry on working as before.  
 
Once the connection to the central database is restored, you will be able to update either 
the local database or the central database with changes that have been made in the 
meantime.  
It is strongly recommended to use the "Overwrite Local Database" option in order to avoid 
overwriting the data stored on other stations. 
 
Note that you will not be able to make changes to tag and alarm definitions while you are 
disconnected from the central database. 
 
There is a system tag, WIZSYS_UMCENTRALDATABASE which tells you whether you are 
connected to the SQL Server database or not. 
You can synchronize the local and central databases at any time by clicking the 
"Synchronize Now" button. 

 
 

 
 

   
 
 
 
 

Station Properties - Limitation of Log Files 
 
The log file, errors.dat, can become very large when, for example, an application is running 
for long periods of time or the parameter WIZINFORM=YES is set in WizTune.dat. 
 
Each time the application starts, the errors.dat file from the previous session is appended 
to the file, errors. 
This file can also become very large. 
To avoid this situation, you can use this dialog box to either: 
1. Limit the size of errors.dat, or 
2. Limit the number of errors.dat files stored in errors 
3. Limit the number of historical errors.dat files that will be stored in errors. This is first-in, 
first-out queuing mechanism; when the limit of stored files is reached, the oldest errors.dat 
file will be the first one to be removed. 
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This parameter enables you to select the name of the user you want to be logged in 
whenever you start the application (default user). Use an asterisk(*) for the last user. If a 
password is missing, the user will be prompted to enter it. The format is User. Password  
  
1. 1. Fill in the User Field: User's name 
1. 2. Fill in the Password Field: Your password. 
  
If a password is missing, the user will be prompted to enter it. 

 
 

 

 
   
 
 
 
 

Step 2: Defining Network 
When configuring a Wizcon station, specify a unique name and a unique ID number for 
your station. It is recommended to keep a 10 number gap between different station IDs. 
For instance, if one ID is 80, the next ID should be 90, and so on. The range for ID 
numbers is 1 through 999.  
Before configuring a station verify the station's name so that you can give your station a 
unique name.  
Note:     Networking require a security plug. 

o To define your computer as a network station: 
1.    From the Studio Control Panel, double click on Wizcon Network icon. In the Network 
dialog box scroll to open the Local Station tab. 

     
2.    In the Station Name field, specify a unique name for the station. 
3.    In the Station ID field, specify a unique ID number for the station. 
4.    Leave the Backup station field empty. For more details about Hot Backup configuration 
see Configuring a Hot Backup Station.  
5.    Click OK to save your definitions and to close the dialog box. 
6.    Restart the application to implement the changes. 
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Step 3: Defining Communication Drivers and Blocks 
Blocks are defined logically to maximize the efficiency of the application. This is 
implemented by defining blocks according to common sampling rates and consecutive 
addresses in the PLC. After defining communication drivers and blocks restart the 
application for the changes to take effect. When defining blocks, avoid: 

 Leaving gaps of more than 20 addresses within the block. 
 Defining blocks with a sampling rate that is different from the individual tag 

sampling rate. 
 Defining the same tags in more than one block. 
 Defining large blocks. 

Note:     For further details on Communication Blocks see the Chapter 8, Communication 
Drivers. 
 

 
 

 
 

   

 
 
 

 
 

Step 4: Defining User Groups 
Defining user groups is important at this stage because each subsequent design level may 
call for user authorization. Once you define the user groups, you can add individual users 
at any time to any group.  
Defining user groups later on in the design process is possible, but not recommended. For 
example, in a car production plant, engineers, managers and floor workers have different 
levels of authorization. If you assign authorization rights early in the design process, you 
will save valuable time in later stages of the design. 
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Note:     For further details on Creating Groups see page 18 in Chapter 7, Security and 
User Management . 
 

 
 

 
 

   

 
 

 
 
 

Step 5: Defining Tags and Alarms 

Defining Tags 
Tags are I/O points that are mapped from PLCs to the application as well as to internal 
(dummy) and calculated (compound) variables. You can use tags in images, charts, alarms 
and all application functions.  
When defining tags, make sure that tag and block sample rates do not conflict with each 
other. 
Note:     For further details see Chapter 9, Tags. 

Defining Alarms 
Once you define the tags, continue by defining the alarms. Alarms notify a user of an event 
in the process. They can: 

o     Indicate the beginning of a process.  
o     Warn of a failure in part of the process.  
o     Give instructions on how to handle the alarm. 
o     Hold user messages about the alarm. 

   When defining alarms it is possible to: 
o     Set different severity levels to control grouping and display of the alarms. 
o     Target serious alarms to a pop-up window, ensuring that users will not perform 

any systematic function before clearing the alarm. This is recommended. 
o     Group alarms in families. 
o     Assign an alarm to an object in an image. This object will then change its 

graphical attributes whenever the alarm conditions are met. 
o     Assign a Help file to each alarm so the user will know what to do when an alarm 

begins.  
o     Assign the print function  
o     Assign macros to start 
o     ...  

Note:     For further details see Chapter 15, Alarms. 
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Step 6: Building the Application Image 
The Image is a graphical representation of the application process and represents the 
feedback that the user receives from the plant. The Image is the main part of the 
application that a user views. Therefore, it should be informative, yet easy to understand. 
When designing images, take advantage of the following features: 

o     The Image Editor that features many different toolboxes to enable you to build 
your application. 

o     Zones, different areas of the image that can be viewed in close up. Each zone 
can represent a different part of a plant process. 

o     Layers that can be compared to transparent sheets with the same coordinates, 
which lay on top of each other. You can enable group access to certain layers and 
thereby control sensitive information.  

o     Cluster libraries that use object-oriented technology to simplify and speed up 
application design and maintenance. A cluster is an object with pre-defined 
behavior patterns and can be linked to existing tags and alarms, or can be used to 
automatically create new tags and alarms. 

o     The Image Editor that features many different toolboxes to enable you to build 
your application. 

Note:     For further details on Images see Chapter 20, Introduction to the Image 
Module, Chapter 21, Image Editor and Chapter 22, Image Animation. 
 

 
 

 
 

   

 
 

 
 
 

Step 7: Defining Application Language 
Language commands are used to make logic calculations that you do not want the PLC to 
perform. Language is written and implemented according to If and Then conditions. For 
example: 
IF: @FLAG =1 
THEN: REPORT "Shift" 
Some examples of Application Language commands include: 

o     Starting and stopping a process. 
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o     Loading a recipe. 
o     Writing to a tag value based on another tag value. 
o     Writing to a file or printer. 

Note:     For further details on Language see Chapter 30, Application Language. 
 

 
 

 
 

   

 
 

 
 
 

Step 8: Testing the Application 
At this stage of the design process, it is recommended that you test your application to 
check your image, alarm, tag and block definitions. 
After completing the test and implementing the necessary changes, you can continue to 
define your reports, charts, recipes and fine tune the application. 

 
 

 

 
   
 
 
 
 

Step 9: Defining Charts, Reports and Recipes 

Defining Charts 
Charts (see Chapter 26, Charts) provide graphical views of past and current tag values. 
You can use charts to follow a trend or compare values. You can define up to 16 tags on a 
single chart.  
When defining a chart, it is possible to: 

o     Define a unique color to each chart that is also used by the scales of the chart.  
o     Determine that charts show online or historical activities. 

Defining Reports 
You can define reports (see Chapter 34, Reports) for different users such as: operators, 
engineers, and managers. Make sure that each report includes the required information for 
the designated user.  
Reports can be: 
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o     Triggered in the application language. 
o     Written to a file. 
o     Sent directly to the printer. 

   When designing reports, it is possible to: 
o     Place fields in different positions and include any text, such as a header or short 

explanation at the end of the report. The fields can represent runtime values and a 
number of calculations performed on the historical tag values, such as averages, 
integrals, sums and more. 

o     Choose the range calculation, such as start day, start time, end day and end 
time.  

o     Define compound fields that are based on two other fields according to a 
specific formula. Multiple fields allow you to receive a value based on a group of 
other fields. 

Defining Recipes 
Recipes are specified sets of tag values that you can store for future use.  
When defining recipes, remember that: 

o     Each recipe must belong to a model that includes tags for certain processes or 
production modes. The recipe uses the tags in the model to which it belongs, but 
can also include tags that are not defined in the model. 

o     Each model and recipe has a unique name. 
o     The same tag can belong to more than one recipe.  
o     You can save the current values of any tags at any time as a recipe. This means 

that at the end of a process, you can save its values as a recipe and reload the 
recipe when the process is resumed. 

Note:     For further details see Chapter 32, Recipes. 
 
 

 

 
   
 
 
 
 

Step 10: Fine-Tuning the Application 
Once you have completed these steps, it is recommended to check all your definitions. 
Use the Single Tag Value and:  

o    Activate system language commands. 
o    Initiate dynamic behavior in an image. 
o    Activate reports. 
o    Check alarms.  

   Once you are satisfied with the results, fine-tune your entire application, by:  
o    Adding users to the user groups. 
o    Saving layouts that can be loaded upon login. 
o    Setting the menus that will be displayed for the different user groups. 
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Shutting Down 

 
 
 
 
 

Shutting Down 
This section describes how to logout and how to exit the system. 

Logout 
After initiating logout, you will not have access to the system until you login again. 

o To logout: 
Click the Logout icon button in the Quick Access Bar.  

Exiting the Application 
You can exit the system from the Quick Access Bar or from the Application Studio. 

o To exit the application: 
Click the Exit button in the Quick Access Bar.  
Or, 
From the File menu in the Application Studio, select Exit. 
  

 
 

 
 

   
 
 
 
 

Operator / Logout 
Select this dialog box to log out of the system.  
After you select this item, you will no longer have access to the Application, until you log in 
again. 
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Logout 
  
Press the Logout icon from the Quick Access Bar to close the application. 

 
 

 
 

   

Other Topics 

 
 
 
 
 

Default values in the Application for different countries: 
  
Country Date Style   Date Separator
USA MMDDYY / (slash) 
Japan YYMMDD / (slash) 
Netherlands DDMMYY / (dash) 
Denmark DDMMYY / (dash) 
Germany DDMMYY . (dot) 
Austria DDMMYY . (dot) 
Russia DDMMYY . (dot) 
All others DDMMYY / (slash) 
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Load Events Summary 
  
Press the Load Event Summary icon from the Quick Access Bar to load an Event 
Summary file (*.ann). 

 
 

 

 
   
 
 
 
 

Load Chart 
  
Press the Load Chart icon from the Quick Access Bar to load a chart file. (*.chr) 

 
 

 

 
   
 
 
 
 

File / Load 
Select this item to open an existing window layout. 
  
If you select this item when a layout is already loaded, you will be prompted to verify 
whether you want to save or discard the existing layout. If you then want to proceed, all 
windows on the screen will be closed, and a new layout will be started.  
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Load Image 
  
Press the LOAD IMAGE from the Quick Access Bar to load an image file. (*.vim) 

 
 

 

 
   
 
 
 
 

Load Layout 
  
Press the Load LAYOUT icon from theQuick Access Bar to load a layout file. (*.lay) 

 
 

 
 

   

 
 
 

 
 

Load History Viewer 
  
Press the Load History Viewer icon from the Quick Access Bar to load an History Viewer 
file. (*.anl) 
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Load Recipe 
  
Press the Load RECIPE icon from the Application's Quick Access Bar to load a recipe file.  

 
 

 

 
   
 
 
 
 

Show or hide done bar 
  
Select this option to show a background processing dialog box when large tasks such as 
loading a large image are being executed. 

fault: YES 
 
 

  
De
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About this chapter: 
This chapter describes the Application Studio, which is the operational framework of the 
system. 
Overview describes how to open and exit the Application Studio and its components. 
Modules describes the various application container icons. 
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Defining System Options discusses system options and how to modify the default 
application file path. 
Multi Language Support describes how to define multi-language support in an 
application. 
Layouts describes how to capture and save layouts and how to assign them to users. 
Object Oriented Model describes a new way to organize and access data. 
 
 
 
 

 
 

 
 

   

Overview 

 
 
 
 
 

Overview 
The Application Studio is opened from the Quick Access bar that is displayed when the 
application is accessed. The Application Studio has an explorer-like interface and offers full 
control and access to all parts of the system during application development. The interface 
has two panes:  
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o     All Containers 
o     Control Panel  

The Application Studio window also contains: 
o     A menu bar through which you can access application operational menus.  
o     A toolbar that enables quick access to the Application Studio’s most frequently 

used functions. 
o     A status bar showing the number of tags and alarms in the application.  

Note:     The status bar will not be displayed in the Events Summary when in the Window 
Attributes dialog box the Size Border option is unchecked. 
Toolbar 

     Open application  

     Save application 

     Add Tag 

     Add Alarm Definition 

     New HTML file  

     New Events Summary Profile  
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     New Trend Profile  

     Capture Layout 

     New Image 

     New Events Summary  

     New Chart  

     New History Viewer  

     New Recipe  

     New Report  

     Help 

 
 
 

 
 

   

 
 

 
 
 

Studio / ToolBar 
The Application Studio Toolbar is located under the Studio's Main menu. It includes 
shortcuts to menu items found in the Containers list. From this Toolbar you can access 
such items as the Application Image Windows, Save an application, open Chart and 
History Viewer Windows and so on.  
The Studio Toolbar consists of the following menu shortcuts. 

o Open Image File (*.vim) 
o Save your application (*.wpj ) 
o Open New Tag Definition dialog 
o Open New Alarm Definition dialog 
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ary Profile 

ialog 
 with its toolbars 

Window 

oftware version of the Application Studio 

 

o Opens a New HTML File 
o Open a New Events Summ
o Open a New Trend Profile 
o Open the Capture Layout d
o Open the Image Window together
o Open New Events Summary Window 
o Open New Chart Window 
o Open New History Viewer 
o Open New Recipe Dialog 
o Open New Report Dialog  
o Display the copyright and s
o Access to Application's Online help topics 

 

 
 

   

 

 

All Containers Section 
isplays a hierarchical structure (tree) of the containers from 

 

ment lists all the users and groups defined in a project. This 
iven 

o cation contains the elements that are used to publish an application, 

d 

Rig cl a container opens a popup menu that displays related options. For 
dd 

 contents is 

 

 
 

The All Containers pane d
which an application is built. Containers can be thought of as the building blocks of the
application. The tree is made up of four main folders of containers with the current 
application as its root. 

o    User Manage
module also defines the user's access permission and level. Access can be g
per user, group and team. Backup users can also be defined. User Management 
also enables the System Integrator to create a user timetable and schedule 
workplans.  
   Web Appli
such as HTML pages for the Image, Events Summary Profile, and Trend Profiles. 

o    Files contain the elements that are stored as files, such as: Images, Events 
Summaries, Charts, History Viewer, Model Recipes, Layouts and Reports. 

o    Objects holding the elements that are stored as objects, such as: Tags an
Alarms. 

ht icking on 
example, right-clicking on Alarms displays a popup menu with the following options: A
Alarm, Add Level, Modify Level, Import Alarms, Export Alarms and Properties. 
When a container is selected in the All Containers section on the left, a list of its
displayed in the List Zone on the right. For example when Alarms is selected in the All 



Chapter 5 Getting to Know the Application Studio 

Containers list, a list of all the alarms in the application is displayed in the List of Alarms, as 

shown below.  
All lists, for example the List of Alarms share the following common features: 

o    Right clicking anywhere in the list displays a popup menu with context sensitive 
options.  

o    Clicking on a column header sorts the list within the column. The information for 
each list is displayed under columns that are relevant to the list. 

o    A number/character written with an * means filter according to the character and 
a number of additional characters. 
For example, 1* will show the following 1,12, 122, 1A etc. 

o    A number/character written with an ? means filter according to the character and 
an additional character. 
For example, 1? will show the following 1,12, 13, 1A etc. 

o    A list can be duplicated in a separate window by right clicking in the list window, 
pointing to View and selecting Duplicate from the popup menu. A list can be 
duplicated only once. For example, the List of Alarms. 
A list can be customized by right clicking in the list window, pointing to View and 
selecting Settings from the popup menu. A dialog box is displayed in which you 
can set the order and the type of fields to be displayed in the List Zone. For 
example, the List of Alarms dialog box.  
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To specify the columns to be displayed in the List of Alarms, click the checkbox next to a 
column name to select it. The following columns are available: 

o    Alarm Expression 
o    Text 
o    Family 
o    Zone 
o    Severity 

You can determine the order by which the columns appear in the Application Studio by 
selecting a column and activating the Move Up or Move Down buttons. 
You can select all the columns by activating the Select All button, and deselect them by 
activating the Deselect All button. Clicking the Default button selects all the columns.  

 
 

 

 
   
 
 
 
 

This is a list tree that represents the various elements of the Application. The containers 
Tree area is made of two main groups: Files and Objects. The root of the Tree is the 
station or application name. Whenever a tree item is selected, a list of the container's 
content is displayed in the right hand side of the Studio window. 
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The Control Panel 
The Control Panel, on the right of the Application Studio, is displayed when the root of the 
tree (the current application) is selected.  

  

 
Communication Drivers 

  

 
Printers 

  

 
Multiple Tags 

  

 
Single Tags 

  

 
DDE Blocks 

  

 
Application Setup 

  

 
Macros 
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Network 

  

 
Application Language 

  

 
WizPLC Development 

  

 
WizPLC Runtime 

  

 
Tag Filters 

  

 
Alarm Filters 

  

 
Printer Targets 

  

 
Zone Navigator 

  

 
Advanced Alarm Management 

  

 
Scheduler 

  

 
RePlay 
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Tag Generator 

  

 
Tag Mapper 

  

 
Network Application Update 

 
 
 

 
 

   

 
 

 
 
 

Menu Options 
The following menu options are available in the Application Studio 

Menu Option Action 

File New Open a new file 

  Open Open an existing file 

  New Application Display the New Application Wizard 

  Open Application Open an existing application 

  Save Save the current project 

  Save As Save the current project with a specific name 

  Exit Exit the application 
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View Toolbar Show/hide the toolbar 

  Status Bar Show/hide the status bar 

  Disable non-web 
features Disable non-web features in the Image 

  Window system 
menu 

Show/hide the icon in the top left corner of the 
image window. This overrides the System menu 
property of the image window attribute 

Design Add Object Add a new tag or new alarm 

  Communication 
Drivers 

View the drivers defined for the application, add a 
new driver, remove a driver and define driver 
properties 

  Macros Define macros 

  DDE Blocks 
View the DDE blocks defined for the application, 
add a new block, delete a block and define block 
properties 

  Application Setup Setup additional add-ons and programs to run 
while starting the application 

  Alarm Parameters This option enables you to define the Class Name 
and the user given Field Names to an alarm 

  Alarm Filter This option contains a list of all the alarm filters 
defined in the project 

  Printer Targets 

A combination of alarm filters and printers. When 
an alarm is issued it is channeled through the 
Alarm Filters according to predefined parameters 
and sent to the printer targeted for it  

  Zone Navigators 

The Zone Navigator is a global, multi-image zone 
navigation window that enables you to quickly and 
efficiently navigate through a list of zones defined 
in your application’s various image files  

  Language This is used to define the settings used in the 
application language. 

  Options This is used to configure options such as; WizPro, 
Paths and Printers. 
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  Authorization This option enables you to configure operator 
access to the application 

  
Advanced Alarm 
Management 
(AAM) 

There are two sub-menu options: 
AAM channels - enabling definition and 
configuration of the communication lines by AAM 
AAM pager services - displays a list of all installed 
drivers (drivers can be added). The parameters of 
each driver can be configured  

  Scheduler 
Configuration Where the Scheduler can be configured. 

Network 
Local Station and 
Network 
Properties 

Configure your computer as a SCADA or 
Hotbackup and set your network environment and 
establish application performance  

  Record Remote 
Data Record remote tags and alarms 

Tools Single Tag Assign an immediate value to a tag. This is useful 
for testing tag performance. 

  Multiple Tags Define multiple tags to optimize performance. 

  Add System Tags Assign an immediate value to a tag. This is useful 
for testing tag performance 

  Tag Generator Generate automatically tags in the tag database 

  Import Import a list of tags or a list of alarms 

  Export Export a list of tags or a list of alarms 

  Find Search for already existing tags and alarms. 

  Multi language 
Support Define language support 

  WizPLC 

This menu option is used to run the WizPLC 
program while the application is running. There are 
two modes, Development (for developers using the 
application) and Runtime. 
Tag export is available from this menu. 
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  Advanced Alarm 
Viewer 

Displays the number of alarms that have already 
been or that are being processed and how they are 
processed by AAM. 

  Application 
Upgrade 

Allows you to install new components after an 
upgrade of an application (installing a new version 
or a patch) 

  View Log File Click to open the Errors Log dialog box. 

Help Help Topics Displays Help topics 

  Tip of the Day Displays the Tip of the Day dialog box 

  About the Studio Displays information about the Application Studio  

: 
 
 

 
 

   

Modules 

 
 
 
 
 

Communication Drivers 
Communication drivers handle communications with external devices, such as PLCs, 
industrial instruments, remote computers and field buses. These drivers are separate 
program files, which are installed when installing the application. Communication driver file 
names have the format VPIWN??.DLL , in which ?? is the two or three-letter code of the 
driver. Since each communication driver is different, the driver information documentation 
should be consulted for specific communication driver details. 
You can define communication blocks to improve driver performance when working with 
large quantities of tags. These blocks enable you to transfer large blocks of information 
instead of individual data items.  
The first step in designing an application is to define the communication drivers and blocks. 
You then define the tags, which are control values monitored by the system. They are used 
as internal variables for: 

o     Calculations and display. 
o     Communication with PLC's to represent data from PLC memory or to send 

commands to PLC's.  
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Note:     In fast Pentium PCs with a 16550 UART (serial interface chip), Windows 2000 
default settings may cause communication errors on serial communication drivers. To 
overcome this problem, lower the buffer sizes on the UART in the following menu: 
Start/Setting/Control Panel/ System/Device Manager/Port/ Communication Port 1.4/Port 
Settings/Advanced. 
Use a trial and error method to reach the optimum setting. 
For further details read Chapter 8, Communication Drivers. 
 

 
 

 
 

   

 
 

 
 
 

Printers 
The Printers dialog box enables enhanced printing capabilities. Each printer added to a 
system can be set to print reports, alarms or both. In addition a definition can be made 
where many alarms are printed on a full page or whether only one alarm is printed on each 
page. Page orientation and font can also be defined. Alarm properties that are printed can 
also be set together with different colors, text and background. 
For further details read Chapter 16, Alarm Filters, Printers & Printer Targets. 
 

 
 

 
 

   

 
 
 

 
 

Multiple Tags 
The Multiple Tags feature can be used to optimize performance and enhance functionality. 
This utility enables you to adjust system parameters and establish the correct environment 
for working with the application. 
Multiple Tags display tag lists which enable you to read and write tag values, as well as 
change several tag attributes. In addition, Multiple Tags provides options to save the tag 
list as a recipe or a tag list file.  
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Tag list files are ASCII files that contain lists of tags and their attributes. These files have 
the extension .GLS and can be used in the application to generate tag lists in the tag 
definition procedure. For further details read Chapter 12, Multiple Tags. 
 

 
 

 
 

   

 
 

 
 
 

Single Tags 
The Single Tag dialog box is used to assign an immediate value to a specific tag.  
In the Single Tag dialog box parameters such as the Station Name, Tag Name, 
Description, Current Value, New Value and Suggested Value slider are used to simulate 
the tag's value. 
For further details refer to Chapter 9, Tags. 
 

 
 

 
 

   

 
 
 

 
 

DDE Blocks 
The DDE Client Block enables the system to receive many tag values from the server in 
one update message. This improves the communication between the application and the 
DDE server. The DDE Client Block is built from a matrix of rows and columns in which 
each cell of the matrix contains the value of one data item. 
Note:     Not all programs support block messages. Check the documentation of the DDE 
server application. 
A common use for DDE client blocks is a setup in which a DDE server simultaneously 
updates a block of items that make up a recipe. The system, the client, receives all the 
items, and the tag values are changed immediately.  
Define DDE client blocks only if data items in the server change simultaneously (within 
milliseconds). The system receives the whole block of data whenever one of the items in 
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the block changes. Therefore, if items change one at a time, the application will receive a 
whole block of values, many of which have not changed. 
For further details refer to Chapter 38, Application DDE Support. 
 

 
 

 
 

   

 
 

 
 
 

Macros 
Macros are shortcuts that can be used to execute predefined actions, commands, or 
programs whenever designated keys or key combinations are activated. This enhances 
overall application functionality and saves you the time and effort of having to execute 
application operations in several stages. 
You can define up to 65 535 application macros. Application macros are defined by the 
following attributes: 

o     Accelerator keys that invoke the macros (F1 to F12, A to Z, ALT alone, or in 
combination with Ctrl, Shift, and others) 

o     A unique name and description  
o     Authorization groups  
o     Confirm before Execute option  

Application macros include the following types: 
o     Actions 
o     Commands 
o     Sequence 
o     DDE Command Macros 
o     Trigger Macros (described in the Triggers section of Chapter 21, Image 

Editor). 
Macros will only be executed when: 
An application window, including the Application Studio, or the Single Tag Input dialog box 
is the active window. If any other window is active the macro will not be executed. 
If the application is used locally (for example, if a trigger macros is invoked through a web 
browser) it will not be executed.  
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Application Network 
Application stations operating in a network environment can share objects, such as alarms 
and tags. Direct access to remote tags and alarms can be implemented through a simple 
station definition procedure. Once the station is defined to support application network 
activities, any operation involving tags and alarms on a local station can include remote 
tags and alarms as well. 
The application network system operates in a manner similar to other network systems. 
The application kernel, handles all network operations and transfers data from/to local and 
remote stations.  
The application supports various network components, including Novell Requester, LAN 
Server and TCP/IP. 
Installation in a TCP/IP environment enables application workstations on one network to 
communicate with application stations on other networks. Through TCP/IP, the application 
Network offers a complete enterprise-wide solution. 
For further details refer to Chapter 19, The Application Network. 
 

 
 

 
 

   

 
 
 

 
 

Application Language 
Note:    This feature is not available on the web. 
Application Language is a simple but powerful tool used to create programs that can 
enhance the capabilities of control equipment working with the application, such as PLCs, 
and establish the connectivity interface between this application and external computer 
applications. 
Note:    Application Language runs on your local PC, it is not supported on the Web. 
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WizPLC Development and Runtime 
WizPLC enables you to write control logic programming. There are two modes: 

o    Development which is a programming, monitoring and debugging tool, 
integrated with the application SCADA system and enables project management 

o    Runtime that runs compiled code on a Windows NT real-time processor. It 
communicates with I/Os and exchanges data with the application and WizPLC 
Development. 

For further details refer to the WizPLC manual. 
 
 

 
 

   

 
 
 

 
 

Tag Filters 
The Tag Filter module is used to filter, view and manage a list of tags and their status 
(locked/unlocked) in the application. This is useful for the development and maintenance of 
an application.  
The Tag Filters List is stored in the application's TFM.XML filter that is created in the .\docs 
directory (or another appropriate directory of the application). 
When accessed through Java applets the Tag Filters List can be defined/modified/viewed 
in the Image module during runtime. Up to 10 tag filters can be selected simultaneously. 
Tags can be sorted according to: 

o     Source 
o     PLC - tags associated with external devices and mapped on the external device 

variables. 
o     Dummy - tags representing internal variables used for a variety of calculations, 

control and other application related needs. 
o     Compound - tags which are linear calculations based on values of other tags. 
o     System - tags that are predefined and built to provide system status information 
o     Type 
o     Analog - tags that have numeric values represented in various formats. 
o     Digital - discrete logic tags that have a boolean value of True (1) or False (0). 
o     String - tags that are defined to receive alphanumeric strings. 
o     Locked - which filters only locked tags. A locked tag can be either analog, digital 

or string. 
For further information read Chapter 10, Tag Filter Module. 
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Alarm Filters 
ters alarms and reports before they are printed out or written to 

t when parameters defined in tag variants are not 

ther details refer to Chapter 16, Alarm Filters, Printers & Printer Targets. 

 

 

 
 

The Alarm Filter module fil
the Events Summary. Alarm filters are displayed in the Alarm Filters table and defined or 
modified in the Filter Properties dialog box. Filter properties can be updated, however the 
name of a filter cannot be changed.  
The Alarm Filter, filters the alarms sen
met.  
For fur
 

 

 
 

   

 

 

Printer Targets 
s a combination of alarm filters and printers. When an alarm is issued it is 

 

 
 

 

A Printer Target i
filtered according to predefined parameters and sent to the printer targeted for it. 
The Printer Target dialog box holds a list of all the printer targets that have been defined. 
Each printer target is identified by a unique name and description.  
For further details refer to Chapter 16, Alarm Filters, Printers & Printer Targets. 
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Zone Navigator 
or is a global, multi-image zone navigation window that enables you to 
ntly navigate through a list of zones defined in the application's various 

e 

 

 
 
 
 

The Zone Navigat
quickly and efficie
image files. A number of navigators each of which can contain a number of zones from on
or more different image files can be defined in the Zone Navigator module. 
For further details refer to Zone Navigator in Chapter 21, Image Editor. 
 

 

 
 

   

 

 
 

Advanced Alarm Management 

larm Management communication lines (TAPI modem or modem connected to 

ble: 
 modem connected to COM port). 

Dur  anced Alarm Viewer shows statistics and an Events 

tails refer to Chapter 17, Advanced Alarm Management. 

er Services module enables definition of a list of paging drivers and Call 
er 

Chapter 17, Advanced Alarm Management. 
 

 

 

Channels 
Advanced A
COM port) are defined in the Channels dialog box where channels can be added, 
removed, deactivated or be modified. 
The following configurations are availa

o     Channels Setup (Tapi modem or
o     Pager Services Setup. 
o     Vocal Server Setup. 
ing runtime the real time Adv

Summary. 
For further de

AAM Pager 
The AAM Pag
Management parameters. New drivers can be added, existing drivers removed and driv
setup can be configured. 
For further details refer to 
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Scheduler 
 based Scheduler enables you to easily create daily or weekly task orientated 

 to create unlimited tasks, 

apter 31, Scheduler. 

 

 
 
 
 

The Internet
schedules remotely. Accessed through an Internet browser or by clicking on an icon, the 
Scheduler is extremely user friendly, efficient and economical. 
Being both task and time orientated the Scheduler can be used
actions and states. Tasks can be modified, enabled/disabled and have many states such 
as On/Off attached to them. An unlimited number of actions, which are basic operations, 
can be attached to each task.  
For further information read Ch
 

 

 
 

   

 

 

RePlay  
ay module is used to view a graphical display of previous history tag values in 

 

ry defined during Tag Definition can be used. 

 

 
 

 

The RePl
images. The application reads and displays the tag values from the application's history. 
The RePlay module is activated from the Application Studio Control Panel. An application
image cluster controls the RePlay itself.  
Note:     Only tags that have Write to Histo
For further details see Chapter 23, RePlay Module. 
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Tag Mapper 
ile of tags and tag values that can be used to considerably 

able 

 values are directed to target tags. More than 

o ce tag.  
A si e  same target tags 

 tag the user must first create the 
e 

ble only at a specific time. The table that is used is defined by 

er of tags can be mapped. The Tag Mapper is bidirectional. For further 

 

The Tag Mapper is a data f
reduce workload during application creation. Tag values of tags held in a Tag Mapper t
are mapped by the Tag Mapper into a list of other tags.  
There are two types of Tag Mapper tags: 

o     Source: These are tags whose
one source tag can be pointed to the same target tag. 
    Target: This tag type receives the values of the sour

ngl  image can be used to display different source tags values in the
(depending on the index value entered by the user).  
To define the source tags that update a specific target
tables used by the Tag Mapper. Each table has a unique Id (Index) that is later used in th
image as the index value.  
Each image can use one ta
the index value.  
An unlimited numb
details see Chapter 11, Tag Mapper. 
 

 

 
 

   

 

 

Tag Generator 
tor module is an engineering tool designed to quickly and easily generate 

communication drivers with network 
 will 

ing Wizcon PLC or dummy tags into 
, 

fine the information required for the tag generation, 

to be connected to 

 on Chapter 13, Tag Generator Module. 

 
 

 

The Tag Genera
or update tags in the NovaPro Open database.  
This tool requires the application to be based on 
browsing capabilities such as BACnet or OPC drivers. Future NovaPro Open versions
support additional drivers with browsing features. 
The Tag Generator allows you to update any exist
adressed PLC tags through a mapping process. If tags do not exist in Wizcon database
the Tag Generator will create them. 
A mapping rules interface helps to de
such as, tag record settings, address format, prefix or suffix related to the automated tag 
naming. All information related to the last used mapping rules is stored in a setup file 
(WizTagGen.ini) and reloaded at the next use of the Tag Generator. 
In order to begin the tag generation, the communication drivers need 
the related devices. 
Additional information
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Network Application Update 
e module enables an application developer to quickly and 

 

 

 

 
 

The Network Application Updat
easily update far station application files remotely. To the station operator this action is 
invisible. However a record of the update will appear in the station's error.dat file.  
An unlimited number of network stations using the application can be defined in the
Remote Update Settings dialog box. This dialog box, by default, holds all the files within 
the application. For further details see Chapter 36, Network Application Update. 
 

 

 
 

   

Defining System 
Options 

 

Defining System Options 
ion paths and printers options are implemented online.  

 

 
 
 
 

Note:    Changes to applicat
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Application Setup 
The Application Setup dialog box enables you to set up or modify the additional add-ons 
and programs you wish to run when starting the application.  

o To open the Application Setup dialog box: 
In the Control panel of the Application Studio, double-click the Communication Driver 

 icon. 
Or,  
From the Design menu, select Application Setup. The Application Setup dialog box is 
displayed.  
 
 

 
 
The following options are available: 

Add Sets up the additional program you wish to run 
while starting the system.  

Properties    Displays the properties of the selected 
program.  

Remove    Removes the selected program from the list of 
programs. 
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Move up 

This enables the user to move a program file 
up in the list box. Highlight the program in the 
list box you wish to move up one line and 
press the Move Up button. 

Move down 

This enables the user to move a program file 
down in the list box. Highlight the program in 
the list box you wish to move one line and 
press Move Down button. 

Advanced 
Open a dialog box " Advanced Setting" that 
specifies that the default Application Language 
is run. 

 
Note:     When adding a list of programs, write the list in the order that you want them to 
run. Do not place a program that should run before the application interface following a 
program that should run after it. 

o To setup a program you wish to run while starting: 
Click the Add button in the Application Setup dialog box. The Programs Specification 
dialog box is displayed:  

   

 
 
The following options are available: 

Program to Run 
Specifies the full path of the program. Click the 
Browse button to access the DDE server and 
client settings (Bin/WizDDEs/c.exe). 
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Parameters Specifies the program parameters, if there are 
any. 

Open a Window    

Opens the program in a window. The following 
window styles are available:  
Default: Opens the window in a default size. 
Minimize: Opens the window minimized. 
Maximize: Opens the window maximized. 

Start the Program 
before User Login 

Specifies whether to run the user program before 
or after user login.  

Wait for the 
program to end 
before running the 
next program 

Specifies whether to wait until the current program 
will end before running the next program. 

o To select the setting environment for an application: 
Click the Advanced button in the Application Setup dialog box. The Advanced Settings 
dialog box is displayed:  

  
The following options are available: 

Run Application Language Specifies that the default Language runs. 

Run WizPLC Runtime Specifies that WizPLC runs. 

Select Application Browse to select an application. 
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WizPro Options 
WizPro is the application programming interface kernel. It provides mechanisms through 
which application PLC and external device communication can be implemented, maintains 
an on-line database, and services all inter-process requests and messages. 

o To set WizPro options: 
From the Design menu, point to Options and select WizPro from the popup menu. The Set 
WizPro Options dialog box is displayed: 
 

 
 
The following options are available: 

Tag 
Sampling    

Enables the WizPro tag sampling mechanism. Tags are 
sampled according to the rate defined for the tag in the Analog 
Tag Definition dialog box or the Digital Tag Definition dialog 
box as described in the Defining Tags section in Chapter 9, 
Tags. Tag sampling will not occur if this option is deselected.  

Write to HIS 
File    

Enables the recording mechanism to record sampled tags in 
historical files. Historical sampling will not occur if this option is 
deselected. 

Alarm 
Module    

Enables WizPro to generate alarms based on the condition 
defined in the alarm module. 

Collapse 
Alarms    

Enables WizPro to collapse alarms in the Events Summary. 
This means that repeated identical alarms will be displayed on 
a single line in the Events Summary. If this option is not 
selected, each alarm will be displayed on a separate line until 
the condition defined for the alarm ceases to exist. 
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Enable Multi-
language 
Support 

Enables the Multi-language support in Wizcon. 

Perform 
Compress on 
Next Restart  

Physically removes all deleted tags and alarms from the 
system's database and renumbers their ID numbers. When 
tags or alarms are removed from the application, they are not 
physically deleted, but only marked as deleted so as not to 
affect the internal ID numbers of the remaining tags and 
alarms. Enable this option in applications where it is necessary 
for tags and alarms to have sequential ID numbers.  

Note:     
If the ID number of tags or alarms changes, the data in the history files may not be 
processed. Therefore, it is strongly recommended that you keep a backup of the tag 
definition files (table tags and alarms in Wizdata MDB) deleting any tags from the 
database. 
If the ID number of tags changes save the application’s Language commands again in the 
application Language Definitions dialog box, as described in Chapter 30, Application 
Language. This is necessary so that the commands will correspond to the new, internal 
tag IDs. 
Deleted tags count as defined tags when the application checks that the number of defined 
tags is less than the amount allowed by the security key.  
 

 
 

 
 

   

 
 

 
 
 

Changing Default File Paths 
Default paths can be defined for each file type to enable the system to keep track of files 
and their locations. 

o To define file paths: 
From the Design menu, point to Options and select Paths from the popup menu. The Set 
Default Paths dialog box is displayed:  
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The dialog box displays the application file types with their current path specifications. 
Note:    You cannot use this dialog box to change the user path and the application path. If 
you want to do this, you must modify the Wizcfg.dat file directly. 

o To change the path of a specific file type: 
1.    Click in the relevant line and either type in the new path or click the Browse button to 
open the Browse for Folder dialog box where you can search for the correct file path. A 
path must be specified with a terminating backslash (\). 
2.    Click Save to confirm the new path locations. 
Note:     Restart the application for changes to take effect. It is not recommended to 
change the path of Users, Macros, Classes, Web Applications, Event Summary Profiles, 
Pictures and Trends. 
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Set Default Paths     
In this dialog box, you can specify the default path name locations of Application design 
and operational elements. To enable the system to keep track of files and their locations 
you can define paths for each file type. 
In this dialog box, all the file types are listed with their current path specifications. to 
change the path of a specific file type, simply click in the line that you want to change, and 
specify the new path. 
  
To set the default path:
1. Select the Design Menu from the Studio Application 
2. Select the Option menu 
3. Select the Paths option. 
 The elements appear in the left column, the path names are entered in the middle column, 
and the filename format of the element appears in the right column.  
 Note that the Application item refers to any application component that is not represented 
in this dialog box. A path must be specified with a terminating backslash.  
  
For example, .\ refers to the current directory, and img\ refers to the image subdirectory in 
the current directory. Note that the LRM path (for alarm files) will not be changed on-line.  
  
To cause the Application to save alarm files in a new path, you must first exit the 
Application and then restart Application again.  

 
 

 

 
   
 
 
 
 

Design / Options / Paths    
Select the Paths item to specify the path names of Application files. 

 
 

 
 

   

Multi Language Support 
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Multi Language Support 
Using Multi-language support, the tag description, alarm text and the text field in an image 
can be developed in one language and translated to another. During runtime, a user can 
choose the required language.  
Support for different languages is dependent on the operating system and its support for 
that language. Far Eastern languages, such as Japanese, are supported in the application 
only in their native operating system. Latin languages are supported in any operating 
system. 
All texts for specific languages are kept in files. The size of this file is proportional to the 
size of the application. For small applications, this can take as much as 10 kbyte. A larger 
application can take as much as several mbytes. 

 
 

 
 

   
 
 
 
 

Multilanguage Support 
Note: Not applicable on the Web. 
The applications enable the user to switch online, from one language to another, in the 
application level. Using this feature, application can be developed in one language, then all 
texts can be translated to another language, and at run time the user can choose the 
language he wants to use. A full list of application strings, such as tag descriptions or 
image texts, that are ready for translation will be included in the documentation. 
Support for different languages is dependent on the operating system and its support for 
that language. Far eastern languages such as Japanese are supported only on their native 
operating system. Latin Languages are supported on any operating system. 
All texts for specific languages are kept in files. The size of the file is proportional to the 
size of the application. For small application this can take as much as 10k byte, while for a 
very larger application can take as much as several Mega bytes. 
If you have a multi language application with strings in two or more languages, it is 
possible that not all the strings will be present in all languages after importing. If string is 
absent in selected language, the missing string will appear on the screen in the following 
format: 
<??string ID?> 
Where string ID is number, that is <??0000000005?> etc. 
 
Operating procedures, when using Multilanguage for the first time: 
To work with the Multilanguage feature for the first time you must first set language 
definition: 

1. Select the menu item Export language. Path : Studio menu \ [application 
name]Tools \ Multilanguage \ Export Language. 
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2. In the Export field dialog box write the name of the text file you wish to create for 
the language strings used for translation. 

3. You must then import this text file. Select the Multilanguage \ Import path. Select 
the available language from the list. In the Import file field enter the name of the 
text file that contains the language string. (The file you created in the export field). 

Note that the above procedure is for first time user of Multilanguage 
 
To set the language, follow the next path 
[application name]Tool \ Multi language \ Select Language. 
 
Loading files created in another application 
If you try to load image or [application name]GATES.DAT file created in another 
application, Multilanguage support module may discover that the file was not created in the 
current application. In this case we have two situations: 

• Current application without language definition, work with default. 
• Current application is multilanguage application with two or more defined 

application languages. 
In case of default, multilanguage support module will attach the loaded file to the current 
application.  
In case of multilanguage application, the Language Database Selection dialog box 
appears and user can browse through the language database directory. When finding the 
directory from the where the file was copied or loaded, press "OK" button to continue 
loading. If selected database does not match the loaded file, the language database 
selection dialog will reappear. If you do not want or do not know path, you can select one 
of the two possibilities - press the "Ignore" button to attach loaded file to the current 
language database, or press the "cancel" button to prevent file loading.  

 
 

 
 

   

 
 
 

 
 

MultiLanguage / Export 
Note: The multilanguage feature is not supported on the Web. 
Use this dialog box to define the name of the text file you wish to create for the language 
string used for translation.  
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MultiLanguage / Import  
Note: The multilanguage feature is not supported on the Web. 
For first time procedure, use this dialog box to enter the name of the text file that contains 
the language string (The file which was created in the export field) 

 
 

 
 

   
 
 
 
 

MultiLanguage / Select 
 
Note: The multilanguage feature is not supported on the Web. 
Applications will enable the user to switch online, from one language to another, in the 
application level. Use this dialog to set the Language.  

 
 

 
 

   

 
 
 

 
 

Strings 
If you have a multi-language application with strings in two or more languages, it is 
possible that not all the strings will be present in all languages after import. If a string is 
absent in a selected language the missing string will appear on the screen in the following 
format: 
<??string ID?> 
Where the string ID is a number, such as <??0000000005?>. 
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Defining Multi-language Support 
 multi-language support in an application. The 

ro Options dialog box (see 

uage strings into a file. 
ation was written and import the file into the 

e file with a text editor, translate the language strings into the required 

he translated file into the application. 
 to 

1.   o , point to Multi-language Support and select Export Language 

This section describes how to define
following steps need to be repeated for each language used.  
First of all, you must check if the feature is enabled in the Wizp
WizPro Options) 
1.    Export the lang
2.    Select the language in which the applic
application. 
3.    Open th
language and save the file with a new name. 
4.    Select the required language and import t
After you have defined multi-language support for a language, you can then select it
determine that the application texts will appear in that language. 

o To export a file: 
 Fr m the Tools menu

from the popup menu. The Export Language dialog box is displayed: 

  
 
2.    In the Export to file field, enter the name of the text file you wish to create for the 

ve your definitions and close the dialog box. It is recommended to save 

n defined in your application, the last 

1.   o  to Multi-language Support and select Import Language 

language strings. 
3.    Click OK to sa
the file in the same directory as your application. 
Note:     If multi-language support has already bee
language you imported will appear in the Export language field.  

o To import the text file:  
 Fr m the Tools menu, point

from the popup menu. The Import Language dialog box is displayed: 

  
 
2.    Click in the Import Language field to display a list of available languages. Select the 

 of the text file that contains the language 

rs: 

language in which the application was written. 
3.    In the Import from file field, enter the name
string (this is the file you created in the Export to file field in the Export Language dialog 
box on the previous page), or click Browse to locate the file. 
4.    Click OK to import the file. The following message appea
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5.    Click Yes to establish a link between the language and its file. 

1.   sing any text editor.  
d language and save the file as a new 

ccess the Explorer and remove the extension (.txt) from the file. 
ialog box and enter 

 file that contains the translated 

. 

 

o To translate the file: 
 Open the language file u

2.    Translate the language strings into the require
file.  
3.    A
4.    Follow step 1 on the previous page to open the Import Language d
the required language in the Import language field.  
5.    In the Import from file field, enter the name of the
language strings, or click Browse and locate the file. 
6.    Click OK to import the file. A message box opens
7.    Click Yes. The language is now supported. 
 

 

 
 

   

 

 

Selecting a Language 
ulti-language support, you can select the language in which you 

Fro h uage Support and select Select Language from 

 
 

 

After you have defined m
want the application to display the application texts.  

o To set a language:  
m t e Tools menu, point to Multi-Lang

the popup menu. The Select Language dialog box is displayed: 

  
 
1.    Click in the Select the language for the application field, and select the required 
language from the list of supported languages. 
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are 

ction. For example, to display the alarms 

Text 

 
 

2.    Click OK to save your definitions and close the dialog box. The language strings 
now displayed in the selected language. 
Note:     The language strings are displayed in another language only after refreshing the 
required container in the All Containers se
language strings in the selected language, click the + sign to the left of Objects. The 
objects list collapses and the + changes to a -. Click the - sign to expand the objects list 
and then click Alarms to display the List of Alarms. The alarm text is displayed in the 
column of the List of Alarms in the selected language. 
 

 
 

   

 
 

 
 

Loading System Files Created in Another System Application 
If you try to load (import) an image, or the wizgates.dat and alerts.dat file created in 

 that the file was not 

rt module will attach the 

nguage database selection dialog box is 

 

 

another application, the multi language support module may detect
created in the current application. The following may occur: 

o     If a language has not been defined for the application, the application will work 
with the default language. The multi-language suppo
loaded file to the current application. 

o     If the current application is a multi-language application with two or more 
defined application languages, the La
displayed: 

 
 
If the selected database does not match the loaded file, the Language Database Selection 

ialog box will reappear. You can either click Ignore to attach the loaded file to the current 

 
 

d
language database, or click Cancel to prevent file loading. 
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Layouts 
Note:    This feature is not available on the web. 
A layout is the position of an open window in an application. This section describes how to 

d save layouts and how to assign them to users.  
e user logs on, the windows included in 

as described below. 

 
 

Layouts 

 
 

capture an
You can assign a layout to a user, so that when th
the layout will automatically be displayed in the position in which they were saved.  
You can also close all the open windows in your application, 
Capturing layouts, assigning them to users and user log on is for local use only. Layouts 
are not used when interacting with the application through a browser. 

 

   
 
 
 
 

Capturing and Saving Layouts 
You can open Image, Events Summaries, History Viewers and Chart windows, position 
them on your screen and save their position.  

ts settings, can be saved for later use, this is done by the 

 
 

 

Layout / Capture Layout 
Note: The Layout feature is not supported on the Web. 
  
Any current layout with all i
Capture layout option. 
  
To save a layout with its current name, select the Save item.  
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Saving Layouts (by Default) 
You can configure the layout property so that you are prompted to save the layout of any 

he application.  

om the popup menu. The Layouts 
Pro t

 
 

open windows before you exit t
o To save a layout by default: 

1.    Right-click Layouts and select Properties fr
per ies dialog box is displayed: 

  
 
2.    Select Prompt to save layout. When you exit the application you are prompted to save 

e current layout. This change can be implemented online. 

click Layouts and select 
Cap e pup menu. A standard Save As dialog box is displayed in which 

uired layout and select 
Loa a p menu.  

n Studio, right-click the layout you want to delete and 
sele D e popup menu. 

 
 

th
o To save a layout: 

In the All Containers section of the Application Section, right 
tur  Layout from the po

you can save the layout. The layout is displayed in the List of Layouts. 
o To add additional window positions to an existing layout:  

Specify the existing layout file name in the Save As dialog box. 
o To load a layout: 

In the List of Layouts in the Application Studio, right click the req
d L yout from the popu
o To delete a layout: 

In the List of Layouts in the Applicatio
ct elete Layout from th
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Assigning Layouts to Users 
When you have captured and saved a layout, you can assign it to a user, so that when the 
user logs in, the layout is automatically displayed on the screen. A layout is assigned to a 

odule. See Chapter 7, Security and User Management, 

.  
2.   l and select Modify from the popup menu. The User 

user in the User Management m
User Management - Overview. 

o To assign a layout to a user: 
1.    In the User Management container in the All Containers pane click Users. The List of 
Users opens in the Control Panel

 Se ect a user and then right click 
Properties: User dialog box opens.  
 

 
 
3.    In the Layout field click the arrow to open a dropdown list and select the relevant 
layout. The selected layout will be attached to the User and will open on the User's station. 

ote:     Users can also be assigned a layout when defining new users and following the 

 
 

N
instructions above. 
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Closing all Open Windows  
You can use the Close All windows feature to close all the windows open in your 
application. 

o To close all windows: 
ight click Layouts and select Close All windows from the 

 
 

 

In the All Containers section, r
popup menu. 

 
 

   

Object Oriented Model 

 
 
 
 

Object Oriented Model Presentation 
The Object Oriented Model provides a new way to organize and access data.  
It is introducing the notion of objects. 
An object is defined by its type. 

perties.  
er-defined 

). 

fined, built-in objects. So they are also 

st 

 

Object types are defined by a set of pro
These properties can be simple values like integers, strings, etc… or another us
object type, or a link to a tag (or alarm
 
Tags and alarms are objects too. They are prede
described with a set of properties: tag description, tag address, alarm text, alarm family, 
etc… 
 
When creating an object of a specified type, a new instance is created. This instance mu
be given a unique name. 
After, in order to use these objects, it is possible to address any instance and its properties 

ith a name. w
For example, you can now display a tag description in an image specifying: 
HEATER001.Description  
 
As another example, you can choose a tag for a chart specifying: 
Building01.Floor[0].ServiceRoom.AirConditionSupply 
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s. Tags or alarms are 
sibilities to the user without breaking 

bject Template
 
 

This notion of object is a layer above existing tag and alarm notion
still usable as before. This object layer brings new pos
legacy behaviour. 
 
Access Means
Description
O

 
 

   

 
 

 
 
 

Object Oriented Model Access means 
Creating and editing object types 

A new tab has been added in the studio to display objects and handle all related 

Th ain studio window: 
operations. 

is tab is accessible at the bottom of the m
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This view will display, on the left, a tree with all objects structures that are defined. A 
contextual menu on these tree items gives access to all object types related operations: 

• creating a new type 
• modifying an existing type 
• deleting an existing type 
• creating an object instance 

•  exporting object types 
• importing object types 

On the right side, object instances and property values are listed.  
This list is following the object type and property selected on the left tree. 
It is also possible to filter the list by instance name and property value. 
 
A contextual menu on these object instances gives access to the following functions: 

• renaming an object 
• changing a property value 
• deleting an object 

 

Using objects and properties 
When you want to use an object or a tag defined in an object, it is done in a very similar 
way as you did before when selecting a tag.  
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You can type a tag name, a full property name of an object or choose it with the object 
browser that is accessible when clicking on the […] button on the right. 
 

 
 
This opens the object property selector that allows quick and easy browsing and filtering of 
the objects available in the application: 

 
 
It is possible, if needed, to create a new object type, or a new object instance. You can 
also modify a property of an object. 
 
Depending on what’s requested, the object selector can eventually refuse your selection. It 
is typically the case when you can only choose a tag, or a specific tag type.  

 
 

 
 

   

122 



Chapter 5 Getting to Know the Application Studio 

 
 
 
 
 

Object Oriented Model Description 
Object types 

All object types have a name, a label and a set of properties.  
The name can contain only letters, numbers or underscore character. It cannot start with a 
number. 
It is not possible to use built-in type names like “tag”, “alarm” or “integer” or a name that is 
already used by a user-defined type. 
The label can contain a friendly name displayed to the operator to designate this type. It is 
free and can be empty. It can be changed or translated without any implication in the 
application’s behaviour. 
The list of properties is defining the structure of the type. There is no limit to the number of 
properties.  
 

 
 
It is possible to control the order of properties only during creation. This order affects only 
the display and input order. 
 

Object properties 
All object properties have a name, a label and a type. 
The name can contain only letters, numbers or underscore character. It cannot start with a 
number. 
Property names must be unique inside their type.  
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The label can contain a friendly name displayed to the operator to designate this property. 
It is free and can be empty. It can be changed or translated without any implication in the 
application’s behaviour. 
 
The type defines the nature of information that will be store in this property. 
It can be a simple predefined type: 

• a boolean value (also called “logical” or “digital”) 
• an integer value 
• a real value (floating point) 
• a string (limited to 255 characters) 
• a time  

 
 
… Or a built-in type: 

• a tag 
• an alarm 

The value of this property will be a link to an existing tag or alarm. 

 
 
… Or any other previously defined type. 
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Finally, it is possible to declare any property as an array. In this case the array size must 
be specified. An array property can be addressed with a numerical index from zero to the 
array size minus one. 
 

Object instances 
All object instances must have a unique name. All tags are considered as objects, so tag 
names cannot be used for new object names and vice-versa. Alarms have an automatically 
generated name based on their type, family and id that is always unique. 
Once created, it is not possible to change the type of an object. 
 

 
 
The name can contain only letters, numbers or underscore character. It can start with a 
number. 
It is possible to rename an object after creation. 
 
When an object is created, all properties are set to a default empty value. All user-defined 
type properties are created too. Tag and alarm properties of this new empty object are not 
linked to any tag or alarm. 
 

Restrictions 
Properties other than tags are not tags. It means they cannot be used in place of a tag 
because they do not support what tag does. For example: it is not possible to choose an 
integer property in a chart because no history is maintained for its value. 
 

Naming 
A full property name always starts with an object name (that can be a tag name): 
Building01  
 
If you want to point to the property named “OutdoorLight” of this building you must type 
it after a point: 
Building01.OutdoorLight  
 
This property is a tag. Since a tag is an object you can access to its description like this: 
Building01.OutdoorLight.Description  
 
If a property is an array you can access a specific array item with brackets like this: 
Building01.Floor[0].ServiceRoom.Number  
 

Networking 
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As for tags, objects of other stations are accessible if you start the name with a station 
name followed by colon: 
STATION04:Building01.Floor[0].ServiceRoom.AirConditionSupply 
 
Also note that the tag property of an object can only refer to tags on the same station. On 
the previous example it means that “AirConditionSupply” is always linked to a tag on 
STATION04.    
 

Exporting/importing object types definitions 
It is possible to export and import type definitions to easily exchange them between 
applications. 
 
In the object view of the studio, if you right-click on “User-defined types” in the type’s tree, 
you have access to a contextual menu that allows you to export all types to an xml file or to 
import the type definitions from an xml file. 
 
If you right-click on one type you will be able to export only the desired type (and any other 
that is used by its properties). 
 
If you import a file that contains a type definition that already exists in the application, it will 
be checked that the imported definition is compatible with the existing. If it’s not the case, 
an error will be displayed and the existing type is not modified. 
A type definition is compatible with another if all of its properties exist and if they both have 
the same type. 

 
 

 
 

   

 
 
 

 
 

Object Template 

Defining an object template 
To provide a way to create series of object with fewer inputs, an object template can be 
defined. 
 
An object template is based on a specific object type and is defined with two parts: 

• a set of parameters that will be prompted to the user for creation 
• a set of expression that will used these parameter values to assign value to object 

properties that are created  
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Parameters 
Parameters are the values that will be prompted to user for creation. 
As object properties, they can be boolean, integer, real, string or time. 
 

 
 
If a parameter is an integer, it can be defined as a “loop”. In this case the user will be able 
to define a range of values to create a set of objects. 
 
The parameters order is important. All parameters declared after a loop will be prompted to 
user for each iteration. That also means that loops are nested. 
 

Expressions 
Expressions are the values to put in the property value of the object that will be created. 
An expression can be a simple constant value like any number or any string. 
It can also be a reference to a parameter of the template. The syntax if the following:  
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%parameter_name% 
where “parameter_name” is the name of one of the parameters of the template. 
 
When the property is a string (or a tag name), the expression can be more complex and 
can contain several parameter references to build a full string. 
OUTDOORLIGHT_%Prefix%_%Counter% 
Here, “Prefix” as been declared as a string and “Counter” as an integer (that can be a 
loop). 
 

 
 
In case of integer parameters, it is possible to force the number of digits with this syntax: 
TAG_%Counter,3% 
This will produce strings like this: TAG_001, TAG_002, TAG_003, etc… 
 

Creation process 
The process of object creation when using object templates starts with parameter inputs: 
 
Example of string parameter input: 

 
 
Example of loop integer parameter input: 

 
 
Before creation, a preview is displayed in order to check values generated for all the 
different properties: 
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It is possible to confirm, to skip or to accept all creation. 
 
Once accepted, an empty object is created and all property values are then written in it. 
 

Specific case of tags 
If the tag name exists, the property will be linked to this tag. 
If not, the tag will be created. It is possible to define tag properties by expression, so that 
this tag will require minimal adjustment to be usable in the application. 

 
 

 
 

   

Other Topics 

 
 
 
 
 

Enables you to give the program's parameters if there are any. 
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Enables you to give the full path for the program to run 
 
 

 

 
   
 
 
 
 

Check this option if you want to run the user program before or after the Application 
interface 

 
 

 

 
   
 
 
 
 

Check this option if you want to wait that this program will end before running the 
next program 
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An option to open the program with a window. 
 
 

 

 
 

The studio is an Explorer like interface from which the application developer has full control 
and access to all parts of the application. 

 

  
 
 
 
 

 

 
 

   

 

 

m Application's Quick Access Bar to capture a layout 
 your image and save it. (*.lay) 

Note: Not applicable for the Web. 

 

 
 

 

Capture Layout 
APTURE LAYOUT icon froClick the C

in
  

 

 
 

 

 
 

s 

ist of the container's 
content is displayed in the right hand side of the Studio window. 

  
 
 

This is a list tree that represents the various elements of the application. The container
Tree area is made of two main groups: Files and Objects. The root of the Tree is the 
station or application name. Whenever a tree item is selected, a l
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plays icons that represent various elements of the application that do not appear 

in the tree list. These include: Application language definition, Communication Driver 
definition Single tag dialog, Multiple Tags utility and setting such as Authorization and 
Network. 

 
 

  

This is a zone located in the "Application studio" dialog box to the left of the Containers
tree. It dis

 

 
 

 
 
 
 

eating a New Application 
n using the Application Getting Started Wizard.  

  

Cr
You can create a new applicatio
  
To Create a New Application
1. Double-click on the Blank Application icon located in the Application Getting
Wizard. The Set Application dialog opens:  

 Started 

nd 

s 
reate your folder using Windows Explorer. 

ty. The application 
ill have to 

repeat the process.  
5. Click OK to save your choices. The Application Studio opens. 

 
 

 In this dialog, you provide two items for defining a new application: 
a) An application folder, in which files of your application will be located, a
b) A name of .wpj file in the folder, which will keep the details about the application. 
Note that the application’s name IS the name of this .wpj file. 
3. In the Application name field, type the name of your new application.  
4. Specify a new folder name and click on the Create button. This will be your application'
folder. You can also c
 Note: The folder you assign your new application should be emp
detects files from another application, an error message will appear and you w
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Creating a Template Application 
You can create a template application using the Getting Started Wizard. A template 
application is an application which is based on an existing application.  
To Create a Template Application
1. 1. Double-click on the Template Application icon located in the Getting Started Wizard. 

plate 

xisting 

 4. Click the Open button and the Set Application Dialog appears. 

ased on an existing one. 

tory, including all subdirectories. Therefore, if a 
subfolder of the template folder was assigned for the new application, Wizard will attempt 
to copy this subfolder as well. You cannot copy a folder unto itself because every subfolder 
of the application folder may be considered as a part of the application. Therefore, do not 
use a subdirectory as the target folder. 

 

1. 2. Double-click on the Template-based Application icon and the Choose Tem
Application dialog opens.  
1. 3. Select a template application by selecting a W.wpj file which represents an e
application.  
1.
1. 5. In the Set Application dialog give your application a name and set the folder. 
1. 6. Click OK and the Application Studio opens. You now can work on your new 
application which is b
  
When you have set the above information the application Wizard copies all contents of the 
template application into the new folder, renames the file in the new folder to the new 
application's name. 
Note: When the Getting Started Wizard copies a template application into a new one, it 
takes ALL contents of the template direc

 

 
 

   
 
 
 
 

A Layer is a specific part of an image used to provide a more detailed view of a 
particular section of the plant or facility. 
Each layer can be assigned its own scale range so the Elaborating Zoom can be used to 
view the layer in the specified range. 
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A Layout is a set of Application windows saved in a file. 
 
 

 

 
   
 
 
 
 

Layout / Close All Windows   
Note: The multilanguage feature is not supported on the Web. 
This option is used to clear all layouts from showing in the Window. 

 
 

 

 
   
 
 
 
 

Check this option to determine if the application will prompt you to save the layout 
when you exit the Application. 

 
 

 

   

 
 
 

 
 

 

Layout Properties 
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ote: Not applicable for the Web. 
hen you 

exit the Application. 
 
If this box is check then the layout will be saved when you exit the Application. 

 

N
This parameter determines if the Application will prompt you to save the layout w

 

 
 

   

 
 

 
 
 

Use this option to define the layout tuning parameters. 
  
Note: Not applicable for the Web. 

 
 

Layout Property 

 

 
 

 
 
 
 

 saved, loaded and selecting. 

mes for filing operations, the default layout path will always 
e used. The default path is defined in the Paths dialog box (Design/Option/Paths). 

 cause a specified layout to be loaded automatically whenever specific 

Capture Layout 

  

Layouts Overview  
Note: Not applicable for the Web. 
 
A window layout is a set of windows in the Studio Application saved in a file. Window 
layout can be
Layouts enable you to maintain continuous control of the plant. By saving a particular 
layout. You can ensure that specific window combination will be available whenever you 
need them. 
Each layout should be assigned a unique name for filing operations. Remember that 
whenever you specify layout na
b
Note that you can
operators log in to the system. 
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se, this is done by the 
apture layout option. 

ith its current name, select the Save item.  

creen, the operator will be prompted to verify 
whether to save or discard the existing layout. All overviews on the screen will then be 
closed and a new layout can be started. 

 
 

Any current layout with all its settings, can be saved for later u
C
To save a layout w
 
Clear layout  
To clear the current layout screen and create a new layout, select this option.  
If a window layout already exists on the s

 
 

   

 
 

 
 

 
udio. 

m which the application developer has full 
ontrol and access to all parts of the application. 

n Studio consists of the following elements:

 

Application Studio    
The Application includes all relevant objects and files needed to run your application. 
To manage the Application use the Application St
The Studio is an Explorer-like interface fro
c
The Studio is your application workplace. 
 
Applicatio
Menu Bar  
Tool Bar
Containers Tree 

el 

bject List 

in Menu 
u bar contains the following menus: File, View, Design, Network, 

m is a 

Control Pan
File Lists 
O
Status Bar 
 
Applications Ma
Application's Main Men
Tools and Help. 
Containers Tree List 
In the left hand side of the Studio window there is a tree list that represents the various 
elements of the Application. 
The Containers tree area is made up of two main groups: Files and Objects. Each ite
collection list of objects or files.  
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ayed in the right-hand side of the Studio 

a content sensitive pop up 

All li s 
Rig l

 pop up 

can be filtered by entering a text under each column header. 

nt 
ments of the Application that do not appear in the tree list.  

s and History Viewer, Recipes, Layout and Reports. 
, as Image, to its list by dragging and dropping the file from Windows 

he 

ranch includes lists of Tags, Alarms and Macros. Double clicking on any 
be 

The status line appears at the bottom of the Studio window and displays temporary 
information and quick help, such as, menu option commands, the name of the user, Num 
Lock, Caps Lock and SCRL lock. 

 
 

The root of the tree is the station or application name. When any of the tree items is 
selected, a list of the container's contents is displ
window. 
Clicking the right mouse button on any item in the tree opens 
menu with options relevant to the selected item. 

st share the following common features: 
ht c ick the mouse opens content sensitive pop up menu. 
• List columns can be customized by the user by using the View Setting

menu item. 
• List can be sorted by any column by clicking on its header. 
• Any list 
• Any list can be duplicated in a separate window for ease of use by using the 

Duplicate view pop up menu item. 
Control Panel 
When the root of the tree is selected the right-hand list displays icons that represe
various ele
These include: Application Language definition, Communication Driver definition, Single 
tag dialog, Multiple Tags utility, and settings such as Authorization and Network. 
File Lists 
Under the Files branch you can find Application elements that are stored as files. These 
include the Windows, Images,  
Charts, Events Summary
You can add Window
Explorer. Double-clicking on a Window in the list opens it. To open a new Window use t
New pop up menu item. 
Object Lists 
The Objects b
object opens its properties; you can modify and save the changes. New objects can 
defined using the New pop up menu item. 
Status Bar 

 

   

 
 
 

 
 

ign 

r each file type. 

 

Set Default Paths     
In this dialog box, you can specify the default path name locations of Application des
and operational elements. To enable the system to keep track of files and their locations 
you can define paths fo
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 this dialog box, all the file types are listed with their current path specifications. to 
ific file type, simply click in the line that you want to change, and 

In
change the path of a spec
specify the new path. 
  
To set the default path:
1. Select the Design Menu from the Studio Application 
2. Select the Option menu 
3. Select the Paths option. 
 The elements appear in the left column, the path names are entered in the middle column, 

d the filename format of the element appears in the right column.  

ctory in 
-line.  

  
To cause the Application to save alarm files in a new path, you must first exit the 
Application and then restart Application again.  

 
 

an
 Note that the Application item refers to any application component that is not represented 
in this dialog box. A path must be specified with a terminating backslash.  
  
For example, .\ refers to the current directory, and img\ refers to the image subdire
the current directory. Note that the LRM path (for alarm files) will not be changed on

 
 

   

Using the application 

 
 

ator. 
d Application brings the easy to use, open technology of the Internet to 

ugh event-driven, bandwidth friendly data distribution techniques, the Application 

llation, or plug-
ins. 
For updated information about Application, news, new releases and links to other related 
resources please check our web site at http://www.Wizcon.com

 
 
 

Application 's Internet Capabilities 
  
The Application is the industry's first Intranet Supervisory & Control Application Gener
Java-base
Supervisory and Control. 
The Application allows you to integrate your application with your Intranet or Internet 
network. 
Thro
enables real-time graphics and information updates from any computing platform. All of 
this, without the need for any platform-specific software, client software insta

 frequently. 
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1st thing 

 
 
 
 

ts and files needed to run your application.  
o manage the Application use the Application Studio. 

 application developer has full 
access to all parts of the application. 

o is your application workplace. 

dio consists of the following elements:

 

Application Studio    
The Application includes all relevant objec
T
The Studio is an Explorer-like interface from which the
control and 
The Studi
 
Application Stu
Menu Bar  

Tree 
ontrol Panel 

 a 

 name. When any of the tree items is 
nd side of the Studio 

Clic g  
menu w levant to the selected item. 
All l  
Rig l

 

 be sorted by any column by clicking on its header. 
• Any list can be filtered by entering a text under each column header. 

Tool Bar
Containers 
C
File Lists 
Object List 
Status Bar 
 
Applications Main Menu 
Application's Main Menu bar contains the following menus: File, View, Design, Network, 
Tools and Help. 
Containers Tree List 
In the left hand side of the Studio window there is a tree list that represents the various 
elements of the Application. 
The Containers tree area is made up of two main groups: Files and Objects. Each item is
collection list of objects or files.  
The root of the tree is the station or application
selected, a list of the container's contents is displayed in the right-ha
window. 

kin  the right mouse button on any item in the tree opens a content sensitive pop up
ith options re

ists share the following common features: 
ht c ick the mouse opens content sensitive pop up menu. 
• List columns can be customized by the user by using the View Setting pop up

menu item. 
• List can
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nt 
ments of the Application that do not appear in the tree list.  

and settings such as Authorization and Network. 

s and History Viewer, Recipes, Layout and Reports. 
, as Image, to its list by dragging and dropping the file from Windows 

he 

ranch includes lists of Tags, Alarms and Macros. Double clicking on any 
be 

The status line appears at the bottom of the Studio window and displays temporary 
information and quick help, such as, menu option commands, the name of the user, Num 
Lock, Caps Lock and SCRL lock. 

 
 

Control Panel 
When the root of the tree is selected the right-hand list displays icons that represe
various ele
These include: Application Language definition, Communication Driver definition, Single 
tag dialog, Multiple Tags utility, 
File Lists 
Under the Files branch you can find Application elements that are stored as files. These 
include the Windows, Images,  
Charts, Events Summary
You can add Window
Explorer. Double-clicking on a Window in the list opens it. To open a new Window use t
New pop up menu item. 
Object Lists 
The Objects b
object opens its properties; you can modify and save the changes. New objects can 
defined using the New pop up menu item. 
Status Bar 

 
 

   

Customizing your working 

environment 

 
 
 
 

t Window Attributes 
plicable on the Web. 

d 

 

Se
Note: Setting Window Attributes is not ap
In this dialog box, you can assign default attributes to all windows of the type you selecte
(Image, Charts, Events Summary, or History Viewer).  
  
The fields in this dialog box are as follows: 
Title Bar: The line in the window that contains the title, name in Title The window name 
that appears in the title. This component is relevant only if the Title Bar appears.  
Name in Title: The text to appear in the title bar, if the title bar option was selected. 
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 of a window. This menu contains items that can be used to manipulate windows 

to change the window 

Menu Bar: The line in which the window menus appear.  
Always onTop: Select to display thewindow viewport) on top of other open applications.  
Pos: The window X and Y position coordinates in pixels.  
Size: The window size in pixels.  

 
 

System Menu: The menu that appears when you click on the small box at the top left 
corner
(move, size, close, etc.).  
Min/Max Button: The buttons that appear in the upper right corner of a window. These 

ed sizes.  buttons can be used to shrink or enlarge the window to predetermin
hen clicked on, can be dragged Size Border: Window borders that w

size.  

 
 

   

Studio environment 

 
 
 
 

dio may be duplicated to a 
separate frame. This feature allows user to observe lists of different items simultaneously 
(without navigation via the Containers Tree). 
  
The feature is accessible via popup menu, invoked by clicking of right mouse button, 
whenever the mouse cursor is present inside the List Zone 

 
 

 

View - Duplicate     
The list of the elements, exposed by the List Zone of the Stu
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n the chosen List Zone 
  
The feature is accessible via popup menu, invoked by clicking of right mouse button, 
whenever the mouse cursor is present inside the List Zone 

 
 

View Setting 
Used to set the order and the type of fields to be displayed i

 
 

   

Tuning Parameters 

Alarms 

 
 
 

efined. This 
s 

the User Defined 

plication that has master backup is run.  

er Login defines how and where an alarm issued during user login/logout is written to.  
n alarm is sent when the computer disk is xxx full.  

 
 

Alarm Properties General Tab    
This dialog box has the following tabs: 
General where the message that appears when a user logs in and out is d
message can by default be acknowledged and ended and be viewed in the Event
Summary and History. Alarms can also be ended by the user by using 
status feature. 
Time Format where the time and date format of the message is defined.  
Hotbackup used when an ap
Network Communications used during network communications failure. 
VPI Communication Error used during communication failure between the application 
and communication drivers. 
Us
Wil Diskfull defines when and how a
Tag Lock defines that a tag is locked when an alarm is issued. 
  
The following options are available: 
Avoid generating alarms using tag set values on system startup  
When this is checked no alarms using tag set values are generated during system startup.  
Avoid generating new alarms  Specifies that logins and logouts are not logged. Restart 
the application for changes to take effect. 
Login Alarm Text Specifies the text you want to appear when a user logs in. This change 
can be implemented online. 
Logout Alarm Text  Specifies the text you want to appear when a user logs out. This 
change can be implemented online. 
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ansferred to other 
. Alarm messages, however are transferred to other stations where they can be 

he user has already been authorized to acknowledge 
rm status appear. 

Notes: 
If no names are defined then the default names AlarmStatus0 and AlarmStatus1 are given. 
If in the Alarm Properties dialog box Allow User Defined Status is not checked then none of 
these column options are available.  
The default status names are language dependant.  

 

Allow user defined status This feature is optional. Names are limited to hold up to 20 
characters. Check this option to enable the user to define alarm states.  
Status names This feature is optional. Alarm states are given in the States.dat file in the 
application’s directory. When the application is loaded this file is read and information in it 
is used where applicable. Status names are local and therefore are not tr
stations
handled. You can move an alarm to another user-defined status only if it has not already 
been acknowledged. However, if the alarm has been moved to another status it cannot be 
moved back to its previous status. If t
an alarm further authorization is not required wher ala

 

 
 

   
 
 
 
 

rmat   
 this dialog box the user can define the Alarm time format. 

is page is used to select between four different alarm time formats for the Alarm printer. 

  
Day+Time+Milliseconds - Day in month plus Time plus Milliseconds. 
  
Note After defining the time format, make sure to restart the Application. 

 
 

Alarm Properties Time fo
In
  
Th
The possible options are: 
  
Day+Time - Day in month and time. 
  
Date+Time- Full date and time. 
  
Date+Time +Milliseconds - Full date plus Time plus Milliseconds 

 

   

History Viewer 
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 dialog box is used to define the History Viewer window attributes. 
 initiated in two ways:

History Viewer Properties    
This
The History Viewer Property dialog box could be
From the History Viewer file situated in the Containers tree

OR 
From the Pop-up menu in situated in the List Zone
1. Select the History Viewer file from the Containers tree 
2. Right click an existing History Viewer or anywhere in that Zone. 
3. As a result a Pop-up menu will show up, click it and select the Property option. 

 
 

1. Right click the History Viewer file from the Containers tree 
2. Select the property option from the rolling menu. 

 
 

   

Recipes 
 
 
 
 
 

ilable: 
 that will be loaded during system 

the processing of values according to the tag associated with the appropriate 

Notes: 
Restart the application for changes to take effect. 
The application logger and alarm generator are activated only after the specified recipe is 
loaded. 
If the load fails, see the file called error.rcp for a description of the failure. 

Recipe Properties  
The following options are ava
Startup Recipe:  Determines the name of a recipe
startup.  
Process each value according to its tag: 
Enables 
address in the recipe block.  
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Event summaries 
 
 
 
 
 

is option and new alarms that 

re acknowledge: With this option selected, if a user tries to 

me of the person who ended or 
acknowledged the Alarm. 
Standard Printing       If this option is checked, a "Print to…" menu item will be available in 
the File menu and the Wiztune parameter ANN_STANDARD_PRINTING will be set to 
YES. This menu item is used for printing Event Summary with Windows standard dialogs. 
Advanced Defines Events Summary window attributes. 

 
 

Events Summary Properties     
Use this dialog box to define the Events Summary tuning parameters (locally). 
The following options are available: 
  
New alarm (not acknowledged/ended)  blinking: Select th
arrive in the event summary will blink 
Handler name required befo
acknowledge an alarm, they will have to enter a name before continuing.  
  
Alarm help text status The following options are available: 
Assist:  Enables the user to obtain alarm help text from alarm Help files. 
Ack:  Acknowledges alarms. 
Assist and Ack:  Enables both the Assist and Ack options. This change can be 
implemented online. 
Scroll alarm list  Enables the Events Summary to scroll and display alarms at the top of 
the list. If this option is checked, this parameter determines that when a new alarm arrives 
the Events Summary automatically scrolls to show the top alarms in the list. This ensures 
that if the new alarm is important, it will not be missed if the operator scrolled the list too 
far. Restart the application for changes to take effect. 

hich helps the user to know Show Force End User implements the Force End field, w
whether the name that appears in the User field is the na
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Tag 

 
 
 
 
 

disk rate. 

t is anticipated that a large 

Note after you have determined the size, make sure to restart the application. 
Flush Size: 
This parameter determines a value that will represent the application logger flush to disk 
rate, in seconds (for history files). Maximum is 3600 seconds. 
Note after you have determined the size, make sure to restart the application 

 
 

Tag Properties    
Used to determine the logger buffer size for history files and the logger flush to 
Buffer Size: 
This parameter determines the logger buffer size for history files, in lines (records). 
Maximum is 2048 records. Increase the value of this option, if i
number of changes will occur at once at any time during the session. 

 
 

   

Image 
 
 
 
 
 

ote: Not applicable on the Web. 

nds and can be from 50 
(1/20 second) to 30000 (30 seconds). If you specify a value that exceeds these limits, the 
Application will automatically apply the maximum and minimum values instead. 
 
It is recommended to increase the values for this option, if it is anticipated that a large 
number of dynamic objects on the screen will b updated at once 

 
 

Image Property - Dynamic    
N
Used to determine the blinking rate values for dynamic objects. 
The values you specify for fast, medium and slow are in milliseco
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es folder, relative to the 

S directory. (Default). 

Image Property - Pictures    
Note: Not applicable on the Web. 
  
The Image properties box allows you to set the location of picture fil
web application root directory. 
The Pictures folder is located underneath the DOC
  
To access the Events Summary Profiles properties:
1. From the Containers List select Files Images. 
2. Right-click on the highlighted Images icon and select the Properties option. 

 The Image Properties dialog appears (as shown below). 

5. Press OK or Apply to enter your selection. 
  
You can also access this from the Web Application Properties Pictures tab 

 
 

3.
4. The Default folder name Pictures appears in the field. 

 

   

 
 

 
 
 

te: Not applicable on the Web. 

y using a cache of memory 
tmaps for drawing the background of slow zones. 

 

Image Property- Fast Zone   
No
This parameter determines the period of time (in ms) for "slow" zones. A zone is "slow" if it 
has a background that takes more than a given period of time to draw. This parameter 

e drawing time for "Goto Zone" operations bimproves th
bi
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onsidered to be 

tes  

 zones 
eaches 

this limit, the least recently used fast zone bitmap is removed from the cache in order to 
make room for the new bitmaps. 
  
Note After the Max fast zone was defined make sure to restart the Application. 

 

If the Fast zone threshold is set to be 2500, that means that the zone is c
"slow" if its background takes 2500ms or more to draw. 
  
No
After the zone threshold was defined make sure to restart the Application 
It only affects the background of the image, dynamic elements are drawn as before. 
Operate only when NOT is Edit mode. 
  
Maximum fast zone - This parameter determines the limit of the number of fast
bitmaps that can be kept in a single Window's memory cache. When a window r

 

 
 

   
 
 
 
 

 

ages and determines the mode in 

Setting the amount of memory availa
Always restart the program after upda
The following options are available: 
Images memory pool size ts to be 

eter can be set from 60 to 200. 

Parse each image when loading 
 

 

etwork tags validity is 
not checked. Therefore, use this option after all tag 
definitions in the network station are complete. 

Open new image in Navigation 
mode 

This checkbox defines that the new image will be 
opened in Navigation mode. 

Image Property - Loading     
Note: Not applicable on the Web.
  
This tab determines the amount of memory available for image objects. It also 
enables/disables tag name parsing when loading im
which the image will open.  
Notes:  

ble for image objects is not applicable on the Web. 
ting this tab. 

Enables large images with many objec
created, but allows only 10 (+-) Image windows to 
be open at one time. The lower the value, the more 
Image windows that can be opened simultaneously 
(they must be smaller in size). The value for the 
param

Enables or disables tag name parsing when loading 
in the Images module. Disable this option to shorten
image load time for images that contain network
tags. 
When this option is disabled n
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ote: Not applicable on the Web. 

 well as determine the 
larm notification 

ation. 

o access the Property dialog box:

 

Image Property - Rates    
N
 
Used to determine the image update performance in milliseconds as

mages use to collapse tag/asize of the internal message buffer that i
message received by the applic
 
T
1. Follow the next Path: Studio / Image / Right click the Image Files 

age update rate Max/Min Rates:

2. Select the Properties option 
3. The Image property dialog box will appear  
 
Im
These parameters determine the image update performance in milliseconds.
The default values are: Maximum = 2000 and Minimum= 10.  
Note After those parameters were defined restart the Application. 
 
Message Buffer size:
Determines the size of the internal message buffer that images use to collapse tag/alarm 

 
The default range is 5 to 500 messages. 
A high value for this parameter improves the performance of images with rapidly changing 
dynamic objects, so that images will not have to make graphical updates for each value 
message. 

 
 

notification message received by the application. When tag values change, an image 
receives message in a buffer from the application and updates graphical objects 
accordingly. 
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 - Trigger   
Note: Not applicable on the Web. 
This tab defines trigger objects and o
This tab holds the following fields: 

d 

not 

Mouse pointer on triggers 

t in an image. The 

Trigger small input box 
 be 

ly have a field for 

State Determines which trigger object is 
activated when overlapping triggers are 
clicked. This could be either; Top 
(default) or Bottom. 

Note: Always restart the program after updating this tab
 
 

Image Property

nmouseover properties. 

Trigger object Determines whether trigger objects are 
highlighted when selected. If this option 
is checked, trigger objects will be outline
(with dashed lines) when they are 
selected. The default option is 
selected. 

Determines whether the mouse pointer 
will be highlighted when it is moved on 
top of a trigger objec
default option is not selected. 

When checked, the input box when 
defining data entry for triggers, will
small and and will on
entering the value.  

. 

 

   

 
 
 

 
 

plicable on the Web. 
This tab is used to define the proper int and resolution level. 

ble: 
on remains when 

adding/removing toolbars and 
menus dow 

Repaint images after editing 
operations  

 

Image Property - View    
Note: Not ap

ties of the Image window, repa
The following options are availa
Image positi When this dialogbox is checkbox is checked, Image 

objects do not change position when either the image 
modules attributes (defined in the Image Win
Attributes dialog box) change 

When checked this field defines that an image will be 
repainted automatically after actions that may alter the
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Resolution factor ll 

 operating system, monitor or 

Number of gradient color r of steps used when 
t is 
ay 
 

Adv ys the Image Window Attributes dialog box where 

ize in 
r. The 

 a PC and measure an object’s length in the image (a line will do). 

gth and the result is the xx.xx value. 
und and reload the application. 

. 5. Restart the application for changes to take effect. The range of the factor is 

Advanced but
Note: Image Windows not applicable on the Web. 

ibute can
apply to all future windo ns are available:  

tle 

  

order  can be changed by clicking and 

indow. 

s. 

Specifies X and Y coordinate in pixels. 

ring in the title bar. 
Notes: 

image (such as, moving, copying) are performed. This
option is useful in small and medium zones. 

Sets global stretching or shrinking factors applicable to a
images. This is required to solve display differences 
caused by replacing an
other H/W or to move between resolutions. 

This field determines the numbe
steps drawing objects filled with gradient color. The defaul

16. Drawing large gradient surfaces in many steps m
be slow therefore, develop using few steps and then
increase for run-time. 

anced button Displa
window attributes are defined. 

Note: When changing the Resolution Factor the window remains the same s
pixels. However a centimeter in one image will not be a centimeter in anothe
image remains unchanged when the value is 1. Values greater than 1 expand the 
image.  

o To set correct application values: 
1. 1. Load the image in
1. 2. Load the same image in another PC and measure the same object’s length. 
1. 3. Divide the first length by the second len
1. 4. Enter the IMG_RESFACTOR with the value you fo
The range is 0.1<=IMG_RESFACTOR<=10. 
0 The default value: 1 
1
0.1<+IMG_RESOLUTION _FACTOR<=10. 
Setting Image Window Attributes: 
Click the ton in the View tab of the Properties dialog box. 

 Attributes is 
 
Each listed attr  be set to On or Off. When confirmed, the selected attributes will 

ws of the type specified. The following optio
Title bar The line in the window holding the title. This is relevant only if the Ti

bar is active. 

Name in title Title bar text. 

System menu The menu that opens when clicking on the top left corner of a menu.
The menu options are: Move, Size, Close. 

Min/Max button This option defines whether the min/max buttons will appear in the 
Image window. 

Size B Specifies that window border size
dragging. 

Specifies that the menu bar will open in the Images wMenu Bar 

Always on Top When selected the image is displayed on top of other application

Pos 

Size Specifies window size in pixels. 

Title Bar Text Specifies the name appea
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1. 1. The system menu is title bar dependent. Its corresponding checkbox is unchecked 
and disabled.  
2. 2. If the menu bar is not selected but the system menu is, the menus and items included 
in the Menu bar will appear in the system menu. 

 
 

 
 

   

 
 
 
 
 

pported on the Web. For the Web use Trends Profiles. 

rs in the "Line with marker" and "Marker only" 
graphs. When checking this parameter a different marker will be drawn for different colors, 
so graph with two different colors will be drawn with two different markers. There are 10 
markers available. 
  
Advanced Button 
Used to define the Chart window attributes. 

 
 

Charts 

Charts Properties     
harts are not suNote: C

  
Use chart multi markers 
This parameter affects the style of the marke

 
 

   

 
 
 
 
 

Remote Popup Events Summaries 

Internet Enhancements 
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g 

s and their order, according to which the alarms will be sorted 

Display  Specifies which alarm components are displayed in the  Popup Events Summary. 
Color Assigns alarm text and background colors according to their severity level or zone. 
Options Specifies Popup Events Summary window parameters. (Title bar and List 
Length are not available.) 
Important: The application supports all available popup options except for Buzz. 

 
 

  
Designing a Popup Events Summary that is displayed in a browser is identical to designin
a standard Popup Events Summary.  
  
Popup Display Options 
The application supports the following display options. These options are defined by 
selecting Popup Settings from the Design menu of the Application Studio, and include: 
Filter Assigns values to each of the alarm classifications so that the Popup Events 
Summary will display only the alarms that meet these specifications. 
Sort Specifies the categorie
in the Popup Events Summary.  

 
 

   
 
 
 
 

es a history mode that displays a report of historical alarms. This shows a list of 
arm activities for a specified period of time. For example, alarm information one week 
o from the current date.  

 enables you to define filters for the Events Summary Viewer to specify 

de. Clicking History, on 

pecifies filters for the Events Summary Viewer that determine what type of 
.  

Viewing Alarms in History Mode 
The Application provides two modes for alarm display in an Events Summary Viewer. In 
addition to the online mode, which features realtime monitoring of alarms, the application 
provid
al
ag
The Application
what type of alarm information is displayed. For example, you can define a filter that will 
display only the start time of the alarms that were activated one week ago from the current 
date. 
  
Online Mode 
The following Events Summary Viewer is displayed in online mo
the left of the menu bar, displays the Events Summary Viewer in history mode.  
History Mode 
The Events Summary Viewer is displayed in history mode.  
The following options are available: 
Online  Displays the Events Summary Viewer in online mode. 
Columns S
alarm information it displays
Report  Configures historical alarm reports, as described on the following page. 
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er are available until you 
vents Summary Viewer parameters are 

layed 

 

on to this 
 the Events 

Summary Viewer, notifying that the history reading has been cancelled. 
 When the query is complete, the Application reads the history file prior to displaying the 
alarm report. A progress dialog appears displaying how much of the file has been read  
5. (Optional) You can click Cancel at any time to stop the Application from reading the 
history prior to displaying the report in your browser. This is useful if the report is larger 
than you expected. 
 When the history reading is complete, the report is displayed in your browser. 

 
 

Note: Any changes you make to the Events Summary View
refresh. The next time you login, the default E
displayed.  
Configuring Alarm Reports 
The Application provides the following filters to configure the information that is disp
in an alarm report.  
The range of date and time an alarm was activated. 
The range of date and time an alarm was acknowledged. 
The range of date and time an alarm ended. 
To configure an alarm report: 
1. Select History in the Events Summary Viewer. The Events Summary Viewer is 
displayed in History mode. 
2. Select Report. The Alarm Report dialog is displayed. This dialog is similar to the 
standard Alarm Report Definition dialog.  
3. Click OK when you have specified the required filters. The Alarm Report dialog closes
and a progress dialog is displayed while the application connects to the server.  
A system file with an adb extension is created in the Docs/History folder of your 
application. 
4. (Optional) You can stop the application from transferring the history informati
file at any time by pressing Cancel. The Application then displays a message in

 

   
 
 
 
 

eous 

tion supports alarm object attributes in a browser. They are defined in the 
t Definition dialog  

hen the value is within one of several specified value 

 

Miscellan
Alarm Objects 
The Applica
Alarm Objec
The Application now supports the following alarm object attributes in a browser: 
Blink 
Specifies that an object will blink when the value is within the specified value range. 
Fill color 
Sets the fill color of an object w
ranges. 
Line color 
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 line color of an object when the value is within one of several specified value 

 is 

Remote users should create an HTML file with the same name as the assist file and save it 
in the directory which contains the application’s HTML files. When the alarm object is 
activated, the HTML file is opened together with the assist file. 
Accessing Images with Layers 
The Application supports the use of layers in Images that are remotely accessed. Users 
can access specific layers of an Image according to group authorization. 
Note: Remember that Images accessed remotely have only scale. 

 
 

Sets the
ranges. 
Acknowledge 
Causes the alarm associated with the object to be acknowledged whenever the object
selected in the Trigger mode. 
Acknowledge with confirm 
Prompts the operator before acknowledging the alarm  
Assist 
Provides textual assistance when the object is selected. 

 
 

   

 

 
Layout / Close All Windows   

Note: The multilanguage feature is not supported on the Web. 
This option is used to clear all layouts from showing in the Window. 

 
 

Layout 
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About this chapter: 
This chapter describes how to create an application project using the Getting Started 
Wizard and how to define Station Properties as follows: 
Overview describes the first steps in creating an application Project. 
Optimizing Application Performance discusses the system's Station Properties, which 
optimize application performance and enhance functionality.  
 

 
 

 
 

   

Overview 
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Overview 
After the program is activated the Getting Started Wizard opens on your screen. Through 
the Wizard you can create new projects, either using a template or blank template, search 
for existing projects or open the most recently used project. 
When a new project is created all files are copied from the NewWizAPP folder to your new 
application folder. These are the WizUM.mdb file containing a user name and password 
(default = user.password) and the Wiztune.dat File. This file can be opened by right 
clicking the project name and selecting the Open Tuning Parameters File option. 
A new project file is saved with the suffix *.Wpj. (This may change in future software 
versions). When the Application Studio opens on your screen, the name of the project 
appears at the route of the All Containers pane.  
After the project is saved, Station Properties, which enables you to adjust system 
parameters to optimize your application's working environment can be defined. The Station 
Properties dialog box can be opened by right clicking the project name.  
The Getting Started Wizard enables you to open existing applications from the Application 
Studio or to create new applications. There are three tabs: New, Existing and Recent.  
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New Tab 
This tab enables you to open new applications. There are two options: 

o     Blank Application 
o     Template Application 

To open a blank application: 
Click the Blank Application icon to open the Set Application dialog box. 
Or,  
If you have already accessed an existing project and wish to open a new one. From the 
File menu select New Application to open the Set Application dialog box.  

 
1.    In the Folder Name field, at the end of the folder's location, type in the name of your 
folder. Click the Create button. The new folder name will be added to the folder location 
and also appear in the Folders list. 
2.    In the Application Name field, type in the name of the application. The suffix *.Wpj will 
be added by default. 
3.    Click OK to confirm.  
4.    Before the new application opens the Create System Tags message box will open on 
your screen. 
5.    Select either Yes or No accordingly. The Quick Access Bar will open on your screen. 
Note:     To open the Application Studio, click the Show Studio icon. The new project will 
appear at the root of the All Containers pane. If you created a folder for the application 
before opening the program this will appear in the Folders list. 
To create a template application: 
Click the Template Application icon to open the Choose Template dialog box. 
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Or 
If you have already accessed an existing project and wish to open a new one. From the 
File menu select New Application to open the Choose Template dialog box.  

     
1.    Select the *. Wpj file of the application on which the new application is based, and click 
Open. The Set Application dialog box is displayed.  
2.    In the Folder Name field, at the end of the folder's location, type in the name of your 
folder. Click the Create button. The new folder name will added to the folder location and 
also appear in the Folders list. 
3.    In the Application Name field, type in the new name of the application. 
4.    Specify a new name for the application in the Application Name field. 
5.    Click OK to confirm. The application closes and then reopens with the default settings 
of the selected application.  
6.    Before the new application opens the Create System Tags message box will open on 
your screen. 
7.    Select either Yes or No accordingly. The Quick Access Bar will open on your screen. 
8.    To open the Application Studio, click the application icon. The new project will appear 
at the root of the All Containers pane. 
Note:     A short cut for creating a new application is to right click in the required location 
and creating a new folder and then right clicking and selecting the application.  
 

 
 

 
 

   

 
 

 
 
 

Creating a New Application 
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You can create a new application using the Application Getting Started Wizard.  
  
To Create a New Application
1. Double-click on the Blank Application icon located in the Application Getting Started 
Wizard. The Set Application dialog opens:  
 In this dialog, you provide two items for defining a new application: 
a) An application folder, in which files of your application will be located, and 
b) A name of .wpj file in the folder, which will keep the details about the application. 
Note that the application’s name IS the name of this .wpj file. 
3. In the Application name field, type the name of your new application.  
4. Specify a new folder name and click on the Create button. This will be your application's 
folder. You can also create your folder using Windows Explorer. 
 Note: The folder you assign your new application should be empty. The application 
detects files from another application, an error message will appear and you will have to 
repeat the process.  
5. Click OK to save your choices. The Application Studio opens. 

 
 

 
 

   
 
 
 
 

Creating a Template Application 
You can create a template application using the Getting Started Wizard. A template 
application is an application which is based on an existing application.  
To Create a Template Application
1. 1. Double-click on the Template Application icon located in the Getting Started Wizard. 
1. 2. Double-click on the Template-based Application icon and the Choose Template 
Application dialog opens.  
1. 3. Select a template application by selecting a W.wpj file which represents an existing 
application.  
1. 4. Click the Open button and the Set Application Dialog appears. 
1. 5. In the Set Application dialog give your application a name and set the folder. 
1. 6. Click OK and the Application Studio opens. You now can work on your new 
application which is based on an existing one. 
  
When you have set the above information the application Wizard copies all contents of the 
template application into the new folder, renames the file in the new folder to the new 
application's name. 
Note: When the Getting Started Wizard copies a template application into a new one, it 
takes ALL contents of the template directory, including all subdirectories. Therefore, if a 
subfolder of the template folder was assigned for the new application, Wizard will attempt 
to copy this subfolder as well. You cannot copy a folder unto itself because every subfolder 
of the application folder may be considered as a part of the application. Therefore, do not 
use a subdirectory as the target folder. 
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Default Wiztune.dat File 
When a new application is created all files are copied from the NewWizAPP folder to your 
new application folder. The WizUM.mdb file contains a user name and password (default = 
user.password) and the default Wiztune.dat file contains the following parameters: 
  
DEFAULTUSER=user.password ----> (password is encrypted) 
NET_PROTOCOL=NPITCP 
VFI=VFI5FST,VFI5CB 
TRG_FEEDBACK=YES 
IMG_NEW_OPEN_NAVIGATE=NO 
RECIPEPERGATE=YES 
OLD_NET_USER_AUTH=YES 
ALARM_IGNORE_TAG_SET_VALUES=NO 
IMG_KEEP_POSITION=YES 
VFI5FST_MODE_TIMESTAMP=YES 
  

 
 

 

 
   
 
 
 
 

Existing Tab 
This tab holds a list of all existing system applications. 
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o To open an existing application: 

Click the Existing tab and select the relevant application. 
Or, 
From the File menu select Open Application to open the Open dialog box.  
Select the *.wpj file of the application you want to open and click Open. The system closes 
and then re-opens displaying the specified application. 

 
 

 

 
   
 
 
 
 

Opening an Existing Application 
You can open an existing application using the Application Getting Started Wizard.  
To Open an Existing Application
1. Click on the Existing tab in the Application Getting Started Wizard. 
2. Select a *.wpj application file. The selected application name appears in the File Name 
field. 
3. Click Open. 
4. Application Studio opens with the selected application. 
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Recent Tab 
This tab holds a list of all existing system applications.  

 
o To open a recent application: 

Click the Recent tab and select the relevant application. 
 
 

 

 
   
 
 
 
 

Opening a Recent Application 
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You can open a recently used application using the Getting Started Wizard.  
In the Recent tab of the Application Getting Started Wizard you can find a list of full paths 
to several files, each of which represents one of the recently used applications. 
To Open a Recent Application
1. Click on the Recent tab in the Application Wizard. 
 The Recent Application screen appears: 
 The full paths of recent applications appear in the dialog. 
2. Double-click on the file you want, or Press OK. 
 The recent application you selected opens with the Application Studio. 
 

 
 

 
 

   

Optimizing Application 

Performance 

 
 
 
 
 

Optimizing Application Performance  
The Station Properties enable you to optimize application performance and enhance 
functionality. System parameters can be adjusted to establish an optimal working 
environment for your application. 
u To define Station Properties: 
Right click the application in the root of the container list in the All Containers section (if 
you have saved your application, the application name will appear in the root), and select 
Station Properties. The Station properties dialog box opens. This dialog box has the 
following tabs: 

o    General - where the application workplace can be customized.  
o    User - where a default user that will be logged in when you start the application 

is defined.  
o    Date Format - where the date format is defined. 
o    VFI - where the format for history files by selecting Virtual File Interface DLLs is 

defined.  
o    Audit Trail - where an Audit Trail is added or enabled to view operator actions 

stored in an application system file in the form of tag values.  
o    ODBC Connectivity - to enable the Open Database Connectivity (ODBC) dialog 

box to save the application's historical data to various databases through 
Microsoft's ODBC.  
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o    Advanced Alarm Management - where the Advanced Alarm Management 
module is enabled.  

o    Scheduler - where actions, tasks and states can be defined over the Internet 
o    User Management - where the User Management database source (MS 

ACCESS or MS SQL Server) is defined and the synchronization properties are set. 
This tab will be used to define the Centralized User Management. 

o    Limitation of Log Files - where the file size limits for Online log file (errors.dat) 
and the Historical log file (errors.) are defined. 

 
 

 
 

   
 
 
 
 

Setting General Station Parameters 
The application workplace can be customized in the General tab of the Station Properties 
dialog box.  

  
 
 
The following options are available: 
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Show Quick Access 
Bar 

Determines whether or not the Quick Access bar 
appears when the program is loaded. 

Show done bar    
Displays a background processing dialog box 
when large tasks such as loading a large image 
are being executed. Changes are made online. 

Auto Restart after 
an illegal shutdown 

Specifies if the application automatically restarts 
and recovers its last state after an illegal 
shutdown (for example after power failure). 
Changes are implemented online. Note that after 
an illegal shutdown, a system alarm will be 
generated to inform all other stations. 

Display untitled 
windows icons in 
task bar    

When checked the word untitled appears in the 
task bar for new items that have not been saved. 

Display windows 
icons in the task 
bar    

When this option is checked and after reset, no 
icons are displayed in the task bar. 

    
 

 
 

 
 

   

 
 

 
 
 

Selecting a Default User 
You can specify the name of the user you want automatically logged in whenever you start 
the application in the Default User tab of the Station Properties dialog box. This is enabled 
after defining a user name and password.  
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Note:     You only log on to the system when using the application locally.  
The instructions below apply to both Default User and Logout User fields: 
1.    In the User field type in the user's name. Enter an asterisk (*) to specify the last user 
that logged out. Changes are implemented online. 
2.    In the Password field type in a unique password for the user.  
3.    If you want the currently logged in user to be logged out after a specified period of 
time, click the automatic logout and select the time period. For example here, the logged in 
user will be logged out to the default logout user after the specified period of time if there is 
no mouse (click or movement) or keyboard activity during this time. 
4.    Click OK to confirm and reset the application to actually save the changes. 
Note:     Remote users login parameters are defined by right clicking Html/properties/users 
and checking either: Enable login Quick Access Bar in browser, or Automatically login with 
default user.  
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Setting the Date Format 
You can set the date style and date separator in the Date Format tab of the Station 
Properties dialog box. 
 

 
 
The following options are available: 

Date style 

Specifies a date style from a list of predefined date styles. 
Listed below are the Date styles: 
DDMMYY  
MMDDYY  
YYMMDD  
DDMMYYYY  
MMDDYYYY  
YYYYMMDD 
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Date 
separator 

Specifies a date separator from a predefined list of date 
separator styles. The date separator files are: 
/(slash) 
.(dot_ 
(dash)  

o To Set Date Format 
1.    In the Stations Properties dialog box select the Date Format tab. The Date Format 
Dialog opens. 
2.    From the Date Style list select a predefined date style. 
3.    From the Date Separator list select the way you want the date to be separated. 
4.    Click OK key to enter your selection. 
When loading for the first time, the application sets default values for these parameters 
using country code, defined in Control Panel/Regional Settings. 
The table below lists the default values in the application for different countries 

Country Date Style Date Separator 

USA MMDDYY    / (slash) 

Japan YYMMDD / (slash) 

Netherlands DDMMYY / (dash) 

Denmark    DDMMYY    / (dash) 

Germany    DDMMYY . (dot) 

Austria    DDMMYY . (dot) 

Russia DDMMYY . (dot) 

All others    DDMMYY / (slash) 

. 
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Setting a Format for History Files 
The format for history files is set in the VFI tab of the Station Properties dialog box.  
VFI enables the designer to select different file formats to be used by the application for 
historical data logging and report generation. The system engineer can use a combination 
of different file systems and databases with the application for data manipulation 
convenience and optimum performance.  
VFI uses a unique driver for each database, thereby taking advantage of the database's 
structure and characteristics. Wizcon Systems supplies drivers to support specific 
databases.  
 

 
 
This dialog box Tags and Alarms fields have the following options:  

o     Proprietary format       
o     DBF format 
o     Custom    
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Setting a Format for Audit Trail 
Audit Trail is a useful security feature for applications. This tab enables you to log operator 
actions to a database via an ODBC data source.  
Operator actions are stored in an application file in the form of tag values that can be 
accessed and viewed.  
The application logs all manual operations, with exception to those made using Add-on 
programs, such as script language and application PLC. Additionally, the application does 
not record Smooth Type trigger actions. 
Audit Trail provides data recovery for users connected to a remote ODBC data source in 
instances of network failure. 
Note:     It is not recommended to work with a remote database due to possible connection 
failures. 

o To enable audit trail: 
1.    Right-click New Application in the All Containers list of the Application Studio to open 
the Station Properties dialog box. 
2.    Using the arrows scroll to open the Audit Trail Enable tab. 
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3.    Check the Enable Audit Control checkbox to activate the Current Data Source field. 
When the database source is predefined, click the Current Data Source field's drop down 
list and select the database. If it is not predefined click the Add Data Source button. 
The standard Windows Create New Data Source wizard window is displayed, in which a 
database source can be defined. The data source can be any valid predefined ODBC data 
source.  
 

 
 
4.    In the Select a Type of Data Source section click User Data Source (applies to this 
machine only) and then click Next to open the next dialog box.  
5.    Select the driver for which you want to set up a data source and click next to open the 
Finish dialog box. 
6.    Verify that the information in this dialog box is correct. If it is, click Finish, if not click 
Back to make any corrections. The ODBC Microsoft Access Setup dialog box opens. 
7.    Complete the Data Source Name and Description fields.  
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8.    In the Database section you have four options: 
Select - click to open an existing location  
Create - click to create a new database 
Repair - click this option targets the specific database for repair 
Compact - click to save the database and to remove unused space from it 
9.    In the System Database field click either None or Database and then click OK. 
10.    The Database Successfully Created notification will appear on your screen. Click 
Apply and OK to close the dialog box and then restart your computer. 
Note:     The application does not support the File Data Source (Machine independent) 
option. 
 

 
 

 
 

   

 
 

 
 
 

Data Recovery 
Audit Trail provides data recovery for users connected to a remote ODBC data source in 
instances of network failure. 
When a network problem is discovered, the application ends the session with the remote 
database and creates a temporary file in the Temp folder of Windows . This file, a text file 
in CSV format, is called BCK*.tmp. 
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The application then scans the network connection once a minute, and when connection to 
the server is re-established, writes the temp file to the audit trail file. If the information is 
written correctly, the application then deletes the temp file. If the information is not written 
correctly, the application will notify you of possible data loss. 
Note:     It is not recommended to work with a remote database due to possible connection 
failures. 
Note:    Chapter 29, Secure HTML File Generation shows how you can configure Audit 
Trail profiles that mean allow you to view the contents of the audit trail database via a Web 
interface. 
 

 
 

 
 

   

 
 

 
 
 

Database Fields 
The following fields and variables are added to a database file. 

Field Variable 

UserName  
Specifies which user name performed the action. SQL_VARCHAR    20 

SourceType 
Specifies the Image or browser. SQL_VARCHAR    10 

SourceName 
Specifies the Image or picture name. SQL_VARCHAR    200 

SourceID 
Specifies the IP address of the browser. SQL_VARCHAR    50 

Action 
Specifies one of the following actions: tag assign, 
zone, macro. 

SQL_VARCHAR   10 

TagName 
Specifies the name of the tag. SQL_VARCHAR   50 

175 



Chapter 6 Building a Project 

TagValue 
Specifies the tag value. SQL_DOUBLE 

ZoneName 
Specifies the name of the zone. SQL_VARCHAR    20 

MacroName 
Specifies the name of the macro. SQL_VARCHAR   10 

TimeAction 
Specifies the time and date the action took place. 
When accessed through a browser, the time and 
date will be that of the server. 

SQL_VARCHAR   20 

 
 

 
 

   
 
 
 
 

Formatting ODBC Connectivity  
The ODBC Connectivity dialog box enables you to save application historical data to 
various databases through Microsoft's ODBC connectivity. 

o To enable ODBC Connectivity: 
1.    Right-click New Application in the All Containers list of the Application Studio to open 
the Station Properties dialog box. 
2.    Using the arrows scroll to open the ODBC Connectivity tab. 
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3.    Check the Enable ODBC checkbox to activate the dialog box options. 
4.    In the Currrent Data Source field select the database type to which you want to save 
application Historical Data. Or click the Add Data Source button to open the Create New 
Data Source dialog box.  
5.    In the Cross Reference Table field, type in the name of the table and click the Create 
Reference Table button to create a cross reference table including tag definition 
parameters. 
6.    If you intend to use a protected database (such as Oracle) type the user name and 
password in the identification field. 
7.    Under the History Table field type in the name of the historical data table. Check the 
Enable Tag Name Logging checkbox to write tag names to the historical data table.  
8.    Click Apply and OK to confirm. 
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Formatting Advanced Alarm Management 
Advanced Alarm Management (AAM) uses a multi-service communication platform to 
provide alarm transmission over various communication channels including SMS, email, 
fax and vocal messages. 
AAM is comprised of two design mode components: 

o     AAM channels and AAM pager services 
o     Advanced Alarm Viewer - a runtime component  
o To enable Advanced Alarm Management: 

If the communication lines used by AAM are already defined then do the following: 
1.    Right-click New Application in the All Containers list of the Application Studio to open 
the Station Properties dialog box. 
2.    Using the arrows scroll to open the Advanced Alarm Management tab. 
 

 
 
3.    Check the Enable Advanced Alarm Management checkbox and click OK. 
4.    If needed, check the Enable Priority Management button checkbox. You can then 
select either Highest priority or Lowest priority. This allows you to define the order in which 
alarms in a queue will be sent. For example, if you select Highest Severity is Highest 
Priority, this means that, if two alarms are waiting to be sent, the alarm that was defined 
with the highest severity will be sent first. 
5.    Restart the application. 
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Formatting the Scheduler  
The Internet based Scheduler enables you to easily create daily or weekly task orientated 
schedules remotely. Being both task and time orientated, the Scheduler can be used to 
create unlimited tasks, actions and states. Tasks can be modified, enabled/disabled and 
have many states attached to them. An unlimited number of actions, which are basic 
operations, can be attached to each task.  
Before the Scheduler is accessed the Scheduler module must first be enabled in the 
Station Properties dialog box. 

o To enable the Scheduler module: 
1.    In the All Containers side of the Application Studio right click the application's name to 
open the Station Properties dialog box. 
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.    Using the arrow, scroll and open the Scheduler tab. 
 OK to actually define this option. 

 

2
3.    Check the Enable Scheduler checkbox and then click
4.    Restart the application. 
 
 

 

 
 

   

 

 

Formating User Management  
ovaPro Open is provided by a local MS ACCESS 

 to 
n 

tabase located on a 
 

o Setting up Wizcon to use SQL Server database 
Onc h een installed, the Wizcon stations 

 

 
 

By default, user management in N
database (WizUM.mdb). The Centralized User Management gives you the possibility
make changes on one station and have them immediately available to all other stations o
the network.This is particularly useful in large-scale configurations. 
In this case, user management is provided by an MS SQL Server da
central computer. See Appendix D, Installing SQL Server database for details of how to
setup this centralized database architecture. 
 

e t e Centralized User Management database has b
must be set up to use this database instead of their local one. 
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1.    In the “User Management” tab as show on the screen capture, select “Microsoft SQL 
Server” by clicking on the related radio button. 
2.    Complete the additional information required, as : 

o     Server name hosting the User database. A browse button helps if name is not 
known. 

o     The login name and password of the database owner which was defined when 
creating the database (Appendix D, Installing SQL Server database). 

o     “Synchronize at startup” option which allows the station to initiate a 
synchronization process after a disconnection between User database server and 
the rleated station.  

o     If “Synchronize at startup”option is checked, then it is possible to choose the 
way to synchronize databases. 

n    from Local database to the Central database. In this case, you “Overwrite Central 
database” with the Local database informations. 
n    from Central database to the Local database. In this case, you “Overwrite Local 
database” with the Central database informations. 

o     A “Synchronize Now” button can initiate an immediat syncrhonization. 
The centralized User database is now available from the configured Local station. Each 
time a change is done on Local station database, the information will automatically be 
updated in Central database, in a background process. 
u In case of disconnection 
If the connection between station and Centralized User database is broken : 
1.    a message box appears 

  
2.    Wizcon switches from Centralized database to its local Access user database and will 
continu to work as before the disconnection. 
Once the network connection is back : 
1.    Wizcon will attempt to connect the central database 
2.    Then, the synchronization process starts silently in the choosen direction as pecified in 
the previous paragraph (Setting up Wizcon to use SQL Server database) 
3.    However, a Wiztune parameter (See Wiztune User Guide) 
UM_SHOW_DIALOG_ON_RECONNECT can be set to 1 to inform the user that 
connection has been restored and select the synchronization process he wants. This 
parameter is set to 0 by default, meaning that the dialog box shown below will not appear. 
Wizcon recommends that this option remains disactivated.  
 

 
 
4.    A System Tags (WIZSYS_UMCentralDatabase) is available to inform the user which 
database is in use, Local or Central. 
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You will not be able to modify tag and alarm definitions or menu authorisations while you 
are disconnected from the centralised user management database. 
 

 
 

 
 

   

 
 

 
 
 

Limitation of Log Files 
NovaPro Open generates log files in order to inform the advanced users about any 
problems which happened in the application. Those files can be limited in term of size. The 
file size limites for Online log file (errors.dat) and Historical log file (errors.) are defined as 
follow : 

o To limit the Online log (errors.dat) file 
1.    By default, the Online log file is not limited. To enable the file size limitation, check the 
related check box, 
2.    A default size limit applies. You can increase or decrease this value. 
3.    Once the file reaches the predefined value, the file content is copied to the errors file 
(historical), and then the errors.dat file is erased. A blank errors.dat is started. 
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o To limit the Historical log file 
Each time Wizcon is closed, the errors.dat file is copied a the end of the errors file, which is 
storing all the previous errors.dat files. 
1.    By default, the Historical log file is not limited. To enable the file size limitation, check 
the related check box, 
2.    A default size limit apllies. You can increase or decrease this value. 
3.    Once the file size reaches the defined value, the oldest information are erased. 
4.    The Max Count of Sessions can be used to limit the amount of sessions logged into 
the historical errors. file. Once the amount of sessions logged into the errors file is reach, 
the oldest session is erased. 
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Data Protection 
Presentation 

The purpose of this feature is to protect Wizcon data from external modification.  

Description 
When data protection is active, a hash is created from WizUM data and WizDB data. At 
start up the application verify the data integrity using those hashes. If the data is corrupted, 
a specific alarm is generated.  

How to use Wizcon data protection 

 
 
In the station property sheet, select the Data protection page. You can then select the 
database you want to protect. 
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About this chapter: 
This chapter describes application security, user authorization and also discusses User 
Management, as follows: 
Authorization Overview discusses application Authorization using the Menu Items and 
System options.  
Security Overview discusses the Security module with a reference to the Installation for 
further details. 
Application Dialog Boxes discusses the dialog boxes that replace the standard Windows 
dialog boxes when the application's system security is installed.  
User Management - Overview discusses definition of users, groups and teams.  
Creating Users discusses how to create new users. 
Creating Groups discusses how to create new groups. 
Creating Teams discusses how to create new teams. 
Shift Management describes how you control who logs into the application and when. 
Centralized User Management discusses how to manage a centralized user database. 
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User Management - Overview 

User Management provides you with an advanced security system, enabling you to 
manage the security of an application both locally and remotely. In the User Management 
you can create and manage users, groups and sub-groups, called teams. You can define 
as many groups and users as you need. 
The security groups and users are then assigned with access permission for changing tags 
value so that only authorized operators can set the tag value, activating a macro, or 
changing an alarm definition and status. For example, by assigning authorization groups to 
each tag, an operator who does not belong to any of the assigned groups will not be 
authorized to change tag values. Note that all operators can read tag values, only 
authorized operators can change them. 
 
Groups and users are easily defined from the application studio. The User Management 
tool was added under the tree root and contains two items: Groups and Users.  
Clicking the Groups item displays the list of all the groups in the studio's right hand. The 
Administrators group is the default group installed by applications. This group cannot be 
removed nor modified. 
Clicking the Users item displays the list of all the users in the studio's right hand, including 
a user named "user" default user. 
The User Management tool can also be accessed from the quick access bar by clicking on 
the User Management icon.  
 
Defining Users 
Defining Groups 
Defining Teams 

 
 

 
 

   

Authorization Overview 
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Authorization Overview 
Authorization in the application refers to the ability to limit operator access to system 
facilities. This powerful feature enables the system engineer to control access to the 
various application components and modules, such as menu items, tags, macros, and 
graphical objects. 
The components, to which access can be limited, include: 

o    Menus and menu items 
o    Writing Tag values 
o    Macro activation 
o    Graphic element layers in images 
o    Alarm acknowledgement 

System authorization is assigned according to users, groups and teams. An unlimited 
number of groups can be defined in the system, each with its own unique name. Each 
operator can be assigned to one or more groups. For example, once a group is assigned to 
a tag, any operator that belongs to the group can perform tag value operations on the tag. 
Operators not assigned to a group matching any of the tag groups will not be able to set 
new tag values. 
Note:    User Management defines users and their passwords and also assigns users to 
groups or teams. The name of the currently logged-in operator is displayed in the Title bar 
of the Quick Access bar.  

o To define authorization settings: 
Select the Design menu and point to Authorization and then select either Menu Items or 
System.  

o    Menu Items - Assign an authorized group to each menu item in the application 
o    System - Set system authorization options to security groups and users. 

 
 

 

 
   
 
 
 
 

Authorization in the application refers to the ability to limit operator access to system 
facilities. This powerful feature enables the system engineer to control access to the 
various application components and modules, such as menu items, tags, macros, and 
graphical objects. 
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Menu Access Authorization 
Each menu item in the system can be assigned authorized users/groups/teams, whereby 
only their defined operators have access to these items. 
For example, if an operator belongs to the groups called MANAGER, SYSTEM, and 
USERS, and a menu item is assigned the groups TECH, SYSTEM, and ENGIN, this item 
will be accessible to the operator (since both have a common group). 

o To assign menu item authorization: 
From the Design menu, point to Authorization and select Menu Items. The Menu 
Authorization dialog box is displayed:  
 

 
 
This dialog box contains a list of the application views such as: Image, (See Chapter 20, 
Introduction to the Image Module) Chart (See Chapter 26, Charts), Events Summary, 
(See Chapter 24, Event Summaries) History Viewer (See Chapter 33, History Viewers), 
and the Quick Access bar. 
The menus of these items are displayed in a tree arrangement. Menu branches are 
expanded and contracted by double-clicking on them. An item that holds sub-items is 
indicated by an arrow (>). When you double-click on such an item, the sub-item list 
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appears. For example, double-clicking on Events Summary displays the following sub-item 
list:  

 
Double-click on Events Summary to close the sub-item list. 

o To assign specific groups to an item: 
1.    Select the item and click the Group button. The Action Permission Manager dialog 
box is displayed in which you can select groups to be assigned to the menu item. Only 
operators assigned to the specified groups will have access to the menu item. 
2.    Click the Set All button to assign all the groups to the item. 
3.    Click the Reset All button to reset all the groups assigned to the item to their original 
settings. 
4.    Click Save to actually save these definitions. 
Note:     If you assign groups to menus that include sub-menus and sub-items, all the sub-
menus and sub-items are affected. However, if you assign groups to a sub-menu or sub-
item, the parent menu is not affected. 
When you select a sub-menu or sub-item that belongs to the menu, you can only reset and 
set the groups that were defined for the parent menu, unless you return to the parent menu 
and change the settings. 
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Authorization Menu Items   
Note: Authorization Menu Items is not supported on the Web. 
Each menu item in the application system can be assigned with authorization groups 
(whereby only operators belonging to the groups will have access to the items) and 
individual users. 
In this dialog box, for each window the menus are organized in a tree view. Menu branches 
are expanded and contracted by double clicking on them. An item that includes sub-items 
is indicated by an arrow. When you double click on such an item, the sub item list appears. 
Double click on the item again to close the sub items list. 
To assign menu item authorization 
1. Select the Menu items from the Design/Authorization menu. The Menu Authorization 
dialog box opens. 
2. Double click the window you want to define the menu authorization for to display the list 
of that window's menus. 
3. Double click a menu to view its menu items.  
4. Select (click) the menu item for which you want to set authorization and click the Groups 
button to open the Access Permission Manager dialog box, where you can select the 
groups and users authorized to operate teh selected menu item. 
5. To assign all the authorization groups and users to an item without entering the Access 
Permission Manager dialog box, click the Set All button. 
6. To reset all the groups and users assigned to an item without entering the Access 
Permission Manager dialog box, click the Reset All button. 
7. Click Save to save your changes, or cancel to abort. 

 
 

 

 
   
 
 
 
 

Action Permission Manager 
The Action Permission Manager dialog box is used to define authorized users and/or 
groups. 
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Add Click here to add a user/group to the Access Members list 

Remove    Click here to remove a user/group from the Access Members list 

Add all Click here to add all users/groups to the Access Members list 

Remove 
all    Click here to remove all users/groups from the Access Members list 

There are four buttons: 
 

o To assign access permission: 
1.    Click the arrow in the dropdown list and select the type of list you want to view. There 
are three options:  

o List all Groups Users - Select this option to display a list of your application's 
defined groups and users  

o List all Groups - Select this option to display a list of your application's defined 
groups 

o List all Users - Select this option to display a list of your application's defined 
users  

2.    From the Groups/Users column select a group/user and click the Add button. The 
selected groups/users are now displayed in the list of Access Members. 
3.    Click OK to confirm. 
Note:     The option buttons are deactivated when the All groups and users have the 
access permission checkbox is checked. 
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Note:    To assign global access permission, check the All groups and users have access 
permission checkbox.  
 

 
 

 
 

   

 
 

 
 
 

Access Permission Manager 
In this dialog box you select the authorized users and / or groups. 
To assign access permission 
1. Select the type of list you want to view:  
 List all Groups&Users - select this option to display a list of your application's defined 
groups and users. 
 List all Groups - select this option to display a list of your application's defined groups. 
 List all Users - select this option to display a list of your application's defined users. 
2. Select the groups/users to whom you want to assign with access permission and click 
the Add button. The selected groups / users are now displayed in the list of Access 
Members. 
 Click the Add All button to assign access permission to all the groups and or users. 
3. Select the All groups and users have access permission checkbox to assign access 
permission to all your application's groups and users. 

 
 

 
 

   

 
 

 
 
 

Security Overview 

Note:    The system's security module must be installed to enable the Security option. 
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The application provides additional system security by ensuring that users access only 
those parts of the Windows system to which they have authorization.  
When the system's security is installed it replaces the standard Windows system control. 
The NovaPro Open dialog boxes overwrite the Windows 2000/XP or 2003 Server dialog 
boxes.  
When turned on, computers that have the security module installed will open with the 
NovaPro Open window. After clicking the Start button users will have to enter their user 
name and passwords in order to gain computer access.  

 
 

 
 

   

Application Dialog 

Boxes 

 
 
 
 
 

Application Dialog Boxes 
This section describes the application’s dialog boxes that replace the standard Windows 
2000/XP or 2003 Server dialog boxes when the application's system security is installed.  
The NovaPro Open Welcome dialog box is displayed when Windows is initiated:  

 
 
 
The NovaPro Open Logon Information dialog box is displayed for user logon:  
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The NovaPro Open Options dialog box is displayed when Ctrl+Alt+Delete is pressed after 
logon:  

 
 
The Logoff NovaPro Open Station dialog box is displayed when the user logs off:  

 
 
The Shutdown NovaPro Open Station dialog box is displayed when shutdown is initiated:  

 
Note:     The above four options are accessible only to authorized users. 
 
The Workstation Locked dialog box is displayed when the station is locked:  
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The Unlock Workstation dialog box is displayed when a user unlocks the station: 

 
 
The Change Password dialog box is displayed when a user changes a password:  

 
 

 
 

 
 

   

 
 
 

 
 

System Definition 
This option defines the level of access the user/group has to the application. The following 
access levels are available: 
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Full security 
(disable all) Specifies that users will be unable to access other programs. 

Disable lock 
station    

Specifies that a user cannot block access to a computer by 
applying a password 

Disable shutdown 
station    Specifies that a user will be unable to shut down a station 

Disable logoff    Specifies that a user cannot logout of the system 

Disable changing 
user password    Specifies that users cannot change their passwords 

Disable ALT-
ESC    Specifies that a user cannot access the Start Menu 

Disable ALT-TAB    Specifies that a user cannot navigate between the programs open 
on the computer using the Alt Tab keys 

  
o To define operator system settings: 

1.    From the Design menu, point to Authorization and select Systems. The System 
Authorization dialog box is displayed. 
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2.   To define authorization level, select an option from the System Authorization Options 
column and then click Add. The name user/group will appear in the Unauthorized Members 
column. 
3.   If there are no users defined for an option, double click the option to open the options 
definition dialog box. Select the name of the user/group/team and click Add and then OK to 
return to the System Authorization dialog box.  
4.   Check the Full Security on Logout checkbox to define this option. 

 
 

 

 
   
 
 
 
 

The following options are available: 
 Full security (disable all) 
Specifies that users will be unable to access functions such as the Task Manager and the 
Start menu (with Alt-Esc),  
run new applications or use a screen saver. 
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 Disable lock station  
Specifies that a user will be unable to block access to a computer by applying a password.  
 Disable shutdown station 
Specifies that a user will be unable to shut down a station. 
 Disable logoff 
Specifies that a user will be unable to log out of the system. 
 Disable changing user password  
Specifies that a user will be unable to change his or her password. 
 Disable ALT-ESC  
Specifies that a user will be unable to access the Start menu. 
 Disable ALT-TAB  
Specifies that a user will be unable to navigate between the programs open on a computer 
using the Alt and Tab keys. 

 
 

 
 

   

 
 

 
 
 

Design / Authorization / System 
Note: This option is available only for Windows NT/ 2000 users.  
 
Select this item to access the Application security system. 
The Application provides an additional system security by ensuring that users access only 
those parts of the system to which they have authorization.  
Note: The Application system security must be installed to enable this option. When the 
Application system security is installed, it replaces the standard Windows system control. 
The Application dialogs overwrite the Windows NT dialogs. 
Selecting this item opens the System Authorization Management dialog box where you can 
define the access permission to Application security system. 
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System Authorization Management 
In this dialog box you set System authorization options to security groups and users.. 

nd groups: 

isable 
orization.  

 
 

To assign system options to users a
1. Select Authorization and then System from the Design menu. The System 
Authorization Management dialog box opens. 
2. Select a System Authorization option and double click on it to display the D
System Authorization dialog box where you can disable users and groups auth
3. Select Full Security when logout to reinstate full system security when the current 
logged in user logs out of the system. 
4. Click OK to close the System Authorization Management dialog box and save your 
changes. 

 

   

 
 

 
 

Disable System Authorization Option 
In this dialog box you define which users and groups are not authorized to perform the 

r application's defined 

x. 
 
 

 

 

selected System Authorization Option. 
By default these System Authorization options are enabled for all groups. Deselect a group 
to disable the selected System Authorization option.  
To disable a system authorization option for groups / users 
1. Select the type of list you want to view:  
 List all Groups&Users - select this option to display a list of you
groups and users. 
 List all Groups - select this option to display a list of your application's defined groups. 
 List all Users - select this option to display a list of your application's defined users. 
2. Select the group / user whose authorization you want to disable. 
3. Click the Add button to add the selected group / user to the list of Unauthorized 
Members. 
4. Click the OK button to return to the System Authorization Management dialog bo

 

   

Overview 

 

User Management - 
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User Management - Overview  
User Management enables management of an application's users both locally and 
remotely (Centralized User Management). Users can be a single user, groups or teams 
built from users in the same groups. 
The application's management methodology, using the Users Timetable module, enables 
simple and efficient scheduling of users, groups and teams.  

 a group called Administrators. Users in this group are 
 name 

s a user/group and modify its parameters. The User 

e imported.  
 

e 

finition of how alarms are transferred and received by users using Advanced 

 
 
 

 
 

By default, User Management has
authorized to modify user properties (including their password). However, the group
cannot be modified or deleted. Users belonging to this group cannot remove themselves 
from it. An authorized user can acces
Management feature provides full backwards compatibility with earlier versions of Wizcon. 
Groups (see Groups Tab) created in previous versions can b
Note:     The default user can be deleted only after a new default user is defined in Station
Properties. Only a user logged in under a different name and with Administrator rights can 
delete the default user. An Administrator must have at least one user in order to access th
application.  
The following basic activities can be performed through User Management: 

     Definition of users, groups and teams o

o     Additional user information such as address can be added 
o     Access permission definition 
o     De

Alarm Management 
o     Backup user definition 

 

   

 

 
 
 

User Management - Overview 
User Management provides you with an advanced security system, enabling you to 
manage the security of an application both locally and remotely. In the User Management 
you can create and manage users, groups and sub-groups, called teams. You can define 
as many groups and users as you need. 
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e then assigned with access permission for changing tags 

 

. The 
 installed by applications. This group cannot be 

moved nor modified. 
 

n 

 
 

The security groups and users ar
value so that only authorized operators can set the tag value, activating a macro, or 
changing an alarm definition and status. For example, by assigning authorization groups to
each tag, an operator who does not belong to any of the assigned groups will not be 
authorized to change tag values. Note that all operators can read tag values, only 
authorized operators can change them. 
 
Groups and users are easily defined from the application studio. The User Management 
tool was added under the tree root and contains two items: Groups and Users.  
Clicking the Groups item displays the list of all the groups in the studio's right hand
Administrators group is the default group
re
Clicking the Users item displays the list of all the users in the studio's right hand, including
a user named "user" default user. 
The User Management tool can also be accessed from the quick access bar by clicking o
the User Management icon.  
 
Defining Users 
Defining Groups 
Defining Teams 

 
 

   

 
 
 

 
 

Steps for Creating Users, Groups and Teams 
This section describes how users, groups and teams are created in the following steps. 

o     Create new users.  See Users Tab  . 
o     Create new groups or add users to existing groups. New users can also be 

created and added in the Groups dialog box.  See Groups Tab  .  
. 

 
 

o  See Creating New Teams  
 

     Create new groups and add teams to them. 

 
 

   

Creating Users 
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Creating Users 
o To define a user: 

In the All Containers section of the Application Studio click User Management and then 
click Users. A List of All Users opens in the Control Panel. 

 

 

  
Note:     If no users are defined in the project then the list will still open with the 
application's default user displayed. 
1.    In All Containers right click Users and then click New or right click anywhere in the 
Control Panel and click New. The New Users dialog box opens.  
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The New User dialog box has four tabs: 

General    Where the user's basic general properties are defined 

Groups    Where the group(s) that the user is a member of are defined  

Messages    Where the user's communication methods for Advanced Alarm 
Management services are defined 

Information Containing information such as the user's address, PIN and other 
comments 
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Defining Users    
Users can be defined as individual security entities as well as members of groups and 
teams.  
To define a user 
In the All Containers tree right click Users then select New. 
Or, Click the Users/Groups icon in the Quick Access Bar, then click the new icon in the 
Users tab. The New User dialog box opens. 
 
A user definition is comprised of several components: 
•     General parameters - including user's unique name, brief description, password, 
layout association and functional permissions.  
•     Group association - selecting the group(s) the user is associated with, and 
defining whether he is the administrator of the associated group(s).  
•     Messenger specifications - selecting the dynamic communication methods, such 
as SMS, e-mail and Fax, the user can be addressed by  
•     Additional Information - including user's address, PIN code and comments.  
 

 
 

   

 
 

 
 
 

Users / Groups Management 
Users are individual security entities that can be selected from any application module that 
requires access permission. 
In this dialog box you can view your application's defined users, add new users and modify 
existing users definition. 
To create a new user 
1. Click the New icon or right click the list of users area and select New User from the 
popup menu. The New User dialog box opens. 
2. Create a new user as explained in Defining Users 
To edit a user's properties 
1. Select the user whose properties you want to modify. 
2. Click the Modify icon or right click the selected user and choose Modify User from the 
popup menu. The User Properties dialog box opens. 
 
To remove a user 
1. Select the user you want to delete. 

207 



Chapter 7 Security and User Management 

2. Click the Delete icon or right click the selected user and choose Delete User from the 
popup menu. A message prompting you whether you want to delete the selected user is 
displayed. 
3. Click Yes to delete the selected user. Click No to abort. 

 
 

 
 

   

 
 

 
 
 

General Tab 
This tab holds fields that define a user's name, description, password and the layout of the 
user's computer screen. The lower section of the tab enables the system manager to 
define access permission both locally and on the Web. 
1.    In the Name field type the name of the user. 
2.    In the Full Name field type in the user's full name. 
3.    In the Description field type in a short description about the user. For example, the 
name of the user's department or job. 
4.    In the Password field type the user's unique password. 
5.    In the Confirm field type the user's password again. 
6.    In the Layout field click the arrow to open the dropdown list and select the relevant 
layout. The user's computer will always open in this view. 
7.    To enable a user to change passwords check the Allow Changing Password 
checkbox. 
8.    To enable the user to update information check the Allow Changing Information 
checkbox. 
9.    To enable the user to access the Web module check the Allow Web Access checkbox. 
10.    If you don’t want the user’s password to expire, check “Password Never Expires” 
11.    If you want to make sure that the user always has a password defined, check “User 
must have a password. 
12.    Click OK to actually create the user. The new user's name will be added to the Users 
List. Or, click Apply and then click the Group tab in this dialog box.  

o To modify existing users: 
1.    In All Containers click User Management then click Users to open the List of Users. 
2.    Right click the specific user to open a popup menu and click modify. Or, double click 
the specific user. The User Properties dialog box will open. 
3.    Modify the users properties and then click OK to confirm. 

o To delete existing users: 
1.    In All Containers click User Management then click Users to open the List of Users. 
2.    Right click the specific user to open a popup menu and click delete. The Delete User 
message will open. 
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3.    Click Yes to delete the user. The User will be deleted from the List of Users. 
u To set a default user: 
1.    In All Containers click User Management and then click Users to open the List of 
Users. 

2.    In the list right click the relevant user and select Set as Default. The  Users icon will 
appear next to the selected user name. 

o To change a user’s password: 
1.    In All Containers click User Management then click Users to open the List of Users. 
2.    Right click the specific user to open a popup menu and click Change Password. The 
Change Password dialog box will open. 
3.    Type in the new password in the New Password field. 
4.    In the Confirm Password field type the new password again. 
5.    Click OK to confirm. 
Note:     The User Name field cannot be changed. 

o To view the List of Users: 
This option has three sub-options Duplicate, Settings and Clear Filters described below: 

o     Duplicate - This option opens a duplicate copy of the List of Users. When right 
clicking and/or selecting a user in the list the same options as for User are 
available.  

o     Settings - This option defines the List of Users settings. There are three 
columns; Full Name, Description and User Name. Columns can be deleted and 
their order changed. 

1.    To delete/activate a column click the checkbox next to the specific column name. 
2.    To change the order the columns appear in the List of Users, select a column name 
and click either Move up or Move down. 
3.    Clicking Select All activates all columns. These columns will be displayed in the List of 
Users. 
4.    Clicking Deselect All de-activates all columns. No columns will be displayed in the List 
of Users. 
5.    Click Default to return to the application settings. 
6.    Click OK to confirm. 

o     Clear Filters - The List of Users table can be filtered alphabetically or numerical 
as follows: 

1.    Type the filter number or letter in the textbox under the List of Users columns. The list 
will be filtered accordingly. 
2.    To clear the filter, right click in the List of Users, select View and then Clear Filters. 
The complete List of Users will open on your screen.  
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User Definition - General    
In this dialog box you define the user's basic and general properties. 
To define the user's general parameters 
1. Type the name of the user in the User name field. 
2. In the Full name filed, type the user's full name. 
3. Enter additional details (such as user's position) in the Description field. 
4. Type the User's password. The password can be up to 20 characters. 
5. Type the password again in the Confirm field. 
6. Select whether the user is allowed to: 
•     Change password.  
•     Change general information.  
•     Access the Web application.  
 

 
 

   

 
 

 
 
 

Groups Tab 
Groups can be created for new users by clicking the Groups tab. However, existing users 
can also be added to groups by opening the List of Users and double clicking the specific 
user to open the User Properties dialog box. 
This tab is divided into two sections, List of Groups and Member Of. The user (see Users 
Tab) can be added or removed to a group or added or removed from all the groups listed. 
Additionally, groups can be created, deleted viewed or modified. A user's properties can 
also be viewed and updated.  
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o To add a user to a/all group(s) 

1.    Select the relevant group/s from the List of All Groups column. 
2.    Click the Add button. The name of the Group/s will be added to the Member of column.  
3.    Click OK to confirm. The user's name will be added to the Group/s. This can be 
viewed when selecting Groups in All Containers to open the Groups List in the Control 
Panel, double clicking the group name and then checking the Users tab. 

o To remove a user from a/all group(s)  
1.    Select the relevant group from the List of All Groups column. 
2.    Click the Remove/Remove All button. The name of the Group will be removed from the 
Member Of column.  
3.    Click OK to confirm. The user's name will be removed from the Group/s.  

o To modify groups 
1.    Select the relevant group from the List of All Groups column. 
2.    Either right click to open a popup menu and select Modify or click Modify button 
located under the List all Groups column.  
3.    Click OK. The Group Properties dialog box will open.  
4.    Make your modifications and click OK to confirm. For further instructions read To add 
new groups. 

o To delete groups 
1.    Select the relevant group from the List of All Groups column. 
2.    Either right click to open a popup menu and select Delete or, click the delete button 
located under the List all Groups column.  
3.    Click OK to confirm.  
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o To add new groups  

1.    Click the  New icon located under the List all Groups column. The New Group 
dialog box opens. This dialog box has two tabs; General and Users. A third tab opens after 
the General tab has been filled, Alert Group checked and the Apply button clicked. 

 
2.    Follow the instructions on Creating Groups to complete this dialog box. 
 

 
 

 
 

   

 
 
 

 
 

User Definition - Groups    
In this dialog box you select the group(s) that the user is a member of and define whether 
the user is the administrator of the selected group(s). 
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To assign the user's group membership 
1. Click the Groups tab to open the Groups page. 
2. Select the group to which you want to add the user as a member.  
3. Click the Add button. The group is added to the Member Of list. To add the user as a 
member to all the groups, click the Add All button. 
To appoint the user to the selected group(s) administrator 
Click the checkbox to the left of the group name. 

 
 

 
 

   

 
 

 
 
 

Messenger Tab 
This tab is used to define how alarms are sent to a user/group/team. The Advanced 
Alarm Management (AAM) messenger service enables the following modes: 

o     Generic Beep 
o     Fax 
o     Cell phone 
o     Email 

To define an AAM messenger service: 
1.     Click the Messenger tab to open the Messenger dialog box. This dialog box enables 
new services to be defined and attached to user/groups/teams.  
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AAM Services can be created, deleted, modified and moved up and down within the list. To 
do so either right click in the Assign to AAM Services window or click the relevant button 
located under the window. In addition back up users can be defined.  
1.     To define a new AAM service either right click in the Assign to AAM Services window 
or click the button to open Messenger menu. 

 
2.    In the AAM Service Name field click the dropdown list and select the type of service. 
3.    In the E-mail/Phone field type in the relevant number/address. 
4.    If alarms are to be sent in short format check the Short AAM Info checkbox (see 
Message Formatting). 
5.    Click OK to return to the user Messenger tab. 
6.    In the Backup user field click the arrow to open the dropdown list and select a user. 
7.    Click OK to confirm. 
Note:     In this version the only service that can be supported by the Backup User is Vocal.  
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User Definition - Messenger    
In this dialog box you can select the dynamic communication methods the user can be 
addressed by using the Advanced Alarm Management services. 
To define the user messenger parameters 
1. Click the Messenger tab to open the Messenger page. 
2. Click the New icon to open the Messenger dialog box. 
3. Select the AAM Service Name from the drop-down list. 
4. Type a phone number or an e-mail address if you selected a service of type that 
requires an e-Mail address or a phone number. 
5. Check the Short AAM Info checkbox if the user is to receive alarm messages in short 
(limited) formatting. 
5. Click OK. The service you added now appears in the list of AAM services. 

 
 

 
 

   

 
 
 

 
 

Information Tab 
Additional information regarding the defined user can be written in the Information tab. This 
information includes address, PIN number (for security/accessing the program) and 
comments. 
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o To add information: 

1.   Click the Information tab.  
2.   In the Address field type in the user's address. 
3.   In the PIN code field type in the user's PIN code. 
4.   In the Comments field type in any comments that may be required. 
5.   Click OK. The new user's name and information appears in the List of Users. 

 
 

 
 

   
 
 
 
 

User Definition - Information    
In this dialog box you can add additional information about the defined user. This 
information includes the User's address, PIN (Personal Identification Number) code and 
free text comments. 
To define the user's Information parameters 
1. Click the Information tab to open the Information page. 
2. Type the user's address in the Address box. 
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3. Type the user's PIN code. 
4. Type the user's additional information. 

 
 

 
 

   

Creating Groups 

 
 
 
 
 

Creating Groups 
o To create a new group: 

In the All Containers section of the Application Studio click User Management and then 
click Groups. A List of Groups opens in the Control Panel.  
 

 
 
Note:     If no groups are defined in the project then the list will still open with the 
application's default Administrator displayed. 
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1.     In All Containers right click Groups and then click New or right click anywhere in the 
Control Panel and click New. The New Group dialog box opens. 
When the New Group dialog box opens it has two tabs General and Users however, there 
is a third tab called Teams which only opens after the General tab has been filled, Alert 
group clicked and the Apply button clicked 
. 

General Where the group's basic general properties are defined  See 
General Tab. 

Users    Where the users that are members of the group are defined 
 See Users Tab. 

Teams    Where the groups that are members of the team are defined 
 See Creating New Teams. 

 
 
 

 
 

   

 
 

 
 
 

Defining Groups    
A group definition is comprised of general parameters and users association. 
To define a group: 
In the All Containers tree right click Groups then select New. 
Or, Click the Users/Groups icon in the Quick Access Bar, then click the new icon in the 
Groups tab. The New Group dialog box opens. 
 
A group definition is comprised of several components: 
•     General parameters - including the group's unique name and description.  
•     Users association - selecting the users who belong to this group.  
•     Teams - creating sub-groups for easy scheduling in the Users Timetable.  
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Group Definition - General   
In this dialog box you define the group's basic and general properties. 
To define the group's general parameters 
1. Type the name of the group in the Group name field. The name of each group has to be 
unique. 
2. Type a general description of the group in the Description field. 
3. Check the Alert group checkbox to enable alarm transmission to the group members 
and scheduling of the group members. 

 
 

 
 

   

 
 

 
 
 

Users / Groups Management 
Groups are security entities containing one or more users, that can be selected from any 
application module that requires access permission. 
In this dialog box you can view your application's defined groups, add new groups and 
modify existing groups definition. 
To create a new group 
1. Click the New icon or right click the list of groups area and select New Group from the 
popup menu. The New Group dialog box opens. 
2. Create a new group as explained in Defining Groups 
To edit a group's properties 
1. Select the group whose properties you want to modify. 
2. Click the Modify icon, or right click the selected group and choose Modify Group from 
the popup menu. The Group Properties dialog box opens. 
 
To remove a group 
1. Select the group you want to delete. 
2. Click the Delete icon, or right click the selected group and choose Delete Group from the 
popup menu. A message prompting you whether you want to delete the selected group is 
displayed. 
3. Click Yes to delete the selected group. Click No to abort. 
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Group Definition - General   
 group's basic and general properties. 

me field. The name of each group has to be 

 general description of the group in the Description field. 
 the group members 

 

 

 
 

In this dialog box you define the
To define the group's general parameters 
1. Type the name of the group in the Group na
unique. 
2. Type a
3. Check the Alert group checkbox to enable alarm transmission to
and scheduling of the group members. 

 

 
 

   

 

 

General Tab 
 name of the group and a description of it, for example 

 
 

 

The General tab defines the
Maintenance, or Security.  
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1.   In the Group Name field type in the name of the Group. 
2.   In the Description field type in a description of the group. 
3.   In order to use this group with the AAM module and to create teams in the group, 
check the Alert Group checkbox. 
4.   In order to define this as a shift group, check the shift group checkbox. Note that only 
one group can be defined as a shift group. 
5.   Define the minimum password length for members of this group. 
6.   Click Apply. The Teams tab is added to the dialog box. 

 
 

 
 

   
 
 
 
 

Users Tab 
The Users tab defines the users that are members of the group. This tab is divided into two 
sections, List of Users and Member. Users can be modified, added or removed from 
groups. 
 

221 



Chapter 7 Security and User Management 

 
 
1.    To add a user to a group, select a user from the List all Users column and click the 
Add button. Alternatively, select all the users in the column and click the Add all button. 
The users will appear in the Members column. 
2.    To remove a user, select a user from the Members column and click the Remove 
button. Alternatively, select all the users in the column and click the Remove all button. The 
users will be removed from the Members column.  
3.    Click Apply. 

o To add new users  

1.    Either right click to open a popup menu and then click New or click the  button 
located below the List of Users column. The New User dialog box will open. 
2.    Follow the instructions above for creating a new user. Click OK to confirm. 

o To define a group administrator  
1.    In the Members column check the checkbox next to the relevant user's name. 
2.    Click OK to confirm. 

o To modify existing users  
1.    In the Group Properties Users tab select a specific user from the List all Users column.  

2.    Either right click to open a popup menu and then click Modify or click the  button 
located below the List of Users column. The User Properties dialog box will open. 
3.    Modify the relevant properties and click OK to confirm. 

o    To delete existing users  
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1.    Right click the specific user to open a popup menu and click delete. The Delete User 
message will open. 
2.    Click Yes to delete the user. The user will be deleted from the List of Groups. 
3.    Click OK to confirm. 
 

 
 

 
 

   

 
 

 
 
 

Group Definition - Users    
In this dialog box you select the members of the group and select the group's 
administrator(s). 
To select the group members 
1. Click the Users tab to open the Users page. 
2. Select the user(s) you want to be members of the group. 
3. Click the Add button to add the selected users to the group. 
4. Click the Add All button to add all the users to the group. 
To define the group administrator(s) 
Check the box to the left of the user name in the Members list. 
To remove group members 
1. Select the user(s) you want to remove from Members list. 
2. Click the Remove button. 
3. Click the Remove All button to remove all the users from the group. 

 
 

 
 

   

 
 

 
 
 

Group Definition - Teams   
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Security teams are created within a defined group. The definition of a team enables you to 
easily schedule your group members. 
 
Note that a team can be created only after the group general parameters and members 
were defined. 
To create a team 
1. Click the Teams tab to open the Teams page. 
2. Click the New icon or right click the teams list area and select New Team from the 
popup menu. 
 A new team icon with an empty text box is displayed in the list of all teams. 
3. Type the name of the new team in the text box. 
4. Click the Members icon or right click the team you created and select Team Members 
from the popup menu. The Team Members dialog box opens. 

 
 

 
 

   

 
 

 
 
 

A group administrator is authorized to add and remove users to his group, and to 
modify his group name and description. 
 

 
 

 
 

   

 
 
 

 
 

The Administrators group is the default group provided by the application. Users in this 
group are authorized to modify users properties (including name and password). The 
Administrators group parameters cannot be modified nor deleted, and a user who is a 
member of the Administrators group cannot exclude themselves from this group. 
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Creating Teams 

 
 
 
 
 

Creating Teams 
The users can be grouped into teams in order to schedule in a calendar ( see Users 
Timetable) at what time they can be reached once an alarm occurs.  
Each alarm can be linked to a user group. According the user timetable, NovaPro Open is 
able to route the alarm to the on duty team. 

Creating New Teams 
 

 
 
The Teams tab has two columns; List All Teams and Members.  
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Teams can be  created, deleted, renamed and  new members can be added 
to them. To do so either right click the team name to open a popup menu and select your 
option or, click the relevant button located under the List all Teams column. 
 
1.    To create a new team either right click in the List All Teams column and click New 

Team, or click the New icon . A textbox with a team icon will open in the List all Teams 
column. 
2.    Type in the team's name and then click Apply. 

o To add users to teams 
1.    To add members to the team, select the team in the List all Teams column and then 

either right click to open a popup menu and select Team Members or click the  button. 
The Team Members dialog box will open.  
2.    From the List all Group Members column select the relevant groups that will be added 
to the team and then click Add. Click OK to confirm. The name of the user will appear in 
the Members column.  

o To delete teams 

1.    Right click the specific user to open a dropdown list and click Delete or click the  
button. The team will be removed from the List of Teams. 
2.    Click OK to confirm. 

o To rename teams 
1.    Right click the specific user to open a popup menu and click Rename or click the 

button.  
2.    Type in the new team name. 
3.    Click OK to confirm. 
The Teams tab has two columns List All Teams and Members.  

Teams can be  created,  deleted,  renamed and  new members can be 
added to them. To do so either right click the team name to open a dropdown list and 
select your option or, click the relevant button located under the List all Teams column. 
1.    To create a new team either right click in the List All Teams column and click New 

Team, or click the New icon.  
2.    Type in the team's name and then click Apply. 
3.    To add members to the team, select the team in the List all Teams column and then 
either right click to open a popup menu and select Team Members or click the button. The 
Team Members dialog box will open.  
4.    From the List all Group Members (page) column select the relevant groups that will be 
added to the team and then click Add. Click OK to confirm. The name of the user appears 
in the Members column. Click OK to confirm.  
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Team Members 
Use this dialog box to add members to the team. 
To add members to the team 
1. From the list of All Group Members select the users to be the members of the team 
and click the Add button. 
2. Click the Add All button to add all the group members to the team. 
3. Click OK when done. 
To remove team members 
1. Under Team Members, select the user(s) you want to delete from the team. 
2. Click the Remove button. 
3. To delete all the team members, click the Remove All button.  

 
 

 
 

   

 
 

 
 
 

Group Definition - Teams   
Security teams are created within a defined group. The definition of a team enables you to 
easily schedule your group members. 
 
Note that a team can be created only after the group general parameters and members 
were defined. 
To create a team 
1. Click the Teams tab to open the Teams page. 
2. Click the New icon or right click the teams list area and select New Team from the 
popup menu. 
 A new team icon with an empty text box is displayed in the list of all teams. 
3. Type the name of the new team in the text box. 
4. Click the Members icon or right click the team you created and select Team Members 
from the popup menu. The Team Members dialog box opens. 
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Station Access Restrictions 

Presentation 
   

This feature enables the customer to restrict access to a specific station of a wizcon 
network.  

   
This module is originally developped in WizUM.dll (user management) and is design to 
work with centralized user management.  

   
How to use Station Access Restriction 

   
1-configuring station access restriction 

   
It is possible to grant or revoke access to a station for a specific user or group. This 
function is accessible via the user property dialog and the group property dialog. Note 
that in case of conflict between group and user access right, the most restrictive solution 
will be effective.  
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The computer restriction sheet  
 
Every online station of the Wizcon network is automatically listed in the left list control, and 
each authorized station is listed in the right. The Wizcon administrator may add station to 
the list by clicking the “add new computer” button.  
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Adding manually a new station to the network  
 
By default, each new station is accessible to every user. Be sure to keep your access 
rights up to date.  
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The station was added to the list.

 
 

 
 

   
 
 
 
 

Shift Management 

One and only one group in the system can be defined as a shift group. You can use this 
group to define when users can logon to the system. For this group you must define a set 
of teams and, as with any other team, add users to the team. You can now use the shift 
management dialog box to define the timetables for when the members of each team are 

allowed to enter the system. Press the  button on the Quick Access bar. This will 
open a dialog box that is identical in every repect to the User Timetable dialog box. The 
only differences are that, in this case, the teams included in the shift group are pre-
selected and instead of defining the times at which alarms are sent to members of the 
teams, you are defining the times at which users of each team can logon to the system. If 
you want to know how to use this dialog box, please refer to the chapter that describes 
user timetables, keeping in mind these differences. 

231 



Chapter 7 Security and User Management 

232 

 
Once this time period has expired, 

 
 

Once the shift management timetable has been completed, users will only be allowed to
login to the system during the specified time period. 
they will be logged out of the system. Note however, as described in the section below, a 
shift overlap time can be defined, allowing a small amount of flexibility into the system.  

 
 

   
 
 

User Password Security 

 define how passwords are managed by the system. To 
ing dialog box. To do this, right-click on the user 

 
 

You can define a set of rules that
define a set of rules, you open the follow
management tab on the left of the studio, then choose “Properties”. 
 

 
 
Use this dialog box to specify rules for password management. 

.    Password valid for: You can specify for how many days a password will be valid. The 

ut to expire. 
o 

between known passwords. This enhances security of 

 the user’s password must contain at least one letter, one 

1
limits are displayed. 
2.    Password expiration reminder:  Use this option to give a reminder to the user when 
their password is abo
3.    System keeps up to: You can force the system to remember several old passwords s
that the user cannot simply switch 
the password checking system. 
4.    Check password format:  You can force the user to enter a password with a given set 
of rules. If this option is checked,
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 to the system for 

o 

 

digit and one special symbol from !,@,#,$,%,&,_,-. If this rule is not followed, the user will 
not be able to change the password next time it needs to be changed. 
5.    Shift overlap time: If you have enabled shift management you can specify an "overlap 
time". This means that users from the current shift can continue to login
up to the specified amount of time after their shift is supposed to end or that users from the 
next shift can login to the system for the specified amount of time before their shift is due t
start. 
 
 

 

 
 

   

 
 

 

ser Management Properties 

og box to specify rules about password management. 

rd will be valid. The 
mits are displayed. 

 reminder:  Use this option to give a reminder to the user when their 
assword is about to expire. 

n force the system to remember several old passwords so 
at the user cannot simply switch between known passwords. This enhances security of 

an force the user to enter a password with a given set of 
les. If this option is checked, the user’s password must contain at least one letter, one 

ou can 
pecify an "overlap time". This means that  

pposed to end 

 
 

U

 
Use this dial
 
Password valid for: You can specify for how many days a passwo
li
 
Password expiration
p
 
System keeps up to: You ca
th
the password checking system. 
 
Check password format:  You c
ru
digit and one special symbol from !,@,#,$,%,&,_,-. If this rule is not followed, the user will 
not be able to change the password next time it needs to be changed. 
 
Shift overlap time: If you have enabled shift management (see the user guide), y
s
-          users from the current shift can continue to login to the system for up to the 
specified amount of time after their shift is su
-          users from the next shift can login to the system for the specified amount of time 
before their shift is due to start. 
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iometric Login 

stomer to replace old login/password authentication method by 
rprint in fact) mechanisms. This new functionality enhances overall security.  

 specificities. 
 

print. 

How

 the user management item in Studio tree and 
se nt configuration dialog opens.  

 
 

B

Presentation 
This feature enables the cu
biometric (finge

Description 
enables enrollment of users fingerprints, and user authentication (1-1 and 1-This function 

n) using body
• 1-1 or authentication process is an operation that consists in validating a user login

with a fingerprint.  
• 1-n or identification process is an operation that consists in identifying a user 

thanks to his finger

 to use Wizcon Biometric Login 
1-configuring biometric login 

To n access biometric login, right click o
lect Properties. The user manageme

 
 
To set up bio
th

metric login, you just have to select the biometric device you want to use on 
is station. All available drivers are listed in the combo box; select the device installed on 

your computer.  
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You also have the possibility to choose between to different login strategies:  

• 1-to-many or Identification: if you choose this strategy, biometric information is 
used to identify your identity and, if available, your account.  

1-to-1 or Authentication: if you choose this strategy, the login flow remains as usual 
excepts that, to finalize your login with a specific account, you have to provide biometric 
information that matches with account you are login with.  
 

 
 
To use 1-to-many, you have to check the use 1to-n auth check box, otherwise the system 
is using 1 to 1 strategy.  

   
2-Enrolling a user 
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To enrol a new user or an existing user, check the use biometric login check box and press 
the enroll button.  

 
 
If your device is correctly installed, the biometric enrollment dialog appears; you can now 
put your finger on the fingerprint reader.  
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In order to validate your fingerprint for enrollment, your finger must be placed so that the 
cross is inside the target circle. A green screen indicates that your fingerprint has been 
validated.  

 
 
To validate the setting, you only have to save user configuration.  
 
NB: You cannot enroll two different users with the same biometric information.  
 

3.Using identification 
If you have selected the use 1-n auth during biometric login setup, you are using 
identification. Once you try to login to the application, the identification dialog appears.  

 
 
The system will search in its database for corresponding biometric information, and you are 
logged automatically to the right account.  

   
4.Using authentication 

If you have not selected the use 1-n auth during biometric login setup, you are using 
authentication. Once you try to login to the application, the usual login dialog appears.  
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Once you provide information regarding to a user account, if this user has been enrolled, 
you are prompted to authenticate your identity.  

 
 
If the biometric information provided is correct, you are logged to the system. 

 
 

 
 

   

 
 

 
 
 

LDAP/smartcard login Documentation 

Presentation 
This feature aims to import Active Directory users and groups into NovaPro Open user 
management database. Active Directory is then in charge of user authentication for 
imported users. This feature also enables the customer to replace old login/password 
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authentication method by PKI (using smartcard/token) mechanisms. This new functionality 
enhances overhall security.  

   
This module is originally developped in WizUM.dll (user management) and a new module 
loaded statically(WizADSync.dll) handle data from Active Directory. Two drivers are loaded 
dynamically: a LDAP driver (WizLDAPDrv.dll) and a smartcard driver (WizSCDrv.dll).  
  

1-Importing active directory users into NovaPro Open 
   

The import users/groups function is accessible by right-clicking the user management item 
in the studio tree control.  
 

 
Click the “import AD users” item to launch the import tool.  
 
The import tool then asks for Domain name and Domain controller address (IP address or 
DNS Name).  
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Enter the domain name and Domain controller address.  
 
The tool then asks for a user account with which it will bind to the server. This user must 
have read access to the directory.  
 

 
Enter your AD user name and password.  
 
The import tool produces a tree view containing a hierarchical view of Active Directory 
users and groups. We can see that imported groups and users are already selected. The 
user will now select groups and users he wants to add to its Wizcon project.  
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Tree view with selected users and group.  
 
Now, users and groups are imported, and the credential authentication will be transparently 
handled by the domain controller.  

   
While running Wizcon in studio mode, Active directory users/groups will be recognizable to 
their specific red icons.  
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AD users and Wizcon users are graphically different.  
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AD groups and Wizcon groups are graphically different  
  

   
2-Smartcard authentication 

2-1-User requirements 
   

Smartcard authentication, simply put, allows Wizcon users that have been imported from 
an Active Directory that supports smart card login to login into Wizcon using smartcards. 
The user will be logged out of Wizcon when smart card is removed.  

   
Smart card authentication is handled natively by Windows and Wizcon will take advantage 
of this support. This smartcard support is done using the standard Microsoft PKI (Public 
Key Infrastructure) architecture. Wizcon X will support the eToken smartcard solution from 
Aladdin. These smartcards are USB sticks with integrated readers – these were chosen 
because they are an industry proven, secure and low-cost solution  

   
Note that this functionality will also be available via the Web interface.  

   
2-2-System requirements 

   
Handling of the details of the login process is an IT task, performed at the enterprise level. 
In order to support Microsoft PKI the user must have access to a proper Domain Controller 

243 



Chapter 7 Security and User Management 

(DC) running Active Directory (AD) 2000 or 2003. A Certificate Authority (CA) must be set 
up and trusted by the DC.  

   
The trust of the CA is established by importing the CA certification path, the CA certificate 
and the CA revocation list into active directory.  

   
In order to the setup the PKI, an enrolment station certificate template and a smartcard 
user certificate template must be activated at CA level.  

   
Enrollment is the process of identifying a user to the system. In order to enroll a Wizcon 
user, the enrolment station must possess an enrolment station X509 certificate delivered 
by the trusted CA and an Administrator signature certificate. The Enrolment station must 
also have an eToken RTE driver installed. Smartcard enrolment can then be performed by 
a system administrator.  

   
In order to perform login at a Wizcon station, it must have the eToken RTE installed and 
network access to the Domain Controller.  

   
During login to a Wizcon station, the user will insert the smartcard when requested and 
must enter his pin code. User is then authenticated against the smartcard. The smartcard 
user certificate delivered during enrolment can be retrieved and authenticated against the 
DC.  

   
2-3-smartcard login 

   
When trying to login to Wizcon, the user is asked to insert their Smartcard by the following 
dialog.  

   

 
Smartcard login dialog  
 
A soon as the token is inserted; the authentication process is handled by AD and if the 
user has access, they will be logged in automatically. If however, the user presses ctrl + L, 
the standard login dialog is opened and they can login using the standard login and 
password mechanism (which of course will use Active Directory if the user has been 
imported from Active Directory).  
 

 
Standard login dialog
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Centralized User Management 

By default, user management in NovaPro Open is provided by a local MS ACCESS 
database (WizUM.mdb). The Centralized User Management gives you the possibility to 
make changes on one station and have them immediately available to all other stations on 
the network.This is particularly useful in large-scale configurations. 
In this case, user management is provided by a MS SQL Server database located on a 
central computer. See Appendix D, Installing SQL Server database for details of how to 
setup this centralized database architecture. 
 

o Setting up Wizcon to use SQL Server database 
Once the Centralized User Management database has been installed (see Appendix D, 
Installing SQL Server database), the Wizcon stations must be set up to use this 
database instead of their local one. 
1.    In Wizcon Studio, right-click on project name and select “Station Properties”.  
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2.    In the “User Management” tab as show above, select “Microsoft SQL Server” by 
clicking on the related radio button. 
3.    Complete the additional information required : 

o     The server name that hosts the centralized user database. A browse button 
helps if the name is not known. 

o     The login name and password of the database owner which was defined when 
creating the database (Appendix D, Installing SQL Server database). 

o     “Synchronize” option which allows the station to keep the local and central 
databases synchronized.  

o     If the “Synchronize”option is checked and there is a loss of connection between 
the station and the server hosting the central database, Wizcon will switch to use 
the local user management database. Once the connection is restored, Wizcon will 
reconnect to the central database. However, it may be that either the local or the 
central database has changed during the period of disconnection. You must define 
in which direction to synchronize the databases after the reconnection. There are 
two options: 

o From the Local database to the Central database. In this case, you choose the 
“Overwrite Central database” and this will overwrite the central database with the 
local database information. 

o     From the Central database to the Local database. In this case, you “Overwrite 
Local database” and this will overwrite the local database with the central database 
information. Wizcon strongly recommends that this option is chosen on all stations. 

o     A “Synchronize Now” button can initiate an immediate synchronization in the 
direction specified above. 

The centralized user database is now available from the configured local station. Each time 
a change is made on the central database, the information will automatically be updated in 
local database. 
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o In case of disconnection 
If the connection between station and Centralized User database is broken : 
1.    a message box appears 

  
2.    Wizcon switches from the centralized database to its local Access user database and 
will continue to work as before the disconnection. 
Once the network connection is restored : 
1.    Wizcon will attempt to connect the central database 
2.    The synchronization process starts silently in the chosen direction as specified in the 
previous paragraph (Appendix D, Installing SQL Server database).  
3.    However, a Wiztune parameter (See Wiztune User Guide), 
UM_SHOW_DIALOG_ON_RECONNECT can be set to 1 to inform the user that 
connection has been restored and select the synchronization process he wants. This 
parameter is set to 0 by default, meaning that the dialog box shown below will not appear. 
Wizcon recommends that this option remains disactivated. 
  

 
 
4.    A System tag, WIZSYS_UMCentralDatabase, is available to inform the user which 
database is in use, Local or Central (see System Tags). 
Note:    You will not be able to modify tag and alarm definitions or menu authorizations 
while you are disconnected from the centralized user management database. 
 

 
 

 
 

   

Other Topics 
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Set User Class    
In this dialog box, you can select user classes that will be assigned to the alarm.  
User classes are used in the events summary to filter and display alarms. Note that only 
one user class can be assigned per alarm.  
  
To define user classes for alarms,
1. Select an Alarm from the Alarms list. 
2. Check the User Class box, this will enable the Classes combo box. 
3. Choose the classes wanted. 

 
 

 
 

   
 
 
 
 

A dialog box is used by the operator to enter data for different system functions. They are 
similar to forms that act as interfaces between the Application operator and the system. 
The contents of each dialog box are different, although many dialog boxes contain several 
common fields. 

 
 

 

 
   
 
 
 
 

Set Group Access     
The Application allows you to define security groups for changing tags value by an 
operator, so that only authorized operators can set the tag value. This is implemented by 
assigning authorization groups to each tag. Operators that do not belong to any of the 
assigned groups will not be authorized to change tag values. Note that all operators can 
read tag values, only authorized operators can change them. 

248 



Chapter 7 Security and User Management 

Once a group is assigned to a tag, any operator that belongs to that group can perform tag 
value operations on that tag. Operators not assigned to a group that matches any of the 
tag groups, will not be able to set new tag values. 
In this dialog box, you can assign groups to a tag. each group which was selected is 
assigned to the tag. Operators not assigned to a group that matches any of the tag groups, 
will not be able to set new tag values. 
Set all - provide all defined group with the access permission. 
Reset all - disable all groups from setting new tag values. 
As an example of how group authorization works, if an operator is assigned the groups 
Engineer and Operator, and a layer is assigned the groups Engineer and Manager, that 
operator will be able to access the image layer. However, if the operator was assigned the 
groups  
Operator and Maintenance, that operator will not be able to access the layer.  

 
 

 
 

   
 
 
 
 

Set User Class     
Use the set user class to select an alarm user class from a list of predefined classes. Each 
alarm can be assigned to only one class. Alarm classes enable you to identify the alarm 
more easily and classify alarms in online and historical events summary 
  
In this dialog box, select a class and activate the OK button. 
To cause no class to be selected, activate the Reset All button. 
Note that each class that appears in this dialog box was defined by the operator in the 
User Class Definition procedure.  

 
 

 

 
   
 
 
 
 

Users / Groups  
Click the User Management icon to open the Users / Groups Management dialog box 
where you can define your applications security groups and users. 
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Alarm Recipients 
In this dialog box you select the recipients of the alarm. 

 To defined the Groups&Users - select this option to display a list of your application's 
defined groups and users.  

 List all Groups - select this option to display a list of your application's defined groups.  
 List all Users - select this option to display a list of your application's defined users.  
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About this chapter: 
This chapter describes how to define communication drivers in the application, as follows: 
Overview is an overview of communication drivers and communication blocks. 
Defining Communication Drivers describes how to add and remove communication 
drivers to and from your application. 
Communication Driver Properties describes how to define general driver properties, 
serial port parameters and communication blocks. It also describes how to view general 
driver information.  
Converting Communication Block Definitions describes the conversion utility used for 
communication block definitions. 
Defining OPC (Application Client) provides an overview of OPC (OLE for Process 
Control). 
OPC Driver Properties describes defining OPC driver properties. 
 
 

 
 

 
 

   

 
 

 
 
 

Overview 

Communication drivers handle communications with external devices, such as PLCs, 
industrial instruments, remote computers and field buses. These drivers are separate 
program files, which are installed when installing the application. Communication driver file 
names have the format VPIWN??.DLL , in which ?? is the two- or three-letter code of the 
driver. Since each communication driver is different, the driver's information documentation 
should be consulted for specific communication driver details. 
You can define communication blocks to improve driver performance when working with 
large quantities of tags. These blocks enable you to transfer large blocks of information 
instead of individual data items.  
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The first step in designing an application is to define the communication drivers and blocks. 
You then define the tags, which are control values monitored by the system. They are used 
as internal variables for: 

o     Calculations and display. 
o     Communication with PLC's in order to represent data from PLC memory or to 

send commands to PLC's.  
Note:     In fast Pentium PCs with a 16550 UART (serial interface chip), Windows 2000/XP 
default settings may cause communication errors on serial communication drivers. To 
overcome this problem, lower the buffer sizes on the UART in the following menu: 
Start/Settings/ Control Panel/System/Device Manager/Ports/Communication Port 1.4/ Port 
Settings/Advanced. Use a trial and error method to reach the optimum setting. 

 
 

 
 

   

 
 

 
 
 

Defining Communication Drivers 

Communication drivers are defined in the Communication Drivers dialog box, in which you 
can add and remove drivers and define driver properties. 

o To add/remove a communication driver: 

In the Control Panel of the Application Studio, double-click the  icon.  
Or, 
In the Design menu of the Application Studio, select Communication Drivers. The 
Communication Drivers dialog box is displayed: 
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This dialog box has the following fields: 

Logical Name Specifies the communication driver’s unique name 

Device    

Specifies the name of the physical device. The standard 
name is COMn, where n is a number that refers to the 
serial port of the computer. Drivers that use standard 
TCP/IP, or proprietary network, do not require this 
parameter. 

Name Specifies the name of the communicating driver. For 
example; SIEMENS, SIMATIC S7. 

Parameters Specifies the Device access rights. For example, 
Read/Write and ‘Out of Block’. 

    
o To add a driver 

Click the Add button. The Communication Driver Setup Wizard is displayed. 
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1.    To install a driver from the List (installed with the application) double click the name of 
a communication driver and then click Next. 
 

 
 
2.    Type in a unique logical name for the driver in the relevant field. 

255 



Chapter 8 Communication Drivers 

3.    Click the up/down arrows to define communication time-out or type directly the value in 
the related field. 
4.    Click the relevant text box to define the driver's attributes. This can be either Write, 
Read or Sample tags outside of blocks. 
5.    To modify the Init File, click the Edit Init File button to open a text editor where the file 
can be created/edited.  
6.    Click Next. The Communication Driver Setup Wizard - Serial dialog box opens.  
 

 
 
This dialog box enables you to define the driver’s Com port connection and communication 
parameters. 
7.    To define the Com port click the field’s arrow to open a dropdown list and make your 
selection. 
8.    Fill the Baud Rate, Data Bits, Parity and Stop Bits fields according to the default 
parameters. 
9.    Click Next to open the Communication Driver Setup Wizard - Blocks dialog box. 
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The following options are available: 

Add    Click to add a new communication block to the selected driver 

Delete Delete a communication block from the list 

Modify    Modify an existing communication block 

Files    This option has two sub-options Import and Export 

10.     Click the Add button. The Block Definition dialog box is displayed. 

 
The following options are available: 

Block Address  
The starting address of the block in the device. For address format 
specifications, see the relevant communication driver section in the 
Wizcon Systems Driver documentation. 
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Length  Number of items in the block. 

Sample Rate Sampling rate of the block in seconds and milliseconds. 

Note:     After defining communication drivers restart the application to enable the new 
definitions. 
 

o To remove a driver: 
1.    Select the driver you want to remove and click the Remove button. The driver is 
deleted from the list of drivers. 
 

 
 
Note:     After removing a communication drivers, restart the application to enable the new 
definitions. 
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Design / Communication Drivers    

Select this item to define Application Communication Drivers.  
  
Communication Drivers are drivers used for communications with external devices such 
as PLCs, industrial instruments, remote computers, and network stations. Defining a 
Communication Driver is equivalent to defining a communications channel to a device. In 
the applicaiton, once a channel is defined, it will be referenced only by its assigned 
Communication Drivers.  
  
Communication Drivers are implemented as separate program files called Drivers, which 
are loaded into the application folder during Application installation. Each Communication 
Driver is identified by a two-letter code which appears in the driver filename as 
Communication Driver??.DLL, where ?? is the Communication Driver identification code.  
  
After you select this item, the Communication Drivers Definition dialog box appears 
enabling you to enter the Communication Drivers specifications. 

 
 

 

 
   
 
 
 
 

Design / Communication Drivers    

Select this item to define Application Communication Drivers.  
  
Communication Drivers are drivers used for communications with external devices such 
as PLCs, industrial instruments, remote computers, and network stations. Defining a 
Communication Drivers is equivalent to defining a communications channel to a device. In 
the application once a channel is defined, it will be referenced only by its assigned 
Communication Drivers.  
  
Communication Drivers are implemented as separate program files called Drivers, which 
are loaded into the application directory upon Application installation. Each Communication 
Driver is identified by a two-letter code which appears in the driver filename as 
Communication Driver??.DLL, where ?? is the Communication Driver identification code.  
  
After you select this item, the Communication Drivers Definition dialog box will appear for 
you to enter the Communication Drivers specifications. 
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Communication Driver Properties 

 
 
 
 
 

Communication Drivers Dialog box 
This dialog box has the following fields: 

o Logical Name Specifies the name give to the driver for application identifiction 
purposes 

o Device Specifices the name of the physical device. The standard name is COMn, 
where n is a number that refers to the serial port of the computer. Drivers that use 
standard TCP/IP or proprietary network, do no require this parameter. 

o Name Specifies the name of the communicating driver. 
o Parameters Specifies the device access rights. 

 
 

 
 

   

 
 

 
 
 

Communication Driver Properties 
Communication driver properties are defined in the Communication Driver dialog box.  

o To define communication driver properties: 
1.    In the Design menu of the Application Studio, select Communication Drivers. The 
Communication Drivers dialog box is displayed.  
2.    Select a driver and then click the Properties button to display a dialog box in which you 
can define communication driver properties. 
In this dialog box you can define the following:  

o     General driver properties, in the General Tab. 
o     Serial port parameters, in the Serial Tab. 
o     Communication blocks, in the Blocks Tab. 
o     View information about the driver in the Information Tab. 
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Communication Drivers - General 
Used to define the communication parameters. 

ime out - Defines the period of time (in hundreds of seconds) during which the system 
tion failure. 

ice. 
• the Write option enables write only operation with the device. 

to 

 
 

 

 
Logical name- Any name for personal identification purposes. 
 
T
waits for response from a device before indicating a communica
 
Attributes 

• Checking the Read option enables read only operations with the dev
 Checking 
• Checking the Out block option enables the referencing of elements not included in 

the blocks. If you do not select this option, communications will be limited 
elements within the blocks. 

 
 

   

 
 
 

 
 

Communication Drivers - General 
This dialog box is used to define the communication drivers parameters. 
Logical name --Any name for personal identification purposes. 

 (in hundreds of seconds) during which the system 
. 

rite - select to enable write only operations with the device. 

Time out - Defines the period of time
waits for response from a device before indicating a communication failure
  
Attributes 
Read - select to enable read only operations with the device. 
W
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 elements that are not 
ications will be limited to 

 
 

Sample tags Outside of blocks - select to enable referencing
included in the blocks. If you do not select this option, commun
elements within the blocks. 

 

   
 
 

Communication Drivers Definition 

iver 
al device. The standard name is COMn, where n 

 standard TCP/IP, 

 
Click the Add button to open the Communication Driver Setup Wizard. 

 
 

 

 
 

This dialog box has the following fields: 
Logical Name Specifies the unique name of the Communication Dr
Device Specifies the name of the physic
is a number that refers to the serial port of the computer. Drivers that use
or proprietary network, do not require this parameter. 
Name Specifies the name of the communicating driver. For example; SIEMENS, SIMATIC 
S7. 
Parameters Specifies the Device access rights. For example, Read/Write and out of block. 

1. 
2. Select a driver and then click the Remove button to delete this from the list. 
3. Select a driver and then click the Properties button to view/edit the driver’s 

properties. 

 
 

   

 
 

 
 
Communication Drivers Setup 
This dialog box enables you to select a communication driver from the given list (the list is 

 the Communication Drivers dialog box. The 
Communication Driver setup opens 

driver from the list and press Next to continue. 
 
 

 

originated in the Install Process). 
 
To access this dialog box: 

1. Press the Add button from

2. Select a name of a 
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Communication Drivers - Add Block 
 

tion Drivers Property block dialog box (VPI Icon/ 

ms in the block 
g rate of the block in seconds and milliseconds  

 
 

 

Used to define a communication block. 
 

o define a communication block, follow the next steps: T
Press the Add button in the Communica

roperties button/Block Tab). P
 
Complete the following fields: 

• Address - The starting address of the block in the device. 
• Length - Number of ite
• Sample rate - Samplin

 
 

   

 
 
 

 
 
Communication Drivers - Block Definition 
 
In this dialog box, you can define contiguous communication blocks in the address space 

 
The
Add  block in the device. For address format specifications, 
see LC Technical Information manual.  

of the external device.  
 
Communication blocks can be transferred in single communication transactions, which can 
greatly improve data transfer speed and system performance.  
 
To define a block, follow the next steps 

1. Select the communication drivers from the Design menu. 
2. Select a driver from the drivers list 
3. Press the properties button 
4. Select the Blocks Tab. 

 fields in this box are as follows:  
ress The starting address of the

 the relevant section in the P
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other words, this is the region from Address to 

s in the external 
evice, it may be necessary to define Length as the number of bits divided by 16 (and 

 button to change the current block definition with the new specifications.  
elete Activate this button to delete a block definition from the list. 

 
 

 
Length Number of items in the block. In 
Address+(Length-1) in the external device that will be accessed. Note that when blocks of 
discrete items (single bits) are transferred, and comprise single word
d
rounded).  
 
Sample Rate The sample rate of the block in seconds and milliseconds.  
Add Activate this button to add the block definition to the list.  
Modify this
D

 
 

   

 
 

 
 
 

Communication Drivers - Block Definition 
In this dialog box, you can define contiguous communication blocks in the address space 
of the external device.  

ingle communication transactions, which can 
m performance.  

Communication blocks can be transferred in s
greatly improve data transfer speed and syste
You can also export communication block definitions to external sources in fixed or 
CSV file format, and Import them to the Application in fixed or CSV file format. 
To define a block follow the next steps
1. Select the communication drivers from the Design menu. 
2. Select a driver from the drivers list 
3. Press the properties button 
4. Select the Blocks Tab. 
The fields in this dialog box are as follows: 
Address The starting address of the block in the device. For address format specifications, 

 the PLC Technical Information manual.  
 other words, this is the region from Address to 

ivided by 16 (and 

 button to change the current block definition with the new specifications.  

list.  

see the relevant section in
Length The number of items in the block. In
Address+(Length-1) in the external device that will be accessed. Note that when blocks of 
discrete items (single bits) are transferred, and comprise single words in the external 
device, it may be necessary to define Length as the number of bits d
rounded).  
Sample Rate The sample rate of the block in seconds and milliseconds.  
Add Activate this button to add the block definition to the list.  
Modify  this
Files  Click to export/import communication block definitions. 
Delete Activate this button to delete a block definition from the 
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Converting Communication Block Definitions 
The application provides a conversion utility for communication block definitions. You can: 

l sources in fixed or CSV file format.  

ect Communication Drivers. The 

erties are displayed:  
 

 Export from the popup menu. The Open block file for export dialog is displayed. 
 the standard Open dialog. 

 Open. The file is exported. 

played. 
f type field, select the type of file you want to import. You can choose 

ous 

r importing files for changes to take effect. 
 
 

 
 

Export communication block definitions to externa
Import communication block definitions to the application in fixed or CSV file format. 
To import/export communication block definitions:  
To convert communication block definition: 
1. In the Design menu of the Application Studio, sel
Communication Driver dialog is displayed. 
2. Select a driver from the list of available drivers, click the Properties button and then 
select the Blocks tab. The communication driver prop
3. Click the Files button. This displays a popup menu in which you can select Export or
Import. 
4. To export:  
a. Select
This is similar to
b. In the Files of type field, select one of two export options: BLS or CSV.  
c. Locate the file you want to import and click
5. To import:  
a. Select Import from the popup menu. The Choose block file dialog is dis
b.  In the Files o
between BLS or CSV.  
c. Locate the file you want to import and click Open. The imported file will replace previ
block definitions. 
  
Note: Restart afte

 
 

   
 
 

Communication Drivers - Information 
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 - This field could have one of two parameters: 

NUL value appears in this field, it 
ith any field 

 
 

Used to present the overall information available on a specific driver. 
 
Type
Serial - Defines parameter for serial communication (RS-232C protocol). 
NUL- Any driver which is not of a Serial type. When the 
means that the specific communication driver is not meant to communicate w
device. 
Support - Describes the functions the driver supports. 

 

   

 
 

 
 

Communication Drivers Information 
This dialog box is used to present the overall information available on a specific driver. 

rial defines parameter for serial communication (RS-232C protocol). 
e NUL value appears in this field, it 

te with any field 

 
 

 

 

  
Type this field may contain one of two parameters:  
Se
NUL any driver which is not of a Serial type. When th
means that the specific communication driver is not meant to communica
device. 
Supports describes the functions supported by the driver. 
Description provides the PLC and protocol name. 

 

 
   
 
 
 

General Tab 
You can define general driver properties in the General tab of the Communication Driver 

 

dialog box.  
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The following options are available: 

Logical 
Name Specifies a name for identification purposes. 

Time-out Defines the period of time (in milliseconds) during which the system waits 
for response from a device before indicating a communication failure. 

Attributes 

Read: Check to enable Read operations with the device. 
Write: Check to enable Write Only operation with the device. 
Sample tags outside of blocks: Check to enable the sampling of tags not 
included in the communication blocks. If you do not select this option, 
communications will be limited to tags within the blocks. 
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Serial Tab 
You can define serial port parameters in the Serial tab, of the Communication Driver dialog 
box.  

 
The following options are available:  

Serial port 
Enter the appropriate device name. The standard name is 
COMn , where n is a number that refers to the serial port of 
the computer. For example, COM1 for port 1.  

The Baud Rate, Data Bits, Parity and Stop Bits fields are set to the default setting 
determined by the PLC or manufacturer. (If they have been defined they will automatically 
be displayed). 

 
 

 
 

   
 
 
 
 

Blocks Tab 
You can define communication blocks in the Blocks tab, of the Communication Driver 
dialog box, as described below.  
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You can define communication blocks to improve driver performance when working with 
large quantities of tags. These blocks enable you to transfer large blocks of information 
instead of individual data items.  
The rationale for assigning communication blocks is the reduction in transmission 
overhead. In serial communications (RS-232C), the serial bit rate is relatively slow and 10 
to 20 bytes are required just to address the items to be transferred. Thus, while 
approximately 20 extra bytes are required to transfer one single item, large blocks 
containing several items can be assigned instead, using the same addressing overhead. 
It should be noted, however, that not all devices support block transfers, and those that do 
may impose restrictions on block size or item types.  
For more details, see the relevant application Driver documentation. 
The application enables you to define contiguous blocks in the address space of the 
external device. Each block can then be transferred in a single common transaction. 

o To define a communication block: 
Click the Add button in the Communication Driver dialog box. The following dialog box is 
displayed. 
 

 
 
The following options are available: 
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Block 
Address 

The starting address of the block in the device. For address 
format specifications, see the relevant communication 
driver section in the Driver documentation 

Length Number of items in the block 

Sample Rate Sampling rate of the block in seconds and milliseconds 

Note:     In most of the case, the maximum number of blocks that can be defined for each 
driver is 1024. In certain circumstances blocks may be defined differently. For more 
information, refer to the Driver documentation. 

o      Though blocks are efficient in terms of transfer rate, defining large blocks that 
cover unnecessary items may degrade system performance. 

o     It is better to define small blocks with fast sampling rates for items that are 
monitored frequently, and leave the remaining data in larger blocks with slower 
sampling rates. 

o     Although blocks may overlap each other, this situation is undesirable since 
identical tags that belong to two overlapping blocks will be sampled twice (which is 
insufficient). 

o     The relationship between the block and tag sampling rates (specified in the 
Block Definition and Analog/Digital Tag Definition dialog boxes respectively is such 
that the slower of the two rates will always override the other. 
For example, if you define a communication block for five tags with a block sample 
rate of 30 seconds. Three of the tags will be assigned a tag sample rate of 20 
seconds, and the remaining two tags assigned a tag sample rate of 10 seconds. 
The following illustration will clarify the example: 

      G1 G2 G3    G4 G5 
       20 sec       10 sec 
      +-------------+ 
          | 
          30 sec 
The tags will be sampled only after 30 seconds have elapsed since the last time the block 
was sampled. 
However, if you define a sampling rate for a tag group slower than the block sampling rate, 
as in the following illustration. 
      G1 G2 G3    G4 G5 
       40 sec       10 sec 
      +-------------+ 
          | 
          30 sec 
The tags in the group (40-second group in the example above) will be sampled whenever 
the amount of time specified by the slower rate has elapsed. 
It is therefore recommended to group tags into blocks according to their sample rate. 
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Information Tab 
You can view driver information in the Information tab of the Communication Driver dialog 
box:  

 
The following information is available: 

File name The driver file name. 

Type 

This field can contain one of two parameters: 
Serial which defines parameter for serial communication 
(RS-232C protocol). 
NULL which is not serial and can use an external library, 
or device drivers, supplied by an external provider.  

Supports Describes the function that the driver supports. 

Description    The name of the driver. 
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Converting 

Communication Block Definitions 

 

Converting Communication Block Definitions 
mmunication block definitions. You can: 

o  communication block definitions to the application in fixed or CSV file 

To impo  communication block definitions:  
elect Communication Drivers. The 

ers, click the Properties button and then 

 
 
 
 

The application provides a conversion utility for co
o Export communication block definitions to external sources in fixed or CSV file 

format.  
    Import
format. 
rt/export

1.    In the Design menu of the Application Studio, s
Communication Driver dialog box is displayed. 
2.    Select a driver from the list of available driv
select the Blocks tab. The communication driver properties are displayed:  

 
3.    Click the Files button. This displays a popup menu in which you can select Export or 

xport:  
Import. 
4.    To e
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xport from the popup menu. The Open block file for export dialog box is 

o LS or CSV. Then locate 

5.    o 
port from the popup menu. The Choose block file dialog box is displayed: 

o Select E
displayed. This is similar to the standard Open dialog box. 
In the Files of type field, select one of two export options: B
the file and enter a filename. Click Save. The file is exported. 

T import:  
o Select Im

 
o In the Files of type field, select the type of file you want to import. You can choose 

between BLS or CSV. Then locate the file you want to import and click Open. The 
imported file will replace previous block definitions. 

  Restart the application after importing files for changNote:   es to take effect. 

 
 

 

 
 

   

 

 

Importing and Exporting Definitions Using an External Application 
nication block 

tion Files 
k definition file: 

Typ

 

 
 

If you are using an external application you can import and export commu
definition files using the command line. 

Importing Communication Block Defini
o To convert a csv file to a communication bloc
e the following in the command line:  

csv2bls [fromfile] [tofile]  
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Note:    The application can run in the background. Restart the application for the changes 
to take effect. 

Exporting Communication Block Definition Files 
o To convert a communication block definition file to csv format: 

Type the following in the command line:  
bls2csv [fromfile] [tofile]  

o To convert a communication block definition file to a dat file:  
Type the following in the command line:  
bls2dat [fromfile] [tofile]  

 
 

 
 

   

 
 

 
 
 

Defining OPC (Application Client) 

OPC (OLE for Process Control) is an industry software standard designed to provide 
business applications with easy access to industrial plant floor data.  
Using OPC technology, a system integrator can create a common interface for exchanging 
data with hardware field devices or other software that can be reused by this client 
program, and other HMI, SCADA and custom applications. 
This client program uses OPC technology to exchange data with HMI and SCADA software 
and OPC servers. 

 
 

 
 

   
 
 
 
 

Defining OPC (Application Client) 

OPC (OLE for Process Control) is an industry software standard designed to provide 
business applications with easy access to industrial plant floor data.  
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Using OPC technology, a system integrator can create a common interface for exchanging 
data with hardware field devices or other software that can be reused by this client 
program, and other HMI, SCADA and custom applications. 
This client program uses OPC technology to exchange data with HMI and SCADA software 
and OPC servers. 

 
 

 
 

   
 
 
 
 

OPC  

OPC (OLE for Process Control). 
OPC is an industry software standard designed to provide business applications with easy 
access to industrial plant floor data.  

 
 

 
 

   
 
 
 
 

OPC Driver Properties 

Communication drivers are defined in the Communication Drivers dialog box, in which you 
can add and remove drivers as described on the following page, and define driver 
properties. 

o To add/remove a communication driver: 
In the Control Panel of the Application Studio, double-click the Communication Drivers 
icon. 
Or, 
In the Design menu of the Application Studio, select Communication Drivers.  

o To define communication driver properties: 
1.   In the Design menu of the Application Studio, select Communication Drivers. The 
Communication Drivers dialog box is displayed.  
2.   Select the driver and then click the Properties button to display The Communication 
Driver - OPC Client dialog box in which you can define communication driver properties. 
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In this dialog you can define the following:  

Logical Name Specifies the name given to the driver for application identification 
purposes. 

OPC Server 
Name 

Name of a specific interface. 
OPC Servers are provided by different vendors. The code written by 
the vendor determines the devices and data to which each server 
has access, the way in which data items are named and the details 
about how the server physically accesses that data. 
For this reason, we expect that the OPC Server will generally be a 
local or remote program which includes code that is responsible for 
data collection from a physical device. 

Node Name 
Specifies the name of the computer hosting the server.  
If your OPC is running from a remote site you must make sure that 
DCOM™ is configured correctly to provide networking.  
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OPC Driver Properties 

OPC Communication drivers are defined in the Communication Drivers dialog, in which 
you can add and remove drivers, and define driver properties. 
  
To add/remove a communication driver 
In the Control Panel of the Application Studio, double-click the Communication Drivers 
icon.  
or, 
In the Design menu of the Application Studio, select Communication Drivers. The 
Communication Drivers dialog opens. 
To define communication driver properties: 
In the Design menu of the Application Studio, select Communication Drivers. The 
Communication Drivers dialog is displayed Select a driver and then click the Properties 
button to display The Communication Driver - OPC Client dialog in which you can define 
communication driver properties. 
In this dialog you can define the following:  
Logical Name - Specifies the name given to the driver for application identification 
purposes. 
OPC Server Name - Name of a specific interface. 
OPC Servers are provided by different vendors. The code written by the vendor determines 
the devices and data to which each server has access, the way in which data items are 
named and the details about how the server physically accesses that data. 
For this reason, we expect that the OPC Server will generally be a local or remote program 
which includes code that is responsible for data collection from a physical device. 
Node Name - Specifies the name of your computer.  
If your OPC is running from a remote site you must make sure that DCOM™ is configured 
correctly to provide networking.  

 
 

 
 

   

BACnet Configuration 
Console 
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General 
 
Start up Settings 
 
There are 3 options available: 
 
1. Synchronise time on start-up. Activation of this option will synchronise the clock 
settings based on preset configuration in the “Time Synch” dialog box. For more details 
about time synchronisation, see the dedicated dialog box.  
 
2. Transfer history on start-up. Activation of this option will import history from the 
BACnet devices into the application when it is starting up. See the “History” dialog box for 
full details. 
 
3. Refresh alarms on start-up. Select this option if you want to transfer all active alarms 
from the devices when starting the application. See the dedicated dialog box for details on 
how BACnet alarms are interpreted in the application. 
 
Init. File Import/Export 
 
The settings that you have defined for the different options on the BACnet Configuration 
Console can be stored in an external ASCII file. You can modify and /or transfer this file 
between different applications. To save the settings, press the Export Init. File button and 
select the file that you want to write to. To load the settings from a previous session or a 
different application, press the Import Init. File button and select the previously exported 
ASCII file. 
 
Network 
 
You can select the BACnet networks to which you want to connect the application. Use the 
Connect and Disconnect button to choose which networks you want to use. The list of 
currently connected networks is displayed in the combo-box list BACnet networks. For a 
given network, you can control the connection by using a digital tag (a control tag). If the 
selected tag is set to 1 when the application starts, a connection to the associated network 
will be made. Likewise, if the tag value is 0, the associated network will not be connected 
and its devices therefore inaccessible. 
 
Note: If a network appears in the list of BACnet networks, but with no associated control 
tag, the network will be connected by default at application start-up. 
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Object Browser 
 
This dialog box allows you to browse all the connected BACnet networks and all the 
devices on each of the networks.  
 
The list on the left shows the available networks based on control tags conditions. Clicking 
on each “node” expands the list, allowing you to see the connected devices. 
 
Clicking on the device allows you to see the list of data objects in the device. 
 
When you have clicked on a data object, the list on the right shows you the values for each 
of the properties of the data object. 
 
Use the “Refresh All” button to update the device list in all networks at any time. The date 
of the last refresh is shown underneath this button. 
 
Use the “Remove Device” button if you want to hide the device from the list of accessible 
devices and from system integration during the tag declaration phase in your SCADA 
application. The device will be hidden until the next “refresh all” operation is performed. 
 
Likewise, use the refresh button underneath the list of properties in order to refresh this list. 

 
 

 
 

   

 
 
 

 
 

Time Synchronisation 
 
Use this dialog box to ensure that all devices on the BACnet network have the same clock 
time and that they remain synchronised. 
 
At the top of the page is the date and time on the local station with the offset from GMT. 
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Select Time Master 
 
When you are synchronising the time on the whole network, one device or computer must 
act as the “master” – the reference from which all other times are taken. 
 

o Use local system as Time Master – all other devices will be updated from the time 
on the current PC 

 
o Use BACnet device as Time Master – all other selected devices (see below) will 

use the specified device as the reference for their time settings. If you choose this 
option, you must specify the device; use the “Master BACnet Device” list to specify 
the master. 

 
The “Select Device” button shows a list of all devices on the network. Select the ones that 
you want to update (hold down the “shift” or “control” button to select several devices). The 
“Synchronise All” button will select all devices on the network. 
 
When you are ready to synchronise the devices, press the “Synchronise Now” button. 
 
Cyclic Synchronisation 
 
You can synchronise the devices on a regular (cyclic) basis. Check the “Enable Cyclic 
Synchronisation” button to activate this option. 
 
Once you have selected this option, you can define the time period for the synchronisation, 
e.g. selecting 24 hours means that once every 24 hours, the device times will be 
synchronised. The synchronisation options are those defined elsewhere on this dialog box. 
 
Note: BACnet synchronisation mechanism supports UTC time format. Please make sure 
that your devices are switched to that mode as well. 
 

 
 

 
 

   

 
 
 

 
 

Alarms 
 
BACnet devices generate alarms. However, the format and meaning of these alarms are 
not necessarily interpreted in the same way in the SCADA application. This dialog box will 
allow you to define how to interpret BACnet alarms, convert them into software alarms and 
present them to the user. 

280 



Chapter 8 Communication Drivers 

281 

 
The mapping rules are simple. The table below shows how the BACnet object properties 
are converted into alarm properties. 
 
BACnet Object Property  SCADA Alarm Property 

Description maps to Text 

Alarm generating Object Name maps to Family 

Priority maps to Severity 
 
Alarm Property Management 
 
You can define a set of filters. All alarms who meet the criteria defined in each filter will be 
transferred to the software. 
 
This group of controls allows you to define a set of filters. These filters intercept the 
BACnet alarms, and use the filter rules to convert them into software alarms. 
 
These filters are based either on the name of the alarm object or on its priority. 
 
Priority Range 
 
As shown in the table above, BACnet alarm priorities are converted into Severity 
properties. Use the “From” and “To” buttons to define the range of priorities that will be 
accepted by this filter. The priority will be converted into the Severity of the alarm. 
 
Object Name Rule 
 
You can base the filter on the name of the object that generated the alarm. Use the box to 
give a pattern match. If a name matches the filter, it will be converted into an alarm and, as 
shown above, the name will be converted into the Family of the alarm. 
Once you have defined the filter, you can add it to the list.  
 
Note: The order of the items in the list is important. When an alarm arrives, it is matched 
against all filters in the list starting from the top of the list. The first filter that matches is the 
one that is used to convert and transfer the alarm to the software. 
 
Use the “Move Up”, and “Move Down” buttons to change the order of the filters in the list.  
 
Use the “Remove” button to remove filters from the list. 
 
Targets 
 
For the currently selected filter in the list, you can define the target of the alarm. You can 
choose to send the alarm to one or more of the “Default Printer”, “Event Summary”, 
“Popup” or “Popup Buzzer”. 
 
Attributes 
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For the currently selected alarm in the list, you can select the attributes of the alarms that 
will be generated. You can choose from one or more of “System Wide”, “Auto 
Acknowledge”, “Auto END”, “Record to File”, “Discard” or “Inhibit”. 
 
User Attributes 
 
You can define which users or groups have access to the alarm. Press the “Groups” button 
and you will be presented with a standard dialog box to do this. 
 
Alarm Family 
 
Choose the family for the alarms generated by the currently selected filter. By default, the 
family name will be prefixed with “BACNET_” in order to help identify it. 
 
Alarm Zone 
 
Define the alarm zone for the alarms that will be generated by the currently selected filter. 
 
Action on Alarm and AAM (Advanced Alarm Management) 
 
Press the “Action on Alarm” button to launch a dialog box that will allow you to define a set 
of actions to perform when an alarm is generated: 
· Goto Zone 
· Execute macros on alarm 
o Started 
o Acknowledged 
o Ended 
· Select AAM recipients 
 
These are the same options as you find in the standard product. Refer to the online help 
therein for further details. 

 
 

 
 

   

 
 
 

 
 

History 
 
This dialog box helps you to import BACnet historical data into the software.  
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BACnet history is stored in objects known as Trend Logs (TR). A TR is linked to a Data 
Object in the device and its role is to collect historical data for the data object. 
 
Select BACnet device 
 
You can select the BACnet device for which you want to import history using the dropdown 
list. This shows a list of all devices on the network.  
 
Select Objects 
 
Once you select the device, you see a list of all objects in the device that can generate 
historical data. Use the “Definition Mode” button to decide whether the list should show, 
 

o The data objects themselves, or,  
o The trend objects that are linked to the data objects.  

 
You can select which of the objects you want to import history. Use the shift and control 
buttons to make multiple selections. However, you can select all objects with the “Select 
All” or deselect all with the “Unselect All”. 
 
Limit History Transfer Session 
 
In order to limit network traffic or overloading the software, it may be desirable to limit the 
rate of transfer of the historical data. Click the checkbox to activate this option. 
 
There are two ways to limit the transfer: 
 
1. Limit the number of records that are transferred in one go (By record count). If you 
choose this option, you must select the number of records to select in any one go (“Limit 
to” option) and choose the number of records. 
2. Limit the time for any one transfer session. In this case, use the Limit to option to select 
the time period for any one transfer session. 
 
Remember that these settings apply only to the selected device.  
 
 
Select Tag for History Log 
 
You can use a digital tag in order to control the transfer of the records. If the tag is set to 1, 
the history transfer will begin, respecting the other options selected (rate of transfer etc.) 
 
You will also see the time of the last transfer. 
 
Manual Mode 
 
You can also force a manual transfer of historical data. If you do this, you can choose the 
start and end time of the historical data you want to retrieve. 
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In each case, you can choose the Date and Time and specify whether this information is, 
 

o Absolute. i.e. this is the date and time from which you want to retrieve data 
o Relative Date. i.e. The date specified is relative to the current date but at a 

specified time (e.g. 1 day back from today, beginning at 2pm.) 
o Relative. i.e. both the specified date and time are relative to the current date and 

time. 
 
When you want to start the transfer, press the “Get History” button. 

 
 

 
 

   

 
 

 
 
 

Log Files 
 
Two types of log file are used: 

o Online Log: Records events from the current session. This data is stored in a file, 
BACnet.log 

o Historical Log File: Keeps an archived collection of old online log files. 
 
Online Log File 
 
You can enable or disable logging as required (it is advised to log data) by selecting the 
Enable Online Log option. 
 
If you choose to log data, you have the choice to limit the size of the log file. This means 
that, if the file gets bigger than the limit specified, the oldest data in the file will be removed 
as more data is logged. The size is specified in megabytes. 
 
Historical Log File 
 
You can keep a backlog of previous online log files by selecting the option Enable 
Historical Log.  
 
You may want to limit the scope of this file in 2 different ways: 
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1. Limit by Size. This is the same option as described above for the current online log file. If 
you choose this option, you can set of the maximum size of the file. Once the limit is 
reached, the oldest data will be removed as new data is added. 
2. Limit by number of sessions. You can select to keep the limited number of sessions in 
History log file. If you choose this option, you can choose the maximum number of 
sessions for which you want to keep data. Once the maximum number of sessions is 
reached, the oldest session will be removed as new session is added. 
 
Set Information Level 
 
There are 4 levels of information, each more detailed than the previous:  

o LowInfo - Critical errors only will be recorded into the log file 
o Info - All errors occurred during the working session will be recorded into the log 

file 
o Normal - All errors and warnings information level 
o Trace - All information that mentioned above and additional debug information 

according the flags setup in Filter dialog box. 
 
 

 
 

   

VPI 

 
 
 
 
 
Communication Drivers Setup 
This dialog box enables you to select a communication driver from the given list (the list is 
originated in the Install Process). 
 
To access this dialog box: 

1. Press the Add button from the Communication Drivers dialog box. The 
Communication Driver setup opens 

2. Select a name of a driver from the list and press Next to continue. 
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Communication Drivers - Add Block 
 
Used to define a communication block. 

ress the Add button in the Communication Drivers Property block dialog box (VPI Icon/ 

ms in the block 
• Sample rate - Sampling rate of the block in seconds and milliseconds  

 
 

 
 

 
To define a communication block, follow the next steps: 
P
Properties button/Block Tab). 
 
Complete the following fields: 

• Address - The starting address of the block in the device. 
• Length - Number of ite

 
 

   

 
 

 
 
 
Communication Drivers - Block Definition 
 
In this dialog box, you can define contiguous communication blocks in the address space 

hich can 

o define a block, follow the next steps 

3. Press the properties button 

The
Add  block in the device. For address format specifications, 
see LC Technical Information manual.  

other words, this is the region from Address to 

s in the external 
evice, it may be necessary to define Length as the number of bits divided by 16 (and 

Sample Rate The sample rate of the block in seconds and milliseconds.  

of the external device.  
 

ommunication blocks can be transferred in single communication transactions, wC
greatly improve data transfer speed and system performance.  
 
T

1. Select the communication drivers from the Design menu. 
2. Select a driver from the drivers list 

4. Select the Blocks Tab. 
 

 fields in this box are as follows:  
ress The starting address of the

 the relevant section in the P
 
Length Number of items in the block. In 
Address+(Length-1) in the external device that will be accessed. Note that when blocks of 
discrete items (single bits) are transferred, and comprise single word
d
rounded).  
 



Chapter 8 Communication Drivers 

287 

e this button to delete a block definition from the list. 
 
 

Add Activate this button to add the block definition to the list.  
Modify this button to change the current block definition with the new specifications.  
Delete Activat

 

   

 
 

 
 
 
Communication Drivers - Information 
 
Used to present the overall information available on a specific driver. 
 

field, it 
icate with any field 

evice. 
. 

 
 

 

Type - This field could have one of two parameters: 
Serial - Defines parameter for serial communication (RS-232C protocol). 

UL- Any driver which is not of a Serial type. When the NUL value appears in this N
means that the specific communication driver is not meant to commun
d
Support - Describes the functions the driver supports

 

   

 
 

 
 

Presents a list all drivers and their communication parameters. 
 
Logical Name: Any name for personal Identification purposes.  
Name:The VPI identification name  
Device The name of the device. The standard name is COMn, where n is a number that 

arameters : Describes the operation available with the device 
 
 

 

 

refers to the Serial port of the computer  
P
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Communication Drivers Definition 
This dialog box has the following fields: 
Logical Name Specifies the unique name of the Communication Driver 
Device Specifies the name of the physical device. The standard name is COMn, where n 
is a number that refers to the serial port of the computer. Drivers that use standard TCP/IP, 
or proprietary network, do not require this parameter. 

; SIEMENS, SIMATIC 

 rights. For example, Read/Write and out of block.  
izard. 

 
 

 
 

Name Specifies the name of the communicating driver. For example
S7. 
Parameters Specifies the Device access

1. Click the Add button to open the Communication Driver Setup W
2. Select a driver and then click the Remove button to delete this from the list. 
3. Select a driver and then click the Properties button to view/edit the driver’s 

properties. 

 

   

 
 

 
 
 
Communication Drivers - General 
Used to define the communication parameters. 
 
Logical name- Any name for personal identification purposes. 
 

g which the system 
 failure. 

ttributes 
 with the device. 

 Checking the Write option enables write only operation with the device. 
 in 

 

Time out - Defines the period of time (in hundreds of seconds) durin
waits for response from a device before indicating a communication
 
A

• Checking the Read option enables read only operations
•

• Checking the Out block option enables the referencing of elements not included
the blocks. If you do not select this option, communications will be limited to 
elements within the blocks. 
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Serial Communication Drivers 
 
In this dialog box, you can define parameters for VPI application serial communications 
(RS-232C protocol).  
 

rd name is COMn , where n is 

or example, COM1 for port 1.  
 
 

 

Serial Port - Enter the appropriate device name. The standa
a number that refers to the serial port of the computer. 
F

 
 

   

 
 

 
 

Serial Communication Drivers 
In this dialog box, you can define parameters for VPI-Application serial communications 
(RS-232C protocol).  
Serial Port - Enter the appropriate device name. The standard name is COMn , where n is 
a number that refers to the serial port of the computer. 
  
For example, COM1 for port 1. For information about the Baud Rate, Word Size, Parity, 

ular VPI, see the PLC Technical Information manual. 
 
 

 

and Stop Size options for a partic
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Defines the operation attribute of the driver. 
• Checking the Read option enables read only operations with the device. 
• Checking the Write option enables write only operation with the device.  
• Checking the Out block option enables the referencing of elements not included in

the blocks. If you do not select this option, communications will be limited to 
elements within the blocks. 

 
 

 

 
 

   

 
 

 
 

Defines the period of time (in hundreds of seconds) during which the system waits for 
response from a device before indicating a communication failure. 

 
 

 

 

   

 
 

 
 

Virtual PLC Interfaces which handle communications with external devices, such as PLCs, 
industrial instruments and remote computers. 
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Serial Communication Drivers Parameters  
In this dialog box, you can define parameters for VPI-Application serial communications 
(RS-232C protocol).  
Serial Port - Enter the appropriate device name. The standard name is COMn , where n is 
a number that refers to the serial port of the computer. 
For example, COM1 for port 1. For information about the Baud Rate, Word Size, Parity, 
and Stop Size options for a particular VPI, see the PLC Technical Information manual. 

 

 

 
 

 

 

   

What is WizModbusSlave 

 
 
 
 
 

WizModbusSlave Overview 
WizModbusSlaveä is an add-on client application based on the Slave – Master 

ion station to a Modbus Slave PLC thus enabling 
rect access to any application Tag over the 

network. 
WizModbusSlave communicates via RS232 with up to 16 local application stations (master 
stations) through serial Communication ports, COM1 to COM16 (or any other 16 
consecutive numbers in the range of 1 – 99), and with up to 1000 remote application 
stations through TCP/IP. Using this architecture the WizModbusSlave station functions like 
a v een the remote and the local stations. 

age any 
e online 

 the system. 

 
 

 

WizModbusSlave 

architecture, which simulates an applicat
a Modbus Master compliant application di

irtual PLC and intermediates betw
izModbusSlave has a user-friendly W interface, allowing you to easily map and man

application tag from any application remote station and any Modbus Slave I/O. Th
connection is bi-directional (read and write) and event-driven. This means that whenever a 
value or the state of any application tag changes – it will be reported to all the master 
stations in
This help will guide you through the steps necessary to install WizModbusSlave and then 
configure it to read and write data from / to tags located in any application station in the 
network.  
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How to ... 

 
 
 
 

Installing the WizModbusSlave Application 
WizModbusSlave cannot run independently, it is an add-on application. You should 
therefore run the application before running WizModbusSlave. 

nstall WizModbusSlave in your system: 

 
   

 

Before you i
Make sure the system folder (in Windows 95/98 WIN\System and in Windows NT 

WINNT\System32) of your operating system contains the following files: Mfc42.dll, 
Mfc42d.dll, Mfco42d.dll, Msvcrtd.dll. 

Build and run an application and define a station name and ID in the Local station 
configuration in the Network menu. 
Compatible Equipment 
W t connected to a Modbus master 

• low the steps as prompted.  
•   are 
i
• lave application is created on your desktop.  
 

izModbusSlave can communicate with any equipmen
station. 
To install WizModbusSlave 
      Activate the WizModbusSlave setup file, and fol

  The WizModbusSlave application files ModbusSlave.exe and Modbusl.dll 
nstalled in the WizFactory\wizcon\Bin folder.  
     A shortcut to the WizModbusS

 

   

 

 
Configuring a WizModbusSlave Station 

The WizModbusSlave application supports up to 16 local master stations. For each of the 
16 local stations you have to open a WizModbusSlave window, where you select the COM 
port through which the master station communicates with the WizModusSlave station. You 
can run up to 16 WizModbusSlave applications simultaneously, each application will be 
assigned with a number between 1 and 16: The first application you open will be named 
WizModbusSlave1, the second application you open will be named WizModbusSlave1 and 
the 16th application you open will be named WizModbusSlave16. 

 

 

 
 

292 



Chapter 8 Communication Drivers 

293 

To configure a WizModbusSlave station 
1. Run your  application. 
2. Select Local Station Configuration from the Network menu of the application studio and 
de

 
 

fine the station name and ID. 
3. Activate the WizModbusSlave.exe file from your desktop or from the application Bin 
folder to open the WizModbusSlave application window. 

 
 

   

 

 
Mapping Application Tags to the WizModbusSlave Station 

 
 
 

 

 
 

 

   

ther Topics 

 
 
 
 
 

Select the station name. 
 

 

 

O
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Type the device ID. 
. 

 
 

 
 

 
 

   

 
 

Click to modify a selected tag. 

 

 
 
 

 

 
 

   

 
 
 

Editing a Mapped Tag 
 

 
 

 
 

 
 

   

 



Chapter 8 Communication Drivers 

295 

 
 

Type the address 

 
 

 
 

 
 

   

 
 

 

How to Contact eMation 

 
 

 

 
 

   

 
 

 

Select the Tag name. 

 

 

 
 

   

 
 

 
 

Click to add the tag to the list. 
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Select the address type 
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About this chapter: 
Overview gives a short overview of application tags. 
Defining Tags discusses how to define application tags. 
General Tab discusses the General tab options. 
Record Tab discusses the Record tab options. 
Lock Tag discusses the Lock tab options. 
WizPLC Tab discusses how to define tags in WizPLC. 
Alarms Tab discusses the Alarm tab options. 
Fixed (GLS File) Format discusses Fixed Formatted tags 
Single Tag Input describes how to assign an immediate value to a specific tag.  
MultiAdd Tags discusses how to automatically generate a group of tags according to a 
user-defined pattern format.  
System Tags discusses predefined system tags. 
Exporting Tags discusses how to generate a tag list file (list of tag definitions) in two 
formats 
Importing Tags discusses how to import a tag list file into the system. 
Defining Tag Properties discusses how to define properties for the tag buffer size and the 
flush rate. 
 
 

 
 

 
 

   

 
 

 
 
 

A Tag is a contact point through which the Application receives data from the controller and 
/ or outputs data to it. Tags can be analog, digital or compound. 
Compound Tags are tags for which the values are the result of a combination of two other 
tags. 
In addition you can define Dummy Tags.which is not an actual contact points with the PLC, 
but can be used to store specific values. 

 
 

 
 

   

Overview 
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Overview 
The term Tags in the application refers to control values monitored by the system. These 
values are similar to variables in a programming language such as BASIC, PASCAL, and 
C. Like their programming counterparts, each value is identified by a unique name and can 
be one of several data types, such as integer, real, or Boolean. 
PLC tags are distinguished from other variables in that they can be associated with 
external device components, such as registers or I/O points in PLCs, memory locations in 
remote devices. A tag value represents the value of an external component or device, so 
that referencing the tag is equivalent to referencing the component or device itself. 
Updating a tag causes the external component or device to also be updated. Thus, an 
application PLC tag is actually a link to external devices. 
Once tags are defined in the Tag Definition dialog box, they can be used in other modules 
for displaying, calculating and control functions.  
For quick reference, the number of tags within the application is listed Application Studio 
Status Bar.  
Note:   Tags have now to be linked to the WizPLC, by an export option. It means all the 
Wizcon tags you want to use within WizPLC need to be declared one by one in this 
section, or globally in the WizPLC tag export interface. 

 
 

 

 
   
 
 
 
 

Tags Overview    
The term Tags in the application refers to control values monitored by the system. These 
values are similar to variables in a programming language such as BASIC, PASCAL, and 
C. Like their programming counterparts, each value is identified by a unique name and can 
be one of several data types, such as integer, real, or Boolean. 
PLC tags are distinguished from other variables in that they can be associated with 
external device components, such as registers or I/O points in PLCs, memory locations in 
remote devices. A tag value represents the value of an external component or device, so 
that referencing the tag is equivalent to referencing the component or device itself. 
Updating a tag causes the external component or device to also be updated. Thus, an 
application PLC tag is actually a link to external devices. 
Once tags are defined in the application tag definition module, they can be used in other 
modules for displaying, calculating and control functions.  
Basic Principles 
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In the application, a tag can be associated with one of the following sources: PLC, Dummy 
or Compound: 

• PLC Tags These tags are associated with external devices and mapped to the 
external device variables (for example, PLC registers). The application samples 
these tags periodically through the communication driver so that value changes in 
the field device variable are automatically transferred to the associated tag. PLC 
tag value changes in the application are recognized in the external device. 

• Dummy Tags These tags represent internal variables and are used for a variety of 
calculations, control and other application-related needs. Dummy tags are updated 
by user input or changed by other application modules. These tags are set to 0 
upon system initialization. 

• Compound Tags Tags that are linear calculations based on values of other tags. 
• System Tags Tags that are pre-defined and built to provide system status 

information. These tags can be added to an application only once either when the 
application is activated or anytime afterwards. Once added, System Tags will 
appear under the Tags icon in the All Containers pane. When double clicked a list 
of all the System Tags in the application will open in the Control Panel. 

• RePlay Tags The RePlay Tags list is held in the Application Studio, All Containers 
pane under the Tags container. This list contains seven application dummy 
WIZRPL tags and the dummy WIZRPL tags that are generated during image 
RePlay. 
In the RePlay module the list of WIZRPL Tags appears in the RePlay Image field. 
Dummy RePlay tags have the same attributes as the original tags used in the 
original image. 

According to their data types, tags can be one of the following: 
• Digital Discrete logic tags that have Boolean values of TRUE (1) or FALSE (0). 
• Analog Tags that have numeric values represented in various formats (signed or 

unsigned integer, floating point, BCD). 
• String Tags which are defined to receive alpha-numeric strings. 

 
 

 
 

   

 
 
 

 
 

Basic Principles 
An application tag can be associated with one of the following sources: PLC, Dummy or 
Compound: 

o  PLC: These tags are associated with external devices and mapped to the external 
device variables (for example, PLC registers). The application samples these tags 
periodically through the communication driver so that value changes in the field 
device variable are automatically transferred to the associated tag. PLC tag value 
changes in the application are recognized in the external device.  

o Dummy Tags: These tags represent internal variables and are used for a variety of 
calculations, control and other application-related needs. Dummy tags are updated 
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by user input or changed by other application modules. These tags are set to 0 
upon system initialization. 

o Compound: Tags that are linear calculations based on values of other tags. 
o      System Tags: Tags that are predefined and built to provide system status 

information. These tags can be added to an application only once either when the 
application is activated or anytime afterwards. Once added, System Tags will 
appear under the Tags icon in the All Containers pane. When double clicked a list 
of all the System Tags in the application will open in the Control Panel. 

o     RePlay Tags: The RePlay Tags list is held in the Application Studio, All 
Containers pane under the Tags container. This list contains eight application 
dummy WIZRPL tags and the dummy WIZRPL tags that are generated during 
image RePlay.  
In the RePlay module the list of WIZRPL Tags appears in the RePlay Image field. 
Dummy RePlay tags have the same attributes as the original tags used in the 
original image. 

o     Tag Mapper: The Tag Mapper is a data file of tags and tag values that can be 
used to considerably reduce workload during application creation. Tag values of 
tags held in a Tag Mapper table are mapped by the Tag Mapper into a list of other 
tags. 

   There are two types of Tag Mapper tags: 
o Source: These are tags whose values are directed to target tags. More than one 

source tag can be pointed to the same target tag. 
o Target: This tag type receives the values of the source tag. All target tags must 

have the WIZTGM_ prefix. 
According to their data types, tags can be one of the following: 

o     Digital Tag Type (see page ) Discrete logic tags that have Boolean values of 
TRUE (1) or FALSE (0). 

o     Analog Tag Type (see page  ) Tags that have numeric values represented in 
various formats (signed or unsigned integer, floating point, BCD). 

o     String Tag Type (see page )Tags which are defined to receive alpha-numeric 
strings. 

Tag Icons 
The application marks the different tag types with icons. Below are the Analog, Digital and 
String icons used to mark tags in the Studio Tag List. 

o      Analog 

o      Digital 

o      String 
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Tag Icons 
The application marks tag-type with icons. Below are the Analog, Digital and String icons 
used to mark tags in the Studio Tag List. 

Analog Tag 

Digital Tag 

 String Tag 
 
 

 
 

   

Tags Type 
 
 
 
 
 

Analog Tag     
Analog tags have numeric values represented in various formats (signed or unsigned 
integer, floating point, BDC). 
Click in the Tag Type field of the Tag Definitions: New Tag dialog box and select Analog 
from the drop-down list. The Tag Type parameters will appear as follows:  
Format This field is used to specify the data format of the external device. The options 
include: 
 Unsigned 16: Unsigned 16-bit integer. 
 Signed 16: Signed 16-bit integer. 
 BCD: 4-digit BCD format. 
 Float: 4-byte IEEE single-precision, floating point format. 
 Signed 32: Signed 32-bit integer. 
 Unsigned 32: Unsigned 32-bit integer. 
Tolerance Specifies the minimum amount of change that must occur to a tag value, since 
the last change, for an event to be recognized. Using this parameter is a convenient way of 
smoothing sensor fluctuations.  
 Tolerance applies to analog PLC tags only. The value is in the external device 
measurement units (raw PLC units) and not engineering units (ref Conversion). 
Tag Scale Low/High Limit These fields specify the upper and lower limits of the tag's 
value. This option is only relevant when the Set to Default option is not checked.  
Set Default When this option is checked the Low/High limits are default according to the 
format limits. 
Conversion External devices normally generate values according to their internal format 
and in order to obtain the maximum accuracy. For instance, a temperature measured in the 
field, which is in the range between 0 and 600 degrees, may be presented as a numerical 
range of between 0 to 65535. To convert the field measured value in engineering units, the 
application uses the linear conversion. 



Chapter 9 Tags 

306 

 Value 1 Measured: Measured raw value sample. 
 Value 1 Engineering: Corresponding engineering value sample. 
 Value 2 Measured: Another measured raw value sample. 
 Value 2 Engineering: Another corresponding engineering value sample. 
For example, if you specify the following:  
Value 1 Measured = 0. 
Value 1 Engineering = 0. 
Value 2 Measured = 1. 
Value 2 Engineering = 2.  
The converted value would be the raw PLC value multiplied by two.  
  
Note: When converting a float tag value the result will always be a float number even if the 
tag format is WORD or DWORD. 

 
 

 
 

   

 
 

 
 
 

Digital Tag      
What is a Digital Tag? 
Discrete logic tags that have boolean values of TRUE (1) or FALSE (0). 
  
How to define a Digital Tag? 
Select the Digital option from the Tag Type field in the Tag Definition dialog box.. 
  
The filter field applies to digital PLC tags only. Specifies the minimum amount of time 
during which a tag value should remain stable. In this field define the amount of time the 
Application will wait after a tag value change is detected, before continuing to sample the 
tag. 
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String Tag     
A string tag can receive an alphanumeric string as a tag value. 
To define a string tag type: 
1. 1. Click in the Tag Type field of the Tag Definitions: New Tag dialog box and select 
String from the drop-down list. The Tag Type parameters will appear as follows:  
1. 2. In the Width field, specify the maximum number of characters that you want the string 
to include. The maximum length of a string tag is 255 characters. 

 
 

 
 

   

Tag Source 

 
 
 
 
 

PLC Tags     
PLC Tag Source Parameters 
Note: If drivers have not been previously defined then do so now. For further information 
refer to the Communication Drivers chapter. 
To open the Tag Source parameter fields: 
In the Tag Definitions dialog box click the arrow in the Tag Source field and select PLC. 
The Tag Source field opens. 
Note: The following parameters are available both when creating and modifying a tag. 
The following options are available: 
Driver Specifies the name of the driver responsible for communication with the relevant 
external device. The available communication drivers should be previously defined in the 
communication driver definition module. For a list of currently defined communication 
drivers, click on the arrow to the right of the field.  
Address The address string specifies the location of the tag data source in the PLC or 
other field device. Generally, the address represents combination of a PLC unit and PLC 
register number and type. The exact address format is specific for each PLC and depends 
on the driver used for the communication. For more details, refer to the driver on-line 
reference. 
Sample External devices are sampled periodically to update the values of their associated 
tags. Therefore, a tag value always reflects the state of its associated device. Each tag is 
assigned its own sampling rate. However, if the device component, with which the tag is 
associated is included in a communications block, the block will ultimately determine the 
sampling rate. The following options are available: 
 Never: The external device is never sampled to update its respective tag. 
 In Monitor: The device is sampled to update its respective tag only when the tag's value 
is requested by one of the application’s modules (for example, displayed in an Image). This 
option is useful for minimizing communications traffic, thereby improving system 
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performance. Select this option for tags that are used for monitoring field activities and do 
not record into history files. Do not select this option for tags that are used for alarm 
definition. 
 Always: The device is always sampled to update its respective tag. If you select this 
option, specify the sample rate in seconds and/or milliseconds. 
Note: If the tag is included in a communication block, the block will ultimately determine the 
sampling rate. Tags can be sampled at a rate of upto 40 milliseconds. 
. 

 
 

 
 

   
 
 
 
 

Dummy Tags     
What are Dummy Tags? 
These tags represents internal variables and are used for a variety of calculations, control 
and other application related needs. Dummy tags are updated by user input or changed by 
other application modules. These tags are set to 0 upon system initialization. 
  
Result on the Source Parameters: 
Once the Dummy Tag was chosen the Source Parameters Section will remain close since 
no parameter need to be defined for dummy tags.  

 
 

 

 
   
 
 
 
 

Compound Tags    
A compound tag is an analog tag, the value of which is a combination of two other tags.  
Note: The following parameters are available both when creating and modifying a tag. 
Click in the Tag Source field of the Tag Definitions: NEW Tag dialog box, and select 
Compound from the drop-down list. The Tag Source parameters will appear:  
The compound tag formula is as follows: 
Constant1 * Tag1 oper Constant2 * Tag2 
Where oper is one of the following operators: +, -, / (division), or * (multiplication). 
Operators can be selected by clicking on the relevant operator. 
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Note: In the tag field click on the arrow to the right of the fields, to obtain a list of available 
tags. 
Define the compound tag in the Calculate field as either In Monitor or Always. Select 
Always if you want the compound tag to be calculated always (also when the tag is not In 
Monitor). 
After you define the formula, whenever the individual tags are sampled, the compound tag 
will be assigned a value according to the evaluated formula. 

 
 

 
 

   

Defining Tags 

 
 
 
 
 

Defining Tags 
o To define a tag: 

Click the Tag icon in the application toolbar to open the Tag Definition dialog box. 
Or, 
From the All Containers section of the Application Studio, right-click Tags and select Add 
Tag to open the Tag Definition dialog box.  
The Tag Definition dialog box has five tabs: 

o     General Tab used to create new tags and modify existing ones  
o     Record Tab defines how tag value changes will be recorded to history 
o     Dynamic Data Exchange (DDE) Link Tab used to define the online 

communication method for other applications (such as Excel) 
o     Lock Tag enables tag values to be locked for a predefined period of time. The 

Status Tag (digital) option indicates the locked tag status 
o     WizPLC Tab defines if the tag will be used or not in WizPLC, and to define the 

general attributes of this softlogic tag. 
o     Alarms Tab where the following tag related alarms can be defined:  
o LoLo 
o Low  
o High 
o HiHi 
o Rate of Change 
o Deviation 
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Tag Specification 
In this dialog box, you can select the tag type and all the relevant specifications for the tag 
you want to define.  
Except for Compound tags, if no address is specified for a tag, it is assumed to be a 
Dummy tag. Name: The unique tag name that identifies it and represents its value. In the 
Name field, you can specify the name of the tag that you want to add, or modify the name 
that exists, for a change operation. The tag name should be unique and is limited to 32 
characters.  
Description:  
In the Description field, you can enter a brief description of the tag that you want to add, or 
modify the existing description for a change operation.  
The remaining fields in the dialog box are described in the following sections.  
Source: As shown in the Tag Specifications dialog box that, the Source field is divided into 
two sections: source options and source parameters. The source parameters section is 
context-sensitive and contains different fields and options, depending on the source that 
you select (PLC, Dummy, or Compound). Each of the source options is described below.  
PLC To associate the tag you want to define or modify with a PLC, select the PLC option in 
the Source field of the Tag Specifications dialog box. The fields in this section are:  
VPI Specify the VPI name which is responsible for communication with the relevant 
external device. The available VPIs should be previously defined in the VPI definition 
module. For a list of currently defined VPIs, click on the arrow to the right of the field.  
Address The address string specifies the location of the tag data source in the PLC or 
other field device. Generally, the address represents combination of a PLC unit and PLC 
register number and type. The exact address format is specific for each PLC and depends 
on the VPI used for the communication. (For more information see the VPI on-line 
reference). Note that it is recommended to  
define the tag address in the boundaries of a communications block.  
Sample External devices are sampled periodically to update the values of their associated 
tags. Thus, a tag value always reflects the state of its associated device. Each tag is 
assigned its own sampling rate. However, if the device component the tag is associated 
with is included in a communications block, that block will ultimately determine the 
sampling rate.  
The Sample options include:  
Never The external device is never sampled to update its respective tag.  
In Monitor The device is sampled to update its respective tag only when the tag's value is 
requested by one of Application modules (for example, displayed in an Image window). 
This option is useful for minimizing communications traffic, thereby improving system 
performance. Select this option for tags that are used for monitoring field activities and not 
recorded into history files or used in alarm definition.  
Always The device is always sampled to update its respective tag. If you select this option, 
specify the sample rate in seconds and/or milliseconds. Note: If the tag is included in a 
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communication block, the block will ultimately determine the sampling rate. Note: The 
fastest rate at which Application will sample a tag is 50 milliseconds.  
Dummy To define a tag as a dummy tag, select the Dummy option in the Source field of 
the Tag Specifications dialog box. After you select this option, the Source field in the dialog 
box will be empty, since no parameters need to be defined for dummy tags.  
Compound A compound tag is an analog or digital tag, the value of which is a combination 
of two other tags. To define compound tags, select the Compound option in the Source 
field of the Tag Specifications dialog box. The compound tag formula is as follows: 
Constant1 * Tag1 oper Constant2 * Tag2 Where oper is one of the following operators: +, -
, / (division), or * (multiplication). Note: In the tag and operator fields, you can click on the 
arrow to the right of the fields, to obtain a list of available tags and operators. After you 
define the formula, whenever the individual tags are sampled, the compound tag will be 
assigned a value according to the evaluated formula.  
Type As shown in the Tag Specifications dialog box, the Type field is divided into two 
sections: type options and type parameters. Depending on the type that you select 
(Analog, Digital, or String), the parameters section contains different fields and options. 
Each of the type options is  
described below.  
Analog To define analog tags, select the Analog option in the Type field of the Tag 
Specifications dialog box. The fields in this section are:  
Format This field is used to specify the data format of the external device. The options 
include: Unsigned 16 Unsigned 16-bit integer Signed 16 Signed 16-bit integer BCD 4-digit 
BCD format Float 4-byte IEEE single-precision, floating point format Signed 32 Signed 32-
bit integer Unsigned 32 Unsigned 32-bit integer  
Tolerance Specifies the minimum amount of change that must occur to a tag value since 
the last change, for an event to be recognized. Using this parameter is a convenient way of 
smoothing sensor fluctuations. Tolerance applies to analog tags only. The value is in the 
external device measurement units (raw PLC units) and not engineering units (ref 
Conversion).  
Low/High Limit These fields specify the upper and lower limits of the tag's value. If the low 
limit you specify is greater than the high limit, the low value will be the minimum and the 
high value will be the maximum in engineering units, according to the PLC value type.  
Conversion External devices normally generate operational values according to their 
internal format and in order to obtain the maximum accuracy. For instance, a temperature 
measured in the field is in the range between 0 and 600 degrees may be presented as a 
numerical range of between 0 to 65535. To convert the field measured value in 
engineering units, the Application uses the automatic linear conversion. The conversion 
procedure is applied only to Analog tags, as described below:  
Measured Measured raw value sample  
Engineering Corresponding engineering value sample  
Measured Another measured raw value sample  
Engineering Another corresponding engineering value sample  
For example, suppose you specify the following: First measured value is 0. First 
engineering value is 0. Second measured value is 1. Second engineering value is 2. In this 
case, the converted value would be the raw PLC value multiplied by two. Digital To define 
digital tags, select the Digital option in the Type field of the Tag Specifications dialog box. 
The Type field in the dialog box appears:  
String A string tag is a tag that can receive alpha-numeric string as a tag value. To define 
string tags, select the String option in the Type field of the Tag Specifications dialog box. In 
the Length field, specify the maximum number of characters that you want the string to 
include.  
Record The Record field contains options that you can select to determine whether tag 
value changes will be recorded.  
The options include:  
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Never The tag value will never be recorded.  
Changes The tag value will be recorded whenever it is sampled and is found to have 
changed since the previous sample.  
Every ... The tag value will be recorded each specified time interval. Note that the fastest 
rate at which Application samples a tag for recording is 50 milliseconds.  
DDE Links the Application can communicate online with other applications (such as Excel) 
through the DDE (Dynamic Data Exchange) interface.  
The DDE is a common protocol that allows applications to exchange data freely, using 
either one-time data transfers, or ongoing transfers in which applications send updates to 
each other whenever new data is available.  
The DDE Link to Tag section in the Tag Specifications dialog box contains options that 
enable you to specify that the tag will be linked to another application through the DDE. 
This will cause the tag value to be updated immediately, whenever a change occurs in the 
object to which the tag is linked. Note: Once you link a tag to another application through 
the DDE, the format of the address will be the standard DDE format. For tags that will not 
be part of a DDE Client Block, select the 'single' option.  
The fields in this section are:  
Application The application to which you want the tag to be linked.  
Topic The topic in the application that contains the object to which the tag will be linked.  
Item Name The name of the item to which you want the tag to be linked. The name is 
taken from the application and topic to which the tag is linked (Excel cell number, 
Application image object, etc.).  
To connect a tag to one item from a DDE block, select the Block option In the DDE section 
of the Tag Specification dialog box. The DDE section then appears with the following fields:  
Block Name The block to which the tag will belong.  
Row The row number of the item in the block with respect to the start position.  
Column The column number of the item in the block with respect to the start position. 
Remember that you specified the start position in the Address field when you defined the 
DDE block.  
Important Notes  

• PLC tags linked to DDE items will actually cause the DDE application to update 
the PLC, and the updated value sampled from the PLC will be automatically 
transferred to the DDE application. However, if any Application module reads or 
writes tag values, it will first access the PLC and then update the DDE link. 

• A sign indicates when a DDE connection to an application terminates. 
• Group Assignment 
• Authorization Groups: the Application allows you to define security groups for 

changing tags value by an operator, so that only authorized operators can set the 
tag value. This is implemented by assigning authorization groups to each tag. 
Operators that do not belong to any of the assigned groups will not be authorized 
to change tag values. Note that all operators can read tag values; only authorized 
operators can change them.  
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General Tab 
The General tab defines a tag's general properties. This tab is dynamic and changes when 
either the Tag Source or Tag Type fields are defined. 

 
 
The following options are available: 

Tag Name Enter a unique tag name with no more than 31 characters. 

Description Enter a brief description of the tag with no more than 255 characters. 

Groups     
Click to display the Access Permission Manager dialog box in which 
you can define authorized users and security groups so that only 
authorized operators can set tag value.  
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Tag Source    

This field is divided into two sections: 
Tag source option: Click to display a drop-down list in which you can 
choose the source to work with. Your choice will determine the 
available tag source parameters. 
Tag source parameters: There are three types of source parameters.  
• Dummy: select for internal application-related processing and needs. 
The Dummy tag has no tag source parameters.  
• PLC: select to associate with a PLC driver.  
• Compound: select for automatic calculations based on tag values.  

Tag Type    

This field is divided into two sections: 
Tag Type and Tag Parameters. 
Click to display a drop-down list in which you can choose the tag type to 
work with. There are three tag types: 
• Analog (the default tag type). See Analog Tag Type for further 
details. 
• Digital see Digital Tag Type for further details.  
• String see String Tag Type for further details. 
Your choice will determine the available tag type parameters. 

 
 
 

 
 

   

 
 

 
 
 

Tag Definition - General      
The General tab defines a tag’s general properties. This tab is dynamic and changes when 
either the Tag Source or Tag Type fields are defined. 
The following options are available: 
Tag Name Enter a unique tag name with no more than 32 characters. 
Description Enter a brief description of the tag with no more than 254 characters. 
Groups  Click to display the Access Permission Manager dialog box in which you can 
define authorized users and security groups so that only authorized operators can set the 
tag value.  
Tag Source This field is divided into two sections: 
Tag source option 
Tag source parameters  
Click to display a drop-down list in which you can choose the source to work with: Your 



Chapter 9 Tags 

315 

choice will determine the available tag source parameters. Dummy: select for internal 
application-related processing and needs. The Dummy tag has no tag source parameters. 
PLC: select to associate with a PLC driver. Compound: select for automatic calculations 
based on tag values.  
Tag Type This field is divided into two sections: 
Tag type  
Tag type parameters 
Click to display a drop-down list in which you can choose the tag type to work with. Your 
choice will determine the available tag type parameters. 
Analog (the default tag type) 
Digital  
String  
The default tag type is Analog.  
PLC Tag Source Parameters 
Note: If drivers have not been previously defined then do so now. For further information 
refer to the Communication Drivers chapter. 
To open the Tag Source parameter fields: 
In the Tag Definitions dialog box click the arrow in the Tag Source field and select PLC. 
The Tag Source field opens. 
Note: The following parameters are available both when creating and modifying a tag. 
The following options are available: 
Driver Specifies the name of the driver responsible for communication with the relevant 
external device. The available communication drivers should be previously defined in the 
communication driver definition module. For a list of currently defined communication 
drivers, click on the arrow to the right of the field.  
Address The address string specifies the location of the tag data source in the PLC or 
other field device. Generally, the address represents combination of a PLC unit and PLC 
register number and type. The exact address format is specific for each PLC and depends 
on the driver used for the communication. For more details, refer to the driver on-line 
reference. 
Sample External devices are sampled periodically to update the values of their associated 
tags. Therefore, a tag value always reflects the state of its associated device. Each tag is 
assigned its own sampling rate. However, if the device component, with which the tag is 
associated is included in a communications block, the block will ultimately determine the 
sampling rate. The following options are available: 
 Never: The external device is never sampled to update its respective tag. 
 In Monitor: The device is sampled to update its respective tag only when the tag's value 
is requested by one of the application’s modules (for example, displayed in an Image). This 
option is useful for minimizing communications traffic, thereby improving system 
performance. Select this option for tags that are used for monitoring field activities and do 
not record into history files. Do not select this option for tags that are used for alarm 
definition. 
 Always: The device is always sampled to update its respective tag. If you select this 
option, specify the sample rate in seconds and/or milliseconds. 
Note: If the tag is included in a communication block, the block will ultimately determine the 
sampling rate. Tags can be sampled at a rate of upto 40 milliseconds. 
To Define OPC Source Parameters 
You can associate the tag you want to define with an OPC driver by clicking in the Tag 
Source field of the Tag Definition: New Tag dialog box and selecting the driver from the 
drop-down list. The Tag Source parameters will appear.  
Note: The following parameters are available both when creating and modifying a tag. 
1. 1. From the Driver drop-down list select the OPC driver. 
1. 2. In the Address field click on the Browse button. The Add Item dialog box opens.  
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Note that this dialog box opens only if your OPC Server supports Browsing. If not you must 
enter the address manually. 
1. 3. From the Browse Items list, select the name of the item that you want to be linked to 
and click OK to complete the operation.  
Compound Tag Source Parameters 
A compound tag is either an analog or digital tag, the value of which is a combination of 
two other tags.  
Note: The following parameters are available both when creating and modifying a tag. 
To define compound tags:  
Click in the Tag Source field of the Tag Definitions: NEW Tag dialog box, and select 
Compound from the drop-down list. The Tag Source parameters will appear.  
The compound tag formula is as follows: 
Constant1 * Tag1 oper Constant2 * Tag2 
Where oper is one of the following operators: +, -, / (division), or * (multiplication). 
Operators can be selected by clicking on the relevant operator. 
Note: In the tag field click on the arrow to the right of the fields, to obtain a list of available 
tags. 
Define the compound tag in the Calculate field as either In Monitor or Always. Select 
Always if you want the compound tag to be calculated always (also when the tag is not In 
Monitor). 
After you define the formula, whenever the individual tags are sampled, the compound tag 
will be assigned a value according to the evaluated formula. 
Analog Tag Type 
Analog tags have numeric values represented in various formats (signed or unsigned 
integer, floating point, BDC). 
To define an analog tag type: 
Click in the Tag Type field of the Tag Definitions: New Tag dialog box and select Analog 
from the drop-down list. The Tag Type parameters will appear.  
The following options are available: 
Format This field is used to specify the data format of the external device. The options 
include: 
 Unsigned 16: Unsigned 16-bit integer. 
 Signed 16: Signed 16-bit integer. 
 BCD: 4-digit BCD format. 
 Float: 4-byte IEEE single-precision, floating point format. 
 Signed 32: Signed 32-bit integer. 
 Unsigned 32: Unsigned 32-bit integer. 
Tolerance Specifies the minimum amount of change that must occur to a tag value, since 
the last change, for an event to be recognized. Using this parameter is a convenient way of 
smoothing sensor fluctuations.  
 Tolerance applies to analog PLC tags only. The value is in the external device 
measurement units (raw PLC units) and not engineering units (ref Conversion). 
Tag Scale Low/High Limit  These fields specify the upper and lower limits of the tag's 
value. This option is only relevant when the Set to Default option is not checked.  
Set Default When this option is checked the Low/High limits are default according to the 
format limits. 
Conversion External devices normally generate values according to their internal format 
and in order to obtain the maximum accuracy. For instance, a temperature measured in the 
field, which is in the range between 0 and 600 degrees, may be presented as a numerical 
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range of between 0 to 65535. To convert the field measured value in engineering units, the 
application uses the linear conversion. 
 Value 1 Measured: Measured raw value sample. 
 Value 1 Engineering: Corresponding engineering value sample. 
 Value 2 Measured: Another measured raw value sample. 
 Value 2 Engineering: Another corresponding engineering value sample. 
For example, if you specify the following:  
Value 1 Measured = 0. 
Value 1 Engineering = 0. 
Value 2 Measured = 1. 
Value 2 Engineering = 2.  
The converted value would be the raw PLC value multiplied by two.  
Note: When converting a float tag value the result will always be a float number even if the 
tag format is WORD or DWORD. 
Digital Tag Type 
A digital tag type is a discrete logic tag with Boolean values of TRUE (1) or FALSE (0). 
To define a digital tag type: 
Click in the Tag Type field of the Tag Definitions: New Tag dialog box, and select Digital 
from the drop-down list. The Tag Type parameters will appear.  
The following option is available: 
Filter Used for debouncing, which is filtering out oscillations. This option is only available 
for PLC tags. 
String Tag Type 
A string tag can receive an alphanumeric string as a tag value. 
To define a string tag type: 
Click in the Tag Type field of the Tag Definitions: New Tag dialog box and select String 
from the drop-down list. The Tag Type parameters will appear. In the Width field, specify 
the maximum number of characters that you want the string to include. The maximum 
length of a string tag is 255 characters. 

 
 

 
 

   

 
 
 

 
 

Enter the unique tag name that identifies it and represents its value. The name should be 
unique and is limited to 31 characters. 
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You can enter a brief description of the tag that you want to add, or modify the existing 
description for a change operation. 

 
 

 
 

   
 
 
 
 

PLC Tag Source Parameters 
Note:     If drivers have not been previously defined then do so now. For further information 
refer to Chapter 8, Communication Drivers. 

o To open the Tag Source parameter fields: 
In the Tag Definitions dialog box click the arrow in the Tag Source field and select PLC. 
The Tag Source field opens. 

  
 
Note:     The following parameters are available both when creating and modifying a tag. 
The following options are available: 

Driver 

Specifies the name of the driver responsible for communication with the 
relevant external device. The available communication drivers should be 
previously defined in the communication driver definition module. For a list 
of currently defined communication drivers, click on the arrow to the right of 
the field.  

Address    

The address string specifies the location of the tag data source in the PLC 
or other field device. Generally, the address represents combination of a 
PLC unit and PLC register number and type. The exact address format is 
specific for each PLC and depends on the driver used for the 
communication.  
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Sample    

External devices are sampled periodically to update the values of their 
associated tags. Therefore, a tag value always reflects the state of its 
associated device. Each tag is assigned its own sampling rate. However, if 
the device component, with which the tag is associated is included in a 
communications block, the block will ultimately determine the sampling rate. 
The following options are available: 
Never: The external device is never sampled to update its respective tag. 
In Monitor: The device is sampled to update its respective tag only when 
the tag's value is requested by one of the application's modules (for 
example, displayed in an Image). This option is useful for minimizing 
communications traffic, thereby improving system performance. Select this 
option for tags that are used for monitoring field activities and do not record 
into history files. Do not select this option for tags that are used for alarm 
definition. 
Always: The device is always sampled to update its respective tag. If you 
select this option, specify the sample rate in seconds and/or milliseconds. 

Note:     If the tag is included in a communication block, the block will ultimately determine 
the sampling rate. Tags can be sampled at a rate of up to 50 milliseconds. 

o To Define OPC Source Parameters 
You can associate the tag you want to define with an OPC driver by clicking in the Tag 
Source field of the Tag Definition: New Tag dialog box and selecting the driver from the 
drop-down list. The Tag Source parameters will appear.  
Note:     The following parameters are available both when creating and modifying a tag. 
1.    From the Driver drop-down list select the OPC driver. 
2.    In the Address field click on the Browse button. The Add Item dialog box opens. 
Note:     This dialog box opens only if your OPC Server supports browsing. If not you must 
enter the address manually. 
3.    From the Browse Items list, select the name of the item that you want to be linked to 
and click OK to complete the operation.  
 

 
 

 
 

   

 
 

 
 
 

You can select the Source Options you wish to work with. The choice you make will affect 
the Source parameters section. there are 3 types of source tags: PLC, Dummy, 
Compound. 
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Dummy Tags     
What are Dummy Tags? 
These tags represents internal variables and are used for a variety of calculations, control 
and other application related needs. Dummy tags are updated by user input or changed by 
other application modules. These tags are set to 0 upon system initialization. 
  
Result on the Source Parameters: 
Once the Dummy Tag was chosen the Source Parameters Section will remain close since 
no parameter need to be defined for dummy tags.  

 
 

 

 
   
 
 
 
 

PLC Tags     
PLC Tag Source Parameters 
Note: If drivers have not been previously defined then do so now. For further information 
refer to the Communication Drivers chapter. 
To open the Tag Source parameter fields: 
In the Tag Definitions dialog box click the arrow in the Tag Source field and select PLC. 
The Tag Source field opens. 
Note: The following parameters are available both when creating and modifying a tag. 
The following options are available: 
Driver Specifies the name of the driver responsible for communication with the relevant 
external device. The available communication drivers should be previously defined in the 
communication driver definition module. For a list of currently defined communication 
drivers, click on the arrow to the right of the field.  
Address The address string specifies the location of the tag data source in the PLC or 
other field device. Generally, the address represents combination of a PLC unit and PLC 
register number and type. The exact address format is specific for each PLC and depends 
on the driver used for the communication. For more details, refer to the driver on-line 
reference. 
Sample External devices are sampled periodically to update the values of their associated 
tags. Therefore, a tag value always reflects the state of its associated device. Each tag is 
assigned its own sampling rate. However, if the device component, with which the tag is 
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associated is included in a communications block, the block will ultimately determine the 
sampling rate. The following options are available: 
 Never: The external device is never sampled to update its respective tag. 
 In Monitor: The device is sampled to update its respective tag only when the tag's value 
is requested by one of the application’s modules (for example, displayed in an Image). This 
option is useful for minimizing communications traffic, thereby improving system 
performance. Select this option for tags that are used for monitoring field activities and do 
not record into history files. Do not select this option for tags that are used for alarm 
definition. 
 Always: The device is always sampled to update its respective tag. If you select this 
option, specify the sample rate in seconds and/or milliseconds. 
Note: If the tag is included in a communication block, the block will ultimately determine the 
sampling rate. Tags can be sampled at a rate of upto 40 milliseconds. 
. 

 
 

 
 

   
 
 
 
 

If this option is checked then the device is always sampled to update its respective tag. If 
you select this option, specify the sample rate in seconds and / or milliseconds. 

 
 

 

 
   
 
 
 
 

Specify the address string specifies the location of the tag data source in the PLC or other 
field device. The address represents a combination of a PLC unit and PLC register number 
and type. The exact format is specified for each PLC and depends on the VPI used for the 
communication. 
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Specify the VPI name which is responsible for communication with the relevant external 
device. The available VPIs Should be previously defined in the VPI definition modules. 

 
 

 
 

   

 
 
 

 
 

If chosen then the device is sampled to update its respective tag only when the tag's value 
is requested by one of Application module. 

 
 

 
 

   
 
 
 
 

If choose then the external device is never sampled to update its respective tag. 
 
 

 

 
   
 
 
 
 

You can select the Source Options you wish to work with. The choice you make will affect 
the Source parameters section. There are 3 types of source tags: PLC, Dummy, 
Compound. 

 
 

 
 



Chapter 9 Tags 

323 

   
 
 
 
 

If the Always sampling rate is chosen then define the sampling rate in milliseconds. 
 
 

 

 
   
 
 
 
 

If the always option is chosen define the sample rate in seconds. 
 
 

 

 
   
 
 
 
 

These fields specify the upper and lower limits of the tag value. If the low limit you specify 
is greater than the high limit, the low limit value will be the minimum and the high will be the 
maximum in engineering unites, according to the PLC value type. 

 
 

 

 
   
 
 
 
 

Compound Tag Source Parameters 
A compound tag is either an analog or digital tag, the value of which is a combination of 
two other tags.  
Note:    The following parameters are available both when creating and modifying a tag. 
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o To define compound tags:  
Click in the Tag Source field of the Tag Definitions: NEW Tag dialog box, and select 
Compound from the drop-down list. The Tag Source parameters will appear:  

  
The compound tag formula is as follows: 
Constant1 * Tag1 oper Constant2 * Tag2 
Where oper is one of the following operators: +, -, / (division), or * (multiplication). 
Operators can be selected by clicking on the relevant operator. 
Note:    In the tag field click on the arrow to the right of the fields, to obtain a list of available 
tags. 
Define the compound tag in the Calculate field as either In Monitor or Always. Select 
Always if you want the compound tag to be calculated always (also when the tag is not In 
Monitor). 
After you define the formula, whenever the individual tags are sampled, the compound tag 
will be assigned a value according to the evaluated formula. 

 
 

 

 
   
 
 
 
 

Compound Tags    
A compound tag is an analog tag, the value of which is a combination of two other tags.  
Note: The following parameters are available both when creating and modifying a tag. 
Click in the Tag Source field of the Tag Definitions: NEW Tag dialog box, and select 
Compound from the drop-down list. The Tag Source parameters will appear:  
The compound tag formula is as follows: 
Constant1 * Tag1 oper Constant2 * Tag2 
Where oper is one of the following operators: +, -, / (division), or * (multiplication). 
Operators can be selected by clicking on the relevant operator. 
Note: In the tag field click on the arrow to the right of the fields, to obtain a list of available 
tags. 
Define the compound tag in the Calculate field as either In Monitor or Always. Select 
Always if you want the compound tag to be calculated always (also when the tag is not In 
Monitor). 
After you define the formula, whenever the individual tags are sampled, the compound tag 
will be assigned a value according to the evaluated formula. 
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If this option is chosen then the device is always calculated to update its respective tag.  
 
 

 
 

   

 
 
 

 
 

Choosing this option will make the device always sampled to update its respective tag. If 
you select this option, specify the sample rate in seconds and /or milliseconds. 

 
 

 
 

   
 
 
 
 

Specify the numeral value to be multiplied by the tag name field. 
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Represents the constant number which will be used in the compound tag formula. 
 
 

 
 

   
 
 
 
 

if this option is chosen then the device is calculated to update its respective tag only when 
the tag's value is requested by one of Application modules. 

 
 

 

 
   
 
 
 
 

Choosing this option will sample the sample to update its respective tag only when the 
tag's value is requested by one Application modules. 

 
 

 

 
   
 
 
 
 

The Type field is divided into two sections: type options and the parameters. Depending on 
the type that you select (Analog, Digital, string) the parameters will change. 

 
 

 

 
   
 
 



Chapter 9 Tags 

327 

 
 

Analog Tag Type 
Analog tags have numeric values represented in various formats (signed or unsigned 
integer, floating point, BDC). 

o To define an analog tag type: 
Click in the Tag Type field of the Tag Definitions, New Tag dialog box and select Analog 
from the drop-down list. The Tag Type parameters will appear as follows:  

  
The following options are available: 

Format    

This field is used to specify the data format of the external device. The 
options include: 
Unsigned 16: Unsigned 16-bit integer. 
Signed 16: Signed 16-bit integer. 
BCD: 4-digit BCD format. 
Float: 4-byte IEEE single-precision, floating point format. 
Signed 32: Signed 32-bit integer. 
Unsigned 32: Unsigned 32-bit integer. 

Tolerance    

Specifies the minimum amount of change that must occur to a tag value, 
since the last change, for an event to be recognized. Using this 
parameter is a convenient way of smoothing sensor fluctuations.  
Tolerance applies to analog PLC tags only. The value is in the external 
device measurement units (raw PLC units) and not engineering units (ref 
Conversion). 

Tag Scale 
Low/High Limit    These fields specify the upper and lower limits of the 
tag's value. This option is only relevant when the Set to Default option is 
not checked.  

Set Default When this option is checked the Low/High limits are default according to 
the format limits. 
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Conversion    

External devices normally generate values according to their internal 
format and in order to obtain the maximum accuracy. For instance, a 
temperature measured in the field, which is in the range between 0 and 
600 degrees, may be presented as a numerical range of between 0 to 
65535. To convert the field measured value in engineering units, the 
application uses the linear conversion. 
Value 1 Measured: Measured raw value sample. 
Value 1 Engineering: Corresponding engineering value sample. 
Value 2 Measured: Another measured raw value sample. 

  

Value 2 Engineering: Another corresponding engineering value sample. 
For example, if you specify the following:  
Value 1 Measured = 0. 
Value 1 Engineering = 0. 
Value 2 Measured = 1. 
Value 2 Engineering = 2.  
The converted value would be the raw PLC value multiplied by two. 

    

Note:    When converting a float tag value the result will always be a float number even if 
the tag format is WORD or DWORD. 

 
 

 
 

   
 
 
 
 

Analog Tag     
Analog tags have numeric values represented in various formats (signed or unsigned 
integer, floating point, BDC). 
Click in the Tag Type field of the Tag Definitions: New Tag dialog box and select Analog 
from the drop-down list. The Tag Type parameters will appear as follows:  
Format This field is used to specify the data format of the external device. The options 
include: 
 Unsigned 16: Unsigned 16-bit integer. 
 Signed 16: Signed 16-bit integer. 
 BCD: 4-digit BCD format. 
 Float: 4-byte IEEE single-precision, floating point format. 
 Signed 32: Signed 32-bit integer. 
 Unsigned 32: Unsigned 32-bit integer. 
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Tolerance Specifies the minimum amount of change that must occur to a tag value, since 
the last change, for an event to be recognized. Using this parameter is a convenient way of 
smoothing sensor fluctuations.  
 Tolerance applies to analog PLC tags only. The value is in the external device 
measurement units (raw PLC units) and not engineering units (ref Conversion). 
Tag Scale Low/High Limit These fields specify the upper and lower limits of the tag's 
value. This option is only relevant when the Set to Default option is not checked.  
Set Default When this option is checked the Low/High limits are default according to the 
format limits. 
Conversion External devices normally generate values according to their internal format 
and in order to obtain the maximum accuracy. For instance, a temperature measured in the 
field, which is in the range between 0 and 600 degrees, may be presented as a numerical 
range of between 0 to 65535. To convert the field measured value in engineering units, the 
application uses the linear conversion. 
 Value 1 Measured: Measured raw value sample. 
 Value 1 Engineering: Corresponding engineering value sample. 
 Value 2 Measured: Another measured raw value sample. 
 Value 2 Engineering: Another corresponding engineering value sample. 
For example, if you specify the following:  
Value 1 Measured = 0. 
Value 1 Engineering = 0. 
Value 2 Measured = 1. 
Value 2 Engineering = 2.  
The converted value would be the raw PLC value multiplied by two.  
  
Note: When converting a float tag value the result will always be a float number even if the 
tag format is WORD or DWORD. 

 
 

 

 
   
 
 
 
 

Format 
This field is used to specify the data format of the external device. The options include: 
Unsigned 16 Unsigned 16 bit integer 
Signed 16 Signed 16 bit integer 
BDC 4 digit BCD format 
Float 4 byte IEEE single precision, floating point format 
Signed 32 Signed 32 bit integer 
Unsigned 32 Unsigned 32 bit integer 
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The low and the high fields specify the upper and lower limits of the tag value. If the low 
limit you specify is greater than the high limit, the low limit value will be the minimum and 
the high will be the maximum in engineering unites, according to the PLC value type. 

 
 

 

 
   
 
 
 
 

Specifies the minimum amount of change that must occur to a atag value since the last 
change, for an event to be recognized. 

 
 

 

 
   
 
 
 
 

Specifies the minimum amount of change that must occur to a atag value since the last 
change, for an event to be recognized. 
The value is in the external device measurement units (raw PLC units) and not engineering 
units (ref Conversion). 
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Used to measure raw values. 
 
 

 

 
   
 
 
 
 

Represents the Corresponding (to the measured) engineering value sample. 
 
 

 

 
   
 
 
 
 

Digital Tag Type 
A digital tag type is a discrete logic tag with Boolean values of TRUE (1) or FALSE (0). 

o To define a digital tag type: 
Click in the Tag Type field of the Tag Definitions: New Tag dialog box , and select Digital 
from the drop-down list. The Tag Type parameters will appear:  

  
The following option is available: 

Filter    
Used for debouncing, which is filtering out oscillations. This 
option is only available for PLC tags. See PLC Tag Source 
Parameters. 
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Digital Tag      
What is a Digital Tag? 
Discrete logic tags that have boolean values of TRUE (1) or FALSE (0). 
  
How to define a Digital Tag? 
Select the Digital option from the Tag Type field in the Tag Definition dialog box.. 
  
The filter field applies to digital PLC tags only. Specifies the minimum amount of time 
during which a tag value should remain stable. In this field define the amount of time the 
Application will wait after a tag value change is detected, before continuing to sample the 
tag. 

 
 

 

 
   
 
 
 
 

The filter field apply to digital PLC tags only. Specifies the minimum amount of time during 
which a tag value should remain stable. In this field define the amount of time the 
Application will wait after a tag value change is detected, before continuing to sample the 
tag. 
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Determines the "always" sample rate in milliseconds units. 
 
 

 
 

   

 
 
 

 
 

Determines the "always" sample rate in seconds units. 

 
 

 
 

   
 
 
 
 

String Tag Type 
A string tag can receive an alphanumeric string as a tag value. 

o To define a string tag type: 
Click in the Tag Type field of the Tag Definitions, New Tag dialog box and select String 
from the drop-down list. The Tag Type parameters will appear as follows:  

  
 
In the Width field, specify the maximum number of characters that you want the string to 
include. The maximum length of a string tag is 255 characters. 
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String Tag     
A string tag can receive an alphanumeric string as a tag value. 
To define a string tag type: 
1. 1. Click in the Tag Type field of the Tag Definitions: New Tag dialog box and select 
String from the drop-down list. The Tag Type parameters will appear as follows:  
1. 2. In the Width field, specify the maximum number of characters that you want the string 
to include. The maximum length of a string tag is 255 characters. 

 
 

 
 

   
 
 
 
 

Specify the maximum number of characters that you want the string to include. 
 
 

 

 
   
 
 
 
 

Authorization Groups 
Security authorization can be added during tag definition. This enables the group/user to 
sample tag value changes. 
This is implemented by assigning authorization groups/users to each tag. Operators who 
do not belong to any of the assigned groups will not be authorized to change tag values.  
Note:     All operators can read tag values, but only authorized operators can change them. 
Operator authorization is discussed in more detail in Chapter 7, Security and User 
Management. 
Once a group is assigned to a tag, any operator who belongs to the group can perform tag 
value operations on that tag. 

o To assign groups to a tag: 
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Click the Groups button to open the Access Permission Manager where authorized users 
and/or groups can be selected.  

  
1.    Click the dropdown list above the Groups/User Name field and select the type of list 
required. There are three list modes:  

o     List all Groups&Users - displaying a list of the application's defined groups and 
users  

o     List all Groups - displaying a list of the application's defined groups. 
o     List all Users - displaying a list of the application's defined users. 

2.    To actually assign access permission select the relevant groups/users and click the 
Add button, or, click the Add All button to assign all groups/users. The selected groups 
users are now displayed in the list of Access Members. 
3.    To delete users/groups from the Access Members List, select the relevant 
groups/users and click Remove, or click the Remove All button. 
4.    Check the All groups and users have access permission checkbox to assign access 
permission to all your application's groups and users.  
5.    Click OK to confirm. 
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Allows you to define security groups for changing tags value by an operator, so that only 
authorized operators can set the tag value. Operators can then be added to any group that 
is defined, to provide them with access to different Application elements (such as tags, 
menu items, etc.).  

 
 

 
 

   
 
 
 
 

Record Tab  
Click the Record Tab to access the Record tab dialog box to determine how tag value 
changes are both initialed and recorded.  

 
  
The following options are available for defining the recording: 
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Never    Specifies that tag value changes will never be 
recorded. 

Changes 

Specifies that the tag values will be recorded 
whenever it is sampled and is found to have 
changed by more than the tolerance since the 
previous sample. 

Update     
Specifies that the tag value will be recorded 
whenever a driver is set to update the values 
(even if no changes were detected.) 

Every    Specifies that the tag value will be recorded each 
specified time interval.  

ODBC 
Logging    

Specifies that tag value changes will be written in 
the same format both to the ODBC and to 
application history. This option is available when 
either Changes, Update or Every is selected. 

  
 
 

 
 

   
 
 
 
 

Tag Definition- Record    
In this dialog box you can decided whether tag value changes will be recorded or not. 
The options include: 
Never The tag value will never be recorded. 
Changes The tag value will be recorded whenever it is found to have changed since the 
previous sample. 
Update The tag value will be recorded whenever a driver is set to update the values (even 
if no changes were detected.) 
Every The tag will be recorded each specified time interval. 
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Tag Definition- Record    
In this dialog box you can decided whether tag value changes will be recorded or not. 
The options include: 
Never The tag value will never be recorded. 
Changes The tag value will be recorded whenever it is found to have changed since the 
previous sample. 
Update The tag value will be recorded whenever a driver is set to update the values (even 
if no changes were detected.) 
Every The tag will be recorded each specified time interval. 

 
 

 
 

   
 
 
 
 

If this option is chosen the tag value will be recorded whenever it is found to have changed 
since the previous sample. 

 
 

 

 
   
 
 
 
 

If this option is chosen the tag will be recorded each specified time interval. 
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If this option is checked then the tag value will never be recorded. 
 
 

 

 
   
 
 
 
 

If this option is chosen the tag value will be recorded whenever a driver is set to update the 
values (even if no changes were detected.) 

 
 

 

 
   
 
 
 
 

Startup Values Tab  
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The following options are available for defining the startup values of the tag: 

Startup Value 
Defined    Specifies whether a startup value will be defined. 

Default A hard-coded value typed into the Value field. 

Last Historical 
    

Takes the initial value from the recorded history 
(see below). Be careful: this can reduce 
performance if the search for the last value takes 
a long time. 

Last correctly 
sampled value 

This allows you to set the startup value for tags 
that are not recorded to history 
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Dynamic Data Exchange (DDE) Link Tab  
Click the DDE Link tab to access the DDE Link dialog box where how the application 
communicates with other applications (such as Excel) can be defined.  

 
DDE is a common protocol that allows applications to exchange data freely, using either 
one-time data transfers, or ongoing transfers in which applications send updates to each 
other whenever new data is available.  
The DDE Link tab contains options that enable you to specify that the tag will be linked to 
another application through the DDE. This will cause the tag value to be updated 
immediately, whenever a change occurs in the object to which the tag is linked.  
There are three options: 
In the DDE Type field click the arrow in the dropdown list and select either: 

None  Specifies that no DDE link is associated with the 
tag. This is the default option. 

Single    Specifies the application, topic, item name and 
type of link.  

Block    Specifies the block name, row, column and type of 
link.  
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Tag Definition- DDE Link   
The Application can communicate online with other application (such as Excel) through the 
DDE interface. 
  
The DDE is a common protocol that allows to exchange data freely, using either one- time 
data transfer in which applications send updates to each other whenever new data is 
available. 
  
The DDE link to tag section in the Tag Definition dialog box contains options that enable 
you to specify that the tag will be linked to another application through the DDE. This will 
cause the tag value to be updated immediately, whenever a change occurs in the object to 
which the tag is linked. 
  
In the DDE field you can select one of three options: Block, None, Single. 

 
 

 
 

   

 
 
 

 
 

DDE Type - Single 
Select Single from the Tag Definition dialog box for tags that will not be part of a DDE client 
block. 

  
The following fields define the DDE connection: 

Application The application to which you want to link the tag.  



Chapter 9 Tags 

343 

Topic    The topic in the application that contains the object to which the tag will 
be linked. 

Item Name    
The name of the item to which you want to link the tag. The name is 
taken from the application and topic to which the tag is linked. For 
example, an Excel cell number. 

Link    

Enables you to define the DDE Link as: Always linked to the DDE server 
or In Monitor. When selecting Always, every change will be passed by 
application DDEC to WizPro, even if the tag is not In Monitor. 
Application DDEC enables your application to run as a DDE client and 
receive information from server applications. Refer to Chapter 38, 
Application DDE Support for more details about application DDEC.  

 
 
 

 
 

   

 
 

 
 
 

DDE Tag Link- Single    
If you choose Single option in the DDE type, the following parameters will be requested: 
Application - The application that you want the tag to be linked to. For a list of available 
applications click on the arrow to the right of the field. 
Topic The Topic in the application that contains the object to which the tag will be linked. 
Item Name The name of the item that you want the tag to be linked you the name is taken 
form the application and topic to which the tag is linked (Excel cell number...). 
Link Allows you to define the DDE Link as wither always linked to the DDE server or in 
Monitor. When selecting Always, every change will be passed by the application DDEC to 
the application, even if the tag is not in monitor. 
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DDE Type - Block 
Select Block from the Tag Definition dialog box to connect a tag to one item from a DDE 
block. 

  
The following options are available: 

Block 
Name    The block to which the tag will belong. 

Row    The row number of the item in the block relative to the start position. 

Column    The column number of the item in the block relative to the start position. 

Link 

Enables you to define the DDE Link as:  
Always linked to the DDE server or In Monitor. When selecting Always, 
every change will be passed by application DDEC to WizPro, even if the 
tag is not In Monitor.  

The application DDE block mechanism enables the application to receive many tag values 
from the server in one update message. This improves the communication between the 
application and the DDE server. 
A common use for DDE client blocks is a setup in which a DDE server immediately 
updates a block of items building a recipe. Define DDE client blocks only if data items in 
the server change simultaneously (within milliseconds). For more details, refer to the DDE 
Support chapter. 
PLC tags linked to DDE items will actually cause the DDE application to update the PLC, 
and the updated value sampled from the PLC will be automatically transferred to the DDE 
application. However, if any application module reads or writes tag values, it will first 
access the PLC tags and then update the DDE link. 

 
 

 
 

   
 
 
 
 

DDE Tag Link- Block    
If you choose Block in the DDE type, the following parameters will be requested: 
Block Name The block to which the tag will belong. 
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Row The row number of the item in the block relative to the start position 
Column The column number of the item in the block relative to the start position. 
Link Allows you to define the DDE Link as whether always linked to the DDE server or in 
Monitor. When selecting Always, every change will be passed by the application DDEC to 
the application, even if the tag is not in monitor. 

 
 

 
 

   
 
 
 
 

Specify the internal name of the block being defined.  
 
 

 

 
   
 
 
 
 

When selecting Always, every change made will be passed by WizDDEC to WIZPRO, 
even if the tag is not in monitor. 

 
 

 

 
   
 
 
 
 

Specify the column number of the item in the block relative to the start position. 
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If chosen the device is sampled to update its respective tag only when the tag's value is 
requested by one of Application modules. 

 
 

 

 
   
 
 
 
 

Specify the row number of the item in the block relative to the start position 

 
 

 
 

   

 
 
 

 
 

Lock Tag 
Click the Lock tab to access the Lock dialog box. Tag values can be locked for a 
predefined period of time. This could be for a short time or permanently.  
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The following options are available: 

Lock Tag This field when checked enables the Lock Tag option. 

Tag value in locked 
state    

Specifies the value of the tag in its locked state. The tag remains 
with this value until the date/time limits expire. 

Never expire       When checked defines that the tag will remain permanently 
locked. 

Lock until       Defines the time and date when the defined Lock Tag option 
expires.  

Status Tag       Defines the status of the locked tag (digital only). 

Station     Specifies a tag station. 

Tag    Specifies a tag name. 
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Tag Definition - Lock    
This dialog box enables you to lock a tag value for a predefined time. 
To lock a tag value 
1. Check the Lock Tag checkbox to enable the Lock feature. 
2. Type the value of the tag in its locked state. The tag remains with this value until lock 
expires. 
3. Under Time Definition, check the Never expire checkbox if you want the tag to remain 
locked permanently; or, select the date and time after which the lock feature will expire. 
4. Under Status Definition, check the Status Tag checkbox to define a status tag (a digital 
tag) to indicate the locked tag status. 
  
To change lock definitions at run-time, define a Fast Action trigger using the 
LockTagsValues function to display a list of all your application tags that were defined with 
the Lock Tag feature and change lock tag status and values. 

 
 

 

 
   
 
 
 
 

WizPLC Tab 
The WizPLC tab allows to define if the tag will be used in WizPLC program and to set 
some of the softlogic tag attributes. 
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Export as a 
WizPLC variable 

This field, when checked, enables the Export of the current tag as 
a WizPLC variable. 

WizPLC variable 
name 

Specifies the tag nameA which will be used in WizPLC, but with 
some naming rules and restrictionsB  

Has an IO address When checked, this field defines the addressC of the IO on the 
WizPLC fieldbus. 

Sampling 
Frequency 

Specifies the sample rate for the data update - reading rate of 
Wizcon in WizPLCD. The maximum sampling rate is 50ms. 

No PLC Sampling 
The value will not be read by the PLC. Use this option only if the 
PLC will never modify the value - it will give you better 
performance. 

Retain When checked specifies to WizPLC this tag will use the retain data 
feature. 

Read-only When checked specifies that the related WizPLC variable will be 
read-only. 
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Variable is 
initialized by 
Wizcon 

When checked specifies to WizPLC that Wizcon will provide the 
starting values to the WizPLC runtime. 
When unchecked, the WizPLC runtime will use the default values 
delivered by the program. 

ABy default, Wizcon will put the Wizcon tag name in this field. 
BSome characters are forbidden and some names are reserved as : 
   - no number as first character 
   - no double underscore character in the name 
   - all IEC 61131-3 reserved names  
CAddresses must respect the IEC 61131-3 format and must fit with the PLC configuration (See 
WizPLC user guide). 
DWe do not recommend that you define too many different rate values. It is preferable to re-
use as much as possible the sample rates already used for other tags. In the WizPLC log file 
(SoftPLCDx.log), a message will inform you if there are too many different sample rate values. 

o How to modify tags and IO address 
1.    If you changed a previously defined tag name or IO address, in order to have them 
available within the WizPLC database file, you need to perform a ‘Build’ (or ‘Login’) 
command in WizPLC. 
2.    Then, if you want this modification to be available in the runtime, an ‘online change’ of 
the WizPLC runtime is required.  
3.    Any modification of the sample rate requires a reset of the WizPLC runtime.  
Note:    In order to declare several Wizcon tags into WizPLC, you can use the WizPLC tag 
Export tool. This tool is accessible when launching the WizPLC development tool. 
Moreover, this tool allows you to export network and system tags. 
Note:    When the tag conversion settings are defined, WizPLC will set the tag type as real. 
 

 
 

 
 

   

 
 
 

 
 

Tag Definition - WizPLC 
 
If you want your Wizcon tags to be available in WizPLC, you must define how you want 
them to be used in WizPLC. This dialog box helps you to do this. 
The following options are available: 
 

o WizPLC variable name: The name of the variable when used in WizPLC. This 
name must be IEC 61131-3 Compliant. 
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o Has an IO Address: Check this option and you can then define the address of the 
variable 

o Sampling frequency: The time interval between sampling of the variable. The 
maximum sampling frequency is 50ms. 

o No PLC Sampling: The value will not be read by the PLC. Use this option only if 
the PLC will never modify the value - it will give you better performance. 

o Retain: Whether the value of the tag is to kept between sessions of WizPLC 
o Read-only: Whether Wizcon can change the value of the variable or not. 
o Variable is initialized by Wizcon: Whether the initial value comes from Wizcon or 

WizPLC 
 
 

 
 

   

 
 

 
 
 

Alarms Tab 
The Alarms tab is used to define Tag Related Alarms and their properties. The following 
apply to all Tag Related Alarms: 

o     Alarms definition are automatically generated with the correct condition and text 
that is a combination of the tag description and the alarm type. 

o     If the combination of the tag description and the alarm type is longer than the 
maximum permitted number of alarm text characters then the alarm text is a 
combination of the tag name and the alarm type. Other parameters such as Zone, 
Family,..., are set to default. 

o     The user can edit text and other properties, however the alarm condition cannot 
be modified. 

o     An alarm can be deleted from the Tag Definition dialog box only. 
o     An automatic alarm is marked as such and the link to the tag is saved. The tag 

contains a link to each alarm definition. If the properties of the above setting 
change the conditions also change and as a result the alarm definition is updated.  

o     In the Alarms tab when an alarm in the Alarms Value field is checked the user 
can modify the definition of this specific alarm by clicking the relevant alarm button. 

o     Un-checking the relevant checkbox removes the alarm definition. 
o     If a tag definition is deleted all alarms related to this tag will be removed 

automatically. 
o To access the Tag Definition Alarms Tab 

In the Tag Definition dialog box click the Alarms tab to access the Alarms dialog box.  
Or 
In the All Containers list right click Tags, select Add Tag and after defining the tag name 
and other general properties click the Alarms tab.  
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This dialog box has the following fields: 

Alarms Values 

There are four alarm values: 
LoLo - critically low process values. The tag value must fall below this 
limit to generate an alarm. 
Low - low precess values. The tag value must fall below this limit to 
generate an alarm.  
High - high process values. The tag value must exceed this limit to 
generate an alarm. 
HiHi - critically high process values. The tag value must exceed this 
limit to generate an alarm.  
These values are independent of each other. For example LoLo can 
be defined as 1000 and HiHi can be defined as 5. 

  

Rate Alarm    
Processes values that change too quickly. When a process value 
fluctuates by more than the rate of change limit in the given time 
interval the tag generates an amount per unit of time. 



Chapter 9 Tags 

353 

Deviation 
Alarm    

Processes values that deviate from the optimum value. Deviation 
alarms require a definition of a target value and range. If the process 
exceeds the range, a Deviation Alarm occurs. For example, if the 
optimum value is 100 and the range (dead band) is +/-5%, the 
process can vary from 95 to 105 without generating an alarm. The 
Deviation Dead Band is given as a percentage of the value. Deviation 
alarms can be according to: 
Type which is according to %. 
Fixed which is fixed according to a set size. 

o To define Tag Related Alarms do the following: 
1.    In the Alarm Values field check the alarm type, which could be either LoLo, Low, High 
or HiHi and then type in the value in the relevant field. If an option is not checked an alarm 
cannot be defined. Only when a checkbox is selected the can alarm exists. 
2.    Click the Alarm button opposite the checked Alarm Value to open the Alarm Definition 
dialog box. Modify the alarm accordingly and then click OK to return to this dialog box. 
3.    In the Rate Alarm field fill in the Rate of Change and then click the Alarms button to 
open the Alarm Definition dialog box. Modify the alarm accordingly and then click OK to 
return to this dialog box. 
4.    In the Deviation Alarm field do one of the following: 

o     To define the Optimal Value check this checkbox and then type in its value. This 
is the basic value. 

o     In the Dead Band % field check either the Percentage or Fixed and then type in 
the value.  

Click the Alarms button to open the Alarms dialog box and modify the alarm accordingly. 
Click OK to return to this dialog box. 
5.    Click OK to confirm and save your changes. 
 

 
 

 
 

   

 
 

 
 
 

Tag Definitions Tag Related Alarms 
This dialog box has the following fields: 
Alarm Values There are four alarm values: 
LoLo – critically low process values. The tag value must fall below this limit to generate an 
alarm. 
Low – low precess values. The tag value must fall below this limit to generate an alarm.  
High – high process values. The tag value must exceed this limit to generate an alarm. 
HiHi – critically high process values. The tag value must exceed this limit to generate an 
alarm.  
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These values are independent of each other. For example LoLo can be defined as 1000 
and HiHi can be defined as 5. 
Rate Alarm Process values that change too quickly. When a process value fluctuates by 
more than the rate of change limit in the given time interval the tag generates an amount 
per unit of time. 
Deviation Alarm Process values that deviate from the optimum value. Deviation alarms 
require a definition of a target value and range. If the process exceeds the range, a 
Deviation Alarm occurs. For example, if the optimum value is 100 and the range (dead 
band) is +/-5%, the process can vary from 95 to 105 without generating an alarm. The 
Deviation Dead Band is given as a percentage of the value. Deviation alarms can be 
according to: 
Type which is according to %. 
Fixed which is fixed according to a set size. 
To define Tag Related Alarms do the following: 
1. 1. In the Alarm Values field check the alarm type, which could be either LoLo, Low, High 
or HiHi and then type in the value in the relevant field. If an option is not checked an alarm 
cannot be defined. Only when a checkbox is selected the can alarm exists. 
2. 2. Click the Alarm button opposite the checked Alarm Value to open the Alarm Definition 
dialog box. Modify the alarm accordingly and then click OK to return to this dialog box. 
3. 3. In the Rate Alarm field fill in the Rate of Change and then click the Alarms button to 
open the Alarm Definition dialog box. Modify the alarm accordingly and then click OK to 
return to this dialog box. 
4. 4. In the Deviation Alarm field do one of the following: 

• To define the Optimal Value check this checkbox and then type in its value. This is 
the basic value. 

• In the Dead Band % field check either the Percentage or Fixed and then type in 
the value.  

5. 5. Click the Alarms button to open the Alarms dialog box and modify the alarm 
accordingly. Click OK to return to this dialog box. 
6. 6. Click OK to confirm and save your changes. 

 
 

 
 

   

 
 
 

 
 

Tag Definitions Tag Related Alarms 
This dialog box has the following fields: 
Alarm Values There are four alarm values: 
LoLo – critically low process values. The tag value must fall below this limit to generate an 
alarm. 
Low – low precess values. The tag value must fall below this limit to generate an alarm.  
High – high process values. The tag value must exceed this limit to generate an alarm. 
HiHi – critically high process values. The tag value must exceed this limit to generate an 
alarm.  
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These values are independent of each other. For example LoLo can be defined as 1000 
and HiHi can be defined as 5. 
Rate Alarm Process values that change too quickly. When a process value fluctuates by 
more than the rate of change limit in the given time interval the tag generates an amount 
per unit of time. 
Deviation Alarm Process values that deviate from the optimum value. Deviation alarms 
require a definition of a target value and range. If the process exceeds the range, a 
Deviation Alarm occurs. For example, if the optimum value is 100 and the range (dead 
band) is +/-5%, the process can vary from 95 to 105 without generating an alarm. The 
Deviation Dead Band is given as a percentage of the value. Deviation alarms can be 
according to: 
Type which is according to %. 
Fixed which is fixed according to a set size. 
To define Tag Related Alarms do the following: 
1. 1. In the Alarm Values field check the alarm type, which could be either LoLo, Low, High 
or HiHi and then type in the value in the relevant field. If an option is not checked an alarm 
cannot be defined. Only when a checkbox is selected the can alarm exists. 
2. 2. Click the Alarm button opposite the checked Alarm Value to open the Alarm Definition 
dialog box. Modify the alarm accordingly and then click OK to return to this dialog box. 
3. 3. In the Rate Alarm field fill in the Rate of Change and then click the Alarms button to 
open the Alarm Definition dialog box. Modify the alarm accordingly and then click OK to 
return to this dialog box. 
4. 4. In the Deviation Alarm field do one of the following: 

• To define the Optimal Value check this checkbox and then type in its value. This is 
the basic value. 

• In the Dead Band % field check either the Percentage or Fixed and then type in 
the value.  

5. 5. Click the Alarms button to open the Alarms dialog box and modify the alarm 
accordingly. Click OK to return to this dialog box. 
6. 6. Click OK to confirm and save your changes. 

 
 

 
 

   

 
 
 

 
 

MultiState Tags 
Presentation 

A multistate Tag is a tag which can take many states (in fact text values) according to the 
current value of the tags and the list of defined states. This an enhancement of text tables 
that exist in Image module.  

   
Access means 
• Multistates tags can be accessed via Tag definition dialog.  
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• Multistates can also be handled via the tags tree in multistates folder.  

   

How To 
• A new property page has been added to Tag definition dialog:  

   

 

   

If you want the current tag to be a multistate tag, check the Multi-state tag checkbox. You 
can then select an existing multistate or create a new one. If a multistate is selected, the 
list displays all the states included in the multistate. Each state is defined as an interval 
with a low value (Value1), a high value (Value2) and the corresponding text. When the tag 
value will be between the low and high values defined in this state, then the corresponding 
text value will be available in the tag content. Typically, this multistate value will be 
displayed in image.  

  
 

• Define a new multistate:  
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==> Text table name: enter the name of the multistate  

   

==> Default text when tag is not initialized: enter the text that will be displayed if 
the tag is not yet initialized  

   

==> Default text when value is out of range: enter the text that will be displayed 
when the tag value doesn't correspond to one of the defined states.  

   

Then you can add new states. A state includes a low limit , a high limit and a text. 
This text will be updated in multistate text value when the tag value is between low 
limit and high limit (included).  

   

• Define or modify a new state:  
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• Displaying the list of multistates in Wizcon Studio  

   

You can use the tags tree to display the list of defined multistates. When you 
select a multistate, all the multistate tags that are related to this multistate are 
displayed. By selecting a multistate, you can access to the right-click menu to 
modify or delete it. But be careful: if you modify it, it will be modified for all the tags 
that use it!!  
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Single Tag Input 

This section describes how to assign an immediate value to a specific tag.  
o To define single tag input: 

In the Control Panel of the Application Studio, double-click the Single Tag icon. 
Or, 
From the Tools menu of the Application Studio, select Single Tag. The Single Tag Input 
dialog box is displayed: 

  
The following options are available: 

Station Name  The application network station to which the tag belongs. 

Tag Name 

The tag for which the value is to be modified. Click on the arrow on the 
right side of the field to display a drop-down list of tags. When a tag is 
selected, its description is displayed underneath the Tag Name field 
and its value is displayed in the Current Value field. 

Current 
Value    Specifies the current value of the selected tag. 

New Value Enter the new tag value, or click on the arrows in the Suggest field 
slider, to determine a new tag value. 

Set    Specifies a new current value that is written immediately.  

Suggest    Specifies a new current value that is displayed in the New Value field 
and written by clicking Apply. 
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Single Tag     

To define single tag input: 
In the Control Panel of the Application Studio, double-click the Single Tag icon. 
Or, 
From the Tools menu of the Application Studio, select Single Tag. The Single Tag Input 
dialog box is displayed: 
The following options are available: 
Station Name  The application network station to which the tag belongs. 
Tag Name The tag for which the value is to be modified. Click on the arrow on the right 
side of the field to display a drop-down list of tags. When a tag is selected, its description is 
displayed underneath the Tag Name field and its value is displayed in the Current Value 
field. 
Current Value Specifies the current value of the selected tag. 
New Value Enter the new tag value, or click on the arrows in the Suggest field slider, to 
determine a new tag value. 
Set Specifies a new current value that is written immediately.  
Suggest Specifies a new current value that is displayed in the New Value field and written 
by clicking Apply. 

 
 

 

 
   
 
 
 
 

Single Tag 
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Press the Single Tag icon from the Application's Quick Access Bar to open the Single Tag 
Input dialog box. 

 
 

 
 

   
 
 
 
 

Tool / Single tag 

Select this item to modify a single tag value.  
  
This method is useful when you want to change a specific tag's value instantly for practical 
and testing purposes. 
  
After you select this item, the Single Tag dialog box will appear with several fields that you 
can use to specify the tag that you want to write a value to, and the value that you want to 
apply.  

 
 

 
 

   
 
 
 
 

MultiAdd Tags 

The MultiAdd operation is used to automatically generate a group of tags according to a 
user-defined pattern format.  

o To define tag pattern format: 
1.    In the All Containers section of the Application Studio, click on Tags to display the List 
of Tags. 
2.    In the List of Tags section, right-click the tag you want to add to a group and select 
MultiAdd from the popup menu. The MultiAdd Tag Definition dialog box is displayed: 
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3.     This dialog box is used to generate a pattern for tags to be added to the existing tag 
list. Once a pattern is defined for the Name format and Address format fields, you can 
activate the Generate button to add tags to the list according to the pattern you defined.  
The following options are available: 

Name format    

The contents of this field can be any of the following characters: 
*: This character will remain as is in the next tag. 
A: This character will be incremented alphabetically. 
D: This character will be incremented in decimal numeric order. 
H: This character will be incremented in hexadecimal numeric order. 

 O: This character will be incremented in octal numeric order. 

 

#: This character will cause whatever character appears in that 
position to be incremented according to its specific character type. If 
the character is alphabetical, it will be incremented alphabetically; if 
the character is numerical, it will be incremented numerically. Any 
other character will remain as is. 
Note: The MultiAdd operation increments only the tag name and 
address. 
For example, if the current tag name is WATER39X and the next 
name format was defined as *****DHA, the MultiAdd operation will 
cause the tag name WATER39Y to be generated. 
Note that if the format length is less than the current name/address 
length, the format will affect the right part of the name/address. For 
example, if the name format was defined as **HHH, and the current 
name is WATER001, the next name will be WATER002. 

Address format 
    

The contents used for the Name format field can also be used for the 
Address format field. 

Pattern and Step 

Specifies incremental amounts. You can enter any numerical value 
from 1 to 7. The Name and Address of the next tag will be 
incremented according to the amount specified in these fields. For 
example, in the Name format field, if you entered AA for the Pattern 
and 2 for the Step, the next tag will be called AC.  
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Amount to add    Specify the number of tags that will be added to the list when the 
Generate button is activated. 

After you set the MultiAdd definition, click the Generate button to generate the specified tag 
pattern. See Chapter 12, Multiple Tags for further information. 
 

 
 

 
 

   

 
 

 
 
 

Multi Add Tag Definition     

Note: Not applicable on the Web. 
This dialog box is used to generate a pattern for tags to be added to the existing tag list. 
Once a pattern is defined for the Name format and Address format, you can activate the 
Generate button to add tags to the list, according to the pattern you defined.  
  
In this dialog box, the values for the Pattern field can be: 
* This character will remain as is in the next tag.  
A This character will be incremented alphabetically.  
D This character will be incremented in decimal numeric order.  
H This character will be incremented in hexadecimal numeric order.  
O This character will be incremented in octal numeric order.  
# This character will cause whatever character appears in that position to be incremented 
according to its specific character type. If the character is alphabetical, it will be 
incremented alphabetically; if it is numerical, it will be incremented numerically. Any other 
character will remain as is.  
  
In the Step field, specify the increment step (1 - ) by which to advance the Name and 
Address of each tag. For example, assume the tag selected in the list box is called 'tag01', 
if you define '****DD' as the Pattern for the Name format and 4 for the Step, the next tag 
generated will be 'tag05'.  
  
In the Amount to add field specify the number of tags that will be added to the list when 
the Generate button is activated.  
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Tag Management 

o To modify a tag: 
1.    In the All Containers section of the Application Studio, click on Tags to display the List 
of Tags. 
2.    In the List of Tags section, right-click the tag you want to modify and select Modify Tag 
from the popup menu. 
Or,  
Double-click on the tag in the List of Tags section. The Tag Definition dialog box is 
displayed in which you can modify the tag. 

o To delete a tag: 
1.    In the All Containers section of the Application Studio, click on Tags to display the List 
of Tags. 
2.    In the List of Tags, right click the tag you want to delete and select Delete Tag from the 
popup menu. A dialog box is displayed in which you can confirm your request or cancel it. 

o To find a tag: 
1.    In the List of Tags right-click anywhere and select Find Tag from the popup menu. The 
Find Tag dialog box opens. 
2.    In the Find What field type in the name of the tag, its description or address. 
 

 
 
3.    In the Conditions field select either; Tag Name, Description or Address (your selection 
will depend on the information you typed in the Find What field). 
4.    Click Find. The tag is highlighted in the List or Tags. 
5.    To close the dialog box click Exit or anywhere in the Application Studio. 
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Tag Modify 

This option allows the user to Modify the Tag definition. 
  
To initiate this option: 
1. Select a Tag from the List Tag 
2. Right Click it and select the Modify option from the Pop-up Menu. 
OR 
 Double click a chosen Tag. 

 
 

 
 

   
 
 
 
 

Delete Tag 

This option enables you to delete the selected tag. 
  
To delete a Tag: 
1. Select a tag from the list tags  
2. Click your mouse right button and choose the Delete option form the Pop up menu. 
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Tools / Find / Tag 

The application enables you to locate tags in the List of Tags in the Application Studio. This 
is especially useful if you have an application with many tags.  
To locate a tag: 
1. Click anywhere in the List of Tags and select Find from the Tools menu. The Find Tag 
dialog is displayed. 
2. In the Find what field, enter the name of the tag you want to locate, its description or its 
address. 
3. In the Conditions area, select either Tag name, Description or Address depending on 
the tag criteria you entered in the Find what field. 
4. Click Find. The tag is located in the List of Tags. 
5. Click Exit or anywhere in the Application Studio outside the List of Tags to close the 
dialog. 

 
 

 
 

   
 
 
 
 

Locating Tags 

The Application enables you to locate tags in the List of Tags. 
  
To locate a tag: 
1. Click anywhere in the List of Tags and select Find from the Tools menu. The Find Tag 
dialog is displayed.  
2. In the Find what field, enter the name of the tag you want to locate, its description or its 
address. 
3. In the Conditions area, select either Tag name, Description or Address depending on 
the tag criteria you entered in the Find what field. 
4. Click Find. The tag is located in the List of Tags. 
2. Click Exit or anywhere in the Application Studio outside the List of Tags to close the 
dialog. 
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Find Tag  

In this dialog box, enter the name prefix of any tag that you want to search for in the tag 
list. Then, activate the Find button to perform the search.  

 
 

 
 

   
 
 
 
 

System Tags 

System Tags are predefined, built-in tags providing system status information. These tags 
can be added to an application only once either when the application is activated or 
anytime afterwards. Once added, System Tags will appear under the Tags icon in the All 
Containers pane. When double clicked a list of all the tags in the application will open in 
the Control Panel. 
System Tags also hold information for the application PLC integrated application. For a list 
of System Tags see Appendix H System Tags. 

o To define Systems tags when opening the program: 
If global tags have not been defined in your project then during application start-up the 
following message box will open on your screen. 

  
 
6.    Click Yes to add system tags or No not to. 
7.    Check the Never ask again checkbox to define this option. The System Tags icon will 
appear in the All Containers pane as a sub item of Tags.  
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8.    Double click the System Tags icon to view the List of System Tags.  
o    To define System Tags using the Tools menu: 

1.    From the Tools menu select Add Systems Tags. A Warning message will appear on 
your screen.  
2.    Click Yes to add System Tags. The System Tags icon will appear in the All Containers 
pane as a sub item of Tags.  
3.    Double click the System Tags icon to view the List of System Tags.  
 

 
 

 
 

   

 
 

 
 
 

System Tags 

Application system tags are pre-defined, built-in tags that provide system status 
information.  
To add system tags 
Select Add System Tags from the Tools menu. Once added, a new icon for System Tags is 
added to the All Container tree under Tags, and all the available system tags are displayed 
in a list. 
Note: System tags can be added to your application only once and cannot be removed. 
  
System Tags Names 
All system tags have the prefix WIZSYS followed by an underscore and a name indicating 
the tag's function. 
  
System Tags Type 
There are three types of system tags: Digital tags, Analog tags and String tags. 
Most system tags are read only, and return system data as stated in the tag's description. 
Some tags, such as tags indicating system time and date can be modified. 
List of System Tags 
The following is a list of System tags: 
WIZSYS_TAGSAMPLING  
WIZSYS_WRITE2HISFILE  
WIZSYS_ALARMMODULE  
WIZSYS_COLLAPSEALARMS  
WIZSYS_COMPRESSDEFINITION  
WIZSYS_WIZPLCCYCLETIME  
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WIZSYS_WIZPLCCYCLES  
WIZSYS_WIZPLCMAXTIME  
WIZSYS_WIZPLCSTATE  
WIZSYS_DAYS1970  
WIZSYS_DATE  
WIZSYS_DAY  
WIZSYS_HOUR  
WIZSYS_MINUTE  
WIZSYS_MONTH  
WIZSYS_OPERATOR  
WIZSYS_SECOND  
WIZSYS_MILLISECMIDNIGHT  
WIZSYS_TIME  
WIZSYS_YEAR  
WIZSYS_DISKFREE  
WIZSYS_DISKUSED  
WIZSYS_MINUTEMIDNIGHT  
WIZSYS_DAYS1980  
WIZSYS_BACKUP  
WIZSYS_PLUGMODEL  
WIZSYS_PLUGTAGS  
WIZSYS_TAGCOUNT  
WIZSYS_STATIONNAME  
WIZSYS_STATIONID  
WIZSYS_NETWORKACTIVE  
WIZSYS_MEMFREE  
WIZSYS_MEMUSED  
WIZSYS_WDAY  
WIZSYS_WILRUNNING  
WIZSYS_WIZPLCRTRUNNING  
WIZSYS_WIZPLCDEVRUNNING  
WIZSYS_COLLAPSEALARMS  
WIZ SYS_IMAGEX  
WIZ SYS_IMAGEY  
WIZ SYS_SCHEDULERENABLE  
WIZ SYS_SCHEDULERLASTERR  
WIZ SYS_SCHEDULERSTART  
WIZ SYS_SCHEDULERSTATUS  
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Tools / Add System Tags 

Select this item to add system tags to your application. System tags are pre-defined, built-
in tags that provide system status information. 
Note: System tags can be added to your application only once and cannot be removed. 
Adding system tags is also available when starting the application. 

 
 

 
 

   

Exporting Tags 

 
 
 
 
 

Exporting Tags 
The Export Tags option enables you to generate a tag list file (list of tag definitions) in two 
formats: 

o     ASCII - where files can be added. The list files are saved with a GLS extension 
o     CSV as Excel files - limited to numbers beginning with 0, for example tag 

addresses. This is a convenient tool for editing.  
You can edit the file to add, modify or delete tags. You can then import the file back into 
the system. 
Note:     The Excel program deletes the digit 0 before a number. To overcome this problem 
use ASCII format.  

o    To generate a list of tag definitions: 
In the All Containers pane right click on Tags and select Export Tags from the popup 
menu. The Tag List dialog box opens: 
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This dialog box is divided into two fields: Filter and Tags: 

Filter    

Name    - Specifies the tag you want to filter. 
Address - Specifies the address you want to filter. 
Comm. Driver   - Specifies the name of the communication 
driver. 

List 
Target    

Specifies the target destination of the generated list: 
Printer - the generated list will be sent to the defined 
printer. 
File (.GLS) - the generated list will be sent to file which can 
be either: 
Fixed format 
CSV 

Filter conditions can be set so that only specific tags will appear in the generated tag list.  
4.    The Filter and Address fields in this dialog box are in From/To format and are used to 
set the tag list filter. In addition, you can specify the tag list target.  
5.    If File is selected as the target, the filename, without the path or extension, must be 
specified and then select Fixed or CSV. The file will be placed in your application directory. 
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Export / Tag  
Use this dialog box to set filter conditions so that only specific tags will appear in the 
generated tag list.  

 
 

 
 

   
 
 
 
 

Tag Export     
This dialog box is used to set filter conditions so that only specific tags will appear in the 
generated tag list.  
This option opens up a dialog box that allows the user to produce a Tags List file. A Tag 
list file is an ASCII file with GLS extension. It describes all or some of the tags available in 
the system (depends on the filter which is being used). You can edit the Tags list file to 
Add, Modify and delete Tags. you can then Import the file back into the system. 
For each item in the Filter field, you can specify the range for the tags that you want to 
appear in the list.  
For Target, you can select Printer, to send the generated list to the printer, or File, to send 
the list to a file.  
If you select File, do not specify the path or extension of the file. The extension can be 
.GLS, CSV or Fixed format, and the file will be placed in your application directory.  
  
This option could be initiated by: 
1. Right click the Tags Object from the Container tree. 
2. Select the Export Tags option from the Pop-Up menu.  

 
 

 
 

   
 
 
 
 

Export Tags to WizPLC 
 
You can export tags to WizPLC at the moment at which you define the tag. However, this 
dialog box allows you to export tags en masse before launching the WizPLC development 
studio. 
 
In the listbox on the left, you can see the list of tags in Wizcon. Note that you can select 
tags from any Wizcon station.  
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Underneath, you have the set of options available to define how the tags will be handled in 
WizPLC.  
 
The following options are available: 

o WizPLC variable name: The name of the variable when used in WizPLC. This 
name must be IEC 61131-3 Compliant. 

o Has an IO Address: Check this option and you can then define the address of the 
variable 

o Sampling frequency: The time interval between sampling of the variable. The 
maximum sampling frequency is 50ms. 

o No PLC Sampling: The value will not be read by the PLC. Use this option only if 
the PLC will never modify the value - it will give you better performance 

o Retain: Whether the value of the tag is to kept between sessions of WizPLC 
o Read-only: Whether Wizcon can change the value of the variable or not. 
o Variable is initialized by Wizcon: Whether the initial value comes from Wizcon or 

WizPLC 
 
 
You can select one or more tags, and apply the above options to the selected tags. Once 
you have chosen the options, use the Add button between the two listboxes to export the 
tags to WizPLC.  
 
The listbox on the right shows the list of WizPLC tags. If you want to remove the tags from 
WizPLC, use the Remove button between the two listboxes. 

 
 

   

 
 
 
 
 

Export Tags to WizPLC 
 
You can export tags to WizPLC at the moment at which you define the tag. However, 
this dialog box allows you to export tags en masse before launching the WizPLC 
development studio. 
 
In the listbox on the left, you can see the list of tags in Wizcon. Note that you can select 
tags from any Wizcon station.  
 
Underneath, you have the set of options available to define how the tags will be handled 
in WizPLC.  
 
The following options are available: 

o WizPLC variable name: The name of the variable when used in WizPLC. This 
name must be IEC 61131-3 Compliant. 
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o Has an IO Address: Check this option and you can then define the address of 
the variable 

o Sampling frequency: The time interval between sampling of the variable. The 
maximum sampling frequency is 50ms. 

o No PLC Sampling: The value will not be read by the PLC. Use this option only 
if the PLC will never modify the value - it will give you better performance 

o Retain: Whether the value of the tag is to kept between sessions of WizPLC 
o Read-only: Whether Wizcon can change the value of the variable or not. 
o Variable is initialized by Wizcon: Whether the initial value comes from Wizcon 

or WizPLC 
 
 
You can select one or more tags, and apply the above options to the selected tags. 
Once you have chosen the options, use the Add button between the two listboxes to 
export the tags to WizPLC.  
 
The listbox on the right shows the list of WizPLC tags. If you want to remove the tags 
from WizPLC, use the Remove button between the two listboxes. 

 
 

   
 
 
 
 
 

Fixed (GLS File) Format 
Tag list files (.GLS) are ASCII files that you edit, or create and add to or replace the 
existing application tag list. 
Note:    Long tag names, address strings and additional parameters in tag definitions 
make length of a line in a GLS file over 256 bytes. In order to work with GLS files, use 
any Standard Windows Editor and set the Wrap option to OFF. 
Any line that begins with a semicolon (;) will be ignored. 
Tag descriptions appear inside the characters < >. Addresses have the format driver 
address or empty spaces for dummy tags. 
For DDE-Params, the parameters are Link (Y/N), and <Application:Topic:Item>. 
For Source-Params, the parameters are: 

PLC    Driver address Smp Smp-Rate 

Dummy    No parameters 

Compound Const1 Tag1 Oper Const2 Tag2 

For Type-Params, the parameters are: 

Analog Format Tol Conversion Min./Max. 
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Digital    Filter 

String Length 

The lines following the title line contain the tags and their corresponding tag 
information. 

 
 

 
 

   
 
 
 
 

GLS files are ASCII files that you edit, add to or replace with the existing Application 
tag list. The title line of the Tag list file has the following format: No., Name, 
Description, Groups, Red, Rcd- Rate, DDE-Params, Source, Source Params, Type, 
Type Params. 

 
 

 

 
   
 
 
 
 

Tag Export     
This dialog box is used to set filter conditions so that only specific tags will appear in 
the generated tag list.  
This option opens up a dialog box that allows the user to produce a Tags List file. A 
Tag list file is an ASCII file with GLS extension. It describes all or some of the tags 
available in the system (depends on the filter which is being used). You can edit the 
Tags list file to Add, Modify and delete Tags. you can then Import the file back into 
the system. 
For each item in the Filter field, you can specify the range for the tags that you want 
to appear in the list.  
For Target, you can select Printer, to send the generated list to the printer, or File, to 
send the list to a file.  
If you select File, do not specify the path or extension of the file. The extension can 
be .GLS, CSV or Fixed format, and the file will be placed in your application directory.  
  
This option could be initiated by: 
1. Right click the Tags Object from the Container tree. 
2. Select the Export Tags option from the Pop-Up menu.  
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Exporting Tag Definition Files Using an External Application  
If you are using an external application you can export tag definition files using the 
‘gls2csv’ tool through a command line or, save the option in the dialog box in a CSV 
file format. 

o To convert a tag definition file to CSV format: 
Type the following in the command line:  
gls2csv [fromfile] [tofile]  

 
 

 
 

   

 
 
 

 
 

Importing Tags 
The Import Tags option enables you to import a tag list file into the system. The imported 
file can replace the current list of tag definitions.  

o To import tag definitions: 
In the All Containers section of the Application Studio, right-click on Tags and select Import 
Tags from the popup menu. The List to Tags dialog is displayed:  
1.    In the Files of type field, select the type of file you want to import. You can choose 
between CSV and GLS. Locate the file you want to import and click Open. The Import 
Mode dialog is displayed. 
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2.    Click Replace to replace the tags in the tag list with the imported tags, Append to add 
the specified tags to the tag list, or Cancel to cancel the import.  
 

 
 

 
 

   

 
 

 
 
 

Import Tags     
This option is used to import a Tag List file into the system. 
1. From the Tools menu of the Application Studio, select Import and then Tags. The Open 
Tag file for Import dialog is displayed.  
2. In the Files of type field, select the type of file you want to import. You can choose 
between CSV and GLS. Locate the file you want to import and click Open. The Import 
Mode dialog is displayed. 
3. Click Replace to replace the alarms in the alarm list with the imported alarm, Append to 
add the specified alarm to the alarm list, or Cancel to cancel the import. 

 
 

 

 
   
 
 
 
 

Importing Tag Definition Files Using an External Application  
If you are using an external application you can import tag definition files using the 
command line.  

o To convert a csv file to a tag definition file: 
Type the following in the command line:  
csv2gls [fromfile] [tofile] 
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Defining Tag Properties 

You can define properties for the tag buffer size and the flush rate. 
o To define tag properties: 

In the All Containers section of the Application Studio, right click Tags and select 
Properties from the popup menu. The Tag Properties dialog is displayed: 

  
The following options are available: 

Buffer size 

Determines the WizPro logger buffer size for history files, in lines (records). 
The maximum is 2048 records. Increase the value of this option if you 
anticipate that a large number of changes will occur at any time during the 
working session.  

Flush 
rate:    

Determines a value that will represent the WizPro logger flush to disk rate in 
seconds (for history files). The maximum is 3600 seconds.  

Note:     Restart the application for changes to take place. 
 

Mandatory Tag Definition Parameters 
You can also define a set of mandatory fields for tag definitions as shown in the following 
dialog box. This dialog box allows you to define a set of mandatory fields when defining a 
tag. For each of the selected options, the user will not be able to define a tag unless the 
selected fields have been defined 
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Tag Properties    

Used to determine the logger buffer size for history files and the logger flush to disk rate. 
Buffer Size: 
This parameter determines the logger buffer size for history files, in lines (records). 
Maximum is 2048 records. Increase the value of this option, if it is anticipated that a large 
number of changes will occur at once at any time during the session. 
Note after you have determined the size, make sure to restart the application. 
Flush Size: 
This parameter determines a value that will represent the application logger flush to disk 
rate, in seconds (for history files). Maximum is 3600 seconds. 
Note after you have determined the size, make sure to restart the application 
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Tag Properties    

Used to determine the logger buffer size for history files and the logger flush to disk rate. 
  
Buffer Size: 
This parameter determines the logger buffer size for history files, in lines (records). 
Maximum is 2048 records. Increase the value of this option, if it is anticipated that a large 
number of changes will occur at once at any time during the Application session. 
  
Note after you have determined the size, make sure to restart the Application. 
  
Flush Size: 
This parameter determines a value that will represent the logger flush to disk rate, in 
seconds (for history files). Maximum is 3600 seconds. 
  
Note after you have determined the size, make sure to restart the Application 

 
 

 
 

   
 
 
 
 

Tag Property 

Use this option to define the Tag tuning parameters 
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Check this option to determine the logger buffer size for history files, in lines (records). 
Maximum is 2048 records. Increase the value of this option, if it is anticipated that a large 
number of changes will occur at once at any time during the Application session. 
Note after you have determined the size, make sure to restart the Application. 

 
 

 
 

   

 
 

 
 
 

Check this to determine a value that will represent the logger flush to disk rate, in seconds 
(for history files). Maximum is 3600 seconds. 
Note after you have determined the size, make sure to restart the Application. 

 
 

 
 

   

Other Topics 

 
 
 
 
 

Design / Add Object / Tags 
Select this item to define Tags and assign their Authorization groups.  
  
In the application, tags represent control values monitored by the system. These values 
are similar to variables in a programming language (such as BASIC, PASCAL, and C), or 
to the names of registers in a PLC. Like variables, each tag is identified by a unique name 
and can be one of several data types, such as integer, real, or Boolean. However, tags are 
distinguished from other variables, in that they can be associated with external devices, 
such as registers, I/O nodes in PLCs, memory locations in remote devices, or tags in other 
application stations.  
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A tag value represents the value of an external component or device, so that referencing 
the tag is equivalent to referencing the component or device itself. Updating a tag causes 
the external component or device to be updated as well. Thus, an application tag serves as 
a link between the system and the external device.  
  
After you select the Tags item from the menu, the Tag Definition dialog box will appear 
for you to enter the tag specifications.  

 
 

 
 

   
 
 
 
 

Cluster - Tag Definition 
The Tag definition dialog box is used to manipulate existing tags. The list displays tag 
names and descriptions for already defined application tags. 
  
Change- To change the selected tag's attribute only. you can not change the original tag's 
name. 
  
List- To export tag definition in to an ASCII file. 

 
 

 

 
   
 
 
 
 

Tag - Special Tokens 
In the Tag Definition dialog box, you can use special tokens to enable customized tag 
creation and identification upon object Instantiation. These tokens can be used in the Tag 
Name, Address, and Description fields to enable customized tag attribute generation.  
  
"[..]" brackets specify an optional parameter.  
  
The following tokens can be used:  
$ID([from-to])  
The from-to variable represents characters from the data supplied by the operator upon 
instantiation. The following methods can be used for the From-To parameter:  
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#-#  For example, if the string is ABCDE, and you specify 2-4 for From-To, the letters BCD 
will be displayed  
# The character located at the number you specify will be displayed. For example, if the 
string is ABCDE, and you specify 3 for From-To, the letter C will be displayed.  
+#- All the characters from the number you specify and on will be displayed. For example, 
if the string is ABCDE, and you specify 3- for From-To, the letters CDE will be displayed.  
-# All the characters up to the number you specify will be displayed. For example, if the 
string is ABCDE, and you specify -3 for From-To, the letters ABC will be displayed.  
 For example, If you specify the tag name ANA$ID(2-3) in the Tag Definition dialog box, if 
the operator instantiates the object for which this tag was defined and enters the instance 
name I02, a tag called ANA02 will be created for that object (the count for 2-3 in I02, is I=1, 
0=2, and 2=3).  
 For tag address, if, for example, you want the address constant to be 0000, in the Address 
field in the Tag Definition dialog box, you can choose 0000$ID(2-3). Then if, for example, 
the operator enters A10 in the instance name, the address of the tag generated upon 
Instantiation of the object would be 000010.  
 The same applies for description. For example, if you want the constant Valve to appear in 
the description followed by the valve number, you could use Valve$ID() (where the empty 
parentheses indicate that all the characters in the operator-supplied name should be used). 
If the operator enters 12 for the instance name while instantiating the object, the 
description of the generated tag will be Valve12.  
  
Different combinations of the $ID variable can be used to customize generated tag 
attributes upon object Instantiation, for example:  
$ASK("text"[,from-to])  
  
For text, specify the text that will appear in the prompt upon Instantiation. The from-to 
parameter is optional and can be used in the same way as described in $ID token. If you 
entered $ASK("Tag Name") in the Tag Name field of the Tag Specifications dialog box and 
$ASK("Enter Description") in the Description field, when you instantiate the object in the 
image another dialog box will appear and prompt you for the instance parameters.  

 
 

 

 
   
 
 
 
 

Tag Assignment     
 
Note: ApplicationSQL is not applicable on the Web.  
 
Tag Assignment 
In Application tag assignment operations, the value assigned to the tag can be any 
expression in ‘C’ format (as in the condition expression), or the result of a historical 
function on a tag. For example: 
syntax: 
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@tag-name = expression 
@tag-name = historical expression 
 
Expression 
You may assign one of the following expression types to a tag: 

o If @tag_name is a numerical tag, a numerical expression as described earlier in 
the condition section. 

o If @tag_name is a string tag, a string expression as described earlier in the SQL 
command section. 

o $SQLRC: This is a variable containing the SQL completion code. It is a predefined 
variable that indicates the status of the last SQL command executed. 

 
Historical Functions 
Much like the Application Report module, ApplicationSQL supports historical operations on 
tag values in historical files. The results of these operations can be assigned to tags. The 
ApplicationSQL historical functions are split into two groups. 
The functions in the first group perform a calculation on values within a specified time 
interval: 
WMIN returns the lowest value recorded during the specified interval.  
WMAX returns the highest value recorded during the specified interval. 
WAVERAGE returns the arithmetic average of all the values recorded during the interval. 
WWAVERAGE returns the average of recorded values of the tag, relative to the time the 
value occurred in the tag. 
WINTEGRAL returns the sum of recorded values, multiplied by the time the value occurred 
in the tag, until the next recording of the same tag. 
WSUM returns the sum of all the values recorded during the interval. 
 
The syntax for this group of commands is as follows: 
 FUNCTION(@tag-name, from-time, to-time)  
example: 
 WMIN(@ANA01, REL(1, 10:0:0), REL(1, 0:0:0) ); 
The functions in the second group perform calculations based on a value range given: 
WINTIME returns the total amount of time that tag values were in the range specified.  
WINCOUNT returns the number of times that tag values were recorded for a specified 
value range.  
 
The syntax for this group of commands is as follows: 
FUNCTION(@tag-name, from-time, to-time, low-value, high-value) 
example: 
@DURATION = WINTIME(@TEMP, REL(0, 10:0:0), REL(0, 0:0:0), 90, 100); 
Note: For more information on each ApplicationSQL historical command, please refer to 
the Reports chapter of the Application 5 User’s Guide. 
 
From/To Parameter 
For every applicationSQL historical function, you must specify the From/To parameter to 
define the time interval for which historical values will be analyzed. A time indicator can be 
absolute or relative. 
syntax: 
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indicator(date, time) 
•     §   The Indicator part is used for indicating whether the date-time is absolute or 
relative. Specify one of the following:  

ABS Absolute date & time: A full date and time with minutes & seconds must be 
specified. 
REL Relative date & time: The number of days back and number of hours back are 
specified. 
RELD Relative date & Absolute time: The number of days back and a specific time are 
specified. 
•     §   The full format for the date and time parameters is as follows:  

 date day-month-year 
 time hour:minutes:seconds  
 
examples: 
ABS(12-10-89, 12:30:00) 
 This specifies 12:30 on October 12, 1989 
RELD(10, 12:30:00) 
 This specifies 12:30 10 days ago.  
REL(10, 1:0:0) 
 This specifies 10 days and 1 hour ago.  

 
 

 
 

   

 
 

 
 
 

Tag Cluster Definition 
  
In the Define Cluster dialog box, click the Tags or Alarms button. A new tag/alarm with the 
modified original tag/alarm definition will be generated during cluster instantination in the 
image. The Tag Definition dialog box is displayed. Only tags/alarms that are associated 
with the cluster objects will appear in the tags/alarms list and only the Change button is 
enabled.  
1. 1. Click the Change button to open the Tag/Alarm Specification dialog box. 
1. 2. Complete the fields in this dialog box according to instructions in the Tags and Alarms 
chapters.  
Note: You can also access this dialog by double-clicking on a line in the list. 
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External devices normally generate operational values according to their internal format 
and in order to obtain the maximum accuracy. 

 
 

 

 
   
 
 
 
 

Tag Field Definition    
In this dialog box, specify the tag and its station for which the field will be defined.  
For Days and Hours, specify the days and hours of the tag records that you want to use 
for the calculations in the report.  
Select the Given at Run Time option to cause the values to be determined by the 
Application Language  
Last Value Returns the tag value at the end of the specified interval. This value will be the 
last value that was recorded in the interval you specified.  
Minimum Returns the lowest value recorded in the interval you specified.  
Maximum Returns the highest value recorded in the interval you specified.  
Average Returns the arithmetic average of all the values recorded during the interval you 
specified.  
Sum Returns the sum of all the values recorded during the interval you specified.  
Integral Returns the sum of the products of each recorded value, multiplied by the time 
until the next recording.  
Weighted Average Returns the average value of the tag, relative to the time the value 
occurred in the tag.  
Total Time for Range Returns the total amount of time that tag values were in the range 
specified.  
Count for Range Returns the number of times that tag values were recorded for a 
specified range.  
Time of Logging No. Returns the time of the nth recording after the beginning of the 
interval. (For example, if you want the hour at which the th recording occurred, type for this 
option.)  
Value of Logging No. Returns the value of the nth recording after the beginning of the 
interval. (For example, if you want the value of the 4th recording, type 4 for this option.)  
Repetition --- of Value --- (Time) Returns the time of a specific occurrence of a specific 
value (for example, this function can return the hour at which a value of 1.0 was recorded 
for the second time).  
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For Repetition, type 0 to obtain the last time the value you specified appeared for that 
period.  
For example, Repetition 0 of value 100 will return the last time the tag had the value 100. 
Current Value Returns the current value of the tag. This function will cause the Application 
to force-read the tag when generating the report.  

 
 

 
 

   
 
 
 
 

Tags Properties: Mandatory Fields 
 
 
When defining a tag, you can force the user to specify a value for zero or more of the fields 
that constitute the tag description. 
 
The list box allows you to specify which fields are mandatory. For example, clicking on the 
"Description" item, will not allow the user to add or modify a tag if a description has not 
been provided. 
 
Use the "Select All" or "Deselect All" to check or uncheck all of the items in the listbox. 
 
 
User Management: Properties 
 
Use this dialog box to specify rules about password management. 
 
Password valid for: You can specify for how many days a password will be valid. The 
limits are displayed. 
 
Password expiration reminder: Use this option to give a reminder to the user when their 
password is about to expire. 
 
System keeps up to: You can force the system to remember several old passwords so 
that the user cannot simply switch between known passwords. This enhances security of 
the password checking system. 
 
Check password format: You can force the user to enter a password with a given set of 
rules. If this option is checked, the user’s password must contain at least one letter, one 
digit and one special symbol from !,@,#,$,%,&,_,-. If this rule is not followed, the user will 
not be able to change the password next time it needs to be changed. 
 
Shift overlap time: If you have enabled shift management (see the user guide), you can 
specify an "overlap time". This means that  
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• users from the current shift can continue to login to the system for up to the 
specified amount of time after their shift is supposed to end 

• users from the next shift can login to the system for the specified amount of time 
before their shift is due to start. 

 
 

 
 

   

 
 

 
 
 

Modify the Tag List 
The Application enables you to add tags, modify current tag specifications and remove the 
tags that are displayed in the Trend Viewer. These changes are made online and are in 
effect until you refresh the browser. The Trend Viewer is then displayed according to its 
default settings. 
To add a tag: 
1. Select Edit Tags from the Setup menu of the Trend Viewer. The Tag definition dialog is 
displayed: 
2. Click Add. The Tag definition dialog is displayed in which you can add a tag. This tag is 
similar to the standard Add the new tag dialog used during Trend Viewer definition. 
3. Click OK to close the dialog and save your changes. 
  
To modify current tag specifications: 
1. Select Edit Tags from the Setup menu. The Tag definition dialog is displayed. 
2. Select the tag you want to modify and click Edit. The Tag definition dialog is displayed in 
which you can change the current tag specifications. 
3. Click OK to save your changes and close the dialog. 
  
To remove a tag: 
1. Select Edit Tags from the Setup menu. The Tag definition dialog is displayed. 
2. Select the tag you want to remove and click Remove. The tag is removed from the Tag 
list. 
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Retain Tag Options 
Periodic Saving: 
Activate a periodic saving for the Retain tags. The Retain values correspond to the latest 
value of each Retain tag and is dump into a file on shutdowns. They are used for setting 
the value at next start-up. It is possible to force a periodic saving of the velues for extra 
security. 
  
Note after you have determined the periodic saving, make sure to restart the Application. 
  
On communication error: 
If the last value of a Retain tag is not sure due to communication error, you can decide 
what to do with it.  
  
Note after you have determined it, make sure to restart the Application 

 
 

 
 

   

Tags 

Sublevel 

 
 
 
 
 

Tag Context Definition 
 
A tag context is used by images and charts to change tags dynamically. It is used in 
conjunction with a tag template ID, which is a normal tag ID with 2 special '#' delimiters. 
 
When a tag context is chosen for a window (image, chart), all tag template IDs are 
modified by replacing the delimited text with this context. 
 
Choose a name for the context. This name will be used as a title for this context. Choose a 
context string. This will be the part that will be switched in tag template ids. 
 
When such a context is defined, it opens a new tag tree in your tag list, listing all tags that 
contain your chosen context as a substring. 
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Defining Tags 
 
 
 
 
 

Tag - Special Tokens 
In the Tag Definition dialog box, you can use special tokens to enable customized tag 
creation and identification upon object Instantiation. These tokens can be used in the Tag 
Name, Address, and Description fields to enable customized tag attribute generation.  
  
"[..]" brackets specify an optional parameter.  
  
The following tokens can be used:  
$ID([from-to])  
The from-to variable represents characters from the data supplied by the operator upon 
instantiation. The following methods can be used for the From-To parameter:  
#-#  For example, if the string is ABCDE, and you specify 2-4 for From-To, the letters BCD 
will be displayed  
# The character located at the number you specify will be displayed. For example, if the 
string is ABCDE, and you specify 3 for From-To, the letter C will be displayed.  
+#- All the characters from the number you specify and on will be displayed. For example, 
if the string is ABCDE, and you specify 3- for From-To, the letters CDE will be displayed.  
-# All the characters up to the number you specify will be displayed. For example, if the 
string is ABCDE, and you specify -3 for From-To, the letters ABC will be displayed.  
 For example, If you specify the tag name ANA$ID(2-3) in the Tag Definition dialog box, if 
the operator instantiates the object for which this tag was defined and enters the instance 
name I02, a tag called ANA02 will be created for that object (the count for 2-3 in I02, is I=1, 
0=2, and 2=3).  
 For tag address, if, for example, you want the address constant to be 0000, in the Address 
field in the Tag Definition dialog box, you can choose 0000$ID(2-3). Then if, for example, 
the operator enters A10 in the instance name, the address of the tag generated upon 
Instantiation of the object would be 000010.  
 The same applies for description. For example, if you want the constant Valve to appear in 
the description followed by the valve number, you could use Valve$ID() (where the empty 
parentheses indicate that all the characters in the operator-supplied name should be used). 
If the operator enters 12 for the instance name while instantiating the object, the 
description of the generated tag will be Valve12.  
  
Different combinations of the $ID variable can be used to customize generated tag 
attributes upon object Instantiation, for example:  
$ASK("text"[,from-to])  
  
For text, specify the text that will appear in the prompt upon Instantiation. The from-to 
parameter is optional and can be used in the same way as described in $ID token. If you 
entered $ASK("Tag Name") in the Tag Name field of the Tag Specifications dialog box and 
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$ASK("Enter Description") in the Description field, when you instantiate the object in the 
image another dialog box will appear and prompt you for the instance parameters.  
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   About this chapter: 
This chapter describes the Tag Filter module. 
Tag Filter Module Overview on the following page, discusses the basic Tag Filter options. 
Accessing the Tag Filter discusses how to access this module. 
Tag Filter Properties discusses the Tag Filter General and Network tabs. 
Tag Filter in the Image Module takes you through the necessary steps required to open 
this list in the Image.  
Running the Tag Lock on the Web takes you through the necessary steps required to 
run the Tag Lock using the Html module. 
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The Tag Filter module is used to filter, view and manage a list of tags and their status 
(locked/unlocked) in the application. This is useful for the development and maintenance of 
an application.  
The Tag Filters List is stored in the application's TFM.XML filter that is created in the .\docs 
directory (or another appropriate directory of the application). 
When accessed through Java applets the Tag Filters List can be defined/modified/viewed 
in the Image module during runtime. Up to 10 tag filters can be selected simultaneously. 
In this version upto 1000 tags can be defined. 
Tags can be sorted according to: 

o     Source 
o     PLC - tags associated with external devices and mapped on the 

external device variables. 
o     Dummy - tags representing internal variables used for a variety of 

calculations, control and other application related needs. 
o     Compound - tags which are linear calculations based on values of 

other tags. 
o     System - tags that are predefined and built to provide system status 

information 
o     Type 

o     Analog - tags that have numeric values represented in various formats. 
o     Digital - discrete logic tags that have a boolean value of True (1) or 

False (0). 
o     String - tags that are defined to receive alphanumeric strings. 
o     Locked - which filters only locked tags. A locked tag can be either 

analog, digital or string. 
Note:     There is the option to select all sources and all types or only one or more source 
or type. 
 

 
 

 
 

   

 
 
 

 
 
Tag Filters 
 
The Tag Filter is used to view and manage a list of locked tags in the control application. 
This module contains a list of tag filters that are stored in the application in the TFM.XML 
file that is created in DOCs or another appropriate directory of the application and can be 
accessed through Java applets. Up to 10 tag filters can be selected simultaneously. 
The Tags Filters list can be viewed in the Image module during runtime. 
This dialog box has the following fields: 
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• Name: Displays the Tag Filter name as defined in the Tag Filter Properties dialog 
box  

• Description: Displays a description of the Tag Filter as defined in the Tag Filter 
Properties Filters dialog box  

• Add: Click this button or, right click and select Add to open the Tag Filter 
Properties dialog box. Complete the relevant fields and click OK to save your 
definitions  

• Change: Select a tag filter and then either click this button or, right click and select 
Change to open the Tag Filter Properties dialog box. Update the selected tag and 
click OK to save your modifications  

• Delete: Select a tag filter and then either click this button or, right click and select 
Delete. The selected tag will be removed from the list  

For further information see Tag Filter Properties and Select Tag Filters. 
 
 

 
 

   

Accessing the Tag F

 
 

ilter 

 

Accessing the Tag Filter 
o To access the Tag Filter: 

ntrol Panel click the 

 
 

In the Application Studio Co Tag Filters icon to open the Tag 
Filte d
Or, 

rs to

rs ialog box. 

Select Design in the menu bar and then Tag Filte  open the Tag Filters dialog box.  
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The Tag Filters dialog box has the following columns and fields: 

Name This column holds the logical name of the Tag Filter as defined in the 
Tag Filter Properties dialog box. 

Description  This column holds a description of the type of tag the filter should 
display as defined in the Tag Filter Properties dialog box. 

Add This button when clicked opens the Tag Filter Properties dialog box 
where new tag filters can be created.    

Modify    
Select a Tag Filter and then click the modify button to open the Tag 
Filter Properties dialog box and modify either the General properties or 
Network properties of the Tag Filter. 

Delete Select a Tag Filter and then click this button to delete it from the list. 

Note:     The Add, Modify and Delete options can also be accessed by right clicking in the 
Tag Filters dialog box. 
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Select Tag Filters  
 
In this dialog box tag filters can be created, modified and added/removed to/from the 
Selected Filters list. 
This dialog box has the following fields: 

• New: Click this button to open the Tag Filter Properties dialog box where new Tag 
Filters can be created. 

• Modify: Select a filter from the All Defined Filters list and then click this button to 
open the Tag Filter Properties dialog box where modifications can be made. 

• Delete: Select a filter from the All Defined Filters list and then click this button. A 
message box will open, click Yes to delete this filter or No not to. 

• Add: Select a filter from the All Defined Filters list and then click this button to add 
it to the Selected Filters list. 

• Remove: Select a filter from the Selected Filters list and then click this button to 
remove it from the list. 

For further information see Tag Filter Properties and Tag Filters. 
 
 

 
 

   

 
 

 
 
 

Tag Filter Properties  
This dialog box has two tabs: 

o     General page - where the general criteria of the Tag Filter are defined. 
o     Network page - where a list of all the available application stations on the 

network are held and can be selected and defined for the Tag Filter. 
Note:     For a tag to appear in the Tag Filters list it must comply with all the requirements 
in the Tag Filter Properties dialog box fields. 
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Tag Filter Properties  

his dialog box is used to define the Tag Filter Properties that can be viewed in the Tag 

 module, tags that are out of the defined 

x has two tabs: 
g Filter are held. 

ed Stations list. 
Gen a

ing fields: 
name for the Tag Filter  

r 
 tag filter applies (*? can be 

• dress: Type in the address of the tag to which this tag filter applies (*? can 

• : Complete the boundaries (1-32) in the From and To fields  

 the external 

o presenting internal variables used for a variety of 

o  values of other 

o m - These tags are predefined and built to provide system status 

• Type: T he following options. Check the relevant one: 
ious formats 

 

o g - Tags that are defined to receive alphanumeric strings  
• Loc d  

Net
d to define the Filter Tag network station. The stations appearing in the Filter 

tion. 

 

 
 

 
T
Filters list in the Image module during runtime. 
When the Filter Tags list is opened in the Image
boundaries will not be displayed. 
The Tag Filter Properties dialog bo

• General where the general details of the Ta
• Network where stations are selected and added to the Select
er l Tab 

This tab has the follow
• Name: Type in a unique 
• Description: Type in a description of the Tag Filte
• Tag Name: Type in the name of the tag to which this

used) 
Tag Ad
be used) 
Driver No

• Source: This field has the following options. Check the relevant one 
o PLC - Tags associated with external devices and mapped on

device variables  
Dummy - Tags re
calculations, control and other application related needs 
Compound - These tags are linear calculations based on
tags  
Syste
information  
his field has t

o Analog - Tags that have numeric values represented in var
o Digital - Discrete logic tags that have Boolean values of True (1) or False

(0)  
Strin

ke  Tag: When this field is checked only locked tags will be filtered 
work Tab 

This tab is use
Tag Stations list are active in the Network menu. 

1. In the List All Stations field type in the name of the sta
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elected Stations list. 
n. 

For

2. Click the forward arrow icon to add the new station to the S
3. To remove a station from the list select the station and click the back arrow butto
4. Click OK to save your definitions.  

 further information see Tag Filters and Select Tag Filters. 
 
 

 
 

   

 

 

Tag Filter Properties - General Tab 
l properties of the Tag Filter. 

 

 
 

This tab when filled defines the genera

 
1.    In the Name field type in the logical name of the user. 
2.    In the Description field type in the type of tag that the Tag Filter should display. 

 
dialog box. 
3.    In the Tag Name field type in the name of the tag as defined in the Tag Definition
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s. 
ed during tag definition in the Tag Definition dialog box see Chapter 9, Tags 

mmunication source type.  

s fields to display tags beginning with A. 
ers of the alphabet can be used in the same way. 

 
 

4.    The Tag Address field refers to PLC tags that are filtered according to their addres
(This is defin
page ). 
5.    The Driver No. From and To fields refer to the driver's serial number which is defined 
in the co
6.    In the Source field check the relevant source. In this field any number of source types 
can be selected. See Source. 
7.    In the Type field check the relevant tag type. In this field any number of tag types can 
be selected. See Type. 
8.    Click OK to confirm and save your definitions. 
Note:     
A* can be written in the Tag Name and Tag Addres
Other lett
A? can be written in the Tag Name Address to display tags whose name begins with an A 
and one other character for example AB, A1. Other letters of the alphabet can be used in 
the same way. 
A?B can be written to display all tags whose name is made up of three characters 
beginning with A and ending with B with any character in the middle. Other letters of the 
alphabet can be used in the same way. 
 

 
 

   

 
 

 
 

Tag Filter Properties - Network Tab 
This tab lists all the available application stations on the network. 
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The Network tab has two columns: 

List all Stations This column lists all the application's network stations. 

Selected 
Stations This column lists all the selected network stations.  

1.   To add a Network station to the Selected Stations list, in the List of all Stations select a 
station and then click the  button. 
2.   To remove a network station from the Selected Stations list, in the Selected Station list 
select the relevant station and then click the   button. 
  

 
 

 
 

   

Tag Filter in the Image 
Module 

401 



Chapter 10 Tag Filter Module 

 
 
 
 
 

Tag Filter in the Image Module 
The Tag Filters List can be defined/modified/viewed in the Image module during runtime. 

o To access the Tag Filter module from an Image object, do the following: 
In the All Containers side of the Application Studio click Images (Chapter 20, Introduction 
to the Image Module) and then select an image from the List of Images on the right side 
of the Application Studio. An image will open on your computer screen. 
Or, 
In the Quick Access bar click the Load Image icon and select the relevant image from the 
list in the Open dialog box. 
1.    When the Image module is open and when in Edit mode draw an object using one of 
the drawing tools. 
2.    Select the object and then right click and select Trigger Definition. The Trigger Object 
Definition dialog box will open. 

 
3.    Click the Fast Actions button to open the List of Available Fast Actions dialog box.  
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4.    Scroll down the list and double click on LockTagValues. The Tag Lock Option dialog 
box opens. There are two options: 

 
o     From the Current Image - which when clicked opens the Tag Lock Trigger 

opens displaying a list of tags and their states from the current image.  
o     From the Filter List - when this option is defined and the Select Filters button 

clicked the Select Tag Filters dialog box opens.  
 

 
 

 
 

   

 
 

 
 
 

Tag Value Lock 
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The Tag Value Lock window enables you to modify the application's tag lock definitions in 
the Image module at runtime. When this trigger next opens it will be in the mode defined 
during Trigger creation.  

o To access the Tag Value Lock in an Image object, do the following: 
In the All Containers side of the Application Studio click Images and then select an image 
from the List of Images on the right side of the Application Studio. An image will open on 
your computer screen. 
Or, 
In the Quick Access bar click the Load Image icon and select the relevant image from the 
list in the Open dialog box. 
In the Image module during runtime (trigger mode) using the trigger hand click on the 
object to open the Tag Value Lock dialog box where a list of all locked/unlocked tags are 
listed. 

 
The Tag Value Lock trigger has the following options: 

Lock/Unlock  Where filtered tags can be locked/unlocked without exiting the dialog 
box. Each unlocked tag receives a continuous current value update. 

Print    A Which prints to reports printer defined in the application. 

From 
Image/From 
Filters 

This toggle button moves between the From Image and From Filter 
List modes. 

Select Filters 
Which when clicked opens the Select Tag Filters dialog box where 
new Tag Filters can be defined, modified and added to the Selected 
Filters List.  

AThis feature is enabled on Web only with the SUN JAVA plug-in. 
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Modifying Tag Lock Values  
The lock tag definition dialog box enables the filter tags to be both locked/unlocked. This 
dialog box also enables tag value modification READ/WRITE. 

o To access the Lock Tag Definition in an Image object, do the following: 
1.    Double click a tag in the Tag Values Lock list to open the Lock Tag Definitions dialog 
box.  

 
2.    The Value Definition fields are defined in the Tag Definition dialog box during tag 
creation. 
3.    To lock a tag check the Lock checkbox. 
4.    In the Tag Value in the Locked State field type in the new value of the tag when in 
locked state. This value will apply only when the tag is locked. 
5.    If the tag is to always remain locked check the Never Expire checkbox to enable this 
option. When this option is selected the Tag Value will be Locked Until fields are 
unavailable. 
6.    If the tag is to be locked for a specific period in the Tag Value will be Locked Until 
fields scroll and define the To and From times. 
7.    To enable this tag for READ or WRITE click the relevant button. 
8.    To add a new value to a tag, do the following. In the Value Modification Value field, 
type in the new tag value. To write this value to the tag, click the WRITE button. The 
current value field will be updated to the new number. 
9.    To read a current value from a tag, click the READ button. The current tag value will 
appear in the Current Value field. 
Note:     For more details see Chapter 9, Tags and Chapter 20, Introduction to the 
Image Module, Chapter 21, Image Editor and Chapter 22, Image Animation. 
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Note:    You will only be able to modify tags to which you are allowed access. 
 

 
 

 
 

   

 
 

 
 
 

Running the Tag Lock on the Web 
To run the defined trigger Tag Lock on the web follow the instructions on  page to access 
the tag lock from an Image object.  

o    To access the Lock Tag Definition dialog box in an Image object over the Web, 
do the following: 

1.    In the All Containers side of the Application Studio click Html to open the List of Html 
Files. 
2.    Double click the relevant image to open the Tag Locks dialog box over the web. 
 

 
 
This dialog box has the following buttons:  

Lock Settings The Lock Setting button is activated by double clicking the relevant tag. 
When clicked this button opens the Lock Tag Definitions dialog box.  

Lock/Unlock    The Lock button is activated by clicking the relevant tag. When clicked 
this button will lock the selected tag. 

Lock All    This button locks all the tags in the Lock Tags window. 
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  . 

Image/From 
 

om Filter List 
modes. 

ilters cked opens the Select Tag Filters dialog box where new Tag 
Filters can be defined, modified and added to the Selected Filters List. 

ates
The Tag Filters List can be 

 
 

Unlock All  This button unlocks all the tags in the Lock Tags window

From 

Filters 

Select F

This toggle button moves between the From Image and Fr

When cli

Note:     + indic  that the tag is locked. - indicates that the tag is unlocked. 
modified/viewed on the Web during runtime. However, any Tag 

Filter changes will not be saved to the application. 
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   About this chapter: 
This chapter describes the Tag Mapper module. 
Tag Mapper - Overview discusses the basic options of this module. 
Accessing the Tag Mapper discusses how to access this module and describes the 
dialog box options. 
Creating a Tag Mapper Table instructs you on how to create a Tag Mapper Table. 
Customizing Tag Mapper Dialog Boxes instructs you how to customize this features 
dialog boxes.  
Tag Mapper Tags in the Image Module instructs you how to use this module in the 
Image.  
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Tag Mapper - Overview 

The Tag Mapper is a data file of tags and tag values that can be used to considerably 
reduce workload during application creation. Tag values of tags held in a Tag Mapper table 
are mapped by the Tag Mapper into a list of other tags. See Creating a Tag Mapper 
Table. 
There are two types of Tag Mapper tags: 
Source: These are tags whose values are directed to target tags. More than one source 
tag can be pointed to the same target tag. 
Target: This tag type receives the values of the source tag. All target tags must have the 
WIZTGM_ prefix. 
To define the source tags that update a specific target tag first create the tables used by 
the Tag Mapper. Each table has a unique Id (Index) that is later used in the image as the 
index value. Each image can use one table only at a specific time. The table that is used is 
defined by the index value. A single image can be used to display different source tags 
values in the same target tags (depending on the index value entered by the user).  
An unlimited number of tags can be mapped. The Tag Mapper is bidirectional. All Tag 
Mapper dialog boxes are resizeable.  
Dialog boxes can be accessed by either clicking the relevant button, from the menu bar 
options, or by right clicking and selecting an option. 
Tag Mapper Tables can be imported and exported to/from other applications. 
Note:     Only one WIZTGM_INDEX tag can be used in an image. 
 

 
 

 
 

  

 
 

 
 
 

Tag Mapper Overview 

The Tag Mapper is a data file of tags and tag values that can be used to considerably 
reduce workload during application creation. Tag values of tags held in a Tag Mapper table 
are mapped by the Tag Mapper into a list of other tags.  
There are two types of Tag Mapper tags: 
Source: These are tags whose values are directed to target tags. More than one source 
tag can be pointed to the same target tag. 
Target: This tag type receives the values of the source tag. More than one source tag can 
be pointed to the same target tag. 
A single image can be used to display different source tags values in the same target tags 
(depending on the index value entered by the user).  
To define the source tags that update a specific target tag the user must first create the 
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tables used by the Tag Mapper. Each table has a unique Id (Index) that is later used in the 
image as the index value.  
Each image can use one table only at a specific time. The table that is used is defined by 
the index value.  
An unlimited number of tags can be mapped. The Tag Mapper is bidirectional.  
Note: All Tag Mapper dialog boxes are resizeable. Dialog boxes can be accessed by either 
clicking the relevant button or by right clicking and selecting an option. 
Tag Mapper Tags in the Image Module 

 
 

 
 

  

Accessing the Tag 

Mapper 

 
 
 
 
 

Accessing the Tag Mapper  
o To access the Tag Mapper do the following: 

Double click the  Tag Mapper icon in the Application Studio Control Panel to open 
the Tag Mapper dialog box. 
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This dialog box has the following Menu bar options: 

Field 

Export: This option is used to export either: 
• All tables 
• Selected tables 
to the open or other applications. This option can also be accessed by right 
clicking in the dialog box and selecting Export from the dropdown list. 

 
Import: This option is used to import Tag Mapper Tables from the open or 
other applications. This option can also be accessed by right clicking in the 
dialog box and selecting Import from the dropdown list. 

 Exit: This option is used to exit the Tag Mapper. 

Table 

 

New Table: This option is used to open the Set Tag Mapper Table dialog 
d by right clicking in the dialog box and 
wn list. 

r Table. This option 
ialog box and selecting Edit 

pdown list. 
his option opens the Tag Mapper Tables Tag Summary 

 

Delete: This option is used to delete a selected Tag Mapper Table. A Tag 
Mapper Table can also be deleted using the Delete button. 

s 

This option is used to open the Help project for this module. 

his dialog box 

 

Table 
Description    

New Table    
nder the last entry in the Tag Mapper. 

 box. This option can also be accesse
selecting New Table from the dropdo

 

 

Edit: This option is used to edit a selected Tag Mappe
can also be accessed by right clicking in the d
from the dro
Tags Summary: T
dialog box. This dialog box can also be opened by clicking the Tag Summary
button. 

Clients: This option opens the Online Clients dialog box where remote user
are listed. This dialog box can also be opened by clicking the Online Clients 
button. 

Help 

T has the following fields: 

ID This is the Id of the Tag Mapper table where the tags are held. This 
number is generated by the system and cannot be modified. 

Table Name This is the name of the Tag Mapper table. 

This is a short description of the Tag Mapper table. 

This button when clicked opens the Set Tag Mapper Table where a 
new table can be created. A record of the new table will appear 
u
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to open the 
Set Tag Mapper Table where modifications can be made. This dialog 

ccessed through the menu bar’s Table Edit option, 
or by right clicking and selecting Edit. 

Delete    

ve the 
table from the Tag Mapper. A Tag Mapper Table can also be deleted 

t clicking and 

y 
le Tags 

Summary dialog box. This dialog box can also be opened by 
selecting Tag Summary from the menu bar’s Table options. 

Online Clients    Tag Mapper can be seen. 
This dialog box can also be opened by selecting Online Clients in the 

 
 

 
 

Select a table record line and then click on this button 

Edit    box can also be a

Select a table record line and then click on this button to remo

through the menu bar’s Table Delete option, or by righ
selecting Delete. 

Tags Summar
This button when clicked opens the Tag Mapper Tab

This button when clicked opens the Online Clients viewer where a 
list of all the clients that are clients of the 

menu bar’s Client options. 

 
 

  

 
 
 

ag Mapper 
his dialog box has the following menu bar options: 

Field Export: This option is used to export either: All tables or Selected tables 
to the open or other applications.  
Import: This option is used to import Tag Mapper Tables from the open or other 
applications.  
Exit: This option is used to exit the Tag Mapper

Table New Table: This option is used to open the Set Tag Mapper Table dialog box.  
Edit: This option is used to edit a selected Tag Mapper Table.  
Tags Summary: This option opens the Tag Mapper Tables Tag Summary dialog 
box.  
Delete: This option is used to delete a selected Tag Mapper Table.  

Clients: This option opens the Online Clients dialog box where remote users are listed.  

Help This option is used to open the Help project for this module. 

 
 

T
T

. 
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This dialog box has the following field options: 
ID This is the Id of the Tag Mapper table where the tags are held. This 

number is generated by the system and cannot be modified. 

er table. 

n
New Table 

an be created. A record of the new table will appear under the last 

g 

Delete  

Tags Summ Summary 

 Clie wer where a list of 
e seen. 

oxes Tag Mapper Tags in the Image 

 
 

Table Name This is the name of the Tag Mapp

Table 
Descriptio  

This is a short description of the Tag Mapper table. 

 This button when clicked opens the Set Tag Mapper Table where a new 
table c
entry in the Tag Mapper. 

Edit  Select a table record line and then click on this button to open the Set Ta
Mapper Table where modifications can be made. 

Select a table record line and then click on this button to remove the table 
from the Tag Mapper. 

ary  This button when clicked opens the Tag Mapper Table Tags 
dialog box. 

Online nts  This button when clicked opens the Online Clients vie
all the clients that are clients of the Tag Mapper can b

Overview Customizing Tag Mapper Dialog B
Module 
 

 

 
 
 

a
o To create a

and select New Table  
Or, 
From the menu bar Table option select New Table to open the Set Tag Mapper Table 
dialog box. 

 
  

 
 

Creating a Tag M pper Table  
 new table do the following: 

1.    In the Tag Mapper dialog box click the New Table button  
r, O

Right click 
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This dialog box has the following fields: 

Table Name This is the name of the Tag Mapper table. 

Table Description    This is a short description of the Tag Mapper table. 

Table Id       This serial number is automatically generated by the system and 
cannot be modified. 

Bidirectional Update  When checked enables automatic bidirectional source and target 
tag update. 

ber of the table where the tags are held. 

Source Tag       These are tags whose values are directed to target tags. More 
than one source tag can be pointed to the same target tag. 

Factor    This is the number by which the target tag is multiplied. The 

Target Tag This tag type receives the values of the source tag. More than 

 Record  Click this button to open the Tag Mapper Table Record dialog 

d. 

Id    This is the num

default is 1. 

one source tag can be pointed to the same target tag. 

New box where a new record line can be created. 

Edit Select a record line and then click this button to open the Tag 
Mapper Table Record dialog box where this line can be edite
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s 
 

m 

ype in the Table Nam
3.    Check the Bidirection
4.    Click the relevant butto

OK to confirm. 
o To create a table record do the following: 

Tag Mappe

Right click and select New Record to open the Tag Mapper Record Table dialog box. 

Delete    Select a record line and then click this button to remove it from
the list. 

Multi Record
This button when clicked opens the Multi Records Setup dialog
box where may records can be defined and added the table at 
one time.    

Import This button when clicked opens the Import Table where files fro
external files can be imported. 

2.    T e and Table Description. 
al Update checkbox to enable this option. 

n and complete the dialog box fields. 
5.    Click 

1.    In the Set 
Or,  

r dialog box click the New Record button 

 
This dialog box is used to define/select source and target tags and to
which the target tag is multiplied. It has the following fields: 

 define the factor by 

Local 
Station    This field is automatically filled by the application when applicable. 

Source Tag 
Which has the following sub fields: 
Station where the station is selected 
Tag where the specific source tag is selected 
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Tag where the specific target tag is selected 

 tag is multiplied. The default is 1. 

2.    Complete the dialog box fields and then click OK to confirm and to return to the Set 
Tag Mapper Table

odify
In the Tag Mapper  then click the Edit button  
Or  

 and sel
Or 

r Table 
In th relevant table entry and then click the Delete 

 
 

Target Tag
Which has the following sub fields: 
Station where the station is selected 

Factor    This is the number by which the target

 dialog box. 
o To M  a Tag Mapper Table 

 dialog box select the relevant table entry and

Right click ect Edit  

From the menu bar Table option select Edit to open the Set Tag Mapper Table. 
o To Delete a Tag Mappe
e Tag Mapper dialog box select the 

button  
Or, 
Right click and select Delete
Or, 
From the menu bar Table option select Delete. 

o To define multi records  
1.    In the Set Tag Mapper Table dialog box click the Multi Records button.  

 
This dialog box is used to define/select multiple source and target tags. Each new record 
added will have a factor of the value created in the table.  
In this dialog box the user can select an unlimited number of source tags which are 
automatically inserted by the application. 
This dialog box has the following fields: 
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by the application. An unlimited 

Create Target Tag 
using XX as prefix 

type in the target tag prefix to which an 
index will be added starting at the value defined in the Start at 

Start at Index    This is the first consecutive Index number.  

Factor efinitions 

Tag  

r s multiplied. 

e tag can be pointed to the same target tag. 

he main Source T
3.    Check the Create Target Tags Using checkbox and type in the target tag prefix. 

tarting at Ind
5.    Click the Create Reco

able dialog box. 

 Import 

Source Tags    number of source tags can be selected. 
This list is automatically inserted 

Check this option and then 

Index field. 

Create Records as When this button is filled the Multi Records table is filled with the 
source tags d

ID    This is the Id of the selected source tag. 

Source This is a list of the source tags selected from the main source tags
list.  

Facto This is the factor by which the target tag i

Target Tag This tag type receives the values of the source tag. More than one 
sourc

2.    In t ags fields select the relevant tags.  

4.    In the S ex and As Factor fields type in the relevant numbers. 
rds button. The Multi Records table is filled. 

6.    Click OK to confirm and to return to the Set Tag Mapper T
o To import Tag Mapper Table files from external applications 

1.    In the Set Tag Mapper Table dialog box click the Import button to open the
Table dialog box. 
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This dialog box has the following fields: 

Import from Existing 
Tables 

Import from File 

 

ID: This is the ID of the imported table 
Table Name: This is the name of the table required 
ID: This is the ID of the imported file 
Table Name: This is the name of the imported table 

Import Buttons When these button are clicked the respective table/file is 
imported. 

ID ID of the imported table/file record. 

Source Tag This is a list of the source tags  

Factor This is the factor by which the target tag is multiplied 

Target Tag This tag type receives the values of the source tag. More than 
one source tag can be pointed to the same target tag. 

o To view the Tag Mapper Tables Tags Summary dialog box 
1.    In the Tag Mapper Table dialog box click the Tags Summary button or from the menu 
bar Table option select Tags Summary.  
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This dialog box displays a list of all the tags that are used by the Tag Mapper. It has the 
following fields: 

Filter table    
The displayed information in this dialog box can be filtered 
according to a specific table or to display all the tables in 
the Tag Mapper 

Tag Name This is the name of the tag defined in the Tag Mapper 
table.    

Tag type       This is the type of tag which can be either source or target. 

Table    This is the name of the table. 

Table 
Properties    

When a table record is selected and this button clicked the 
Set Tag Mapper Table dialog box opens displaying this 
entry. Modifications can be made. 

o To view the Online Clients list: 
In the Tag Mapper dialog box click the Online Clients button 
Or, 
From the menu bar Clients option select Online Clients.  
The Online Clients viewer will open listing all the stations that are clients of the Tag 
Mapper. 
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o To export all Tag Mapper Tables: 

1.    In the Tag Mapper dialog box either right click and select Export All 
Or, 
From the menu bar File options select Export All. The Save As dialog box opens. 

  
2.    Select the relevant file and click the Save button. 

o To export selected Tag Mapper Tables: 
1.    In the Tag Mapper dialog box select the relevant Tag Mapper Table from the list and 
then either right click and select Export Selected 
Or, 
From the menu bar File options select Export Selected. The Save As dialog box opens. 
2.    Select the relevant file and click the Save button. 

o To import Tag Mapper Tables: 
1.    In the Tag Mapper dialog box either right click and select Import 
Or, 
From the menu bar File options select Import. The Open dialog box opens. 
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2.    Select the relevant file and click the Open button. The Import Tag Tables From dialog 
box opens. 

  
This dialog box has the following options: 

o     Replace all tables 
o     Replace only existing tables 
o     Add no existing tables 

3.    Check the relevant option and click OK to confirm. 
 

 
 

 
 

  

 
 
 

 
 

Set Tag Mapper Table 
This dialog box has the following fields: 
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Table Name This is the name of the Tag Mapper table. 

Table Description This is a short description of the Tag Mapper table. 

Table Id This serial number is automatically generated by the system and 
cannot be modified. 

Bidirectional Update When checked enables automatic bidirectional source and target 
tag update. 

Id This is the number of the table where the tags are held. 

Source Tag These are tags whose values are directed to target tags. More than 
one source tag can be pointed to the same target tag. 

Factor This is the number by which the target tag is multiplied. The default 
is 1. 

Target Tag This tag type receives the values of the source tag. More than one 
source tag can be pointed to the same target tag. 

Table Record  Click this button to open the Tag Mapper Table Record dialog box 
where a new record line can be created. 

Edit Select a record line and then click this button to open the Tag 
Mapper Table Record dialog box where this line can be edited. 

Delete Select a record line and then click this button to remove it from the 
list. 

Multi Records  This button when clicked opens the Multi Records Setup dialog box 
where may records can be defined and added the table at one 
time. 

Import  This option is used to import Tag Mapper Tables from the open or 
other applications. This option can also be accessed by right 
clicking in the dialog box and selecting Import from the dropdown 
list. 

Overview Tag Mapper Multi Records Tag Summary Record Tags Creating a Tag 
Mapper Table 

 
 

 
 

  

 
 
 

 
 

Creating a Table Record 
In the Set Tag Mapper dialog box click the New Record button or, right click and select 
New Record to open the Tag Mapper Record Table dialog box. This dialog box is used to 
define/select source and target tags and to define the factor by which the target tag is 
multiplied.  
Overview 
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Set Tag Mapper Table Record 
This dialog box is used to define/select source and target tags and to define the factor by 
which the target tag is multiplied. It has the following fields: 
Local Station This field is automatically filled by the application when applicable. 

Source Tag Which has the following sub fields: 
Station where the station is selected 
Tag where the specific source tag is selected 

Target Tag Which has the following sub fields: 
Station where the station is selected 
Tag where the specific target tag is selected 

Factor  This is the number by which the target tag is multiplied. The default is 1.  
Complete the dialog box fields and then click OK to confirm and to return to the Set Tag 
Mapper Table dialog box. 
Tag Mapper Set Tag Mapper Table Multi Records Tag Summary Overview 

 
 

 
 

  

 
 

 
 
 

Editing a Tag Mapper Table 
In the Tag Mapper dialog box select the relevant table entry and then click the Edit button 
or right click and select Edit to open the Set Tag Mapper Table where you can make the 
relevant modifications. 
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Deleting a Tag Mapper Table 
In the Tag Mapper dialog box select the relevant table entry and then click the Delete 
button or right click and select Delete. 
Overview 

 
 

 
 

  

 
 

 
 
 

Creating Multiple Records 
1. In the main Source Tags fields select the relevant tags.  
2. Check the Create Target Tags Using checkbox and type in the target tag prefix. 
3. In the Starting at Index and As Factor fields type in the relevant numbers. 
4. Click the Create Records button. The Multi Records table is filled. 
5. Click OK to confirm and to return to the Set Tag Mapper Table dialog box. 

Overview 
 
 

 
 

  

 
 
 

 
 

Multi Records 
This dialog box is used to define/select multiple source and target tags. Each new record 
added will have a factor of the value created in the table.  
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In this dialog box the user can select an unlimited number of source tags which are 
automatically inserted by the application. 
This dialog box has the following fields: 
Source Tags This list is automatically inserted by the application. An unlimited 

number of source tags can be selected. 

Create Target Tag 
using XX as prefix 

Check this option and then type in the target tag prefix to which an 
index will be added starting at the value defined in the Start at 
Index field 

Start at Index  This is the first consequtive Index number.  

Create Records as 
factor 

When this button is filled the Multi Records table is filled with the 
source tags definitions 

ID This is the Id of the selected source tag 

Source Tag This is a list of the source tags selected from the main source tags 
list.  

Factor This is the factor by which the target tag is multiplied  

Target Tag This tag type receives the values of the source tag. More than one 
source tag can be pointed to the same target tag. 

Creating Multiple Records Overview Tag Mapper Set Tag Mapper Table Tag 
Summary Record Tags 

 
 

 
 

  

 
 

 
 
 

Import 
This dialog box has the following fields: 
Import from 
Existing Tables 

ID: This is the ID of the imported table  
Table Name: This is the name of the table required 

Import from file: ID: This is the ID of the imported file 
Table Name: This is the name of the imported table 

Import Buttons:  When these buttons are clicked the respective 
table/file is imported. 

ID ID of the imported table/file record 

Source Tag This is a list of the source tags . 

Factor This is the factor by which the target tag is multiplied 

Target Tag This tag receives the values of the source tag. More 
than one source tag can be pointed to the same target 
tag  
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Tag Summary 
This dialog box displays a list of all the tags that are used by the Tag Mapper. It has the 
following fields: 
Filter table The displayed information in this dialog box can be filtered according to a 

specific table or to display all the tables in the Tag Mapper 

Tag Name This is the name of the tag defined in the Tag Mapper table. 

Tag type This is the type of tag which can be either source or target. 

Table  This is the name of the table. 

Table 
Properties 

When a table record is selected and this button clicked the Set Tag 
Mapper Table dialog box opens displaying this entry. Modifications can be 
made. 

Overview Set Tag Mapper Table Multi Records Creating a Table Record 
 
 

 
 

  

 
 
 

 
 

Online List 
In the Tag Mapper dialog box click the Online button. The Online Clients viewer will open 
listing all the stations that are clients of the Tag Mapper. 
Overview 
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Customizing Tag Mapper Dialog Boxes 
Both the column width and the order that information is displayed in a column can be 
modified. 

o Modifying column width: 
1.   To modify the column width, place your curser over the column line. A cross will be 
displayed. 
2.   Move the column line to its new position. 

o Modifying table entry hierarchy: 
1.   Click the column title bar to display the   
2.   Click a table line and the click the arrow to move up. 

 
 

 

 
  
 
 
 
 

Tag Mapper Tags in the Image Module 

Each image that is used with the Tag Mapper must have the WIZTGM_INDEX tag that is 
automatically created by the program.  
Only values that are greater than 1 can be used when they have a table that matches this 
index value.  
Other tags that can be used are tags with the WIZTGM_ prefix as defined in the Tag 
Mapper Tables. These tags will display the relevant source tags values. 
Changing the WIZTGM_INDEX tag value in an image will cause the image to display the 
relevant source tags as defined in the Tag Mapper.  
All tags holding the WIZTGM_ prefix including the WIZTGM_INDEX tag have different 
values in different images. This means that even if the tag name is the same the values in 
each image will differ. The tags will appear in the application's tags list, however, they 
cannot be used as regular application tags. For example when a tag value is changed in 
the Single Tag dialog box, the change will not affect an image that has this tag attached. 
These tags values can only be changed from within the image. 
When an image is opened for the first time, the value assigned to the WIZTGM_INDEX for 
this image is taken from the application. The value 0 is invalid and cannot be used. 
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Note:     Only one WIZTGM_INDEX tag can be used in an image. 
For further information see Chapter 20, Introduction to the Image Module, Chapter 21, 
Image Editor, Chapter 22, Image Animation and Chapter 9, Tags.  
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   About this chapter: 
This chapter describes how Multiple Tags are used in the system, as follows: 
Overview is an overview of Multiple Tags. 
Accessing Multiple Tags discusses how to access this module. 
Defining a Tag List File and Defining a Tag Filter, describes how to access multiple 
tags. 
 
 

 
 

 
 

  

 
 

 
 
 

Overview 

The Multiple Tags module can be used to optimize performance and enhance functionality. 
This module enables you to adjust system parameters and establish the correct 
environment for working with the application. 
Multiple Tags displays tag lists and enables you to read and write tag values, as well as 
change several tag attributes. In addition, Multiple Tags provides options to save the tag 
list as a recipe or a tag list file.  
Tag list files are ASCII files that contain lists of tags and their attributes. These files have 
the extension .GLS and can be used in the application to generate tag lists in the tag 
definition procedure. 
Read Chapter 9, Tags for more information regarding Tags. 
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Accessing Multiple Tags 

The Multiple Tags module is accessed from the Application Studio in two steps: 
o     Specifying a tag list file to be loaded and defining a tag filter so that only specific 

tags are loaded from the file.  
o     Displaying the Tag List in the Tags Exerciser Program Window. 

 
 
 

 
 

  

 
 
 

 
 

Tool / Multiple Tags 

Used to open Wtags Exerciser Program. 
  
The Multiple Tags utility can be used to optimize performance and enhance functionality. 
This utility enables you to adjust system parameters and establish a proper application 
working environment. 
  
This utility displays tag lists and enables you to read and write tag values, and change 
several tag attributes. In addition it provides options to save the tag list as recipe or . GLS 
file.

 
 

 

 
  
 
 
 
 

Tools / Multiple Tags 

Used to open the Application Tags Exerciser Program. 
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The Multiple Tags utility can be used to optimize performance and enhance functionality. 
This utility enables you to adjust system parameters and establish a proper application 
working environment. 
  
This utility displays tag lists and enables you to read and write tag values, and change 
several tag attributes. In addition it provides options to save the tag list as recipe or GLS 
file.

 
 

 
 

  

Defining a Tag List File 

and Defining a Tag Filter 

 
 
 
 
 

Defining a Tag List File and Defining a Tag Filter  
In the Tag Filter dialog box you can: 

o Define a tag filter: Only tags that meet the filter requirements specified appear in 
the generated list. 

o Specify a tag list file: Select between a standard application tag file and a .GLS 
file. 

o To specify a tag list file and/or define a tag filter:  

In the Control Panel of the Application Studio, double-click the Multi Tags icon.  
Or, 
From the Tools menu, select Multiple Tags. The standard Tag Filter dialog box is displayed 
on top of the Tags Exerciser Program window.  
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The following options are available: 

Tag 
Filter    

Specifies filter parameters so that only the tags that meet 
the filter requirements appear in the generated tag list. The 
following tag options are available: 
Name 
Driver No. 
Address 
Source (PLC, Dummy, Compound, 
System) 
Type (Analog, Tag Value, String). 

Source 
File 

Specifies a tag list file. The following options are available: 
WizPro:     A standard application tag file. 
File (.GLS):   A GLS file. Enter the file in the field (without 
specifying the extension). Click in the field to display a list 
of existing .GLS files from which you can select a file.  

Click OK to save your options. The Tag Filter dialog box closes and the Tags Exerciser 
Program window is displayed with a list of the tags that meet the filter requirements 
specified.  
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Tags Exerciser Program Window 
The Tags Exerciser Program window displays a list of the tags that meet the filter 
requirements specified in the Tag Filter dialog box. The following is an example of a tag list 
in the Tags Exerciser Program window: 

  
The data in the window is displayed under the following columns.  

Name Tag name 

Driver Driver number associated with the tag 

Address    The address of the tag in the PLC 

Value The last read value of the tag 

Rate    Tag sampling rate in seconds (specified during tag 
definition) 
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Sample 

Tag sampling attribute that can be: 
Y for always 
R only is clients are registered for the tag 
N for never 

Type    

Tag type which can be: 
A for analog 
D for digital 
A or D for Compound 
S for string tags 
No character for dummy tags 

  
The dialog box contains a menu bar with the following menus and options: 

File    New    Clear the tag list from the Tags Exerciser Program 
window. 

  Open Open the Tag Filter dialog box to define a tag filter 
and specify a tag list file. 

  Save as 
Recipe Save the list as a recipe. 

  Save as GLS Save the list as a tag list file. 

Options    Sample 
Selected  Sample the currently selected tag in the list. 

  Sample All    
Change the Never sample attribute of all the tags in 
the list to Request. Tags are then sampled only 
when clients are registered for them. 

  Sample 
Disable    

Select this item to change the sample attribute of all 
the tags to Never. This will disable the sampling of all 
the tags.  

  Find Tag Search for a tag. 

  Zoom Tag Modify the tag options. 

Help Using Help Display the standard Windows Help on how to use 
Help files. 

  Find Display the Find Setup Wizard in which you can 
enter key words to find a topic.  
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  Help Index Display the Multiple Tags Help topics. 

Note:    If a communication error occurs, a line of asterisks appears for any tag represented 
in the tag list that is associated with the VPI to which the error occurred. The line of 
asterisks is on-going and appears until the error is corrected. When the error is corrected, 
the tag value appears in the tag list. 

 
 

 
 

  
 
 
 
 

Find Tag 
After a list is generated, you can search for a specific tag. 

o To find a specific tag: 
From the Options menu in the Tags Exerciser Program window select Find Tag. The Find 
Tag By Name dialog box is displayed: 

 
Specify the name of the tag you want to search for and click the Find button. The tag will 
appear highlighted in the list of tags.  
Note:    The name you specified is used as a prefix in the name matching process. The 
search is modeless, meaning that you will not have to close the dialog box to perform any 
other operation in the window. 

 
 

 

 
  
 
 
 
 

Zoom Tag 
The Zoom Tag option is used to modify the attributes of a tag in the Tags list. The 
attributes that can be modified and operations that can be performed include: 

o    Reading the tag value. 
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o    Writing a value to the tag. 
o    Changing the sample attribute. 
o To modify the attributes of a tag: 

Double-click the tag in the list. 
Or, 
Click a tag in the list to select it, and select Zoom Tag from the Options menu. The Tags 
Exerciser Program Window is displayed: 

 
The following options are available: 

Tag Name The name of the tag. 

Driver    The Driver address to which the tag belongs. 

Address Specifies the current tag address. Enter the new address and activate 
the Change button to confirm the change.  

Value    Displays the specified tag value. Click the Read button to display the 
current value. Enter the new value and activate the Write button. 

Sample 

The following options are available:  
Always: The tag will be sampled always. 
In Monitor: The tag will be sampled only when its value is requested by 
an application module (displayed in an image window). 
This mode minimizes communications traffic and improves system 
performance. 
Never: Tag sampling is disabled.  

Note:    This dialog box is modeless, meaning that you can switch to a different tag without 
closing it by simply double-clicking on the required tag in the list. 
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Saving the Tag List 
The tag list can be saved in one of two file types: 

o     Recipe file. 
o     Tag list (.GLS) file  
o To save the current tag list in a recipe file: 

1.    From the File menu, select Save as Recipe. The Recipe File Name dialog box is 
displayed: 

     
2.    Enter a recipe model to which you want the recipe to belong in the Recipe Model field. 
Click inside the field to display a list of existing recipe models. 
3.    Specify the name of the recipe file in the Recipe Name field.  
4.    Click OK to save your definitions and close the dialog box. 
Note:     For more details about recipe models and recipes, refer to Chapter 32, Recipes. 

o To save the current tag list in a tag list file: 
1.    From the File menu, select the Save as GLS option. The New Tag List File dialog box 
is displayed: 

     
2.    Enter the name of the file in which the list is to be saved without the GLS extension.  
3.    Click OK to save your definition and to close the dialog box. 
Note:    You can launch the tag definition dialog box with a double-click or a right-click on 
the relevant tag. 
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   About this chapter: 
This chapter describes the Tag Generator module. 
Tag Generator Module Overview describes the main purpose of the Tag Generator. 
Accessing the Tag Generator discusses how to launch this module and describes the 
dialog box options. 
Connecting to a Data source describes the way to connect a Data source to the Tag 
Generator. 
Wizcon tag management describes the different ways to manage the Wizcon tags in this 
module. 
Mapping rules describes the parameters used by the Tag Generator to name and 
parametrize the Wizcon tags. 
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Tag Generator Module Overview 

The Tag Generator module is an engineering tool designed to quickly and easily generate 
or update tags in the NovaPro Open database.  
This tool requires the application to be based on communication drivers with network 
browsing capabilities such as BACnet or OPC drivers. Future NovaPro Open versions will 
support additional drivers with browsing features. 
The Tag Generator allows you to update any existing Wizcon PLC or dummy tags into 
addressed PLC tags through a mapping process. If tags do not exist in Wizcon database, 
the Tag Generator will create them. 
A mapping rules interface helps to define the information required for the tag generation, 
such as, tag record settings, address format, prefix or suffix related to the automated tag 
naming. All information related to the last used mapping rules is stored in a setup file 
(WizTagGen.ini) and reloaded at the next use of the Tag Generator. 
In order to begin the tag generation, communication drivers need to be connected to the 
related devices. 
The following terminology is related to the Tag Generator module : 

o   Data Source - Communication protocol which will be used to establish 
communication with a data server and which will be applied to modified or newly 
created Wizcon tags. 

o   DSD - Data Source Driver - module of the Tag Generator which is in charge of 
connection to a data source, device and browsing for data items. 

o     Device - Specific device, which is a part of the data source (Specific OPC server 
in the case of OPC, BACnet device in the case of BACnet protocol) 

o     Data Item - data item or data object, defined on the data server. 
o     Wizcon Tag - Wizcon internal variable. Can be a Dummy or PLC source type. 

Can be any data format. 
o     Data Item Mapping - Modification of a dummy tag already defined in a Wizcon 

project into a PLC tag with properties corresponding to properties of source item. 
o     Wizcon Tag generation - Process which generates a new Wizcon tag with a 

PLC source and maps all data item definition properties into the new Wizcon tag. 
 
 

 
 

 
 

   

 
 

 
 
 
Tag Generator Overview  
 
The Tag Generator module is an engineering tool designed to quickly and easily generate 
or update tags in the NovaPro Open database.  
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 tag. 

 
 

This tool requires the application to be based on communication drivers with network 
browsing capabilities such as BACnet or OPC dr
support additional drivers with browsing features. 
The Tag Generator allows you to update any existing application PLC or dummy tags in
addressed PLC tags through a mapping process. I
database, the Tag Generator will create them. 
A mapping rules interface helps to define the information required for the tag generation, 
such as, tag record settings, address format, pr
naming. All information related to the last used mapping rules is stored in a setup file 
(WizTagGen.ini) and reloaded at the next use of the Tag Generator. 
In order to begin the tag generation, communication drivers need to be connected to th
related devices. 
The following terminology is related to the Tag Generator module : 
Data Source - Co
a data server and which will be applied to modified or newly created
DSD - Data Source Driver - module of the Tag Generator which is in charge of connection 
to a data source, device and browsing for data items. 
Device - Specific device, which is a part of the data source (Specific OPC server in the 
case of OPC, BACnet device in the case of BACnet pr
Data Item - data item or data object, defined on the data server. 
Application Tag - Application internal variable. Can be a Dumm
be any data format. 
Data Item Mapping - Modification of a dummy tag already defined in an application project 
into a PLC tag with p
Application Tag generation - Process which generates a new application tag with a PLC 
source and maps all data item definition properties into the new application
Accessing the Tag Generator
Connecting to a data source
Application Tag Management
Mapping Rules

 

   

 
 

 
 

ccessing the Tag Generator 
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o     Application Studio icon 

 

 

A

The Tag Generator is accessible by 3 m

o     Application toolbar  
o     Menu 
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s the Tag generator through the Application Studio, do the following : 

ou le click the 

o To acces
 

D b  Tag Generator icon in the Application Studio Control Panel to open 
rator dialog box. the Tag Gene

 

 
 
This dialog box is split in three different areas : 

ill define from which VPI tags 
will be generated in Wizcon database. 

Mapping Rules 

e the 
developer designs the mapping rules : 

n. 

Display Wizcon 
Tags 

isting or 
newly created Wizcon tags. 

ialog box

the mapping rules in the WizTagGen.ini file. 

Select VPI Driver In this area the user w

This area is split into 2 main parts, wher

• Tag name format 
• Tag sampling & addressing informatio

This area is used to visualize and select ex

In addition, this d  contains the following command buttons : 

OK This button, when clicked, saves the information of 
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e 

Help le. 

Map Tags When mapping rules are defines, this button 

 

o To access the Tag Generator through the Application Toolbar 
nerator is acc ject section, 

by right-clicking on the Ta
 

o access the Tag Generator module under the menu bar, select Tools and the Tag 
enerator. 

 
 
 

Clos This button closes the dialog box without any 
action (mapping rules will not be saved). 

Clicking this button calls the related help modu

initiates the tag(s) creation or the tag(s) update. 

Undo Last This command allows to cancel last tag 
creation/modification directly in Wizcon database

The Tag Ge essible from the Application Toolbar. Under the Ob
gs item, the following context menu is displayed: 

 
o To access Tag Generator through the Menu bar 

T
G

 

   

 
 

 
 
 

pplication Studio Icon 

Double click the Tag Generator icon in the Application Studio Control Panel to open the 
Tag Generator dialog box. 

 

 

A
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pplication toolbar 

The Tag Generator is accessible from the Application Toolbar. Under the Object section, 
gs item, a context menu is displayed. Click on the Tag Generator 

 
 

 
 

A

by right-clicking on the Ta
item in the list. 

 

   

 
 
 

 
 

enu 

To access the Tag Generator module under the menu bar, select Tools and the Tag 
tor. 

 

 

M

Genera
 

 

   

 
 
 

 
 

onnecting to a Data source 

The Data Source connection is the 1st step in the tag generation process. 
ection, you must have declared a communication 

ication Drivers). Only communication drivers 
with item browsing capabilities, are usable in the Tag Generator. 

Once the Tag Generator dialog box is opened, the left part of it is designed to select and 
visualize the data sources. 

 

C

Before selecting a data Source for conn
driver in Wizcon (see Defining Commun

o To select a communication driver 
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o     All Wizcon VPI are visible in the dropdown list, but only ones with browsing 

capabilities are selectable. For others, an error message is displayed. 
o     When a driver is selected, the Tag Generator module sends a request to the 

driver in order to get the list of the items available on the network. 
 

o To select a data item / group of data items 
The l
displaye  not 
sup t
You can

     single selection of a data item by left clicking on it 
tem to select it and then pressing the 

 range selection of items by clicking on the first to select and then pressing the 
 the last item of the group. 

The l on tags. 
 

 
 

 se ected VPI Driver displays the list of its Data Items (or Data Objects). This list is 
d with the available items (devices) on the network. Online updates are

por ed. 
 then perform : 

o

o     multiple selection by clicking on the first i
CTRL key. Clicking on items to select them one by one. Clicking again on a 
selected item will deselect it. 

o     a
SHIFT + click on

 se ected items are now ready to generate or update Wizc

 

   

Application tag 

management 

 
 
 
 

Wizcon tag management 
The right side of the Tag Generator dialog box displays the list of Wizcon tags related to 
the application, according to the filter settings. 

Tag filtering and sorting 
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A set of check boxes allows the application developer to define the type of tags to display 
in the list. 

 PLC tags 

mmy and PLC) 

  format (Dummy and PLC) 

can combine tal and/or String 
 cross 

Additional filters are available by typing the first letters of the searched tag name, type or 
. 

Once filters are applied, only tags conforming to the filter are displayed. 

ting & c
ace. 

t one Data Item in the VPI item list.  

Dummy Displays all Wizcon dummy tags 

PLC Displays all

Analog Displays tags in Analog format (Dummy and PLC) 

Digital Displays tags in Digital format (Du

String Displays tags in String

Note:    You 
format to

Dummy and/or PLC types with Analog, Digi
filter the database. 

address

Genera onverting Wizcon tags 
There are several ways to generate Wizcon tags through the Tag Generator user interf

o Single tag generation 
This method consists of three steps: 
1.    Selec

2.    Click the  button,  
3.    Tag Generator creates a new tag in the Wizcon database.  

from e  combined with the Mapping Rules fields (see Mapping 
le for modification in the Tag user interface (Defining 

e, tag address, and the mapping rules 
mple ra ord rate. If the ‘Tag name format’ fields in Mapping rules 

Note:     Tag information such as tag name, tag address, sample rate or record rate, come 
 th  Data item parameters

rules). These parameters are availab
Tags) 
For example, a Data Item can provide tag nam
provide the sa te and rec
are checked, they will override the Data Item naming. 

o One to one tag conversion 
For this method, steps are : 
1.     Select one Data item in the VPI item list on one side.  
2.    Select on the other side, a Wizcon tag in tag list. 

3.    Click the  button, 
4.    Tag Generator merges the Data item information into the selected Wizcon tag fields.  
Not  s (in Mapping rules fields) are not applicable. The 

, or a PLC tag. In this case, the Data Item address will 

ne shot. In this case, you must : 

e:    In this case, the naming rule
Wizcon tag can be a Dummy
override the Wizcon tag address, if any.  

o Multiple tag generation 
You may want to create a set of tags in o
1.    Select a set of Data items in the VPI item list 
2.    You can then define Mapping rules (see Mapping rules) 

3.    Click the  button,  
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izcon database. 
pping rules and the selected Data 

 allows you to merge a group of Data Items information into a group of 

rsion 

1.   e VPI item list 

4.    The Tag Generator creates exactly the same amount of tags in the W
The description of these tags is provided by the ma
Items. 

o

This operation
 Multiple tag conversion 

existing Wizcon tags. These tags can be dummy or PLC tags. Tag Generator will check if 
the format matches between Data Items and the tags before merging. Steps for conve
are : 

 Select a set of Data items in th
2.    Select a set of Wizcon tags (whatever the format is) 

3.    Click on the  button.  
4.    The Tag Generator merges the first Data Item with first Wizcon tag in the list, merges 

in the list,...and so on. In this case, the 
formation. 

 case of tag creation, 

 
 

the second Data Item with the second Wizcon tag 
Mapping Rules are applied, and will override Data Item in
Note:     In general, tag naming in Mapping Rules only applies in the
not during tag conversion. 
 

 
 

   

Mapping rules 

 
 
 
 
 

ion or the creation phase, the Tag Generator uses the settings defined 
by the user in the Mapping Rules fields. Settings are split into two parts : 

o     Tag name format 
o     Tag communication & storage parameters 

When the Tag Generator module is launched, the initialization file restores the settings of 
the last Tag Generator session.  

at 

Mapping rules 
During the convers

Tag Name Form
This section of the mapping rules allows the user to specify the rules for Wizcon tag 
naming. These settings apply once the  button is clicked. 
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The following settings are available : 

The item name will be used as the Wizcon tag name, with 
ffixes added according to the other mapping 
licable for tag conversion). 

template name o the other 
mapping rules. 

ld by 
ed in the 2nd field.  

atic 

Add Suffix  

Increment by... 

This variable value is appended to the Item names. The 
ed with 

the value in the “Incremented by” field. 

nication & 
rs are r Defining Tags. 

 

 
 

Use Item Name as 
a template prefixes & su

rules (not app

Use static The specified string will be used as the Wizcon tag name, 
with prefixes & suffixes added according t

Replace...by... This function replaces the string provided in the 1st fie
the string provid

Add Prefix This string is prepended to the item name or the static 
template. 

Add Suffix St This static string is appended to the item names 

Start with... start value is added to the 1st tag, and increment

Tag commu
These paramete

storage parameters 
equired in tag definition as mentioned in 
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History log settings 
Those settings define how tags are recorded in regular Wizcon archive files (see Appendix 
Application Files) 
 

 

 
 

Record never Specifies that tag value changes will never be recorded. 

ecord on change 
Specifies that the tag values will be recorded whenever it is 
sampled and is found to have changed by more than the tolerance 
since the previous sample. 

Record on update Specifies that the tag value will be recorded whenever a driver is set 

Record each ill be recorded during each specified 
time interval. 

 
 
 

R

to update the values (even if no changes were detected). 

Specifies that the tag value w

 

 

   

 
 
 

 
 

Tag address format 
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These settings define how addresses are assigned to Wizcon tags. 
 

  
 

Address prefix Specifies the prefix to add to the Date Item address. 

Address suffix Specifies the suffix to add to the Data Item address 

Use default VPI 
address format 

Specifies to duplicate ‘as is’ the Data Item address 
format to the Wizcon tag. 

 
 

 
 

 

   

 
 
 

 
 

Sample rate settings 
These settings define how tags are sampled. 
 

 

  
 

Never sample The external device is never sampled to update its 
respective tag. (some VPIs require this type of setting) 
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Sample in monitor 

The device is sampled to update its respective tag only 
when the tag's value is requested by one of the 
application's modules (for example, displayed in an 
Image). This option is useful for minimizing 
communication traffic, thereby improving system 
performance. Select this option for tags that are used 
for monitoring field activities and do not record into 
history files. Do not select this option for tags that are 

Sample each 
The device is always sampled to update its respective 
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Sample in monitor 

The device is sampled to update its respective tag only 
when the tag's value is requested by one of the 
application's modules (for example, displayed in an 
Image). This option is useful for minimizing 
communication traffic, thereby improving system 
performance. Select this option for tags that are used 
for monitoring field activities and do not record into 
history files. Do not select this option for tags that are 

Sample each 
The device is always sampled to update its respective 

 

 
 

used for alarm definition. used for alarm definition. 

tag. If you select this option, specify the sample rate in 
seconds and/or milliseconds. 
tag. If you select this option, specify the sample rate in 
seconds and/or milliseconds. 
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   About this chapter: 
This chapter describes the Tag templates. 
Tag Template Overview describes the purpose of tag templates and how they can help 
reduce application development. 
Tag Templates in Action - defining a context shows how to define a context 
Using Tag Templates describes how to use the tag templates 
Notes: adds several points to bear in mind when using Tag Templates  
 
 

 
 

 
 

   

Tag Template Overview 

 
 
 
 
 

Tag Template Overview 
  
Early versions introduced the concept of a Tag Mapper. This feature is designed to allow 
you to reduce application development time. In this chapter, we discuss a powerful feature, 
the Tag Template, which allows great flexibility in defining and changing at runtime the tag 
that is used in charts, images, event summaries and history viewers. 
In the following pages we will see how we can use tag templates to change the name of a 
tag that is used anywhere in an image (including different zones) or in a chart. We will see 
that this concept is particularly interesting in applications where you have several charts or 
images which are identical in many respects apart from the tags that they display. A good 
example of this is an application in building automation where you may have similar 
images or charts per floor in a building, but the tags that are displayed are different. 
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Tag Templates in Action - defining a context 
  
In order that we can dynamically change the name of a tag at runtime, we need to identify 
the name, or part of a tag name, that we may wish to change. We do this by defining 
special markers in the name, for example, MY_BUILDING_#FLOOR1#. The # symbols are 
used to define the dynamic part of the name. Now, we can use a tag context to change the 
part of the name between the # symbols.  
In the above example, FLOOR1 is the dynamic part of the tag name. If no context is 
defined (see below), the normal tag name without the # markers will be used. Therefore, in 
this case, the tag MY_BUILDING_FLOOR1 will be used if no context is defined. However, 
if we define a context, say, FLOOR2, and we assign this tag to, for example, animate an 
object in an image, the name of the tag will be calculated as MY_BUILDING_FLOOR2 at 
runtime.  
To summarise, a tag context is used to define the dynamic part of the tag name. It consists 
of a name which helps to identify the context, and a string of characters that will be used to 
change the name of the tag (i.e. the string of characters that will be placed between the # 
markers as defined above). 

 
 

 
 

   
 
 
 
 

Creating a tag context 
Tag contexts can be defined in several places: 

o    In the application studio. 
o    When using the context in an image or chart. 

The most common is to define them in the application studio. The figure below shows a 
branch on the tag tree, "Tag Contexts" 
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A right-click on Tag Contexts will allow you to add, modify or delete a tag context. In this 
case, we are going to add a context. If you do this, you will see the following dialog box: 

 
  
The "Context Name" is what you will use to identify the context when we use it later. The 
"Tag Context" contains the actual string that will be used to modify the tag names. You can 
add as many tag contexts as you like. As you add Tag contexts, and select a context by 
clicking on it, in the main part of the studio window you will see a list of all tags that would 
match that context - this is a kind of filter that is shown for information only. It is telling you 
that if you were to use the selected context in an image or a chart, then these are the tag 
names that would match the context. 
Note that, if a context is defined, you can modify it (change the name or the string), or 
delete it at any time. 
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Using Tag Templates 
The following sections will give you an overview, via examples, of how you can use tag 
templates to speed up application development and to bring your applications to life.  
 
Using Tag Templates in Images 
Before we can explain in more detail how tag templates can be used, you need to 
understand about image animation. If you don't, then you should read the relevant chapter 
before continuing.  
Tag templates can be used in all dynamic, static and trigger objects in an image. You can 
change the context by: 

o     Associating a zone in an image with a context using the zone definition dialog 
box, 

o     Using an action macro (LoadImage, GotoZone) 
o     Using a fast action: 

o LoadImage - Loads an image into a given zone 
o LoadTrendFile - Loads a chart 
o Change Tag Context - changes the current context for the image 

 
Example 1: Dynamically changing the tag that is used to animate an image object 
 
Below; we can see that we have used the tag, MY_BUILDING_#FLOOR1# to cause an 
object to blink depending on the value of the tag contextt 

 
Here we can see that part of the tag name has been enclosed by the # symbols. This 
means that if no context has been applied to the image, then the usual tag name, 
MY_BUILDING_FLOOR1 will be used to drive the animation.  
Now imagine that we have changed the context (using one of the methods described 
above for example), and have set the context to be FLOOR2. This means that, in this case, 
it is tag MY_BUILDING_FLOOR2 which is driving the animation. 
Example 2: Assigning a context to an image zone 
The dialog box shown below allows you to assign a tag context to each zone that you use 
in an image. If you do this, every time that you change to a given zone in an image, the 
given context will be used by default. 
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This doesn't mean of course that we can never change the context for a given zone. If we 
want to change the context for a given zone, we can do it dynamically using one of the 
methods listed above. 
Example 3: Loading a Chart 
As stated earlier, tag templates can also be used in charts. To see how this works, see the 
figure below. Here we see that we can choose a set of tags to use for the graph definition. 
As defined above, we can use the # markers in the name of the tag to define a tag name at 
the point at which we load the chart. Again, the context can be given in the LoadTrendFile 
fast action, or the corresponding macro. 

 
Notes: 
 

o     For each image, a special string tag, WIZTAGTMPL_CONTEXT, can be used to 
display the current context. (Stars (***) will be displayed for this tag if no context is 
defined). 

o     Tag templates can be defined for any objects in an image or chart that use tag 
names (e.g. buttons, sliders, dynamic tag displays). 

o     Tag templates cannot be used in XY graphs. 
o     Tag templates are also available on the web. 
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About this chapter: 
This chapter describes how to define and use alarms in the system, as follows: 
Overview is an overview of application alarms. 
Basic Principles describes the basic principles of alarm definition. 
Defining Alarms describes how to define alarms, how to define a single action for an 
alarm and how to assign a name to alarm classes. 
Alarm Filters describes how to define filters and apply tag counters to alarms. 
Alarm Help Files describes how to create alarm help files. 
Alarm Properties describes how to define a login and logout message, the time format 
that appears in the Events Summary and the alarm printout, and how to overwrite default 
print sequences. 
Exporting Alarms describes how to generate a list of alarms in ASCII format, and 
describes the ALS file format. 
Importing Alarms describes how to import alarm definitions from an ASCII file. 
Finding Alarms describes how to locate an alarm in the List of Alarms in the Application 
Studio. 
 

 
 

 
 

   

 
 
 

 
 

Overview 

Alarms are configured application messages used to notify operators of exceptional 
conditions at the workplace. The application generates automatic system messages that 
provide operators with information about internal system events, such as communication 
driver failure, network communication errors and others.  
Application alarms can be targeted to and be displayed in the Event Summaries, appear 
in a popup window, or be printed out.  
Alarms can be defined in order of hierarchy. New alarms can be added (or existing alarms 
modified) to different levels of the hierarchy tree. Alarms can be defined according to 
attributes, inhibited, delayed, have Help messages containing instructions on how to 
handle the cause of the alarm and have comments attached to them. They can also be 
recorded to history for report purposes. 
Note:     For quick reference, the number of alarms within the application is listed 
Application Studio Status Bar. 
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Alarms - Overview 

Alarms are application messages used to notify operators about exceptional conditions in 
the plant. Application alarms can be displayed in the Events Summary window or pop-up 
window. Using these windows, operators can examine and handle numerous alarms by 
filtering and sorting them. 
Alarms are generated whenever pre-defined conditions exist. Only the system engineer 
can define alarm conditions. 
To provide the operator with online help (such as operational instructions) when an alarm 
occurs, alarm messages can be linked to help files. 
A feature in the application enables you to associate image objects with alarms. Alarm 
objects in images react to the conditions of the alarm with which they are associated. 
Application alarms can be displayed in a hierarchical tree in which an alarm has a parent, 
child and sibling relations with other alarms. The alarm hierarchic tree is built up of Levels 
to which alarms can be attached. A level definition can override subordinate levels and 
alarms defined in these levels. 
  
Alarms and Levels can be initiated: 
1. 1. Through the Alarms Object located in the Containers tree. Right click the Alarms 
object (selection is observed by shading the chosen item blue).  
1. 2. Click the Add Alarm or Add Level option. 
  
Alarms can be added through the Design Menu 
1. 1. Click the Design Menu 
1. 2. Select Alarm from the Add Object menu. 
  
There are two ways to display a list of all the Alarm objects:  
1. 1. Click the Alarm object from the Containers tree. As a result a list of all Alarms is 
displayed. Each Alarm is described by the following parameters:Tag name, Condition, 
Text, Family, Zone and severity. 
OR 
1. 1. Click the Alarm object from the Containers tree 
1. 2. Move with the mouse to the List Zone area and press the right mouse button. 
1. 3. As a result the option of "Duplicate view" will be shown, choose this option. 
  
To set the order of fields to be displayed in the Events Summarys list: 
1. 1. Click the Events Summary file form the Containers tree 
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1. 2. Move with the mouse to the List Zone area and press the right mouse button. 
1. 3. As a result the option of "View Setting" will show, choose this option and start the 
editing. 
  
Defining Alarms 
Defining Levels 

 
 

 
 

   

Basic Principles 

 
 
 
 
 

Basic Principles 
Only users with the appropriate authorization can define alarm conditions. Application 
alarms are generated whenever predefined conditions exist.  
Up to 65,535 alarms can be defined in the application. Each alarm can be assigned 
different characteristics and properties during the alarm definition procedure. Alarms can 
be sent to different targets and be checked by different attributes. 

Alarms in Events Summaries 
Alarms are written to the Event Summaries. If previously defined the operator can see a 
graphical display of the cause of the alarm, check Help for instructions in handling the 
alarm, acknowledge and end the alarm, add comments or inhibit (on the Internet) the 
alarm. The Start, End and Acknowledgement time and date of the alarm can also be listed 
in the Summary Events.  

Alarm Objects in Images 
The application enables you to visualize alarm conditions graphically by associating image 
objects with alarms. Alarm objects in images react to the conditions of the alarms in the 
alarm family with which they are associated. For example, if the alarm condition is true in 
the alarm family, the object may begin to blink or change colors.  

Alarm Filters 
The application enables you to define filters and apply tag counters to alarms. Those tags 
will contain the amount of alarms matching the filter conditions, and can be used in Wizcon 
modules (e.g. image module,...). The alarm filter is automatically activated when the 
application is loaded. 
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Defining Alarms 

 
 
 
 
 

Defining Alarms 
Alarms are defined in the Application Studio. After defining an alarm, you can assign a 
name to alarm classes, as described below. 

o To define an alarm: 

Click the  Alarms icon in the Application Studio toolbar 
Or,  
In the All Containers pane of the Application Studio, right click Alarms and then select Add 
Alarm from the popup menu. The Alarm Definition dialog box opens.  
This dialog box has two tabs: 

o    General Tab - where general alarm properties such as Alarm Condition, Alarm 
Text, Zone, Family, Target, Attributes and Delay are defined.  

o    Action on Alarm - where actions such as, Go to Zone, Execute Macro on Alarm 
and AAM Configuration are defined. 

 
 

 

 
   
 
 
 
 

Alarms Definition      
Alarms are defined in the Application Studio. After defining an alarm, you can assign a 
name to alarm classes, as described below. 
Click the Alarms icon in the Application Studio toolbar 
Or,  
In the All Containers pane of the Application Studio, right-click Alarms and then select Add 
Alarm from the popup menu. The Alarm Definition dialog box opens.  
This dialog box has two tabs: 
General - where general alarm properties such as Alarm Condition, Alarm Text, Zone, 
Family, Target, Attributes and Delay are defined.  
Action on Alarm - where actions such as, Go to Zone, Execute Macro on Alarm and AAM 
Configuration are defined. 
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General Tab  
This tab is used to define general alarm properties. 
Alarm Condition  This field defines the alarm conditions. 
Alarm Text  This field when completed shows a description of the alarm. An alarm 
message can include tokens. 
Family Specifies the name of the group to which the alarm belongs. The name can consist 
of up to 64 characters and is the link to alarm objects. It is also used for classification and 
filtering. 
Help File Specifies the name of the Help file that contains information for the operator. For 
more details about creating alarm help files, refer to the section on Alarm Help Files. 
Zone You can enter a zone area from 0 to 50,000. This value is used to classify and filter 
alarms in the Events Summary and application popup windows.  
Severity Specifies the priority order of each alarm. For example, a low priority could be 0 
and a high priority, 50,000). It is also used for classification and filtering. 
User Fields These are customized fields that are defined by the user according to their 
specific requirements. User fields enable additional alarm filtering. There are five User 
Fields. 
Groups This option is used to assign authorized users and groups of users to the alarm. 
Alarm recipients can handle the alarm according to user authorization. 
Inhibition by Tag  Inhibit if a specific tag receives a specific value. 
Inhibit Immediate This checkbox when checked means inhibit this alarm immediately. 
Targets Specifies the alarm destination. The following options are available:  
Default Printer: The alarm message is sent to the printer defined as the alarms printer. 
Events Summary: The alarm is displayed in the Events Summary. 
Popup: The alarm is displayed in a Popup window. 
Popup buzz: The alarm is displayed in a Popup Events Summary that will buzz when the 
alarm is displayed. If you do not select this option, the Popup Events Summary will not 
buzz when the alarm is displayed even if it was defined to do so in the PopUp Buzz dialog 
box. 
User class: Enables you to identify an alarm and to classify it online and in historical 
Events Summaries. Select this option and click on the arrow on the right of the field to 
select an alarm user class from a drop-down list of predefined classes. Each alarm can be 
assigned only one class. 
Attributes The alarm operational attributes include the following: 
System Wide: Alarms can be limited to a single station or distributed among several 
application stations using application network support facilities.  
If this option is selected, the alarm will be distributed to other stations in the network. It can 
be acknowledged from any station across the network. By default, alarms appear only on 
the station used by the operator. 
Auto Acknowledge: The system automatically acknowledges alarms (as they occur) as if 
already acknowledged by the operator. 
Auto END: The system automatically ends alarms (after they occur) as if the condition that 
caused the alarm to be generated has already terminated. 
Class at Acknowledge: Enables you to re-assign a User Class property to the alarm when 
the alarm is acknowledged. This means that you can change the routing of an alarm upon 
its acknowledgment. 
Record to File: Records the alarm in the alarm’s history file. 
Discard: Discards active alarms when the application is terminated. 
Exclude from Printing: If this option is selected the alarm will not be printed. 
Auto Print AHP File: Help files with the AHP suffix can also be printed. A help file in 
HTML format is printed manually according to user demand. An alarm line and its AHP file 
are printed as a set where the AHP file appears directly under the alarm. When working in 
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a network configuration and an alarm with an AHP file attached is sent to another station 
this alarm will be printed in the far station only when the AHP file is located in the far 
station. 
Note: If an alarm is defined with both the Auto Acknowledged and Auto End options, it will 
be considered inactive and will not be displayed in the Events Summary. 
Delay Delay intervals can be defined during which time alarms will not be generated. 
There are three options defining when the alarm will be reset: 
 Condition is false: Alarms will not be generated when the alarm condition is false (within 
the time delay). 
 Delay time ends: If the alarm condition is True, at the end of the defined time delay 
alarms will be generated. This is without taking into consideration changes in alarm status 
during the delay period. 
 Never: The delay feature will not be imposed.  
Note: The default is Never. 

Alarms Overview  
 
 

 
 

   
 
 
 
 

The name of the group to which the alarm belongs. 
 

 
 

 
 

   

 
 
 

 
 

General Tab  
This tab is used to define general alarm properties. 
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Alarm 
Condition This field defines the alarm conditions 

Alarm 
Text  

This field when completed shows a description of the alarm. An alarm 
message can include tokens and contain up to 253 characters. 

Family    
Specifies the name of the group to which the alarm belongs. The name can 
consist of up to 64 characters and is the link to alarm objects. It is also used 
for classification and filtering. 

Help 
File    

Specifies the name of the Help file that contains information for the 
operator. For more details about creating alarm help files, refer to the 
section on Alarm Help Files  .  

Zone    You can enter a zone area from 0 to 50,000. This value is used to classify 
and filter alarms in the Events Summary and application popup windows.  

Severity    
Specifies the priority order of each alarm. For example, a low priority could 
be 0 and a high priority, 50,000). It is also used for classification and 
filtering. 
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User 
Fields 

These are customized fields that are defined by the user according to their 
specific requirements. User fields enable additional alarm filtering. There 
are five User Fields. See Assigning User Field Names . 

Groups    
This option is used to assign authorized users and groups of users to the 
alarm. Alarm recipients can handle the alarm according to user 
authorization. 

Inhibition 
by Tag Inhibit if a specific tag receives a specific value. 

Inhibit 
Immediate This checkbox when checked means inhibit this alarm immediately. 

Targets 

Specifies the alarm destination. The following options are available:  
Default Printer: The alarm message is sent to the printer defined as the 
alarms printer. 
Events Summary: The alarm is displayed in the Events Summary. 

 

Popup: The alarm is displayed in a Popup window. 
Popup buzz: The alarm is displayed in a Popup Events Summary that will 
buzz when the alarm is displayed. If you do not select this option, the 
Popup Events Summary will not buzz when the alarm is displayed even if it 
was defined to do so in the PopUp Buzz dialog box. 

Targets 

User Class: Enables you to identify an alarm and to classify it online and in 
historical Events Summaries. Select this option and click on the arrow on 
the right of the field to select an alarm user class from a drop-down list of 
predefined classes. Each alarm can be assigned only one class. 

Attributes 

The alarm operational attributes include the following: 
System Wide: Alarms can be limited to a single station or distributed 
among several application stations using application network support 
facilities.  
If this option is selected, the alarm will be distributed to other stations in the 
network. It can be acknowledged from any station across the network. By 
default, alarms appear only on the station used by the operator. 
Auto Acknowledge: The system automatically acknowledges alarms (as 
they occur) as if already acknowledged by the operator. 
Auto END: The system automatically ends alarms (after they occur) as if 
the condition that caused the alarm to be generated has already terminated. 
Class at Acknowledge: Enables you to re-assign a User Class property to 
the alarm when the alarm is acknowledged. This means that you can 
change the routing of an alarm upon its acknowledgment. 
Record to File: Records the alarm in the alarm's history file. 
Discard: Discards active alarms when the application is terminated. 
Exclude from Printing: If this option is selected the alarm will not be 
printed. 
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Auto Print AHP File: Help files with the AHP suffix can also be printed. A 
help file in HTML format is printed manually according to user demand. An 
alarm line and its AHP file are printed as a set where the AHP file appears 
directly under the alarm. When working in a network configuration and an 
alarm with an AHP file attached is sent to another station this alarm will be 
printed in the far station only when the AHP file is located in the far station. 
Note: If an alarm is defined with both the Auto Acknowledged and Auto End 
options, it will be considered inactive and will not be displayed in the Event 
Summaries. 

Delay 

Delay intervals can be defined during which time alarms will not be 
generated. There are three options defining when the alarm will be reset: 
Condition is false: Alarms will not be generated when the alarm condition 
is false (within the time delay). 
Delay time ends: If the alarm condition is True, at the end of the defined 
time delay alarms will be generated. This is without taking into 
consideration changes in alarm status during the delay period. 
Never: The delay feature will not be imposed.  
Note: The default is Never. 

 
 
 

 
 

   

 
 

 
 
 

Alarm Conditions 
Expressions are displayed in the Alarm Condition field in different colors and according to 
their expression type.  

o     Red for errors 
o     Black for operations 
o     Blue for correct tag names 
o     Olive green for functions 

Alarm Condition options consist of a list of tags, operators and functions from which you 
can build an expression.  

o     Tags - when selected a field box with an arrow is added to the Alarm Condition 
field. 
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The Alarm Condition field is divided into two when the Tag (right click on the field) option is 
selected from the popup menu. The upper field enables selection of the Station Name 
whereas the lower field enables selection of a tag from this station's tag list. 
Clicking the arrow to the right of the field displays a dropdown list of available tags from 
which you can select the required tag. Only one tag can be added at a time to the Alarm 
Condition field. Clicking anywhere in the Alarm Condition field removes the tag field box 
and enters the tag into the expression. Tags can be written manually by first entering a @ 
and then the required tag name. 

o Numeric Operator - when selected displays the following options: 
+ Add 
- Subtraction 
/ Division 
MOD Integer value of the remainder 
 

o Relational Operators - when selected displays the following options: 
= Equal 
<> Not Equal 
<= Less or Equal than 
>= Greater or Equal than 
< Less than 
> Greater than 
 

o Logical Operator when selected displays the following options 
AND Combines two conditions logically 
OR Combines two conditions logically 
NOT Negates the condition that follows it 

o     Function - when selected displays the following options: 

Function    Syntax    Description 

Log    LOG(expression)where 
expression > 0 Calculates base 10 logarithm.  

Ln LN(expression) where 
expression > 0 Calculates natural logarithm. 

Root ROOT(expression) 
expression>= 0 Calculates square root. 

Min    MIN(x,y)where both x and y are 
expressions. 

Returns the minimum out of the two 
parameters. 

Max    MAX(x,y)where both x and y are 
expressions. 

Returns the maximum out of the two 
parameters. 
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Power    POWER(x, y) where both x and 
y are expressions. Returns the value of xy. 

Sign SIGN(expression)   Calculates 
the sign. 

Returns -1 if expression<0 and 1 if 
expression >=0. 

Floor FLOOR(expression)   Calculates 
the floor. 

Returns a floating-point value 
representing the largest integer that 
is less than or equal to expression. 

Bit 
BIT(B,@tagname)where B is bit 
number and @tagname is a tag 
value 

Alarm is on when BIT is true 
value="1" 

Abs    Abs (expression)   Calculates 
absolute value. 

Returns the absolute value of 
expression. 

Sin    SIN(expression) where 
expression angle is in radians. Calculates sine. 

Cos COS(expression) where 
expression angle is in radians Calculates cosine. 

Tan    TAN(expression) where 
expression angle is in radians. Calculates tangent. 

ROC     

Processes values that change too 
quickly. If a process value fluctuates 
by more than the rate of change 
limit in the given time interval, the 
tag generates the alarm. The rate is 
given in percentage per unit of time. 

Deviation 
(%)  

Processes values that change from 
the optimum value. Deviation 
alarms require a definition of a 
target value and range. If the 
process value exceeds the range, a 
deviation alarm occurs. For 
example, if the optimum value is 
100 and the range (deadband) is +/-
5 the process can vary from 95 to 
105 without generating an alarm. 
The deadband is given by 
percentage of the value. 
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Deviation_F 
(Fixed)  

Process values that change from 
the optimum value. Deviation 
alarms require a definition of a 
target value and range. If the 
process value exceeds the range, a 
deviation alarm occurs. For 
example, if the optimum value is 
100 and the range (deadband) is +/-
5 the process can vary from 95 to 
105 without generating an alarm. 
The deadband is given by a 
constant value of the value. 

o     Bit Operator - when selected displays the following options: 
OR Combines two conditions logically 
AND Combines two conditions logically 
XOR Exclusive OR 
NOT Negates the condition that follows  
 

 
 

 
 

   

 
 

 
 
 

Alarm Text 
The alarm text can include the following tokens:  

@tagname    Replaces @tagname with the current tag value when the alarm is 
started. 

@!tagname    Replaces @!tagname with the value of the tag that is force read from 
the PLC when the alarm is started. 

@#tagname    
Replaces @#tagname with the value retrieved from the block to which 
the tag belongs, if the block is fresh. If the tag does not belong to a 
block, the @# control will function the same as @!. 

Note:    The above three tagname tokens must be typed in lower case letters. Otherwise 
the system will not recognize them. 

$TIME    The current time in Hours.Minutes.Seconds format. The value range is 
from 00.00.00 to 23.59.59. 
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$DATE    The current date in Day.Month.Year format. The value range is from 
01.01.00 to 31.12.99. 

$HOUR    The current hour. The value range is from 0 to 23. 

$MINUTE    The current minute. The value range is from 0 to 59. 

$SECOND    The current second. The value range is from 0 to 59. 

$DAY    The current day. The value range is from 1 to 31. 

$MONTH    The current month. The value range is from 1 to 12. 

$YEAR    The current year. The value range is from 00 to 99. 

$WEEKDAY    The current day of the week. The value range is from 1 to 7, where 1 
is Sunday and 7 is Saturday. 

$OPERATOR    The current operator name. The value is a string that represents the 
operator name. 

$INTIME    The number of minutes that passed since midnight. The value is used 
for tag comparison and definition. The value range is from 1 to 1439. 

$INDATE    
The number of days that passed since January 1, 1980. The value is 
used for tag comparison and definition. The value range is from 0 and 
on. 

 
 

 
 

   

 
 

 
 
 

Assigning Names to Alarm Classes 
This option is used to assign user-defined names to alarm classes. Alarm classes can be 
used to categorize alarms to identify them more easily, and to filter them in the system 
Events Summary. See General Tab . 

o To assign class names: 
From the Design menu, select Alarm Parameters and then Class Names. The Alarm User 
Class Names dialog box is displayed:  



Chapter 15 Alarms 

476 

  
The dialog box displays 16 default class names. Double-click on the default name to select 
it, and enter the new name. 

 
 

 

 
   
 
 
 
 

Assigning User Field Names 
These are customized fields that are defined by the user according to their specific 
requirements. User fields enable additional alarm filtering. There are five User Fields. 

o To define User Fields: 
From the Design menu, select Alarm Parameters and then Field Names to open the Alarm 
User Fields dialog box. 

 
1.   Type in the unique User Name opposite the relevant number. 
2.   Click OK to confirm. 
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Alarm Help Files 
Alarm Help files are user-created ASCII files. Each Help File contains handling instructions 
for an associated alarm. The operator receiving an alarm can open the alarm's Help File in 
the Event Summaries by clicking the assist icon or by right clicking on the alarm and 
selecting Assist. 
Help files can also be saved in HTML format and be sent to the operator via the Internet. 
Help Files can be created using any text editor. However the Help File folder must be 
saved in the same location as the application. 

o     System Help Files are saved as XXX.AHP 
o     HTML Help Files are saved in a folder called DOCS as XXX.HTML 

After a Help File for an alarm has been created and saved in the application folder it can be 
attached to an alarm in the Alarm Definition General Tab. 

o To define a Help File: 
1.    In the Help File field click the Browse icon. The Open dialog box opens displaying Help 
Files folders. 
2.    Select the relevant Help File and click Open to return to the General tab. 
3.    Click Apply or OK. 
 

 
 

 
 

   

 
 
 
 
 
Used to indicate the name of a file that contains alarm help information for the operator. 
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Action on Alarm 
You can define a single action for an alarm when it reaches one of three states: when it 
starts, when it is acknowledged and when it ends. When the alarm reaches the selected 
state, it will trigger a macro.  

o To define an action on alarm: 
In the Alarm Definition dialog box click the Action on Alarm tab. The Action on Alarm 
dialog box will open.  

 
The following options are available 

Go to 
Zone    

When selected an image of the zone specific to the alarm opens on the 
users screen when the alarm is generated. 
Window Defines the window into which the image will be loaded 
Image Defines the image file that will be opened when the alarm is 
generated. 
Zone Defines the specific zone in the image file that will be displayed when 
an alarm is generated. 
Context Defines the context that will be used in the loaded image. 
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Execute 
Macro on 
Alarm 

Started: Enables defining an action when the alarm starts.  
Acknowledged: Enables you to define an action when the alarm is 
acknowledged.  
Ended: Enables you to define an action when the alarm ends.  
Create Macro: Macros can be attached to all three alarm states. Defined 
actions will be activated automatically by application at run-time. This 
feature makes building applications easier. The user does not need to 
use either Application Language or an add-on to perform an action 
when an alarm changes its status.  

AAM 

Enables configuration of alarm transmission to users and groups via 
printer, fax, e-mail, SMS, voice messages and other services. Before 
configuring advanced alarm transmission verify that the appropriate 
drivers providing this service in Advanced Alarm Management are 
defined.  
Select Recipients: Click Groups to define Advanced Alarm 
Management recipients. 
File Association: Add text file for the E-mail message. 
Synthesized Alarm Text: If this checkbox is checked this text file is sent 
as a voice message. When this checkbox is not checked the For Voice 
WAV file will be defined. The default is checked. 

o To define AAM transmission: 
In the Alarm Definition dialog box click the Action on Alarm tab.  
1.    In the Select Recipients field click the Groups button to open the Alarm Recipients 
dialog box. Select the relevant recipients and click Add and then OK.  

  
2.    In the File Association field select a text file that will be attached to your e-mail, or will 
be sent by fax or to the printer. 
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3.    To send a vocal message, click the browse button and select a sound file (file of type 
*.wav).  
4.    Check the Synthesized Text checkbox to send the text file as a voice message. When 
this checkbox is not checked the For Voice WAV file will be defined. 
Note:     Before configuring advanced alarm transmission, verify that the appropriate 
drivers providing this service in AAM are defined.  
 

 
 

 
 

   

 
 

 
 
 

Action on Alarms   
You can define a single action for an alarm when it reaches one of three states: when it 
starts, when it is acknowledged and when it ends. When the alarm reaches the selected 
state, it will trigger a macro.  
In the Alarm Definition dialog box click the Action on Alarm tab. The Action on Alarm dialog 
box will open.  
The following options are available: 
Go to Zone When selected an image of the zone specific to the alarm opens on the users 
screen when the alarm is generated. 
Image Defines the image file that will be opened when the alarm is generated. 
Zone Defines the specific zone in the image file that will be displayed when an alarm is 
generated. 
Exclude Macro on Alarm 
Started: Enables defining an action when the alarm starts.  
Acknowledged: Enables you to define an action when the alarm is acknowledged.  
Ended: Enables you to define an action when the alarm ends.  
Create Macro: Macros can be attached to all three alarm states. Defined actions will be 
activated automatically by application at run-time. This feature makes building applications 
easier. The user does not need to use either application Language or an add-on to perform 
an action when an alarm changes its status.  
AAM Configuration Enables configuration of alarm transmission to users and groups via 
printer, fax, e-mail, SMS, voice messages and other services. Before configuring advanced 
alarm transmission verify that the appropriate drivers providing this service in Advanced 
Alarm Management are defined.  
Select Recipients: Click Groups to define AAM recipients. 
File Association: Add text file for the email message, which could be either a Printer, Fax 
or email message. 
Synthesized Alarm Text: If this checkbox is checked this text file is sent as a voice 
message. When this checkbox is not checked the For Voice WAV file will be defined. 
To define AAM transmission: 
1. 1. In the Alarm Definition dialog box click the Action on Alarm tab.  
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1. 2. In the Select Recipients field click the Groups button to open the Alarm Recipients 
dialog box. Select the relevant recipients and click Add and then OK.  
1. 3. In the File Association field select a text file that will be attached to your e-mail, or will 
be sent by fax or to the printer. 
1. 4. To send a vocal message, click the browse button and select a sound file (file of type 
*.wav).  
1. 5. Click OK to confirm.  
Note: Before configuring advanced alarm transmission, verify that the appropriate drivers 
providing this service in AAM are defined. 
Alarms Overview 

 
 

 
 

   

 
 

 
 
 

Macros that will be activated as the alarm changes state can be attached to each of these 
states. If the alarm is Auto ACK, then the acknowledge state cannot have an action for it. If 
the alarm is Auto END, then the ended state cannot have an action for it. 

 
 

 

 
   
 
 
 
 

Choose the macro you wish to activate once the alarm changes to this state. 
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If this option is chosen then the user will be able to attach an action once the Alarm has 
moved to the started state. 

 
 

 
 

   
 
 
 
 

If this option is chosen then the user will be able to attach an action once the Alarm has 
moved to the acknowledged state 

 
 

 

 
   
 
 
 
 

If this option is chosen the user will be able to attach an action once the Alarm state has 
moved to the ended state. 

 
 

 

 
   
 
 
 
 

Alarm Levels 

Alarms can be defined according to hierarchy. Each alarm can be defined at a different 
level in the hierarchical tree. Levels can be modified, added or deleted. Level definition 
contains most of the parameters used by alarm definition so that when one is defined and 
then modified its sub-levels also receive the same modifications. Alarm hierarchy is defined 
and viewed in the All Containers tree. 
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Note:     If at the Alarm Level the inhibit condition is valid, the alarms belonging to this level 
will not occur even if they are not inhibited. 

o To add a level: 
In the All Containers pane right click Alarms. From the dropdown menu select Add Level. 
The Definition dialog box opens. 
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1.    Type in the Level Name in the Level Name field of up to 253 characters. 
2.    The other fields appearing in this dialog box are described in detail in General Tab 
with exception to the Modify field.  
3.    The Modify field has the following sub-fields: Include Alarms, Change and Override. 
Make your selection accordingly.  
4.    Click OK to confirm. 

o To modify a level: 
In the All Containers pane right click Alarms and select Modify Level from the dropdown 
menu. The Definition dialog box will open on your screen. 
Or, 
In the All Containers pane double click the Alarms icon. A List of Alarms opens in the 
Control Panel. Select an alarm and either right click and select Modify Level or double 
click. The Alarm Definitions dialog box will open on your screen.  
Further instructions appear in To add a level  and in the General Tab     . 

o To delete a level: 
1.    In the All Containers pane right click Alarms and select Delete Level from the 
dropdown menu. A message box opens on your screen. 
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2.    Click Yes to delete the level. The level will be removed from the list. 
 

 
 

 
 

   

Exporting Alarms 

 
 
 
 
 

Exporting Alarms 
The Export Alarms option enables you to generate a list of alarms in ASCII or CSV format 
and send the list to the printer or a file. The generated list can also be filtered to include 
only specific alarms.  
Alarm lists can be generated and then edited using a text editor. Once generated, the list 
can be printed for project documentation. This is useful in large projects, where thousands 
of alarms must be defined. In this case, working with a text editor is faster than defining 
each alarm separately. 

o To generate a list of alarms: 
In the All Containers section of the Application Studio, right click Alarms and select Export 
Alarms from the popup menu. The Alarm List dialog appears: 
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The dialog box contains filter options that you can select to determine which alarms will 
appear in the list that you want to generate. Each filter field is optional (except for the 
filename in the List Target field, which must be specified if you select the File option). 
The following options are available: 

No. Specifies the range of numbers of the alarms that you want to appear 
in the generated list. 

Tag Name    Specifies the name, or name prefix range of the tags associated with 
the alarms that you want to appear in the generated list. 

Family    Specifies the name or prefix of the family to which the alarm belongs 
that you want to appear in the generated list. 

Severity    The severity range of the alarms that you want to appear in the 
generated list. 

Zone The zone range of the alarms that you want to appear in the generated 
list. 

Targets    The target specifications of the alarms that you want to appear in the 
generated list (any, none, or all can be selected). 

User Class 

Activate this button to select classes to filter the alarms that will appear 
in the generated list. After you activate this button, the Set User Class 
dialog box appears. See To assign class names 
You can select one or more classes, so that only the alarms that 
belong to the classes will appear in the generated list. Activate the Set 
All button to select all the classes. Activate the Reset All button to 
deselect all the classes.  

Attributes 
The attribute specifications of the alarms that you want to appear in the 
generated list. You may select any attribute, all of the attributes, or 
none at all.  

List Target 

Specifies the target destination of the list to be generated: Printer or 
File (.ALS). You can select Printer to send the list to the printer, or File 
(.ALS) to save the list in a file with the extension .ALS. For File (.ALS), 
specify the name of the file without the extension. This file will be 
located in the application’s directory in the Set Default Paths dialog 
box.  

Fixed The file is printed in .ALS format. 

CSV The file is printed to an Excel file. 

After you complete the dialog box and activate the OK button, an alarm list will be 
generated according to the filter you specified. 
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Used to define the alarm destination (printer, events summary, pop-up events summary...) 
 
 

 

 
   
 
 
 
 

.ALS File Format 
This section describes the field definitions of an .ALS file. An .ALS file can be opened with 
any text editor. 
The format of the file is as follows: 
The first line contains the alarm attribute fields. This line begins with a semicolon. 
Each remaining line contains one alarm definition. 
The fields in the alarm definition lines are as follows: 

No.    Specifies the alarm original number.  

Tag    Specifies the name of the tag associated with the alarm. 

Cond Specifies the conditional operator of the alarm condition.  

Value Any numerical value for the alarm condition. 

Text    The text that will appear when the alarm condition is true. The text 
appears in brackets < >. 

Prt,Ann,Pop, 
These fields represent the target specification of the 
Buz,Fil   alarm. The value can be Y for Yes or N for No. 

Sys,AAc,AEn, 
    

These fields represent the alarm attributes. The 
Dis,ClA   value can be Y for Yes or N for No. 
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Sev Specifies the alarm severity from 0 (lowest level) to 50,000 (highest 
level). 

Zone    Specifies the alarm zone number from 0 to 50,000. 

Name    Specifies the alarm name (assigned in the alarm definition). The name 
appears in brackets <>. 

Help    
Specifies the name of the help file associated with the alarm (specified 
in the alarm definition). The name of the help file appears in brackets 
<>. 

User Class Specifies the user class associated with the alarm. The value 0 
represents no user class specification. 

Action on 
Alarm    

Specifies the name of the action macro, which can be attached to each 
state of the alarm. 

 
 

 
 

   
 
 
 
 

Alarm Export   
The Export Alarms option enables you to generate a list of alarms in ASCII or CSV format 
and send the list to the printer or a file. The generated list can also be filtered to include 
only specific alarms. Alarm lists can be generated and then edited using a text editor. Once 
generated, the list can be printed for project documentation. This is useful in large projects, 
where thousands of alarms must be defined. In this case, working with a text editor is 
faster than defining each alarm separately. 
In the All Containers section of the Application Studio, right-click Alarms and select Export 
Alarms from the popup menu. The Alarm List dialog appears: 
The dialog box contains filter options that you can select to determine which alarms will 
appear in the list that you want to generate. Each filter field is optional (except for the 
filename in the List Target field, which must be specified if you select the File option). 
The following options are available: 
No. Specifies the range of numbers of the alarms that you want to appear in the generated 
list. 
Tag Name Specifies the name, or name prefix range of the tags associated with the 
alarms that you want to appear in the generated list. 
Family Specifies the name or prefix of the family to which the alarm belongs that you want 
to appear in the generated list. 
Severity The severity range of the alarms that you want to appear in the generated list. 
Zone The zone range of the alarms that you want to appear in the generated list. 
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Targets The target specifications of the alarms that you want to appear in the generated 
list (any, none, or all can be selected). 
User Class Activate this button to select classes to filter the alarms that will appear in the 
generated list. After you activate this button, the Set User Class dialog box appears: 
You can select one or more classes, so that only the alarms that belong to the classes will 
appear in the generated list. Activate the Set All button to select all the classes. Activate 
the Reset All button to deselect all the classes.  
Attributes The attribute specifications of the alarms that you want to appear in the 
generated list. You may select any attribute, all of the attributes, or none at all.  
List Target  Specifies the target destination of the list to be generated: Printer or File 
(.ALS). You can select Printer to send the list to the printer, or File (.ALS) to save the list in 
a file with the extension .ALS. For File (.ALS), specify the name of the file without the 
extension. The file will be located in the application directory specified in the Set Default 
Paths dialog box. 
After you complete the dialog box and activate the OK button, an alarm list will be 
generated according to the filter you specified. 

 
 

 
 

   

 
 

 
 
 

Exporting Alarm Definition Files Using an External Application  
If you are using an external application you can export alarm definition files using the 
command line. 
Note:     WizPro must not be running during this operation.  

o To convert an alarm definition file to CSV format: 
Type the following in the command line:  
als2csv [fromfile] [tofile]  
 

 
 

 
 

   

Importing Alarms 
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Importing Alarms 
The Import Alarms option enables you to import alarm definitions from an ASCII file. You 
can use the imported ASCII file to replace the current list with the generated one, or 
append it to the current list of alarms. 

o To import alarm definitions: 
In the All Containers section of the Application Studio, right-click Alarms and select Import 
Alarms from the popup menu. The Open Alarm file for Import dialog box opens on your 
screen. 

 
1.    In the Files of type field, select the type of file you want to import. You can choose 
between CSV and ALS. Locate the file you want to import and click Open. The Import 
Mode dialog box is displayed. 

 
2.    Click Replace to replace the alarms in the alarm list with the imported alarm, Append 
to add the specified alarm to the alarm list, or Cancel to cancel the import. 
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Import Alarms 
This option is used to import an Alarm List file into the system. 
1. From the Tools menu of the Application Studio, select Import and then Alarms. The 
Open Alarm file for Import dialog is displayed.  
2. In the Files of type field, select the type of file you want to import. You can choose 
between CSV and ALS. Locate the file you want to import and click Open. The Import 
Mode dialog is displayed. 
3. Click Replace to replace the alarms in the alarm list with the imported alarm, Append to 
add the specified alarm to the alarm list, or Cancel to cancel the import. 

 
 

 

 
   
 
 
 
 

Importing Alarm Definition Files Using an External Application  
If you are using an external application you can import alarm definition files using the 
command line. 
Note:    WizPro must not be running during this operation.  

o To convert a CSV file to an alarm definition file: 
Type the following in the command line:  
csv2als [fromfile] [tofile] 
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Alarm Properties 

 
 
 
 
 

Alarm Properties 
This section describes how to define alarm properties also for predefined alarms. 

o To define alarm properties: 
In the All Containers section of the Application Studio, right click Alarms and select then 
Properties. The Alarms Properties dialog box opens.  
 

 
 
This dialog box has the following tabs: 

o     General - where the message that appears when a user logs in and out is 
defined. This message can by default be acknowledged and ended and be viewed 
in the Events Summary and History. Alarms can also be ended by the user by 
using the User Defined status feature. 

o     Time Format - where the time and date format of the message is defined.  
o     Hotbackup - used when an application that has master backup is run.  
o     Network Communication Error - used during network communications failure. 
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o     VPI Communication Error - used during communication failure between the 
application and communication drivers. 

o     User Login - defines how and where an alarm issued during user login/logout is 
written to.  

o     Diskfull - defines when and how an alarm is sent when the computer disk is 
xxx% full.  

o     Recipe - used during recipe errors on loading. 
o     Tag Lock - defines that a tag is locked when an alarm is issued. 
o     Communication error with remote ODBC database - used during 

communication error with ODBC database centralizing the historical data. 
 

 
 

 
 

   

 
 

 
 
 

Specifying a Login/Logout Message 
You can specify a message that will appear when a user logs in and logs out in the 
General tab of the Alarms Properties dialog box.  
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The following options are available: 

Avoid generating alarms using tag 
set values on system startup 

When this is checked no alarms using tag set 
values are generated during system startup. 

Login Alarm Text Specifies the text you want to appear when a user 
logs in. This change can be implemented online. 

Logout Alarm Text Specifies the text you want to appear when a user 
logs out. This change can be implemented online. 

Allow user defined status 
This feature is optional. Names are limited to hold 
up to 20 characters. Check this option to enable the 
user to define alarm states.  
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Status names 

This feature is optional. Alarm states are given in 
the States.dat file in the application's directory. 
When the application is loaded this file is read and 
information in it is used where applicable. Status 
names are local and therefore are not transferred to 
other stations. Alarm messages, however are 
transferred to other stations where they can be 
handled. You can move an alarm to another user-
defined status only if it has not already been 
acknowledged. However, if the alarm has been 
moved to another status it cannot be moved back to 
its previous status. If the user has already been 
authorized to acknowledge an alarm further 
authorization is not required where alarm status 
appear. 

Note:     If no names are defined then the default names AlarmStatus0 and AlarmStatus1 
are given. If in the Alarm Properties dialog box Allow User Defined Status is not checked 
then none of these column options are available. The default status names are language 
dependant.  

o To define alarm status names: 
1.    In the Alarm Properties General Tab click the Status Names button to open the Alarm 
Status Names dialog box. 

  
 
2.    Type in the name of the alarm states in the 0 and 1 fields. 
3.    Click OK to save these definitions. 
The new alarm status names appear in the Event Summary Columns dialog box where 
they can be selected and added as new columns to the Event Summaries. The status 
timestamp and user's name are also logged into the history file when an alarm is logged. 
Alarms can be assigned to a status by the user either in the Events Summary or Image 
(see Chapter 20, Introduction to the Image Module) modules. 
Note:     When status names are not defined the default names Alarm Status0 user 
AlarmStatus0 time and AlarmStatus1 user AlarmStatus1 time are used by default.  
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Determining a Time Format  
You can choose between four different alarm time formats to determine the time format 
that will appear in the Events Summary and the Alarm printout, in the Time Format tab of 
the Alarm Properties dialog box. 
 

 
 
The following options are available: 

Day + Time    Displays a time format of month, time. 

Day + Time + 
MilliSeconds 

Displays a time format of month, time plus 
milliseconds. 

Date + 
Time    Displays the full date and time. 

Date + Time 
+ 
MilliSeconds 

Displays the full date and time plus milliseconds. 

Note:     Restart the application for changes to take effect. 
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Determining Hotbackup 
This is a system filter used when an application that has master backup running. 
 

 
 
Note:     Restart the application for changes to take effect. 
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Determining Network Communications Errors 
This is a system filter that highlights network communications failure.  
 

 
 
 

 
 

 
 

   

 
 

 
 
 

Determining VPI Communication Errors 
This is a system filter used to inform about communication driver errors. 
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Determining User Login Parameters 
This is a system filter used to define how and where an alarm issued during user 
login/logout is written to. 
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Determining Diskfull 
This is a system filter that defines when and how an alarm is sent when the computer disk 
is xxx% full.  
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Determining Recipe 
This system filter defines when and how an alarm is sent when an error occurs on the 
command RLOAD used in Wizcon Language or on macros. 
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Determining Tag Lock 
This dialog box is used to define the alarm occurring when a tag is locked.  
The default values (2) for Zone and Severity are assigned. A default family name (Taglock) 
is assigned. 
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Determining Remote ODBC communication error 
This dialog defines the alarm displayed when the remote ODBC database, used for 
historical data logging, is in communication error.  
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The parameters of the alarms are tunable however the following parameters are default: 

o     System Wide 
o     Auto Acknowledge 
o     Record to File 
o     Default Printer  

Alarm text always holds the specific locked tag's name. After the tag is unlocked the alarm 
ends. 
In addition, those alarms can be sent to Users and Groups thanks to the AAM module. For 
detailed setting, see Action on Alarm. 
 
 

 
 

 
 

   

 
 

 
 
 

Determining Illegal Login Attempts 
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This dialog box is used to define the alarm occurring when a user tries but fails to login.  
  

 
  
  

 
 

 
 

   
 
 
 
 

Determining Illegal Shutdowns 
This dialog box is used to define the alarm occurring when the application closes down for 
an unknown reason (for example, a crash). 
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Finding Alarms  

The application enables you to locate alarms in the List of Alarms in the Application Studio. 
This is especially useful if you have an application with many alarms. 

o To locate an alarm: 
1.   Click anywhere in the List of Alarms and select Find from the Tools menu. The Find 
Alarm dialog box is displayed: 
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2.   Enter the alarm text in the Alarm Text field.  
3.   Enter the alarm family in the Family field.  
4.   Select the condition(s) by which you want to conduct the search in the Conditions area. 
You can choose between Alarm Text, Family name or Both. 
5.   Click Find. The alarm is located in the List of Alarms. 
6.   Click Exit or anywhere in the Application Studio outside the List of Alarms to close the 
dialog box.  
Note:    The Alarms List can also be opened using the filter option in the Application Studio. 
  

 
 

 

 
   
 
 
 
 

Find Alarm 

In this dialog box, you can enter a value for any of the fields (a value for each field is not 
necessary) to activate a search.  
  
1. 1. In the Tag Name field, specify the name, or partial name, of the tag associated with 
the alarm you want to find. The characters that you enter will be the prefix of the name for 
which the application will search.  
1. 2. In the Family field, specify the family name, or partial family name (assigned to the 
alarm when it was defined), of the alarm you want to find. The characters that you enter will 
be the prefix of the family for which the Application will search.  
1. 3. In the Text field, specify the text, or any part of the text, of the alarm you want to find.  
1. 4. To begin the search, activate the Find button. A search will then begin for an alarm 
with the attributes you specified. If an alarm that meets your filter requirements is found, it 
will be highlighted in the alarm list.  
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Alarms on the Network     

When an alarm is generated in the active station, the active station informs the passive 
station that an alarm started. The information includes all the information which is needed 
to start the same alarm on the backup station. 
 
When the passive station after receiving notification from the active station then starts the 
alarm using an internal API similar to Application Start Alarm. 
Further changes to the alarm performed in the active station are passed to the backup 
station using the alarm ID and the event that occurred. (Ack/End/Class/Text changed). 
 
When a request to start/ack/end an alarm on the passive station is made, the passive 
station routes the request to the active station. The passive station will show the result of 
the request after it receives the notification from the active station. 
 
When the passive station starts it requests the status of all active alarms at the master 
station, builds the an Alarm id on active station to the Alarm id on passive station 
translation table and bringa the passive station to the same status. 
 
Failure Detection and Reaction 
In automatic switch backup mode the master station periodically checks the connection 
with the master station. The frequency of the check is user defined. To fine-tune your 
network go to the Utilities menu Tuning Parameters.  
 
In case of communication test failure with the master station or in case the backup station 
was switched to active mode (in manual switch backup mode), the backup station 
broadcasts a backup is active message to the network. 
 
When the remote stations receive the message they: 

• Update their internal stations database with the information that the master station 
is now replaced by the backup station. 

• Disconnect the session with the master station. 
• Reconnect to the backup station. 

If the local station was a client of alarms of tags on the master station it re-registers as a 
client for the alarms and the tags at the backup station. 
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Other Topics 

 
 
 
 
 

Design / Add Object / Alarms  
Select this item to define Alarms.  
 
In the application an alarm is an internal message that provides the operator with 
information concerning events that occur in the field, or that are generated by the system.  
 
Application alarms are generated whenever predefined conditions are true. These 
conditions can only be defined by the System Engineer.  
 
After you select the Alarms item, the Alarm Definition dialog box will appear for you to 
define different alarm characteristics and properties, such as condition, target, severity, 
and others. Once defined, alarms will be displayed once per event in the system events 
summary or pop-up  
events summary.  
 
In addition, to provide the operator with on-line help for alarms (such as operational 
instructions), alarm messages can be linked to the Help Files. These are ASCII files that 
you can create using any text editor. The files can contain any text you want, but the 
extension must be AHP.  
 

 
 

 
 

   

 
 
 

 
 

Used to select an alarm user class from a list of predefined classes. Each alarm can be 
assigned only one class. 
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Alarm has been acknowledged 
 
 

 

 
   
 
 
 
 

Alarm Cluster Definition 
In the Define Cluster dialog box, click the Tags or Alarms button. A new tag/alarm with the 
modified original tag/alarm definition will be generated during cluster instantination in the 
image. The Tag Definition dialog box is displayed. Only tags/alarms that are associated 
with the cluster objects will appear in the tags/alarms list and only the Change button is 
enabled.  
1. 1. Click the Change button to open the Tag/Alarm Specification dialog box. 
2. 2. Complete the fields in this dialog box according to instructions in the Tags and Alarms 
chapters.  
Note: You can also access this dialog by double-clicking on a line in the list. 

 
 

 

 
   
 
 
 
 

A logical expression or bit value that represents the condition in the alarm statement. 
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Alarm Condition Statement     
In the Alarm Condition field, enter the required expression, or right-click and select one of 
the options (described in the Alarm Condition Options section below) from the popup 
menu.  
Expressions are displayed in the Alarm Condition field in different colors, according to the 
expression type.  
Red for errors 
Black for operations 
Blue for tag names 
Alarm Condition Options 
The Alarm Condition options consist of a list of tags, operators and functions from which 
you can build an expression.  
When Tag is selected, a field box with an arrow is added to the Alarm Condition field. 
Click the arrow to the right of the field to display a dropdown list of available tags and 
select the required tag. 
You can only add one tag at a time to the Alarm Condition field. Clicking anywhere in the 
Alarm Condition field removes the tag field box and enters the tag into the expression. 
You can also enter tags manually by first entering a @ and then the required tag name. 
Numeric Operator 
Selecting Numeric Operator displays the following options: 
Option Description     

+ plus     

- minus     

= equal     

/ backslash     

% percentage     
 Relational Operators 
Selecting Relational Operators displays the following options: 
Option Description     

= = Equal     

!= Not equal     

<= Less than equal     

>= More than equal     

< Less than      

> Greater than     
  
Logical Operator 
Selecting Logical Operator displays the following options: 
Option Description     
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AND Combines two conditions logically.     

OR Combines two conditions logically.     

NOT Negates the condition that follows it.     
Function 
Selecting Function displays the following options: 
Option Description   

Log Calculates base 10 logarithm. Syntax LOG  
(expression) expression>0. 

  

Ln Calculates natural logarithm. Syntax LN(expression) 
where expression > 0. 

  

Root Calculates square root. Syntax ROOT(expression)  
expression>= 0 returns the square-root of x. 

  

Min Calculates minimum. Syntax MIN(x,y) where both x  
and y are expressions returns the minimum out of the  
two parameters. 

  

Max Calculates maximum. Syntax MAX(x,y) where both 
x and y are expressions returns the maximum out of 
the two parameters. 

  

Power Calculates power. Syntax POWER(x, y) where both 
x and y are expressions returns the value of xy. 

  

Sign Calculates the sign. Syntax SIGN (expression) return 
–1 if expression<0 and 1 if expression >=0. 

  

Floor Calculates the floor. Syntax FLOOR(expression)  
return, returns a floating-point value representing the 
largest integer that is less than or equal to expression. 

  

Bit Calculates a bit. Syntax BIT(B,I) return the bit B  
value from the I integer value. Returns 1 if the bit B is set and 0 if 
the bit is reset. 

  

Abs Calculates absolute value. Syntax Abs (expression)  
returns the absolute value of expression.  

  

Sin Calculates sine. Syntax: SIN (expression) expression  
angle in radians. 

  

Cos Calculates cosine. Syntax: COS(expression)  
expression angle in radians. 

  

Tan Calculates tangent. Syntax: TAN(expression)  
expression angle in radians. 

  

Bit Operator 
Selecting Bit Operator displays the following options: 
Option Description     

OR Combines two conditions logically.     

AND Combines two conditions logically.     

XOR Exclusive OR.     

NOT Negates the condition that follows.     
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Alarm Condition 
Expressions are displayed in the Alarm Condition field in different colors and according to 
their expression type.  
Red for errors 
Black for operations 
Blue for correct tag names 
Olive green for functions 
Alarm Condition options consist of a list of tags, operators and functions from which you 
can build an expression.  
Tag when selected a field box with an arrow is added to the Alarm Condition field. 
The Alarm Condition field is divided into two when the Tag (right click on the field) option is 
selected from the popup menu. The upper field enables selection of the Station Name 
whereas the lower field enables selection of a tag from this station’s tag list. 
 
Clicking the arrow to the right of the field displays a dropdown list of available tags from 
which you can select the required tag. Only one tag can be added at a time to the Alarm 
Condition field. Clicking anywhere in the Alarm Condition field removes the tag field box 
and enters the tag into the expression. Tags can be written manually by first entering a @ 
and then the required tag name. 
Numeric Operator – when selected displays the following options: 
Option Description 

+ plus 

- minus 

= equal 

/ backslash 

% percentage 
  
Relational Operators – when selected displays the following options: 
Option Description 

= = Equal 

!= Not equal 

<= Less than equal 

>= More than equal 

< Less than  
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> Greater than 
  
Logical Operator when selected displays the following options 
Option Description 

AND Combines two conditions logically. 

OR Combines two conditions logically. 

NOT Negates the condition that follows it. 
  
Function - when selected displays the following options: 

Function Syntax Description 

Log LOG(expression) 
where expression > 0 

Calculates base 10 logarithm.  

Ln LN(expression) where 
expression > 0 

Calculates natural logarithm. 

Root ROOT(expression) 
expression>= 0 

Calculates square root. 

Min MIN(x,y) 
where both x and y are 
expressions. 

Returns the minimum out of the two 
parameters. 

Max MAX(x,y) 
where both x and y are 
expressions. 

Returns the maximum out of the two 
parameters. 

Power POWER(x, y) 
where both x and y are 
expressions. 

Returns the value of xy. 

Sign SIGN(expression) Calculates the sign. Returns –1 if 
expression<0 and 1 if expression >=0. 

Floor FLOOR(expression) Calculates the floor. Returns a floating-
point value representing the largest 
integer that is less than or equal to 
expression. 

Bit BIT(B,@tagname) 
where B is bit number 
and @tagname is a tag 
value 
  

Alarm is on when BIT is true value="1" 

Abs Abs (expression) Calculates absolute value. Returns the 
absolute value of expression. 

Sin SIN(expression) 
where expression angle 
is in radians. 

Calculates sine. 

Cos COS(expression) 
where expression angle 
is in radians 

Calculates cosine. 

Tan TAN(expression) 
where expression angle 
is in radians. 

Calculates tangent. 

ROC   Process values that change too quickly. If 
a process value fluctuates by more than 
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the rate of change limit in the given time 
interval, the tag generates the alarm. The 
rate is given in percentage per unit of 
time. 

Deviation (%)   Process values that change from the 
optimum value. Deviation alarms require 
a definition of a target value and range. If 
the process value exceeds the range, a 
deviation alarm occurs. For example, if 
the optimum value is 100 and the range 
(deadband) is +/-5 the process can vary 
from 95 to 105 without generating an 
alarm. The deadband is given by 
percentage of the value. 

Deviation_F (Fixed)   Process values that change from the 
optimum value. Deviation alarms require 
a definition of a target value and range. If 
the process value exceeds the range, a 
deviation alarm occurs. For example, if 
the optimum value is 100 and the range 
(deadband) is +/-5 the process can vary 
from 95 to 105 without generating an 
alarm. The deadband is given by a 
constant value of the value. 

  
Bit Operator – when selected displays the following options: 
Option Description 

OR Combines two conditions logically. 

AND Combines two conditions logically. 

XOR Exclusive OR. 

NOT Negates the condition that follows. 
 
 

 

 
   
 
 
 
 

Press this button to enter the browser dialog box which enables you to choose and locate 
the AHP file name  

 
 

 
 



Chapter 15 Alarms 

516 

   
 
 
 
 

Alarms can be limited to a single station or distributed among several Application stations. 
Alarms are distributed to several stations using Application network support facilities. By 
default the alarm appears only on the station used by the operator. 

 
 

 

 
   
 
 
 
 

Used to specify a tag for which the alarm is to be issued. 
 
 

 

 
   
 
 
 
 

To test the alarm condition, select the Value field 
 
 

 

 
   
 
 
 
 

Used to define a logical operator or bit value that represents the condition in the alarm 
statement.  
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Alarms Definition      
Alarms are defined in the Application Studio. After defining an alarm, you can assign a 
name to alarm classes, as described below. 
Click the Alarms icon in the Application Studio toolbar 
Or,  
In the All Containers pane of the Application Studio, right-click Alarms and then select Add 
Alarm from the popup menu. The Alarm Definition dialog box opens.  
This dialog box has two tabs: 
General - where general alarm properties such as Alarm Condition, Alarm Text, Zone, 
Family, Target, Attributes and Delay are defined.  
Action on Alarm - where actions such as, Go to Zone, Execute Macro on Alarm and AAM 
Configuration are defined. 
General Tab  
This tab is used to define general alarm properties. 
Alarm Condition  This field defines the alarm conditions. 
Alarm Text  This field when completed shows a description of the alarm. An alarm 
message can include tokens. 
Family Specifies the name of the group to which the alarm belongs. The name can consist 
of up to 64 characters and is the link to alarm objects. It is also used for classification and 
filtering. 
Help File Specifies the name of the Help file that contains information for the operator. For 
more details about creating alarm help files, refer to the section on Alarm Help Files. 
Zone You can enter a zone area from 0 to 50,000. This value is used to classify and filter 
alarms in the Events Summary and application popup windows.  
Severity Specifies the priority order of each alarm. For example, a low priority could be 0 
and a high priority, 50,000). It is also used for classification and filtering. 
User Fields These are customized fields that are defined by the user according to their 
specific requirements. User fields enable additional alarm filtering. There are five User 
Fields. 
Groups This option is used to assign authorized users and groups of users to the alarm. 
Alarm recipients can handle the alarm according to user authorization. 
Inhibition by Tag  Inhibit if a specific tag receives a specific value. 
Inhibit Immediate This checkbox when checked means inhibit this alarm immediately. 
Targets Specifies the alarm destination. The following options are available:  
Default Printer: The alarm message is sent to the printer defined as the alarms printer. 
Events Summary: The alarm is displayed in the Events Summary. 
Popup: The alarm is displayed in a Popup window. 
Popup buzz: The alarm is displayed in a Popup Events Summary that will buzz when the 
alarm is displayed. If you do not select this option, the Popup Events Summary will not 
buzz when the alarm is displayed even if it was defined to do so in the PopUp Buzz dialog 
box. 
User class: Enables you to identify an alarm and to classify it online and in historical 
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Events Summaries. Select this option and click on the arrow on the right of the field to 
select an alarm user class from a drop-down list of predefined classes. Each alarm can be 
assigned only one class. 
Attributes The alarm operational attributes include the following: 
System Wide: Alarms can be limited to a single station or distributed among several 
application stations using application network support facilities.  
If this option is selected, the alarm will be distributed to other stations in the network. It can 
be acknowledged from any station across the network. By default, alarms appear only on 
the station used by the operator. 
Auto Acknowledge: The system automatically acknowledges alarms (as they occur) as if 
already acknowledged by the operator. 
Auto END: The system automatically ends alarms (after they occur) as if the condition that 
caused the alarm to be generated has already terminated. 
Class at Acknowledge: Enables you to re-assign a User Class property to the alarm when 
the alarm is acknowledged. This means that you can change the routing of an alarm upon 
its acknowledgment. 
Record to File: Records the alarm in the alarm’s history file. 
Discard: Discards active alarms when the application is terminated. 
Exclude from Printing: If this option is selected the alarm will not be printed. 
Auto Print AHP File: Help files with the AHP suffix can also be printed. A help file in 
HTML format is printed manually according to user demand. An alarm line and its AHP file 
are printed as a set where the AHP file appears directly under the alarm. When working in 
a network configuration and an alarm with an AHP file attached is sent to another station 
this alarm will be printed in the far station only when the AHP file is located in the far 
station. 
Note: If an alarm is defined with both the Auto Acknowledged and Auto End options, it will 
be considered inactive and will not be displayed in the Events Summary. 
Delay Delay intervals can be defined during which time alarms will not be generated. 
There are three options defining when the alarm will be reset: 
 Condition is false: Alarms will not be generated when the alarm condition is false (within 
the time delay). 
 Delay time ends: If the alarm condition is True, at the end of the defined time delay 
alarms will be generated. This is without taking into consideration changes in alarm status 
during the delay period. 
 Never: The delay feature will not be imposed.  
Note: The default is Never. 

Alarms Overview  
 
 

 

 
   
 
 
 
 

Alarm has been terminated. 
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Alarm Export   
The Export Alarms option enables you to generate a list of alarms in ASCII or CSV format 
and send the list to the printer or a file. The generated list can also be filtered to include 
only specific alarms. Alarm lists can be generated and then edited using a text editor. Once 
generated, the list can be printed for project documentation. This is useful in large projects, 
where thousands of alarms must be defined. In this case, working with a text editor is 
faster than defining each alarm separately. 
In the All Containers section of the Application Studio, right-click Alarms and select Export 
Alarms from the popup menu. The Alarm List dialog appears: 
The dialog box contains filter options that you can select to determine which alarms will 
appear in the list that you want to generate. Each filter field is optional (except for the 
filename in the List Target field, which must be specified if you select the File option). 
The following options are available: 
No. Specifies the range of numbers of the alarms that you want to appear in the generated 
list. 
Tag Name Specifies the name, or name prefix range of the tags associated with the 
alarms that you want to appear in the generated list. 
Family Specifies the name or prefix of the family to which the alarm belongs that you want 
to appear in the generated list. 
Severity The severity range of the alarms that you want to appear in the generated list. 
Zone The zone range of the alarms that you want to appear in the generated list. 
Targets The target specifications of the alarms that you want to appear in the generated 
list (any, none, or all can be selected). 
User Class Activate this button to select classes to filter the alarms that will appear in the 
generated list. After you activate this button, the Set User Class dialog box appears: 
You can select one or more classes, so that only the alarms that belong to the classes will 
appear in the generated list. Activate the Set All button to select all the classes. Activate 
the Reset All button to deselect all the classes.  
Attributes The attribute specifications of the alarms that you want to appear in the 
generated list. You may select any attribute, all of the attributes, or none at all.  
List Target  Specifies the target destination of the list to be generated: Printer or File 
(.ALS). You can select Printer to send the list to the printer, or File (.ALS) to save the list in 
a file with the extension .ALS. For File (.ALS), specify the name of the file without the 
extension. The file will be located in the application directory specified in the Set Default 
Paths dialog box. 
After you complete the dialog box and activate the OK button, an alarm list will be 
generated according to the filter you specified. 
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Alarm Modify 
This option enables you to Modify the alarm definition. 
To modify the alarms definition: 
1. Select an alarm from the List alarms 
2. Right Click the alarm and select the Modify option from the pop-up menu. 
  
OR 
  
Double click a selected alarm. 

 
 

 
 

   
 
 
 
 

Check this button if you don't wish an Alarm to keep on generating on the screen. 
 
 

 

 
   
 
 
 
 

The text you insert will be printed at the system insertion. 
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The message you insert will be printed at system departure. 
 
 

 

 
   
 
 
 
 

This parameter contains the escape sequence sent to printer before each alarm. In this line 
you can type a value that will represents an ASCII escape code used to instruct your 
printer to condense the alarm text. 

 
 

 

 
   
 
 
 
 

If you check this option the alarms will be printed in two lines. The first line will contain the 
WIZPRO title, time stamp, etc. The second line will contain the alarm text. 

 
 

 

 
   
 
 
 
 

Use this option to select between four different alarm time formats for the Alarm printer. 
The possible options are: 
Day+Time Day in month and time 
Date+Time Full date and time. 
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Date+Time +Milliseconds Full date plus Time plus Milliseconds 
Day+Time+Milliseconds Day in month plus Time plus Milliseconds. 

 
 

 
 

   
 
 
 
 

Alarm Properties Hotbackup Tab 
  
This is a system filter used when an application that has master backup is run.  
Note: Restart for changes to take effect. 

 
 

 

 
   
 
 
 
 

Alarm Properties Diskfull Tab 
This is a system filter that defines when and how an alarm is sent when the computer disk 
is xxx full.  

 
 

 
 

   

 
 
 

 
 

Alarm Properties Network Communication Error Tab 
This is a system filter that defines backup during network communications failure.  
  
The VPI Communication Errors tab is a system filter used to communicate with other 
drivers.  
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Alarm Properties - ODBC communication errors 
When you define a tag, you can choose to write the tag history to an ODBC data source. 
This dialog box allows you to define the properties of an alarm that is issued when a 
communication error occurs with this data source.  
Note that when the communication error occurs, tag history will be logged to a sub folder in 
the application folder, when the communication is restored, the ODBC database will be 
updated with the data that was missed. 

 
 

 

 
   
 
 
 
 

Alarm Properties Tag Lock Tab 
This dialog box is used to define that a tag is locked when an alarm is issued.  
The default values (2) for Zone and Severity are assigned. A default family name (Taglock) 
is assigned. 
The parameters of the alarm are tuneable however the following parameters are default: 
System Wide 
Auto Acknowledge 
Record to File 
Default Printer  
Alarm text always holds the specific locked tag’s name. After the tag is unlocked the alarm 
ends. 
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Alarm Properties User Login Tab 
This is a system filter used to define how and where an alarm issued during user 
login/logout is written to. 

 
 

 

 
   
 
 
 
 

Alarm Properties VPI Communication Error Tab 
This is a system filter used to communicate with other drivers.  

 
 

 

 
   
 
 
 
 

Alarm Property 
Use this option to define the Alarm tuning parameters. 

 
 

 

 
   
 
 
 
 

The alarm operational attribute include the following: 
  
System Wide Alarms can be limited to a single station or distributed among several 
application stations. Alarms are distributed to several stations using application network 
support facilities. By default the alarm appears only on the station used by the operator. 
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Auto ACK If this option is selected, alarms will be issued as if already acknowledged by 
the operator. 
  
Auto END If This option is selected, alarms will be issued as if the condition that caused 
the alarm to be generated was already terminated. 
  
Discard If this option is selected, active alarms will be discarded when the application is 
terminated. 
  
Class at ACK If this option is selected, it will be possible to re assign a User Class 
property to the alarm when the alarm is acknowledged. 
  
This means that you can use this option to change the routing of an alarm upon it 
acknowledgement. 
  
Record to file If this option is selected, the alarm will be recorded in the alarm history file. 

 
 

 
 

   
 
 
 
 

This option enables you to choose the alarm destination (printer, events summary, pop-up 
events summary...) 

 
 

 

 
   
 
 
 
 

Insert the name of the family to which the alarm belongs.  
 
 

 
 

   



Chapter 15 Alarms 

526 

 
 
 
 
 

Insert the name of the file that contains alarm help information for the operator 
 
 

 
 

   
 
 
 
 

Insert the Alarm severity level from 0 (lowest level) to 50,000(highest level). The severity 
level value is used to determine the priority order of each alarm. 

 
 

 

 
   
 
 
 
 

Insert the alarm message, which can include token. 
 
 

 

 
   
 
 
 
 

A Zone is a specific area in an application image marked for navigational purposes. Once 
defined zones can be used in go to and macro operations, to cause specific image 
sections to dill the image area of the window immediately. 
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Zones are defined by selecting the Zones definition item from the Options menu in the 
image window. 
Insert the Alarm zone number from 0 to 50,000. This value is used to classify and filter 
alarms events summary windows and application pop-up windows. 

 
 

 
 

   
 
 
 
 

Alarm has been started. 
 
 

 

 
   
 
 
 
 

Alarm Status Names 
This optional feature is used to define the name of the alarm status. Names can hold up to 
20 characters. When status names are not defined the default names ALARMSTATUS 0 
and ALARMSTATUS1 are used by default.  

 
 

 

 
   
 
 
 
 

Alarm Text 
  
The alarm text can include the following tokens:  
@tagname Replaces @tagname with the current tag value when the alarm is started. 
@!tagname Replaces @!tagname with the value of the tag that is force read from the PLC 
when the alarm is started. 



Chapter 15 Alarms 

528 

@#tagname Replaces @#tagname with the value retrieved from the block to which the tag 
belongs, if the block is fresh. If the tag does not belong to a block, the @# control will 
function the same as @!. 
Note: The above three tagname tokens must be typed in lower case letters. Otherwise the 
system will not recognize them. 
$TIME The current time in Hours.Minutes.Seconds format. The value range is from 
00.00.00 to 23.59.59. 
$DATE The current date in Day.Month.Year format. The value range is from 01.01.00 to 
31.12.99. 
$HOUR The current hour. The value range is from 0 to 23. 
$MINUTE The current minute. The value range is from 0 to 59. 
$SECOND The current second. The value range is from 0 to 59. 
$DAY The current day. The value range is from 1 to 31. 
$MONTH The current month. The value range is from 1 to 12. 
$YEAR The current year. The value range is from 00 to 99. 
$WEEKDAY The current day of the week. The value range is from 1 to 7, where 1 is 
Sunday and 7 is Saturday. 
$OPERATOR The current operator name. The value is a string that represents the 
operator name. 
$GROUP The groups associated with the current operator. 
$INTIME The number of minutes that passed since midnight. The value is used for tag 
comparison and definition. The value range is from 1 to 1439. 
$INDATE The number of days that passed since January 1, 1980. The value is used for 
tag comparison and definition. The value range is from 0 and on. 

 
 

 

 
   
 
 
 
 

Alarm Token     
Used as defined signs to be used in the Alarm text. 
  
The Alarm text can include the following tokens: 
@tagname Replaces @tagname with the current tag value when the alarm is started. 
@!tagname Replace @!tagname with the value of the tag that is force read from the PLC 
when the alarms is started. 
@#tagname Replaces @#tagname with the value retrieved from the block to which the tag 
belongs, if the block is fresh. If the tag does not belong to a block, the @# control will 
function the same as @!. 
$TIME The current time in Hours.Minutes.Seconds format.  
$DATE The current data in Day.Month.Year format.  
$HOUR The current hour. 
$MINUTE The current minute. 
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$SECOND The current second. 
$DAY The current day. 
$MONTH The current month. 
$YEAR The current year. 
$WEEKDAY The current day of the week. 
$OPERATOR The current operator name. The value is a string that represents the 
operator. 
$GROUP The groups associated with the current operator. 
$INTIME The number of minutes that passed since midnight. 
$INDATE The number of days that passed since January 1, 1980. 

 
 

 
 

   
 
 
 
 

Alarm User Fields 
These are customized fields that are defined by the user in the Alarms Definition dialog box 
according to their specific requirements. User fields enable additional alarm filtering. There 
are five User Fields available. User Field names can also be modified in the Application 
and in the alarm report definition dialog box. 

 
 

 
 

   

 
 
 

 
 

The Alarm Viewer is an application module used to display online and historical alarms. 
Several operations (such as acknowledge) can be performed on the alarms displayed in 
the events summary. Events Summary appears in the events summary window, which are 
invoked by selecting the Events Summary item form the Studio Menu. In addition to the 
events summary window, a pop-up events summary can also be defined to appear on 
the screen immediately, whenever severe alarms occur. 
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Alarms on the Network     
When an alarm is generated in the active station, the active station informs the passive 
station that an alarm started. The information includes all the information which is needed 
to start the same alarm on the backup station. 
 
When the passive station after receiving notification from the active station then starts the 
alarm using an internal API similar to Application Start Alarm. 
Further changes to the alarm performed in the active station are passed to the backup 
station using the alarm ID and the event that occurred. (Ack/End/Class/Text changed). 
 
When a request to start/ack/end an alarm on the passive station is made, the passive 
station routes the request to the active station. The passive station will show the result of 
the request after it receives the notification from the active station. 
 
When the passive station starts it requests the status of all active alarms at the master 
station, builds the an Alarm id on active station to the Alarm id on passive station 
translation table and bringa the passive station to the same status. 
 
Failure Detection and Reaction 
In automatic switch backup mode the master station periodically checks the connection 
with the master station. The frequency of the check is user defined. To fine-tune your 
network go to the Utilities menu Tuning Parameters.  
 
In case of communication test failure with the master station or in case the backup station 
was switched to active mode (in manual switch backup mode), the backup station 
broadcasts a backup is active message to the network. 
 
When the remote stations receive the message they: 

• Update their internal stations database with the information that the master station 
is now replaced by the backup station. 

• Disconnect the session with the master station. 
• Reconnect to the backup station. 

If the local station was a client of alarms of tags on the master station it re-registers as a 
client for the alarms and the tags at the backup station. 
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Alarms - Overview 
Alarms are application messages used to notify operators about exceptional conditions in 
the plant. Application alarms can be displayed in the Events Summary window or pop-up 
window. Using these windows, operators can examine and handle numerous alarms by 
filtering and sorting them. 
Alarms are generated whenever pre-defined conditions exist. Only the system engineer 
can define alarm conditions. 
To provide the operator with online help (such as operational instructions) when an alarm 
occurs, alarm messages can be linked to help files. 
A feature in the application enables you to associate image objects with alarms. Alarm 
objects in images react to the conditions of the alarm with which they are associated. 
Application alarms can be displayed in a hierarchical tree in which an alarm has a parent, 
child and sibling relations with other alarms. The alarm hierarchic tree is built up of Levels 
to which alarms can be attached. A level definition can override subordinate levels and 
alarms defined in these levels. 
  
Alarms and Levels can be initiated: 
1. 1. Through the Alarms Object located in the Containers tree. Right click the Alarms 
object (selection is observed by shading the chosen item blue).  
1. 2. Click the Add Alarm or Add Level option. 
  
Alarms can be added through the Design Menu 
1. 1. Click the Design Menu 
1. 2. Select Alarm from the Add Object menu. 
  
There are two ways to display a list of all the Alarm objects:  
1. 1. Click the Alarm object from the Containers tree. As a result a list of all Alarms is 
displayed. Each Alarm is described by the following parameters:Tag name, Condition, 
Text, Family, Zone and severity. 
OR 
1. 1. Click the Alarm object from the Containers tree 
1. 2. Move with the mouse to the List Zone area and press the right mouse button. 
1. 3. As a result the option of "Duplicate view" will be shown, choose this option. 
  
To set the order of fields to be displayed in the Events Summarys list: 
1. 1. Click the Events Summary file form the Containers tree 
1. 2. Move with the mouse to the List Zone area and press the right mouse button. 
1. 3. As a result the option of "View Setting" will show, choose this option and start the 
editing. 
  
Defining Alarms 
Defining Levels 
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If this option is selected, alarms will be issued as if already acknowledged by the operator. 
 
 

 

 
   
 
 
 
 

If This option is selected, alarms will be issued as if the condition that caused the alarm to 
be generated was already terminated. 

 
 

 

 
   
 
 
 
 

Auto Restart after an illegal shutdown 
  
Select this option if you want the application to automatically recover the last state after a 
crash (power failure, etc.). 
  
Default: No 
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If this option is selected, it will be possible to reassign a User Class property to the alarm 
when the alarm is acknowledged. 
This means that you can use this option to change the routing of an alarm upon it 
acknowledgement. 

 
 

 

 
   
 
 
 
 

Building an Application 
Building Applications 
To build an application follow the steps described below: 
Step 1. 
Install the application on your development station. 
It is recommended to install an application to a folder named Application located under 
the root of your drive. 
The Installation utility automatically initializes an empty Application project in the PROJECT 
directory under your main Application directory. 
Your web application folder for this application is at the DOCS folder under that directory 
(\ApplicationET\PROJECT\DOCS). 
Step 2 
Start Application Studio.  
Click the Windows Start button, and then select Programs, Application,  
Application application studio appears. 
Step 3 
Define Tags and Alarms. 
For help on how to define tags and alarms please see Application's on-line help.  
Step 4 
Optional, define Application Language program. 
Step 5 
Draw Images. 
Draw the graphical representation of your process by using the application's Image Editor. 
To create a new Image, select the Images folder on your Project tree. Right click in the List 
of Images and area and select New… For additional help on how to draw your image using 
the application’s Image editor and Cluster libraries please see Application's online help. 
When you Save your Image, each zone that you defined in the image is automatically 
saved in a separate file in Application Picture format (WNP extension), in your pictures' 
directory of your Web application. 
Pictures' file name is made from the image name concatenated with the zone name. 
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The current view is also saved as a Picture with the same name as the image name. The 
current zone and currently selected layer and scale designate this picture. 
Later, when you build your HTML file, you can select one of the pictures as the first to 
appear, by using the Visualizer. 
You can set web application directories through the Web Application properties by right 
clicking on the Web application folder in the studio tree. 

 
 

 
 

   
 
 
 
 

Design / Class Names    
Note: Not suuported on the Web. 
Select the Class Names item to assign class names for alarms. 
  
Class names are assigned to alarms for filter purposes.  
Any alarm class name you define, can be used later to filter alarms in the Events Summary 
or Pop-up Events Summary window.  
After you select this item, the Alarm User Class Names dialog box will appear for you to 
enter the class names.  

 
 

 
 

   

 
 
 

 
 

Cluster Alarm definition  
In this dialog box you can change the definition of existing alarms and generate and use 
filter alarm lists. 
  
List Export alarm definition into an ASCII file according to the specified filter. 
Change Changes the definition of an existing alarm. 
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Columns 
You can define which of the alarms content fields will be displayed in the Events Summary 
and in the Popup Event Summary windows. 
To define the alarm columns 
1. 1. Check the alarm columns you want to display. A check mark to the left of the field 
indicates that this field will be displayed. 
1. 2. The selected fields are displayed from left to right, meaning that the topmost field in 
this list will be displayed in the leftmost part of the window. 
1. 3. You can define the order in which the selected fields will be displayed: 
1. 4. Select the field you want to relocate. Click on the Move Up / Move Down buttons to 
place the selected field in the desired location. 
1. 5. To reset the columns to the default configuration, click the Default button. This will 
check the Start Time and the Zone fields only. 

 
 

 

 
   
 
 
 
 

Correct Syntax Errors 
This dialog box appears if you indicate that you want to correct an error that was detected 
in the alarm or tag list file.  
  
In this box, enter the correction to the error. For example, if the error is a non-existing tag 
or alarm, delete the tag or alarm and type a valid tag or alarm name in its place.  

 
 

 

 
   
 
 
 
 

Delete Alarm 
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This option enables you to delete the selected alarm.  
To delete an Alarm: 
1. Select (highlight) an alarm from the alarms list  
2. Click your mouse right button and choose the Delete option form the Pop up menu. 

 
 

 
 

   
 
 
 
 

If this option is selected, active alarms will be discarded when the application is terminated 
 
 

 

 
   
 
 
 
 

Export / Alarm 
Use this dialog box to set filter conditions so that only specific tags will appear in the 
generated tag list.  

 
 

 

 
   
 
 
 
 

Find Alarm 
In this dialog box, you can enter a value for any of the fields (a value for each field is not 
necessary) to activate a search.  
  
1. 1. In the Tag Name field, specify the name, or partial name, of the tag associated with 
the alarm you want to find. The characters that you enter will be the prefix of the name for 
which the application will search.  
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1. 2. In the Family field, specify the family name, or partial family name (assigned to the 
alarm when it was defined), of the alarm you want to find. The characters that you enter will 
be the prefix of the family for which the Application will search.  
1. 3. In the Text field, specify the text, or any part of the text, of the alarm you want to find.  
1. 4. To begin the search, activate the Find button. A search will then begin for an alarm 
with the attributes you specified. If an alarm that meets your filter requirements is found, it 
will be highlighted in the alarm list.  

 
 

 
 

   
 
 
 
 

Import Alarms 
This option is used to import an Alarm List file into the system. 
1. From the Tools menu of the Application Studio, select Import and then Alarms. The 
Open Alarm file for Import dialog is displayed.  
2. In the Files of type field, select the type of file you want to import. You can choose 
between CSV and ALS. Locate the file you want to import and click Open. The Import 
Mode dialog is displayed. 
3. Click Replace to replace the alarms in the alarm list with the imported alarm, Append to 
add the specified alarm to the alarm list, or Cancel to cancel the import. 

 
 

 

 
   
 
 
 
 

Alarm Properties General Tab    
This dialog box has the following tabs: 
General where the message that appears when a user logs in and out is defined. This 
message can by default be acknowledged and ended and be viewed in the Events 
Summary and History. Alarms can also be ended by the user by using the User Defined 
status feature. 
Time Format where the time and date format of the message is defined.  
Hotbackup used when an application that has master backup is run.  
Network Communications used during network communications failure. 
VPI Communication Error used during communication failure between the application 
and communication drivers. 
User Login defines how and where an alarm issued during user login/logout is written to.  
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Wil Diskfull defines when and how an alarm is sent when the computer disk is xxx full.  
Tag Lock defines that a tag is locked when an alarm is issued. 
  
The following options are available: 
Avoid generating alarms using tag set values on system startup  
When this is checked no alarms using tag set values are generated during system startup.  
Avoid generating new alarms  Specifies that logins and logouts are not logged. Restart 
the application for changes to take effect. 
Login Alarm Text Specifies the text you want to appear when a user logs in. This change 
can be implemented online. 
Logout Alarm Text  Specifies the text you want to appear when a user logs out. This 
change can be implemented online. 
Allow user defined status This feature is optional. Names are limited to hold up to 20 
characters. Check this option to enable the user to define alarm states.  
Status names This feature is optional. Alarm states are given in the States.dat file in the 
application’s directory. When the application is loaded this file is read and information in it 
is used where applicable. Status names are local and therefore are not transferred to other 
stations. Alarm messages, however are transferred to other stations where they can be 
handled. You can move an alarm to another user-defined status only if it has not already 
been acknowledged. However, if the alarm has been moved to another status it cannot be 
moved back to its previous status. If the user has already been authorized to acknowledge 
an alarm further authorization is not required wher alarm status appear. 
Notes: 
If no names are defined then the default names AlarmStatus0 and AlarmStatus1 are given. 
If in the Alarm Properties dialog box Allow User Defined Status is not checked then none of 
these column options are available.  
The default status names are language dependant.  

 
 

 
 

   

 
 
 

 
 

Alarm Properties Time format   
In this dialog box the user can define the Alarm time format. 
  
This page is used to select between four different alarm time formats for the Alarm printer. 
The possible options are: 
  
Day+Time - Day in month and time. 
  
Date+Time- Full date and time. 
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Date+Time +Milliseconds - Full date plus Time plus Milliseconds 
  
Day+Time+Milliseconds - Day in month plus Time plus Milliseconds. 
  
Note After defining the time format, make sure to restart the Application. 

 
 

 
 

   
 
 
 
 

Tools / Find / Alarm 
The application enables you to locate alarms in the List of Alarms in the Application Studio. 
This is especially useful if you have an application with many alarms. 
1. Click anywhere in the List of Alarms and select Find from the Tools menu. The Find 
Alarm dialog is displayed: 
2. Enter the alarm text in the Alarm Text field.  
3. Enter the alarm family in the Family field.  
4. Select the condition(s) by which you want to conduct the search in the Conditions area. 
You can choose between Alarm Text, Family name or Both. 
5. Click Find. The alarm is located in the List of Alarms. 
6. Click Exit or anywhere in the Application Studio outside the List of Alarms to close the 
dialog. 

 
 

 

 
   
 
 
 
 

The alarm severity level form 0 (lowest level) to 50,000 (highest level). The severity level 
value is used to determine the priority order of each alarm. 
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Levels Definition   
Alarms can be defined according to hierarchy. Each alarm can be defined at a different 
level in the hierarchical tree. Levels can be modified, added or deleted. Level definition 
contains most of the parameters used by alarm definition so that when one alarm level is 
defined and then modified its sub-levels also receive the same modifications. Alarm 
hierarchy is defined and viewed in the All Containers tree. 
To add a level: 
In the All Containers pane right click Alarms. From the dropdown menu select Add Level. 
The Alarm Level Definition dialog box opens. 
This dialog box has the following fields and options: 
Level Name Where the name of the level can be typed in. A level name can hold up to 235 
characters. 
Parent Level Full Name: This is the path of the alarm’s level and is automatically 
generated by the application. 
Family Specifies the name of the group to which the alarm belongs. The name can consist 
of up to 16 characters and is the link to alarm objects. It is also used for classification and 
filtering. 
Help File Specifies the name of the Help file that contains information for the operator. For 
more details about creating alarm help files, refer to the section on Alarm Help Files. 
Zone You can enter a zone area from 0 to 50,000. This value is used to classify and filter 
alarms in the Events Summary and application popup windows.  
Severity Specifies the priority order of each alarm. For example, a low priority could be 0 
and a high priority, 50,000). It is also used for classification and filtering. 
Groups This option is used to assign authorized users and groups of users to the alarm. 
Alarm recipients can handle the alarm according to user authorization. 
User Fields These are customized fields that are defined by the user according to their 
specific requirements. User fields enable additional alarm filtering. There are five User 
Fields. 
Targets Specifies the alarm destination. The following options are available:  
Default Printer: The alarm message is sent to the printer defined as the alarms printer. 
Events Summary: The alarm is displayed in the Events Summary. 
Popup: The alarm is displayed in a Popup window. 
Popup buzz: The alarm is displayed in a Popup Events Summary that will buzz when the 
alarm is displayed. If you do not select this option, the Popup Events Summary will not 
buzz when the alarm is displayed even if it was defined to do so in the PopUp Buzz dialog 
box. 
User class: Enables you to identify an alarm and to classify it online and in historical 
Events Summaries. Select this option and click on the arrow on the right of the field to 
select an alarm user class from a drop-down list of predefined classes. Each alarm can be 
assigned only one class. 
Attributes The alarm operational attributes include the following: 
System Wide: Alarms can be limited to a single station or distributed among several 
application stations using application network support facilities.  
If this option is selected, the alarm will be distributed to other stations in the network. It can 
be acknowledged from any station across the network. By default, alarms appear only on 
the station used by the operator. 
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Auto Acknowledge: The system automatically acknowledges alarms (as they occur) as if 
already acknowledged by the operator. 
Auto END: The system automatically ends alarms (after they occur) as if the condition that 
caused the alarm to be generated has already terminated. 
Class at Acknowledge: Enables you to re-assign a User Class property to the alarm when 
the alarm is acknowledged. This means that you can change the routing of an alarm upon 
its acknowledgment. 
Record to File: Records the alarm in the alarm’s history file. 
Discard: Discards active alarms when the application is terminated. 
Exclude from Printing: If this option is selected the alarm will not be printed. 
Inhibit: If this option is selected, the alarm will not be generated, even if the alarm 
conditions are true. This enables the operator to de-activate an alarm temporarily and then 
reactivate it. Alarms can be inhibited in the Events Summary during runtime. 
Auto Print AHP File: Help files with the AHP suffix can also be printed. A help file in 
HTML format is printed manually according to user demand. An alarm line and its AHP file 
are printed as a set where the AHP file appears directly under the alarm. When working in 
a network configuration and an alarm with an AHP file attached is sent to another station 
this alarm will be printed in the far station only when the AHP file is located in the far 
station. 
If an alarm is defined with both the Auto Acknowledged and Auto End options, it will be 
considered inactive and will not be displayed in the Events Summary. 
Delay Delay intervals can be defined during which time alarms will not be generated. 
There are three options defining when the alarm will be reset: 
 Condition is false: Alarms will not be generated when the alarm condition is false (within 
the time delay). 
 Delay time ends: If the alarm condition is True, at the end of the defined time delay 
alarms will be generated. This is without taking into consideration changes in alarm status 
during the delay period. 
 Never: The delay feature will not be imposed. The default is Never. 
Modify This field has the following options: 
Change where you can select either; 
Current level only 
Current level and sublevels 
Including alarms when this is checked the changes defined in this dialog box will apply to 
the alarms also. 
Override where you can select either: 
All properties 
Changes only 
To delete a level: 
1. 1. In the All Containers pane right click Alarms and select Delete Level from the 
dropdown menu. A message box opens on your screen. 
1. 2. Click Yes to delete the alarm level. The alarm level will be removed from the list. 
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Locating Alarms 
The Application enables you to locate alarms in the List of Alarms in the Application Studio. 
This is especially useful if you have an application with many alarms. 
1. Click anywhere in the List of Alarms and select Find from the Tools menu. The Find 
Alarm dialog is displayed: 
2. Enter the alarm text in the Alarm Text field.  
3. Enter the alarm family in the Family field.  
4. Select the condition(s) by which you want to conduct the search in the Conditions area. 
You can choose between Alarm Text, Family name or Both. 
5. Click Find. The alarm is located in the List of Alarms. 
6. Click Exit or anywhere in the Application Studio outside the List of Alarms to close the 
dialog. 

 
 

 
 

   
 
 
 
 

A Predefined Alarms 
Application predefined alarms are alarms generated by the Application without user 
intervention, in special situations. All these alarms have no interface. 
Below is a list of such alarms, descriptions of the situation for generation and values of 
different alarm attributes for each of them. 
Network communication error 
Alarm text: "Communication error with station StationName"  
Generating condition: Alarm generated on Application network station when 
communication error is detected with another Application network station. 
Application module generating alarm - WIZpro 
Alarm symbolic name in Application - "COMMERR" 
Severity – 99 
Zone – 99 
Class (target) – events summary, popup, alarm printer 
History - No 
System Wide - No 
Network alarms notification 
Alarm text: "All alarms from station StationName are uncertain." 
Generating condition: Alarm generated on one Application network station which is a 
client of another Application network station's alarms that is down. 
Application module generating alarm - WIZpro 
Alarm symbolic name in Application - "COMMERR" 
Severity – 99 
Zone – 99 
Class (target) – events summary, popup, alarm printer 
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History - No 
System Wide - No 
Communication error with PLC (VPI) 
Alarm text – "Communication Error: VPI VpiName station StationName"  
Generating condition: Alarm generated on an Application station when communication 
error with PLC is detected. 
Application module generating alarm - WIZpro 
Alarm symbolic name in Application - "COMMERR" 
Severity – 99 
Zone – 99 
Class (target) – events summary, popup, alarm printer 
History - Yes 
System Wide – No 
Hot backup  
Alarm text – "Backup of StationName is active."  
Generating condition: Alarm generated on Application backup station when detected 
communication error with master station (master is down) and Application backup station 
replaces the master. 
Application module generating alarm - WIZpro 
Alarm symbolic name in Application - "HOTBACKUP" 
Severity – 99 
Zone – 99 
Class (target) – events summary, alarm printer 
History - No 
System wide - Yes 
Evaluation Plug Model 
Alarm text – "WIZpro shutdown in 5 minutes." 
Generating condition: Alarm generated on Application station when used evaluation plug 
model and evaluation plug working time (2 hours) will elapse in 5 minutes. 
Application module generating alarm - WIZpro 
Alarm symbolic name in Application - "PLUG" 
Severity – 99 
Zone – 99 
Class (target) – events summary, popup, alarm printer 
History - Yes 
System Wide - No 
Login / Logout alarms 
Alarm text – Text defined in "Login Alarm Text" or "Logout Alarm Text" (depends on 
alarm) 
Generating condition: Alarm generated on Application user login and logout according to 
setting in Objects / Alarms / Properties / General . If nothing set in "Login Alarm Text" or 
"Logout Alarm Text", corresponding alarm is not generated. 
Application module generating alarm – Application STUDIO 
Alarm symbolic name in Application - "LOGIN_TEXT" or "LOGOUT_TEXT" (according 
to situation) 
Severity – 1 
Zone – 1 
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Class (target) –alarm printer 
History - Yes 
System Wide - No 
Application language alarm - Disk Full: 
Alarm text –"Station StationName: Disk DiskName Percent% full. Backup or delete files" 
Generating condition: Alarm generated when disk is 5% full every hour. When 9 % of 
disk capacity is reached, alarm history files deleting attempt will be performed.  
Application module generating alarm – Application Language 
Alarm symbolic name in Application - "WIZWIL" 
Severity – 10 
Zone – 0 
Class (target) – depend on Application Language settings 
History - Yes 
System Wide - No 

 
 

   
 

If this option is selected, the 
alarm will be recorded in the alarm history file. 

 
 

 
 

   

Design/ User Class 
Definition    
In this dialog box, you can define alarm classes. 
This option is used to assign user-defined name for alarms classes. Alarm classes can be 
used to categorize alarms to identify them more easily and to filter them in the system 
Events Summary. Alarm classes are used by the events summary to filter and display 
alarms. The classes are numbered from 1 to 16.  
To change the default name of a class, simply delete the name (using the Delete or 
Backspace key), and type the name that you want.  
After you define the classes, they can be assigned to alarms by activating the User Class 
combo box in the Alarm Definition dialog box.  
To define classes for alarms 
Select the Class Names item from the Design Menu. 
In this dialog box, select a class and activate the OK button. 
To cause no class to be selected, activate the Reset All button. 
Note that each class that appears in this dialog box was defined by the operator in the 
User Class Definition procedure.  
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   About this chapter: 
This chapter describes Alarm filters, Printers and Printer Targets and how to configure 
them as follows: 
Overview  describes Alarm filters, Printers and Printer Targets and their functionality in the 
system program. 
Defining Printers describes how to define printers and their various functions. 
Defining Alarm Filters describes alarm filters and their functionality in the program and 
how to define their different parameters. 
Defining Printer Targets describes printer targets and their functions in the program.  
 

 
 

 
 

   

Overview 
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Alarm Filters 
The Alarm Filter applies on alarms before they are printed out or written to the Event 
Summaries. Alarm filters are displayed in the Alarm Filters table and defined or modified in 
the Filter Properties dialog box. Filter properties can be updated, however the name of a 
filter cannot be changed.  
The Alarm Filter applies on the alarms sent when parameters defined in tag variants are 
not met.  
All the alarms which went through the alarm filter, are sent to the related Printers defined in 
the Printer Targets module.  See Defining Alarm Filters. 
 

 
 

 
 

   

 
 

 
 
 
Alarm Filters Manager - Overview 
 
The Alarm Filter filters alarms and reports before they are printed out or written to the 
Events Summary.  
Alarm filters are displayed in the Alarm Filters table and defined or modified in the Filter 
Properties dialog box.  
Filter properties can be updated, however the name of a filter cannot be changed. The 
Alarm Filter filters the alarms sent when parameters defined in tag variants are not met. 
After alarms and reports outside the defined categories have been filtered out by the 
Alarms Filter, the remaining alarms are sent to the Printers defined in the Printer Targets 
module. 
Add an alarm filter
Define the alarm filter's properties
Select Alarm Filters
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Printers 
The Printers dialog box enables enhanced printing capabilities. Each printer added to a 
system can be set to print reports, alarms or both. In addition a definition can be made 
where many alarms are printed on a full page or whether only one alarm is printed on each 
page. Page orientation and font can also be defined. Alarm properties that are printed can 
also be set together with different colors, text and background.  See Defining Printers. 
 

 
 

 
 

   

 
 

 
 
 

Printer Targets 
A Printer Target is a collection of predefined filters and printers specifying the conditions 
under which the targeted printer is activated. 
The Printer Target dialog box holds a list of all the printer targets that have been defined. 
Each printer target is identified by a unique name and description.  See Defining Printer 
Targets. 
 

 
 

 
 

   

 
 
 

 
 
Printer Targets Overview 
 
A printer target is a collection of pre-defined filters and printers, specifying the conditions 
under which a target printer will be activated. 
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The Printer Targets dialog box contains a list of all the printer targets you defined. Each 
printer target is identified by a unique name and description. 
To load a target printer 
1. Select the printer you want to load. 
2. Click the Load button. A check mark to the left of the printer indicates that the printer is 
loaded. 
Or, 
 Select the checkbox on the left of the printer you wish to load. 
To unload a target printer 
1. Select the printer you want to unload. 
2. Click the Unload button. 
Or, 
 Uncheck the checkbox on the left of the printer you wish to unload. 
 
When a printer target is loaded and an alarm that meets the filter criterion is generated, the 
alarm will be sent automatically to the printer defined for printing alarms. 
 
Adding a Printer Target

 
 

 
 

   

 
 

 
 
 
Printers Overview     
 
Using the Print dialog box you can specify the printers that will be used for the different 
types of printing tasks, and to define the various printing parameters, such as orientation 
and font. The different types of files generated the application for alarms and reports may 
be sent to different types of printers. To use several printers, you have to specify which 
printers are active using the Printer Targets definitions. 
 
General Properties 
Printing Source 
Select what files will be printed by the selected printer:  

• Reports - the printer will be used to print reports. 
• Alarms - the printer will be used to print on-line alarms and events. 

 
Alarm Print Options 

• Full page - the printer will print a full page. 
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• One alarm per page - the printer will print one alarm on each page. 
• Line printing - the printer will strike the paper a line at a time. This option is used 

with dot-matrix and inkjet printers, additional parameters are defined in the Line 
Printing tab. 

 
 
Orientation 
Select the page orientation: Portrait or Landscape. 
 
Font 
Select the font you wish to use in your printouts. 
 
Alarm Properties 
Select and organize the fields (columns) that will be displayed in your alarm printouts. 
 
Colors 
Define printouts text and background colors. 
 

 
 

 
 

   

 
 
 

 
 

Workflow 
This section describes the order of the steps required for defining Printers, Alarm Filters 
and Printers Targets.  

Define tags    Tags definition. 

Define alarm Alarm definition. 

Define Printer The Printer module has three tabs; General, 
Alarm Properties and Color.  

Define Alarm 
Filter    

Alarm filters are attached to alarms. The Alarm 
Filter filters alarms according to family, severity, 
zone and classes.  
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Define Printer 
Target    

The Printer Target dialog box connects between 
the defined filters and printers.  

 
 

 
 

   

Defining Printers 

 
 
 
 
 
Adding Printers    
 
You can add a local or a network printer. 
To add a printer 
1. Click the Printers icon in the control panel, or on the Design menu click Options and then 
Printers. The Printers dialog box appears. 
2. Click the Local Printer button to add a local printer; Click the Network Printer button to 
add a network printer. 
3. Select the printer you want to add and click OK. The printer you added now appears in 
the Printers list. 
 
To define the printer's properties 
1. Under Use printer for select Reports or Alarms or both. 
2. Under Alarm Print Options, select the whether you want to print only one alarm on each 
page, a full page, or support line printing. 
3. Under Orientation, select the page orientation: Portrait or Landscape. 
4. Click the Choose Font button to display the Font dialog box where you can define your 
printouts font. 
5. Click the Alarm Properties tab to select and organize the alarm fields (columns) that will 
be displayed in the alarm printouts. 
6. Click the Color Properties tab to customize both text and background printout colors. 
7. Click the Line Printing tab to define the line printer properties. 
8. Click the Preview button for a print preview. 
9. Click OK. 
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Defining Printers 
The Printers dialog box enables enhanced printing capabilities. Each printer added to a 
system can be set to print reports, alarms or both. Printers can also be Network printers 
that are shared by multiple users. In addition, you can define whether many alarms will be 
printed on a full page or whether only one alarm will be printed on each page. Page 
orientation, font and printed alarm properties can also be defined and printed in different 
colors, text and background. 

o To specify printers: 

In the Control panel of the Application Studio, double-click the Printer icon. 
Or, 
From the Design menu, point to Options and select Printers from the popup menu. The 
Printers dialog box is displayed. 
The Printers option has four tabs: 

o  General Tab  
o  Alarm Properties Tab  
o  Colors Tab  
o  Line Printing Tab  

 
 
 

 
 

   

 
 
 

 
 
Selecting Printers 
 
To select a printer 
1. Select the printer you want to add from the list of all defined printers. 
2. Click the Add button. 
 The selected printer is now added to the list of selected printers. 
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To remove a selected printer 
1. Select the printer you want to remove from the list of selected printers. 
2. Click the Remove button. 

 
 

 
 

   

 
 

 
 
 

General Tab  

 
1.   To define a printer either, click the name of a printer from the Printers List or click the 
arrow in the Select Printer field's dropdown list and select a printer. 
2.   Printers can be added or deleted from the Printers List. To add printers to the Printers 
List click either Local Printer or Network Printer. Double click the name of a printer in the 
List and OK to confirm. To delete a printer select a printer and click Delete Printer. The 
printer will be deleted from the list.  
3.   Report, Alarms or both can be printed. In the Use Printer For field check the relevant 
checkbox(es) to define this option. 
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Alarms: This option has backwards compatibility. This means that alarms from previous 
versions that have the Default Printer option selected will print to the defined printer. 
Reports: This option has backwards compatibility (see Alarms above) and also prints 
reports. 
Note:    When Alarms and Reports are both checked, the selected printer is the default 
printer for alarms and reports printing.  
4.   The Alarm Print Options has three options, Full page, One alarm per page or Line 
printing, click the relevant option.  
5.   In the Orientation field click either Portrait or Landscape. 
6.   To change font style or color, click the Choose Font button and select a font or color. 
7.   Click OK to confirm. 
Note:    When the Network Printers button is clicked, the Network Browser opens. You can 
browse the Network Place directory to visualize the list of the computers that have shared 
printers. Select the relevant computer name from this list and then select a printer. 
Only one Alarms and one Reports printer can be defined per application. The Line Printing 
tab only opens when this option is clicked in the Alarm Print Options and is only for Dot 
Matrix printers or Dot Matrix mode.  

 
 

 
 

   
 
 
 
 

Alarm Properties Tab 
1.    To define a printer either, click on the name of a printer from the Printers List or click 
the Select Printer field's dropdown list and select a printer. 
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2.    Printers can be added or deleted from the Printers List. To add printers to the Printers 
List click either Local Printer or Network Printer. Double click the name of a printer in the 
List and OK to confirm. To delete a printer select a printer and click Delete Printer. The 
printer will be deleted from the list. 
3.    The Columns Order field allows to define the printing layout of the alarms. Check the 
relevant column in the list to define this option. 
4.    The order in which columns appear in the printout can be defined using the following 
buttons: 

o     Move Up - Moves a column up one space. 
o     Move Down - Moves a column down one space.  
o     Select All - Selects all the columns in the options list. 
o     Deselect All - Removes all the columns in the options list. 
o     Default - Resets to the default options list. 

5.       Click OK to confirm these changes. 
Note:     When Network Printers is selected the Network Browser opens. Browse to open 
the Network Place directory where a list of the computers that have shared printers is 
located. Select the relevant computer name from this list and then select a printer. 
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Colors Tab 
You can assign the colors of the alarms text and background that will be printed. 
The Text or/and Background colors can be based on alarm Severity or/and Zone. 

  
1.   To define colors, select a printer from the Printers List . 
2.   Select either Zone or Severity. Additional zones can be entered by typing the zone 
number in the sequential textbox. 
3.   To add/change a color of Text and Background, click the (empty) color box to open the 
color chart, select a color and click OK. The color will be added to the list.  
Note:   Color can be defined for Windows mode printing. 
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Line Printing Tab 

 
Note:    This tab only appears after Line Printing is defined in the Alarm Print Options of the 
General Tab. 
1.   To define a printer either, click on the name of a printer from the Printers List or click 
the Select Printer field's dropdown list and select a printer. 
2.   Printers can be added or deleted from the Printers List. To add printers to the Printers 
List click either Local Printer or Network Printer. Double click the name of a printer in the 
List and OK to confirm. To delete a printer select a printer and click Delete Printer. 
3.   An escape sequence is a set of characters giving additional commands to the printer 
regarding printing format. Each printer has its own escape sequence, which is usually 
written in the printer's manual.  
4.   The number of characters in each line can be defined. To do so either type in the 
number or use the arrows to scroll up/down. 
5.   The number of lines on each page can be defined. To do so either type in the number 
or use the arrows to scroll up/down. The digit 0 indicates continuous printing. 
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Line Printing 
 
Line printing applies to dot-matrix printers and inkjet printers that strike the paper a line at a 
time. 
To define the printer's line printing properties 
1. Click the Line Printing tab to open the Line Printing page. 
2. Type the Escape code sequence used by the printer. The code is in decimal numbers. 
 Use comma for command separating. 
3. Define the number of characters in each printed line (default is 136 characters). 
4. Set the number of lines on each page. Note that 0 is used for continuous printing. 

 
 

 
 

   

Defining Alarm Filters 

 
 
 
 
 
Adding Alarm Filters  
 
To add an alarm filter 
1. Click on the Alarm Filters icon in the Application Studio control panel, or select Alarm 
Filters from the Design menu. The Alarm Filters dialog box is displayed. 
2. Click the Add button to open the Filter Properties dialog box where you can define a 
new filter: 
 
To modify an alarm filter 
1. Select the alarm filter you want to change. The Filter Properties dialog box is displayed.  
2. Change the filter's properties as applicable. Note that you cannot change the filter's 
name. 
Alarm Filters Manager 

 
 

 

557 



Chapter 16 Alarm Filters, Printers & Printer Targets 

 

   

 
 

 
 
 

Defining Alarm Filters 
When the alarm condition is true, an alarm is generated.The Alarm Filters module filters 
alarms according to family, severity, zone, classes and user defined fields. 

In the Control panel of the Application Studio, double-click the Alarm Filters icon. 
Or, 
From the Design menu select Alarm Filters. The Alarm Filters dialog box is displayed: 

  
The Alarm Filters dialog box has four columns: 

Alarm Filters Displays an Alarms Filters list 

Tag for Started & 
Unacked Number of Started and Unacknowledged alarms 

Tag for Started & 
Acked    Number of Started and Acknowledged alarms 
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Tag for 
Ended&Unacked 

Number of alarms that are Started and Ended but 
not acknowledged 

Alarm filters can be added, updated and deleted. 
o    To add Alarm Filters: 

To define an Alarm Filter click the Add button located under the Alarm Filter list. The Filter 
Properties dialog box opens. 
There are three tabs:  

o    General Tab 
o    Network Tab 
o    Counters Tab 

 
 

 
 

   
 
 
 
 

Filter Properties 
 
This tab holds general information about the alarm filter. 

1. In the Name field type a unique name for the alarm filter. 

2. In the Description field type a short description of the alarm filter. 

3. Click the Family field’s arrow to open the dropdown list and select a 
family. Only alarms from this family will be displayed. 

4. In the Severity field specify the Minseverity and Maxseverity fields. 
Alarms out of these fields will not be displayed. 

5. In the Zone field specify the Minzone and Maxzone fields. Alarms out 
of these zones will not be displayed. 

6. Click the Select Class button to open the Set Class Filter dialog box. 
Filter classes can be used to categorize alarms to identify them more 
easily and to filter them in the Events Summary. Classes can be added 
and removed individually or as a group by clicking the Set All and Reset 
All buttons. Click OK to return to the General tab. 

7. Click the Select Fields button to open the User Fields Filters dialog 
box.  
This dialog box holds customized fields that are defined by the user in the 
Alarms Parameters Field Names dialog box. Type in your filtering criteria 
in the relevant User Field and click OK to confirm. The Alarm Filter will 
filter the User Fields accordingly. For example in User Field 1 only Alarms 
that are High will be filtered. 

8. Click OK to actually save the Alarm Filter definitions.  
Network tab 
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Counters tab 
Select Alarm Filters

 
 

 
 

   

 
 

 
 
 

Selecting Alarm Filters 
 
1. Select the filters from the list and click the arrow to add the filter to the list of selected 
filters. 
2. Click the New button to define a new filter. 
3. Select a filter from the list of defined filters, and click the Modify button to edit the filter 
properties (note that all the filter properties are editable except the name). 
4. Select a filter from the list of defined filters, and click the Delete button to remove the 
selected filter. 

 
 

 
 

   

 
 
 

 
 

General Tab  
This tab holds general information about the alarm filter. 
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1.    In the Name field type a unique name for the alarm filter. 
2.    In the Description field type a short description of the alarm filter. 
3.    Click the Family field's arrow to open the dropdown list and select a family, or type the 
family name directly. Only alarms from this family will be displayed. 
4.    In the Severity field specify the Minseverity and Maxseverity fields. Alarms out of these 
fields will not be displayed. 
5.    In the Zone field specify the Minzone and Maxzone fields. Alarms out of these zones 
will not be displayed. 
6.    Click the Select Class button to open the Set Class Filter dialog box. 
Filter classes can be used to categorize alarms to identify them more easily and to filter 
them in the Event Summaries. Classes can be added and removed individually or as a 
group by clicking the Set All and Reset All buttons. Click OK to return to the General tab. 
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7.     Click the Select Fields button to open the User Fields Filters dialog box.  

 
 
 
This dialog box holds customized fields that are defined by the user in the Alarms 
Parameters Field Names dialog box. Type in your filtering criteria in the relevant User Field 
and click OK to confirm. The Alarm Filter will filter the User Fields accordingly. For example 
in User Field 1 only Alarms with the value “2” will be filtered. 
8.    Click OK to actually save the Alarm Filter definitions. 
Note:     The Family name list is defined in the Tags dialog box in the Tag Name field.  
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Network Tab 
This tab is used to apply a Filter Alarm to the alarms coming from the selected network 
stations.  
 

 
 
1.    In the List All Stations column select the relevant station.  
2.    Either double click the station name or, click the Forward button. The station name will 
be transferred to the Selected Station column. 
3.    To remove a station from the Selected Station list click the Backwards button.  
4.    The All Stations checkbox enables filtering alarms on all the stations in the network 
including local stations. Click this checkbox to enable this option. When this checkbox is 
selected the button options are not enabled. 
5.    Click OK to confirm. 
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Counters Tab 
This tab is used to assign tags to counters that will contain the amount of alarms matching 
the filter conditions, and can be used in Wizcon modules (e.g. image module,...). 
 

 
 
1.    To enable the fields in this dialog box check the Enable Count Alarms checkbox. 
2.    In each field click the arrow to open the dropdown list and select the tag that will get 
counted value. Do not select system tags. 
3.    Click OK to confirm. The selected tags will appear in Alarm Filter main dialog box in 
the related columns.  

o To change Alarm Filters specifications: 
1.    To change an Alarm Filter either double click the alarm filter in the list or select the 
Alarm Filter and click the Change button located under the Alarm Filter list. The Filter 
Properties dialog box will open. 
2.    Change relevant parameters using the instruction for To add Alarm Filters Click OK 
to confirm. The changes will appear in the Alarm Filters list. 

o To delete an Alarm Filter: 
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1.    To delete an Alarm Filter select the alarm filter and click the Delete button located 
under the Alarm Filter list. A message box will open asking if you are sure that you want to 
delete this alarm filter. 
2.    Click Yes to delete the Alarm Filter. 
3.    Click OK to confirm. 
Note:    See the Event Summary chapter for details on how the name of the alarm filter can 
be changed dynamically in order to update the contents of the event summary in realtime. 
 

 
 

 
 

   

 
 

 
 
 

Defining Printer Targets 

A Printer Target is a collection of predefined filters and printers specifying the conditions 
under which the targeted printer is activated. 
The Printer Target dialog box holds a list of all the printer targets that have been defined. 
Each printer target is identified by a unique name and description.  

o To specify Printer Targets: 

In the Control panel of the Application Studio, double-click the Printer Target icon. 
Or, 
From the Design menu select Printer Target. The Set Printers dialog box is displayed: 
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1.    To add a printer target click the Add button. The Target Definition dialog box opens.  
2.    To modify a printer target select the printer target in the Name column and click the 
Modify button. 
3.    Printer targets can be deleted. To do so select the printer target in the Name column 
and click the delete button. 
4.    To load a printer target, select the printer target in the Name column and click the 
Load button. A tick will appear in the checkbox next to the selected printer target.  
5.    To unload a printer target select the printer target in the Name column and click the 
unload button. Or uncheck the checkbox of the selected printer target  
Note:     When a Printer Target item is loaded and an alarm meets the target filter criterion, 
the alarm will be sent automatically to the printers declared as the targets. 

o To specify Target Definition: 
A Target Definition is comprised of a user defined name and description and a selection of 
printers and filters. This dialog box opens when either the Add or Modify button is clicked in 
the Printer Target dialog box. 
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1.    Type the name of the target in the Name field.  
2.    Type a description for the target in the Description field. 
3.    In the List all Selected Filters field select the relevant filter. To add filters to this list 
click the Select Filter button to open the Select Filter dialog box. Select a filter, click Add 
and OK to confirm. 
4.    In the List all Selected Printers field select the relevant printer. To add printers to this 
list click the Select Printers button to open the Select Printers dialog box. Select a printer, 
click Add and OK to confirm. 
5.    To automatically load the printer target during application start up click the Load at 
Application Startup button and click OK. The printer target now appears in the Printer 
Targets list. 
Note:     The Name must be unique. 
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Adding a Printer Target 
 
To add a printer target 
1. Click the Printer Target icon located on the studio control panel. The Printer Targets 
dialog box opens. 
2. Click the Add button to open the Target Definition dialog box. 
3. Type the name of the target in the Name field (note that this name should be unique). 
4. Type a description for the Printer Target. 
5. Click the Select Filters button to display the Select Filters dialog box, where you can 
select your printer target filters, or create new filters for your printer target. 
6. Click the Select Printers button to display the Select Printers dialog box where you can 
select the printers for your target printer from the list. 
7. Select the Load at application startup checkbox to automatically load the printer target 
upon application startup. 
8. Click OK when done. The printer target now appears in the list of Printer Targets. 
 

 
 

 
 

   

Other Topics 

 
 
 
 
 

Redirects the messages to a Popup, for the Popup events summary, or the printer, for the 
alarm printer. 
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Redirect messages to the file specified. 
 

 
 
 
 

 

 

 
   
 

The application now enables you to print trend viewers as they appear in the browser. 

 print: 
t from the Options menu of the Trend Viewer 

 

 
 
 

  
To
Select Prin
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About this chapter: 
This chapter describes Advanced Alarm Management (AAM), as follows: 
Advanced Alarm Management (AAM) Overview is an overview of the application 
network environment. 
Getting Started describes the basic requirements for AAM. 
Channels describes working with AAM Channels. 
Pager Services describes working with AAM Pager Services. 
Vocal Server describes this server’s setup. 
Message Formatting lists different types of user message formats. 
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Advanced Alarm Management (AAM) Overview 

The Advanced Alarm Management (AAM) module provides additional alarm services. This 
is useful when critical alarms requiring urgent attention need to be sent, read and the 
cause of the alarm handled. 
The AAM module sends either alphanumeric or voice messages. An alarm can be sent by 
SMS, pager, E-mail, fax, printer, or as voice to single or multiple users. An alarm sent by 
voice mail can be acknowledged and any messages sent with the alarm can be read. 
AAM messages can be sent to groups (defined in Chapter 7, Security and User 
Management, User Management - Overview8) and according to schedules set in the 
Users Timetable (Chapter 18, Users Timetable, Users Timetable Overview ). 
The AAM module supports multilanguage. User messages can be translated into French, 
English or German. 
Note:     All WAV files played by the AAM must be in mono format and not stereo.  
Advanced Alarm Management can be used in two modes: 

o     Demo mode: Used for trial purposes, runs for two hours after which the user 
(developer) must restart the computer. The voice option is not available.  

o     Plug with AAM option: Authorized unlimited full-time mode. 
The following AAM configuration module defines how and where an alarm is sent: 

o     Channels - defining the modems (TAPI modem or modem connected to COM 
port). 

o     Pager Services - defines the types of services used to send alarms (SMS, E-
mail, Pager, Fax, Printer, Voice). 

o     Advanced Alarm Viewer- a real time log where outgoing alarms can be 
viewed. 

o     User Timetable - where users within teams and groups work schedules can be 
defined. Alarms will be sent to users in real-time and according to work shift. See 
Chapter 18, Users Timetable. 

o     Vocal Server - defines the different settings related to the vocal transmission of 
an alarm. 
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Advanced Alarm Management Overview 
 
The Advanced Alarm Management (AAM) uses a multi service communications platform to 
provide alarm transmission over various communication channels, such as SMS, e-mail, 
fax or vocal messages, using: 
A universal messaging service (Paging service) to send numerical or alphanumeric 
messages (with an attached file or not) to beeps, pagers or terminals (screen terminals, 
printers or fax). 
A telematic terminal server (ANSI, HTML, videotex). 
A voice server. 
A file transmission service (Z-Modem, FTP). 
AAM is comprised of two design mode components: Alarm Channels and AAM Pager and 
a run-time component: Advanced Alarm Viewer. 

 
 

 
 

   

 
 

 
 
 

Advanced Alarm Management 

Click the Advanced Alarm Management icon to open the Advanced Alarm Management 
dialog box where you can direct your alarms through various communication channels. 

 
 

 
 

   

Getting Started 

 
 
 
 
 

Getting Started 
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This section discusses basic work principles and requirements for using AAM. 

Requirements 
o     Network communications - modem. 
o     Plug authorization. 
o     Multi media hardware - sound card (for voice functionality only). 

Plug Upgrade 
Contact your supplier for details regarding ordering a new plug or upgrading existing 
software through the Remote Upgrade Service (RUS). Or visit our website at 
www.Wizcon.com to find your nearest supplier.

Workflow for Alphanumeric Messages 

    

Workflow for Vocal Messages 

 
Configuring AAM 
Advanced Alarm Management is configured in the Station Properties dialog box Advanced 
Alarm Management tab. 

o To define Advanced Alarm Management: 
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In the All Containers pane right click on the project name. The Station Properties dialog 
box opens. 
 

 
 
1.    Using the arrows scroll and select the Advanced Alarm Management tab.  
2.    Check the Enable Advanced Alarm Management checkbox. 
3.    If needed, check the Enable Priority Management button checkbox. This function 
enables to send first alarms with highest priority. You can decide what kind of alarms will 
have the highest priority, the ones with low severity value or the ones with high severity . 
4.    Click OK to confirm and restart the application.  
 

 
 

 
 

   

Channels 

 
 
 
 
 

Channels 
Advanced Alarm Management communication lines (TAPI modem or modem connected to 
COM port) are defined in the Channels dialog box where channels can be added, 
removed, deactivated or be modified. 

o Quick Access Bar Icon 
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The Advanced Alarm Management dialog box can be accessed by clicking the  AAM 
icon on the Quick Access Bar. 

 
The following configuration options can be accessed through this dialog box: 

o     Channels (modems) channels setup - Tapi modem or modem connected to 
COM port)  

o     Pager Services (messages) 
o     Vocal Server 
o     Advanced Alarm Viewer 
o     Message Formatting 

During runtime the real time Advanced Alarm Viewer shows statistics and the Event 
Summaries. 
 

 
 

 
 

   

 
 
 

 
 

Defining Channels 
o To specify AAM Channels: 

In the Quick Access bar click the AAM icon and then click the Number of modems Setup 
button. 
Or, 
From the Design menu, point to Advanced Alarm Management and select Channels from 
the popup menu. The Channels dialog box is displayed. 
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The Channels dialog box has four buttons: 

Add    
This button, when clicked opens the Channel 
dialog box where TAPI modems and COM ports 
can be selected and added. 

Properties    
This button when clicked opens the Line 
Properties dialog box where communication line 
parameters can be configured. 

Remove This button when clicked removes a selected 
modem/or port from the list. 

Deactivate    This button, when clicked deactivates a selected 
modem/port. 
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Line Designation 
 
The Channels dialog box enables you to define and configure the communication lines 
used by the Advanced Alarm Management. 
The Channels window displays a list of the serial ports and modems and enables you to 
select the ports to be used by AAM. The used ports are marked by the symbol . 
To add and define communication channels 
1. Click the Add button to display a dialog box containing a list of all the Physical (COM) 
ports and a list of Modems (TAPI). 
2. Check the Display only available COM ports checkbox to display only existing ports 
that are not used by other applications. 
3. Select the port you want to use. 
4. Click the OK button. 
 The Line Properties dialog box opens, enabling you to configure the various port 
parameters. 
To modify a port properties 
1. In the Channels dialog box, select the port you wish to modify. 
2. Click the Properties button to open the Line Properties dialog box, where you can modify 
the selected port properties. 
To delete a port 
1. Select the port you want to delete. 
2. Click the Remove button. 
To deactivate an active port 
1. Select the port you want to deactivate. 
2. Click the Deactivate button. 

 
 

 
 

   

 
 

 
 
 

TAPI Modem/COM Port setup Dialog Box 
In this dialog box you can view and select TAPI modems and/or physical COM ports. 
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Select a modem, port or both and click the OK button. The Line Properties dialog box 
opens on your screen. 
Notes: By default all modems and physical ports defined in the system are listed in this 
dialog box. To view TAPI modems or COM ports, check the Display only Modems and 
Display only Available COM ports checkboxes. 
We highly recommend you to use a modem connected to a COM port rather than a TAPI 
modem to enable maximum parameters control. 

 
 

 
 

   
 
 
 
 

TAPI Modem Properties Dialog Box 
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Click the Setup button to open the standard Microsoft dialog box where setup modem 
parameters can be defined. 

Voice functionality: The AAM module supports voice functionality with the TAPI 
modem if the modem driver also supports voice functionality. 

With Windows 
NT4:  

Generally, modem drivers do not support voice function and AAM 
cannot be used with the TAPI modem. Therefore, the COM port is 
connected to the modem.  

With Windows 
2000/XP:  

Most TAPI modem drivers support voice functionality and the AAM 
module can use TAPI modem for voice call management. Not all 
driver modems support voice functionality.  

o To check that a driver can manage voice functionality:  
In the AAM dialog box, click Setup. Add a TAPI modem, and click Properties to open a 
standard Microsoft dialog box. If in the Assigned Service on Incoming Call field the Vocal 
Server option is defined this means that your TAPI modem driver can handle voice calls 
and can be used by AAM. 

 
 

 
 

   
 
 
 
 

COM Port Properties Dialog Box 
This dialog box is used to configure the parameters of the communication line.  
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Line Properties has the following fields: 

The port number is the name of the port defined in the Channels or 
Channel Modem and Port dialog box. Port    

When this option is selected AAM defines that this port remains 
open permanently solely for the application. If this checkbox is not 
checked then this modem/port will be opened on demand and 
when available and will be automatically closed when 
communication terminates.     

Keep Open 

There are two port types: 
Hayes Modem - where communication is established through the 
telephone network Type    

Direct Communication - for example, a printer connected to the port 

Bauds, Bits, 
Parity    Where port/modem communication bandwidth is defined    

Where communication error control parameters are defined: 
None - no flow control 
Hardware - communication errors will be checked at the hardware 
level Flow Control    
Xon/Xoff - communication errors will be checked at the software 
level. Xoff code (13h) request for data emission suspension sent 
to the transmitter who then returns Xon (11h) code to resume 
transmission.  

This field assigns services to incoming calls: 
Assigned service    Direct line - assigned service that will manage port communication  

Modem - assigned service that will manage incoming call 
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Prefix to dial    The number dialed to receive an outside communication line. 

Voice Modem    
Modem used to carry voice messages. Voice modem parameters 
can be defined by clicking the button to open the Modem 
Parameters in the Vocal Code dialog box. 

Fax Modem Modem used to send fax messages. 

Modem CSM/PCS 
Where the parameters for this modem can be defined. Click the 
Browse button to open the GSM/PCS modem parameters dialog 
box. 

Reserved for    Defines that this modem/port is reserved for incoming calls only. 

Automatic Setting Port/modem settings according to definitions. 

Carrier Detect DCD carrier settings. 

Modem Parameter Where the Hayes modem parameters are defined. 

1.    Check the Keep open checkbox to enable port sharing between several applications. 
2.    In the Type field select either Hayes Modem or Direct.  
3.    Port baud rate should be defined as follows: 

Parameter Value 

Baud rate 300-11520 

Bits    7,8 

Parity Even, Odd, None 

Stop bits 1,2 

These parameters can be modified by the services using the port for outgoing calls 
according to the communication type established. 
4.    In the Flow Control field select either None, Hardware or Xon/Xoff. 
5.    In the Assign Service on Incoming Call field click the dropdown list and select the 
relevant service. 
6.    In the Prefix to Dial field type the prefix used to access the outside communication line 
if relevant. 
7.    Select the relevant format type: 

o If a Hayes Modem has been selected then click the Modem parameters button to 
open the Hayes Modem Parameters dialog box. 

o If Direct has been selected in the Type field then select either Automatic 
connection, Connect detect or both. 

8.    Click OK to confirm.  
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Modem Parameters in Vocal Mode 
This dialog box defines the parameters of the modem that transmits voice messages. 

o To specify modem parameters in vocal mode: 
In the Line Properties dialog box click the voice modem button to open the Modem 
Parameters dialog box. 
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1.    In the Modem field click the arrow to open the dropdown list and select the correct 
modem type. 
2.    In the Transmission format field click the arrow in the Rate field to select how often the 
transmission line is sampled and then select the number of bits per sample. 
3.    In the Silence Detection Voice Receive field type in the silence detection period 
number (x100ms) and then in the Silence Sensitivity Tuner field select either; Low, Medium 
or High. 
4.    DTMF tone detection can be either on Transmission, Reception or Command, select a 
mode. 
5.    In the Other Parameters field type in the relevant parameters.  
6.    In the Reinitialiization in Vocal Mode field define baud level. 
7.    In the Flow Control field select either None, Hardware or Xon/Xoff. 
8.    In the Begin and End Voice Communication fields type in the relevant number. 
9.    Click OK to confirm. 
Notes: To avoid noise problems on the phone line, select the hardware flow control option. 
The parameter Ringback Goes Away Timer (100 ms) enables synchronization of 
messages that are played during user download. By default this is defined at 50. The value 
must be modified according the modem you use (with Olitec Speed Com 2000 the value 
could be 100). 
 

 
 

 
 

   

 
 
 

 
 

GSM/PCS Modem Parameters 
This dialog box defines the parameters of the GSM/PCS modem and the format of SMS 
messages. 

o To specify GSM/PCS modem parameters: 
In the Line Properties dialog box click the Browse button to open the GSM/PCS modem 
parameters dialog box. 

 
1.   In the PIN number field type in the unique PIN number. 
2.   In the SMS format field select either; Auto, PDU or Text. 
3.   Click OK to confirm. 
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GSM/PCS modem properties 
 
In this dialog box you can configure the GSM/PCS modem parameters. 
To configure the GSM/PCS modem parameters 
1. Type the modem PIN (Personal Identification Number) number to authorize access to 
the GSM modem functions. 
2. Select the SMS format, the format that will be used to transmit short messages. 
 Note that selecting Auto enables the actual format configured in the modem to be used. 
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3. Click OK to save your configurations and return to the Line Properties dialog box. 
 
 

 
 

   

 
 
 

 
 

Hayes Modem Parameters 
This dialog box is used to define the Hayes Modem communication line parameters. 

o To specify Hayes modem parameters: 
In the Line Properties dialog box click the Modem Parameter button to open the Hayes 
modem parameters dialog box. 
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1.    In the Init String field type the command string that will be transmitted to the modem at 
interface initialization and at the end of each communication session. 
2.    Specify the Dial field parameters: 

o     Prefix - type the string to be transmitted before the dial number 
o     Suffix - type the attention string to signal a modem command during data 

communication 
3.    Specify the Hang-up field parameters: 

o     Prefix - type the attention string to signal a modem command during data 
communication 

o     Suffix - type the disconnection command 
4.    In the Originate Connection field type the command that will be sent to the modem to 
connect it after an incoming call received when the modem is setup for manual use. 
5.    In the Answer Connection field type the connection command that will be sent to the 
modem when an incoming call is received and the modem is set up for manual use. 
6.    Check the Hang-up by DTR checkbox to enable the DTR line to function as a 
command to disconnect the modem from the line. 
7.    Type the number of rings the system waits before answering an incoming call. The 
type of answer depends on the service selected for incoming calls in the Line Properties 
dialog box. 
8.    Select the Caller ID to enable a protocol generation for identification of the call dial 
number during incoming calls. There are three protocol types: 

o     Formatted ID - analog voice modem with formatted caller identification 
o     Unformatted ID - analog voice modem with unformatted caller identification 
o     Register S190 - ISDN modem, caller ID installed in the S190 modem register. 

Note:     To avoid problems during phone line connection add W to the ATDT for 
commands, for example; ATDTW. This will cause the modem to generate an error when 
the phone line is not connected. 

o To modify Channel Line Properties: 
In the Channels dialog box select the specific port or modem and click the Properties 
button. The Line Properties dialog box will open. See COM Port Properties Dialog Box.  

o To remove Channel Line Properties: 
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In the Channels dialog box select the port or modem and click the Remove button. 
o To deactivate Channel Line Properties: 

In the Channels dialog box select the port or modem and click the Deactive button. 
 

 
 

 
 

   

 
 

 
 
 
Hayes Modem Parameters 
 
In this dialog box you can configure the Hayes modem line specific parameters. 
To configure the Hayes modem parameters 
1. In the Init string field, type the command string that will be transmitted to the modem at 
interface initialization and at the end of each communication session. 
 This string has to be used only for general setting commands; the specific communication 
commands are transmitted by the services using the port before each communication 
session. 
2. Specify the Dial parameters: 
 Prefix - type the string to be transmitted before the dial number. 
 Suffix - type the string to be transmitted after the dial number. 
3. Specify the Hang-up parameters: 
 Prefix - type the attention string to signal a modem command during a data 
communication. 
 Suffix - type the disconnection command 
4. In the Originate connection field, type the command that will be sent to the modem to 
connect it, following a manual outgoing call. 
5. In the Answer connection field, type the command that will be sent to the modem to 
connect it, following an incoming call when the modem is setup for manual answering. 
6. Check the Hang-up by DTR checkbox to enable the DTR line to function as a command 
to disconnect the modem from the line (hang-up command). 
7. Type the number of rings the system waits before answering an incoming call. The type 
of answer depends on the service selected for incoming calls in the Line Properties dialog 
box. 
8. Select the Caller ID to enable a protocol generation for identifying the caller dial number 
during incoming calls. There are three protocol types: 

 Formatted ID - analog voice modem with caller identification. 
 Unformatted ID - analog voice modem with caller identification. 
 Register S190 - ISDN modem, caller id stored in the modem register S190. 
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Jericho 

 
 
 
 
 
Direct Line Properties 
 
Selecting the direct line communication option enables direct communication, for example, 
to a printer connected to the port. 
The direct line special parameters are as follows: 
Automatic connection  
Select this option to enable automatic transition to the connected state from the port 
opening, providing that the DSR line is high (if the Connect detect option is selected). 
Connect detect  
Select this option to enable the DSR line functioning as indicator of active connection of 
adverse equipment: disconnection when DSR falls and, if the Automatic connection option 
is selected, automatic connection as soon as DSR goes to high state. 
Reserved for incoming calls  
Select this option to indicate that the port cannot be used for outgoing calls. 

 
 

 
 

   

 
 
 

 
 
Hayes Modem Line Properties 
 
Selecting the Hayes Modem line type, communication is established through the telephone 
network and uses a modem of type Hayes. 
To define the Hayes modem properties 
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1. In the Prefix to dial box, type the number to dial for access to the public telephone 
network (0 by example), if the modem is connected to an internal telephone line. 
2. Select the Voice modem checkbox to indicate that the modem connected to the port is 
a voice modem and will be used for voice communications. Click the browse button to 
open the Modem parameters in vocal mode dialog box where you can select a voice 
modem and configure its properties. 
3. Select the Fax modem checkbox to indicate that the modem connected to the port is a 
fax modem and will be used for fax transmission. 
4. Select the Modem GSM/PCS checkbox to indicate that the modem connected to the 
port is a GSM or PCS modem. 
 Click the browse button to open the GSM/PCS modem properties dialog box where you 
can configure this modem properties. 
5. Select the Reserved for incoming calls checkbox to indicate that the port cannot be 
used for outgoing calls. 
6. Select the Automatic setting checkbox to enable validation of the automatic modem 
interface settings: Identification of the baud rate and the transmission format used by the 
connected modem.  
 This option does not need validation with most Hayes modems as the automatic settings 
are managed by the modem itself. 
7. Select the Carrier detect checkbox to automatically end the communication when the 
DCD (carrier detect line) falls. 
8. Click the Modem Parameters button to open the Hayes Modem Parameters dialog box. 

 
 

 
 

   

 
 
 

 
 
Line Designation 
 
The Channels dialog box enables you to define and configure the communication lines 
used by the Advanced Alarm Management. 
The Channels window displays a list of the serial ports and modems and enables you to 
select the ports to be used by AAM. The used ports are marked by the symbol . 
To add and define communication channels 
1. Click the Add button to display a dialog box containing a list of all the Physical (COM) 
ports and a list of Modems (TAPI). 
2. Check the Display only available COM ports checkbox to display only existing ports 
that are not used by other applications. 
3. Select the port you want to use. 
4. Click the OK button. 
 The Line Properties dialog box opens, enabling you to configure the various port 
parameters. 
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To modify a port properties 
1. In the Channels dialog box, select the port you wish to modify. 
2. Click the Properties button to open the Line Properties dialog box, where you can modify 
the selected port properties. 
To delete a port 
1. Select the port you want to delete. 
2. Click the Remove button. 
To deactivate an active port 
1. Select the port you want to deactivate. 
2. Click the Deactivate button. 

 
 

 
 

   

 
 

 
 
 
Line Properties 
 
The Line properties dialog box allows you to configure the parameters of a 
communication line using the physical ports COM1 to COM64. 
To configure the communication line parameters 
1. Check the Keep open option to enable port sharing between several applications. When 
this option is selected, the port is permanently kept open by the AAM and consequently 
cannot be used by another application. If this option is not selected, the port will be opened 
by the AAM (providing that it is free) only upon communication establishment. It will be 
automatically closed as soon as the communication will be ended. 
2. Select the line type: 
 Direct - select this option to enable direct communication (for example to a printer 
connected to the port). 
 Hayes Modem - select this option if the communication is established through the 
telephone network and uses a modem of type Hayes. 
3. Define the port baud rate and transmission format, as follows: 
 Parameter Values 
 Baud rate 300 - 11520 
 Bits 7, 8 
 Parity Even, Odd, None 
 Stop bits 1, 2 
 Note that these parameters can be modified by the services using the port for outgoing 
calls (paging services) according to the communication that is being established. 
4. Select the Flow control type to enable the control of communication errors: 
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 None - no flow control. 
 Hardware - communication errors will be checked on the Hardware level. 
 Xon/Xoff - communication errors will be checked on the Software level by sending the 
code Xoff (13h) to request the transmitter to suspend data emission, and the code Xon 
(11h) to request the transmitter to resume data emission. 
 Note: the selection of Flow Control can be modified by the services using the port for 
outgoing calls (paging service) according to the communication that is being established. 
5. Assign a service for the incoming calls: 

 If the port is set as a direct line, assign the service that will manage the 
communication on the port. 

 If the port is set as a modem line, assign the service that will manage incoming 
calls. 

If you selected a Hayes modem line type go to Hayes Modem Properties 
If you selected a Direct line type go to Direct Line Properties 

 
 

 
 

   

Pager Services 

 
 
 
 
 

Pager Services 
The AAM Pager Services module enables definition of a list of paging drivers and Call 
Management parameters. New drivers can be added, existing drivers removed and driver 
setup can be configured. 

Adding Pager Services 
This button when clicked opens the Add Paging Drivers dialog box. The list of drivers can 
be configured according to country and with/without the GSM modem. 
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1.    In the Paging Service Setup dialog box click the Add button to open the Add Paging 
Drivers dialog box. 
2.    In the Country field click the arrow to open the dropdown list and select a country. The 
Drivers list will show only the drivers available for the specific country. 
3.    To enable the GSM modem, click the With GSM Modem checkbox. 
4.    Select a driver from the Drivers list. 
5.    Click OK. The driver will appear in the Paging Service Setup Installed Drivers list. 

Remove Pager Services 
This option removes a driver from the Installed Drivers list. 
Select the driver from the Installed Drivers list and click the Remove button. The driver is 
removed from the list. 

 
 

 
 

   
 
 
 
 

Paging Service - Overview 
 
The paging service of Advanced Alarm Management handles all the functions of sending 
messages to a user using a selected media such as: bip, paging system, fax, terminal or 
printer and e-mail. 
When a request to send a message to a user is initiated, the paging service searches for a 
port compatible with the messaging system that has to be used, initializes this port with the 
appropriate parameters and then starts the call to the destination of the messaging system. 
when the connection is established, it transmits all the waiting messages for the system in 
question.  
To configure AAM paging serivces 
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1. Click the AAM - Pager Services iconlocated on the studio Control panel; 
 Or, Select Advanced Alarm Management from the Design menu, then select Pager 
services. 
 The Paging Service Setup dialog box opens. 
2. Add drivers to support the various messaging options and configure the drivers 
parameters accordingly, as described in Paging Service Setup 
 

 
 

 
 

   

 
 

 
 
 

Defining Paging Service Setup 
o To define paging service setup: 

In the Quick Access bar or in the Control panel of the Application Studio, click the AAM 
icon and then click the Number of message services configured Setup button. 
Or, 
From the Design menu, point to Advanced Alarm Management and select Pager Services 
from the popup menu. The Paging Service Setup dialog box is displayed. 
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The Paging Service Setup dialog box has the following options: 

Installed Drivers A list of all drivers installed in the application. 

Setup    This option opens the setup dialog box for the selected service. 

This opens the Add Paging Drivers dialog box where drivers can be Add    selected and added. 

Remove    This button when clicked removes a selected driver from the list. 

This button allows to call the channels dialog without closing the Ports current dialog box. 

This option defines the number of times transmission connection is Call attempted before a failure message is sent. It also defines the time Management    interval between each attempt. 
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Paging Service Setup 
 
In this dialog box you can define the list of paging drivers you want to use, and setup the 
specific parameters of each selected driver, as well as the parameters of a call 
management. 
The dialog box displays a list of all the installed drivers to which you can add additional 
drivers and configure the parameters of each driver. 
To add a new driver 
1. Click the Add button to display a list of all the supported drivers. The Add Paging 
Drivers dialog box opens:  
2. Select a Country to display a region-related list of drivers. 
3. Click the With GSM modem checkbox to add to the list those drivers that work with 
GSM modems. 
4. Select the driver(s) you want to add and click the OK button to return to the Paging 
Service Setup dialog box. 
To configure the driver's parameters 
1. Select the driver you want to configure. 
2. Click the Setup button to open the driver's related setup dialog box. 
To define the call management options 
1. Type the number of tries in case a call fails. 
2. Define the time interval (in seconds) the system waits before trying.  
Paging Service Overview 

 
 

 
 

   

 
 

 
 
 

Defining Call Management 
This field defines both the number of times connection is attempted before a failure 
message is sent and the time-out before each call attempt. 
1.   In the Number Tries if call fails field, type in the number of times a transmission is sent. 
2.   In the Time-out before New Try field type in the number of seconds between each 
connection attempt. 
3.   Click OK to confirm. 
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Driver Setup  
This option defines the selected driver's setup. In general different dialog boxes open for 
different drivers. 

 
 

 

 
   
 
 
 
 

E-mail Driver Configuration (Direct SMTP connection) 
A SMTP server can be used to send E-mail (directly) by defining the full address of the 
SMTP server given by the Internet provider. 

 
 

 

 
   
 
 
 
 

E-mail Driver Configuration (With Internet modem connection)  
E-mail can be sent through a modem and an Internet connection: 
1.   Setup the Internet connection independently of the application.  
2.   Check the option ‘Connect to the server using a modem’ 
3.   In the E-mail Driver Setup dialog box select the name of your Internet connection. 
4.   Define the login and password of the connection. 
5.   The SMTP Server Address can be either an IP address or the server name. 
6.   In ‘your E-mail address’ you can fill in the recipients address. 
7.   Click OK to confirm. 
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SMS Driver Configuration 
Each country already has an SMS driver profile configured and therefore generally these 
do not need to be configured. However, in most countries SMS messages are sent via 
TAPI or ERMES servers. Therefore, if the SMS driver profile is not in the list contact 
Wizcon Systems for an updated configuration file. 

 
 

 

 
   
 
 
 
 

Pager Driver Configuration 
Each country already has a page profile configured and therefore generally these do not 
need to be configured. However, in most countries message pagers are sent via TAPI or 
ERMES servers. Therefore if the SMS driver profile is not in the list contact Wizcon 
Systems for an updated configuration file. 
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Fax Driver Configuration 
Note:    To avoid flow communication problems select the hardware flow control option by 
clicking the More button.  
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Voice Driver Configuration 
Note:     No specific parameters are needed in the configuration of the voice driver. 
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Vocal Server 

 
 
 
 
 

Vocal Server  
The Vocal Server dialog box configures the sound of the voice message defined in the 
Alarms dialog box Action on Alarm tab AAM field. The voice can be defined as male, 
female, according to age, volume, pitch, rate, country of origin and more. 
Note:     All WAV files played by the AAM must be in mono format and not stereo. The 
following format must be used 44kHz 16bit mono. 

o To open the Vocal Server Setup 
In the Quick Access bar click the AAM icon. The Advanced Alarm Management dialog box 
opens. Click Vocal Server Setup to open the Vocal Server Setup dialog box. 
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This dialog box has the following fields: 

About    This button when clicked opens the Vocal Server license agreement.  

Engine    The Engine field defines the type of synthesizer. 

Test 
Message    Type in the message of the alarm text    

Advanced - when clicked this button opens the Voice Synthesis 
Parameters dialog box.  

Voice 
Synthesis 
Parameters: 

Voice - this field defines the type of voice speaking the message 
Rate - this field defines how fast the message is spoken 
Pitch - this field defines the pitch the message is spoken  
Volume - this field defines the volume at which this message is spoken 

1.    In the Engine field click the arrow in the dropdown list and select ViaVoice Outloud 4.0. 
2.    In the Text Message field type in the text of the voice message. 
3.    In the Voice field click the arrow to open the dropdown list and select the voice type. 
4.    In the Rate, Pitch and Volume fields slide the button to change parameters. 
5.    Click the Advanced button to open the Voice Synthesis Parameters dialog box to 
make further changes to the voice. 
6.    Click OK. 
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Vocal Server Overview 
 
The Vocal Server enables you to define a vocal interface to control the communication of 
an application using the telephone, from a simple telephonic keyboard. 
The vocal server interacts with an internal database. This database contains a set of 
variables that can be read or written by specific functions of the scripts (in reaction to 
operator commands for example).  
Some variable can be linked to external variables (variables belonging to an external 
application) through interface drivers: DDE driver, OPC driver, specific drivers.  
The database has a double architecture: physical and logical. The physical architecture of 
the database allows to physically localize variables and to connect them to the external 
world (internal variable, driver and relative address to this driver). The logical architecture 
of the database enables to define a representation of the data independent of their physical 
implementation. It allows to define logical groups, representative of physical entities of 
identical structure: office, electric module, machine, etc.  
Variables are referenced in scripts by designating them by their logical name and their path 
in the logical architecture of the data base: Set point and BuildA\Floor1\Office103 for 
example. The logical path can be contextually defined by the identification of the in line 
operator, thus allowing to use the same script to order some different variable sets.  
The vocal server manages a list of identifiers (channel number, user code). Each identifier 
can be associated to a script and a path in the logical architecture of the database (logical 
group).  
Configuring the Vocal Server 

 
 

 
 

   

 
 

 
 
 
Configuring the Vocal Server 
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Messages 
Click on this button to consult or edit the recorded voice messages. 
 
Programs 
List of defined scripts (or programs). This list can contain up to 16 different scripts, 
numbered 00 to 15. The script marked by '>' is the script that is activated by each 
connection.  
 
To edit a script, click the corresponding line in the list then click on the "Edit... button. 
If the selected line is empty (addition of a script), a dialog box is displayed prompting you 
to select a file; select an existing script (script importation) or type the name of the script 
you want to create (create a new script).  
 
To remove a script from the list, select the corresponding line in the list then click on the 
Remove button. A removed script is only removed from the list. The corresponding file is 
not deleted.  
 
The > initial Program button allows you to define the script that will be activated at every 
operator's connection. Such script is marked by ' > '.  
 
The Broadcast button enables you to transmit the defined script list and the associated 
program files to all the stations connected on the network (updating the configuration of a 
vocal server will be distributed to several stations).  
 
Database 
Name of the file containing the description of the used database. If no database is defined, 
type the name of a new database file in the edit field, with the .vab extension.  
 
To edit the database designated in the edit field, click on the Edit… button.  
 
The Broadcast button allows you to transmit the defined database to all the stations 
connected on the network (updating of the configuration of a vocal server to several 
stations).  
 
Identifiers 
List of identifier codes "recognized" by the vocal server. This list can be referenced by 
specific functions in scripts to authorize or not a received identifier code and to get the 
contextual parameters associated with this identifier code: associated program and logical 
group.  
 
To create a new identifier, type the identifier code in the Id field, the code of the associated 
program (00 to 15) in the Prog field and the name of the logical group in the Group field, 
then click on the Apply button ". The name of the logical group can be selected also in the 
list of group defined in the database by clicking on the browse button on the right of the 
field. The program name and group name are optional.  
 
To delete an identifier, select the corresponding line in the list then click on the Remove 
button.  
 
The Broadcast button allows you to transmit the defined list of identifiers to the all stations 
connected on the network (updating the configuration of a vocal server distributed on 
several stations).  
 
Voice synthesis 
Select the voice synthesis motor to use. When a voice synthesis motor is selected, it is 
immediately initialized. It will be then automatically initialized every time the application will 
be launched. 
Selecting None stops the voice synthesis motor. 
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Select the voice to use. When the voice is modified, the voice synthesis motor is 
immediately reset with the new voice. 
 
Adjustment of the voice synthesis 
- Speed: this parameter defines the elocution speed of the synthesis  
- Pitch: this parameter defines the tonality of the voice generated, low (high value) or high 
(low value)   
- Volume:  this parameter defines the sound level of the message generated. 
 
To test the selected voice synthesis motor and the adjustments, type a text in the field Test 
message , then click on the button Listen . 
Vocal Server Overview 

 
 

 
 

   

 
 

 
 
 

WAV Messages 
The following messages are held in the product Bin.To activate the message the following 
format must be defined in the Frequency Formatting dialog box: PCM48KHz.8bit.mono. 
File names cannot be modified. 

This message is used to inform the user that the alarm ACKFILE.WAV message has been acknowledged. 

This message is used to inform the user that the alarm ENDALARM.WAV has ended. 

This message is used to inform the user that the ENDMSG.WAV    message has ended. 

This message is used to inform the user that the alarm STARTALARM.WAV is starting. 

This message is used to inform the user that their 
WAITACTFILEACKEND.WAV    message has been received and that they can either 

press * to confirm it or press # to exit the message. 

This message informs the user that their message WAITACTFILEEND.WAV    was received and that to end the message press #. 
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Voice Synthesis Parameters 
The Voice Synthesis Parameters edits the voice of the voice message. 
This dialog box has four tabs: 

o    Voice - defines the voice label, gender, and other parameters. 
o    Features - defines voice language, dialect, style and more 
o    Dictionaries - holds lists of words, roots, abbreviations common to the module. 
o    Identifiers - lists the identifier codes recognized by the Id field. 
o To open the Voice Synthesis Parameters 

In the Vocal Server Setup dialog box click the Advanced button to open the Voice 
Synthesis Parameters dialog box. 

 
 
 

 

 
   
 
 
 
 

Voice Tab 
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This tab has the following fields: 

This field defines the voice sound in the following options: Label, Voice vocal tract, pitch, speed, volume, head size, pitch fluctuation, Characteristics roughness and breathiness. 

Describe As    This option defines voice gender and age. 

Store    This option displays the Edit Stored Voices list 

Edited Stored This option is used to edit the Stored Voices list Voice 

Show/Hide This option shows/hides the test panel where the defined voice can 
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Test Panel    be tested, compared to another voice in the list and saved 

  
1.   From the Speaker listbox click the arrow to select the speaker type. The values in the 
Voice Characteristics tab change accordingly. 
2.   Change the sound of the voice using the Voice Characteristic fields. 
3.   Click Test to hear the voice. 
4.   To change the voice gender click the Describe As button to open the Describe Voice 
As dialog box, where you can change the gender characteristics. 
5.   Click the Show Test Panel button to compare the voice to another voice in the list. 
6.   The Save Speaker button saves the voice to file. 
7.   Click the Delete Speaker button to erase this voice. 
8.   Click OK to confirm. 

 
 

 
 

   

 
 

 
 
 

Features Tab 
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This tab has the following fields: 

Native Language This option defines language and dialect &Dialect 

Style    This option defines type of speech 

This option defines how the selected tab will be processed: 
Interpret - causes all tags to be recognized and interpreted 
Treat as Unknown - causes all tags to be treated as unknown and 
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Tag Processing processed according to the application's definitions  
Speak - causes all unknown tags to be spoken as individual 
characters and numbers 
Ignore - causes all unknown tags to be ignored 

This option defines the Audio sampling rate used. PC optimizes 
Audio    the sampling rate for the computer while Phone optimizes 

sampling rate for the telephone 

This option shows/hides the test panel where the defined voice can Show/Hide Test    be tested, compared to another voice in the list and saved 

o Features Definition 
1.   In the Speaker field click the arrow to open the dropdown list and select a speaker 
type. 
2.   In the Native Language and Dialect field click the arrow to open the dropdown list and 
make your selection. 
3.   In the Style field click the arrow to open the dropdown list and make your selection. 
4.   In the Tag Processing field select the relevant processing method. 
5.   In the Audio field select either PC (11.025kHz) or Phone (8kHz). 
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6.   Click the Show Test Panel button to compare the voice to another voice in the list. 
7.   Click OK to confirm. 

 
 

 
 

   

 
 

 
 
 

Dictionaries Tab 
This tab is used to add or edit dictionaries and to define special word types. 

 
This dialog box has the following fields: 

There are three dictionary types: 
Special Words - contains entries which may include digits or other 
non-alphabetic symbols or entries that require translations with 

Dictionary Type  annotations, SPRs or other non-alphabetic symbols 
Roots - contains the root of the word only 
Abbreviations - contains entries that include periods 

When this button is clicked it opens the Edit Dictionary dialog box 
Edit    where you can add, edit, delete, add speakers, keys and 

translation 

This option shows/hides the test panel where the defined voice Show/Hide Test can be tested, compared to another voice in the list and saved 
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1.   In the Dictionary Type field click the arrow to open the dropdown list and select a 
dictionary term. 
2.   To edit a dictionary term click the Edit button to open the Edit Dictionary dialog box. 
3.   Click OK to confirm. 

 
 

 
 

   
 
 
 
 

Edit Dictionary  

 
This dialog box has the following fields: 

Add    This option when clicked opens the Dictionary Entry dialog box 

Edit    This option when clicked opens the Dictionary Entry dialog box 

Delete    When selected deletes the dictionary entry 

The string of characters that the dictionary searches for. Click this option to 
hear the pronunciation of the key Key    

Trans Click this option to hear the translation of the key. 

    
o Managing dictionaries 

1.    To add a new dictionary entry, click the Add button. The Dictionary Entry dialog box 
will open. Complete the fields as described in Dictionary Entry and click OK to return to 
this dialog box. 
2.    To edit a dictionary entry, select the entry and click the Edit button. The Dictionary 
Entry dialog box will open. Complete the fields as described in Dictionary Entry and click 
OK to return to this dialog box. 
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3.    To delete a dictionary entry, select the entry and click the Delete button. The entry will 
be removed from the list. 
4.    Click the Key button to listen to the pronunciation of the key for the selected dictionary 
term. 
5.    Click the Trans button to listen to the pronunciation of the translation that was provided 
by the user for the selected dictionary term.  
6.    Click OK to confirm. 
 

 
 

 
 

   

 
 

 
 
 

Dictionary Entry  
This dialog box opens when the Edit Dictionary Add or Edit buttons are selected. 

 
This dialog box has the following fields: 

Key    The string of characters that the dictionary searches for. 

Translation    The translation of the key that the dictionary searches for. 

SPR from Key    Phonetic alphabet the dictionary searches for 

SPR from The phonetic alphabet that the dictionary searches for. Translation 

1.   In the Key field type in the new directory term. 
2.   In the Translation field type in the way that the word should be pronounced. 
3.   If the translation sounds correct click OK, if not continue modifying the spelling of the 
translation. 
4.   For phonetic alphabet pronunciation click the SPR from Translation button. 
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5.   Click OK to confirm. 
 
 

 
 

   
 
 
 
 

Identifiers Tab 
The Identifier tab dialog box holds a list of identifier codes recognized by the vocal server.  

 
This dialog box has the following fields: 

Description This field shows the description of the selected speaker 

Guide    This field shows the Description field's code 

Show/Hide This option shows/hides the test panel where the defined voice can be 
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Test tested, compared to another voice in the list and saved 

1.   In the Speaker field click the arrow to open the dropdown list and select a speaker 
type. 
2.   Click the Show Test Panel button to compare the voice to another voice in the list. 
3.   The Save Speaker button saves the voice to file. 
4.   Click the Delete Speaker button to erase this voice. 
5.   Click OK to confirm. 
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User Message Format 

 
 
 
 
 

User Message Format 
This section shows message formats for different kinds of pager services. 

E-mail Message Format 

Station Name: Station1  
Alarm Status: Alarm Started  
Alarm Date/Time: Thursday August 30 2001, 10 Hours, 22 Minutes, 21 
Seconds  
Alarm Text: The test variable is equal to 46  
Alarm Severity: 2  
Alarm Zone: 15  
Alarm Family: Electrical  

Note:    The contents of the Alarm Text field will appear also in the Object of the E-mail. 

SMS Message Format 

St:   Station1 
Alarm Started: Thursday August 30 2001, 10 Hours, 57 Minutes, 46 
Seconds, <The test variable is equal to 46> 
Svr:   2 
Zn:   15 
Fam:   Electrical. 
  

Pager Message Format 
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Station Name: Station1 
Alarm Date/Time: Thursday Augu 
Alarm Text: The test variable is equal to 46 Alarm Severity:  
Alarm Family: Electrical  
  

Fax Message Format 

<Logo> 
<Fax Message Header> 
Station Name: Station1 
Alarm Status: Alarm Started. 
Alarm Date/Time: Thursday August 30 2001, 10 Hours, 22 Minutes, 21 
Seconds  
Alarm Text: The test variable is equal to 46  
Alarm Severity: 2 
Alarm Zone: 15 
Alarm Family: Electrical 
  

Printer Message Format 

Station Name: Station1  
Alarm Status: Alarm Started  
Alarm Date/Time: Thursday August 30 2001, 10 Hours, 22 Minutes, 21 
Seconds  
Alarm Text: The test variable is equal to 46 
Alarm Severity: 2  
Alarm Zone: 15  
Alarm Family: Electrical 

Station name is: Stations1 
Alarm started at: 
Date is: Thursday August 30 2001, 11 Hours, 12 Minutes, 28 
Seconds 
Severity is equal to 
Family is: Electrical. 

Voice Message Format 
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Note:    An introduction message will be played before the alarm message. An alarm 
message can be acknowledged by pressing the * character after which a confirmation 
message will be played. 

 
 

 
 

   

Advanced Alarm V

 
 

iewer 

 

Tools AAM Viewer 
The AAM viewer displays detailed information on all AAM alarms in the application. 

 

 
 

 

 
 

   
 
 
 
 

Advanced Alarm Viewer 
The AAM viewer displays detailed information on all AAM alarms in the application. 

o To open the Advanced Alarm Viewer 
In the Quick Access bar click the AAM icon. The Advanced Alarm Management dialog box 

 Alarm Viewer to open the Advanced Alarm Viewer dialog box. 

In th ed Alarm Viewer. The Advanced Alarm 

opens. Click the Advanced
Or,  

e menu bar select Tools and then Advanc
eView r opens.  
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Description of available statistics: 

Displays the number of alarms that are being 
processed Alarms in process    

Displays the number of alarms that have been 
processed Alarms processed    

Displays the number of alarms that have 
successfully reached their destination Alarms well processed 

Alarms processed with errors    Displays the number of erroneous alarms generated 

Displays the number of users that have been 
reached  Joined users 

Displays the number of users that cannot be 
reached  Unreachable users 

Alphanumeric messages sent 
correctly 

Displays the number of alphanumeric message sent 
correctly  

Alphanumeric message sent with 
error  

Alphanumeric messages sent with error. Displays 
the number of erroneous alphanumeric messages  

Displays the number of vocal message sent 
correctly. Vocal messages sent correctly    

Vocal messages sent with error    Displays the number of erroneous vocal messages  

616 



Chapter 17 Advanced Alarm Management 

Displays the number of alarms that have been 
acknowledged by user  Alarms acknowledged    

Displays the number of alarms that have not been 
acknowledged  Alarms unacknowledged    

Description of fields available in the Events Summary: 

AAM ID    Displays the alarm identifier provided by the AAM module 

Status    Displays an icon according to the management status of the alarm  

Date    Displays the date the alarm was raised  

Time    Displays the time that the alarm was raised 

User    Displays the name of the user receiving the alarm 

Driver Name    Displays the driver used to reach the user 

Destination Displays the destination address of the sent message 

Backup User Displays Yes if the user is the backup user, otherwise it displays No.  

Detailed 
Status    Additional informations on the AAM status 

More Details This button when clicked opens the Event Log Journal  

Note:     In this version the only service that can be supported by the Backup User is Vocal. 
 

 
 

 
 

   

 
 

 
 
 
Advanced Alarm Viewer 
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The Advanced Alarm Viewer provides you with a statistic view of your AAM alarms: 
number of alarms generated, how many alarms are in-process and also the amount of 
alarms that were successfully sent to the alarm target or the alarm recipient, and the 
number of alarms that failed to get to their defined targets. 
In addition, the Advanced Alarm Viewer displays a list view of the AAM alarms including 
the following information: 

this column displays the status of the generated alarm. Status 

this column displays the alarm serial number provided by the system. AAM ID 

this column displays the alarm date. Date 

this column displays the alarm start time. Time 

this column displays the user attached to the alarm. User  
this column displays the driver used for the alarm generation. Driver Name 

this column displays the alarm message destination Destination 

this column displays Yes if a backup user was defined and No if a backup 
user was not defined. 

Backup User 

this column displays additional information on the AAM status. Detailed 
Status 
 
To refresh this window and display updated data, click the Update button. 
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To display the Event Log Journal window, click the More Details button. 
 
 

 
 

   

 
 
 

 
 

Event Log Journal 
The Event Log Journal is a table that holds the historical record of all events detected by 
the Advanced Alarm Management module. A new Event Log Journal file is opened every 
day where each event is written in order of occurrence. The file is saved in the Trace folder 
located under the application bin folder in the following format: 

tYYMMDD.LOG 
YY=year, MM=month DD=date 

o To open the Event Log Journal 
Click the Details button in the Advanced Alarm Viewer dialog box. 
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The Event Log Journal has the following fields columns and options: 

Date: The date of this Event Log Journal file 

The AAM service where the event occurred, this could be Pager, Vocal Service: Server or both 

Events:    The Events button when clicked opens a list of all event types  

Print: The Print button when clicked prints a copy of this page 

Time:    The event time stamp 

The AAM service where the event occurred, this could be Pager, Vocal Service:    Server or both 

Event: Label of the event including the event code number and name 

Identifier:    The user whose station generated the event 

Information:    Additional information regarding the event 

o To select the Event Log Journal date: 
1.   In the Date field click the arrow to open the dropdown list.  
2.   Select the relevant date. The Log will show only the events that occurred on the 
selected date. 

o    To select a service: 
1.   In the Service field click the arrow to open the dropdown list.  
2.   Select the relevant Service. This could be Pager, Vocal Server or both. The Log will 
show only the events that occurred in the selected service. 

o To select an event type: 
Click the Events button to open the Events Type list.  
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1.   Check the relevant event types.  
2.   Click the All button to select all event types and None for no event types. 
3.   Click Close to close the list. The selected event types will be recorded. 

 
 

 
 

   
 
 
 
 

Event log 
The Event Log Journal window contains the historical record of all the events that were 
detected by the AAM. 
The Event Log Journal Files 
The event log is recorded to files - a file per each day. The files are stored in the a folder 
named trace, located under your bin folder. 
The name of the stored log files have the format: tYYMMDD.LOG, where: 
YY =year; MM=month; DD=day of the month.  
For example a file named t010702.log is a file created on July 2nd, 2001. 
The stored event log file is actually a daily table containing the chronological event list of a 
day. 
Each line in this table describe an event in 5 columns: 

The event time stamp. Time 

The service correlated with the event (for example, pager). Service 

Event  Label of the event, including the event code number and name (for example: 
"04:Call Failed") 

The user whose station generated the event. Identifier 
Additional information about the event Information 

The Event Log Journal View 
You can customize the view of the Event Log Journal window by selecting a date, the 
services whose events you want to view and the event types. 
To select a date 
1. Click on the Date drop-down box to display a list of dates. The date format is dd/mm/yy, 
where dd is the day, mm is the month and yy is the year. 
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2. Select the date whose log file you want to display. The Event Log Journal now displays 
the selected date events. 
To select a service 
1. Click on the Service drop-down box to display the list of available services. 
2. Select the service whose events you want to display: select All to display all the services 
events, Pager to display pager services events and Vocal Server to display vocal server 
events. 
To select event types 
1. Click on the Events button to display a list of all possible events. 
2. Check the events you want to display. 
3. Click the All button to display all the event types in the Event log Journal window. Click 
None to deselect the list of events. 
4. Click the Close button when done. 
Customizing the Event Log Journal window 
The event log list can be customized, sorted and resized and each column of the event log 
list can be modified. 
To customize the event log list columns 
1. Position your cursor on the column you wish to customize and click your mouse right 
button, a popup menu is displayed, enabling to select one of the following options: 
Column title , Column width , Column position, Column alignment, Sort on column, Mask, 
Display, Printing, Export. 
2. Define each of the options as applicable.  
To adjust the event log list columns width 
You can manually adjust the event log list columns by dragging the event log window title 
bar column lines to the desired width. 
To sort the event log list 
You can sort the list both by increasing and decreasing order of each column. Click on the 
title of the column you want to sort the list by: an arrow will indicate whether the list is in 
increasing or decreasing order (first click is used for increasing order, second click is used 
for decreasing order). 

 
 

 
 

   

 
 
 

 
 

Export 
You can export the event log table data either to the clipboard or to a specified file. 
To export the event log table data 
1. Right click the event log table and select Export from the popup menu displayed. 
The Export dialog box opens. 
2. Select the columns you wish to export. 
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3. Check the Include first line header checkbox to display the columns title in the 
exported file. 
4. Select the columns separator in the exported data (tab, semi colon or comma). 
5. Define where to export your table data: to the clipboard or a file. If you selected to export 
the data to a file, click the browse button to select the file to which you want to export the 
table data. 
6. Click OK when done. 

 
 

 
 

   

 
 

 
 
 

Customizing the Event Log Journal Window 
Each column in the Event Log Journal can be customized according to requirements. 

o To customize the Event Log Journal: 
Right click in the column you wish to customize to open the dropdown list options.  

o To define the column title: 
1.   Select Column Title from the dropdown list to open the Column Title dialog box. 
2.    Type in the new name of the column and click OK.  

o To define the column width: 
1.   Select Column Width from the dropdown list to open the Column Width dialog box. 
2.   In the Column Width field type in the new measurement and click OK.  

o To define the column position: 
1.   Select Column Position from the dropdown list to open the Column Position dialog box. 
2.   In the Column Position field type in the new position (range 1-5) and click OK. The 
position of the column within the table will change accordingly. 

o To define column alignment: 
1.   Select Column Alignment from the dropdown list to open the Column Alignment dialog 
box. 
2.   In the Title Alignment field select either; Left, Center or Right. 
3.   In the Column Alignment field select either; Left, Center or Right and click OK. The 
column will be aligned accordingly. 

o To sort a column: 
Select Sort on Column from the dropdown list. The column in the Event Log List will be 
sorted accordingly. 

o To mask a column: 
Select Mask from the dropdown list. The column will be hidden. 

o To display a column: 
This option is used to retrieve masked columns. 
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1.   Select Display from the dropdown list to open the Column Display list. 
2.   Select the columns you wish to display in the Event Log Journal table and click OK. 
The selected columns will open in the table.  

o To print a column: 
Select Printing from the dropdown list to open the Printing Format list 
1.   Select the columns you wish to print. 
2.   Select printing orientation, which is either Default, Portrait or Landscape. Click OK to 
print the column. 

o To export a column: 

 
1.   Select Export from the dropdown list to open the Export dialog box. 
2.   Select the columns you wish to export. 
3.   Check the Include first line header checkbox to display the columns title in the exported 
file. 
4.   Select the columns separator in the exported data (tab, semi colon or comma). 
5.   Define where to export your table data: to the clipboard or a file. If you selected to 
export the data to a file, click the browse button to select the file to which you want to 
export the table data. 
6.   Click OK when done. 

 
 

 
 

   
 
 
 
 

Column Title 
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 to open the Column title dialog box where you can rename the column's 

 

Select this item
title. 

 

 
 

   

 

 

Column Width 
o open the Column width dialog box where you can change the column's 

 

 

 
 

Select this item t
width. 

 

 
 

   

 

 

Column Position 
pen the Column position dialog box where you can change the position 

 

 
 

 

Select this item to o
of the column in the window. 
You can type a number in the range 1 - 5 (as this window contains 5 columns), where 1 is 
the left-most column and 5 is right-most column. 
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 the title 
alignment (left, center or right) and the column alignment (left, center or right). 

 

 
 

Column Alignment 
Select this item to open the Column alignment dialog box where you can define

 

 
 

   

 

 

Select this item to sort the event log list according to this column. 

 

 

 
 

Sort on Column 

 

 
 

   

 

 

rrent column (both title and contents of column will disappear 
upon clicking the Mask item. 

 

 
 

 

Mask 
Select this item to hide the cu
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 display dialog box where you can select the columns 
to display in the event log window. 

 

 
 

Display 
Select this item to open the Column

 

 
 

   

 

 

log box where you can select the columns 
you want to print and the printing orientation. 

 

 

 
 

Printing 
Select this item to open the Printing format dia

 

 
 

   

 

 

tting dialog box is used to define the format of the alarm message that 
is s  t

ick Access bar click the AAM icon. The Advanced Alarm Management dialog 

2.    Click the Message Format button to open the Message Formatting dialog box. 

 
 

 

Message Formatting 

The Message Forma
ent o the user.  
o To open the Advanced Alarm Viewer 

1.    In the Qu
box opens.  
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This dialog box has the following options and buttons: 

This field defines the type of alarm format sent to the user:  
Long which, when checked, indicates that the user will receive an 
alarm message holding all the alarm fields available. The defaults for 
this field are Start time and Text. 

Format    
Short which, when checked, indicates that the user will receive an 
alarm holding limited fields only. The default for this field is Text. 
Note: Check the End Time Message checkbox to enable the user to 
receive notification that an AAM has ended. 

This list holds all the columns that can be selected and which will 
appear in the AAM message sent to the user. Columns List    

Move Up    Moves a selected column from the Columns List one space up.    

Move Down Moves a selected column from the Columns List one space back. 

Selects all the columns appearing in the Columns Lists and adds them 
to the AAM message format. Select All 

Deselect All    Unchecks all the selected messages from the Columns List. 

Default Returns the options of this dialog box to default. 

Note:     A message will not be sent to a vocal client in the following circumstances: 
o If the alarm is acknowledged by pressing the button "*" on a cellular phone. 
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o If the AutoAck option is selected.    
 

 
 

 
 

   

 
 

 
 
 

Message Formatting 

 
This dialog box has the following options and buttons: 
Format This field defines the type of alarm format sent to the user:  
Long which when checked indicates that the user will receive an alarm message holding 
all the alarm fields available. 
Short which when checked indicates that the user will receive an alarm holding limited 
fields only. 
Columns List This list holds all the columns that can be selected and which will appear in 
the AAM message sent to the user. 
Move Up Moves a selected column from the Columns List one space up.  
Move Down Moves a selected column from the Columns List one space back. 
Select All Selects all the columns appearing in the Columns Lists and adds them to the 
AAM message format. 
Desselect All Unchecks all the selected messages from the Columns List. 
Default Returns this dialog box’s options to the application’s default. 

 
 

 
 

   

 

628 



Chapter 18   Users Timetable 
Users Timetable ................................................................................................................629 
Users Timetable Overview ................................................................................................630 

Users Timetable Overview.............................................................................................630 
Users Timetable Overview.............................................................................................631 
Menu bar........................................................................................................................632 
Toolbar...........................................................................................................................633 

Customizing the Users Timetable......................................................................................633 
Selecting the Schedule Time Frame .................................................................................635 

Selecting the Schedule Time Frame..............................................................................635 
Selecting the Schedule Time Frame..............................................................................636 
Yearly Schedule.............................................................................................................638 

Scheduling Teams.............................................................................................................640 
Scheduling Teams .........................................................................................................640 
Scheduling a Team ........................................................................................................642 
Mark/Stop Marking Options ...........................................................................................643 

Shift Management .............................................................................................................643 
Overview ........................................................................................................................643 
How to............................................................................................................................644 

 
About this chapter: 
Users Timetable Overview discusses the basic User Timetable options. 
Customizing the Users Timetable discusses how to create a personalized teams 
schedule. 
Selecting the Schedule Time Frame discusses how to create time frames.  
Scheduling Teams discusses how to create a team schedule. 
 

 
 

 
 

   

 
 

 
 
 

Users Timetable 

Click the Users Timetable icon to open the Users Timetable window where you can 
schedule the alarm recipient teams. 
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Users Timetable 

Overview 

 
 
 
 
 

Users Timetable Overview 
The Users Timetable module enables efficient management of the application's workforce 
teams. Using this module, teams can be selected and scheduled in a calendar 
environment, which can be either; daily, weekly or yearly. For further timetable 
management efficiency each team can be allocated a specific color. 
Commands and options in the Users Timetable module are performed through the 
module's menu bar, toolbar or by right clicking in the timetable.  
Timetable intervals can be locked or unlocked. This could be to reserve time period cells 
for scheduled teams or for defining public holidays and so on. 
Note:    The User Timetable is a   ccessible via the Web. 

o To access the Users Timetable: 

In the Quick Access Bar click the  icon. The Set Users Timetable dialog box opens. 
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Users Timetable Overview 
The application provides you a new and easy way to schedule your application’s teams. 
Using the Users Timetable you can select a team and schedule it on a calendar 
environment that offers you three different views: Weekly schedule, Daily schedule and 
Yearly schedule. Each team has its own color, which makes it easier to manage this 
timetable. 
The Users Timetable can be accessed from the quick access bar by clicking on the icon. 
 
To learn how to work with the Users Timetable follow these steps: 
Selecting the schedule time frame
Scheduling a team
Customizing the table
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Menu bar 
The Users Timetable menu bar has the following options and commands: 

File 
Save 
Print 
Exit 

Edit 

Select all 
Clear - which has the following sub options: 
• Clear all 
• Clear selected 
• Clear row 
• Clear column 

View 

Fit to view all 
Gridlines - which has the following sub options: 
• Both 
• Vertical 
• Horizontal 
• None 
Team Name 
Week Separator 

Options 

Set time intervals 
Stop marking 
Headers font 
Colors 
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Toolbar 
The Users Timetable toolbar icons have the following options and commands: 

  Save current group timetable 

  Print current group timetable 

  Clear group timetable 

  Insert row to the timetable 

  Remove the row from the timetable 

  Set timetable interval 

  Lock selected cells in the timetable 

  Unlock selected cells in the timetable 

  Toggle stop/start marking in the timetable 

 
 

 
 

   

 
 
 

 
 

Customizing the Users Timetable 

The Users Timetable fonts and colors can be customized to meet your personal 
requirements. Additionally rows and columns can also be added or removed. 
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o To customize the timetable font: 
1.    In the Options menu select Headers Font. The Font dialog box opens. 
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2.   l

elect Colors. The Colors dialog box opens. 

 Se ect and define the font type, style and size. 
3.    Click OK to confirm. 

o To customize timetable colors: 
1.    In the Options menu s

 
2.    Click the dropdown menu in each field to display a color palette. Select the relevant 
color. 

   When a group with teams is selected for the first time the teams are assigned 

mize timetable gridlines: 
.    In the View menu select Gridlines. The Gridlines sub menu opens. 

2.   e

rtical gridlines only 

o o insert time rows: 

1.   ic

3.    Click OK to confirm. 
Note:  
random colors. 
 

o To custo
1

 Th re are four options: 
o Both - displays both horizontal and vertical gridlines 
o Vertical - displays ve
o Horizontal - displays horizontal gridlines only 
o None - displays no gridlines 

 
 
T

 Cl k the  Insert icon o
ct sert time row. The In

r right click in the table area to open the popup menu and 
sele In sert New Time dialog box opens. 
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2.    Using the arrows scroll up or down to define the new time. 
3.    Click OK to confirm. A new row with the new time will be added to the table. 

o To remove time rows: 

Select the specific row and then click the  Remove icon or right click in the table area to 
open the popup menu and select Remove time row. The time row is removed. 
 

 
 

 
 

 

   

Selecting the Schedule Time Frame 

 
 
 
 
 

Selecting the Schedule Time Frame 
The Users Timetable has three time frames each of which changes the appearance of the 
table. The frames are:  

o     Daily - displays a 24 hours work schedule 
o     Weekly - displays a weekly work schedule 
o     Yearly - displays a monthly schedule with upto 31 days per month 

Note:     The start day can only be set in a weekly time frame whereas start and end times 
can be set in all time frames. The Daily/weekly/ Yearly Schedule field is activated only after 
a group with teams is selected. 
To customize a time frame: 
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1.    In the Options menu select Set Time Intervals or click the  Set Time icon. The Set 
Time Intervals dialog box opens. 
2.    In the Time Interval field define the period of time that each time cell represents. The 
default is 60 minutes. 
3.    In the Day Start At and Day Ends At fields use the arrows to scroll and define the new 
time. The default is 00:00. 
4.    Select the day of the week that the timetable begins. 
Note:     The Yearly Schedule field at the bottom of the dialog box is for reference purposes 
only. 
 

 
 

 
 

   

 
 
 

 
 

Selecting the Schedule Time Frame 
 
The Users Timetable provides three time frames: Daily schedule, Weekly schedule and 
Yearly schedule. 
Each time frame changes the appearance of the table accordingly. 
To select the timetable time frame 
Open the schedule drop-down menu and select the time frame: 
 Daily schedule: the table displays a 24 hours schedule. 
 Weekly schedule: the table displays a one week schedule.  
 Yearly schedule: the table display a monthly schedule, containing up to 31 week days 
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ou can customize each of the time frames to start and end in a different time or day. 

om the Options menu, or click on the time intervals icon 

 dialog box opens. 

0) and end time (default is 00:00). 

chedule enables you to schedule teams to a selected month and 

n click the This month button to display current month calendar and use the arrow 

o do that, select Week Separator 

 

Y
To customize the time frames 
1. Select Set Time Intervals fr
located on the toolbar. 
 The Set Time Intervals
2. Define the timetable time interval (default is 60). 
3. Define the day start time (default is midnight 00:0
4. Select the day a week begins with (default is Monday). 
The Yearly timetable 
Selecting the Yearly s
year. 
You ca
buttons to move back and forward in the year's months. 
You can add a week separator to the monthly calendar. T
from the View menu. 

 

 
 

   

 

 

s you to deine a typical 

de: Use this mode when all days have the same timetable. Select the icon 

 

 
 
Selecting the planning mode 
 

ou have two modes for planning: Daily, and weekly which allowY
day or week in your calendar. The yearly calendar allows you to define special days or 
times different to the standard times. 
 
 Daily Mo  

es, a dialog box will appear allowing you to 
r all 

ode: Choose this mode if the planning changes depending on the day of the 

from the toolbar or the properties menu.  
Note: when switching weekly to daily mod
choose the day to use as the reference for the daily mode. Be careful: The planning fo
other days will be lost after saving (you can use the cancel button if you don’t want to 
proceed). 
 
 Weekly M
week. For example, weekend working times are different from weekday working times. 
Select the icon  from the toolbar or the properties menu.  
Note: when passing from daily to weekly mode, the daily timetable is automatically 

lanning special days on the annual calendar 
f calendar: 

amming you want to do.  

transferred to every day of the week in the weekly timetable. 
 
P
Open the drop-down list and choose the type o
 Daily or Weekly calendar depending on the type of progr
 Yearly Calendar: This allows you to see the planning month by month. 
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To add a special day (e.g. a public holiday), you must do the following: 
 

638 

1. Select the group on the left to see the list of teams. 

2. Select a team so that you pass into edit mode . 
3. In the calendar, click on the cell in which you want to start the planning and drag 

4. 

the mouse to select the time-period that you need. 

To return to « standard » mode, click the icon  on the toolbar or the menu. 

5. To save the timetable, click the button  on the toolbar, or File, Save. 
 

lick on the button This Month to show the days of the month and use the arrows to move 

 

 
C
forwards or backwards thru the months. 

 

 
 

   

 

 

Yearly Schedule 
le displays a month-by-month view of the yearly calendar. In turn, each 

 

 
 

The Yearly Schedu
month can be split into weeks. 
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o To customize a yearly timeframe: 
1.    In the Select Group field click the drop-down arrow to open the groups/teams list. 
2.    Select the relevant groups and then, in the field above select Yearly schedule. 
3.    To select a month either click the month fields arrow to open a dropdown list or scroll 
backwards/forwards using the Forwards/Backward arrow buttons. 
4.    To select a year click the Year field's arrow and scroll down to select the relevant year. 
5.    Click the This Month button to display the current month's calendar. 
6.    If you have made changes to the User Timetable and wish to return to the timetable 
that is currently saved in the database click the Default Schedule button. 

o To customize a weekly calendar in a yearly timeframe: 
1.    In the View menu select Week Separator. The timetable is marked with weekly 
gridlines. 

o To lock/unlock time intervals: 

 

1.    Select the specific time cell and then click the Locked icon. The selected time cell 
will be locked. 

2.    To unlock a time cell select the relevant cell and click the Unlocked icon. 
Note:     This option is only available in the Daily and Weekly options. Time cells can only 
be locked when the Stop Marking option is on. Locked Time cells remain locked even 
when the group changes. 
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Scheduling Teams 

 
 
 
 
 

Scheduling Teams 
Teams are groups of users defined in Alert Groups. When an alarm is generated and 
targeted to a specific group of users, the team that is scheduled in the Users Timetable at 
that specific time will receive the alarm. 
Note:     Users/Groups/Teams are created in the User Management module. See 
Chapter 7, Security and User Management. 

o To schedule a team: 

 
1.    Click the Select Group dropdown list to display all the application's Alert Groups. A + 
sign to the left of the group's name indicates that the group has teams. 
2.    Click the relevant team. The team will now appear in the List of Teams. 
3.    To change the team color code, right click on the specific team to open the Change 
Teams Color dialog box, and select a color. The team's color identifier will change to the 
selected color both in the List of Teams and in the Users Timetable. 
4.    To schedule a team, select a team and in the Users Timetable click the relevant table 
cells. The cells will be painted the team's color identifier and the name of the team will 
appear in the cell. 

o To print a user timetable: 

1.    To print a timetable either click the Printer icon or select Print from the File menu. 
The Print option dialog box will open. 
2.    Check that the Printer parameters are correct and Click OK. 

o To save a user timetable: 

To save a timetable either click the Save icon or select Save from the File menu.  
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Team Planning 
 
Teams are sub-groups created within work groups marked as a « Shift Group ». During the 
time specified for a given team in the timetable, only the members of that team will be able 
to login to the system. Their session will be closed automatically when the specified time 
period elapses. 
. 
Note: You can define an « overlap time » during which members of the next team can 
login to the system. You can define this overlap time on the user properties dialog box 
launched from the application studio.  
 
Team Planning 

1. Select a group on the left-hand-side of the window in order to see the teams. 

2. Select a team. The window passes into edit mode (represented by the icon ). 
3. Click on the cell for which you want the time period for this team to begin; drag and 

release to define the end. Note that each time you click on a cell, the cell takes on 
the color of the team. 

4. To return to « standard » mode, click the icon  on the toolbar or the menu. 

5. To save the timetable, click the button  on the toolbar, or File, Save. 
To modify a team color 
Each team has a color assigned to it. Double click on the name of the team if you want to 
change it. 
To print the team planning 
Click on the icon  or select the menu File, Print. 
 
To add a new time to the timetable  

Select the icon  on the toolbar or right click anywhere in the timetable. Select « Add a 
Time » in order to add a new time into the timetable at the appropriate place. 
 
To delete a time  

Select the icon  on the toolbar or right click anywhere in the timetable. Select « Remove 
a Time » in order to add a new time into the timetable at the appropriate place. 
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Scheduling a Team 
Teams are sub-groups created within Alert groups specially for scheduling purposes. 
When an alarm is generated and defined to target a certain group of users, the group's 
team that is scheduled at the time of the alarm generation will be the recipient of the alarm. 
To schedule a team 
1. Select the scheduling time frame. 
2. Click the Select Group drop-down box to display all your application's alert groups. A 
plus sign (+) to the left of the group's name indicates that the group has teams. 
3. Select the team you want to schedule. The selected team now appears in the Teams list 
with a colored rectangle to its left. Each team is assigned with a unique color, provided 
automatically by the system. 
4. To change a team's color, double click the team in the Teams list to display the Change 
Team Color dialog box, where you can select a different color from the color palette, or 
define colors of your own. 
5. In the timetable, click the table cell where you want to start the group's scheduling and 
drag the mouse until the desired area is covered. Click again to stop area selection. 
 Note that every time you click on the table, the "clicked" cell will be painted with the team's 
color. 
6. To reserve cells for the scheduled team and prevent other teams scheduling in those 
cells, click the Lock icon on the toolbar. This icon will appear on the locked cells. To unlock 
the cells you locked, click on the unlock icon on the toolbar. This option is available only in 
the Daily and the Weekly schedules. 
 Note that you can lock cells only when the Stop marking option is enabled. 
To stop cells painting 
Click your mouse right button on the table area and select Stop marking from the popup 
menu displayed; or, select Stop Marking from the Options menu. 
To display the team's name on the painted cells 
Select Team Name from the View menu. 
To save the scheduling 
Select Save from the File menu, or click the save icon on the toolbar. 
To print the scheduling 
Select Print from the File menu, or click the print icon on the toolbar. 
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Mark/Stop Marking Options 
Time cells can be automatically marked according to row, column or specific cell. The Stop 
Marking option prevents time cells that are not included in a team's time scheduling from 
being marked. 

o To activate/deactivate the marking option: 
1.   In the Option menu check that the Stop Marking option is not activated. Or, click the 

Toggle icon.  
2.   Select the team for which the time cells are allocated.  
3.   Select the first time cell and then right click to open a popup menu.  
4.   Select either Mark Entire Column or Mark Entire Row accordingly. 

5.   To deactive the Marking option either; click the  icon or from the Options menu 
select Stop Marking or right click in the Users Timetable to open the dropdown list and 
select Stop Marking. 
Note:    Stop Marking is deactivated when a new team is selected.  

 
 

 
 

   

Shift Management 

Overview 
 
 
 
 
 
Overview of the Shift Management calendar 
 
The application offers you a simple way to plan working hours for your teams defined in a 
Shift Group. 
Thanks to this calendar, you can select a team and plan his access rights to the system 
(i.e. when he is able to login to the application). 
There are two planning modes: 

• Daily Mode : Can be used when the planning is the same for every day of the 
week.. 

• Weekly mode : This allows you to plan working times for a typical week (where the 
working times may be different depending upon which day). 

 
Whichever mode is chosen, it is then possible to create "special days" using the "yearly 
calendar". 
 
If a user is not in a team that is currently active, he cannot login to the application. Each 
team has its own 
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You can launch the shift management calendar by clickin the icon , on the Quick 
Access Bar or by launching the web page, ShiftManagement.html. 
 
To learn more about using the shift management calendar, see the following: 
Selection of the programming mode
Team Planning
Configuring the calendar

 
 

 
 

   

How to 

 
Customizing the Table 

 
You can customize the scheduling table fonts, colors and gridlines. In addition you can add 
time rows and day columns. 
To customize the table's fonts 
1. Select Headers Font from the Options menu to display a standard Fonts dialog box. 
2. Select and define the font you wish to use in your table headings. 
3. Click OK when done. 
To customize the table's colors 
1. Select Colors from the Options menu to display the Colors dialog box. 
2. Click the drop-down menu in each field to display a color palette and select the table's 
header background and text colors; cell background and text colors; gridlines colors and 
the yearly schedule colors (week day background and text colors). 
3. Click OK when done. 
To customize the table's gridlines 
Select Gridlines from the View menu, then select: 
 Both - to display both vertical and horizontal gridlines. 
 Vertical - to display vertical gridlines only. 
 Horizontal - to display horizontal gridlines only. 
 None - to display no gridlines. 
To add a time row  
1. Right click on the calendar table area to display the popup menu. 
2. Select Insert Time Row to open the New time dialog box where you can define the time 
to be added to the table. 
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Calendar Configuration 
 
The calendar is entirely configurable. Once saved, the configuration will apply to all users. 
You can configure the grid of the timetable, fonts and the colors.  
 
To personalise the table 

Select the icon  from the toolbar or the property menu. The properties dialog box will be 
launched. The "General Properties" tab allows you to configure the time usage: 
 
 Time interval : Allows you to configure a single time unit in minutes. 
 Start Time : Allows you to configure the time at which the working day begins. 
 End Time : Allows you to configure the time at which the working day ends. 
 First day of the week : The selected day will appear in the first column. 
 
 Gridlines : whether to show the grid lines 
  Both – show horizontal and vertical grid lines. 
 Vertical – show vertical grid lines. 
 Horizontal – show horizontal grid lines. 
 Aucune – No grid lines. 
Team Name : Whether to show the team name in each cell. 
Week separators : Whether to show the week separators. 
 
To customise the fonts 

Select the icon  from the toolbar or the menu in order to launch the dialog box. The 
« Fonts » tab allows you to choose the font to use in the column headers. 
 
To personalize the table colors 

Select the icon  from the toolbar or the menu to launch the properties dialog box. The 
"Colors" tab allows you to choose the colors that will be used in the headers of the 
timetable: 
In each field, click on the color square to launch the color selection dialog box. Then select 
the text, the background color for each type of calendar view. 
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About this chapter: 
This chapter describes how to design and operate an application network, as follows: 
Overview is an overview of the application network environment. 
 Basic Concepts describes the application network configurations. 
Configuring Application Network Stations describes how to configure the application for 
networking. 
 Network Properties describes how to set your network environment to establish 
maximum application performance.  
 Configuring a Hot Backup Station  describes the backup configuration and principles of 
the backup station and the master station 
Application Backup - Principles of Operation describes the principles of the backup 
stations. 
 Recording Remote Data  describes how to record remote tags and alarms. It also 
describes how to simulate the connection between a remote station that is not running. 
 
 

 
 

 
 

   

 
 

 
 
 

Overview 

Application stations operating in a network environment can share objects, such as alarms 
and tags. Direct access to remote tags and alarms can be implemented through a simple 
station definition procedure. Once the station is defined to support the application's 
network activities, any operation involving tags and alarms on a local station can include 
remote tags and alarms as well. 
The application network system operates in a manner similar to other network systems. 
The application kernel, handles all network operations and transfers data from/to local and 
remote application stations.  
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The application supports various network components as TCP/IP. 
Installation in a TCP/IP environment enables application stations on one network to 
communicate with other application stations on other networks. Through TCP/IP, the 
application network offers a complete enterprise-wide solution. 

 
 

 
 

   
 
 
 
 

A computer Network consists of several computers linked together to enable data to be 
transferred from one computer to another. 
Several Application stations can be linked together in a network, so that Application 
reports, charts, tag values, recipes and images can be transferred from one station to 
another. 
The Application network definition and configuration is performed by selecting the item 
included in Network menu in the Studio Application. 

 
 

 

 
   
 
 
 
 

Application Network 

This topic contains the necessary information for designing and operating a Application 
network. 
  
Application stations operating in a network environment can share objects, such as alarms 
and tags. Direct access to remote tags and alarms can be implemented through the simple 
station definition procedure described in this chapter. Once the station is defined to support  
Application network activities, any operation involving tags and alarms on a local station 
can include remote tags and alarms as well. 
  
The Application network system operates in a manner similar to other network systems.  
The Application supports various network components, including Novel Requester, LAN 
Server and TCP/IP. 
  
Installed in a TCP/IP environment enables Application stations on one network to 
communicate with Application stations on other networks.  
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Through TCP/IP, the Application Network offers a complete enterprise-wide solution 
  
You configure an Application for network by using the Network menu in the Studio 
Application. 
  
Application Networking on Windows 2000 
To use Application networking on Windows do the following: 
1. Go to Windows Settings / List Zone Network  
 The Network window opens: 
2. Select the NetBEUI Protocol. 
3. Press the Properties button and the NetBEUI Properties window opens.  
4. Select Advanced option.  
5. Click on the check box to set this protocol to be the default protocol. 
  
Configuring SCADA and SCADA View Stations 
To define your computer as a SCADA or SCADA View station on the Application network, 
Select the Local Station Configuration item from the Network menu. The following dialog 
box appears: 

 
 

 
 

   

Basic Concepts 

 
 
 
 
 

Basic Concepts 
This section describes the application's network configurations.  

Application Station 
A general term describing a station that is configured to operate on the application network 
(can be SCADA or BACKUP). 

Application SCADA Station 
An operations station that can communicate with up to 1000 network stations and 32 PLCs 
simultaneously. This station performs functions such as: 

o    Sampling PLCs 
o    Generating alarms 
o    Collecting historical data 
o    Performing control operations  
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The operator can view the process through the application user-interface and interact with 
on-going activities. The application's SCADA station can receive and send data to other 
network stations.  

Application Hot Backup Station 
For applications that require the highest degree of reliability, the application provides the 
hot backup redundant configuration. This configuration consists of two identical application 
SCADA stations. Both stations are connected to the same PLCs, but one station runs in 
the Master mode and samples data in the field, while the second station (Backup station) 
remains in a Stand-By mode. When the Master station goes down, the Backup station 
switches to the Master mode, starts to sample PLCs and distributes real-time data to other 
stations across the network. 
In addition to real-time redundancy, the Hot Backup feature ensures the integrity of 
historical databases. After the Master station recovers, the backup station updates the 
Master station with the missing historical data. This mechanism ensures that the historical 
database on the Master stations remains complete. 

Application VIEW Stations 
A network VIEW station is not connected to a PLC, but to SCADA stations via a network. 
Any regular Wizcon model can behave as a View station. 
It is a fully operational station that allows operators to view and control the process. This 
station automatically receives all the online and historical data from the SCADA stations, 
as required. The operator can transparently interact with the process using application 
images, charts and other standard modules. The application VIEW station serves as a 
mirror of the real-time and historical data from one or more SCADA stations.  

 
 

 

 
   
 
 
 
 

Application SCADA Station 
  
Application SCADA station is an operations station that can communicate with up to 16 
networks of PLCs simultaneously. This station performs functions such as sampling PLCs, 
generating alarms, collecting historical data and performing control operations. The 
operator can view the process through the Application user-interface and interact with on-
going activities. The Application SCADA station can receive and send data to other 
network stations.  
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Application SCADA View Station 
  
The Application SCADA View station is a full operational station that allows operators to 
view and control the process. This station automatically receives all the online and 
historical data from the SCADA stations, as required. The operator can transparently 
interact with the process using Application’s Images, Charts and other standard modules. 
The Application SCADA View serves as a mirror of the real-time and historical data from 
one or more SCADA stations. The SCADA View Station is not connected to a PLC, it is 
connected to SCADA Stations via a network 

 
 

 
 

   

Configuring the 
Application for Networking 

 
 
 
 
 

Configuring the Application for Networking 
Before defining stations for your network first configure the O/S for networking. 

Time Setting Considerations 
The application timestamp is based on local time according to daylight saving time 
therefore synchronize the clocks on your network settings. 
Make sure that: 

o    The windows settings are identical in all application stations across the network. 
This includes Time Zone as well as Daylight Saving Time. 

o    All network PC clocks are synchronized at all times. It is recommended to use a 
network utility to periodically synchronize the PC clocks. 

 
 

 
 

   

Configuring Application 
Network Stations 
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Configuring Application Network Stations  
You can configure your computer as an application network station, as described below. 
You can also query the status of a station with Application Language. 

o To configure network stations: 
Select the Network menu in the Application Studio. The following options are available: 

o     Local Station Tab and Network Properties This dialog box enables you to 
configure your computer as a SCADA. It has the following tabs: 

o     General Tab where the network can be activated and other general parameters 
defined. 

o     Local Station Tab where the station's name and ID are defined and where you 
can define a Backup station. 

o     Protocol Tab where the type of protocol used is defined. 
o     Internet Tab where the maximum time a message is delayed and number of 

messages that can be delayed are defined. 
o     Backup Tab where the backup mode and properties are defined. 
o     Recording Remote Data This dialog box defines sets remote tags and alarms 

records. 
 

 
 

 
 

   

 
 
 

 
 

Configuring a Network station  
When configuring a Wizcon station, specify a unique name and a unique ID number for 
your station. It is recommended to keep a 10 number gap between different station IDs. 
For instance, if one ID is 80, the next ID should be 90, and so on. The range for ID 
numbers is 1 through 999.  
Before configuring a station verify the station's name so that you can give your station a 
unique name.  
Note:     Networking requires a security plug. 

o To define your computer as a network station: 
1.    In the Network dialog box scroll to open the Local Station tab. 
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2.    In the Station Name field, specify a unique name for the station. 
3.    In the Station ID field, specify a unique ID number for the station. 
4.    Leave the Backup station field empty. For more details about Hot Backup 
 configuration see Configuring a Hot Backup Station.  
5.    Click OK to save your definitions and to close the dialog box. 
6.    Restart the application to implement the changes. 
 
 

 
 

 
 

   

Network Properties 

 
 
 
 
 

Network Properties 
The Network Properties menu enables you to set your network environment and establish 
maximum application performance, and to enable or disable specific functions. 

o To define network properties: 
Double-click the Network icon in the Control Panel. 
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Or, 
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 the Network menu of the Application Studio, select Network Properties. The Network 

n network module is loaded, enabling you to access 

o tion, in the Protocol tab. 

 in the Backup tab. 
 

From
dialog box opens in which you can: 

o    Determine if the applicatio
application stations on the network, in the General Tab, 
   Determine a network protocol to be used by the applica

o    Optimize network use in the Internet tab. 
o    Determine the Hot Backup switching mode

 

 
 

   
 

Network Tuning Properties  
enables you to set your network environment and establish 

the Control Panel. 

 the Network menu of the Application Studio, select Network Properties. The Network 

module is loaded, enabling you to access application 

the application, in the Protocol tab. 

 in the Backup tab. 
 

 
 
 

The Network Properties menu 
maximum application performance, and to enable or disable specific functions. 
To define network properties: 
Double-click the Network icon in 
Or, 
From
dialog box opens in which you can: 
Determine if the application network 
stations on the network, in the General tab, 
Determine a network protocol to be used by 
Optimize network use in the Internet tab. 
Determine the Hot Backup switching mode

 

 

 
   
 

Network Property 
ning network parameters. 

 

 
 
 

Used to define the tu
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General Tab 
mine if the application network module will be loaded in the General tab of 

 
 
 
 

You can deter
the Network dialog box. 

 
The following options are available: 

Activate Specifies that the network is activated. Select to activate.  Network 

The following options are available: 
Maximum Network Answer Time Delay: Defines the amount of time 
that a query waits for an answer from a remote station. The default 
time is 6 sec. 
Maximum Network Time Delay: Determines the maximum time 
interval that a station will delay before updating the other stations Message with 
tag and alarm changes. The default time is 1000ms. 
Maximum Network Changes Delay: Determines the

control  
 maximum 

number of messages that a source station accumulates before it sends 
the data buffer to a target station. The default is 48 messages. 
As soon as either of the two last settings reaches the defined value, 
the data buffer will be sent. 

Note:    Restart the application for changes to take effect 
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Network Property - General    
pplication Studio. The following options are available: 

ters defined. 
 

. 
ed and number of messages that 

ode and properties are defined. 

u can determine if the application network module will be loaded in the General tab of 

 available: 
 network is activated. Select to activate.  

mount of time that a query waits 

the application for changes to take effect  
efined value, the data buffer will be sent. 

 

 
 
 
 

Select the Network menu in the A
Local Station and Network Properties This dialog box enables you to configure your 
computer as either a SCADA or View station. It has the following tabs: 
General where the network can be activated and other general parame
Local Station where the station’s name and ID are defined and where the network is
defined as a Management View or Backup station. 
Protocol where the type of protocol used is defined
Internet where the maximum time a message is delay
can be delayed are defined. 
Backup where the backup m
  
Yo
the Network dialog box. 
The following options are
Activate Network  Specifies that the
Message control  The following options are available: 
Maximum Network Answer Time Delay: Defines the a
for an answer from a remote station. 
Maximum network time delay: Determines the maximum time interval that a station will 
delay before updating the other stations with tag and alarm changes. The default time is 
1000ms. 
Maximum network changes delay: Determines the maximum number of messages that a 
source station accumulates before it sends the data buffer to a target station. The default is 
48 messages. 
Notes: 
Restart 
As soon as either of the two settings reaches the d

 

 
 

   
 

Local Station Tab 
d to define the station name, the ID number and Backup station. In 

 
 
 

The Local Tab is use
the Network dialog box scroll to open the Local Station tab. 
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1.    In the Station Name field, specify a unique name for the station. 
2.    In the Station ID field, specify a unique ID number for the station. Keep a 10 number 
gap between different station IDs. For instance, if one ID is 80, the next ID should be 90. 
Range for ID numbers is 1-999. 
3.    Check the Backup Station checkbox to open the Backup Parameters if needed. For 
details about Hot Backup configuration and use, see Configuring a Hot Backup Station 
and Application Backup - Principles of Operation
4.    Click OK to save your definitions and close the dialog box. 
 

 
 

 
 

   

 
 

 
 
 

Protocol Tab 
You can select either the NetBIOS or TCP/IP network protocols in the Protocol tab of the 
Network dialog box. 
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1.   Click on the network protocol to be used by the application. The default network 
protocol is: TCP/IP. 
2.   If relevant, click the Show Popup Window on Communication Errors checkbox to define 
that a popup window opens for a communication error in another station. 
Note:    Restart the application for changes to take effect. 

 
 

 
 

   

 
 
 

 
 

Network Property - Protocol   
Path: Application's Studio Network Network Properties 
Select the Protocol tab and the Network Protocol page opens:  
Click on the network protocol to be used by the Application. The two network protocols are 
NetBIOS or TCP/IP. 
Press OK to activate. 
Default: NetBIOS 
Restart the Application for action to take effect. 
  
In order for a Application station to communicate with Application stations on other LANs, 
specify the Broadcast Address of the 'remote' stations in a text file called 
OTHERNET.DAT. 
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Internet Tab 
You can optimize Internet access in the Internet tab of the Network dialog box. 
To transfer data between Java applets and the application, two connection modes are 
available: 

o TCP Connection (default): this establishes a connection using sockets via, by 
default, port 3028. If you use a firewall, you will need to add this port to the list of 
exceptions. If your security policy does not allow this, opt for the second option, 
described here: 

o HTTP Connection: this connection mode the HTTP protocol standard through port 
80. No special configuration is therefore required on the part of your network 
administrator on either the client or the server side. This mode uses an ISAPI 
extension which is installed by default on the IIS server. Note that the connection 
between the web server (the ISAPI extension) and the application uses sockets. 
As a result, the parameters below apply equally to this mode. This mode is 
compatible with secure communication using secure socket layers (SSL). In this 
case, the certificate should be installed at least for the virtual folders Docs and 
WizNet. In this case, the protocol will be HTTPS.  

Please note that IIS on Windows XP limits the number of concurrent connections. As a 
result, in HTTP connection mode, you can have a maximum of 10 simultaneous 
connections. Each applet uses 3 connections, therefore the maximum is 3 applets in this 
mode. It is therefore recommended to use Windows 2000 Server or Windows 2003 Server 
(which do not have these limitations) when using the web clients. 

 
The following options are available: 
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Maximum time a 
message could be 
delayed 

Specifies the maximum time interval that a server will delay, 
before updating the Wizlets with tag and alarm changes. 
The default value is 100ms. 

Maximum number of 
messages delayed 

Specifies the maximum number of messages that a server 
accumulates before it sends the data buffer to the Wizlets. 
The default value is 48. 

Wizcon for Internet Port 
number 

Specifies the port used by the internal network mechanisms 
to communicate with the Wizcon applets. The default value 
is 3028. 

Note:     The data buffer will be sent once either of the two settings reaches the defined 
value. Restart the application for changes to take effect. 
 

 
 

 
 

   

 
 

 
 
 

Backup Tab 
This tab is used to configure Hot Backup stations. For full details about how to configure 
and use the Hot Backup function see Configuring a Hot Backup Station and Application 
Backup - Principles of Operation. 
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1.    In the Backup Tab Hot Backup Mode field select either: 

o Auto - which is the default switch option. 
o Manual - which enables activating the backup station regardless of the state of the 

Master station.  
o Disabled - which disables the switching option. 

2.    If TCP/IP protocol is used add the backup station's IP address to the master station in 
the Network Properties Backup tab TCP/IP Address field. Note that you can also use name 
resolution, in which case you give the name of the backup station only - this simplifies 
setting up of your application. 
3.    Exit the application on the Master station and copy all the Master station application 
files to the Backup station  
4.    Run the application. 
 
 

 
 

 
 

   

 
 
 

 
 

Network Property - Backup   
Path: Application's Studio Network Network Properties 
The Network Dialog box opens: 
Select the Backup tab and the Network Backup page opens:  
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Hotbackup Mode 
The Hotbackup mode enables you to determine the Hotbackup switching mode. The 
Hotbackup station can be activated automatically or manually. 
Both Master and Hotbackup stations must be set to the same mode.  
Select Manual mode to enable activating the Backup Station regardless of the state of the 
Master station. 
Note that the Backup station can only be manually activated by using the WizSetBackup 
ModeAPI in an add-on. 
For more information please see the Application Programming Interface on-line help. 
Default: AUTO 
Restart the Application for changes to take effect. 
  
TCP\IP Address 
To establish the link between a Master station and its Backup station, you must specify the 
TCP/IP address of the remote station. It should be specified in both stations when working 
with TCP\IP. This field specifies the TCP\IP address of the backup station. 
If you are in backup station, specify the TCP\IP address of the Master Station. And if you 
are in the Master Station specify the TCP\IP address of the Backup station. 
  
You can now choose to use names of the machines to connect to either other stations on 
the network or your backup station. In this case machines can be configured to obtain IP 
address automatically without any problem. 
  
Connecting to the backup station using Name Resolution  
  
You can now connect by simply typing the name of the workstation using name resolution 
instead of the IP address, as shown below: 
  

 
  

Using name resolution to connect to the backup station, BACKUP_STN 
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Connecting to other stations on the network using name resolution 
  
A common way to limit the set of stations on the network is to define a file, othernet.dat 
(see the user guide). When you do this, you must give the IP address of the machines that 
are to be connected to the network. You will now have the option to give only the name of 
the other workstation and the configuration will be resolved automatically for you. 
  
  
Note: Make sure that the address field is empty when switching from Hotbackup 
configuration to SCADA station

 
 

 
 

   

Configuring a Hot 

Backup Station 

 
 
 
 
 

Configuring a Hot Backup Station 
The Hot Backup configuration is based on a pair of SCADA stations: One operates as a 
master and the other serves as a standby or backup. If the Master station fails, the Backup 
station takes over.  
A Backup station can also operate as a VIEW station, serving as an additional station for 
displaying and controlling the process on the Master station.  
When configuring stations, no application station may have the same name as the Backup 
stations with the '2' appended.  
For instance, if the Backup stations are named “WIZCON”, no other application station on 
the network can be named “WIZCON2”. This is a system reserved name. 

o To define a station as a Hot Backup station: 
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1.     In the Network Properties dialog box Backup Tab Hot Backup Mode field select either: 

o     Auto - which is the default switch option. 
o     Manual - which enables activating the backup station regardless of the state of 

the Master station.  
o     Disabled - which disables the switching option. 

2.    If TCP/IP protocol is used, add the backup station's IP address to the master station in 
the Network Properties Backup tab TCP/IP Address field. If you use name resolution, you 
can give the name of the backup station instsead of its IP address. 
3.    Exit the application on the Master station and copy all the Master station application 
files to the Backup station  
4.    Run the application. 
5.    From the Network menu of the Application Studio, select Local Station Configuration. 
The Local station configuration dialog box opens. 
6.    Return to the Local Station dialog box and check the Backup Station checkbox. The 
Backup Parameters field opens.  
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The following options are available: 

Checkup rate 
Specifies the checkup rate in seconds, at which 
the Backup station will check if the Master station 
is still functioning. 

Share history files 

Specifies that the Backup and Master station both 
share the same history files (LRM, HIS). Both 
stations have the same tag history path and use a 
file server or peer-to-peer connection. This option 
is recommended when historical data is critical. 

Update history of 
Primary  

Updates the Master with the data logged in the 
Backup station. 

7.    (Optional) If you are configuring the backup station as a VIEW station, leave the above 
options blank, and click OK. 
8.    In the Backup Tab of the Network Properties dialog box, the Hot Backup Mode field 
select either: 

o     Auto - which is the default switch option. 
o     Manual - which enables activating the backup station regardless of the state of 

the master station. 
o     Disabled - which disables the switching option. 

9.    If TCP/IP protocol is used, add the Master station's IP address to the backup station in 
the Network Properties Backup tab TCP/IP Address field. 
10.    Enter your specifications. Click OK to save them and close the dialog box. 
Notes: Only tag historical data can be transferred to the Master and not alarm history. A 
Master station is automatically updated with the online data (tag values and live alarms) 
when it becomes active. Alarm history, recorded by the Backup station during the Master 
station fail-time, will not be transferred to the Master station after the master restarts. If 
neither of the procedure options is selected, each station, when active, will record historical 
data independently, and no historical data will be transferred between the two stations. 
When the Hot Backup Mode is set to Manual, the Backup station can only be activated 
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using the WizSetBackup Mode API in an add-on. Restart the application for changes to 
take place. 
 

 
 

 
 

   

 
 

 
 
 

Hot Backup Station Configuration 
Note: Hot Backup Station is not supported on the Web. 
  
The hot backup configuration is based on a pair of SCADA stations: one operates as a 
master and the other serves as a stand by or backup. If the master station fails, the backup 
station takes over.  
Note:  No application station may have the same name as a Backup station with the ‘2’ 
appended. For instance, if a Backup station is named Silo, no other application station on 
the network can be named Silo2.  
  
Name the backup station the same name as the master station. The application 
automatically adds ‘2’ to the name, thereby identifying the station name with 2 appended to 
it as the Backup station on the network. 
  
To define a station as a hot backup station, first copy all the master station application files, 
run the application and select the Define as a Hot Backup Station option in the Local 
Station Configuration dialog box. 
  
In the Checkup Rate field, specify the times per seconds (1/sec.) at which the backup 
station will check if the master station is still functioning. 
Share history files Option 
When this option is enabled the backup and master station both share the same history 
files (LRM, HIS). Both stations have the same tag history path and use a file server or 
peer-to-peer connection. This option is recommended when historical data is critical. 
  
Update history of primary option 
Select the Update history of primary (master) so that the master or main station will be 
updated with the data logged in the Backup Station. 
Notes:  
1. Only tag historical data can be transferred to the master, and not alarm history. A master 
station is automatically updated with the online data (tag values and live alarms) when it 
becomes active. 
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2. Alarm history recorded by the backup station during the master station fail-time, will not 
be transferred to the master station, after the master restarts! 
  
Caution!: 
If neither of the proceeding options is selected, each station when active will record 
historical data independently, and no historical data will be transferred between the two 
stations. 
  
Status of a station and Application Language 
The status of a station can be queried through the $Backup application language variable. 
The $BACKUP variable represents the status of the backup station. When this variables 
set to 1 - the station is in passive mode. When variable is set to 0 - the station is in active 
move 
  
Caution!: 
Do not assign $BACKUP to a tag through the application language!  
Since Application t language runs on both the master and backup station -the assignment 
statement of WIL5 $BACKUP is executed twice. Once by the master WIL5 and the other 
by the backup station’s WIL5, thus not giving a true picture of the situation. 

 
 

 
 

   
 
 
 
 

Updating an existing Hot Backup application 
Both master and backup stations must be identical. The procedure below ensures that the 
tags file in the master and the backup station will always be identical. This is a must for 
master/backup applications.  

o Procedure to add/change tags to an existing Hot Backup application: 
1.   Exit from the application in the backup station. 
2.   Add or change the new tags in the master station. 
3.   Copy the files to the wizdata.mdb file to the backup station. 
4.   Run the application in the backup station. 
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Querying the Status of a Station with Application Language 
The status of a station can be queried through the $BACKUP Application Language 

kup station: 

.  
Not  
app t nt 

 
 

variable. The $BACKUP variable represents the status of the bac
o     When this variable is set to 1 - the station is in Backup or passive mode. 
o     When the variable is set to 0, the station is in Master or active mode
e:    Do not assign $BACKUP to a tag through the application language. Since 
lica ion language runs on both the Master and Backup stations - the assignme
em nt of WIL5 $BACKUP is executed twice. Once by the Master WIL5, and thstat e e other 

by the Backup station's WIL5, thus not giving a true picture of the situation. 
For more details refer to Chapter 30, Application Language. 
Note:     
 

 
 

   

Application Backup - 

Principles of Operation 

 
 
 
 
 

Application Backup - Principles of Operation 
The Backup station and the Master station always have the same status of tags and 
alarms. This is executed in the following way: 

Tags 
o    When a tag is changed at the active station, a message is sent to the passive 

station notifying of a tag change, with the ID of the tag and its new value. The 
passive station receives the message and performs WizPutGateVal in memory 
only mode. 

o    When a tag is changed from the passive station, the request is routed to the 
active station where it is written to the PLC or to memory (depending on the type of 
the tag). The active station then informs the passive station that a tag was 
changed (as in case 1). 

o    When a passive station is first loaded, it requests an update of all tag values. 

Alarms 
o    When an alarm is generated in the active station, the active station informs the 

passive station that an alarm was started. The forwarded information includes all 
that is needed to start the same alarm on the Backup station. 
The passive station receiving notification from the active station starts the alarm 
using an internal API similar to WizStartAlarm. 
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Further changes to the alarm generated in the active station are passed to the 
Backup station using the alarm ID and the event that occurred. 
(Ack/End/Class/Text changed). 

o    When a request to Start/Ack/End an alarm on the passive station is made, the 
passive station routes the request to the active station. The passive station will 
show the result of the request after it receives the notification from the active 
station. 

o    When the passive station starts, it requests the status of all active alarms at the 
Master station, builds an Alarm id on active station to Alarm id on passive station 
translation table, and brings the passive station to the same status. 

Failure Detection and Reaction 
In automatic switch Backup mode, the backup station periodically checks the connection 
with the master station. The frequency of the check is user defined. For more details about 
fine-tuning, see WizTune User Guide. 
During communication test failure with the Master station, or if the Backup station was 
switched to active mode (in manual switch backup mode), the Backup station broadcasts a 
Backup is Active message to the network. 
When the remote stations receive the message they: 

o    Update their internal stations database with the information that the Master 
station is now replaced by the Backup station. 

o    Disconnect the session with the Master station. 
o    Reconnect to the Backup station. 
o    If the local station was a client with alarms and tags on the Master station, it re-

registers as a client for the alarms and tags at the Backup station. 
 
 

 

 
   
 
 
 
 

Recording Remote Data  

Wizcon stations are able to record tags and alarms from remote stations.  
o To specify remote tags and alarms for recording in your local database: 

1.    From the Network menu select the Record Remote Data option. The Define remote 
data to record dialog box opens: 
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2.    Select the remote station for which you want the tag and alarm data to be recorded, 
and activate the OK button to save your settings and close the dialog box.  
3.    Restart the application for your changes to take affect. 

o To change the recording specifications of a remote station: 
Select a station in the list box and activate the Change button. The Define Data To Record 
From Station dialog box opens: 

 
The following options are available: 
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Record Tags 

Specifies the tags that are to be recorded in the local database. 
Select to configure the tag recording parameters as follows:  
Tag name: Specifies the tag that you want to record. Click on the 
arrow to the right of the field and select a tag or enter a name 
prefix so that all the tags beginning with the prefix are recorded.  
After you specify a tag, activate the Add button to add the name to 
the list.  
To delete a tag from the list, select the name you want to delete in 
the listbox and activate the Delete button. 

Record Alarms 

Specifies the alarms that the application should record in your local 
database. Select to configure the alarm recording parameters, as 
follows: 
Specify values in the following filter fields, so that only the alarms 
that meet these specifications will be recorded in your local 
database. These values will appear under the Filter column in the 
Define Data To Record From Station dialog box, shown on the 
previous page. 
Minimal Severity 
Maximal Severity 
Family Prefix 
First Zone 
Last Zone 
These filter fields together with the Class button are similar to the 
specifications defined for the Events Summary. Refer to Display, 
in the Chapter 24, Event Summaries.  

 
 
 

 
 

   

 
 

 
 
 

Recording Remote Data   

In addition to application server stations, both SCADA and VIEW stations are also able to 
record remote tags and alarms.  
You can simulate the connection to a remote station that is not running. This enables you 
to work with remote tags, alarms and images to help you when developing the local station 
application. 
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e following filter fields, so that only the alarms that meet these 
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ds together with the Class button are similar to the specifications defined for 
ummary. Refer to the section called Alarm Display, in the Events Summaries 

 
 

To specify remote tags and alarms for recording in your local database: 
1. 1. From the Network menu select the Record Remote Data option. The Define remote 
data to recor
1. 2. Select the remote station for which you want the tag and alarm data to be
and activate the OK button to save your settings and close the dialog box.  
1. 3. Restart the application for yo
To change the recording specifications of a remote station: 

. The Define Data To Select a station in the list box and activate the Change button
From Station dialog box opens: 
The following options are available: 
Record Tags Specifies the tags that are to be recorded in the local database. Select to 
configure the tag recording param
 Tag name: Specifies the tag that yo
field and select a tag or enter a name prefix so that all the tags beginning with the prefix 
are recorded.  
 After you specify a tag, activate the Add button to add the name to the list.  
 To delete a tag from the list, select the name you want to delete in the listbox and activat
the Delete butto
Record Alarms Specifies the alarms that the application should record in yo
database. Select to configure the alarm recording parameters, as follows: 
 Specify values in th
specifications will be recorded in your local database. These values will appear under
Filter column in the Define Data To Record From Station dialog box, shown on the
previous page. 
 Minimal Severity 
 Maximal Severity 
 Family Prefix 
 First Zone 
  Last Zone
 These filter fiel
the Events S
chapter.  

 

 
   
 
 
 

/ Record remote data 

Select this item to define remote data recording 

 

 

 



Chapter 19 The Application Network 

 
 

   

Installing Web Application 

 
 
 

Installing an Application for development 
Hardware 
Co and up).  
Me

500MB minimum free. This is required for both installing the program and for 

B) 

phic adaptor that supports the operating system desktop. 
 and the screen resolution should be set 

ows NT version 4.0, Windows 2000 or Windows XP 
 is required for a web server. 

: A web server is required for publishing the application, (not for 

re 
red. 

• ny HTML editor may be used. (Optional) 
The ll

 
er that can be 

 
 

Other Topics 

 
 

mputer: Pentium III 450MHz (recommended 1GHz 
mory: 256MB (recommended 512MB).  

Hard Disk: 
later developing an application. 
Monitor Adapter: 8MB (Recommended 32M
Monitor: Resolution 800X600 or higher 
Display: VGA, SVGA, or any gra
The display should be set at 256 colors or higher
at 800 x 600 or higher. 
Mouse: Any PC compatible mouse. 
Parallel Port: Required for the system’s security plug. 
Software 
Operating System: Microsoft’s Wind

• Correctly configured TCP/IP: A fixed IP address
• Web server

development). 
• Browser: Microsoft Internet Explorer 5 (or higher) and virtual machine. If you a

installing the Scheduler then the Microsoft Internet Explorer 5.5 SP2 is requi
HTML Editor: A

 fo owing is required to publish an application on the web. 
Java 1.1 enabled browser or higher o

 A web server. For example, the Microsoft Internet Information Servo
downloaded from the Microsoft web site. 

 

   

Sharing information with 
other stations 
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Local Station Configuration   See also 
To View station on the Application network 

. Specify a unique name and a unique ID number for your station. 

ip: 
 a 10 number gap between different station IDs. For instance, if one ID is 80, the next 

otes: 
and SCADA View stations require a security plug. 

 your computer name. The 

 
anagement view Parameters

 
 
 
 

 define your computer as a SCADA or SCADA 
select from the Network menu Local Station configuration. 
The Local Station Configuration dialog appears: 
 
1
2. Leave the check boxes in their default state unmarked. 
3. Restart the Application to implement the new settings. 
 
T
Keep
ID should be 90. Range for ID numbers is 1-999. 
 
N
SCADA 

• The Application station name must be different from
Windows computer name is configured in Settings Control Panel Network 
Identification 

M
To configure your station as a management view station load the Application without a plug 

ot Backup station configuration

, follow the same procedure as when defining a SCADA station . Then in the local station 
definition dialog box set the Management View station check box, and Select A Server 
station to indicate that requests for data from the local station will be directed to the 
Application Server. 
 
H
The hot backup configuration is based on a pair of SCADA stations: one operates as a 

 

n station may have the same name as a Backup station with the ‘2’ 
 

ame the backup station the same name as the master station. The Application 
pended to 

o define a station as a hot backup station, first copy all the master station application files, 

master and the other serves as a stand by or backup. If the master station fails, the backup
station takes over.  
Note:  No Applicatio
appended. For instance, if a Backup station is named Silo, no other Application station on
the network can be named Silo2.  
 
N
automatically adds ‘2’ to the name, thereby identifying the station name with 2 ap
it as the Backup station on the network. 
 
T
run the Application and select the Define as a Hot Backup Station option in the Local 
Station Configuration dialog box. After selecting this option, the following field appears:  
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 the Checkup Rate field, specify the times per seconds (1/sec.) at which the backup 

hare history files Option 
he backup and master station both share the same history 

l. 

pdate history of primary option 
(master) so that the master or main station will be 

otes:  
 tag historical data can be transferred to the master, and not alarm history. A 

 

he backup station during the master station fail-time, will not be 

aution!: 
 the proceeding options is selected, each station when active will record 

wo 

tatus of a station and Application Language 
 $Backup Application language variable. 

aution!: 
ign $BACKUP to a tag through the Application language!  

ment 

 

In
station will check if the master station is still functioning. 
 
S
When this option is enabled t
files (LRM, HIS) .Both stations have the same tag history path and use a file server or 
peer-to-peer connection. This option is recommended when historical data is critica
 
U
Select the Update history of primary 
updated with the data logged in the Backup Station. 
 
N
1. 1. Only
master station is automatically updated with the online data (tag values and live alarms)
when it becomes active. 
2. 2. history recorded by t
transferred to the master station, after the master restarts! 
 
C
If neither of
historical data independently, and no historical data will be transferred between the t
stations. 
 
S
The status of a station can be queried through the
The $BACKUP variable represents the status of the backup station. When this variables 
set to 1 - the station is in passive mode. When variable is set to 0 - the station is in active 
move 
 
C
Do not ass
Since Application language runs on both the master and backup station -the assign
statement of WIL5 $BACKUP is executed twice. Once by the master WIL5 and the other 
by the backup station’s WIL5, thus not giving a true picture of the situation. 

 

 

   

Network 
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Application Network 
This topic contains the necessary information for designing and operating a Application 
ne

n stations operating in a network environment can share objects, such as alarms 
d tags. Direct access to remote tags and alarms can be implemented through the simple 

 manner similar to other network systems.  
e Application supports various network components, including Novel Requester, LAN 

 environment enables Application stations on one network to 
mmunicate with Application stations on other networks.  

n 

plication. 

Networking on Windows 2000 
 use Application networking on Windows do the following: 

  

 and the NetBEUI Properties window opens.  

 define your computer as a SCADA or SCADA View station on the Application network, 
 Network menu. The following dialog 

 
 

twork. 
  
Applicatio
an
station definition procedure described in this chapter. Once the station is defined to support  
Application network activities, any operation involving tags and alarms on a local station 
can include remote tags and alarms as well. 
  
The Application network system operates in a
Th
Server and TCP/IP. 
  
Installed in a TCP/IP
co
Through TCP/IP, the Application Network offers a complete enterprise-wide solutio
  
You configure an Application for network by using the Network menu in the Studio 
Ap
  
Application 
To
1. Go to Windows Settings / List Zone Network
 The Network window opens: 
2. Select the NetBEUI Protocol. 
3. Press the Properties button
4. Select Advanced option.  
5. Click on the check box to set this protocol to be the default protocol. 
  
Configuring SCADA and SCADA View Stations 
To
Select the Local Station Configuration item from the
box appears: 

 

 
   
 
 

The Application Factory A Plant-wide Solution 
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Th oth data flow between the plant 

e Application Factory solution provides a smooth growth path from a standalone 
that 

sic Concepts 
n A general term describing a station that is configured to operate on 

Application SCADA View station is a full 
ion 

 
 

ew Station
 

e Application Factory concept is designed to ensure smo
floor and other departments in the organization, while maintaining full performance and 
data integrity. 
  
Th
workstation, through the plant-floor configuration, to plant-wide network architecture 
connects the plant floor with existing file servers and other management systems. The 
Application's scalability protects both present and future investments in process 
automation and information technology. 
  
Ba
Application Statio
the Application Network (can be SCADA, BACKUP, VIEW or SERVER). 
Application SCADA Station – The Application SCADA station is an operations station 
that can communicate with up to 32 networks of PLCs simultaneously. This station 
performs functions such as sampling PLCs, generating alarms, collecting historical data 
and performing control operations. The operator can view the process through the 
Application user-interface and interact with on-going activities. The Application SCADA 
station can receive and send data to other network stations.  
Application’s Hot Backup Station
Application SCADA View Station The 
operational station that allows operators to view and control the process. This stat
automatically receives all the online and historical data from the SCADA stations, as 
required. The operator can transparently interact with the process using Application’s 
Images, Charts and other standard modules. The Application SCADA View serves as a
mirror of the real-time and historical data from one or more SCADA stations. The SCADA
View Station is not connected to a PLC, it is connected to SCADA Stations via a network 
Server Station 
Management Vi

 

 

 
   
 

Management View Station 
  

e Application’s Management View stations are stations that bring real-time and historical 

 this 

 
 
 

Th
data from the plant floor to any desktop in the organization. Management View stations can 
display data collected by one or more SCADA stations. In addition to displaying the data in 
forms of images, graphs and reports, Management View stations provide the necessary 
functions for interacting with on-going activities. Each command for changing process 
parameters or downloading a recipe is immediately transferred to the appropriate 
Application SCADA stations. Since the Application Server handles the communication,
process does not affect time-critical operations on the plant-floor. A Management View 
Station cannot operate without a Server station. 
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Management View Station Configuration 
Note: Management View Station is not supported on the Web. 
To configure your station as a management view station load the Application without a 
plug, follow the same procedure as when defining a SCADA station Then in the local 
station definition dialog box set the Management View station check box, and Select A 
Server station to indicate that requests for data from the local station will be directed to 
the Application Server. 

 
 

 

 
   
 
 
 
 

Application's Hot Backup Station 
  
For applications that require the highest degree of reliability, this application provides the 
Hot-Backup redundant configuration. This configuration consists of two identical 
Application SCADA stations. Both stations are connected to the same PLCs, but one 
station is running in the Master mode and samples data in the field, while the second 
station (Backup station) remains in a Stand-By mode. When the Master station goes down, 
the Backup station switches to the Master mode, starts to sample PLCs and distributes 
real-time data to other stations across the network. 
  
In addition to real-time redundancy, the Hot-Backup feature ensures the integrity of 
historical databases. After the Master station recovers, the backup station updates the 
Master station with the missing historical data. This mechanism ensures that the historical 
database on the Master stations remains complete. 
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WIADDE Client (WIZDDEC) 
Th  application to run as a DDE client and receive 

ctivating the WIZDDE Client

 
 
 
 

e WIZDDEC program enables your
information from server applications. 
 
A
To enable your application as a DDE client, you must run the WIZDDEC module. This 

DE Client folder

module can be run in one of two ways: 
 
D
Double click on the Start DDE Client icon in the Application folder group (to find the folder 

ugh Design/Application setup path

move to the Start Application Group/menu and within it select the DDE Server option) 
OR 
Thro
1. Press the Add button 
2. Press Browse to move to the WIZDDES program location 

otes

3. Move to the Application/Bin directory  
4. Choose the WIZDDEc.exe file 
 
N

• Load the application program that is the server before the client. 
 application, the 

For exa

• In order for the WIZDDE to establish contact with the DDE server
server must be loaded before WIZDDE. 
mple,

• If your application receives data from Excel (the DDE server), you must first load 

• t loaded prior to the WIZADDE, or was 

1. Resta  by double clicking on the icon. 
mage, close the display and 

 

Excel before loading the WIZDDE. 
If the DDE server application was no
closed and then reloaded, you must do one of the following to establish 
communication: 
rt WIZDDE client

2. If a DDE tag is displayed, in a Single Tag Input box or i
reopen it. If no DDE tag is visible, simply display the tag in a Single Tag Input box and 
communication will be restored. 
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WIZDDE Client Block 
  
The WIZDDE Client Block mechanism allows the Application to receive many tag values 
from the server in one update message. This improves the communication between the 
Ap WIZDDE Client Block is built from a matrix of rows 
an ll of the matrix contains the value of one data item. 

te: Not all programs support block messages, so please check the documentation of the 

 
d 

 is that the Application receives the whole block of data whenever 

ou should first define all blocks and then connect the 

e

 

plication and the DDE server. The 
d columns in which each ce

No
DDE server application. 
A common use for DDE client blocks is a setup in which a DDE server updates at once a
block of items that make up a recipe. The Application, the client, receives all the items, an
the tag values are changed at once.  
Define DDE client blocks only if data items in the server change simultaneously (within 
milliseconds). The reason
one of the items in the block changes. Therefore, if items change one at a time, the 
Application will receive a whole block of values, many of which have not changed. 
To use DDE Block in an Application, y
tags to the relevant blocks. A DDE block in an Application is composed of an internal 
name, block address, and block dimension. The internal name is used to connect a tag to a 
block. The DDE  
Address is similar to a regular address, except that the Item name is different (explained 
below). The block dimension is also explained below. 
To define DDE Blocks: 
From the List Zon
1. Double click the Station (Utility option) in the Containers tree 
2. From the List Zone select the DDE Block 
3. Press the Add button in the DDE Client block definition dialog box  
OR 
From the Design Menu
1. Select the Design menu form the Studio main menu 

: 

 resides 

 modify an existing block 

lect it and press the Change button.  

x are: 
e - The internal name of the block being defined. 

2. Press the Add button in the DDE Client block definition dialog box  
  
The fields in this box are
Block Name: The internal block name 
Application: The DDE server application where each block physically
  
To define a new block  
Click the Add button 
  
To
Double click on it  
OR 
Se
  
The fields in this bo
Nam
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n. 
pic- The name of the group of data or files on the DDE Server that will be accessed.  

ss. To obtain the block address format, you must read the 
xcel, for example, must specify the 
t Cell. See the Figure above for an 

ally (rows) and seven cells horizontally (columns). 

e will 
not in monitor mode. 

u defined the 
ve. 

 
 

Application - The DDE server applicatio
To
Address - The block addre
relevant documentation of the server. DDE clients of E
block address as follows: Upper Left Cell: Bottom Righ
example. 
Dimension - The number of rows and columns in the block. This is worked out from the 
address.  
The previous example defines a DDE block that resides in Excel. It starts at the cell in 
Row2/Column3 and ends with the cell in Row6/Column9. Therefore, the block covers five 
cells vertic
  
After defining blocks, individual tags can be connected to elements in the block. To 
connect a tag to one item from a DDE block, select the Block item option. In the DDE 
section of the Tag definition dialog box. The DDE section then appears as follows: 

e The block to which the tag will belong. Block Nam
Row The row number of the item in the block relative to the start position. 
Column The column number of the item in the block relative to the start position. 
Link The DDE link definition: Always or In Monitor. Always means that every chang
be passed by WIZDDEC to WIZpro even if the tag is 
Remember that you specified the start position in the Address field when yo
DDE block. The tag shown here is connected to R2 C3 from BLOCK1 defined abo

 

 
   
 
 
 
 

WIZDDE Server  
To run your application as a DDE server, use the WIZDDES program.  
 
To enable your application as a DDE server, you must run the WIZDDES module. This 
mo e of two ways: dule can be run in on
DDE Server Folder
D
m

ouble click on the Start DDE Server icon in the Application folder group (to find the folder 
ove to the Start Application Group/menu and within it select the DDE Server option) 

plication setup path
OR 
Through Design/Ap
1. Press the Add button 
2. Press Browse to move to the WIZDDES program location 
3. Move to the Application/Bin directory  
4. Choose the WIZDDEs.exe file 
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ient. Run Excel or any other application program to serve as the cl
Important WIZDDES Notes

• The WIZDDE Server can support only one client application. If a WIZDDE Server 
communicates with a client and another application establishes contact with the 

ill be terminated.  
) are sent to the DDE 

 
 

Application, the link between the Application and the first client w
mmunication error, then asterisks (*****• If a real tag gets a co

client. 

 

   

 
 
 
 

Network Local Station 
The Local Tab is used to define the station name and ID number and whether it is a 
Management or Backup station. In the Network dialog box scroll to open the Local Station 
tab. 
1. 1. In the Station Name field, specify a unique name for the station. 

d, specify a unique ID number for the station. Keep a 10 number 
 90. 

Either select the Management View checkbox to open the Management View 

Checkup rate Specifies the times per seconds (1/sec.) at which the Backup 

erver or peer-to-peer connection. This option is recommended when 

• ith the data 

1. 5. Cli
 
 

 

 

1. 2. In the Station ID fiel
gap between different station IDs. For instance, if one ID is 80, the next ID should be
Range for ID numbers is 1-999. 
1. 3. 
Parameters field and then do the following: 
1. 4. In the Server station field, click on the arrow to the right and select a server station to 
indicate that requests for data from the local station will be directed to the application 
server. 
In the Station Name field, specify a unique name for the station. 
Or, 
Check the Backup Station checkbox to open the Backup Parameters field which has the 
following options: 

• 
station will check if the Master station is still functioning. 

• Share history files Specifies that the Backup and Master station both share the 
same history files (LRM, HIS). Both stations have the same tag history path and 
use a file s
historical data is critical. 
Update history of Primary Updates the Master or main station w
logged in the Backup station. 
ck OK to save your definitions and close the dialog box. 

 
 



Chapter 19 The Application Network 

684 

   

 
 
 
 

Local station configuration  See also 
Select this item to define a local working station. 

 

 
 

 

 
   
 
 
 
 

Network Properties - Internet   
The Application uses these settings to optimize network use. Lower values mean the 
Application will send smaller packets of data more frequently so that Application Java 
applets will be updated faster. 
Path: Application Studio Network menu Network Properties  

e 

o connection modes are 

The Network dialog box opens: 
You can also access the Network Properties from the Application Studio by pressing th
Network Icon. 
 
To transfer data between Java applets and the application, tw
available: 
TCP Connection (default): this establishes a connection using sockets via, by default, por
3028. If you use a firewall, you will need to add this port to the list of exceptions.  

t 

 the Maximum network time delay field, you can determine the maximum time interval 
at a server will delay, before updating the Wizlets with tag and alarm changes. 

ages 

nnection

In
th
Default: 100ms 
Restart the Application for changes to take effect. 
In the Maximum network messages delayed field, you can determine the maximum 
number of messages that a server accumulates before it sends the data buffer to the 
Wizlets. 
Default: 48 mess
Restart the application for changes to take effect. 
 
If your security policy does not allow this, opt for the second option, described here: 
HTTP Co : this connection mode the HTTP protocol standard through port 80. No 

therefore required on the part of your network administrator on 
either the client or the server side. This mode uses an ISAPI extension which is installed by 
special configuration is 
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between the web server (the ISAPI 
xtension) and the application uses sockets. As a result, the parameters below apply 

is 
er 

default on the IIS server. Note that the connection 
e
equally to this mode. This mode is compatible with secure communication using secure 
socket layers (SSL). In this case, the certificate should be installed at least for the virtual 
folders Docs and WizNet. In this case, the protocol will be HTTPS.  
Please note that IIS on Windows XP limits the number of concurrent connections. As a 
result, in HTTP connection mode, you can have a maximum of 10 simultaneous 
connections. Each applet uses 3 connections, therefore the maximum is 3 applets in th
mode. It is therefore recommended to use Windows 2000 Server or Windows 2003 Serv
(which do not have these limitations) when using the web clients. You can download the 
tool, MetaEdit 2.2 from Microsoft in order to increase this number to 40: 
              http://support.microsoft.com/default.aspx?scid=kb;en-us;301386&sd=tech
 
 
Note: The data buffer will be sent once either of the two settings reaches the defined 
value. 

 
 

 

   

 

 
 
 

Network Simulation    
Network Simulation Option 
The Network Simulation option allows you to simulate the connection to a remote station 
that is not running. This enables you to work with remote tags, alarms and images to aid in 
developing the local station application. 

mulation: 
 of the remote station to a directory on a server drive, or your 

ifying the location of the remote station’s application files. This 
 be located in the local application directory. For example: SCADA01 110 

 
 

 

 

To implement network si
1. 1. Copy the application files
local hard disk. 
1. 2. Create a text file called NETSIM.DAT, as follows: 
STATION_NAME ID PATH 
Where: 
1. 1. "STATION_NAME" is the name of the remote station with which the connection will be 
simulated. 
2. 2. "ID" is the station ID. 
3. 3. "PATH" is the path spec
file must
S:\APPLICATION\REMOTE 
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Network Simulation    
Network Simulation Option 
The Network Simulation option allows you to simulate the connection to a remote station 
that is not running. This enables you to work with remote tags, alarms and images to aid in 
developing the local station application. 
To implement network simulation: 

n files of the remote station to a directory on a server drive, or your 

f the remote station with which the connection will be 

tation ID. 
mote station’s application files. This 

plication directory. For example: SCADA01 110 

 
 

 

1. 1. Copy the applicatio
local hard disk. 
2. 2. Create a text file called NETSIM.DAT, as follows: 
3. 3. STATION_NAME ID PATH 
4. 4. Where: 
5. 5. "STATION_NAME" is the name o
simulated. 
6. 6. "ID" is the s
7. 7. "PATH" is the path specifying the location of the re
file must be located in the local ap

ION\REMOTE S:\APPLICAT

 
 

   
 
 
 
 

Click this box to determine the maximum number of messages that a source station 
accumulates before it sends the data buffer to a target station. 
  
Default: 48 messages 
Restart the Application for changes to take effect. 
  

value. 
 

Note: The data buffer will be sent once either of the two settings reaches the defined 
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Click this box to determine the maximum time interval that a station will delay, before 
updating the other stations with tag and alarm changes. 
  
Default: 1000ms 
Restart the Application for changes to take effect. 
 

 
 

   
 

Check the Activate Network 
check box. Restart the Application for changes to take effect. 

 
 

 

Click on the network protocol 
to be used by the Application. 

The two network protocols are NetBIOS or TCP/IP. 
Press OK to activate. 
  
Default: NetBIOS 
Restart the Application for action to take effect. 
  

 Applica
 in a text file called 

 

In order for a Application station to communicate with tion stations on other LANs, 
ess of the 'remote' stationsspecify the Broadcast Addr

OTHERNET.DAT. 
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   About this chapter: 
This chapter is an introduction to the Image Module as follows: 
Images Overview discusses the basic Image options. 
Getting Started discusses the basic parameters required for creating an image in the 
Image module. 
Image Properties discusses how to predefine the Image Window parameters. 
The Image Window discusses the Image interface, its toolbar, menu bar and various 
operational toolboxes. 
Basic Image Module Concepts discusses the various Image module concepts. 
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Images Overview 

Images are dynamic graphic representations of industrial processes. Tags in an industrial 
process can be represented by an image object and each object can represent specific 
process values. Together they can display a dynamic picture of the work process. 
Images can be saved into Html pages and be viewed from remote stations over the 
Internet. Using the Goto Zone function, operators can receive alarms showing a graphical 
image of the cause of the alarm.  
Images can be imported, inserted or attached to a project from other projects or locations. 
Graphics can also be saved in Cluster Libraries and be used to create multiple projects. 
The Layers functionality enables users to zoom in and out of an image for a more detailed 
view. Different operators can view different layers, a feature which is useful for work 
efficiency and security. 
 

 
 

 
 

   

 
 
 

 
 

Image Overview 

 
Application Images are dynamic graphs representations of industrial processes. Each tag 
in an industrial process can be represented by an image object, and each object can 
represent specific process values, thereby displaying a dynamic picture of the process. 
To initiate the Image window: 
1. Right click the Image file located in the Containers tree 
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2. Select the "New Image" option with the left mouse button. 
OR 
Through the Pop-up menu located in the List Zone  
1. Select the Images file from the Project Tree. 
2. Right click an existing Image or click anywhere in the List zone 
3. Choose the New Image option. 
To view the list of Image files:  
Right click Images on the All Containers tree. As a result a list of all Images is displayed. 
To set the order of fields to be displayed in the Images list: 
1. Click the Image file in the Containers tree 
2. Right click an existing Image or anywhere in the List Zone 
3. Choose the View Setting option from the menu. 
See the following: 
The Image Toolbars  
Viewing Images  

 
 

 
 

   

 
 

 
 
 

The Image Windows 

 
Image windows are windows in which images are viewed and manipulated.  
Images are dynamic pictures through which control processes are monitored and 
supervised.  
 
An Image window can operate in one of the following modes:  
Monitor - In this mode, the image can only be viewed in the current window boundaries. 
Tag value input through trigger objects is supported (if the operator is authorized to do so).  
Navigate - In this mode, the image can only be scrolled, panned, and zoomed in and out.  
Edit - In this mode, an image can be drawn, edited, and saved. When the Edit mode is 
invoked, an auxiliary window, called the Tools window, will appear beside the Image 
window. The Tools window contains editing tools that you can use to draw or modify an 
image.  
The Image window modes can be activated by selecting a mode from the Modes menu.  
Several Image windows can be opened simultaneously on the screen, each displaying 
parts of the same image, or different images.  
In the Edit mode, each image has its own dedicated Tools window.  

 
 



Chapter 20 Introduction to the Image Module 

692 

 
 

   

 
 

 
 
 

Error Management 

Presentation 
  In the image when an object references a tag or an Object Oriented name which is 
not valid, this object is marked with a cross.  
   

Access means / Description 
  The user can not interact with this new feature. It is only here to indicate that there is 
a problem with an object in the image. Depending on the cross color, the user is 
informed of the nature of the error, so it will be easier for him to correct the default.  
   

The following cases are handle:  
  
  
 

- Missing tag (gray cross) 
 

- Communication error (brown cross) 

 

- Template error (red cross)  
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Getting Started 

 
 
 
 
 

Getting Started 
This section discusses basic work principles for creating an image.  
There are two work modes available, where each mode when selected, opens showing 
different functions on the computer screen. These modes are: 

o     Edit - this mode is used for designing and editing images. This mode opens 
displaying the Drawings, Colors, Objects and Operations toolboxes. The Navigate 
toolbars can be activated in this mode enabling the user to move within the image 
and/or zoom in and out of it.  

o   Trigger on - when the Trigger mode is set to ON, objects defined as trigger 
objects can be used for tag input. When this mode is OFF, no objects (even those 
defined as Trigger objects) can be used for tag input. The Navigate toolbars can 
be activated in this mode enabling the user to move within the image and/or zoom 
in and out of it.  

 
 
 

 
 

   

 
 

 
 
 

Image Properties 
Image Properties are used to define the properties of the image. 

o To access the Properties dialog box: 
   In the All Containers section right-click Images and select Properties from the popup 
menu. The Image Properties dialog box opens. This dialog box has the following tabs: 

o    View - where image window view properties are defined. 
o    Loading - where the amount of memory available for Image objects is defined 
o    Trigger - where the parameters for trigger objects are defined. 
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o    Rates - where image update performance in milliseconds and the size of the 
internal message buffer that images use to collapse tag/alarm notification message 
is defined. 

o    Fast Zone - where the period of time (in ms) for "slow" zones is defined. 
o    Dynamic - where the blinking rate values for dynamic objects are defined. 

 
 

 
 

   
 
 
 
 

View  
This tab is used to define the properties of the Image window, repaint and resolution level. 

 
The following options are available: 

Image position 
remains when 
adding/removing 
toolbars and 
menus 

When checked, this defines that the position of the image object 
does not change when adding/removing toolbars and menu bars. 

Repaint images 
after editing 
operations 

When checked this field defines that an image will be repainted 
automatically after actions that may alter the image (such as, 
moving, copying) are performed. This option is useful in small and 
medium zones. 

Resolution factor 

Sets global stretching or shrinking factors applicable to all images. 
This is required to solve display differences caused by replacing 
an operating system, monitor or other H/W or to move between 
resolutions. 
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Number of gradient 
color steps    

This field determines the number of steps used when drawing 
objects filled with gradient color. The default is 16. Drawing large 
gradient surfaces in many steps may be slow therefore, develop 
using few steps and then increase for run-time. 

Advanced button    Displays the Image Window Attributes dialog box where window 
attributes are defined. 

Note:     When changing the Resolution Factor the window remains the same size in pixels. 
However a centimeter in one image will not be a centimeter in another. The image remains 
unchanged when the value is 1. Values greater than 1 expand the image.  

o To set correct application values: 
1.    Load the image in a PC and measure an object's length in the image (a line will do). 
2.    Load the same image in another PC and measure the same object's length. 
3.    Divide the first length by the second length and the result is the xx.xx value. 
4.    Enter the IMG_RESFACTOR with the value you found and reload the application. 
The range is 0.1<=IMG_RESFACTOR<=10. 
The default value: 1 
5.    Restart the application for changes to take effect. The range of the factor is 
0.1<+IMG_RESOLUTION _FACTOR<=10. 

o Setting Image Window Attributes 
Click the Advanced button in the View tab of the Properties dialog box. 
Note:     Image Windows Attributes is not applicable on the Web. 

 
Each listed attribute can be set to On or Off. When confirmed, the selected attributes will 
apply to all future windows of the type specified. The following options are available: 

Title bar The line in the window holding the title. This is relevant only if the Title 
bar is active. 

Name in title Title bar text. 
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System menu    The menu that opens when clicking on the top left corner of a menu. 
The menu options are: Move, Size, Close. 

Min/Max 
button    

This option defines whether the min/max buttons will appear in the 
Image window. 

Size Border Specifies that window border size can be changed by clicking and 
dragging. 

Menu Bar    Specifies that the menu bar will open in the Images window. 

Always on Top When selected the image is displayed on top of other applications. 

Pos Specifies X and Y coordinate in pixels. 

Size Specifies window size in pixels. 

Title Bar Text    Specifies the name appearing in the title bar. 

Note:     The system menu is title bar dependent. Its corresponding checkbox is unchecked 
and disabled. If the menu bar is not selected but the system menu is, the menus and items 
included in the Menu bar will appear in the system menu. 
 

 
 

 
 

   

 
 

 
 
 

Loading  
This tab determines the amount of memory available for image objects. It also 
enables/disables tag name parsing when loading images and determines the mode in 
which the image will open.  
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Note:       Setting the amount of memory available for image objects is not applicable on 
the Web. Always restart the program after updating this tab. 
The following options are available: 

Images memory 
pool size 

Enables large images with many objects to be created, but allows 
only 10 (+-) Image windows to be open at one time. The lower the 
value, the more Image windows that can be opened 
simultaneously (they must be smaller in size). The value for the 
parameter can be set from 60 to 200. 

Parse each image 
when loading 

Enables or disables tag name parsing when loading in the Images 
module. Disable this option to shorten image load time for images 
that contain network tags.When this option is disabled network 
tags validity is not checked. Therefore, use this option after all tag 
definitions in the network station are complete. 

Open new image in 
Navigation mode 

This checkbox defines that the new image will be opened in 
Navigation mode. 
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Disable automatic 
calibration of new 
images 

When an image is created, it is automatically calibrated so that the 
X and Y coordinates are proportionally correct. This automatic 
calibration respects a 4:3 ratio. 
With the automatic calibration option, you may either: 
- choose a different ratio:  
4/3 (default screen),  
5/4 (TFT screen) or  
16/9 (Wide screens) 
- disable the automatic calibration mechanism. 

Automatically add 
tooltips on load 

If you developed an image in a version of the application before 
tooltips were available, you can add them now by checking this 
option. If you check this option you can choose to add the tag 
name or tag description to all objects. If you do this, the tooltips will 
be added to all objects. You must then save the image so that the 
tooltips are stored with the image. 

Automatically add 
global custom 
actions on load 

If you developed an image in a version of the application before 
custom actions were available, you can add them now by checking 
this option. If you check this option, all the global custom actions 
will be applied to all objects. You must then save the image so that 
the custom actions are stored with the image.  

 
 

 
 

   
 
 
 
 

Trigger  
This tab defines trigger objects and onmouseover properties. 
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This tab holds the following fields: 

Trigger object    

Determines whether trigger objects are highlighted when selected. 
If this option is checked, trigger objects will be outlined (with 
dashed lines) when they are selected. The default option is not 
selected. 

Mouse pointer on 
triggers 

Determines whether the mouse pointer will be highlighted when it 
is moved on top of a trigger object in an image. The default option 
is not selected. 

Trigger small input 
box    

When checked, the input box when defining data entry for triggers, 
will be small and will only have a field for entering the value.  

State    Determines which trigger object is activated when overlapping 
triggers are clicked. This could be either; Top (default) or Bottom. 

Define Global 
Custom Actions for 
Images 

For each object in an image, you can define a set of custom 
actions. In many cases, you will want to apply the same set of 
custom actions to each object. In order to simplify this task, you 
can predefine the set of custom actions. Once defined, by default, 
when you add a custom action, unless you specify otherwise, 
these will be the default set of actions. 

Note:     Always restart the program after updating this tab. 
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Rates  
Note:     The Image Rates Properties is not applicable on the Web. 
This tab determines the image update performance in milliseconds. It also defines the size 
of an internal message buffer that images use to collapse tag/alarm notification messages 
received by WizPro. 
 

 
 
This tab has the following fields: 

Image update rate 
Specifies the image update performance in milliseconds. Specify 
maximum and minimum rates. The default values are: Maximum = 
2000 Minimum = 10. 

Message buffer 
size 

Determines the size of the internal message buffer that images use 
to collapse tag/alarm notification messages received by WizPro. 
When tag values change, an image receives messages in a buffer 
from WizPro and updates graphical objects accordingly. The range 
is 5 to 500 messages.A high value for this parameter improves the 
performance of images with rapidly changing dynamic objects, so 
that images will not have to make graphical updates for each value 
message. The default is 20 messages. 

Note:     Always restart the program after updating this tab. 
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Fast Zone  
Note:    Image FastZone Properties is not applicable on the Web. 
This tab determines the period of time (in ms) for "slow zones". A zone is slow if it has a 
background that takes more than a given period of time to draw. This parameter improves 
the drawing time for Goto Zone operations by using a cache of memory bitmaps for 
drawing the background of slow zones.  

 
This tab has the following fields: 

Fast zone 
threshold (msec) 

Specifies the fast zone threshold. If this parameter is set to be 
2500 and the background takes 2500ms or more to draw, the zone 
is considered to be slow. The range is 0 to 1 hour (in ms). The 
default is 2500ms. 

Maximum fast 
zones 

Determines the limit of the number of fast zone bitmaps that can 
be kept in a single window's memory cache. When a window 
reaches this limit, the least recently used fast zone bitmap is 
removed from the cache to make room for the new bitmap. The 
available range is 0-50.The default is 0 (FastZone disabled).  

Note:    This only affects the background of the image. Dynamic elements are drawn as 
before. Operate only when NOT is Edit mode. Always restart the program after updating 
this tab. 
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Dynamic  
Note:    Image Dynamic Properties is not applicable on the Web. 
This tab determines blinking rates for dynamic objects. The blink rate is the period of time 
that the object will appear on the screen, disappear, and then reappear, and so on. 
The format of this parameter is from left to right. It is recommended to increase the values 
for this option if it is anticipated that a large number of dynamic objects on the screen will 
be updated at once.  

 
This tab has the following field: 

The blinking rate 
values for dynamic 
objects (msec) 

Specifies the fast zone threshold. The values specified for fast, 
medium and slow are in milliseconds and can be from 50 (1/20 
second) to 30,000 (30 seconds). If a value that exceeds these 
limits is specified then the application will automatically apply the 
maximum and minimum values instead. The default values are 
200, 500 and 1000 ms. 

Note:    High blink rates decrease the system's performance. When using the Wiztune.dat 
file to enter the values, use commas (,) to separate the values. Restart the application for 
changes to take effect. 
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The Image Window 
Images are created, edited and viewed in windows that can be moved, sized and closed. 
The Image window can be operated using standard window techniques, according to the 
windows specific configuration defined during application setup. 
To open an Image window: 

Click the  New Image icon in the toolbar.  
 
Or, 
In the All Containers section, right-click Images, and select New Image from the pop-up 
menu. The Images interface will open on your screen.  
The following screen shot shows an Images window in Edit mode when the Navigate 
option has been selected. 
 

 
 

Title Bar Displays the title of the image. 

Image 
Region    The work area where the image is designed. 

Scroll Bars 
The bottom and right edge sliders are used for scrolling horizontally and 
vertically. The slider position and size relative to the scroll bar, represent 
the position and size of the window relative to the workspace. 

Status 
Bar    Specifies information of x y coordinates, scale and layers. 
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Zoom Bar The left edge slider is used for zooming:Moving up - zooms out    Moving 
down - zooms in 

Action 
Buttons 

Buttons located above and below the Zoom Bar, used for viewing 
operations. These operations include automatic positioning of the Image 
(a), window selection (w), and Image Redraw (r). 

Toolbar    Holds icons which activate the most common functions. 

 
 
 

 
 

   

 
 

 
 
 

Menu Bar 
The Image menu bar contains the following menus and options: 

File Save, Save as, Insert, Import, Attach to, Print, Exit 

Edit    
Undo/Redo, Copy/Paste to clipboard, Find/Find next, Align, Select, 
Operator, Options, Drawings, Line type, Set background color, Get/Save 
background colors 

View Toolbar, Font bar, Status bar, Objects, Operations, Drawings, Patterns, 
Align, Colors 

Layers    Elaborate on, Active layer, Definition, Override show/hide, move objects to 
active layer 

Clusters    Define, Break, Open lib, Rebuild instances, Basket maintenance, Open 
basket 

Options    Auto window, Goto, Goto Zone, Zones Definition, Repaint window, 
Simulate, Force dyn show, Mark triggers, Styles definition 

Modes    Edit, Navigate, Trigger on, Copy on, Grid setup, Snap to grid, Grid show 

Help    Image module Help files. 
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Toolbar 
The Image toolbar contains the following icons and commands icons: 

      Save 

      Print 

     Copy 

     
Paste 
 

  Undo/Redo 

     Goto 

     Goto Zone 

     Define Zone 

     
Edit Zone 
 

     Navigate Zone 
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     Trigger On 

    Mark Triggers 

    Force Dynamic Show 

    Grid Setup 

    Set Background Color 

    Repaint 

    Line Type 

Additional toolboxes can be activated/deactivated in the View menu. The following options 
are available. 

o     Objects - enables definition of image objects such as Alarm, Trigger, Dynamic, 
Cluster Definition, Group, Slider, Media Player and Scheduler. 

o     Operations - includes Rotate, Pick Color, Active Layer, Toggle Fill, Cluster 
Library, Send to Back, Bring to Front, Delete, Grid, Snap to Grid and Copy Paste 
Attributes. 

o     Drawings - contains simple drawing objects such as Line, Pipe, Box, Text, and 
Circle. Both filled and unfilled objects can be selected. The selection and text tool 
are also included in this toolbox. The Widget option holds the Slider, Media Player 
and Scheduler options. 

o     Patterns - contains 16 different fill patterns, including solid and transparent. The 
Image drawing patterns also support 32 gradient styles. The first color used for the 
gradient is the foreground color, while the last color used is the background color.  

o     Align - enables alignment of two or more selected objects. The objects can also 
be centered or resized horizontally, vertically or both. The objects can also be 
arranged so they are equal distances from each other, either vertically or 
horizontally. 

o     Colors - includes 32 colors for background and foreground (text). A left mouse 
click selects the line color while a right mouse click selects the fill color. 
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Opening Existing Files 
Image files are opened from the Application Studio. 

o To open an existing Image file: 
From the File menu of the Application Studio, select Open. In the dialog box that is 
displayed, select the file to be opened. Image files have the extension *.VIM. 
Or, 
Select the relevant file from the List of Images in the Application Studio. When a file has 
been selected and confirmed, the image will be opened. 
If an image with an undefined tag is loaded, an error message will appear with a reference 
to a file called imgname.mis, where imgname will be the name of the Image that was 
loaded. The .mis file can be opened for further information using any text editor. The file 
includes the name of the undefined tag and its type (dynamic or trigger). 
 

 
 

 
 

   

Basic Image Module 
Concepts 

 
 
 
 
 

Basic Image Module Concepts 

Active Layer 
An image is made up of layers and is built one layer at a time. A layer being worked on is 
referred to as the active layer. The layer that always exists by default is called the base 
layer. 
The active layer name is displayed in the window title together with the Image name and 
the current scale. 

Mouse Buttons 
Generally, the left button is used to draw objects. Click the left button on specific points in 
the image to start and end objects. The right button is generally used to cancel operations 
or complete them. 

Cursor 
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When a drawing operation is selected, the cursor will take on the appearance of the icon 
representing the operation that was selected. 

Filling 
Any figure can be filled with a pattern. A pattern is structured as a foreground (text) color 
over a background color. A transparent attribute can also be selected. Open figures will be 
filled up to the line connecting the endpoints of the figure. 

Orientation 
Some figures are drawn in an orthogonal orientation (only in the horizontal, vertical, or 45-
degree directions). Once such a figure is drawn, it can be rotated to any angle. 

Attributes 
Each figure (circle, square, polygon, and so on.) is assigned a set of attributes, including 
colors, filling and patterns. 
An important drawing feature is that once a figure with specific attributes is drawn, each 
time that the operation is selected again the figure will be drawn with the same attributes. 

Continuous Design 
After an object is drawn, a new object with the same attributes can be drawn immediately 
without selecting the operation again. 

Multiple Windows 
Several Image windows may appear on the screen simultaneously. One toolbox of each 
type will appear for each different Image. For example, if you opened three windows for the 
same image called DEMO, one toolbox of each type will serve all three windows. 

File Management 
Normally an Image window and image are the same. The file name for both are identical 
except for the extension. The Image module will automatically open/save both files as 
required. 
When saving an image for the first time the Save As dialog box opens where files can be 
saved in the following formats:  

o    Image   *.VIM 
o    Bitmaps *.BMP 
o    ASCII   *.ILS 

Image Limitations  
The following lists the technical specifications of the Image module:  
  

Coordinate space    2,000,000 x 2,000,000 pixels 

Number of static elements 100,000 

Number of dynamic elements 14,000 

Number of zoom scales 2,048 

Number of zones 500 

Number of layers    64 
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   About this chapter: 
This chapter describes the Image Editor, as follows:  
Overview, provides an overview of the Image Editor. 
Basic Principles describes some of the basic concepts used for Image design. 
File Menu describes the options in this menu. 
Edit Menu describes the options in this menu. 
View Menu describes the options in this menu. 
Layers Menu describes the options in this menu. 
Cluster Menu describes the options in this menu. 
Options Menu describes the options in this menu. 
Modes Menu, describes the options in this menu. 
 

 
 

 
 

   

 
 

 
 
 

Overview 



Chapter 21 Image Editor 

719 

The Image Editor is the graphic tool of the application. It is used to create and view the 
images that enable the operator to visualize part or all of a control process. 
The Image Editor operating in an Image window defined during application setup includes 
a wide variety of drawing tools that make image design quick and easy. Any drawing in this 
window can be zoomed and scrolled.  
Objects created using the Editor can be linked to tags, so that as the values of a tag 
change, the objects linked to the tag will change accordingly. In addition, objects can be 
defined as triggers for tag value input. 
Image Editor operations can be performed only by operators that have the appropriate 
authorization level permission. While some operators may be authorized to design and 
view images, others may only be able to view them. In addition, each object in an image 
has its own authorization level. 
The following basic activities can be performed using the Image Editor: 

o     Image Editing - Image design. 
o     Image Animation - Associating Image objects and dynamic properties with tags 

and modifying their values. 
o     Image Navigation - Navigating within an image. 

 
 
 

 
 

   

 
 

 
 
 

Viewing Images 

 
There are several ways to view images, using several window positions and zoom levels. 
You can auto arrange all the image objects, or zoom into a specific part of the image, or 
jump to a pre-defined position and zoom level, called Zone, in the image, or define the 
coordinates within the image window you wish to jump to. 
For more information about the various image view options click the respective topic: 
AutowindowHLP_WZ2EDT_AUTOWINDOW  
Zooming into a specific part of the image 
Defining ZonesHLP_DLG_WZ2_DZONE  
Jumping to Zones  
HLP_DLG_WZ2_HANDNAV  
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Image Overview 

 
Application Images are dynamic graphs representations of industrial processes. Each tag 
in an industrial process can be represented by an image object, and each object can 
represent specific process values, thereby displaying a dynamic picture of the process. 
To initiate the Image window: 
1. Right click the Image file located in the Containers tree 
2. Select the "New Image" option with the left mouse button. 
OR 
Through the Pop-up menu located in the List Zone  
1. Select the Images file from the Project Tree. 
2. Right click an existing Image or click anywhere in the List zone 
3. Choose the New Image option. 
To view the list of Image files:  
Right click Images on the All Containers tree. As a result a list of all Images is displayed. 
To set the order of fields to be displayed in the Images list: 
1. Click the Image file in the Containers tree 
2. Right click an existing Image or anywhere in the List Zone 
3. Choose the View Setting option from the menu. 
See the following: 
The Image Toolbars  
Viewing Images  

 
 

 
 

   

Basic Principles 

 
 
 
 
 

Basic Principles 



Chapter 21 Image Editor 

721 

This section describes some of the basic concepts used for image design that should be 
understood before using the Image Editor. 

 
 

 
 

   
 
 
 
 

Objects 
Objects are geometric figures or text that together make up an image. Objects that are 
geometric figures can be either open or closed, and can be filled with specified patterns 
and displayed in unlimited colors. 
In addition to the standard object design features, the following features are also available: 

o    Objects can be defined as Groups, Dynamic, and Triggers. 
o    The Cluster Library contains defined objects that can be used in any image. 

Library clusters can be defined to include one or more existing image object. 
o    An image can include widgets (slider scale objects and Media Player) to enable 

fast and simple tag value changes. Widgets are custom designed and can be 
placed anywhere within the image. 

o    Image objects can be associated with alarms.  
 
 

 

 
   
 
 
 
 

Drawing Space 
An image is drawn in a drawing space measured in drawing units. This measurement can 
be useful when moving throughout the drawing space and determining object sizes. 
The drawing space is from -1,000,000 to +1,000,000 drawing units. 
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Image Window 
An image is held in an image window. The part of the image that is displayed in the window 
depends on the window size, image size, and zoom level. 

 
 

 
 

   

 
 

 
 
 

Fast Actions 
Fast Actions are predefined macros that can be attached to triggers to enable you to 
perform routine operations. These include: 

o     CloseActiveImage - used to close the currently opened Image file. 
o     CloseChart - used to close a specified Chart file. 
o     CloseEventSummary - used to close a specified Events Summary file. 
o     CloseImage - used to close a specified Image file. 
o     GotoUrl - after this trigger option is defined for an Image object when the object 

is clicked it will jump to the defined URL.  
o     LoadAnnFile - used to open a specified Events Summary Profile file, or an 

Event Summary file. 
o     LoadHtmlPage - used to load a specified HTML page. 
o     LoadImage - used to open a specified Image file, window and zone. This may 

also be used to change the context of the image (see the chapter on tag 
templates). 

o     LoadPictureFile - used to open a specified image window.This may also be 
used to change the context of the image (see the chapter on tag templates). 

o     LoadRecipe - used to load the recipe to apply its tag values to the image 
o     LoadTrendFile - used to open a specified trend file.This may also be used to 

change the context of the chart (see the chapter on tag templates). 
o     LockTagsValues - used to open the Tag Value Lock window where you can 

lock/unlock tags and change the locked tags definitions. 
o     OpenScheduler - used to jump from the Image to the Internet Scheduler 
o     SaveRecipe -used to save the recipe tag values to the image 
o     ChangeContext -Changes the context of the current image (see the chapter on 

tag templates). 
o     LoadLayout - Loads the selected layout and sets the context if required so that 

all windows have the same context. 
o     LoadAnlFile - Loads a history viewer and allows you to set the context if 

required. 
o     CloseAnl - Closes the selected history viewer 
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Note:     In this version a recipe description that has been defined in this trigger cannot be 
modified. 
 

 
 

 
 

   

 
 

 
 
 

Lock Object 
This option defines that a selected image object when locked cannot be moved from its 
location. When a locked object is copied onto the clipboard the copied object is unlocked 
while the original object remains locked. 

 
 

 

 
   
 
 
 
 

Zoom Level 
The zoom level determines how the image will be viewed. The smaller the zoom level the 
closer and larger the image. 
Any zoom level can be assigned from 1 to 2048. At a zoom level of 64, each drawing unit 
is 0.01 mm on a standard monitor. 

 
 

 

 
   
 
 
 
 

Layers 
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An image is structured in layers. Each layer contains a part of the overall image. When the 
drawing is completed the layers can be merged. Each individual image layer can be made 
visible or hidden. Layers can be added or changed, but not removed. 

 
 

 
 

   
 
 
 
 

Zones 
Zones are predefined positions in the image window.  

 
 

 

 
   
 
 
 
 

Goto Zones 
The operator with the relevant authorization can, using the Goto Zone option, jump to any 
defined zone from anywhere in an image. The Goto Zone dialog box is used to enter the 
coordinates of the location to which to jump in the image. Any position in the image can be 
jumped to whether or not that position is defined as a zone.  

 
 

 

 
   
 
 
 
 

Zone Navigator 
The Zone Navigator is a global, multi-image zone navigation window that enables you to 
quickly and efficiently navigate through a list of zones defined in the application's various 
image files. A number of navigators each of which can contain a number of zones from one 
or more different image files can be defined in the module. 
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Toolboxes 
The following toolboxes can be activated in the View mode. When the Image window 
definition is to open with Navigate Mode On, the Drawing, Operations, Options and Color 
toolboxes will also open. 

 
 

 

 
   
 
 
 
 

Image Files 
There are three file extension types: 

o    Image    *.VIM 
o    Bitmaps *.BMP 
o    ASCII    *.ILS 

By default image files are saved as *.VIM. 
 
 

 
 

   

 
 
 

 
 

ASCII Files 
By default images are saved in .VIM files. You can, however, also save images as ASCII 
files, which can then be edited and loaded in the Image window. 
Image ASCII files can be useful for the following purposes: 

o    Viewing: Saving images in ASCII format enables you to obtain documented 
records of the images so that they can be viewed by opening the file with any text 
editor. 
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o    This option provides the illustration designer and plant engineer with a powerful 
image-debugging tool. 

o    The ASCII format enables images to be converted easily from/to other formats 
and be used as drawing objects. 

o    This option also enables you to draw Images by editing text files. This can be 
useful when you are working outside the application environment, or want to create 
an image without physically drawing it. 

o    Images in ASCII format can be used for numerous purposes, to enhance Image 
creation and modification capabilities. 

o    Images saved as ASCII (x.ILS) files can be loaded in the same as any other 
image. 

 
 

 
 

   
 
 
 
 

Bitmap 
A bitmap is a graphic format informing the application to consider the graphic element (text 
or drawing) and its background as a solid unit. 

 
 

 
 

   

File Menu 

 
 
 
 
 

File Menu 
The Image File menu has the following options: 
 

Save Select this option to save the current image file with its original name. 
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Save as Select this option to save the current image file with a new name. 

Insert This option allows you to insert an existing image file into an existing Image 
window. 

Import An image file that has been saved as an ASCII file can be imported into the 
image. This file can then be viewed and edited. 

Attach to 
The File Attach to menu allows you to attach an image (*.VIM) to an existing 
window. This replaces the image in the window. The VIM file is modified to 
reflect this change. 

Print    Select this option to print the current view. 

Exit Select this option to close the current window. 

 
 
 

 
 

   

 
 

 
 
 

The Image File Menu 
The Image File menu provides the user with the basic operations of the Image window: 
File / Save Select this item to save the current image window file with its original name.  
File / Save as Select this item to save the current image window file with a new name.  
File/InsertThe Insert file option allows you to insert an existing Image File, into an existing 
Image Window. 
File/Import You can import or load an Image file that has been saved as ASCII file into the 
Image Window. This file can then be viewed and edited. 
File/Attach to The File Attach to menu allows you to attach an Image (*.VIM) to an existing 
Window. This replaces the Image inside the Window. The VIM file is modified to reflects 
this change. Common Open Dialog lets you select the Attach VIM (actually the Image is 
what is attached).  
File/Print Select this item to print the current view. 
File/Exit Select this item to close the current window.  
If you made changes to the image, but did not save the file, you will be prompted to either 
save the changes you made or discard them.  
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New Image Files 
New Image files are opened from the Application Studio. 

o To open a new Image file: 
From the File menu in the Application Studio, point to New and select Image.  
Or,  
Press Ctrl +N. 
Or,  
In the Container List of the Application Studio Containers right-click Images and select New 
Image from the popup menu. A new Image is displayed with the default Image properties. 

 
 

 

 
   
 
 
 
 

Open Files 
Image files are opened from the Application Studio. 

o To open an existing Image file: 
From the File menu of the Application Studio, select Open. In the dialog that is displayed, 
select the file to be opened. Image files have the extension *.VIM. 
Or, 
Select the relevant file from the List of Images in the Application Studio. When a file has 
been selected and confirmed, the Image will be opened. 
If an image with an undefined tag is loaded, an error message will appear with a reference 
to a file called imgname.mis, where imgname will be the name of the image that was 
loaded. 
The .mis file can be opened for further information using any text editor. The file includes 
the name of the undefined tag and its type (dynamic or trigger). 
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Saving Files 
When saving the image for the first time, the Save As dialog box with the extension of 
*.VIM opens in the default directory for the image.  

o To save an Image as an Image file: 
1.   Select Save as to open the Save as dialog box. 
2.   Select Image from the Save as type list. The file is saved with the *VIM extension. 

o To save an Image as a Bitmap: 
1.   Select Save as to open the Save as dialog box. 
2.   Select Bitmap from the Save as type list. The file is saved with the .BMP extension. 

o To save an Image as an ASCII file: 
1.   Select Save as to open the Save as dialog box. 
2.   Select ASCII from the Save as type list. The file is saved with the .ILS extension. 

 
 

 

 
   
 
 
 
 

File / Save   
Select this item to save the current image and window settings (position, mode etc.) 
Selecting the Save option opens the Save As dialog box, prompting you to specify a file 
name. The dialog box displays the image files default folder and default image files 
extension (*.VIM). 

 
 

 
 

   

 
 
 

 
 

File / Save as   
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Select this item to save the current image window file under a new file type:VIM, ASCII, 
BITMAP 

 
 

 
 

   

 
 

 
 
 

Deleting Files 
Images are deleted from the Application Studio. 

o To delete an Image file: 
Select the image name from the List of Images in the Application Studio. Right-click on the 
file you wish to delete and select Delete from the popup menu. 

 
 

 

 
   
 
 
 
 

Inserting Files 
o To insert an image: 

1.   Select Insert from the File menu. The Open dialog box opens.  
2.   Double click the relevant file from the list. The file contents will be merged into the 
currently opened image file. 
Note:    Imported objects will be placed in the layer to which they belonged in the source 
image (according to the ordinal number of the layer and not the layer name), or in the 
current layer if the layer to which they belonged does not exist in the target image. The 
same applies for text in different fonts. 
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File / Insert    
The Insert file option allows you to insert an existing Image file, into an existing Image 
Window. 

 
 

 
 

   

 
 
 

 
 

Importing Files 
The Import option enables you to import or load an image file that has been saved as an 
ASCII file (*.ILS) into the Image window. This file can then be viewed and edited. 

o To import an Image as an ASCII file: 
1.   Select Import from the File menu. The Open dialog box opens.  
2.   Double click the relevant file from the list. The file contents will be imported into the 
currently opened image file. 
Note:    
Imported objects will be placed in the layer to which they belonged in the source Image 
(according to the ordinal number of the layer and not the layer name), or in the current 
layer if the layer to which they belonged does not exist in the target Image. The same 
applies for text in different fonts. 
Images that were saved as ASCII (x.ILS) files can be loaded in the same way as any other 
image. 
For more information see Appendix G, ASCII (ILS) File Format for the structure and format 
of an ILS file. 

 
 

 

 
   
 
 
 
 

Import   
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You can import or load an Image file that has been saved as ASCII file into the Image 
Window. 
This file can then be viewed and edited. 

 
 

 
 

   

 
 

 
 
 

File Attachment  
The Attach to option enables you to attach an Image (*.VIM) to an existing window. This 
replaces the image inside the window. The VIM file is modified to reflect this change.  

o To attach an image file: 
1.   Select Attach to from the File menu. The Open dialog box opens.  
2.   Double click the relevant file from the list. The file contents will be imported into the 
currently opened image file. 

 
 

 

 
   
 
 
 
 

File / Attach to    
The File Attach to menu allows you to attach an Image (*.VIM) to an existing Window. 
This replaces the Image inside the Window. The VIM file is modified to reflects this change. 
The Common Open dialog box enables you to select the Attach VIM (the Image). The 
Image title changes to something like attached to c:\APPLIC\APPL\2.VIM. 
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Printing Images 
Images are printed from the Image file menu. 

o To print an Image file: 
Select Print from the File menu. The Print dialog box is displayed: 
1.   To send the Image to a file in the bitmap format 
2.   Select the Bitmap option and specify the filename. 

 
 

 
 

   
 
 
 
 

File / Print    
Select this item to print the current view. 

 
 

 
 

   

 
 
 

 
 

File / Exit    
Select this item to close the current window.  
If you made changes to the image, but did not save the file, you will be prompted to either 
save the changes you made or discard them. 

 
 

 
 

   

File Menu 
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The Image File Menu 
The Image File menu provides the user with the basic operations of the Image window: 
File / Save Select this item to save the current image window file with its original name.  
File / Save as Select this item to save the current image window file with a new name.  
File/InsertThe Insert file option allows you to insert an existing Image File, into an existing 
Image Window. 
File/Import You can import or load an Image file that has been saved as ASCII file into the 
Image Window. This file can then be viewed and edited. 
File/Attach to The File Attach to menu allows you to attach an Image (*.VIM) to an existing 
Window. This replaces the Image inside the Window. The VIM file is modified to reflects 
this change. Common Open Dialog lets you select the Attach VIM (actually the Image is 
what is attached).  
File/Print Select this item to print the current view. 
File/Exit Select this item to close the current window.  
If you made changes to the image, but did not save the file, you will be prompted to either 
save the changes you made or discard them.  

 
 

 
 

   

 
 
 

 
 

File / Attach to    
The File Attach to menu allows you to attach an Image (*.VIM) to an existing Window. 
This replaces the Image inside the Window. The VIM file is modified to reflects this change. 
The Common Open dialog box enables you to select the Attach VIM (the Image). The 
Image title changes to something like attached to c:\APPLIC\APPL\2.VIM. 
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File / Exit    
Select this item to close the current window.  
If you made changes to the image, but did not save the file, you will be prompted to either 
save the changes you made or discard them. 

 
 

 
 

   

 
 

 
 
 

Import   
You can import or load an Image file that has been saved as ASCII file into the Image 
Window. 
This file can then be viewed and edited. 

 
 

 
 

   

 
 
 

 
 

File / Insert    
The Insert file option allows you to insert an existing Image file, into an existing Image 
Window. 
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File / Print    
Select this item to print the current view. 

 
 

 
 

   

 
 

 
 
 

File / Save   
Select this item to save the current image and window settings (position, mode etc.) 
Selecting the Save option opens the Save As dialog box, prompting you to specify a file 
name. The dialog box displays the image files default folder and default image files 
extension (*.VIM). 

 
 

 
 

   

 
 
 

 
 

File / Save as   
Select this item to save the current image window file under a new file type:VIM, ASCII, 
BITMAP 
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Edit Menu 

 
 
 
 
 

Edit Menu 
The Image Edit menu is the graphic tool of the application and is used to create and view 
the images enabling you to visualize part or all of a control process. The following options 
are available: 
 

Undo/Redo Undo/redo the last action. 

Copy/Paste to 
Clipboard Copy/paste data between applications. 

Copy/Paste 
Attributes Copies/pastes attributes from one object to another. 

Edit Properties 
Edit drawing objects and clusters. Attributes such as line and fill 
color, existing dynamic definitions and trigger definitions can be 
modified. 

Find    Find and go to an object that matches the search text. 

Find Next Search for the next occurrence of the last search string. 

Align    Align two or more objects at right top or bottom. Center or resize 
horizontally, vertically or both. 

Select Select objects in the image. 

Operations This option when selected enables editing and animation 
operations in an Image. 

Drawings 

This option when selected enables you to draw and add text by 
using the polyline, box, circle, pipe, text, and pick color tools or 
assign trigger objects with the button tool. The media player or 
slider properties can also be defined. 
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Set Background 
Color  This option when selected sets the image background color. 

Get Colors    This option when selected retrieves customized colors. 

Save Colors    This option when selected saves customized colors. 

 
 
 

 
 

   

 
 

 
 
 

Image Edit Menu 
The Image Edit Menu is the graphic tool of the application. It is used to create and view the 
images that enable personnel to visualize part or all of a control process. 
The Image Edit Menu includes a variety of drawing tools that make image design quick and 
easy. 
 
The Image Edit Menu consists of the following menu items: 
Edit /Undo- RedoThe Undo command reverses or deletes the last entry. Immediately after 
you undo an action, the Undo command changes to Redo, allowing you to restore what 
you reversed 
Edit/ Copy To Clipboard The Clipboard is an Operating system facility use to transfer data 
between applications. 
Edit/ Paste form Clipboard Select this item to paste objects from the Clipboard to an image 
Edit/Edit Properties Select this item to edit objects 
Edit/ Find Using the Find option you can find and Goto an object that matches the search 
text 
Edit/ Find next Find next searches for the next occurrence of the last search string. 
Edit/Align Two or more selected objects can be aligned to Right Top or Bottom. They can 
also be centered or resized Horizontally, Vertically or Both. 
Edit/Select This item is used to select objects in the image.  
Edit/Operations The Operations Menu allows you to perform editing and animation 
operations on your Image. 
DrawingsThe Drawings Menu enables you to draw and add text in your Image by using 
the Polyline, Box, Circle, Pipe, Text and Pick color tools. 
Line Type Line Type enables you to define lines with different widths and types for objects 
that include lines as part of their shape 
Set Background ColorHLP_WZ2EDT_SETBACKCOLOR  
Get Colors The Set Image Background feature enables you to set the image background 
color. 
Save ColorsHLP_WZ2EDT_SAVECOLORS  
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Undo/Redo 
The Undo and Redo operations are available for Image drawing operations. This applies to 
actions such as delete, scale, rotate and change attributes (color) of an object. The Undo 
command reverses or deletes the last entry. 
Immediately after you undo an action, the Undo command changes to Redo, enabling you 
to restore what you reversed. Up to 50 levels of Undo/Redo operations are available. 

 
 

 

 
   
 
 
 
 

Undo/Redo    
Undo and Redo operation is available for Image drawing operations. This applies to 
actions as delete, scale, rotate and change attributes (color) of an object. 
The Undo command reverses or deletes the last entry. 
Immediately after you undo an action, the Undo command changes to Redo, allowing you 
to restore what you reversed. 
Up to 50 levels of undo/redo operations are available. 
To Undo  
1. Select object you want to undo. 
2. Click on the Undo tool in the Image main toolbar. 
3. The action is reversed. 
You can also Undo an action by clicking the Undo option from the Operations Menu, or 
pressing Ctrl Z. 
To Redo 
1. Select the object you want to redo. 
2. Click on the Redo tool in the Image Main Menu Toolbar. 
3. Your action is restored. 
You can also Redo an action by clicking the Redo option from the Operations Menu, or 
pressing Ctrl Y. 

Notes  The Align feature does not support the Undo feature. Copying 
objects using <Ctrl C> does not support the Undo feature.  
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Copy/Paste to Clipboard 
The Clipboard is a convenient way to transfer graphic objects from the application to 
external applications, vice versa, and from one image to another. This option is only 
available when the Edit mode is activated. 

 
 

 

 
   
 
 
 
 

Copy and Paste Attributes 
This feature can be used to copy and paste both objects and text attributes. 
In an image select an object/text and then click the Copy Attributes button in the 
Operations toolbox. 
Using the tool, click on an object or text in the image. The copied attributes are pasted into 
the selected item. 
Right click anywhere in the image to end this process. 
Notes: 

1. Objects are applied by clicking each object individually. 
2. Copied attributes can only be pasted into the same object/text type. That is, 

attributes copied from text cannot be pasted into objects. 
3. The Copy Attributes button is only enabled when an object/text is selected. 
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Copy To Clipboard 
The application enables you to use the Clipboard as a convenient way to transfer graphic 
objects from the application to external application and vice versa. 
There are two ways to copy an object to the Clipboard  
Through the Edit Menu  
1. Select an object 
2. Select the Copy to Clipboard item from the Edit menu 
3. As a result the object will be copy to the clipboard for later use. 
Through the Pop-Up Menu 
1. Right click an object in the Image window 
2. From the Pop-up Menu select the Copy to clipboard. The Copy to Clipboard operation 
will copy a selected object(s) in many formats.  
Note: Copying objects using <Ctrl C> does not support the Undo feature.  

 
 

 
 

   

 
 

 
 
 

Paste form Clipboard 
Select this item to paste objects from the Clipboard to an image. The imported object will 
be placed in the current active layer. 
For a Paste from Clipboard operation, the application will paste the object first in the image 
parameter format (if the object is in that format). If the object is not in that format, the 
application will paste the object in the Metafile format. If the object is not in that format 
either the application will paste the object in the Bitmap format. If the object is not in any of 
these formats, the application will not paste the object.  
There are two ways to paste an object from the Clipboard  
Through the Edit Menu 
1. Select an object 
2. Select the Paste from clipboard item from the Edit menu 
Through the Pop-Up Menu 
1. Right click object in the Image window 
2. From the Pop-up Menu select the Copy to clipboard 
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To place an object after it has been pasted, either double-click on the point in the image 
where you want the object to appear, or click once to set the size and location of the 
image. 
If you click once, you must define the area which the object will fill by moving the outlined 
box that appears (by dragging the mouse) to the end point of the object, and clicking again.  

 
 

 
 

   

 
 

 
 
 

Copy/Paste Attributes 
This feature supports the following: 

o    Object - line and fill color 
o    Text - font style, size, color and background color 
o    To copy/paste an attribute do the following: 

1.   In an image select an object/text. In the operations toolbox click the Copy/Paste 
Attributes button. 
2.   Click on another object/text in the image. Each time you click an object/text the 
attributes of the copied item will be pasted in to it. 
3.   Right click anywhere in the image to end this process. 
Note:    An object's attributes can be applied by clicking each object individually. 
Copied attributes can only be pasted into the same object/text type. This means that 
attributes copied from text cannot be copied into objects. 
The Copy Attributes button is only enabled when an object/text is selected. 
Text attributes cannot be pasted into object attributes and vica versa. 

 
 

 
 

   

 
 
 

 
 

Copy/Paste Attributes for Grouped Objects 
This option is available for a group of objects. 
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Each individual object in the group may have different attributes, (which will remain the 
individual object's attribute after being grouped). However the attribute of the group will be 
the same. For example the object color and fill of the group is green while each individual 
object within the group has a different color and fill.  
Using the copy/paste button, the object group can be selected and its attributes pasted into 
an object out of the group. 
Note:    The attribute of a group/selected list that has both text and objects cannot be 
copied and pasted into another object. 

 
 

 
 

   
 
 
 
 

Image Parameters 
This format is used by to create image objects. Each object in an image includes several 
parameters (such as dynamic, trigger, etc.). These parameters inform the application how 
the object behaves. 
If this format is used, when transferring an object from/to the clipboard the object will 
include other Imaging parameters information. 

 
 

 

 
   
 
 
 
 

Bitmap 
A bitmap graphic is captured by pixels. In a Copy to Clipboard operation, the application 
copy's the selected object(s) in all of the formats. During a Paste from Clipboard operation, 
the application will paste the clipboard object first in the image parameter format. If the 
object is not in this format it will be pasted in bitmap format and if this fails the object will 
not be pasted. 
Note:     If you paste an object from the clipboard, the imported object will be placed in the 
current active layer. 
When a text object is pasted from the clipboard and the original font of the object you 
pasted does not exist in your system, the object will appear in the current active font. 
The following editing operations can be applied to objects pasted from the Clipboard to a 
image: 
 

Operation Bitmap 
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Move    Yes 

Size Yes 

Rotate No 

Fill No 

Color No 

Dynamic Yes 

Trigger Yes 

 
 
 

 
 

   

 
 

 
 
 

Bitmap Transparency Dialog Box 
This dialog box is used to change color transparency of an Image bitmap.  

o To access the Transparency dialog box do the following: 
1.    From the Drawing Tool bar click the Picture icon and then click in the Image drawing 
area. The Select Picture window opens. 
2.    Double click on a bitmap image. The image will open on your screen. 
3.    Right click anywhere in the image and then select and double click the imported 
bitmap. The Transparency dialog box opens. 
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4.    Check the Use Transparency field to activate the Selected Color fields. 
5.    In the color fields define the required transparency. 
6.    Click OK to save.  

o To copy an object from an image to the Clipboard: 
Select an object(s), and then select Copy to Clipboard from the Edit menu, or click the 
<Ctrl-Insert> key combination.  
Or, 
Select an object and then right click to open a pop up menu and select Copy to Clipboard. 

o To paste an object from the clipboard to an image: 
1.    Select Paste from Clipboard in the Edit menu, or press the <Shift-Insert> key 
combination or select an object and then right click to open a pop up menu and select 
Paste to Clipboard.  
2.    To paste the object do either: 

o     Double-click on the point in the image where you want the object to appear. The 
object will automatically be pasted at the location you selected in its original size. 

o     Click once to set the size and location of the object. You can then define the 
area that the graphic object will fill, using an outline box. After the initial click, 
simply move the outline box, by moving the mouse, to the end point of the object, 
and click again. 

Note:     If you start by clicking on a high point, and move down and click on a lower point, 
the graphic object will appear upside-down (unless that object is in the bitmap format). 
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   Edit Properties 
The Edit Properties dialog box is used to modify selected objects. 

o To open the Edit Properties dialog box: 
Select Edit Properties in the Edit menu, or select an object and then right click to open a 
pop up menu and select Edit Properties.  

  
This dialog box has the following options: 

Objects List This section displays a tree of the object according to hierarchy. 

Object Properties    This section shows the object selected from the Objects List. 

Definition     
This button when clicked is used to modify dynamic tag 
parameters and is only available for objects such as button, alarm 
or text. It is not available that are defined as basic objects. 

Attributes This button when clicked is used to modify an objects color line 
and color fill. 

Triggers    This button when clicked opens the Trigger Definition dialog box. 
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Triggers 
Trigger objects are objects that you can click on to cause pre-defined tag values to be set 
automatically or manually, cause the image to go to a pre-defined zone, or cause pre-
defined macros to be activated. Any object can be defined as a trigger object. However, 
only one tag value input method can be assigned per object. 
The tag value input method that you select in the dialog box will be marked by an arrow.  
The Data Entry, Bit, Smooth, and Test the last position of the dialog box will be saved 
(unless you activated the Cancel button before completing the operation). This means that 
you can drag the dialog box to any position on the screen, and thereafter, whenever the 
dialog box will be invoked, it will appear in its last position. However, the dialog box 
position is relative to the window position. If the window is moved and then the dialog box 
is invoked, it will appear in the position it was last saved, relative to the new location of the 
window.  
For Text Table objects, the String button will appear in the Input Method field instead of 
Data Entry. 
For Time objects, the Time button will appear in the Input Method field instead of Data 
Entry. 
For Date objects, the Date button will appear in the Input Method field instead of Data 
Entry.  

o To define a trigger 
Select the object you want to define as trigger, and then Right click the selected object. 
Select Trigger Definition from the popup menu. 
Or, 
From the Edit menu select Operations, then click on the Trigger option. 
Or, 
From the Objects toolbar select the Trigger tool. The Trigger Object Definition dialog box 
opens: 

     
1.    Select the station to which the tag associated with the trigger object is attached. 
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2.    Select the tag associated with the trigger object, or click the browse button to open the 
Tag Definition dialog box where you can define a new tag. This tag may be a tag template 
identifier (see the chapter on tag templates). 
3.    Select the trigger object Input Method. Several tag input methods can be used for 
trigger objects. To test an input method, tag value variations can be simulated.  
The tag value input methods include the following: 
 

Action     
When the operator clicks on an object, a present value is applied to the 
tag, or a pre-defined macro is activated. This method is valid for all tags 
and objects. 

Buttons 

When the operator clicks on an object, a set of buttons with present 
values appears. Activating a button causes a value to be applied to the 
tag, or a pre-defined macro to be activated. This method is valid for all 
analog and digital tags. 

Bit    When the operator clicks on an object, On, Off, and Toggle buttons 
appear. This method is valid for all tags and objects (except string tags). 

Data Entry    
When the operator clicks on an object, a dialog box appears to specify a 
numerical tag value. This method is valid for all tags and objects besides 
Text Table objects. 

String    

The String button will appear instead of the Data Entry button. When the 
operator clicks on an object, a Text Table that was made active for the 
tag associated with the object will be applied. The Text table contains a 
list of strings corresponding to different tag values. 

Date 
The Date button will appear instead of the Data Entry button. When the 
operator clicks on an object defined as a Date/Time object, a dialog 
appears with the current date value to be modified. 

Time 
The Time button will appear instead of the Data Entry button. When the 
operator clicks on an object defined as a Date/Time object, a dialog box 
appears with the current time value to be modified. 

Smooth 
When the operator clicks on an object, a dialog box appears with tag 
values that can be selected using sliders. This method is not valid for 
string tags.  

Momentary When the operator clicks on an object, a dialog box appears enabling 
the user to change tag value in a one short action. 

Fast Actions When the operator clicks on an object, a pre-defined macro, called Fast 
Action is executed (note that some Fast Action are not Web enabled). 

4.    Click the Set Macro button to define macros for trigger objects (note that Set Macro is 
not supported on the Web). 
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5.    Click the Test button to test the input method and adjust its appearance. In addition 
you can move the numeric keypad to any location on your screen. When you re-open the 
application and operate the keypad, it will be opened at the same location as you selected. 
 

 
 

 
 

   

 
 

 
 
 

Fast Actions 
Fast Actions are pre-defined macros that can be attached to a trigger, enabling you to 
easily execute routine operations.  
Note:     Fast actions are Web enabled. 

o To define Fast Action triggers: 
1.    Click the Fast Action button on the Trigger Object Definition dialog box. The List of 
available Fast Actions dialog box is displayed. 

 
Select the Fast Action you want to attach to the trigger: 

o CloseActiveImage - used to close the opened Image file. 
o CloseChart - used to close a specified Chart file. 
o CloseEventSummary - used to close a specified Events Summary.  
o CloseImage - used to close a specified Image file. 
o GotoUrl - after this trigger option is defined for an Image object when the object is 

clicked it will jump to the defined URL.* 
o LoadAnnFile - used to open a specified Events Summary Profile file or an Event 

Summary file. * 
o LoadHtmlPage - used to load a specified HTML page. * 
o LoadImage - used to open a specified Image file, window and zone. 
o LoadPictureFile - used to open a specified image window. * 
o LoadTrendFile - used to open a specified trend file. * 
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o LockTagsValues - used to open the Tag Value Lock window where you can lock / 
unlock tags and change the locked tags definitions. 

o Open Scheduler - used to jump from the Image to the Internet Scheduler 
o SaveRecipe - used to save the recipe tag values to the image 
o Change Context - used to change the tag context of the current image 
o LoadLayout - Loads the selected layout and sets the context if required so that all 

windows have the same context. 
o LoadAnlFile - Loads a history viewer and allows you to set the context if required. 
o CloseAnl - Closes the selected history viewer 

2.    Click OK to define the selected Fast Action Parameters. 
Note:    * indicates that when Load in the same window (Web only) is checked a new page 
in the Explorer is not opened, however the current page is changed to the selected one. 
Note:    The Web column indicates with the ‘+’ sign that the feature works on web. The ‘-’ 
sign indicates that the feature doesn’t work on web. 
 

 
 

 
 

   

 
 

 
 
 

Find\Find Next  
The Find option is used to search and jump to an object that matches the search text. This 
feature is available in Edit mode only. The Find command opens the Find dialog box while 
Find Next searches for the next occurrence of the last search string. 
A search string can be of upto and including 256 characters. Search options are common 
for all Image windows 

o To open the Find/Find next dialog boxes: 
Select Find/Find next from the Image Edit menu or press the following keys: 

o    Ctrl F = Find 
o    F3 = Find next 

Clicking the Advanced button in the Find dialog box opens the lower section of the dialog 
box showing the advanced search options. If a search fails, a notification message is 
displayed with the searched string. 



Chapter 21 Image Editor 

751 

 
The Find in Image dialog box has the following options.  

Simple text Check this checkbox if the Find field is in simple text. 

Tag name This includes tag names in Dynamic object, Tag value, Trigger, 
Text table and Widgets. 

Alarm family As defined in alarm object. 

Match case The search is made for full matching letter cases; otherwise, 
strings are compared ignoring the case. 

Match whole word 
The search is made to find the exact full text, all characters are 
accounted for. Otherwise, the search is made to find the 
occurrence of the search string inside any text. 

Only in visible view If this option is checked, the search is limited to the visible part of 
the Image inside the Image window. 

Trigger macro 
name The name of the macro that a trigger activates. 

Trigger zone name The name of the zone that a trigger jumps to. 

Trigger button Any name in a trigger button including title and legend on each 
button. 

Cluster instance The instance name of a cluster. 

Cluster library The library name of cluster instance. 

Cluster object The cluster object name as appearing in the library. 
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Text table value    The current string value matches the search string. 

String tag value The current string tag value matches the search string. 

Goto object 
Checks that the application will automatically navigate to the found 
object and bring it into the middle of the current window; scale will 
not be changed. 

Always Goto 
object    

The application will jump to the found object, even if it already 
appears in the visible part of the Window. 

Smart order    

Performs a geometric search. The image is searched from 'left to 
right' in strips of the same size of the current open view. In many 
cases, such a search is more intuitive, especially if the image is 
divided into zones with a corresponding layout. If this option is not 
checked, the search is simple, meaning that the search is by the 
order of objects in the image, from the first object created to the 
last one.  

Note:    For Text table and String tag the Simple text option must be also checked. 
If searching for trigger zone or macro the search is also made in trigger buttons for a 
match. Options can be set independently. 

 
 

 
 

   

 
 

 
 
 

Image Find Option 
Using the find option you can find and Goto an object that matches the search text. This 
feature is available in Edit mode only. The Find command opens the Find dialog box while 
the Find next searches for the next occurrence of the last search string. 
You can activate the Find option using the following keys: 
Find:  Ctrl F 
Find Next: F3 
In the Find in Image option you can do the following: 
You can enter search strings up to 256 characters 
Search options are common for all Image Windows. 
Search Options  
The following is a list of the search categories and their description you can select to 
search for: 
Simple text. 
Tag name - this includes tag names in Dynamic object, Tag Value, Trigger, Text table and. 
Widgets. 
Alarm family name - as defined in alarm object. 
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Trigger macro name - the name of the macro that a trigger activates. 
Trigger zone name - the name of the zone that a trigger goto 
Trigger button - any name in trigger button including title and legend on each button. 
Cluster Instance - the instance name of a cluster. 
Cluster library - the library name of cluster instance. 
Cluster object - the cluster object name as appearing in the library. 
Text table value - the current string value matches the search string. 
String tag value - the current string tag value matches the search string 
Notes:  

1. For Text table and String tag the Simple text option must be also checked. 
2. If searching for trigger zone or macro, then the search is also made in trigger 

buttons for such a match. 
3. Options can be set independently from one of the other. 

Other Search Options 
Other search options give you control of the way the actual search is made. 
Match case -- the search is made for full match of case of letters, otherwise, strings are 
compared ignoring the case. 
Whole word -- the search is made to find the exact full text, all characters are accounted 
for, otherwise, the search is made to find the occurrence of the search string inside any 
text. 
Only in visible view -- if this option is checked, the search is limited to the visible part of the 
Image inside the Window. 
Other Advanced Search Options 
Goto object -- if this option is checked the application will automatically navigate to the 
found object to bring it into the middle of the current Window; the scale will not be changed. 
Always Goto object -- checking this option causes the application to navigate to the found 
Smart Search -- checking this option will cause the search to be performed in a 
geometrical way. The Image is searched from ‘left to right’ in strips of the same size of the 
current open view. In many cases such search is more ‘intuitive’ especially if the Image is 
divided to zones with a corresponding layout. 
If this option is not checked the search is simple, meaning that the search is by the order of 
objects in the Image, from the first object created to the last one.  
Notification Message 
If a search fails a notification message is displayed with the searched string. 

 
 

 
 

   

 
 
 

 
 

Aligning Objects 
The Align option is used to align objects with other objects or to resize objects.  

o To align objects: 
Select Align in the Image Edit menu or activate the Align toolbox by checking Align in the 
View menu. This menu has the following options: 
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  Align objects by their left edges. 

  Align objects by their right edges. 

  Align objects by their centers (vertically). 

  Align objects by their middles (horizontally). 

  Align objects both horizontally and vertically. 

  Align objects by their tops. 

  Align objects by their bottoms. 

  
One or more objects can be resized to the same 
width.  

  
One or more objects can be resized to the same 
height. 

  
One or more objects can be resized to both 
same height and width. 

  
Objects can be arranged (distributed) so they 
are equal distances from each other 
horizontally.  

  
Objects can be arranged (distributed) so they 
are equal distances from each other vertically. 

Note:     The Align feature does not support the Undo option. 
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Edit / Align 
Select the Align option to display a sub-menu where you can choose how to align an object 
with another object(s).  
In addition, the Align sub-menu enables you to resize objects horizontally, vertically or 
both. 
You can also align objects by using the Align toolbar. 
The Align options are as follows: 
Left Aligns objects by their left edges. 
Right Aligns objects by their right edges. 
Top Aligns objects by their tops. 
Bottom Aligns objects by their bottoms. 
Center Horiz. Aligns objects by their middles horizontally. 
Center Vert. Aligns objects by their centers vertically. 
Center Both Aligns object both horizontally and vertically. 
Resize Horiz. Selected objects can be resized to the same width. 
Resize Vert. Selected objects can be resized to the same height. 
Resize Both Selected objects can be resized both to the same width and height. 
Even Spacing Horiz. Spaces between selected objects lined horizontally will be equal. 
Even Spacing Vert. Spaces between selected objects lined vertically will be equal. 

Note: The Align feature does not support the Undo option. 
 
 

 
 

   

 
 
 

 
 

Select Options 
There are three Select Options: 

o    Select 
o    Deselect Last  
o    Deselect All 

1.   To select several objects simultaneously using the left mouse draw a rectangle around 
the relevant objects.  
2.   To add a new object to already selected objects press the <Shift> key and click a new 
object. 
3.   Deselect objects by clicking on an empty part of the image area or select 
Select/Deselect Last/All.  
4.   Deselect the last selected object by pointing to Select in the Edit menu and selecting 
Deselect Last.  
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Note:    Right-clicking sets the object automatically to select mode and cancels the move 
operation. 

 
 

 
 

   

 
 

 
 
 

Drawing Options 
The Drawings toolbox options are used to design image objects. Line, Pipe, Box, Text and 
Circle. 
Both filled and unfilled objects can be selected. The selection and text tool are also 
included in this toolbox. 

  Filled/empty rectangle or square  

  Filled/empty rounded-corner rectangle or square 

  Filled/empty circle 

  Filled/empty ellipse 

  Filled/empty arc 

  Filled/empty orthogonal polygon 

  Filled/empty polygon 

  Filled/empty orthogonal pipe 

  Filled/empty pipe 
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  Arc 

  Orthogonal polyline 

  Polyline 

  Text 

  Picture 

  Button 

   ActiveX 

 
 
 

 
 

   

 
 

 
 
 

The Image Drawing Tools 
The Drawings toolbar is used to draw objects in an image. 
The application includes all the tools you need to create your own graphic objects. These 
tools are found in the Drawings toolbox and include the tools listed below. If you want to 
edit any of these shapes, you can use the Edit Operations Toolbar. 
 
Select toolHLP_WZ2EDT_SELECT_TOOL  
Filled Rectangle or Square  
Unfilled Rectangle or Square  
Filled Rectangle or SquareFilled_Rectangle_or_Square  
Unfilled Round-cornered Rectangle or 
SquareUnfilled_round_cornered_rectangle_or_square_tool  
Filled Circle Tool  
Unfilled CircleHLP_WZ2EDT_CIRCLE  
Filled Ellipse Tool  
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Unfilled Ellipse 
Filled Closed Arc Filled_Closed_Arc_tool 
Unfilled Closed Arc Unfilled_Closed_Arc_Tool 
Filled Orthogonal Polygon 
Unfilled OrthogonalPolygonUnfilled_orthogonal_polygon_tool 
Filled PolygonFilled_polygon_tool 
Unfilled PolygonUnfilled_polygon_tool  
Orthogonal Pipe 
PipePipe_tool 
Arc Arc_tool 
Orthogonal Polyline Orthogonal_polyline_tool 
PolylineHLP_WZ2EDT_POLYLINE  
TextHLP_DLG_WZ2_TEXT  
ButtonHLP_WZ2EDT_BUTTON_PROP  
Insert Picture  
To select a drawing tool 
1. Click in the Drawings toolbar. 
2. Click the tool you want to draw with. 

 
 

 
 

   

 
 

 
 
 

The Drawings toolbar 
The Drawings toolbar contains simple drawing objects such as Line, Pipe, Box, Text, and 
Circle. Both filled and unfilled objects can be selected. The selection, text tool and button 
are also included in this toolbar. 

 
 

 
 

   

 
 
 

 
 

Drawing Lines and Segmented Shapes  
This section describes how to draw with the following group of tools: 

o To draw: 
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1.   In the Drawings toolbox, click the appropriate shape.  
2.   Click the left button on the start point. 
3.   Click the left button on successive end points. 
4.   Click the right button and the last point will automatically be connected to the start 
point, closing the polygon. 
5.   Right-click in the Image to deselect the tool. 
If you click the right button before starting to draw, the Select tool will be activated. 

 
 

 
 

   

 
 

 
 
 

Drawing Rectangles and Ellipses  
o To draw: 

1.   In the Drawings toolbox, click the appropriate shape. 
2.   Position the mouse pointer where you want to start drawing. 
3.   Drag diagonally. 
4.   Release the mouse button. 
5.   Right-click in the Image to deselect the tool. 
If you click the right button before starting to draw the select tool will be activated. 

 
 

 

 
   
 
 
 
 

Drawing Arcs  
Note:    The angle of an arc or closed arc may be affected if the arc is scaled. 

o To draw an arc: 
1.   In the Drawings toolbox, click on the appropriate tool. 
2.   Position the mouse pointer where you want to start drawing, drag to the end point and 
then release the mouse button. 
3.   Move the mouse to the desired radius point and left-click the mouse button. 
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4.   Right-click in the Image to deselect the tool. 
 
 

 
 

   
 
 
 
 

Drawing Pipes 
Note:    The width of the pipe can be controlled using the plus (+) and minus (-) keys at any 
stage during the drawing process. 

o To draw a pipe: 
1.   From the Drawings toolbox, click on the appropriate pipe tool. 
2.   Click the left mouse button on the start point. 
3.   Click the left mouse button on successive end points. 
4.   Right-click when the shape is complete. 
5.   Right-click in the Image to deselect the tool. 

 
 

 
 

   

Drawing Options 

 
 
 
 
 

Animated Gifs 

Presentation 
  This new feature consists in supporting animated gifs in image, like any other object.  
   

Access means 
  The interface to load a gif picture is the same as the one used to load a bmp or a jpeg 
picture.  
   

Description 
  Each animated gif contains its own delay between the display of two frames. 
However for performance reason in the image we have only one timer called 
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periodically which displays the good frame of each animated gif contained in the 
image regarding the ellapsed time. By default this timer updates the pictures ten times 
per second. This delay can be changed by adding the following parameter in 
WIZTUNE.DAT: IMG_ANIMTHREAD_DELAY = xxxx where xxxx is the time 
between two updates in millisecond.  
   

Note 1: When the loaded gif contains a lot of frames or/and big pictures, the memory used 
increases and could become very high.  

   
Note 2: Animated GIF are supported in Web Image. 
 

 
 

 
 

   

 
 

 
 
 

Edit / Drawings  
The Drawings sub-menu enables you to draw and add text in your Image by using the 
Polyline, Box, Circle , Pipe, Text and Pick color tools. 
The Drawings sub-menu also includes the Widget option. The Widget option holds the 
Slider, Media Player and Scheduler options. The Drawings Menu also includes the 
Button to enable the application to contain a trigger object that has the same look and feel 
as a Windows button 
See also the Drawing toolbar 

 
 

 
 

   

 
 
 

 
 

Drawing in the Image    
You can design, draw or modify your application by selecting the appropriate tools in the 
Image. The Drawings toolbar contains simple drawing objects such as Line, Pipe, Box, 
Text and Circle. You can draw both filled and unfilled objects. You can also assign text to 
your image by using the text tool. 
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Drawing shapes 
1. From the Shape tools select a drawing tool. 
2. In the Image area press and hold down the left mouse button. 
3. Start drawing by moving the mouse around, the shape outline you selected is being 
drawn as you move. 
4. Finish drawing by releasing the mouse. 
Notes: 

1. After drawing you remain in the selected tool; note that the object is not selected.  
2. To change colors of selected object select new color in the color toolbar. 
3. Clicking the right mouse button sets the object automatically to select mode and 

cancels the continuity of the last operation. 
4. Double-click on Object toolbar as Trigger, Alarm, Slider, Media or, Dynamic open 

its definition dialog. 
Object Selection/Deselection 
Choose the Selection Tool to select any object (for size or move operations). 

1. To select several objects, start from an empty point in the Image, press and hold 
left mouse button, drag a rectangle around the objects you wish to select. 

2. You add an object to existing selection by left-clicking the mouse while holding 
down the Shift key. 

3. Deselect objects by pressing left mouse button on empty space of Image. 
4. To deselect last used menu item Edit Select Deselect last. 
5. Clicking the right mouse button sets the object automatically to select mode and 

cancels the move operation. 
Aligning Objects 
Whenever you select more than one object, one of the selected objects is marked with 8 
hollow handles. These handles cannot be used to move or resize the object, their sole 
purpose is to mark the object. 
The marked object is the first object selected. Whenever you use an alignment tool (any of 
the 10 alignment tools), all objects are aligned or resized according to the position or size 
of the marked object. 
To make another object the marked or first object 
1. Deselect all (through the menu or by clicking an empty spot) 
2. Select the desired object, by clicking it.  
3. Add the other objects to the selection by holding the shift key pressed while selecting. 
This works with both single select (click) and multi-select (drag). 
Moving/Scaling 

1. Scale by selection of object and handles 
2. To move an object press left mouse button down on object and drag 
3. To copy object move/scale it with Ctrl key pressed. 

Object Sensitive Menus 
1. Press the right mouse button on any object in the Image. The object is selected 

and a pop up menu appears. 
2. For general Image menu click in empty space in the Image. The pop up menu 

deselects previously selected objects. 
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The Image Drawing Tools 
The Drawings toolbar is used to draw objects in an image. 
The application includes all the tools you need to create your own graphic objects. These 
tools are found in the Drawings toolbox and include the tools listed below. If you want to 
edit any of these shapes, you can use the Edit Operations Toolbar. 
 
Select toolHLP_WZ2EDT_SELECT_TOOL  
Filled Rectangle or Square  
Unfilled Rectangle or Square  
Filled Rectangle or SquareFilled_Rectangle_or_Square  
Unfilled Round-cornered Rectangle or 
SquareUnfilled_round_cornered_rectangle_or_square_tool  
Filled Circle Tool  
Unfilled CircleHLP_WZ2EDT_CIRCLE  
Filled Ellipse Tool  
Unfilled Ellipse 
Filled Closed Arc Filled_Closed_Arc_tool 
Unfilled Closed Arc Unfilled_Closed_Arc_Tool 
Filled Orthogonal Polygon 
Unfilled OrthogonalPolygonUnfilled_orthogonal_polygon_tool 
Filled PolygonFilled_polygon_tool 
Unfilled PolygonUnfilled_polygon_tool  
Orthogonal Pipe 
PipePipe_tool 
Arc Arc_tool 
Orthogonal Polyline Orthogonal_polyline_tool 
PolylineHLP_WZ2EDT_POLYLINE  
TextHLP_DLG_WZ2_TEXT  
ButtonHLP_WZ2EDT_BUTTON_PROP  
Insert Picture  
To select a drawing tool 
1. Click in the Drawings toolbar. 
2. Click the tool you want to draw with. 

 
 

 
 

   

 
 
 

 
 

Arc Tool    



Chapter 21 Image Editor 

764 

To draw an arc 
1. From the Drawings toolbar, click on the arc tool. 
2. Position the mouse pointer where you want to start drawing. 
3. Drag to end point. 
4. Release mouse button. 
5. Move the mouse to the desired radius point and left-click the mouse button. 
Note: Arcs are not supported on the Web. 

 
 

 
 

   

 
 

 
 
 

Filled Closed Arc Tool   
To draw a filled closed arc 
1. From the Drawings toolbar, click on the filled closed arc tool  
2. Position the mouse pointer where you want to start drawing. 
3. Drag to end point. 
4. Release mouse button. 
5. Move the mouse to the desired radius point and left-click the mouse button. 

 
 

 
 

   

 
 
 

 
 

Filled Ellipse Tool   
To draw a filled ellipse 
1. From the Drawings toolbar, click on the ellipse tool.  
2. Position the mouse pointer where you want to start drawing. 
3. Drag to form the ellipse. 
4. Release mouse button. 
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Filled Orthogonal Polygon Tool   
To draw a filled orthogonal polygon 
1. From the Drawing Toolbar, click on the closed filled orthogonal polygon tool  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right button and the last point will automatically be connected to the start point, 
closing the polygon. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 

 
 

 
 

   

 
 
 

 
 

Filled Polygon Tool    
To draw a filled polygon 
1. From the Drawings toolbar, click on the filled polygon tool.  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right button and the last point will automatically be connected to the start point, 
closing the polygon. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
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points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 

 
 

 
 

   

 
 

 
 
 

Filled Rectangle or Square    
To draw a filled rectangle or square 
1. From the Drawings toolbar, click the filled rectangle tool.  
2. Position the mouse pointer where you want to start drawing. 
3. Drag diagonally. 
4. Release mouse button. 

 
 

 
 

   

 
 
 

 
 

Filled Round-cornered Rectangle or Square Tool   
To draw a filled round-cornered rectangle or square 
1. From the Drawings toolbar, click the round filled round-cornered rectangle tool.  
2. Position the mouse pointer where you want to start drawing. 
3. Drag diagonally. 
4. Release mouse button. 
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Orthogonal Pipe 
Orthogonal pipes are connected rectangular segments in orthogonal directions. 
(vertical, horizontal, and at 45 degrees). 

 
 

 
 

   

 
 

 
 
 

Orthogonal Pipe Tool   
To draw an orthogonal pipe 
1. From the Drawings toolbar, click on the orthogonal pipe tool. 
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right mouse button to complete the operation. 

 
 

 
 

   

 
 
 

 
 

Orthogonal Polyline Tool   
To draw an orthogonal Polyline 
1. From the Drawings toolbar, click on the orthogonal polyline tool  
2. Click the left mouse button on the start point. 
3. To connect lines, click the left mouse button on successive end points. 
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4. Click the right mouse button to complete the operation. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 

 
 

 
 

   

 
 

 
 
 

Pipe Tool 
To draw a pipe 
1. From the Drawings toolbar, click on the pipe tool  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right mouse button to complete the operation. 

 
 

 
 

   

 
 
 

 
 

Polyline Tool    
To draw a Polyline 
1. From the Drawings toolbar, click on the Polyline tool  
2. Click the left mouse button on the start point. 
3. To connect lines, click the left mouse button on successive end points. 
4. Click the right mouse button to complete the operation. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
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points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 

 
 

 
 

   

 
 

 
 
 

Unfilled Closed Arc Tool    
To draw an unfilled closed arc 
1. From the Drawing Toolbar, click on the unfilled closed arc . 
2. Position the mouse pointer where you want to start drawing. 
3. Drag to end point. 
4. Release mouse button.  
5. Move the mouse to the desired radius point and left-click the mouse button. 

 
 

 
 

   

 
 
 

 
 

Unfilled Ellipse Tool   
• To draw an unfilled ellipse 

1. From the Drawings toolbar, click on the unfilled ellipse tool  
2. Position the mouse pointer where you want to start drawing. 
3. Drag to form the ellipse. 
4. Release mouse button. 
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Unfilled Orthogonal Polygon Tool   
• To draw an unfilled orthogonal polygon 

1. From the Drawings toolbar, click on the unfilled closed orthogonal polygon tool  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right button and the last point will automatically be connected to the start point, 
closing the polygon. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 

 
 

 
 

   

 
 
 

 
 

Unfilled Polygon Tool   
• To draw an unfilled polygon 

1. From the drawings toolbar, click on the unfilled polygon tool  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right button and the last point will automatically be connected to the start point, 
closing the polygon. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 
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Unfilled Rectangle or Square Tool  
To draw an unfilled rectangle or square 
1. From the Drawing toolbar, click the filled rectangle tool. 
2. Position the mouse pointer where you want to start drawing. 
3. Drag diagonally. 
4. Release mouse button. 

 
 

 
 

   

 
 
 

 
 

Unfilled Round-cornered Rectangle or Square Tool    
• To draw a round cornered unfilled rectangle or square 

1. From the Drawings toolbar, click the round cornered rectangle tool  
2. Position the mouse pointer where you want to start drawing. 
3. Drag diagonally. 
4. Release mouse button. 

 
 

 
 

   

 
 
 

 
 

Text 
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This section describes how to insert text into an image: 
o To use the text tool: 

1.   From the Drawings toolbox, click on the text tool. 

  
2.   Enter text in the Text dialog box. Click OK. The text will appear at the specified location 
on the screen. 
The other Text Types field is used for the dynamic display of tag values. When the text is 
entered and confirmed, it will appear at the specified location on the screen. 

 
 

 
 

   

 
 
 

 
 

Text Tool 
The Text Dialog Box is used to specify a plain string or numerical value that will be 
displayed whenever a specific tag value occurs.  
To use the text tool 
1. From the Drawings toolbar, click on the Text tool. The Text dialog box is displayed.   
2. Type your text in the Text box. 
3. Click one of the following buttons for further Text definitions: 
 Tag Value - click to define the attributes for the digital text object. 
 Text Table - click to define a plain string or numerical value that will be displayed 
whenever a specific tag value occurs.  
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Font Style Selection 
In the application any text object, simple, tag value or text table, can have its own font 
style. The Font bar reflects the font style that is going to be used for the next text object. It 
also reflects the font style of the current selected, single, text object. Changing the font 
style while a single text object is selected will change that object's style. Predefined text 
styles can be used for easy uniform texts as labels, titles and so on. 
It is possible to set a style to text and then change only part of the style properties. If a 
style is changed, all texts with that style are changed in any property that was not modified 
for that text. The text object colors are selected and set as any other object. 

o To define font styles: 
1.   From the Options menu, select Styles Definition. The Styles Definition dialog box is 
displayed: 

  
2.   Click the Add button to open the Style Properties dialog box. 
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3.   Specify the required font style from the following options and click OK to save your 
definitions and close the dialog box. 

Style 
name  

Selected from list. Reflects the font style that is going to be used for Text 
objects. Predefined text styles can be used for easy uniform texts as labels, titles 
and so on. 

Font 
Face 
Name    

Can be bitmap or TrueType - selected for available fonts (system dependent). 
List of available system fonts. 

Font 
size  

For bitmap fonts you can select from sizes available for that face name. If 
another value is entered, the Image will use the best fit. In TrueType fonts size 
14 is translated as 1,000 word units on scale of 64. 

Effects 
Select from the following options: Bold: (font dependable), Italic, Underline and 
Strikethrough. 
Note that Underline and Strikethrough are not applicable on the Web. 

Sample 
Text 

Type any text to obtain an example of the way the text will appear in the Image. 
The text example that you type appears in the example box below this field. 

You can activate the Properties button in the Font Styles Definition dialog box to reopen 
the Font Properties dialog box where you can change your font definitions. 
It is important to note that when using bitmap fonts, since these fonts cannot be scaled or 
rotated, changing the zoom does not change the size of the font. It is recommended to 
place bitmap text in layers using only one scale level. 
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Modifying Text 
Text in an image can be edited by selecting the relevant text and then activating the Text 
tool in the Drawing toolbox. 

o To modify text: 
1.   Select text and click the Text button. The Modify Text dialog box is displayed: 

     
2.   The text you selected to edit will appear in the Text field.  
3.   Change the text and activate the OK button to cause the new text to replace the old 
text.  
For tag value, text table, or date/time text, the appropriate dialog is displayed in which you 
can change the text attributes.  

 
 

 
 

   
 
 
 
 

Modifying Text   
Use this dialog box to modify a text object. 
To modify a text object 
1. Select the text object you want to modify. 
2. Click the mouse right button and select Change Text from the popup menu displayed. 
 The Modify Text dialog box is displayed. 
 OR 
 Double click the selected object 
3. Modify your text as applicable and click OK. 
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Specifying Line Properties  
An image can be drawn using different types of lines. The following line widths are 
supported: 1, 2, 4, 6, 8 and 10 pixels. 

o To specify the line width/type: 
1.   Select the line you want to modify. 
2.   Select the Line type button in the Image toolbar, or select Line Type from the Edit 
menu to open the Lines dropdown list. 

 
3.   Select a line type the original line will change to the selected line. 

 
 

 
 

   
 
 
 
 

Colors 
This application has full color support that is limited only by your computer's operating 
system and hardware. 
Double-clicking on any color in the Color toolbox opens a common color dialog box where 
colors can be selected to customize your toolbox.  
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Edit / Get Colors and Save Colors    
The application enables you to get colors, i.e., import a color palette, or save colors, which 
means saving the colors you defined in your image file. 
The *. pal file contains the 16 toolbox colors as well as the additional 16 custom colors 
from the color dialog box. Once you define or customize your colors you can save them in 
a *.pal file. To retrieve or get the colors you have saved, use the Get Colors option. 
To retrieve colors from a saved color palette 
Select Get Colors from the Edit menu. The Open dialog box opens, where you can select 
the colors from a *.pal file. 
To save a color palette 
Select Save Colors from the Edit menu. The Save As dialog box opens, where you can 
save your colors to a *.pal file. 

Note: If the image file name and *.pal file name are the same, the *.pal 
file is loaded automatically. The user can continue to work with his 
customized palette every time he opens an image. 

 
 

 
 

   

 
 
 

 
 

Setting the Image Background Color 
The Set Image Background feature enables you to set the image background color.  

o To set the background  From the Edit menu select Set Background Color. The Color 
dialog box opens.  
2.   Select a color and click OK. The background of your image will display the 
selected color. 
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Edit / Set Background Color   
The Set Image Background feature enables you to set the image background color. 
To set the Background color 
1. Go to Image menu, select the Edit Option and there the Set Background color. 
2. Select a color, press OK and the background of your image will display the color you 
chose.  
OR 
Press the Set Background Color Icon from the Image main menu. 

 
 

 
 

   

 
 

 
 
 

Saving and Getting Colors  
The *. pal file contains the 16 toolbox colors as well as the additional 16 custom colors 
from the Color dialog box. Once you define or customize your colors, you can save them in 
a *.pal file.  

o To get saved colors: 
From the Edit menu select Get/Save Color. The Color dialog box opens. The Color dialog 
box is displayed where you can select the colors from a *.pal file. 
If the Image file name and *.pal file name are the same, the *.pal file is loaded 
automatically. You can then continue to work with the customized palette every time you 
open an Image. 
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Pick Color Tool 
Select the Pick Color tool in the Operations toolbox for filling or drawing objects with the 
exact color used in a different object. 
The Pick Color tool enables you to take a color sample from an area of an image to 
designate a new line color or fill color.  

o    To select the line or fill color using the Pick Color tool: 
1.   Select the drawing tool of your choice. 
2.   Select the Pick Color tool, and then place the dropper icon on any point in the image 
over the desired color. 
3.   Draw your new object and the object fills with the selected color. 
4.   To select a new line color, in the Color toolbox, click the required color. The toolbox 
resets to the last drawing tool that was used, and the color becomes the default color for 
that drawing tool. 
5.   To select a new fill color, in the Color toolbox, right click the required color. The toolbox 
resets to the last drawing tool that was used, and the color becomes the default color for 
that drawing tool. 

 
 

 
 

   
 
 
 
 

Pick Color Tool 
Click on the Pick Color tool in the Operations Toolbar for filling or drawing objects with the 
exact color used in a different object. 
The Pick Color Tool lets you sample colors from an area of an image to designate a new 
line color or fill color.  
To select the line or fill color using the Pick Color tool 
1. Select the drawing tool. 
2. Select the Pick Color tool, then place the dropper icon on any point in the image over the 
desired color. 
3. Draw your new object and the object fills with the selected color. 
Or  
1. To select a new line color from the Color Toolbar, left click the mouse button on the color 
you want. 
2. To select a new fill color from the Color Toolbar, right click the mouse button on the color 
you want. 
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View Menu 

 
 
 
 
 

View Menu 
The View menu activates/deactivates the Image module's toolbar, status bar and unique 
toolboxes. To activate/deactivate an option click the specific menu item in the View menu. 

Toolbar Defines that the toolbar is activate in the Image window. 

Font bar    Defines that the font bar is activate in the Image window. 

Status 
bar    Defines that the status bar is activate in the Image window. 

Objects Defines that the Objects toolbox is activate in the Image window. 

Operations Defines that the Operations toolbox is activate in the Image window. 

Drawing 
Defines that the Drawing toolbox is activate in the Image window. The 
drawing tools enable the user to draw and edit images. Also included is the 
Widget option and a trigger button. 

Patterns    Defines that the Patterns toolbar is activate in the Image window. 

Align Defines that the Align toolbox is activate in the Image window. 

Colors Defines that the Colors toolbox is activate in the Image window. 
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Toolbar 
The Image toolbar contains the following icons and commands icons: 
 

    Save 

    Print 

    Copy 

    
Paste 
 

  Undo/Redo 

    Goto 

    Goto Zone 

    Define Zone 

    
Edit Zone 
 

    Navigate Zone 

    Trigger On 

    Mark Triggers 

    Force Dynamic Show 

    Grid Setup 



Chapter 21 Image Editor 

782 

    Set Background Color 

    Repaint 

    Line Type 

 
 
 

 
 

 
 

   

 
 

 
 
 

The Toolbar 
This toolbar is located under the Image menu and includes shortcuts to menu items such 
as Save, Print, Navigate mode, Goto Zone, Grid setup and Mark triggers. 
 

 
 

 
 

   

 
 
 

 
 

The Image Toolbars 
The image window contains many toolbars that enable you to easily draw and animate 
your application.  
To show a toolbar 
From the View menu, click the toolbar you want to view. A check mark to the left of the 
toolbar name indicates that this toolbar is already opened. 
For more information on each toolbar, click the respective topic: 
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The Fonts toolbarThe_Fonts_Toolbar  
The Align toolbarHLP_WZ2EDT_VIEW_ALIGN  
The Drawing toolbarHLP_WZ2EDT_VIEW_DRAWING  
The Objects toolbarHLP_WZ2EDT_VIEW_OBJECTS  
The Operations toolbarHLP_WZ2EDT_VIEW_OPERATIONS  
The Patterns toolbarHLP_WZ2EDT_VIEW_PATTERN  
The Color toolbarHLP_WZ2EDT_VIEW_COLOR  
The StatusHLP_WZ2EDT_VIEW_STATUSBAR  

 
 

 
 

   

 
 

 
 
 

Font Bar 
The Font bar enables you to set the text font style for any text object, simple, digital or text 
table. This toolbar includes the font name, size, direction and different text effects. The text 
can be bold, italic, underscored or strikethrough. 

  
 
 

 

 
   
 
 
 
 

Status bar 
The Image module Status bar displays the coordination scale and layer of the image 
object. 
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The Status bar 
The Status Bar appears at the bottom of the Image Window. The Status Bar displays 
information about images, features, and procedures. 

 
 

 
 

   

 
 

 
 
 

Objects Toolbox 

  Alarm Definition 

  Trigger Definition 

  Dynamic Definition 

  Cluster Definition 

  Group 

  Slider 

  Media Player 

  Scheduler 
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The Objects toolbar 
The Objects toolbar allows you to define Image objects such as Alarm, Trigger, Dynamic, 
Cluster Definition, Group, Slider, Media and Scheduler 

 
 

 
 

   

 
 
 

 
 

The Objects toolbar 
The Objects toolbar allows you to define Image objects such as Alarm, Trigger, Dynamic, 
Cluster Definition, Group, Slider, Media and Scheduler 

 
 

 
 

   

 
 

 
 
 

Operations Toolbox  
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  Rotate 

  Pick color 

  Active layer 

  Toggle fill 

  Cluster library 

  Send to back 

  Bring to front 

  Delete 

  Grid 

  Snap to grid 

  Copy attributes 

 
 
 

 
 

   

 
 

 
 
 

The Operations toolbar 
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The Operations toolbar includes Rotate, Pick color, Active Layer, Toggle Fill, Cluster 
library, Bring to Back, Bring to Front, Delete, Grids, Snap to Grids and Copy Attributes. 

 
 

 
 

   

 
 

 
 
 

Patterns Toolbox 
The Patterns toolbox contains 16 different fill patterns, including solid and transparent. The 
Image drawing patterns also support 32 gradient styles. The first color used for the 
gradient is the foreground color, while the last color used is the background color.  
Gradient fills are supported for the following objects: Text, Filled box/circle, Polygon. 
 

 
 
Note:     Pipes do not support Gradient fills. 
 

 
 

 
 

   

 
 
 

 
 

The Patterns and Gradient Toolbar 
Note: Patterns and Gradient fills are not supported on the Web. 
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The Patterns toolbar contains 16 different fill patterns, including solid and transparent. The 
Image drawing patterns also support 32 gradient styles. The first color used for the 
gradient is the foreground color, while the last color used is the background color.  
Gradient fills are supported for the following objects: Text, Filled Box - Circle, and Polygon. 
Pipes do not support Gradient fills. 

Notes 

1. Gradients are not fully supported on Windows 98. Circles, 
ellipses and rounded rectangles will be drawn as rectangles. 

2. In the ILS file the gradient pattern numbers run between 100 to 
131 ordered by the above list.  

3. Bitmap fonts are not effected by the Gradient. 

4. After changing attributes of gradient objects, or moving from 
select mode, image may need refresh. 

5.  Performance may suffer when drawing large gradient surfaces 
with many steps. It is advisable that only static (background) 
object will be using the  Gradient. Dynamic over Gradient is 
possible but performance may suffer. It is also advised to do 
development in low number of steps and later increase steps for 
run-time. 

6. To set the gradient steps use Image Properties View or in the 
Wiztune.dat file, manually set the tuning parameter 
IMG_GRAD_STEP= n). Valid values are between 2 to 255 – 
Default is 16. Re-enter Image. 

7. Transparent color will have 'unknown' effect over fill. 

8. The gradient is not affected from rotation or transformation. It is 
possible to rotate objects with Gradient but the Gradient 
orientation will not be rotated 

9. Not supported on Web. Note that if patterns are used and then 
brought to the Web, the patterns turn to solid colors. 

10. The gradient for a group works like for a pattern.  

11. It is not possible to select Gradient fill type in Dynamic definition 
Fill Type range. 

12. The gradient’s center reference point for filled polygons, 
orthogonal polygons, and filled arcs is always calculated by the 
visible parts of the objects. Therefore, when you scroll and the 
object partially disappears from view, you will notice that the 
object’s center point moves upwards away from the center. 
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Align Toolbox 
The Align toolbox enables you to align two or more selected objects. They can be aligned 
to the left, right, top, or bottom. Objects can also be centered or resized horizontally, 
vertically or both. The objects can also be arranged so they are equal distances from each 
other, either vertically or horizontally.  See Aligning Objects.  
 

 
 

 
 

   

 
 
 

 
 

The Align toolbar 
The Align toolbar enables you to align two or more selected objects. They can be aligned 
to the Left, Right, Top, or Bottom. The objects can also be centered or resized Horizontally, 
Vertically or both. 

 
 

 
 

   

 
 

 
 
 

The Align toolbar 
The Align toolbar enables you to align two or more selected objects. They can be aligned 
to the Left, Right, Top, or Bottom. The objects can also be centered or resized Horizontally, 
Vertically or both. 
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Color Toolbox 
The Color toolbox includes 32 colors for background and foreground (text). A left mouse 
click selects the line color while a right mouse click selects the fill color. 
Double-clicking either mouse button opens the Color dialog box, enabling you to customize 
any color. 

 
 

 

 
   
 
 
 
 

The Colors toolbar 
The Color toolbar includes 32 colors for background and foreground color of objects. Left 
click selects the foreground or the color while right click selects the background, or fill 
color. 
Double-clicking either mouse button opens the color palette dialog, enabling you to 
customize any color. 

 
 

 
 

   

 
 
 

 
 

Additional Drawing Tips 
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Moving and Scaling Objects 
When an object is selected, eight handles will appear around the object to indicate that it is 
selected. 

o To move an object or group of objects in the Image: 
1.   Select the object(s) you want to move. 
2.   Click inside the object (or bounded rectangle for a group of objects) hold the mouse 
button down and drag the object(s) to the desired location. 

o To scale an object or group of objects in the Image: 
1.   Select the object(s) you want to scale. 
2.   Click on one of the eight handles of the object (or bounded rectangle, for a group of 
objects) hold the mouse button down and drag the handle to resize the object(s). 

o To resize the object(s) proportionally: 
Click and drag any corner handle in a diagonal direction, as in the following illustration: 
Note:    To terminate a move or scale operation, press the <Esc> key. 

 
 

 

 
   
 
 
 
 

Grouped Objects 
Grouping objects combines two or more objects into a single object. You can flip, rotate, 
and resize or scale all the objects in a group as a single unit. You can also change the 
attributes of all objects in a group at one time. Grouped objects can be edited the same 
way as any other object, but cannot be nested (a group cannot include another group). A 
grouped object can also be ungrouped to separate its original elements. 
Note:    Any object in a segment which is defined as a trigger object, will function in the 
Trigger mode in the same way as when it is not included in a segment.  
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Grouping and Ungrouping Objects 
o To group objects: 

1.   Click the select tool and then drag to select the drawing objects you want to group.  
2.   Click the button on the Group tool in the Objects Toolbox or, point to Operations in the 
Edit menu and select Group.  

o To ungroup objects: 
Select the grouped objects. Click the right mouse button on the grouped objects and select 
Ungroup from the popup menu or, point to the Operations in the Edit menu and select 
Ungroup. 

 
 

 

 
   
 
 
 
 

Grouping and Ungrouping   
Grouping objects combines two or more objects so you can work with them as though they 
were a single object. You can flip, rotate, and resize or scale all the objects in a group as a 
single unit. You can also change the attributes of all objects in a group at one time. For 
example, you can change the fill color to all objects in the group in a single step. 
To Group Objects 
1. Click the select tool and then drag to select the drawing objects you want to group.  
2. Click the left mouse button on the Group tool in the Objects Toolbar. 
Or 
Click Operations from the Edit menu, then click on the Group option. 
Or 
By right clicking an object and selecting the Group option. 
To UnGroup Objects 
1. Select the grouped objects. 
2. Click the right mouse button on the grouped objects and select the UnGroup option. 
Or 
Click Operations from the Edit menu, then click on the Ungroup option. 
Or 
By right clicking the grouped object and selecting the Ungroup option from the menu. 
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Lock Objects 
Image objects can be locked and unlocked. A locked object cannot be moved or modified. 

o To lock an image object: 
1.   Select an image object.  
2.   Right click to open a popup menu. Select Lock. 

 
 

 

 
   
 
 
 
 

Bring to Front/Send to Back 
The Bring to Front option enables you to place objects in the front of your Image.  

o To bring objects to the front: 
Select the drawing object you want to bring to the front and click the Bring to Front tool in 
the Operations toolbox. 

o To send objects to back: 
Select the drawing object you want to send to the back and click the Send to Back tool in 
the Operations toolbox or, from the Operations menu click Send to Back. The selected 
drawing object is placed in behind other overlapping objects. 

 
 

 
 

   

View Menu 
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The Fonts Toolbar 
The Fonts toolbar allows you to set the text font style for any text object, simple, digital or 
text table. 
This toolbar includes the font name, size, direction and different text effects. 
The text can be bold, italic, underscored or strike through. 

 
 

 
 

   

 
 

 
 
 

The Operations toolbar 
The Operations toolbar includes Rotate, Pick color, Active Layer, Toggle Fill, Cluster 
library, Bring to Back, Bring to Front, Delete, Grids, Snap to Grids and Copy Attributes. 

 
 

 
 

   

 
 
 

 
 

The Drawings toolbar 
The Drawings toolbar contains simple drawing objects such as Line, Pipe, Box, Text, and 
Circle. Both filled and unfilled objects can be selected. The selection, text tool and button 
are also included in this toolbar. 

 
 

 
 

   

Layers Menu 
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Layers Menu 
An image is structured in layers. Each layer contains a part of the overall image. When the 
drawing is completed the layers can be merged. Each individual image layer can be 
shown/hidden. Layers can be added or changed, but not removed. The layer that always 
exists by default is called the base layer. 
Each image can consist of one layer (the Base layer) or several layers.  
The Layer menu options are as follows: 
 

Elaborate 
on 

If the Elaborating Zoom is On, each layer will be viewed in the scale range 
assigned when the layer is defined. If the Elaborating Zoom is off, each 
layer will always appear (even if scaling ranges were not specified for 
them). 

Active 
Layer 

The active layer definitions sets the parameters for which all subsequent 
editing operations will be performed. 

Definition This option opens the Layers Definition dialog box where the parameters 
for the layer are defined. 

Override 
Show/Hide
    

This option when set to hide indicates that a layer will always be hidden, 
despite the Elaborating Zoom mode setting. Any layer set as hidden is 
marked with a special arrowhead character. Note that if both Hide and 
Show attributes are assigned to a layer, the layer will be hidden. 

Move 
Object to 
Active 
Layer 

This option is used to move a selected object to the layer defined as 
active. 
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The Layers Menu 
Image objects are drawn in layers. Each image can consist of several layers or of one 
layer, the Base layer. Layers can be added, changed and deleted. 
In an image, each individual layer constitutes one part of the overall image. A complete 
image consists of all layers that belong to that image. 
Each layer is assigned a zoom range. Once created, layers can be viewed in one of two 
scaling modes; Elaborating zoom On or Elaborating Zoom Off.  
Each image layer can be assigned its own authorization levels, to enable only specific 
operators to view the layer, and each layer can be made visible or hidden using the 
visibility mode to toggle. 
The Options available in the Layers menu are: 
Elaborate ON - Select this item to toggle the Elaborate Zoom on and off.  
Active Layer - Select this item to designate the active layer for which all subsequent 
editing operations will be performed.  
Definition- Select this item to define a new layer in the image.  
Override Show - Select this item to set a layer so that it will always be visible, despite the 
Elaborating Zoom mode setting.  
Override Hide - Select this item to set a layer so that it will always be hidden, despite the 
Elaborating Zoom mode setting.  
Move Object to Active Layer 
Select the object that you want to move, and then select the Move Object to Active Layer 
menu item. 

 
 

 
 

   

 
 
 

 
 

Elaborate on 
Layers can be viewed in the Elaborating Zoom On or Elaborating Zoom Off mode. If the 
Elaborating Zoom is on, each layer will be viewed in the scale range you assign when you 
define the layer. If the Elaborating Zoom is off, each layer will always appear (even if 
scaling ranges were not specified for them). 

o To toggle the Elaborating Zoom mode on and off  
Select Elaborate On from the Layers menu. 

 
 

 
 

   
 
 
 
 

Layers / Elaborate   
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Select the Layers item to toggle the Elaborate Zoom on and off.  
A checkmark beside the item indicates that the Zoom is On. When the Elaborating Zoom 
made is on, each layer will be viewed according to the scale range specified in the Layer 
Definition operation. 
When the mode is off, layers will always appear (even if the current scale does not fall 
within the layer's scale range). 
To toggle the Elaborating Zoom mode on and off 
Select Elaborate On from the Layers menu. A checkmark beside the item indicates that the 
mode is active. 

 
 

 
 

   

 
 

 
 
 

Active Layer 
The layer that is worked on is referred to as the active layer. The active layer name is 
displayed in the window Title bar together with the Image name and the current scale. 

o To select an active layer  
Select Active Layer from the Layers menu. 

 
 

 

 
   
 
 
 
 

Definition 
This option when selected opens the Layers Definition dialog box where layers can be 
defined or modified. 

o To define a layer 
In the Layers menu select Definition. The Layers Definition dialog box opens. 
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1.   In the Name field type the name of layer. 
2.   In the From Scale field, specify the lower limit of the zoom level range for elaborating 
zoom. 
3.   In the To Scale field, specify the upper limit of zoom level range for elaborating zoom. 
4.   Click the Group button to open the Access Permission Manager dialog box opens, 
where you can assign authorized users and groups for this layer. 
5.   Click the Add button to add your definition to the list of layers. 

o To modify a layer: 
1.   Select the relevant layer. 
2.   Modify the layer using the instructions above.  
3.   Click the Change button for the changes to take effect. 

o To remove a layer 
Select the relevant layer and click the Delete button. 

 
 

 
 

   
 
 
 
 

Layers / Definition  
Select the Layer Definition item to define a new layer in the image.  
Image objects are drawn in layers. Each image can contain several layers or just one layer 
(the Base layer always exists).  
Each layer in an image constitutes one part of the overall image, and each layer is 
assigned its own zoom range.  
Each image can consist of either one layer (the Base layer) or several layers.  
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To define a new layer 
Select Definition from the Layers menu. The Layer Definition dialog box opens. 

 
 

 
 

   

 
 

 
 
 

Override Show/Hide 
You can override the current visibility mode and make a layer visible or hidden. The Layer 
Override Hide or Layer Override Show dialog boxes are basically identical and enable you 
to select a layer from the list and make it visible or hidden.  
When Override Hide is selected the layer will always be hidden, despite the Elaborating 
Zoom mode setting. A layer set to show/hide is marked with an forward pointing 
arrowhead. 
Note:    If both the Hide and Show attributes are assigned to a layer, the layer will be 
hidden. 

o To open the Layer Override Show dialog box: 
From the Layers menu select Override Show/Hide. The Layer Override Show/Hide dialog 
box opens. 

 
1.   Select the layer that you wish to show/hide and then click the Show/Hide button. This 
layer will always be visible/hidden. 
2.   Click the Clear button if you want all layers to revert to default visibility. 
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Layers / Override Show 
Select this item to set a layer so that it will always be visible, despite the Elaborating 
Zoom mode setting. A layer set to be visible (show) is marked with a special arrowhead 
character. 

 
 

 
 

   

 
 
 

 
 

Layers Visibility Mode 
You can override the current visibility mode and make a layer visible or hidden. 
The Layer Override Hide or Layer Override Show dialog boxes enable you to select a layer 
from the list and make it visible or hidden. 
 

o To make a layer visible 
1. From the Layers menu select Override Show. 
2. In the Layer Override Show dialog box select the layer you want to become visible. 
3. Click the Show button to make this layer always visible. 
4. Click the Clear button if you want all layers to revert to default visibility. A layer set to be 
visible (Show) is marked with a special arrowhead character. 
To hide a layer 

1. From the Layers menu select Override Hide. 
2. In the Layer Override Hide dialog box select the layer you want to become hidden. 
3. Click the Hide button to make this layer always hidden. 
4. Click the Clear button if you want all layers to revert to default visibility. A layer set 

to be hidden (Hide) is marked with a special arrowhead character. 
5. To cancel the permanent effect for all the layers, activate the Clear button.  

Notes: 

If both the Hide and Show attributes are assigned to a layer, that layer 
will be hidden. 

Layers are used to enhance the elaborating zoom effect in an image.  
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Layers / Override Hide  
Select the Override Hide item to set a layer so that it will always be hidden, despite the 
Elaborating Zoom mode setting. Any layer set to be hidden is marked with a special 
arrowhead character. 

Note that if both Hide and Show attributes are assigned to a layer, that 
layer will be hidden. 

 
 

 
 

   

 
 
 

 
 

Move Object to Active Layer 
This option is used to move a selected object from a layer to the layer defined as active. 

o To move an object to the active layer: 
Select an object in one layer and then from the Layers menu select Move Objects to Active 
Layer. The object will appear in the Active Layer. 
Note:     You can select an object and then click the right mouse button on the active layer. 
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Move Object to Active Layer Used to move a selected object to the layer defined as 
active. 

• To move an object to the active layer: 
1. Select the object(s) that you want to move. 
2. From the Layers menu select Move Objects to Active Layer. 
You can select an object and then click the right mouse button on the active layer  

 
 

 
 

   

Layers 

 
 
 
 
 

The Layers Menu 
Image objects are drawn in layers. Each image can consist of several layers or of one 
layer, the Base layer. Layers can be added, changed and deleted. 
In an image, each individual layer constitutes one part of the overall image. A complete 
image consists of all layers that belong to that image. 
Each layer is assigned a zoom range. Once created, layers can be viewed in one of two 
scaling modes; Elaborating zoom On or Elaborating Zoom Off.  
Each image layer can be assigned its own authorization levels, to enable only specific 
operators to view the layer, and each layer can be made visible or hidden using the 
visibility mode to toggle. 
The Options available in the Layers menu are: 
Elaborate ON - Select this item to toggle the Elaborate Zoom on and off.  
Active Layer - Select this item to designate the active layer for which all subsequent 
editing operations will be performed.  
Definition- Select this item to define a new layer in the image.  
Override Show - Select this item to set a layer so that it will always be visible, despite the 
Elaborating Zoom mode setting.  
Override Hide - Select this item to set a layer so that it will always be hidden, despite the 
Elaborating Zoom mode setting.  
Move Object to Active Layer 
Select the object that you want to move, and then select the Move Object to Active Layer 
menu item. 
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Layers / Definition  
Select the Layer Definition item to define a new layer in the image.  
Image objects are drawn in layers. Each image can contain several layers or just one layer 
(the Base layer always exists).  
Each layer in an image constitutes one part of the overall image, and each layer is 
assigned its own zoom range.  
Each image can consist of either one layer (the Base layer) or several layers.  
To define a new layer 
Select Definition from the Layers menu. The Layer Definition dialog box opens. 

 
 

 
 

   

 
 
 

 
 

Layers Visibility Mode 
You can override the current visibility mode and make a layer visible or hidden. 
The Layer Override Hide or Layer Override Show dialog boxes enable you to select a layer 
from the list and make it visible or hidden. 
 

o To make a layer visible 
1. From the Layers menu select Override Show. 
2. In the Layer Override Show dialog box select the layer you want to become visible. 
3. Click the Show button to make this layer always visible. 
4. Click the Clear button if you want all layers to revert to default visibility. A layer set to be 
visible (Show) is marked with a special arrowhead character. 
To hide a layer 

1. From the Layers menu select Override Hide. 
2. In the Layer Override Hide dialog box select the layer you want to become hidden. 
3. Click the Hide button to make this layer always hidden. 
4. Click the Clear button if you want all layers to revert to default visibility. A layer set 

to be hidden (Hide) is marked with a special arrowhead character. 
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5. To cancel the permanent effect for all the layers, activate the Clear button.  

Notes: 

If both the Hide and Show attributes are assigned to a layer, that layer 
will be hidden. 

Layers are used to enhance the elaborating zoom effect in an image.  
 

 
 

 
 

   

 
 

 
 
 

Layers / Elaborate   
Select the Layers item to toggle the Elaborate Zoom on and off.  
A checkmark beside the item indicates that the Zoom is On. When the Elaborating Zoom 
made is on, each layer will be viewed according to the scale range specified in the Layer 
Definition operation. 
When the mode is off, layers will always appear (even if the current scale does not fall 
within the layer's scale range). 
To toggle the Elaborating Zoom mode on and off 
Select Elaborate On from the Layers menu. A checkmark beside the item indicates that the 
mode is active. 

 
 

 
 

   

 
 
 

 
 

Layers / Override Hide  
Select the Override Hide item to set a layer so that it will always be hidden, despite the 
Elaborating Zoom mode setting. Any layer set to be hidden is marked with a special 
arrowhead character. 
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Note that if both Hide and Show attributes are assigned to a layer, that 
layer will be hidden. 

 
 

 
 

   

 
 

 
 
 

Move Object to Active Layer 
Used to move a selected object to the layer defined as active. 
• To move an object to the active layer: 

1. Select the object(s) that you want to move. 
2. From the Layers menu select Move Objects to Active Layer. 
You can select an object and then click the right mouse button on the active layer  

 
 

 
 

   

 
 

 
 
 

Layers / Override Show 
Select this item to set a layer so that it will always be visible, despite the Elaborating 
Zoom mode setting. A layer set to be visible (show) is marked with a special arrowhead 
character. 

 
 

 
 

   

Cluster Menu 
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Cluster Menu 
A Cluster is an object-class. Clusters can easily placed in an application and be reused as 
required. Clusters can be small or large. They can be simple, such as circles or pumps, or 
complex, such as a complete sub-application that includes tanks, pumps and valves.  
Once clusters are instantiated in an Image, they can be moved, scaled, rotated, and 
deleted in the same as any other Image object. To cancel a Cluster definition select a 
cluster object in the Image and then select Break from the Clusters menu in the Image. 
Instances cannot be defined as dynamic, as trigger, or as another cluster (no nesting of 
clusters), unless they are broken apart.  
The Clusters menu has the following options: 
 

Define    This option defines clusters and adds them to the Cluster 
Library 

Break    This option cancels a selected cluster object in the image 

Open Lib This option is used to open a library. 

Rebuild 
Instances 

This option enables instances to be built automatically after 
updating the original cluster in the library  

Basket 
maintenance 

A basket is a tool supplying high-level engineering and 
application design. It is used to make a prototype of the 
application before actual implementation and traces the 
progress of the application development. 

Open 
basket    

This option displays the clusters defined in a basket. On 
the right of the cluster, the number of times that the cluster 
has been used and maximum usage permitted are 
displayed. 

 
 
 

 
 

   

 
 



Chapter 21 Image Editor 

807 

 
 
 

Cluster Library 
The Cluster Library uses object-oriented technology to simplify and speed up application 
design and maintenance. A Cluster Library holds a number of clusters.  
There are two steps for working with clusters:  

o    Defining clusters and adding them to libraries. This step requires knowledge of 
all the application components and is usually performed by application designers.  

o    Using existing clusters and placing them in the application. This requires 
minimum knowledge of the application and no programming skills. 

Once a cluster is placed in an application an instance can be created. One cluster can 
have many different instances, each with the specific characteristics defined according to 
the application's needs. The action of creating a separate instance of the object or function 
is called instantiation. A unique editing feature allows you to modify any object and 
simultaneously apply the changes to all application diagrams. For example, to modify 
runtime supervision in a certain pump type, you can redefine the pump cluster in the library 
and then rebuild all instances of the pump to incorporate the changes made to the cluster 
definition. 
The application includes a set of ready-to-use cluster libraries.  
It is recommended to use clusters whenever possible. Working with clusters is much easier 
than working with graphics, tags, and alarms separately. Besides saving time, you can use 
an object that has been already approved for work. 

 
 

 
 

   

 
 
 

 
 

Defining Clusters 
o To define a cluster and add it to a library: 

Select the graphic object in the image that you want to include in the cluster and then 
either:  
From the Clusters menu select Define. 
Or,  
Click the Cluster Definition tool from the Objects toolbox. 
Or,  
Right-click and select Cluster Definition from the popup menu.  
If no tags or alarms are associated with the graphic objects that are selected in the image 
(the object was not defined as a dynamic, trigger, or alarm object), the Define Cluster 
Object dialog box is displayed: 



Chapter 21 Image Editor 

808 

 
 
The following options are available: 

Name    
Specifies the name of the cluster (up to  
15 characters). 

Lib    
Specifies the name of the library in which the cluster will be 
placed. To select from existing libraries, click on the arrow 
to the right of the field. 

Description 
Specifies a brief description of the cluster (up to  
40 characters). 

Add new 
library to the 
Cluster folder 

Check this checkbox, to add the newly created library to 
the global Cluster folder (this will enable other applications 
to use the new library you create). 

Note:     These fields and buttons appear in the dialog box only if the object is defined as a 
dynamic, trigger, or alarm object. 
 

 
 

 
 

   

 
 

 
 
 

Clusters / Define    
This option will enable you to define a cluster. 
Cluster definition is enabled in two modes: 
Simple - If no tags or alarms are associated with the graphic objects that are selected in 
the image (meaning that the object was not defined as a dynamic, trigger, or alarm object). 
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Dynamic - If the object you have selected is associated with tags or alarms (the object was 
defined as a dynamic or trigger object). 
To define a Cluster and add it to a library 
1. Select the graphic objects in the image that you want to include in the cluster. 
2. Select Define from the Clusters menu. The Define Cluster Object dialog box is 
displayed. 
The Clusters Menu  

 
 

 
 

   

 
 

 
 
 

Linked Tags and Alarms 
If the object you selected in the image is associated with tags or alarms (the object was 
defined as a dynamic or trigger object), the Define Cluster Object dialog box is displayed:  

 
This listbox contains a list of tags and alarms associated with the object you selected, and 
the type of the object with which the tags and alarms are associated. 
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The object types, enclosed in brackets (<>), include: 
o     D for dynamic 
o     G for trigger 
o     A for alarm (Not applicable on the Web) 
o     W for widgets (tag value sliders) 
o     T for text table 
o     N for digital, date/time, and string displays 
o     t for dynamic text tables 
o     n for dynamic digital, date/time and string displays  

Note:     To indicate the connection between the selected line in the list box, and the 
corresponding graphical object, there is an arrow in the "Objects View" window (in the right 
hand side of the list box) from the left top corner of the window to the middle of the object. 
For further information see Chapter 9, Tags and Chapter 15, Alarms. 

o To define tags and alarms do the following: 
In the Define Cluster dialog box, click the Tags or Alarms button. A new tag/alarm with the 
modified original tag/alarm definition will be generated during cluster instantiation in the 
image. The Tag Definition dialog box is displayed. Only tags/alarms that are associated 
with the cluster objects will appear in the tags/alarms list and only the Change button is 
enabled.  

 
1.    Click the Change button to open the Tag/Alarm Specification dialog box. 
2.    Complete the fields in this dialog box according to instructions in the Tags and Alarms 
chapters.  
Note:     You can also access this dialog by double-clicking on a line in the list. 
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Clusters and Alarm Filters 
Presentation 

   
Cluster designers are now able to use alarm filters instead of alarm families inside clusters. 
This has the following advantages:  

   
- Selection of different stations and their family names. 
- Use of more parameters (see the alarm filter dialog box in the novaPro Open studio) 
- Use of Alarm templates so that the same cluster will change automatically according to 
the context. 

   
Description 

   
This new feature is divided in 2 parts: the creation and the instantiation of a cluster.  

   

1) Creation 
   

When a cluster is created, alarm selection indicates if an alarm family or an alarm filter was 
set inside the object, as shown in this dialog box:  

  
   

 

We differentiate an alarm 
object defined by an 

alarm family or an alarm 
filter. An alarm family is 
identified in this dialog 

box with an “A” enclosed 
in brackets. For an alarm 
filter a small ‘a’ enclosed 

in brackets is shown: 
<a>.  

 
Moreover a new button 

has been added for filter 
definition (enabled only 
when an alarm filter is 

defined inside the 
cluster). 
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Like for alarm definition, a new dialog box has been created to list all the alarm filters 
defined inside the cluster. Each alarm filter can easily be changed:  

   

  
   

To change a filter definition, we can double-click on a line in the list or select a line and 
click on the Change button.  

  
  
 

 

In this dialog box all the fields 
can be changed. The 

modifications will then be saved 
inside the cluster structure. We 
can also define special tokens 
for the filter name (and only for 

the filter name!).  
 

The special tokens are $ASK or 
$ID (cf user guide to know how 

to use them). 
 

Note: Upon instantiation of a 
cluster (by dragging and 

dropping it from the clusters 
libraries), if a token is set in the 

filter name, a dialog box in which 
we can choose a new or an 
existing filter will be opened.  
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Once the modifications are applied, we can see in our filter definition dialog box the new 
filter name, filter description and filter family.  

   

 
   

2) Instantiation 
   

When we instantiate a cluster containing an alarm filter, there are three possibilities:  
   

- The filter definition didn’t contain any token:  
   

The users have to fill the instance name field. When the cluster is instantiated, the alarm 
filter properties are the ones defined during the cluster creation.  

   
- The filter definition contained a $ASK token:  

   
In this case we will have the following dialog box:  

   

 
   

If the user knows a filter name, he can directly fill the filter name field. Otherwise he can 
click on the “…” button, which will open the following dialog box:  
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In this dialog box the user can create, delete or modify any filter, but only one filter can be 
selected at a time. Upon selection, the filter name appears in the filter name field.  

   
Note: If the user enters a non existing filter in the filter name field, the cluster will not be 
instantiated.  

   
- The filter definition contained a $ID token: We get the same dialog box as for a filter 
containing a $ASK token, except that the user can’t browse for existing filters (a filter can 
not be created or modified). The filter name must be entered in the instance name field.  

   
Access means 

   
We can access this functionality only inside the image module. 
 

 
 

 
 

   

 
 
 

 
 

Clusters and Alarm Families 
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Presentation 
  This feature relies on the ability to browse distant alarm families.  
   

Access means 
  We can select an alarm family (remote or local) in the image (when defining a new 
alarm object or when dropping a cluster which contains a '$ASK' token for the alarm 
family field) and when defining a filter.  
   

Description 
  For performance reason (and to be consistant with tags methods), we display only 
200 alarm family names at the same time in the combobox. So when the user didn’t 
type anything in the combo box we display the 200 first alarm family names. If the 
user enters a family name prefix, the 100 families before and after this prefix are 
displayed.  
   

Note: this new feature offers the advantage to be faster than the previous method. So, 
when an application contains lot of alarm family names, the application is not frozen during 
few seconds.  

   
How to 

  
 

 

- At first select a station. 
 
- Then choose an alarm family name 
available on this station (if no station is 
selected, local alarm family names are 
displayed) . 

 
 
 

 
 

 
 

   

 
 
 

 
 

Special Tokens 
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In the Tag/Alarms Definition dialog box, you can use special tokens to enable customized 
tag creation and identification during object instantiation. These tokens can be used in the 
Tag Name, Address and Description fields to enable customized tag attribute generation. 
'[..]' brackets specify an optional parameter. 
The following tokens can be used: 

 
 

 
 

   

 
 

 
 
 

$ID([from-to]) 
The from-to variable represents characters from the data supplied by the operator during 
instantiation. The following methods can be used for the From-To parameter: 
#-# All the characters within the number range specified will be displayed. For example, if 
the string is ABCDE and 2-4 for From-To is specified, the letters BCD will be displayed. 
# The character located at the number you specify will be displayed. For example, if the 
string is ABCDE, and you specify 3 for From-To, the letter C will be displayed. 
#- All the characters from the number you specify and forward will be displayed. For 
example, if the string is ABCDE, and you specify 3- for From-To, the letters CDE will be 
displayed. 
-# All the characters up to the number you specify will be displayed. For example, if the 
string is ABCDE and you specify -3 for From-To, the letters ABC will be displayed. 
For example, If you specify the tag name ANA$ID(2-3) in the Tag Definition dialog box and 
if the operator instantiates the object for which this tag was defined and enters the instance 
name I02, a tag called ANA02 will be created for that object (the count for 2-3 in I02, is I=1, 
0=2, and 2=3). 
For tag address, if, for example, you want the address constant to be 0000, in the Address 
field of the Tag Definition dialog box, you can choose 0000$ID(2-3). Then if, for example, 
the operator enters A10 in the instance name, the address of the tag generated upon 
instantiation of the object would be 000010. 
The same applies for Description. For example, if you want the constant valve to appear in 
the description followed by the valve number, if you use Valve$ID() (where the empty 
parentheses indicates that all the characters in the operator-supplied name should be 
used). If the operator enters 12 for the instance name while instantiating the object, the 
description of the generated tag will be Valve12. 
Different combinations of the $ID variable can be used to customize generated tag 
attributes upon object instantiation. 
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$ASK("text"[, from-to]) 
For text, specify the text that will appear in the prompt upon instantiation. The from-to 
parameter is optional and can be used in the same way as described in $ID token. 
For example, if you entered $ASK("TAG NAME") in the Tag/Alarm Name field of the 
Tag/Alarms Specifications dialog box and $ASK ("Enter Description") in the Description 
field, when you instantiate the object in the image, the Instance Parameters dialog box 
appears: 
 

 
 
If you enter $ASK("Tag Name",1-4) in the Tag/Alarm Name field of the Tag/Alarm 
Specifications dialog box and $ASK("Enter Description",1-5) in the Description field, when 
you instantiate the object in the image, the Instance Parameters dialog box reappears. 
However, only the first four characters of the tag/alarm name and the first five characters of 
the tag/alarm description specified by the operator are extracted and used. 

o To find an existing tag/alarm: 
1.    Click the find button to open the Find dialog box. 

 
2.    Specify the name prefix of the tag or alarm family that you want to search, and click 
the Find button.  
3.    Select Define each Object when Instantiating to define alarms during cluster 
instantiation in the Image. 
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Open Lib  
This menu option is used to insert an image from an existing Cluster Library into an image. 

o To instantiate a cluster from a library to the application: 
Select Open Lib from the Clusters menu in the Image window.  
 

 
 
Note:     This window is modeless (meaning that you can perform other application or 
operating system functions while this window appears on the screen). In addition, the 
library window can be resized to adjust its height. 
1.    Specify the library from which you want to instantiate a cluster. To open a list of 
existing libraries, click on the arrow to the right of the Library field. Double click on a 
specific cluster to open an information box where the library to which the cluster belongs 
and further information regarding the cluster is listed. 
2.    Select the cluster and instantiate it in the image by right clicking on the object and 
dragging it to the required location in the image.  
3.    After placing a cluster from a library into an image, the application enables you to 
determine parameters that are used to generate the instance characteristics. If the cluster 
is not defined with the Define each Object when Instantiating option, the Instance 
Parameters dialog box opens. Click the Browse button to locate the tag you want to 
associate with the instance parameters. 
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Note:     If the cluster contains $ASK variables, this dialog includes the $ASK Parameter 
field in which you can specify additional user data. 

o To determine parameters: 
1.    Enter a unique instance name in the Instance name field. 
2.    Enter a tag name in the TAG NAME field or click the Browse button. The Tags 
Identifier dialog box opens:  

 
3.    In the Station field, enter a station name, or click the arrow to the right of the field and 
select the required station from a list of available stations.  
To associate more than one station to the instance parameters, select another station and 
click Add. The station is added to the field.  
To replace stations in the Station field, select a station from the list of stations and click 
Change. The specified station is added to the Station field, replacing all other stations.  
4.    In the Tag field, enter a tag name, or click the arrow to the right of the field and select 
a tag from a list of tags. To associate more than one tag to the instance parameters, select 
another tag and click Add. The tag is added to the field. To replace the tags in the Tag 
field, select a tag from the list of tags and click Change. The specified tag is added to the 
Tag field, replacing all other tags. 
If the cluster is defined with the Define each Object when Instantiating option, the Define 
Instance Links dialog box opens: 
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The following options are available: 

Instance 
Name    The unique name of the instance in the image. 

Linked Tags 
and Alarms 

This listbox contains a list of all the tags and alarms associated with the 
object(s) in the cluster, and the operation defined for each. 

Tags/Alarms    

Activate these buttons to change the original definitions of the tags and 
alarms associated with the objects in the cluster. The tag and alarm 
definitions that you specify will be used to generate new tags and 
alarms for the cluster in the Image. 

Find 
Activate this button to search for a tag or alarm in the Linked Tags and 
Alarms listbox. In the entry field, you can specify the full name of the tag 
or alarm, or a name prefix. 
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Clusters / Open Lib   
To instantiate a cluster from a library to the application, select the Open Lib item. This 
option will enable you to open a library. 
 
To instantiate a cluster from a library to the application 
1. Select the Open Lib item from the Clusters menu in the image window 
2. Specify the library from which you want to instantiate a cluster in the Drag and Drop to 
Img window. 
Clusters Menu 
 

 
 

 
 

   

 
 

 
 
 

Breaking/Editing Clusters  
Clusters can be modified without breaking the cluster. This includes changing tag names 
and range parameters in dynamic operation. You can also change the fill and line color of 
the objects. Trigger operations can also be edited. 
Note:     Editing allows modifying, but not adding new properties to the cluster. 

o To Edit Clusters: 
1.    Select the cluster you want to edit. 
2.    Right-click the object and select Edit Properties from the popup menu.  
Or 
From the Edit menu click Edit Properties. The Edit Properties dialog opens. 
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The Edit Properties dialog displays the structure of the cluster. The dialog box is divided 
into two frames: 

o     Object List on the left. The Object tree contains the structural makeup of the 
cluster. For example the displayed truck consists of dynamic objects, groups and 
polylines. Each object can be modified. 

o     Object Properties on the right. When clicking on an object in the Object list, it is 
shown on the right. The Definitions and Attributes buttons allow you to modify the 
object. You can also modify triggers with the Trigger button.  

Note:     For further information read  See Edit Properties. 
 

 
 

 
 

   

 
 

 
 
 

Breaking Clusters   
Cluster definitions can be cancelled by selecting a cluster object in the Image, and then 
selecting Break from the Clusters menu. 



Chapter 21 Image Editor 

823 

To cancel a Cluster definition: 
1. Select a cluster object in the image. 
2. Select Break from the Clusters menu. 

Note: Instances cannot be defined as dynamic, trigger, or as another 
cluster (no nesting of clusters), unless they are broken apart. 

The Clusters Menu 
 
 

 
 

   

 
 

 
 
 

Deleting a Cluster from the Library 
Clusters can be deleted from their library. 

o To delete a cluster from the library: 
1.   Select the Cluster and the Open Lib menu.  
2.   In the Library field select the library from which you want to delete the object. Then, 
select the cluster from the clusters list in the dialog box and press the Delete button on the 
keyboard. 
Note:    Since a library must contain at least one cluster, the last cluster in the library 
cannot be deleted. 

 
 

 
 

   

 
 
 

 
 

Copying Clusters from One Library to Another 
Clusters can be copied from one library to another. 

o To copy a cluster from one library to another: 
1.   Select the Cluster and the Open Lib menu.  
2.   In the Library field select the library from which you want to copy cluster. Then select 
this menu item again. 
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3.   In the new dialog box select the library to which you want to copy the cluster. 
4.   Then simply drag the cluster from the source library dialog to the target library dialog, 
and the cluster will be copied. 
Note:    Clusters that reside in the same library must have different names. Therefore, if the 
cluster you want to copy already exists in the target library, you will not be able to copy it.  

 
 

 
 

   
 
 
 
 

Rebuild Instances  
One of the big advantages of using clusters is the ability to rebuild all instances 
automatically after updating the original cluster in the library.  

o To rebuild the instances in the application: 
1.    Select Rebuild Instances from the Clusters men to open the Rebuild Cluster Instances 
dialog box: 
 

 
 
In the list, you can see all the instances that were placed in the current Image. Each line 
contains the library name, the cluster name, and how many instances of that object were 
placed.  
2.    Select those items you want to update (note that the list box has multiple selections, 
and therefore, you can select more than one line in the list), and press the Rebuild button. 
Note:     The tags and alarms that were associated with each instance will remain 
unchanged. The Rebuild operation will fail if there is no compatibility between the cluster in 
the library, and the instances in the Image. Compatibility means that the tags, alarms and 
triggers must have the same links. For example you cannot redefine an object that was 
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linked to one tag to be connected to two tags. You can select all items in the list by 
pressing <CTRL></> keys 
 

 
 

 
 

   

 
 

 
 
 

Cluster Edition 
Presentation 

Clusters, once defined in a cluster library, were impossible to modify. It was necessary to 
create a new cluster from scratch and to replace the old version.  

   
Now, cluster edition allows you to modify your cluster by adding new objects and new tags, 
removing objects or changing their position. All of this is done without having to recreate 
the objects from scratch.  

Description 
To use cluster edition, open an cluster editor window. You can open this window with the 
menu "Tools/ClusterEdition" inside main application menus,  
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or by right-clicking on "images" section and choosing "Cluster Edition" .  
   

 
   

Once the editor is opened, all commands are similar to a normal image, except that you 
can drag and drop a cluster from a library to copy all objects that define it. At this point, the 
complete layout will be editable in the usual way with all tools available inside image 
edition.  

   
When edition is finished, select all objects that must be repacked as your new cluster, and 
choose "Create cluster" from the contextual menu.  

   

 
   

As you were using edition mode, cluster original data such as name, library, description 
and tag information ($ask/$id tokens) were saved and are cross-referenced with your new 
cluster layout.  
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Normally, for minimal changes, you only have to validate the cluster creation dialog box, if 
everything seems fine to you. Your original cluster is replaced by your new version, if you 
do not change the name and the lib selection.  

   

Notes 
   

When you instantiate cluster objects in edition mode, they may contain/reference tags that 
are not available, as objects still contain old definitions. This is not a problem as original 
cluster information regarding tag to used are saved. You will be able to modify tag 
information once you come back to the cluster definition user interface.  

   
If you edit a cluster that contains alarm objects and associated alarm definitions, you will 
lose all alarm definition.  

   
In edition mode, you cannot save your current image. To save your cluster modifications 
you have to rely on the create cluster command. 
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Cluster / Rebuild Instance 
One of the big advantages of using clusters is the ability to rebuild all instances 
automatically after updating the original cluster in the library.  

1. Select Rebuild Instances from the Clusters men to open the 
Rebuild Cluster Instances dialog box: In the list, you can see 
all the instances that were placed in the current Image. Each 
line contains the library name, the cluster name, and how 
many instances of that object were placed.  

2. Select the items you want to update (note that the list box has 
multiple selections, and therefore, you can select more than 
one line in the list), and press the Rebuild button. 

Notes: 

1. The tags and alarms that were associated with each instance will 
remain unchanged. 

2. The Rebuild operation will fail if there is no compatibility between 
the cluster in the library, and the instances in the Image. 
Compatibility means that the tags, alarms and triggers must have 
the same links. For example you cannot redefine an object that 
was linked to one tag to be connected to two tags. 

3. You can select all items in the list by pressing <CTRL></> keys. 
 
The Clusters Menu  

 
 

 
 

   

 
 
 

 
 

Cluster Baskets 
The basket is a tool supplying a high level of engineering and application design. It is used 
to make a prototype of the application before starting to actually implement it, and also to 
trace the progress of the application development. 
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When you place an object from the basket to your application, there is one less object that 
you can take from the basket. If you delete an instance that is a basket item from the 
application, it will be added to the basket again (as if not taken from there). All the basket 
operations are also logged in a file called BASKET.LOG, which describes who takes or 
adds items from and to the application basket, and when. 
There is only one basket in the system, which is kept in a simple ASCII text file called 
BASKET.DAT. This file can be edited using any text editor to ensure simple and fast image 
design for the application engineers. The format of the BASKET.DAT file is similar to the 
one that appears in the listbox of the Basket Maintenance dialog box. 

o To define an application basket: 
Select Basket Maintenance from the Clusters menu to open the Basket Maintenance 
dialog box. 
 

 
 
The following fields are available: 

Name    Specifies the name of the item as you want it to appear in the basket 
library. 

Library    Specifies the library from which you want to extract the cluster. To select 
from a list of existing libraries, click on the arrow to the right of the field. 

Object    
Specifies the name of the cluster as it appears in the library you specify. 
To select from a list of existing objects, click on the arrow to the right of 
the field. 

Amounts   For 
Required 

Specify the amount of times the cluster object will be available in the 
basket library. For Used, the value is usually 0 (if you do not fill this field, 
the default value is also 0). This indicates that the first cluster object in 
the basket library will be number 0.  
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Cluster 
Listbox    

A list of existing clusters defined in the basket library. 
 

Add    
Activate this button to add the current cluster definition to the basket 
library. 
 

Change Activate this button to change the definition of a cluster in the basket 
library to the current definition. 

Delete    Activate this button to delete the cluster from the basket library. 

 
 
 

 
 

   

 
 

 
 
 

Clusters Basket Maintenance 
A Basket is a special tool that supplies a new (high) level of engineering and application 
design. It is used to make a prototype of the application before starting to actually 
implement it, and also to trace the progress of the application development. You can think 
of it as a shopping list, you can specify in the basket the components you need to include 
in your application 
To define the application basket, select the Basket Maintenance item from the Clusters 
menu in the image window. 
The Clusters Menu 

 
 

 
 

   

 
 
 

 
 

Open Cluster Basket Objects 
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This option is used to open a cluster basket and import an object into an image. 
o To instantiate an existing cluster: 

Select Open Basket from the Clusters menu. The Drag &Drop to Img dialog box is 
displayed: 
 
 

o To instantiate an object from the library window: 
Click the right mouse button on the object you want to instantiate, and drag the object to 
the desired location in the image. 
Note:     In addition to each object in the library, the numbers indicate the amount of 
required objects that you specify in the Basket Maintenance dialog box and the amount of 
objects you already instantiated in the Image. 
 

 
 

 
 

   

 
 

 
 
 

Clusters / Open Basket    
This option displays the clusters defined in a basket. On the right of the cluster the number 
of times that the cluster has been used and maximum usage are displayed.  
 
The Clusters Menu 

 
 

 
 

     

Clusters 

 
 
 
 
 

Clusters / Define    
This option will enable you to define a cluster. 
Cluster definition is enabled in two modes: 
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Simple - If no tags or alarms are associated with the graphic objects that are selected in 
the image (meaning that the object was not defined as a dynamic, trigger, or alarm object). 
Dynamic - If the object you have selected is associated with tags or alarms (the object was 
defined as a dynamic or trigger object). 
To define a Cluster and add it to a library 
1. Select the graphic objects in the image that you want to include in the cluster. 
2. Select Define from the Clusters menu. The Define Cluster Object dialog box is 
displayed. 
The Clusters Menu  

 
 

 
 

   

 
 

 
 
 

Clusters Basket Maintenance 
A Basket is a special tool that supplies a new (high) level of engineering and application 
design. It is used to make a prototype of the application before starting to actually 
implement it, and also to trace the progress of the application development. You can think 
of it as a shopping list, you can specify in the basket the components you need to include 
in your application 
To define the application basket, select the Basket Maintenance item from the Clusters 
menu in the image window. 
The Clusters Menu 

 
 

 
 

   

 
 
 

 
 

Breaking Clusters   
Cluster definitions can be cancelled by selecting a cluster object in the Image, and then 
selecting Break from the Clusters menu. 
To cancel a Cluster definition: 
1. Select a cluster object in the image. 
2. Select Break from the Clusters menu. 
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Note: Instances cannot be defined as dynamic, trigger, or as another 
cluster (no nesting of clusters), unless they are broken apart. 

The Clusters Menu 
 
 

 
 

   

 
 

 
 
 

Clusters / Open Basket    
This option displays the clusters defined in a basket. On the right of the cluster the number 
of times that the cluster has been used and maximum usage are displayed.  
 
The Clusters Menu 

 
 

 
 

     

 
 
 

 
 

Clusters / Open Lib   
To instantiate a cluster from a library to the application, select the Open Lib item. This 
option will enable you to open a library. 
 
To instantiate a cluster from a library to the application 
1. Select the Open Lib item from the Clusters menu in the image window 
2. Specify the library from which you want to instantiate a cluster in the Drag and Drop to 
Img window. 
Clusters Menu 
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Cluster / Rebuild Instance 
One of the big advantages of using clusters is the ability to rebuild all instances 
automatically after updating the original cluster in the library.  

1. Select Rebuild Instances from the Clusters men to open the 
Rebuild Cluster Instances dialog box: In the list, you can see 
all the instances that were placed in the current Image. Each 
line contains the library name, the cluster name, and how 
many instances of that object were placed.  

2. Select the items you want to update (note that the list box has 
multiple selections, and therefore, you can select more than 
one line in the list), and press the Rebuild button. 

Notes: 

1. The tags and alarms that were associated with each instance will 
remain unchanged. 

2. The Rebuild operation will fail if there is no compatibility between 
the cluster in the library, and the instances in the Image. 
Compatibility means that the tags, alarms and triggers must have 
the same links. For example you cannot redefine an object that 
was linked to one tag to be connected to two tags. 

3. You can select all items in the list by pressing <CTRL></> keys. 
 
The Clusters Menu  

 
 

 
 

   

Options Menu 
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Options Menu 
This menu defines image properties and zones that will appear on the operator's 
workstation. 
The Goto, Goto Zone and Zone Definition options are used to define and jump to zones. 

Autowindow    This option when selected automatically sets the image window position 
and zoom level. 

Goto    This option opens the Goto dialog box where the coordinates of the 
location to which you want to jump in the image are defined. 

Goto Zone Using the Goto Zone function, operators can receive alarms showing a 
graphical image of the cause of the alarm.  

Zone 
Definition 

This option when selected opens the Zones Definition dialog box where 
zone parameters are defined. These zones will appear in the Goto Zone 
list. 

Repaint    
Select this item to redraw the current image. This is useful to view the 
results of editing operations, if they do not immediately appear on the 
screen.  

Window A window zoom is defined by marking a window in an image. This zoom 
enables the operator to define a window's contents. 

Simulate Select this option to simulate variations of tag values and observe how 
the image is affected by each value. 

Force Zone 
Dyn Show 

This option when selected causes a dynamic object in an image to 
appear. 

Mark Trigger 
This option when selected causes all trigger objects in the window to be 
marked (or unmarked) on the screen. A red hand will appear in all the 
trigger objects in the image. 

Styles 
Definition Select this option to define a font for image text objects. 
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Autowindow 
This option automatically sets the Image window position and zoom level, so that all image 
objects in the window will be arranged.  

This function can also be performed by clicking the  button on the left side of the Image 
window. 

 
 

 
 

   
 
 
 
 

Options / AutoWindow  
Select this item to automatically set the image window position and zoom level, so that all 
image objects in the window will be arranged properly.  
This function can also be performed by clicking on the a button on the left side of the image 
window. 

 
 

 
 

   

 
 
 

 
 

Options / AutoWindow  
Select this item to automatically set the image window position and zoom level, so that all 
image objects in the window will be arranged properly.  
This function can also be performed by clicking on the a button on the left side of the image 
window. 
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Goto 
This dialog box is used to enter the coordinates of the location to which you want to jump in 
the image. You can jump to any position in the image, whether or not that position is 
defined as a zone. 

o To open the Goto dialog box: 
1.    Select Goto from the Options menu or click the Goto icon. The Goto dialog box opens. 

 
 
2.    Enter a scale level between 1 and 2048. 
3.    Enter the X and Y coordinates, in drawing units.  
4.    Click OK to confirm. 
Note:     In the Image module scale represents the image zoom level. The smaller the 
scale, the closer the image is. At a scale of 64 each drawing unit is 0.01 on a standard 
workstation monitor. 
 

 
 

 
 

   

 
 

 
 
 

Options / Goto    
This dialog box is used to enter the coordinates of the location to which you want to jump 
to in the image. You can jump to any position in the image, whether or not that position is 
defined as a zone. 
To jump to a specific position in the image window 
1. Select Goto from the Options menu. The Goto dialog box appears. 
2. Enter a scale level between 1 and 2048. 
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3. Enter the X and Y coordinates, in drawing units. 
 

 
 

 
 

   

 
 

 
 
 

Options / Goto    
This dialog box is used to enter the coordinates of the location to which you want to jump 
to in the image. You can jump to any position in the image, whether or not that position is 
defined as a zone. 
To jump to a specific position in the image window 
1. Select Goto from the Options menu. The Goto dialog box appears. 
2. Enter a scale level between 1 and 2048. 
3. Enter the X and Y coordinates, in drawing units. 
 

 
 

 
 

   

 
 
 

 
 

Goto Zone 
The Goto Zone dialog box enables you to easily jump to any of the zones defined in the 
Zones Definition dialog box. 

o To jump to a specified zone in an image: 
From the Options menu select Goto Zone  
Or, 
Click the Go to Zone icon. The Goto Zone dialog box opens. 
 
1.    Select a zone and click OK, or double click a zone. 
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2.    The image window will immediately be centered on the zone's central point and the 
zoom level will be adjusted to the level defined for that zone.  
Note:     A pre-defined zone called Previous Zone is included in the zone list. You can goto 
this zone the same way as any other zone. However, if there is no zone to return to the 
previous zone item will be disabled. 
 

 
 

 
 

   

 
 

 
 
 

Options / Goto Zone   
The Goto Zone dialog box enables you to easily jump to any of the zones you defined. 
To jump to a specified zone in an image: 
1. Select the Goto Zone item from the Options menu, or click the Goto Zone icon from the 
main menu. The Goto Zone dialog box is displayed. 
2. Select the zone you want to jump to and click the OK button, or double click the zone 
you wish to jump to. The image window will immediately be centered on the zone's central 
point and the zoom level will be adjusted to the level defined for that zone.  

Note that a pre-defined zone called Previous Zone is included in the 
zone list. This zone appears as the character <<<. You can goto this 
zone the same way as any other zone. However, if there is no zone to 
return to, the previous zone item will be disabled. 
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Zone Definition 
A Zone is a pre-defined position and zoom level in the image that can be jumped to by 
selecting the Goto Zone item in the Options menu.  

o To open the Zone Definition dialog box 
From the Options menu select Zones Definition 
Or,  
Click the Navigation mode icon. The Zone Definition dialog box opens:  
 

 
    
1.    In the Name field type in a unique zone name. 
2.    In the Central Point field enter the X and Y coordinates, in drawing units, to define the 
zone center in the image window.  
3.    In the Scale field type in a level between 1 and 2048. 
4.    Select the Control tag checkbox if you want to use a digital tag to indicate the zone 
status. At run-time, if the digital tag value is 1, the zone status will be BAD; if set to 0, the 
zone status will be GOOD. 
5.    In the Station field select the station from which you want to select a tag. 
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6.    In the Tag field select the tag you want to use from the drop-down menu, or click the 
browse button to open the Tag Definition dialog box. 
7.    This is an optional step: select a context name through the list of currently available 
contexts. This will automatically fill the tag context field. Only use this if you need access to 
the tag template feature (see the chapter on tag templates). 
8.    Click the Add button to add the zone. The new zone is displayed in the list. 
9.    Click Save to save the zone definition and exit the dialog box. 

o To modify a defined Zone parameters: 
1.    Select the zone you wish to modify. 
2.    Using the instructions for Zone Definition, modify the selected zone parameters. 
3.       Click the Change button. The zone properties displayed in the list of zones are 
modified. 

o To remove a zone: 
1.    Select the relevant zone. 
2.    Click the Delete button. 
 

 
 

 
 

   

 
 

 
 
 

Defining Zones    
A Zone is a pre-defined position and zoom level in the image that can be jumped to, by 
selecting the Goto Zone item in the Options menu.  
 

o How to define a Zone? 
1. Select Zones Definition item from the Options menu. The Zone Definition dialog box 
opens.  
2. Type a unique name for the zone in the Name box. 
3. Enter the X and Y coordinates, in drawing units, to define the zone center in the image 
window.  
4. Enter a scale level between 1 and 2048. 
5. Select the Control tag checkbox if you want to use a digital tag to indicate the zone 
status.  
 At run-time, if the digital tag value is 1, the zone status will be BAD; if set to 0, the zone 
status will be GOOD. 
 Station - Select the station from which you want to select a tag. 
 Tag - select the tag you want to use from the drop-down menu, or click the browse button 
to open the Tag Definition dialog box. 
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6. Choose a Context through ‘Context Name’ combo box that will be applied to objects that 
use tag template Ids. This context is optional. You do not have to select it if you do not 
need one 
7. Click the Add button to add the zone. The new zone is displayed in the list. 
8. Click Save to save the zone definition and exit the dialog box. 
 

o To modify a defined Zone parameters: 
1. Select (click) the zone you wish to modify. 
2. Change the selected zone parameters in the various dialog box fields, as applicable. 
3. Click the Change button. The zone properties displayed in the list of zones are modified. 
 

o To remove a zone: 
1. Select (click) the zone you wish to remove. 
2. Click the Delete button. 
 

 
 

 
 

   

 
 

 
 
 

Zone Navigator 
The Zone Navigator is a global, multi-image zone navigation window that enables efficient 
navigation through a list of zones defined in the application's various image files.  
Using the Zone Navigator window a number of navigators each of which can contain a 
number of zones from one or more different image files can be defined. 
The Zone Navigator can be applied on images through button and action type triggers or 
by configuring an action macro using the Zone Navigation Action macro. 
A digital tag representing the zone status of each Zone Navigator can be attached. If the 
tag value is set to 1 Zone Navigator status will be BAD and if set to 0 Zone Navigator 
status will be GOOD. Additionally, colors can be defined in which zones with a control tag 
of BAD status will be displayed in the run-time Zone Navigator window.  

o To open the Zone Navigators window: 
Double click the Zone Navigator icon on the Studio Control panel.  
Or, 
Select Zone Navigators from the Studio Design menu. 
Or,  
In the Edit mode right click an object to open a popup menu and select Trigger Definition, 
Action and then Zone Navigator. The Zone Navigator dialog box opens. 
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The Zone Navigator has the following fields: 

List of 
Zone 
Navigator
s: 

This list displays all the Zone Navigators defined. Each 
navigator is identified by a unique name and general 
description. 

New:  Click this button to add a new Zone Navigator.  

Modify:  
Click this button to modify the selected Zone Navigator. 
This will open the New Zone Navigator dialog box where 
the Name field will appear in gray.  

Delete: Click this button to delete the selected Zone Navigator. 

Select 
backgroun
d : 
#ffffff;">  
Click this 
button to 
open the 
Color 
dialog box 
where 
color 
indicating 
zones 
status can 
be 
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defined. 
The 
default 
color is 
red. 

o To open a new Zone Navigator: 
In the Zone Navigator dialog box click New to open the New Zone Navigator dialog box. 

 
The New Zone Navigator dialog box has the following fields: 

Name:    Unique Zone Navigator name. This can be up to 60 characters including 
spaces. 

Description:    Unique description of the Zone navigator. This can be up to 256 
characters, including spaces 

Enable Tag 
Control: 

This checkbox when checked enables definition of an analog tag that 
will indicate Zone Navigator status.  

Station: Indicating the station from which the Tag is selected. 
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Tag:  Indicating the Zone Navigator Tag. 

List all 
Selected 
Zones: 

Displays a list of all selected zones. This list has three columns: Zone 
Name, Image Name and Control Tag.    

Add:    
This button when clicked opens the Add Zones dialog box which 
displays a list of defined zones which can be added/removed to the List 
all Selected Zones. 

Delete: This option when clicked deletes a selected zone from the List all 
Selected Zones. 

Move Up    This button when clicked moves a selected line in the List of All 
Selected Zones up a row. 

Move Down    This button when clicked moves a selected line in the List of All 
Selected Zones down a row. 

Window 
Properties:    

The following fields define the zone's behavior on the operator's 
workstation: 

Automatically 
close window 
after (Sec):  

This option defines that the window will automatically close after the 
indicated number of seconds. 

Always 
Select before 
Opening: 

This checkbox when checked defines that this window will be displayed 
on top of other opened windows. 

Always select 
before 
opening: 

This checkbox when checked indicates that the user will jump to the 
zone only after selecting to view it when the alarm is received. 

Open in 
existing 
window:  

This checkbox when checked indicates that zones will be opened in the 
same image window, even when they belong to a different image 
window than the currently opened one. When unchecked, each zone will 
be opened in the image file in which it was defined. 

o To Add zones to the Zone Navigator: 
Click the Add button to open the Add Zones dialog box: 
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This dialog box has the following fields: 

List of All Zones  This displays a list of all defined zones in the application.  

Selected Zones     This displays a list of the zones selected from the List of All Zones. 

Add/Add All  Click these buttons to either add a selected zone to the Selected 
Zones list or click Add All to add all the zones to the list. 

Remove/Remove 
All 

Click these buttons to either remove a selected zone from either 
lists or click Remove All to remove all the zones from the list. 

 
 

 
 

   

Zone Navigator 

Zone Navigator Overview 

Zone Navigators Overview    
The Zone Navigator is a global, multi-image zone navigation window that enables you to 
quickly and efficiently navigate through a list of zones defined in your application's various 
image files.  
Using the Zone Navigator window you can define a number of navigators each of which 
can contain a number of zones from one or more different image files. 
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The Zone Navigator can be applied on images through triggers of type Button and Action, 
or by configuring a macro of type Action using the ZoneNavigation action macro. 
To indicate a zone's status, you can attach a digital tag representing the zone's status to 
each zone navigator. If the tag value is set to 1 the Zone Navigator status will be BAD, if 
set to 0 the Zone Navigator status will be GOOD. You can also define the color in which 
zones defined with a control tag that have BAD status will be displayed in the run-time 
Zone Navigator window. 
To open the Zone Navigators window 
Double click the Zone Navigators icon on the Application Studio Control panel  
Or 
Select Zone Navigators from the Application Studio Design menu. 
  
The Zone Navigator dialogbox has the following fields: 
List of 
Zone 

the list displays all the zone navigators you defined. Each navigator is identified 
by a unique name and a general desctiption. 

New Click this button to add a new Zone Navigator. For more details on adding zone 
navigators, refer to Adding Zone Navigators. 

Modify Click this button to modify the selected zone navigator. For more details on 
modifying zone navigators, refer to Modifying Zone Navigators. 

Delete Click this button to delete the selected zone navigator. 

Define 
Color 

Click this button to open the Color dialog box where you can define the color 
indicating zones status. For more details on defining the zones color, refer to 
Defining Zones Status Color. 

How to 

Adding New Zone Navigators 
Adding a Zone Navigator consists of two steps: 
1. Defining the Zone Navigator parameters. 
2. Attaching zones defined in your images to the Zone Navigator. 
To add a new zone navigator 
1. Click the New button in the Zone Navigators dialog box to open the New Zone Navigator 
dialog box.  
2. Enter a unique name for the Zone Navigator in the Name field. The name can be up to 
60 characters, including spaces. 
3. Type a general description for the Zone Navigator in the Description field. The 
description can be up to 256 characters, including spaces. 
4. Define the various Zone Navigator window properties. 
 Always on top - select this checkbox to display this window on top of any other opened 
windows. 
Close after - define the time (in seconds) after which the Zone Navigator window will be 
closed. 
 Always select before opening - when checked you can go to a zone only when selected. 
 Open in existing window - when checked zones will be opened in the same image 
window, even when they belong to a different image window than the currently opened 
one. When unchecked, each zone will be opened in the image file in which it was defined. 
5. Select the Control tag checkbox, if you want to use a digital tag to indicate the zone 
navigator status: 
 At run-time, if the digital tag value is 1, the zone navigator status will be BAD, if set to 0, 
the zone navigator status will be GOOD. 
 Station - select the station from which you want to select a tag. 
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 Tag - select the tag you want to use from the drop-down menu, or click the browse button 
to open the Tag Definition dialog box.  

Modifying Zone Navigators 
You can modify all the zone navigator parameters, except its name.  
To modify a zone navigator 
1. Open the Zone Navigator dialog box by clicking the Zone Navigators icon in the control 
panel, or by selecting Zone Navigators from the studio Design menu. 
2. Select the zone navigator you want to modify from the list of zone navigators. 
3. Click the Modify button, or double click the selected zone navigator to modify its 
parameters. 
 The Zone Navigator dialog box is opened with the Name field grayed. 
4. Modify the various zone navigator parameters as described in the Adding New Zone 
Navigators topic. 

Defining Zones Status Color 
To indicate a zone's status, you can attach a digital tag representing the zone's status to 
each zone. If the tag value is set to 1 (true), then there is a problem in this zone, and the 
zone will be drawn in a special, predefined color when displayed in the Zone Navigator. 
The default color is red. 
To define zones status color 
1. Click the Define Color button in the Zone Navigators window. A standard color dialog 
box is opened. 
2. Select a color from the color pallet, or click the Define Custom Colors for other colors. 
3. Click OK when done. 

Attaching Zones to the Zone Navigator 
To attach zones to the Zone Navigator 
1. Click the Add button to display the Add Zones dialog box. 
2. Select an image name from the list of images on the left. You can click the + sign to the 
left of each image name to view all the zones in the selected image. 

3. Click the  button to add the selected zones to your Zone Navigator. The 
selected zones are displayed in the list of selected zones on the right. 
4. Click the Add All button to add all the zones to the Zone Navigator (note that if you do 
not expand the image file to view its zones and you click the add arrow, all the zones will 
be added as well). 
To remove zones from the list of selected zones 
1. Select the zone you want to remove from the list. 

2. Click the  button to remove the selected zone/s from the list. 
 Or, to remove all the zones, click on the Remove All button. 

Activating the Zone Navigator 
Once created, the Zone Navigator can be called at run-time, to enable easy navigation 
through your application various zones. 
To do so, follow these steps: 
1. Define a zone navigator that includes a collection of all the application zones you want to 
navigate through at run-time. 
2. Configure a trigger of type Button or Action or an Action Macro using the action Zone 
Navigation to activate the zone navigator. 
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3. Open your application image containing the trigger and click the trigger you configured 
to open the zone navigator window, or click the accelerator defined for opening the zone 
navigator: 
 
The Zone Navigator window contains the following components: 
•     Title bar displaying the Zone Navigator name. 
•     General information displaying the number of zones in this navigator and the 
navigator status (good or bad). 
•     A list view displaying the zones contained in this navigator, including: zone 
name, image name and control tag (if defined).  
•     In addition, you can use the filtering capability to view zones by entering a text in 
any of the list view fields. 

To navigate through the various zones 
1. Select (click) the zone you want to go to from the list of zones. 
2. Click the Go To button. The image file containing the zone you selected is opened in the 
position and the zoom level defined by the zone. 
 Or, 
Double click the selected zone. 

Zone Navigation Action Macro 
Use this action macro to invoke a zone navigator at run-time. 
Take the following steps to configure a macro invoking a zone navigator at run-time: 
1. Select Macros from the application studio Design menu, to open the Macro Definition 
dialog box. 
2. Click the Action button and select Zone Navigation from the drop-down menu. 
3. Click the Parameters button and type the Zone Navigator name, or click the Browse 
button to open the Zone Navigators window, where you can select one of the navigators 
you defined, or create a new zone navigator. 
4. Click OK when done. 

 
 
 
 
 

Repaint  
This option when select redraws the current image. This is useful to view the results of 
editing operations, if they do not immediately appear on the screen, or to remove 
undesirable residues that may remain on the screen after editing.  

o To repaint an object: 
Select the Repaint option from the Options menu. 
Or, 

Click the  button on the Image scroll bar. 
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Options Repaint 
Select this item to redraw the current image.  
This is useful to view the results of editing operations, if they do not immediately appear on 
the screen, or to remove undesirable residues that may remain on the screen after editing.  
To Repaint  
Select the Repaint option from the Options menu. 
OR 
Press the r button from the Image scroll bar. 

 
 

 
 

   

 
 
 

 
 

Window  
A window zoom is defined by marking a window in an image. This is later used as the 
window. This zoom enables the operator to define what is to be included in the window. 

o To zoom in to a specific part of the image: 
1.   Click on any location in the image to define the start and end points of the image 
section you want to zoom in on. 
2.   Click in the outlined box, or, click the button on the Image scroll bar. 
3.   To move an outlined box, position your cursor on a box border (a multiple arrow cursor 
appears), click, and drag the box to the new position. 
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Options / Window    
Select this item to zoom in to a specific part of the image.  
A window zoom is performed by marking a window in the image to be used later as the 
window. This zoom enables the operator to define what is to be included in the window. 
To zoom in to a specific part of the image: 
1.   Click on any location in the image to designate the starting point of the portion of the 
image you want to zoom in on. 
2. Click on the place where you want the end of the image portion to be.  
3. Click in the outlined box.  
 OR 
 Press the w button located in the Image scroll bar. 
 To move an outlined box, place the cursor on a box border (a multiple arrow cursor 
appears), click, and drag the box to the new position. 

 
 

 
 

   

 
 

 
 
 

Options / Window    
Select this item to zoom in to a specific part of the image.  
A window zoom is performed by marking a window in the image to be used later as the 
window. This zoom enables the operator to define what is to be included in the window. 
To zoom in to a specific part of the image: 
1.   Click on any location in the image to designate the starting point of the portion of the 
image you want to zoom in on. 
2. Click on the place where you want the end of the image portion to be.  
3. Click in the outlined box.  
 OR 
 Press the w button located in the Image scroll bar. 
 To move an outlined box, place the cursor on a box border (a multiple arrow cursor 
appears), click, and drag the box to the new position. 
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Simulate  
This option opens the Simulate Tags dialog box, which is used to specify tag values and 
simulate them for test purposes. After dynamic objects are defined, the operator can test 
an object's response to different tag values using an application mechanism that simulates 
tag values without affecting the tag itself.  

o To simulate tag values: 
1.   Select Simulate from the Options menu. The Simulate Tag Values dialog box opens. 

    
2.   In the Station field click the arrow to open the dropdown list and select the tag station. 
3.   In the Tag field click the arrow to open the dropdown list or click the Browse button to 
select the relevant tag. 
4.   In the New Suggested Value field type in a value. 
5.   To set the value is click the Apply button, or, use the horizontal scroll bar to 
immediately set and simulate the specified value. 
6.   Click the Range button to specify the upper and lower range limits of the tag value to 
be simulated. 
7.   Click the Exit button to quit the dialog box and leave the last set value. 

 
 

 
 

   

 
 

 
 
 

Force Zone Dyn Show 
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This option when selected causes a dynamic object in an image to appear even if the 
object is hidden. 

o To define Force Dynamic show 
Select an object form the view and then select Force Dyn. Show from the Options menu, 
right click an object to open a popup menu and then select Dynamic Definition or, click the 
Force Dynamic Show icon from the Image Main Menu. 

 
 

 
 

   
 
 
 
 

Mark Trigger 
Note:    Mark Triggers is not supported on the Web.  
Triggers can be marked in Edit mode during image design. When this option is selected all 
trigger objects in the window are marked (or unmarked) on the screen. After selecting the 
Mark Triggers option, a red hand will appear in all the trigger objects in the image. The 
Mark Triggers function will apply to any trigger object.  
Note:    If an object is marked (with a red hand) to indicate that it is a trigger object, but is 
dynamically or manually transformed (moved, rotated, scaled, etc.), the trigger mark may 
disappear or will not appear in its proper location. If this occurs, you can refresh the screen 
by pressing <Alt-R>. 

 
 

 

 
   
 
 
 
 

Styles Definition 
This option is used to define the image text style. 

o To define text font style: 
1.   Select Styles Definition from the Options menu. The Styles Definition dialog box opens. 



Chapter 21 Image Editor 

854 

 
2.   Click the Add button to open the Style Properties dialog box where you can define the 
new style properties. 
3.   To change the definition of an existing style select a style from the list click the 
Properties button to open the Style Properties dialog box. Change the style attributes: size 
and effect and click the OK button. 
4.   To Remove a style, select a style from the list and click the Remove button. 

 
 

 
 

   

Options Menu 
 
 
 
 
 

The Options Menu 
The Option menu offers the following features: 
AutoWindow Select this item to automatically set the image window position and zoom 
level, so that all image objects in the window will be arranged properly.  
GotoSelect this item to cause the window to jump to a position and zoom level that you 
specify in the dialog box that appears.  
Goto ZoneSelect this item to cause the window to jump to an existing zone.  
Zones Definition Select this item to define Zones.  
Repaint Select this item to redraw the current image.  
Window Select this item to zoom in to a specific part of the image. 
Simulate Select this item to simulate variations of tag values and observe how the image 
is affected by each value.  
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Force Dynamic Show Select this item to cause a dynamic object in an image to appear, 
even if according to a Drum or Show filter (both defined in the Dynamic Parameters dialog 
box), the object is hidden.  
Mark trigger Select this item to cause all trigger objects in the Window to be marked (or 
unmarked) on the screen.  
Styles definition Select this item to define the fonts you want to use for image text 
objects.  

 
 

 
 

   

 
 

 
 
 

Options / AutoWindow  
Select this item to automatically set the image window position and zoom level, so that all 
image objects in the window will be arranged properly.  
This function can also be performed by clicking on the a button on the left side of the image 
window. 

 
 

 
 

   

 
 
 

 
 

Options / Goto    
This dialog box is used to enter the coordinates of the location to which you want to jump 
to in the image. You can jump to any position in the image, whether or not that position is 
defined as a zone. 
To jump to a specific position in the image window 
1. Select Goto from the Options menu. The Goto dialog box appears. 
2. Enter a scale level between 1 and 2048. 
3. Enter the X and Y coordinates, in drawing units. 
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Options / Goto Zone   
The Goto Zone dialog box enables you to easily jump to any of the zones you defined. 
To jump to a specified zone in an image: 
1. Select the Goto Zone item from the Options menu, or click the Goto Zone icon from the 
main menu. The Goto Zone dialog box is displayed. 
2. Select the zone you want to jump to and click the OK button, or double click the zone 
you wish to jump to. The image window will immediately be centered on the zone's central 
point and the zoom level will be adjusted to the level defined for that zone.  

Note that a pre-defined zone called Previous Zone is included in the 
zone list. This zone appears as the character <<<. You can goto this 
zone the same way as any other zone. However, if there is no zone to 
return to, the previous zone item will be disabled. 

 
 

 
 

   

 
 
 

 
 

Defining Zones    
A Zone is a pre-defined position and zoom level in the image that can be jumped to, by 
selecting the Goto Zone item in the Options menu.  
 

o How to define a Zone? 
1. Select Zones Definition item from the Options menu. The Zone Definition dialog box 
opens.  
2. Type a unique name for the zone in the Name box. 
3. Enter the X and Y coordinates, in drawing units, to define the zone center in the image 
window.  
4. Enter a scale level between 1 and 2048. 
5. Select the Control tag checkbox if you want to use a digital tag to indicate the zone 
status.  
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 At run-time, if the digital tag value is 1, the zone status will be BAD; if set to 0, the zone 
status will be GOOD. 
 Station - Select the station from which you want to select a tag. 
 Tag - select the tag you want to use from the drop-down menu, or click the browse button 
to open the Tag Definition dialog box. 
6. Choose a Context through ‘Context Name’ combo box that will be applied to objects that 
use tag template Ids. This context is optional. You do not have to select it if you do not 
need one 
7. Click the Add button to add the zone. The new zone is displayed in the list. 
8. Click Save to save the zone definition and exit the dialog box. 
 

o To modify a defined Zone parameters: 
1. Select (click) the zone you wish to modify. 
2. Change the selected zone parameters in the various dialog box fields, as applicable. 
3. Click the Change button. The zone properties displayed in the list of zones are modified. 
 

o To remove a zone: 
1. Select (click) the zone you wish to remove. 
2. Click the Delete button. 
 

 
 

 
 

   

 
 
 

 
 

Options Repaint 
Select this item to redraw the current image.  
This is useful to view the results of editing operations, if they do not immediately appear on 
the screen, or to remove undesirable residues that may remain on the screen after editing.  
To Repaint  
Select the Repaint option from the Options menu. 
OR 
Press the r button from the Image scroll bar. 
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Options / Window    
Select this item to zoom in to a specific part of the image.  
A window zoom is performed by marking a window in the image to be used later as the 
window. This zoom enables the operator to define what is to be included in the window. 
To zoom in to a specific part of the image: 
1.   Click on any location in the image to designate the starting point of the portion of the 
image you want to zoom in on. 
2. Click on the place where you want the end of the image portion to be.  
3. Click in the outlined box.  
 OR 
 Press the w button located in the Image scroll bar. 
 To move an outlined box, place the cursor on a box border (a multiple arrow cursor 
appears), click, and drag the box to the new position. 

 
 

 
 

   

 
 

 
 
 

Options / Simulate  
This dialog box is used to specify tag values that you want to simulate for testing purposes. 
After dynamic objects are defined, the operator can test an object's response to different 
tag values using an application mechanism that simulates tag values without affecting the 
tag itself. 
When you simulate values, the field device will not be affected.  
To simulate tag values 
1. Select Simulate from the Options menu. The Simulate Tag Values dialog box is 
displayed. 
2. Select the station to which the tag belongs. 
3. Select the tag you want to access. 
4. Enter the tag value to be simulated in the New Suggested Value field. The current tag 
value is displayed in the Current Simulated Value field. The value is set by clicking the 
Apply button. 
 OR 
 Use the horizontal scroll bar to immediately set and simulate the specified value. 
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5. Click the Range button to specify the upper and lower range limits of the tag value to be 
simulated. 
6. Click the Exit button to quit the dialog box and leave the last set value. 

 
 

 
 

   

 
 

 
 
 

Options / Force Dyn. Show 
Select the Force Dynamic Show item to cause a dynamic object in an image to appear, 
even if according to a Drum or Show filter (both defined in the Dynamic Parameters dialog 
box), the object is hidden. 
To define Force Dynamic show 
1. Select an object form the view 
2. Select Forch Dyn. Show from the Options menu. 
 OR 
1. Select an object from the view. 
2. Click it with the right mouse button 
3. Select the Dynamic Definition from the popup menu. 
OR 
Press the Force Dynamic icon from the Image Main Menu. 

 
 

 
 

   

 
 
 

 
 

Options Mark Trigger 

Note: Mark Triggers is not supported on the Web. You can mark triggers 
in Edit mode, while developing your image. 

Select this item to cause all trigger objects in the Window to be marked (or unmarked) on 
the screen.  
After you select Mark Triggers, a red hand will appear in all the trigger objects in the image.  
The Mark Triggers function will apply to any trigger object.  
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Note, however, that if an object is marked (with a red hand) to indicate that it is a trigger 
object, but is dynamically or manually transformed (moved, rotated, scaled, etc.), the 
trigger mark may disappear or will not appear in its proper location. If this occurs, you can 
refresh the screen by pressing <Alt-R>.  

 
 

 
 

   

 
 

 
 
 

Options / Styles Definition   
This dialog box is used to define font styles for the image text.  
To define a new style 
1. Select Styles Definition from the Options menu of the Image Window. The Styles 
Definition dialog box opens 
2. Click the Add button to open the Style Properties dialog box where you can define the 
new style properties. 
3. Click the Close button when done. 
To change the definition of an existing style 
1. Select a style from the list 
2. Click the Properties button. The Style Properties dialog box opens. 
3. Change the style attributes: size and effect and activate the OK button. 
To Remove a style 
1. Select a style from the list 
2. Click the Remove button. 

 
 

 
 

   

Modes Menu 
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Modes Menu 
This menu sets the operating mode of the window. Several image windows can appear on 
the screen simultaneously enabling the operator to view and edit separate parts of the 
same or different images on the same screen. The different modes can be 
activated/deactivated by selecting/deselecting the relevant mode option.  

Edit The Edit is used for designing and editing an image. In this mode, an image 
can be viewed and edited.  

Navigate 

This option is used to move through an image workspace without editing 
the image.In this mode, the displayed image can only be viewed and not 
navigated or edited, though tag input can be performed if the operator is 
authorized to do so and the Trigger on mode has been activated. 

Trigger 
On 

When the Trigger mode is set to On, objects defined as Trigger objects can 
be used for tag input. When this mode is Off, no objects, even one defined 
as a Trigger object, can be used for tag input. 

Copy On 

When this option is selected transformations do not affect the original 
objects. For example, if an object is moved, both the original and the moved 
objects will remain on the screen (the object will be copied). If this mode is 
Off, when an object is moved, only the newly positioned object is moved. 

Grid 
Setup 

This option when selected opens the Grid Setup dialog box where you can 
select the grid unit types and coordinates, reference point to which all other 
points are relative and preview the defined grid. 

Snap to 
Grid    

When this option is On the cursor will move only from point to point on the 
grid, without skipping points. This mode can be activated to position objects 
accurately in the image. 

Grid 
Show When this option is selected a grid appears in the image window. 

 
 

 
 

   
 
 
 
 

Edit  
The Edit mode is used for designing and editing an image. In this mode, an image can be 
viewed and edited. 
A check mark beside the Edit option indicates that it is active. Selecting the option again 
causes the system to revert the Monitor Mode. 



Chapter 21 Image Editor 

862 

In the Edit mode, all the image Window functions are present, including the Tools windows 
which contains the drawing and editing tools used to create and modify images. When the 
Edit Mode is activated, all the Tools available in the window will appear. The Tools window 
contains the object, the operation, the drawing and the color tools. In addition, the current 
coordinates of the location of the cursor in the image will appear in the title bar of the 
window (or in the caption of the icon, if it was minimized).  
Note:    If the Edit mode is activated without the Navigate mode, you will be able to edit the 
image, but not scroll, pan, or zoom in it.  

o To access the Edit Mode: 
Select Edit from the Modes menu. 

 
 

 
 

   
 
 
 
 

Navigate  
The Navigate Mode is used to move through an image workspace without editing the 
image. 
In this mode, the displayed image can only be viewed and not navigated or edited, though 
tag input can be performed if the operator is authorized to do so and the Trigger on mode 
has been activated. The Tools window initially appears outside the Image Window, but can 
be moved to the new location.  
If this mode is selected without the Edit mode, you will be able to scroll, pan, and zoom in 
the image, but not edit it.  
In addition, if the Edit mode is not activated together with this mode, the Tools window will 
not appear. 

o To enable the Navigation mode 
Click the Navigate mode icon in the Image main menu. 
Or, 
Select Navigate from the Modes menu. 

 
 

 

 
   
 
 
 
 

Trigger On  
When the Trigger mode is set to ON, objects defined as Trigger objects can be used for 
tag input. When this mode is OFF, no objects, even those defined as a Trigger object, can 
be used for tag input. 
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When this mode is active, you can move from one trigger object to another by pressing the 
Tab key. To move in the reverse order, press the Shift and tab keys together. Note that you 
move from one object to another according to the order in which the objects were 
designed. To change the order, use the Z order tool. After you select this item, the cursor 
will appear as a white hand. When the hand is placed on a trigger object, it will turn red. In 
this mode, image objects designed for tag input (trigger objects) can be activated. 

o To access the Trigger on mode: 
Click the Trigger on icon on the Image Main Menu.  

 
 

 
 

   

 
 

 
 
 

Copy On  
The Copy On mode enables duplication of objects in Transform operations. 
When the Copy On mode is activated, a transform operation will preserve the original 
object. When the Copy on mode is not activated, a transform operation will discard the 
original object (only the transformed object will remain). 

o To toggle the Copy On mode: 
Select Copy On from the Modes menu. A check beside the item indicates that it is active. 
In addition to the Copy mode, the following methods can also be used to copy objects: 

 
 

 

 
   
 
 
 
 

Grid Display 
To make a grid visible or hidden, click on the grid tool from the Operations Toolbar. 
You can also make the grid hidden or visible from the Image Modes Menu, Show Grid.  
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Grid Setup 
A grid is an array of points superimposed on an image. It is used to accurately position 
objects in an Image. 
A grid consists of the following elements: 

Origin The origin is the reference point that all other points are made relative to. 
The origin can be any point in an Image. 

Step    The distance between adjacent grid points. Different values can be 
assigned for horizontal and vertical steps. 

Snapping    The cursor can be made to move only in grid point steps. When the mouse 
is moved, the cursor will jump to the next grid point. 

 
The following types of grids can be used: 

World    
The grid step is set to the Drawing Space: When the zoom level is changed, 
the visible distance between grid points also changes accordingly together 
with the other geometrical objects in the Image. 

Pixels    
The grid step is set to the screen pixels: Whatever the zoom level, the 
distance between the grid points remains the same, even though object 
sizes visibly change. 

Grids can be made visible or hidden. The following sections describe the operations that 
are performed to create grids and set their attributes. 

o To configure a grid: 
Select Grid Setup from the Modes menu, or the Grid Setup button from the toolbar. The 
Grid Setup dialog is displayed: 



Chapter 21 Image Editor 

865 

 
The following options are available: 

Step Units 
Specifies the grid type, as follows: 
Pixels are Image grid type units. 
World are geometric grid type units. 

Step    
The grid step (in the respective units): 
X is the horizontal step. 
Y is the vertical step. 

Origin    Used to enter the origin point X-Y coordinates. 

Select 
Point    

When this button is activated, the dialog will temporarily be suspended, and 
the operator can then indicate the origin point by clicking the left button in 
the window. 

Show    
When this button is activated, the grid is displayed on the Image to verify 
the setting. If the operator changes the setting and activates the button 
again, the old grid will be deleted and the new one will be displayed. 
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Defining Grid Parameters    
Select the Grid Setup item to define a grid for the image.  
A grid is a rectangular array of points that appears in the image background and can be 
used to place objects at exact coordinates in the image. 
 
To define the image grid setup 
1. Select Grid Setup from the Modes menu. 
 Or, Click the Grid Setup tool located on the main toolbar. 
 The Grid Setup dialog box opens. 
2. Define the Grid step units type: 
 World - The grid step will be set to the drawing space, so that when the zoom level is 
changed, the visible distance between grid points also changes accordingly, together with 
the other geometrical objects in the image.  
 Pixels - The grid step is set to the screen pixels, so that whatever the zoom level, the 
distance between the grid points will remain the same, even though the object sizes visibly 
change. 
3. Enter the grid step (in the respective units). X is the horizontal step and Y is the vertical 
step.  
4. In the Origin section, define the reference point to which all other points are relative.  
5. Click the Select Point button to select the origin point by clicking on a point in the image. 
The X and Y fields will indicate the point you selected.  
6. Click the Show button to cause the grid to appear in the image immediately, according to 
the current configuration.  
7. Click the Set button to save the grid configuration and exit the dialog box. 
The grid origin is the reference point to which all other points are relative.  
The term grid snapping refers to the movement of the cursor in the image, only in grid point 
steps (when the mouse is moved, or arrow key is pressed, the cursor will move to the next 
grid point.  

 
 

 
 

   

 
 
 

 
 

Snap to Grid  
o To toggle the Grid Snapping mode on and off: 

Click the Snap to Grid tool in the Operations toolbox, or select Grid Snap from the Modes 
menu. 
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Grid Show 
o To make a grid show or hidden: 

   Click on the Grid tool from the Operations toolbox, or select Grid Show from the Modes 
menu. A grid is displayed over the Image. 
  

 
 

 
 

   

Modes Menu 

 
 
 
 
 

The Modes Menu 
Window modes (edit, navigate) 
Select one of these items to set the operating mode of the window.  
Several image windows can appear on the screen simultaneously: Edit, Navigate thus 
enabling the operator to view and edit separate parts of the same image, or different 
images, on the same screen. 
Trigger on When the Trigger mode is set to ON, objects defined as Trigger objects 
can be used for tag input. When this mode is OFF, no object, even one defined as a 
Trigger object, can be used for tag input. 
Copy On Select this item to toggle the Copy On mode on and off. 
Grid Setup Select this item to define a grid for the image. 
Grid Snap Select this item to toggle the Grid Snapping on and off. 
Grid Show Select this item to make a grid visible or hidden. 
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Modes / Edit 
Select this item to toggle the Edit Mode on and off. 
The Edit mode is used for designing and editing an image. In this mode, an image can be 
viewed and edited.  
To access the Edit Mode 
Select Edit from the Modes menu. A checkmark beside the Edit item indicates that it is 
active. Selecting the item again causes the system to revert to the Monitor Mode. 
In the Edit mode, all the image Window functions are present, including the Tools windows 
which contains the drawing and editing tools used to create and modify images. 
When the Edit Mode is activated, all the Tools available in the window will appear. 
The Tools window contains the object, the operation, the drawing and the color Tools. In 
addition, the current coordinates of the location of the cursor in the image will appear in the 
title bar of the window (or in the caption of the icon, if it was minimized).  

Note that if the Edit mode is activated without the Navigate mode, you 
will be able to edit the image, but not scroll, pan, or zoom in it.  

 
 

 
 

   

 
 

 
 
 

Modes / Navigate 
Select this item to toggle the Navigate mode on and off.  
Use the Navigate Mode to move through an image workspace without editing the image. 
In this mode, the displayed image can only be viewed and not navigated or edited, though 
tag input can be performed if the operator is authorized to do so and the trigger on Mode 
has been activated. 
The Tools window initially appears outside the Image Window, but can be moved to the 
new location,  
To enable the Navigation mode 
Press the Navigator Icon located in the Image main menu 
OR 
Select Navigate from the Modes menu. 
If this mode is selected without the Edit mode, you will be able to scroll, pan, and zoom in 
the image, but not edit it.  
In addition, if the Edit mode is not activated together with this mode, the Tools window will 
not appear.  
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Modes / Trigger On  
Select this item to toggle the Trigger mode on and off to enable the use of Trigger objects 
with other modes. 
When the Trigger mode is set to ON, objects defined as Trigger objects can be used for 
tag input. When this mode is OFF, no objects, even one defined as a Trigger object, can 
be used for tag input. 
When this mode is active, you can move from one trigger object to another by pressing the 
Tab key. To move in the reverse order, press the Shift and tab keys together. Note that you 
move from one object to another according to the order in which the objects were 
designed. To change the order, use the Z order tool. 
To access the Trigger ON tool  
Press the Trigger On button located in the Image Main Menu. After you select this item, the 
cursor will appear as a white hand. Whenever the hand is placed on a trigger object, it will 
turn red. In this mode, image objects designed for tag input (trigger objects) can be 
activated.  

 
 

 
 

   

 
 

 
 
 

Modes Copy On    
Select this item to toggle the Copy On mode on and off.  
To enable the Copy On mode: 
Select Copy On from the Modes menu. In the Copy On mode, transformations do not affect 
the original objects. For example, if an object is moved, both the original and the moved 
objects will remain on the screen (the object will, in effect, be copied). If this mode is off, 
when an object is moved, only the newly-positioned object will appear.  
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Modes / Grid Setup   
Select the Grid Setup item to define a grid for the image. 
A grid is a rectangular array of points that appears in the image background and can be 
used to place objects at exact coordinates in the image.  
Selecting Grid Setup opens the Grid Setup dialog box where you can select the grid step 
unit types and coordinates, the reference point to which all other points are relative. You 
can also preview your grid definition. 

 
 

 
 

   

 
 

 
 
 

Modes / Grid Show   
Select the Grid Show item to make a grid visible or hidden. 
To enable the Grid Show option 
Select Grid Show from the Modes menu. 
Or, 
Click the Grid icon on the Operations toolbar. 

 
 

 
 

   

 
 
 

 
 

Modes / Snap to Grid   
Select the Grid Snap item to toggle the Grid Snapping on and off.  
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When grid snapping is on, the cursor will move only from point to point on the grid, without 
skipping points.  
This mode can be activated to position objects accurately in the image  
To enable the Grid Snap option 
Select Snap to Grid from the Modes menu. 
Or 
Click on the Snap to Grid icon in the Operations toolbar. 

 
 

 
 

   

The Window Tools 

 
 
 
 
 

The Align toolbar 
The Align toolbar enables you to align two or more selected objects. They can be aligned 
to the Left, Right, Top, or Bottom. The objects can also be centered or resized Horizontally, 
Vertically or both. 

 
 

 
 

   

 
 

 
 
 

The Colors toolbar 
The Color toolbar includes 32 colors for background and foreground color of objects. Left 
click selects the foreground or the color while right click selects the background, or fill 
color. 
Double-clicking either mouse button opens the color palette dialog, enabling you to 
customize any color. 
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The Image Drawing Tools 
The Drawings toolbar is used to draw objects in an image. 
The application includes all the tools you need to create your own graphic objects. These 
tools are found in the Drawings toolbox and include the tools listed below. If you want to 
edit any of these shapes, you can use the Edit Operations Toolbar. 
 
Select toolHLP_WZ2EDT_SELECT_TOOL  
Filled Rectangle or Square  
Unfilled Rectangle or Square  
Filled Rectangle or SquareFilled_Rectangle_or_Square  
Unfilled Round-cornered Rectangle or 
SquareUnfilled_round_cornered_rectangle_or_square_tool  
Filled Circle Tool  
Unfilled CircleHLP_WZ2EDT_CIRCLE  
Filled Ellipse Tool  
Unfilled Ellipse 
Filled Closed Arc Filled_Closed_Arc_tool 
Unfilled Closed Arc Unfilled_Closed_Arc_Tool 
Filled Orthogonal Polygon 
Unfilled OrthogonalPolygonUnfilled_orthogonal_polygon_tool 
Filled PolygonFilled_polygon_tool 
Unfilled PolygonUnfilled_polygon_tool  
Orthogonal Pipe 
PipePipe_tool 
Arc Arc_tool 
Orthogonal Polyline Orthogonal_polyline_tool 
PolylineHLP_WZ2EDT_POLYLINE  
TextHLP_DLG_WZ2_TEXT  
ButtonHLP_WZ2EDT_BUTTON_PROP  
Insert Picture  
To select a drawing tool 
1. Click in the Drawings toolbar. 
2. Click the tool you want to draw with. 
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The Drawings toolbar 
The Drawings toolbar contains simple drawing objects such as Line, Pipe, Box, Text, and 
Circle. Both filled and unfilled objects can be selected. The selection, text tool and button 
are also included in this toolbar. 

 
 

 
 

   

 
 

 
 
 

The Objects toolbar 
The Objects toolbar allows you to define Image objects such as Alarm, Trigger, Dynamic, 
Cluster Definition, Group, Slider, Media and Scheduler 

 
 

 
 

   

 
 
 

 
 

The Operations toolbar 
The Operations toolbar includes Rotate, Pick color, Active Layer, Toggle Fill, Cluster 
library, Bring to Back, Bring to Front, Delete, Grids, Snap to Grids and Copy Attributes. 

 
 

 
 

   

 



Chapter 21 Image Editor 

874 

 
 
 
 

The Patterns and Gradient Toolbar 
Note: Patterns and Gradient fills are not supported on the Web. 
The Patterns toolbar contains 16 different fill patterns, including solid and transparent. The 
Image drawing patterns also support 32 gradient styles. The first color used for the 
gradient is the foreground color, while the last color used is the background color.  
Gradient fills are supported for the following objects: Text, Filled Box - Circle, and Polygon. 
Pipes do not support Gradient fills. 

Notes 

1. Gradients are not fully supported on Windows 98. Circles, 
ellipses and rounded rectangles will be drawn as rectangles. 

2. In the ILS file the gradient pattern numbers run between 100 to 
131 ordered by the above list.  

3. Bitmap fonts are not effected by the Gradient. 

4. After changing attributes of gradient objects, or moving from 
select mode, image may need refresh. 

5.  Performance may suffer when drawing large gradient surfaces 
with many steps. It is advisable that only static (background) 
object will be using the  Gradient. Dynamic over Gradient is 
possible but performance may suffer. It is also advised to do 
development in low number of steps and later increase steps for 
run-time. 

6. To set the gradient steps use Image Properties View or in the 
Wiztune.dat file, manually set the tuning parameter 
IMG_GRAD_STEP= n). Valid values are between 2 to 255 – 
Default is 16. Re-enter Image. 

7. Transparent color will have 'unknown' effect over fill. 

8. The gradient is not affected from rotation or transformation. It is 
possible to rotate objects with Gradient but the Gradient 
orientation will not be rotated 

9. Not supported on Web. Note that if patterns are used and then 
brought to the Web, the patterns turn to solid colors. 

10. The gradient for a group works like for a pattern.  

11. It is not possible to select Gradient fill type in Dynamic definition 
Fill Type range. 

12. The gradient’s center reference point for filled polygons, 
orthogonal polygons, and filled arcs is always calculated by the 
visible parts of the objects. Therefore, when you scroll and the 
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object partially disappears from view, you will notice that the 
object’s center point moves upwards away from the center. 

 
 

 
 

   

Viewing 
 
 
 
 
 

The Image Windows 
 
Image windows are windows in which images are viewed and manipulated.  
Images are dynamic pictures through which control processes are monitored and 
supervised.  
 
An Image window can operate in one of the following modes:  
Monitor - In this mode, the image can only be viewed in the current window boundaries. 
Tag value input through trigger objects is supported (if the operator is authorized to do so).  
Navigate - In this mode, the image can only be scrolled, panned, and zoomed in and out.  
Edit - In this mode, an image can be drawn, edited, and saved. When the Edit mode is 
invoked, an auxiliary window, called the Tools window, will appear beside the Image 
window. The Tools window contains editing tools that you can use to draw or modify an 
image.  
The Image window modes can be activated by selecting a mode from the Modes menu.  
Several Image windows can be opened simultaneously on the screen, each displaying 
parts of the same image, or different images.  
In the Edit mode, each image has its own dedicated Tools window.  

 
 

 
 

   

Selecting 

 
 
 
 
 

Edit / Select 
Use this option to select or deselect objects within the image. 
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You can choose to: 
Select - select an object. 
Deslect Last - deselect the last selected object. 
Deselct All - deselect all selected objects. 

 
 

 
 

   

 
 

 
 
 

Select Tool 
To select an object 
1. Click the select arrow.  
2. Click on the object you want to select. 
3. To select several objects, start from an empty point in the Image, press and hold left 
mouse button, drag a rectangle around the objects you wish to select. 
4. To add an object to existing selection, left-click the mouse button while holding down the 
Shift key. 
5. Handles (small squares) appear on the corners and sides of an object's highlighting box 
when the object is selected.  
6. Use the square handles to resize and transform an object. Click on a selected object 
and the handles change to arrows which then permit you to resize an object. 
7. To move selected objects, click inside the object or bound rectangle, for a group of 
objects and, while holding the mouse button down, drag the object to the desired location. 

 
 

 
 

   

 
 

 
 
 

First selected object is marked with 8 hollow handles.  
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Deselect All 
Select this option to deselect all the objects in the window.  

 
 

 
 

   

 
 
 

 
 

Deselect Last 
Select this option to deselect the last object that was selected in the window.  

 
 

 
 

   

 
 

 
 
 

Select this item to set the a new font style  
 
 

 
 

   

Image Operation 
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Moving Objects   
The move operation is used to move objects from one location to another. As opposed to 
the move operation described in the section called Selection, this move operation is useful 
for long distance moving (from zone to zone, area to area, etc.), since the mouse button 
does not have to be held down while dragging the object. 
To move an object: 
1. Select one or more objects. 
2. From the Edit Menu Operations click the move option. 
3. Click on the left mouse button. The cursor changes to a bi-directional arrow. 
4. Click the left button on a starting point. 
5. Move the frame of the object(s) to the desired location and click the left button. 
6. Clicking the right mouse button sets the object automatically to select mode and cancels 
the move operation. 

 
 

 
 

   

 
 

 
 
 

Rotating Objects 
The Rotate Operation lets you turn an object or group of objects clockwise or counter 
clockwise. 
To Rotate an Object 
1. Select an object. 
2. Select Operations from the Edit menu, then select the Rotate option; or select the Rotate 
tool from the Operations toolbar.  
3. Click the left button on the rotation pivot and see the skewing handles. 
4.  Move the frame of the object around the pivot until the object is rotated to the desired 
orientation and click the left button. 
Once a starting point for the Rotate operation has been established, click the right button to 
cancel the last part of the operation. When no starting point has been established, the right 
button can be used for single object selection. 

Note:  Ellipses cannot be rotated sideways (slanted). 
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Bring to Front   
The Bring to Front option allows you to place objects in the front of your image. You can 
change the way objects overlap or lie by shifting the object to the front. Objects are placed 
with the first object you created on the bottom and the last object you created on top. You 
can shift the order of the objects by using the Bring to Front option or Send to Back option. 
 
To Bring the object to the front 
1 Select drawing object you want to bring to the front. 
2. From the Edit menu select Operations, then Bring to Front. The selected drawing object 
is placed in front of other overlapping objects. 
Or, 
Click the Bring to Front tool on the Operations toolbar. 

 
 

 
 

   

 
 
 

 
 

Send to Back   
The Send to Back option allows you to place objects in the back of your image. You can 
change the way objects overlap or lie by shifting the object to the back. Objects are placed 
with the first object you created on the bottom and the last object you created on top. You 
can shift the order of the objects by using the Bring to Front option or Send to Back option. 
To Send the object to the back 
1. Select the drawing object you want to send to the back. 
2. From the Edit menu select Operations then Send to Back. 
 The selected drawing object is placed in back of other overlapping objects. 
Or, 
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Click the Send to Back tool on the Operations toolbar. 
 
 

 
 

   

 
 

 
 
 

Changing Color   
The Change Color operation allows you to select a different color for your drawing objects. 
To Change Color 
1. Select the drawing tool of your choice. 
2. From the Color select a color. 
3. Highlight your drawing object. 
4. From the Edit menu click Operations, then click on the Change color option. The object 
is drawn with the selected color. 

 
 

 
 

   

 
 
 

 
 

Cancel Override Color   
The Cancel Override Color option enables you to return to the original or default colors you 
chose for your objects, after modification. 
To cancel override color 
1. Draw the objects with your choice of colors and Group them. 
2. Modify your objects colors. 
3. If you wish to return to the original color selection click on the Operations Menu Cancel 
Override Color and your objects keep their original colors. 
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Cancel Override Pattern   
The Cancel Override Pattern option enables you to return to the original or default patterns 
you chose for your objects, after modification. 
To cancel override pattern 
1. Draw the objects with your choice of patterns and Group them. 
2. Modify your objects patterns. 
3. If you wish to return to the original pattern click on the Operations Toolbar Cancel 
Override Pattern and your objects keep their original patterns. 

 
 

 
 

   

Color 

 
 
 
 
 

Pick Color Tool 
Click on the Pick Color tool in the Operations Toolbar for filling or drawing objects with the 
exact color used in a different object. 
The Pick Color Tool lets you sample colors from an area of an image to designate a new 
line color or fill color.  
To select the line or fill color using the Pick Color tool 
1. Select the drawing tool. 
2. Select the Pick Color tool, then place the dropper icon on any point in the image over the 
desired color. 
3. Draw your new object and the object fills with the selected color. 
Or  
1. To select a new line color from the Color Toolbar, left click the mouse button on the color 
you want. 
2. To select a new fill color from the Color Toolbar, right click the mouse button on the color 
you want. 
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Toggle Fill    
The Toggle Fill operation is used to fill and empty objects. The Toggle Fill tool operates as 
a toggle. 
Note that when an object is unfilled it still retains its fill attribute, which can be restored at 
any time. 
To use the Toggle Fill Tool 
1. Select an object. 
2. Click the left mouse button on the Toggle Fill tool in the Operations Toolbar. 
 Or 
 From the Edit Menu, select Operations, then click on the Toggle Fill option. 

 
 

 
 

   

 
 
 

 
 

The Colors toolbar 
The Color toolbar includes 32 colors for background and foreground color of objects. Left 
click selects the foreground or the color while right click selects the background, or fill 
color. 
Double-clicking either mouse button opens the color palette dialog, enabling you to 
customize any color. 
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Changing Color   
The Change Color operation allows you to select a different color for your drawing objects. 
To Change Color 
1. Select the drawing tool of your choice. 
2. From the Color select a color. 
3. Highlight your drawing object. 
4. From the Edit menu click Operations, then click on the Change color option. The object 
is drawn with the selected color. 

 
 

 
 

   

 
 

 
 
 

Edit/Get Colors and Save Colors 
The application enables you to get colors, i.e., import a color palette, or save colors, which 
means saving the colors you defined in your image file. 
The *. pal file contains the 16 toolbox colors as well as the additional 16 custom colors 
from the color dialog box. Once you define or customize your colors you can save them in 
a *.pal file. To retrieve or get the colors you have saved, use the Get Colors option. 
To retrieve colors from a saved color palette 
Select Get Colors from the Edit menu. 
The Open dialog box opens, where you can select the colors from a *.pal file. 
To save a color palette 
Select Save Colors from the Edit menu. 
The Save As dialog box opens, where you can save your colors to a *.pal file. 

Note: If the image file name and *.pal file name are the same, the *.pal 
file is loaded automatically. The user can continue to work with his 
customized palette every time he opens an image. 
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Edit / Get Colors and Save Colors    
The application enables you to get colors, i.e., import a color palette, or save colors, which 
means saving the colors you defined in your image file. 
The *. pal file contains the 16 toolbox colors as well as the additional 16 custom colors 
from the color dialog box. Once you define or customize your colors you can save them in 
a *.pal file. To retrieve or get the colors you have saved, use the Get Colors option. 
To retrieve colors from a saved color palette 
Select Get Colors from the Edit menu. The Open dialog box opens, where you can select 
the colors from a *.pal file. 
To save a color palette 
Select Save Colors from the Edit menu. The Save As dialog box opens, where you can 
save your colors to a *.pal file. 

Note: If the image file name and *.pal file name are the same, the *.pal 
file is loaded automatically. The user can continue to work with his 
customized palette every time he opens an image. 

 
 

 
 

   

 
 

 
 
 

Cancel Override Color   
The Cancel Override Color option enables you to return to the original or default colors you 
chose for your objects, after modification. 
To cancel override color 
1. Draw the objects with your choice of colors and Group them. 
2. Modify your objects colors. 
3. If you wish to return to the original color selection click on the Operations Menu Cancel 
Override Color and your objects keep their original colors. 
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Edit / Set Background Color   
The Set Image Background feature enables you to set the image background color. 
To set the Background color 
1. Go to Image menu, select the Edit Option and there the Set Background color. 
2. Select a color, press OK and the background of your image will display the color you 
chose.  
OR 
Press the Set Background Color Icon from the Image main menu. 

 
 

 
 

   

Drawing Options 

 
 
 
 
 

Edit / Drawings  
The Drawings sub-menu enables you to draw and add text in your Image by using the 
Polyline, Box, Circle , Pipe, Text and Pick color tools. 
The Drawings sub-menu also includes the Widget option. The Widget option holds the 
Slider, Media Player and Scheduler options. The Drawings Menu also includes the 
Button to enable the application to contain a trigger object that has the same look and feel 
as a Windows button 
See also the Drawing toolbar 
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Drawing in the Image    
You can design, draw or modify your application by selecting the appropriate tools in the 
Image. The Drawings toolbar contains simple drawing objects such as Line, Pipe, Box, 
Text and Circle. You can draw both filled and unfilled objects. You can also assign text to 
your image by using the text tool. 
Drawing shapes 
1. From the Shape tools select a drawing tool. 
2. In the Image area press and hold down the left mouse button. 
3. Start drawing by moving the mouse around, the shape outline you selected is being 
drawn as you move. 
4. Finish drawing by releasing the mouse. 
Notes: 

1. After drawing you remain in the selected tool; note that the object is not selected.  
2. To change colors of selected object select new color in the color toolbar. 
3. Clicking the right mouse button sets the object automatically to select mode and 

cancels the continuity of the last operation. 
4. Double-click on Object toolbar as Trigger, Alarm, Slider, Media or, Dynamic open 

its definition dialog. 
Object Selection/Deselection 
Choose the Selection Tool to select any object (for size or move operations). 

1. To select several objects, start from an empty point in the Image, press and hold 
left mouse button, drag a rectangle around the objects you wish to select. 

2. You add an object to existing selection by left-clicking the mouse while holding 
down the Shift key. 

3. Deselect objects by pressing left mouse button on empty space of Image. 
4. To deselect last used menu item Edit Select Deselect last. 
5. Clicking the right mouse button sets the object automatically to select mode and 

cancels the move operation. 
Aligning Objects 
Whenever you select more than one object, one of the selected objects is marked with 8 
hollow handles. These handles cannot be used to move or resize the object, their sole 
purpose is to mark the object. 
The marked object is the first object selected. Whenever you use an alignment tool (any of 
the 10 alignment tools), all objects are aligned or resized according to the position or size 
of the marked object. 
To make another object the marked or first object 
1. Deselect all (through the menu or by clicking an empty spot) 
2. Select the desired object, by clicking it.  
3. Add the other objects to the selection by holding the shift key pressed while selecting. 
This works with both single select (click) and multi-select (drag). 
Moving/Scaling 

1. Scale by selection of object and handles 
2. To move an object press left mouse button down on object and drag 
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3. To copy object move/scale it with Ctrl key pressed. 
Object Sensitive Menus 

1. Press the right mouse button on any object in the Image. The object is selected 
and a pop up menu appears. 

2. For general Image menu click in empty space in the Image. The pop up menu 
deselects previously selected objects. 

 
 
 

 
 

   

 
 

 
 
 

The Image Drawing Tools 
The Drawings toolbar is used to draw objects in an image. 
The application includes all the tools you need to create your own graphic objects. These 
tools are found in the Drawings toolbox and include the tools listed below. If you want to 
edit any of these shapes, you can use the Edit Operations Toolbar. 
 
Select toolHLP_WZ2EDT_SELECT_TOOL  
Filled Rectangle or Square  
Unfilled Rectangle or Square  
Filled Rectangle or SquareFilled_Rectangle_or_Square  
Unfilled Round-cornered Rectangle or 
SquareUnfilled_round_cornered_rectangle_or_square_tool  
Filled Circle Tool  
Unfilled CircleHLP_WZ2EDT_CIRCLE  
Filled Ellipse Tool  
Unfilled Ellipse 
Filled Closed Arc Filled_Closed_Arc_tool 
Unfilled Closed Arc Unfilled_Closed_Arc_Tool 
Filled Orthogonal Polygon 
Unfilled OrthogonalPolygonUnfilled_orthogonal_polygon_tool 
Filled PolygonFilled_polygon_tool 
Unfilled PolygonUnfilled_polygon_tool  
Orthogonal Pipe 
PipePipe_tool 
Arc Arc_tool 
Orthogonal Polyline Orthogonal_polyline_tool 
PolylineHLP_WZ2EDT_POLYLINE  
TextHLP_DLG_WZ2_TEXT  
ButtonHLP_WZ2EDT_BUTTON_PROP  
Insert Picture  
To select a drawing tool 
1. Click in the Drawings toolbar. 
2. Click the tool you want to draw with. 
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Arc Tool    
To draw an arc 
1. From the Drawings toolbar, click on the arc tool. 
2. Position the mouse pointer where you want to start drawing. 
3. Drag to end point. 
4. Release mouse button. 
5. Move the mouse to the desired radius point and left-click the mouse button. 
Note: Arcs are not supported on the Web. 

 
 

 
 

   

 
 
 

 
 

Filled Closed Arc Tool   
To draw a filled closed arc 
1. From the Drawings toolbar, click on the filled closed arc tool  
2. Position the mouse pointer where you want to start drawing. 
3. Drag to end point. 
4. Release mouse button. 
5. Move the mouse to the desired radius point and left-click the mouse button. 
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Filled Ellipse Tool   
To draw a filled ellipse 
1. From the Drawings toolbar, click on the ellipse tool.  
2. Position the mouse pointer where you want to start drawing. 
3. Drag to form the ellipse. 
4. Release mouse button. 

 
 

 
 

   

 
 
 

 
 

Filled Orthogonal Polygon Tool   
To draw a filled orthogonal polygon 
1. From the Drawing Toolbar, click on the closed filled orthogonal polygon tool  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right button and the last point will automatically be connected to the start point, 
closing the polygon. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 
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Filled Polygon Tool    
To draw a filled polygon 
1. From the Drawings toolbar, click on the filled polygon tool.  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right button and the last point will automatically be connected to the start point, 
closing the polygon. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 

 
 

 
 

   

 
 

 
 
 

Filled Rectangle or Square    
To draw a filled rectangle or square 
1. From the Drawings toolbar, click the filled rectangle tool.  
2. Position the mouse pointer where you want to start drawing. 
3. Drag diagonally. 
4. Release mouse button. 
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Filled Round-cornered Rectangle or Square Tool   
To draw a filled round-cornered rectangle or square 
1. From the Drawings toolbar, click the round filled round-cornered rectangle tool.  
2. Position the mouse pointer where you want to start drawing. 
3. Drag diagonally. 
4. Release mouse button. 

 
 

 
 

   

 
 

 
 
 

The Objects toolbar 
The Objects toolbar allows you to define Image objects such as Alarm, Trigger, Dynamic, 
Cluster Definition, Group, Slider, Media and Scheduler 

 
 

 
 

   

 
 
 

 
 

Orthogonal Pipe 
Orthogonal pipes are connected rectangular segments in orthogonal directions. 
(vertical, horizontal, and at 45 degrees). 
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Orthogonal Pipe Tool   
To draw an orthogonal pipe 
1. From the Drawings toolbar, click on the orthogonal pipe tool. 
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right mouse button to complete the operation. 

 
 

 
 

   

 
 
 

 
 

Orthogonal Polyline 
Lines drawn in orthogonal and diagonal directions (vertical, horizontal, and at 45 degrees). 
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Orthogonal Polyline Tool   
To draw an orthogonal Polyline 
1. From the Drawings toolbar, click on the orthogonal polyline tool  
2. Click the left mouse button on the start point. 
3. To connect lines, click the left mouse button on successive end points. 
4. Click the right mouse button to complete the operation. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 

 
 

 
 

   

 
 

 
 
 

Pipe Tool 
To draw a pipe 
1. From the Drawings toolbar, click on the pipe tool  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right mouse button to complete the operation. 
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Polyline Tool    
To draw a Polyline 
1. From the Drawings toolbar, click on the Polyline tool  
2. Click the left mouse button on the start point. 
3. To connect lines, click the left mouse button on successive end points. 
4. Click the right mouse button to complete the operation. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 

 
 

 
 

   

 
 

 
 
 

Grid Display 
To make a grid visible or hidden, click on the grid tool from the Operations Toolbar. 
You can also make the grid hidden or visible from the Image Modes Menu, Show Grid.  

 
 

 
 

   

 
 
 

 
 

Defining Grid Parameters    
Select the Grid Setup item to define a grid for the image.  
A grid is a rectangular array of points that appears in the image background and can be 
used to place objects at exact coordinates in the image. 
 
To define the image grid setup 
1. Select Grid Setup from the Modes menu. 
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 Or, Click the Grid Setup tool located on the main toolbar. 
 The Grid Setup dialog box opens. 
2. Define the Grid step units type: 
 World - The grid step will be set to the drawing space, so that when the zoom level is 
changed, the visible distance between grid points also changes accordingly, together with 
the other geometrical objects in the image.  
 Pixels - The grid step is set to the screen pixels, so that whatever the zoom level, the 
distance between the grid points will remain the same, even though the object sizes visibly 
change. 
3. Enter the grid step (in the respective units). X is the horizontal step and Y is the vertical 
step.  
4. In the Origin section, define the reference point to which all other points are relative.  
5. Click the Select Point button to select the origin point by clicking on a point in the image. 
The X and Y fields will indicate the point you selected.  
6. Click the Show button to cause the grid to appear in the image immediately, according to 
the current configuration.  
7. Click the Set button to save the grid configuration and exit the dialog box. 
The grid origin is the reference point to which all other points are relative.  
The term grid snapping refers to the movement of the cursor in the image, only in grid point 
steps (when the mouse is moved, or arrow key is pressed, the cursor will move to the next 
grid point.  

 
 

 
 

   

 
 
 

 
 

Grouping and Ungrouping   
Grouping objects combines two or more objects so you can work with them as though they 
were a single object. You can flip, rotate, and resize or scale all the objects in a group as a 
single unit. You can also change the attributes of all objects in a group at one time. For 
example, you can change the fill color to all objects in the group in a single step. 
To Group Objects 
1. Click the select tool and then drag to select the drawing objects you want to group.  
2. Click the left mouse button on the Group tool in the Objects Toolbar. 
Or 
Click Operations from the Edit menu, then click on the Group option. 
Or 
By right clicking an object and selecting the Group option. 
To UnGroup Objects 
1. Select the grouped objects. 
2. Click the right mouse button on the grouped objects and select the UnGroup option. 
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Or 
Click Operations from the Edit menu, then click on the Ungroup option. 
Or 
By right clicking the grouped object and selecting the Ungroup option from the menu. 

 
 

 
 

   

 
 

 
 
 

Options Repaint 
Select this item to redraw the current image.  
This is useful to view the results of editing operations, if they do not immediately appear on 
the screen, or to remove undesirable residues that may remain on the screen after editing.  
To Repaint  
Select the Repaint option from the Options menu. 
OR 
Press the r button from the Image scroll bar. 

 
 

 
 

   

 
 
 

 
 

Unfilled Closed Arc Tool    
To draw an unfilled closed arc 
1. From the Drawing Toolbar, click on the unfilled closed arc . 
2. Position the mouse pointer where you want to start drawing. 
3. Drag to end point. 
4. Release mouse button.  
5. Move the mouse to the desired radius point and left-click the mouse button. 
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Unfilled Ellipse Tool   
• To draw an unfilled ellipse 

1. From the Drawings toolbar, click on the unfilled ellipse tool  
2. Position the mouse pointer where you want to start drawing. 
3. Drag to form the ellipse. 
4. Release mouse button. 

 
 

 
 

   

 
 

 
 
 

Unfilled Orthogonal Polygon Tool   
• To draw an unfilled orthogonal polygon 

1. From the Drawings toolbar, click on the unfilled closed orthogonal polygon tool  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right button and the last point will automatically be connected to the start point, 
closing the polygon. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 
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Unfilled Polygon Tool   
• To draw an unfilled polygon 

1. From the drawings toolbar, click on the unfilled polygon tool  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right button and the last point will automatically be connected to the start point, 
closing the polygon. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 

 
 

 
 

   

 
 

 
 
 

Unfilled Rectangle or Square Tool  
To draw an unfilled rectangle or square 
1. From the Drawing toolbar, click the filled rectangle tool. 
2. Position the mouse pointer where you want to start drawing. 
3. Drag diagonally. 
4. Release mouse button. 
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Unfilled Round-cornered Rectangle or Square Tool    
• To draw a round cornered unfilled rectangle or square 

1. From the Drawings toolbar, click the round cornered rectangle tool  
2. Position the mouse pointer where you want to start drawing. 
3. Drag diagonally. 
4. Release mouse button. 

 
 

 
 

   

Image Text 
 
 
 
 
 

Text Tool 
The Text Dialog Box is used to specify a plain string or numerical value that will be 
displayed whenever a specific tag value occurs.  
To use the text tool 
1. From the Drawings toolbar, click on the Text tool. The Text dialog box is displayed.   
2. Type your text in the Text box. 
3. Click one of the following buttons for further Text definitions: 
 Tag Value - click to define the attributes for the digital text object. 
 Text Table - click to define a plain string or numerical value that will be displayed 
whenever a specific tag value occurs.  
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Image Find Option 
Using the find option you can find and Goto an object that matches the search text. This 
feature is available in Edit mode only. The Find command opens the Find dialog box while 
the Find next searches for the next occurrence of the last search string. 
You can activate the Find option using the following keys: 
Find:  Ctrl F 
Find Next: F3 
In the Find in Image option you can do the following: 
You can enter search strings up to 256 characters 
Search options are common for all Image Windows. 
Search Options  
The following is a list of the search categories and their description you can select to 
search for: 
Simple text. 
Tag name - this includes tag names in Dynamic object, Tag Value, Trigger, Text table and. 
Widgets. 
Alarm family name - as defined in alarm object. 
Trigger macro name - the name of the macro that a trigger activates. 
Trigger zone name - the name of the zone that a trigger goto 
Trigger button - any name in trigger button including title and legend on each button. 
Cluster Instance - the instance name of a cluster. 
Cluster library - the library name of cluster instance. 
Cluster object - the cluster object name as appearing in the library. 
Text table value - the current string value matches the search string. 
String tag value - the current string tag value matches the search string 
Notes:  

1. For Text table and String tag the Simple text option must be also checked. 
2. If searching for trigger zone or macro, then the search is also made in trigger 

buttons for such a match. 
3. Options can be set independently from one of the other. 

Other Search Options 
Other search options give you control of the way the actual search is made. 
Match case -- the search is made for full match of case of letters, otherwise, strings are 
compared ignoring the case. 
Whole word -- the search is made to find the exact full text, all characters are accounted 
for, otherwise, the search is made to find the occurrence of the search string inside any 
text. 
Only in visible view -- if this option is checked, the search is limited to the visible part of the 
Image inside the Window. 
Other Advanced Search Options 
Goto object -- if this option is checked the application will automatically navigate to the 
found object to bring it into the middle of the current Window; the scale will not be changed. 
Always Goto object -- checking this option causes the application to navigate to the found 
Smart Search -- checking this option will cause the search to be performed in a 
geometrical way. The Image is searched from ‘left to right’ in strips of the same size of the 
current open view. In many cases such search is more ‘intuitive’ especially if the Image is 
divided to zones with a corresponding layout. 
If this option is not checked the search is simple, meaning that the search is by the order of 
objects in the Image, from the first object created to the last one.  
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Notification Message 
If a search fails a notification message is displayed with the searched string. 

 
 

 
 

   

 
 

 
 
 

Options / Styles Definition   
This dialog box is used to define font styles for the image text.  
To define a new style 
1. Select Styles Definition from the Options menu of the Image Window. The Styles 
Definition dialog box opens 
2. Click the Add button to open the Style Properties dialog box where you can define the 
new style properties. 
3. Click the Close button when done. 
To change the definition of an existing style 
1. Select a style from the list 
2. Click the Properties button. The Style Properties dialog box opens. 
3. Change the style attributes: size and effect and activate the OK button. 
To Remove a style 
1. Select a style from the list 
2. Click the Remove button. 

 
 

 
 

   

 
 

 
 
 

Style Properties    
Use this dialog to define a new style or edit an existing style. 
To define a new style: 
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1. Select the Styles Definition option from the Options Menu.  
2. Click the Add button. The Style Properties dialog box opens. 
3. Type the style name in the Style name field. 
4. Select the font from the Font list. 
5. Define the font attributes: size and effects (bold, italic, underline, strikethrough). 
6. Click OK to save your changes and return to the Font Styles Definition dialog box.  
The new style you defined now appears in the list of styles. 

Note that on the Web only Bold and Italic effects apply. The dialog box 
opens with Underlined and Strikethrough disabled. 

 
 

 
 

   

 
 

 
 
 

Using the Text Tool 
• To use the text tool 

1. From the Drawings toolbar, click on the text tool  
2. Enter text in the text dialog box. 
3. Press OK and the text will appear at the specified location on the screen. 

 
 

 
 

   

 
 

 
 
 

The Fonts Toolbar 
The Fonts toolbar allows you to set the text font style for any text object, simple, digital or 
text table. 
This toolbar includes the font name, size, direction and different text effects. 
The text can be bold, italic, underscored or strike through. 
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Modifying Text   
Use this dialog box to modify a text object. 
To modify a text object 
1. Select the text object you want to modify. 
2. Click the mouse right button and select Change Text from the popup menu displayed. 
 The Modify Text dialog box is displayed. 
 OR 
 Double click the selected object 
3. Modify your text as applicable and click OK. 

 
 

 
 

   

 
 
 

 
 

Text Table  
Text Tables are used to associate tag values with pre-defined strings. Whenever a Text 
Table is defined and activated, a text string will be associated with the tag values that were 
defined in the Table. When a value changes, the corresponding string will be displayed. 
Each string table is stored in a separate file. 
To assign text tables or create new ones: 
Click the Text Table button in the Text dialog box. 
If no text table exists, the New Text Table File dialog box opens where you can specify the 
name of the text table. If a text table file already exists, the Open Text table file dialog box 
appears. Select a file from the list, or activate the New button to invoke a dialog box in 
which you can enter the name of a new text table file. 
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After you specify the file you want to edit, the Text Table dialog box is displayed to specify 
the string-value relationship: 
The following options are available: 

Station Specifies the network station to which the tag belongs. 

Tag Specifies the name of the tag. 

Value Specifies the string display value. 

Text Specifies the string for the value. 

List Specifies the list of values and the strings defined for them. 

Add Adds the value-string pair to the list. 

Change Replaces the selected pair with the one specified in the entry 
boxes. 

Delete Deletes the selected pair from the list. 

Specify a tag name, the tag values, and their corresponding strings in 
the entry boxes, and add them to the list by activating the Add button. A 
value-string pair can be selected from the existing pairs list, placed in the 
entry boxes, and revised, by activating the Change button. When the 
Delete button is activated, the selected pair is removed from the list. 

Special Cases: 
If a tag value does not exist in the text table, the text field will be filled with Xs (xxxxx). 
If no text table file exists, number signs (#####) will appear in the field. 
If a communication error occurred, asterisks (*****) will appear in the field. 
If spaces are to be used in the string, enclose the string in quotation marks, for example, " 
The text ". 
Text table string files can be created or modified using your system editor. The format of 
this file is as follows: 
  Value   String 
   5  "Cycle Starting ..." 
   20  "Cycle Completed !" 

Note: Text Tables can also be used for Trigger objects when the String 
input method is active. 

 
 

 
 

   

Other Topics 
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File / Delete 
Select this item to delete an existing layout. 

 
 

 
 

   
 
 
 
 

Design / Advanced Alarm Management / Channels 
Select this item to open the Channels dialog box where you configure the communication 
lines used by Application Advanced Alarm Management. 
 

 
 

 
 

   

 
 
 

 
 

Design / Advanced Alarm Management / Pager Services 
Select this item to open the Paging Service Setup dialog box where you define the list of 
pager drivers you want to use and setup the specific parameters of each selected driver to 
be used by Application Advanced Alarm Management. 
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Design / Application Setup   
A new concept is introduced with the Application - the Application Studio. The Application 
includes all relevant objects and files needed to run your application. To manage the 
Application you use the Application Studio.  

 
 

 
 

   
 
 
 
 

Design / Authorization    
Note: Not supported on the Web. 
Select this item to configure the Application Authorization scheme.  
In the Application, the system engineer can limit operator access to system facilities by 
assigning authorization groups. Only operators who are assigned with the proper 
authorization level will be able to use specific Application modules and perform specific 
Application actions.  
When you select the Authorization item, a sub-menu will appear with additional items for 
you to select from.  
1. 1. Select the Users item to define operators who will be able to log in to the system and 
use Application modules and functions.  
2. 2. Select the Group Names item to define names for authorization groups. 
3. 3. Select the Menu Items item to assign authorization groups to any menu item in the 
Application system.  

 
 

 
 

   

 
 
 

 
 

Design / Authorization / System 
Note: This option is available only for Windows NT/ 2000 users.  
 
Select this item to access the Application security system. 
The Application provides an additional system security by ensuring that users access only 
those parts of the system to which they have authorization.  
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Note: The Application system security must be installed to enable this option. When the 
Application system security is installed, it replaces the standard Windows system control. 
The Application dialogs overwrite the Windows NT dialogs. 
Selecting this item opens the System Authorization Management dialog box where you can 
define the access permission to Application security system. 

 
 

 
 

   

 
 

 
 
 

Design / Authorization / Groups   
Note: Not supported on the Web. 
Select this item to define names for Application authorization groups.  
After you select this item, the Group Names dialog box will appear for you to define the 
names of groups. Once a group is defined, operators can be assigned to that group for 
authorization purposes.  

 
 

 

 
   
 
 
 
 

Design / Authorization / Menu Items    
Note: Not supported on the Web. 
Select this item to assign authorization groups and users to any Application menu or menu 
item.  
After you select this item, the Menu Authorization dialog box will appear with a list of 
menus for you to select from. The dialog box operates according to the expansion method, 
whereby each menu you select will automatically be expanded to display all the items in 
that menu. You can then select the groups that will have access to the item you want. 
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Design / Authorization / Users 
Select this item to define the names of operators who will be able to log in to the system 
and use Application modules and functions.  
  
After you select this item, the Users Setup dialog box will appear for you to define the 
users who will have access to the system. Each user is assigned a unique name and 
password, which must be specified upon system startup.  

 
 

 
 

   
 
 
 
 

Design / Class Names    
Select the Class Names item to assign class names for alarms. 
  
Class names are assigned to alarms for filter purposes.  
Any alarm class name you define, can be used later to filter alarms in the Events Summary 
or Pop-up Events Summary window.  
After you select this item, the Alarm User Class Names dialog box will appear for you to 
enter the class names.  

 
 

 

 
   
 
 
 
 

Design / DDE Client Definition 
The application DDE client block mechanism allows the Application to receive many tag 
values from the server in on update message. This improves the communication between 
the Application and the DDE server. A common use for DDE client blocks is a setup in 
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which a DDE server updates at once a block of items that make up a recipe. The 
Application, the client, receives all the items, and the tag values are changed at once. 

 
 

 
 

   
 
 
 
 

Design / Options / Application    
Select the item to configure the application’s operational environment. You can specify 
whether or not the application will activate the tag sampling mechanism, write to .HIS files, 
activate the alarms module, and activate the collapse alarms mechanism. 

 
 

 
 

   

 
 
 

 
 

Design / Popup Settings 
What is a Popup Events Summary? 
The Popup Events Summary is an Events Summary that can be made to appear on the 
screen whenever a severe alarm occurs. The operator can filter the alarms that will appear 
in the Popup Events Summary. 
To define the Popup Events Summary parameters follow these steps: 
1. 1. From the Application Studio Design menu select Popup. 
1. 2. From the sub-menu displayed select Popup Settings to define the Popup Events 
Summary columns, colors, filter and popup window specifications. 
1. 3. Select Popup Buzz to define buzz parameters. 
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Design / Printer Targets 
1. 1. Select this item to open the Printer Targets dialog box where you can define Printer 
Targets. 
1. 2. A printer target is a collection of pre-defined filters and printers, specifying the 
conditions under which a target printer will be activated. 
 

 
 

 
 

   

 
 

 
 
 

Design / Zone Navigators 
Select this item to open the Zone Navigators dialog box where you can define Zone 
Navigator objects. 
Zone Navigator is a global, multi-image zone navigation window that enables you to quickly 
and efficiently navigate through a list of zones defined in your application's various image 
files.  

 
 

 
 

   

 
 
 

 
 

Design / Alarm Filter 
The alarm filters are automatically activated when the application is loaded. The Alarm 
Filter Manager enables you to assign values to each of the alarm classifications so that 
the Events Summary will display only the alarms that meet these specifications. 
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Design Alarm Parameters Field Names 
These are customized fields that are defined by the user according to their specific 
requirements. User fields enable additional alarm filtering. There are five User Fields. 
To define User Fields: 
1. 1. From the Design menu, select Alarm Properties and then Field Names to open the 
Alarm User Fields dialog box. 
1. 2. Type in the unique User Name opposite the relevant number. 
1. 3. Click OK to confirm. 

 
 

 

 
   
 
 
 
 

Located in the menu bar of the "Application studio" dialog box. 
 
 

 

 
   
 
 
 
 

Design / Options 
Select this item to configure the Application environment parameters.  
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When you select this item, a sub-menu will appear with several additional items for you to 
select from: the Application, Paths, Printers. 

 
 

 
 

   
 
 
 
 

Design Scheduler 
The new generation Internet based Scheduler enables you to easily create daily or weekly 
task orientated schedules remotely. Accessed through an Internet browser or by clicking 
on an icon, the Scheduler is extremely user friendly, efficient and economical. 
Being both task and time orientated the Scheduler can be used to create unlimited tasks, 
actions and states. Tasks can be modified, enabled/disabled and have many states such 
as On/Off attached to them. An unlimited number of actions, which are basic operations, 
can be attached to each task.  
Timetable templates can be created in advance and be attached to a task. Additionally, 
multiple schedules using the same template can be defined, where changes made to one 
template will automatically appear in all the other schedules using the same template. 

 
 

 

 
   
 
 
 
 

Design Tag Filters 
The Tag Filter module is used to filter, view and manage a list of tags and their status 
(locked/unlocked) in the application. This is useful for the development and maintenance of 
an application.  
The Tag Filters List is stored in the application’s TFM.XML filter that is created in the .\docs 
directory (or another appropriate directory of the application). 
When accessed through Java applets the Tag Filters List can be defined/modified/viewed 
in the Image module during runtime. Up to 10 tag filters can be selected simultaneously. 
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Design/Popup/Filter 
  
The Alarm Filter filters alarms and reports before they are printed out or written to the 
Events Summary. Alarm filters are displayed in the Alarm Filters table and defined or 
modified in the Filter Properties dialog box. Filter properties can be updated, however the 
name of a filter cannot be changed.  
The Alarm Filter filters the alarms sent when parameters defined in tag variants are not 
met.  
After alarms and reports outside the defined categories have been filtered out by the 
Alarms Filter, the remaining alarms are sent to the Printers defined in the Printer Targets 
module. 

 
 

 
 

   
 
 
 
 

An Image is a graphical drawing of a plant or facility that can include dynamic and static 
objects. Application images are drawn in layers, whereby each image can consist of one or 
more layers that can be zoomed into, to obtain views of specific plant sections. 
Image are drawn edited, and viewed in image windows, which are invoked by selecting the 
Image item from the Studio Application. 

 
 

 

 
   
 
 
 
 

Image Property 
Use this option to define the Image tuning parameters. 
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Image Property- Fast Zone   
Note: Not applicable on the Web. 
This parameter determines the period of time (in ms) for "slow" zones. A zone is "slow" if it 
has a background that takes more than a given period of time to draw. This parameter 
improves the drawing time for "Goto Zone" operations by using a cache of memory 
bitmaps for drawing the background of slow zones. 
  
If the Fast zone threshold is set to be 2500, that means that the zone is considered to be 
"slow" if its background takes 2500ms or more to draw. 
  
Notes  
After the zone threshold was defined make sure to restart the Application 
It only affects the background of the image, dynamic elements are drawn as before. 
Operate only when NOT is Edit mode. 
  
Maximum fast zone - This parameter determines the limit of the number of fast zones 
bitmaps that can be kept in a single Window's memory cache. When a window reaches 
this limit, the least recently used fast zone bitmap is removed from the cache in order to 
make room for the new bitmaps. 
  
Note After the Max fast zone was defined make sure to restart the Application. 

 
 

 
 

   
 
 
 
 

This parameter determines whether or not trigger objects will be highlighted when you click 
on the object and hold the mouse button down. If you click this option, the trigger objects 
will be outlined (with dashed lines) when they are selected. 
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Determines the size of the internal message buffer that images use to collapse tag/alarm 
notification message received by the application. 

 
 

 

 
   
 
 
 
 

This parameter determines whether or not the mouse pointer will be highlighted when it is 
moved on top of a trigger object in an Image. 

 
 

 

 
   
 
 
 
 

This parameter determines whether or not trigger objects will be highlighted when you click 
on the object and hold the mouse button down. If you click this option, the trigger objects 
will be outlined (with dashed lines) when they are selected. This option is valid while the 
user is editing or working in the Image, it is not valid on the Web 

 
 

 

 
   
 
 
 
 

Image Property - Loading     
Note: Not applicable on the Web. 
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This tab determines the amount of memory available for image objects. It also 
enables/disables tag name parsing when loading images and determines the mode in 
which the image will open.  
Notes:  
Setting the amount of memory available for image objects is not applicable on the Web. 
Always restart the program after updating this tab. 
The following options are available: 
Images memory pool size Enables large images with many objects to be 

created, but allows only 10 (+-) Image windows to 
be open at one time. The lower the value, the more 
Image windows that can be opened simultaneously 
(they must be smaller in size). The value for the 
parameter can be set from 60 to 200. 

Parse each image when loading Enables or disables tag name parsing when loading 
in the Images module. Disable this option to shorten 
image load time for images that contain network 
tags. 
When this option is disabled network tags validity is 
not checked. Therefore, use this option after all tag 
definitions in the network station are complete. 

Open new image in Navigation 
mode 

This checkbox defines that the new image will be 
opened in Navigation mode. 

 
 

 
 

   

 
 
 

 
 

Maximum fast zone - This parameter determines the limit of the number of fast zones 
bitmaps that can be kept in a single Window's memory cache. When a window reaches 
this limit, the least recently used fast zone bitmap is removed from the cache in order to 
make room for the new bitmaps. 
Note After the Max fast zone was defined make sure to restart the application. 
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Image Property - Pictures    
Note: Not applicable on the Web. 
  
The Image properties box allows you to set the location of picture files folder, relative to the 
web application root directory. 
The Pictures folder is located underneath the DOCS directory. (Default). 
  
To access the Events Summary Profiles properties: 
1. From the Containers List select Files Images. 
2. Right-click on the highlighted Images icon and select the Properties option. 
3. The Image Properties dialog appears (as shown below). 
4. The Default folder name Pictures appears in the field. 
5. Press OK or Apply to enter your selection. 
  
You can also access this from the Web Application Properties Pictures tab 

 
 

 
 

   
 
 
 
 

Image Property - Rates    
Note: Not applicable on the Web. 
 
Used to determine the image update performance in milliseconds as well as determine the 
size of the internal message buffer that images use to collapse tag/alarm notification 
message received by the application. 
 
To access the Property dialog box: 
1. Follow the next Path: Studio / Image / Right click the Image Files 
2. Select the Properties option 
3. The Image property dialog box will appear  
 
Image update rate Max/Min Rates: 
These parameters determine the image update performance in milliseconds. 
The default values are: Maximum = 2000 and Minimum= 10.  
Note After those parameters were defined restart the Application. 
 
Message Buffer size: 
Determines the size of the internal message buffer that images use to collapse tag/alarm 
notification message received by the application. When tag values change, an image 
receives message in a buffer from the application and updates graphical objects 
accordingly. 
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The default range is 5 to 500 messages. 
A high value for this parameter improves the performance of images with rapidly changing 
dynamic objects, so that images will not have to make graphical updates for each value 
message. 

 
 

 
 

   

 
 

 
 
 

This parameter enables an image to be repainted automatically, after actions such as 
moving, copying etc., that may leave the image drawn incorrectly. It is useful for small and 
medium sized zones. 

 
 

 

 
   
 
 
 
 

This parameter sets a global stretching or shrinking factor that applies to all images. It is 
needed in order to overcome display differences caused by replacing an operating system, 
a monitor or other hardware devices. This parameter is also used for moving between 
resolution. 
 
Notes 

• It is not recommended to develop an application using a factor other than 1. 
The range of the factor is 0.1<+IMG_RESOLUTION _FACTOR<=10 

• After the resolution level was defined make sure to restart the Application. 
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Image Property - Trigger   
Note: Not applicable on the Web. 
This tab defines trigger objects and onmouseover properties. 
This tab holds the following fields: 
Trigger object Determines whether trigger objects are 

highlighted when selected. If this option 
is checked, trigger objects will be outlined 
(with dashed lines) when they are 
selected. The default option is not 
selected. 

Mouse pointer on triggers Determines whether the mouse pointer 
will be highlighted when it is moved on 
top of a trigger object in an image. The 
default option is not selected. 

Trigger small input box When checked, the input box when 
defining data entry for triggers, will be 
small and and will only have a field for 
entering the value.  

State Determines which trigger object is 
activated when overlapping triggers are 
clicked. This could be either; Top 
(default) or Bottom. 

Note: Always restart the program after updating this tab. 
 
 

 
 

   

 
 
 

 
 

This parameter determines which trigger object is activated when you click overlapping 
trigger objects. The top or the bottom one you can specify Top for top, or Bottom for 
bottom. 
Note After checking this option, make sure to restart the Application. 
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Image Property - View    
Note: Not applicable on the Web. 
This tab is used to define the properties of the Image window, repaint and resolution level. 
The following options are available: 
Image position remains when 
adding/removing toolbars and 
menus 

When this dialogbox is checkbox is checked, Image 
objects do not change position when either the image 
modules attributes (defined in the Image Window 
Attributes dialog box) change 

Repaint images after editing 
operations 

When checked this field defines that an image will be 
repainted automatically after actions that may alter the 
image (such as, moving, copying) are performed. This 
option is useful in small and medium zones. 

Resolution factor Sets global stretching or shrinking factors applicable to all 
images. This is required to solve display differences 
caused by replacing an operating system, monitor or 
other H/W or to move between resolutions. 

Number of gradient color 
steps 

This field determines the number of steps used when 
drawing objects filled with gradient color. The default is 
16. Drawing large gradient surfaces in many steps may 
be slow therefore, develop using few steps and then 
increase for run-time. 

Advanced button Displays the Image Window Attributes dialog box where 
window attributes are defined. 

Note: When changing the Resolution Factor the window remains the same size in 
pixels. However a centimeter in one image will not be a centimeter in another. The 
image remains unchanged when the value is 1. Values greater than 1 expand the 
image.  

o To set correct application values: 
1. 1. Load the image in a PC and measure an object’s length in the image (a line will do). 
1. 2. Load the same image in another PC and measure the same object’s length. 
1. 3. Divide the first length by the second length and the result is the xx.xx value. 
1. 4. Enter the IMG_RESFACTOR with the value you found and reload the application. 
The range is 0.1<=IMG_RESFACTOR<=10. 
0 The default value: 1 
1. 5. Restart the application for changes to take effect. The range of the factor is 
0.1<+IMG_RESOLUTION _FACTOR<=10. 
Setting Image Window Attributes: 
Click the Advanced button in the View tab of the Properties dialog box. 
Note: Image Windows Attributes is not applicable on the Web. 
 
Each listed attribute can be set to On or Off. When confirmed, the selected attributes will 
apply to all future windows of the type specified. The following options are available:  
Title bar The line in the window holding the title. This is relevant only if the Title 



Chapter 21 Image Editor 

921 

bar is active. 

Name in title Title bar text. 

System menu The menu that opens when clicking on the top left corner of a menu. 
The menu options are: Move, Size, Close. 

Min/Max button This option defines whether the min/max buttons will appear in the 
Image window. 

Size Border Specifies that window border size can be changed by clicking and 
dragging. 

Menu Bar Specifies that the menu bar will open in the Images window. 

Always on Top When selected the image is displayed on top of other applications. 

Pos Specifies X and Y coordinate in pixels. 

Size Specifies window size in pixels. 

Title Bar Text Specifies the name appearing in the title bar. 
Notes: 
1. 1. The system menu is title bar dependent. Its corresponding checkbox is unchecked 
and disabled.  
2. 2. If the menu bar is not selected but the system menu is, the menus and items included 
in the Menu bar will appear in the system menu. 

 
 

 
 

   

 
 

 
 
 

This parameter determines the period of time (in ms) for "slow" zones. A zone is "slow" if it 
has a background that takes more than a given period of time to draw. 

 
 

 
 

   

 
 
 

 
 

These parameters determine the image update performance in milliseconds. The default 
values are: Maximum = 2000 and Minimum= 10.  
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Note After these parameters are defined restart the Application. 
 
 

 
 

   
 
 
 
 

Used to determine the amount of memory available for image object. The value for 
the parameter can be from 60 to 200. 

 
 

 

 
   
 
 
 
 

This parameter enables or disables tag name parsing upon loading in Images. Disable this 
option to shorten image load time for images that contain network tags. 
Caution: When this option is disabled, the validity of network tags is not checked. It is 
suggested to use this option after all tag definitions on network station is completed. 
Note After checking this option, make sure to restart the Application. 

 
 

 

 
   
 
 
 
 

This parameter enables or disables tag name parsing upon loading in Images. Disable this 
option to shorten image load time for images that contain network tags. 
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The value for the parameter can be set from 60 to 200. 
The default enables large images with many objects to be created but allows only about 10 
image files to be open at one time. The lower the value, the more image files can be open 
simultaneously, but they must be smaller in size.  

 
 

 

 
   
 
 
 
 

This parameter enables an image to be repainted automatically after actions such as 
moving, copying etc. 

 
 

 

 
   
 
 
 
 

This parameter sets a global stretching or shrinking factor which applies to all 
images. 

 
 

 

 
   
 
 
 
 

Active Layer 
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Select the active layer item to designate the active layer for which all subsequent editing 
operations will be performed.  

 
 

 
 

   

 
 

 
 
 

Click to add your button definition to the list. 
 
 

 
 

   

 
 
 

 
 

Action Definition   
Click the Action button in the Trigger Object Definition dialog box. The Action Definition 
dialog box is displayed. 

1. In the Formula field you can use any of the following formats: 

@tag op val 

val op @tag 

val 

@tag 
Where @ alone is the current tag, tag is the name of any tag, op is any valid 
operator including operators +,-, /, *, % (percent denotes modulus, as in C 
programming language), &, |, or ^ (bitwise AND, inclusive OR and exclusive OR). 
Val is any numerical value. 

2. Either a Zone or Zone Navigator can be added. Do either: 

• Check the Zone checkbox and then in the Zone field click the 
arrow and select the relevant zone or, type in the relevant 
zone. 

Or, 
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• Check the Zone Navigator checkbox and then in the Zone 
Navigator field click the Browse button. The Zone Navigator 
dialog box opens. Select the relevant Zone Navigator and 
click OK to save and return to the Action Definition dialog 
box. 

3. To add a macro, click the Macro field and select the relevant 
macro.  

4. Click OK to confirm your definitions and to exit this dialog 
box. 

Note: If more than one operation is assigned in this dialog box, the 
operations will be performed in the following order: goto zone, tag 
assignment, run macro. If one of the operations fails, the next operation 
will not be executed. 

 
 

 
 

   

 
 

 
 
 

Alarm Object Definition   
 
To define an object as an alarm object 
Select an object in the image and activate the Alarms object button from the Object Bar  
 
OR 
Select Edit / Operations / Alarm 
 
OR 
Right click an object and selecting the Alarm definition option. 
 
To define an object as an alarm object: 
Select an object in the Image and activate the Alarms object button in the toolbox. The 
Alarm Object Definition dialog box is displayed. The following options are available: 
Station  The network station to which the alarm belongs. For a list of defined stations click 
on the arrow to the right of the field. 
Alarm Family The family of alarms to be associated with the object. The name you specify 
must be the name of a family of alarms that was, or will be, defined in the system. (You can 
specify the name of an alarm family that was not yet defined in the Alarm Definition 
module. Although, at some point, it must be defined.) 
 For a list of defined alarm families click the arrow to the right of the field. You can also use 
a ? and a * wildcard to enable you to quickly define family filters. 
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Show Object When  Select Always to cause the object to appear in the Image constantly. 
If you select this option, you must also select an Animation. 
 Select Alarm Family Active to cause the object to appear in the Image only when the 
alarm condition is true. 
 Select Alarm Family not Active to cause the object to appear in the Image only when the 
alarm condition is false. If you select this option, both the Animation and Trigger Function 
fields will be disabled. 
Animation The following options are available: 
Blink Activate to define the blink parameters for the object. The Image Alarm Blink dialog 
box is displayed.   
Fill Color Activate to define the color display of the object. The Image Alarm - Color dialog 
box is displayed. Select the alarm status option you want and the color to be associated 
with that status. Active alarms can be either; Started (unacked, unended), Acked (and 
unended), or Ended (but unacked). For example, you can define the object to be red when 
the alarm is started, green when it is acked, and its default color when it is ended 
Line " >Trigger Function Select Acknowledge to cause the alarm associated with the 
object to be acknowledged whenever the object is selected in the Trigger mode. 
 Select Acknowledge with confirm to prompt the operator before acknowledging the alarm. 
 Select Assist to cause the help file of the alarm associated with the object to appear 
whenever you select the object in the Image. 
 Select Assist + Ack button to cause the help file of the alarm to appear with an additional 
acknowledge button. For more information about alarm help files, see the Event 
Summaries chapter. 
 Select None for no trigger function. 
 If the No Alarm option is selected in the Show Object When field, the Trigger Function field 
will be disabled. 

Notes for Animation  

1. This note applies to all the Animation dialog boxes: These dialog 
boxes have the following states: Started, Acked, Ended. If User 
Defined States are defined (and enabled in the Alarm/Tag 
properties dialog box) then they will also appear here. Any State 
Name can be defined for User Defined States. However if no 
State Name is defined then the default State 1 and State 2 are 
used.  

2. More than one animation option can be applied for each alarm 
object. 

3. If the No Alarm option is selected in the Show Object When field, 
the Animation field will be disabled. 

4. A selected Animation option is indicated by a small arrow that 
appears beside the button label. 

5. If more than one alarm is active in an alarm family, the status of 
the alarm in order of severity will be as follows: Started, Ended, 
Acked. In the Trigger mode, 

If the Acknowledge option is selected in the Trigger Function field, and 
you click on the object to acknowledge the alarm, all the alarm instances 
will be acknowledged. 

Notes for Trigger 
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1. If an object was already defined as an alarm object, and you 
invoke the Alarm Object dialog box for that object, the dialog box 
will appear with the options you selected. If you change the 
definition (select different options) and then activate the OK 
button, the new definition will replace the previous definition. 

2. Several objects can be selected together in the Image for alarm 
object definition. If an object within the group you selected was 
already defined as an alarm object, the group definition will 
replace the single object’s definition. 

 
 

 
 

   

 
 

 
 
 

Arc Tool    
To draw an arc 
1. From the Drawings toolbar, click on the arc tool. 
2. Position the mouse pointer where you want to start drawing. 
3. Drag to end point. 
4. Release mouse button. 
5. Move the mouse to the desired radius point and left-click the mouse button. 
Note: Arcs are not supported on the Web. 

 
 

 
 

   

 
 
 

 
 

The button size can be set by pressing the arrow keys, PgUp and PgDn keys (for scaled 
uniform movement), and the Home key (to restore the default shape).  
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Cancel Override Color   
The Cancel Override Color option enables you to return to the original or default colors you 
chose for your objects, after modification. 
To cancel override color 
1. Draw the objects with your choice of colors and Group them. 
2. Modify your objects colors. 
3. If you wish to return to the original color selection click on the Operations Menu Cancel 
Override Color and your objects keep their original colors. 

 
 

 
 

   

 
 
 

 
 

Click to override the selected button in the list with the current definition. 
 
 

 
 

   
 
 
 
 

Changing Color   
The Change Color operation allows you to select a different color for your drawing objects. 
To Change Color 
1. Select the drawing tool of your choice. 
2. From the Color select a color. 
3. Highlight your drawing object. 
4. From the Edit menu click Operations, then click on the Change color option. The object 
is drawn with the selected color. 
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CloseChart 
Selecting this Fast Action opens the Define Trigger dialog box enabling you to browse and 
select the chart (*.chr) file you want to close upon activating the CloseChart trigger. 

 
 

 

 
   
 
 
 
 

CloseEventSummary 
Selecting this Fast Action opens the Define Trigger dialog box enabling you to browse and 
select the Events Summary (*.ann) file you want to close upon activating the 
CloseEventSummary trigger. 

 
 

 
 

   

 
 
 

 
 

CloseImage 
Selecting this Fast Action opens the Define Trigger dialog box enabling you to browse and 
select the image (*.vim) file you want to close upon activating the CloseImage trigger. 
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Cluster - Drag&Drop 
 
Click the right mouse button on the object you want to instantiate, and drag the object to 
the desired location in the image. 

Note: In addition to each object in the library, the numbers indicate the 
amount of required objects that you specify in the Basket Maintenance 
dialog box and the amount of objects you already instantiated in the 
Image. 

 
 

 
 

   

 
 
 

 
 

Defining the Cluster Basket 
This dialog box is used for maintaining the cluster basket in your system.  
To maintain / define a basket  
1. Select Basket Maintenance from the Clusters Menu. 
 The Basket Maintenance dialog box opens. 
2. Enter the name of the item as you want it to appear in the basket library. 
3. Type the library name from which you want to extract the cluster, or select a library from 
the drop-down list. 
4. Enter the name of the cluster as it appears in the library you specify, or select an object 
from the drop-down list. 
5. In the Required field, Specify the amount of times the cluster object will be available in 
the basket library  
6. In the Used field, the value is usually 0 (if you do not fill this field, the default value is 
also 0). This indicates that the first cluster object in the basket library will be number 0. 
7. Click the Add button to add the current cluster definition to the basket library. 
To modify a cluster definition in the basket library 
1. Select the cluster you want to modify. 
2. Modify the cluster's parameters as applicable. 
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3. Click the Change button. 
To remove a cluster from the basket library 
1. Select the cluster you want to remove. 
2. Click the Delete button. 

 
 

 
 

   

 
 

 
 
 

Cluster Define (Simple Object) 
   

Select the graphic object in the image that you want to include in the cluster and then 
either:  
From the Clusters menu select Define. 
Or,  
Click the Cluster Definition icon from the Objects toolbox. 
Or,  
Right-click and select Cluster Definition from the popup menu.  
If no tags or alarms are associated with the graphic objects that are selected in the image 
(the object was not defined as a dynamic, trigger, or alarm object), the Define Cluster 
Object dialog box is displayed. 
The following options are available: 
Name Specifies the name of the cluster (up to 15 characters). 
Lib Specifies the name of the library in which the cluster will be placed. To select from 
existing libraries, click on the arrow to the right of the field. 
Description Specifies a brief description of the cluster (up to 40 characters). 
Add new library to the Cluster folder check this checkbox to add the newly created 
library to the global Cluster folder (this will enable other applications to use the new library 
you create). 

Note: These fields and buttons appear in the dialog box only if the object 
is defined as a dynamic, trigger, or alarm object. 

 
The Clusters Menu  

 
 

 
 

   



Chapter 21 Image Editor 

932 

 
 
 
 
 

Cluster / Rebuild Instance 
One of the big advantages of using clusters is the ability to rebuild all instances 
automatically after updating the original cluster in the library.  

1. Select Rebuild Instances from the Clusters men to open the 
Rebuild Cluster Instances dialog box: In the list, you can see 
all the instances that were placed in the current Image. Each 
line contains the library name, the cluster name, and how 
many instances of that object were placed.  

2. Select the items you want to update (note that the list box has 
multiple selections, and therefore, you can select more than 
one line in the list), and press the Rebuild button. 

Notes: 

1. The tags and alarms that were associated with each instance will 
remain unchanged. 

2. The Rebuild operation will fail if there is no compatibility between 
the cluster in the library, and the instances in the Image. 
Compatibility means that the tags, alarms and triggers must have 
the same links. For example you cannot redefine an object that 
was linked to one tag to be connected to two tags. 

3. You can select all items in the list by pressing <CTRL></> keys. 
 
The Clusters Menu  

 
 

 
 

   

 
 
 

 
 

Clusters / Open Basket    
This option displays the clusters defined in a basket. On the right of the cluster the number 
of times that the cluster has been used and maximum usage are displayed.  
 
The Clusters Menu 
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A cluster is an object class with all its behavior, including parameters, the graphical shape 
and tag and alarm functions.  

 
 

 

 
   
 
 
 
 

Clusters Basket Maintenance 
A Basket is a special tool that supplies a new (high) level of engineering and application 
design. It is used to make a prototype of the application before starting to actually 
implement it, and also to trace the progress of the application development. You can think 
of it as a shopping list, you can specify in the basket the components you need to include 
in your application 
To define the application basket, select the Basket Maintenance item from the Clusters 
menu in the image window. 
The Clusters Menu 

 
 

 
 

   

 
 
 

 
 

Breaking Clusters   
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Cluster definitions can be cancelled by selecting a cluster object in the Image, and then 
selecting Break from the Clusters menu. 
To cancel a Cluster definition: 
1. Select a cluster object in the image. 
2. Select Break from the Clusters menu. 

Note: Instances cannot be defined as dynamic, trigger, or as another 
cluster (no nesting of clusters), unless they are broken apart. 

The Clusters Menu 
 
 

 
 

   

 
 

 
 
 

Clusters / Define    
This option will enable you to define a cluster. 
Cluster definition is enabled in two modes: 
Simple - If no tags or alarms are associated with the graphic objects that are selected in 
the image (meaning that the object was not defined as a dynamic, trigger, or alarm object). 
Dynamic - If the object you have selected is associated with tags or alarms (the object was 
defined as a dynamic or trigger object). 
To define a Cluster and add it to a library 
1. Select the graphic objects in the image that you want to include in the cluster. 
2. Select Define from the Clusters menu. The Define Cluster Object dialog box is 
displayed. 
The Clusters Menu  

 
 

 
 

   

 
 
 

 
 

Clusters / Open Lib   
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To instantiate a cluster from a library to the application, select the Open Lib item. This 
option will enable you to open a library. 
 
To instantiate a cluster from a library to the application 
1. Select the Open Lib item from the Clusters menu in the image window 
2. Specify the library from which you want to instantiate a cluster in the Drag and Drop to 
Img window. 
Clusters Menu 
 

 
 

 
 

   

 
 

 
 
 

Copy To Clipboard 
The application enables you to use the Clipboard as a convenient way to transfer graphic 
objects from the application to external application and vice versa. 
There are two ways to copy an object to the Clipboard  
Through the Edit Menu  
1. Select an object 
2. Select the Copy to Clipboard item from the Edit menu 
3. As a result the object will be copy to the clipboard for later use. 
Through the Pop-Up Menu 
1. Right click an object in the Image window 
2. From the Pop-up Menu select the Copy to clipboard. The Copy to Clipboard operation 
will copy a selected object(s) in many formats.  
Note: Copying objects using <Ctrl C> does not support the Undo feature.  

 
 

 
 

   

 
 
 

 
 

Custom Actions 
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You can use this dialog box to send a command to one or several programs external to the 
application. You can choose a set of parameters to send to the programs. 
These programs will be called via a right-click on the object during runtime. If there are 
several programs defined, a drop-down menu will allow you to choose which program to 
call. If there is only a single program, you can choose to launch it directly after a right-click. 
 
You can create the programs in the following way: 
 
For each program that you want to call, you must give it a Title (this is the name that will 
appear when you do the right-click). 
 
The "Command" is the actual program that will be launched. Use the button "…" to help 
you to find it if you need to. 
 
For each program you can send a set of parameters: A User-defined string (type the string 
in the text box below the list of parameters), the tag names of all the tags associated with 
the object and the position on the screen of each of the associated tags (the position is 
measured in image coordinates). 
 
The format of the string that is sent to the program is the following (remember that they can 
be in any order): 
 
Application.exe –tagnames:TAGNAME1,TAGNAME2,TAGNAME3 –coords:X,Y <userstr> 
 
Note that there are no spaces between the tag names, and that the user-defined string 
(userstr) is a free-form string. The only thing to notice is that there is a space between the 
string and any of the other parameters.  
 
You can add the parameters in any order you like. Use the up and down buttons to change 
the order of the parameters.  
 
For each program, use the "Add" button to add it to the list. You can "Modify" each 
program, or remove it from the list. 
 
As for the parameters, use the up and down buttons to change the order in which they will 
appear in the drop-down menu following a right-click on the object. 
 
If only one program is defined for the object, use the "Start action without displaying menu" 
option to launch the program without the drop-down menu appearing. 

 
 

 
 

   

 
 
 

 
 

Define Instance Links 
If the cluster is defined with the Define each Object when Instantiating option, the Define 
Instance Links dialog box opens: 
The following options are available: 
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Instance Name The unique name of the instance in the image. 
Linked Tags and Alarms This listbox contains a list of all the tags and alarms associated 
with the object(s) in the cluster, and the operation defined for each. 
Tags/Alarms Activate these buttons to change the original definitions of the tags and 
alarms associated with the objects in the cluster. The tag and alarm definitions that you 
specify will be used to generate new tags and alarms for the cluster in the Image.  
Find Activate this button to search for a tag or alarm in the Linked Tags and Alarms listbox. 
In the entry field, you can specify the full name of the tag or alarm, or a name prefix. 

 
 

 
 

   

 
 

 
 
 

Defining Tooltips 
 
This dialog box will allow you to assign tooltips to objects in the image. You can define the 
tooltips while developing the application, but they will only be activated during runtime. 
The following options are available and you can choose any combination of the options. 
 
You can choose to display either the tag name, tag description, its address or a text string 
of your own choosing.  
 
Note that if you have several tags associated with a single object, you will see these 
options for each tag attached to the object. 

 
 

 
 

   

 
 
 

 
 

Defining Zones    
A Zone is a pre-defined position and zoom level in the image that can be jumped to, by 
selecting the Goto Zone item in the Options menu.  
 

o How to define a Zone? 
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1. Select Zones Definition item from the Options menu. The Zone Definition dialog box 
opens.  
2. Type a unique name for the zone in the Name box. 
3. Enter the X and Y coordinates, in drawing units, to define the zone center in the image 
window.  
4. Enter a scale level between 1 and 2048. 
5. Select the Control tag checkbox if you want to use a digital tag to indicate the zone 
status.  
 At run-time, if the digital tag value is 1, the zone status will be BAD; if set to 0, the zone 
status will be GOOD. 
 Station - Select the station from which you want to select a tag. 
 Tag - select the tag you want to use from the drop-down menu, or click the browse button 
to open the Tag Definition dialog box. 
6. Choose a Context through ‘Context Name’ combo box that will be applied to objects that 
use tag template Ids. This context is optional. You do not have to select it if you do not 
need one 
7. Click the Add button to add the zone. The new zone is displayed in the list. 
8. Click Save to save the zone definition and exit the dialog box. 
 

o To modify a defined Zone parameters: 
1. Select (click) the zone you wish to modify. 
2. Change the selected zone parameters in the various dialog box fields, as applicable. 
3. Click the Change button. The zone properties displayed in the list of zones are modified. 
 

o To remove a zone: 
1. Select (click) the zone you wish to remove. 
2. Click the Delete button. 
 

 
 

 
 

   

 
 
 

 
 

Click to remove the selected button from the list. 
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Deselect All 
Select this option to deselect all the objects in the window.  

 
 

 
 

   

 
 
 

 
 

Deleting Objects    
The Delete operation enables you to remove the selected objects from an Image. 
To delete an object 
1. Select one or more objects. 
2. Select the Delete option from the Operations Menu and the object is removed from the 
Image. Or Click the left mouse button on the Delete tool in the Operations toolbar. Or 
Press the Delete key on the keyboard. 

 
 

 
 

   

 
 

 
 
 

Deselect Last 
Select this option to deselect the last object that was selected in the window.  

 
 

 
 

   



Chapter 21 Image Editor 

940 

 
 
 
 
 

Drag&Drop to Img 
This menu option is used to insert an image from an existing Cluster Library into an image. 

Note: This window is modeless (meaning that you can perform other 
application or operating system functions while this window appears on 
the screen). In addition, the library window can be resized to adjust its 
height. 

1. Specify the library from which you want to instantiate a 
cluster. To open a list of existing libraries, click on the arrow 
to the right of the Library field. Double click on a specific 
cluster to open an information box where the library to which 
the cluster belongs and further information regarding the 
cluster is listed. 

2. Select the cluster and instantiate it in the image by right 
clicking on the object and dragging it to the required location 
in the image.  

3. After placing a cluster from a library into an image, the 
application enables you to determine parameters that are 
used to generate the instance characteristics. If the cluster is 
not defined with the Define each Object when Instantiating 
option, the Instance Parameters dialog box opens. Click the 
Browse button to locate the tag you want to associate with 
the instance parameters. 

Note: If the cluster contains $ASK variables, this dialog includes the 
$ASK Parameter field in which you can specify additional user data. 

The Clusters Menu 
 
 

 
 

   

 
 
 

 
 

Edit / Drawings  
The Drawings sub-menu enables you to draw and add text in your Image by using the 
Polyline, Box, Circle , Pipe, Text and Pick color tools. 
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The Drawings sub-menu also includes the Widget option. The Widget option holds the 
Slider, Media Player and Scheduler options. The Drawings Menu also includes the 
Button to enable the application to contain a trigger object that has the same look and feel 
as a Windows button 
See also the Drawing toolbar 

 
 

 
 

   

 
 

 
 
 

Edit / Align 
Select the Align option to display a sub-menu where you can choose how to align an object 
with another object(s).  
In addition, the Align sub-menu enables you to resize objects horizontally, vertically or 
both. 
You can also align objects by using the Align toolbar. 
The Align options are as follows: 
Left Aligns objects by their left edges. 
Right Aligns objects by their right edges. 
Top Aligns objects by their tops. 
Bottom Aligns objects by their bottoms. 
Center Horiz. Aligns objects by their middles horizontally. 
Center Vert. Aligns objects by their centers vertically. 
Center Both Aligns object both horizontally and vertically. 
Resize Horiz. Selected objects can be resized to the same width. 
Resize Vert. Selected objects can be resized to the same height. 
Resize Both Selected objects can be resized both to the same width and height. 
Even Spacing Horiz. Spaces between selected objects lined horizontally will be equal. 
Even Spacing Vert. Spaces between selected objects lined vertically will be equal. 

Note: The Align feature does not support the Undo option. 
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Drawing in the Image    
You can design, draw or modify your application by selecting the appropriate tools in the 
Image. The Drawings toolbar contains simple drawing objects such as Line, Pipe, Box, 
Text and Circle. You can draw both filled and unfilled objects. You can also assign text to 
your image by using the text tool. 
Drawing shapes 
1. From the Shape tools select a drawing tool. 
2. In the Image area press and hold down the left mouse button. 
3. Start drawing by moving the mouse around, the shape outline you selected is being 
drawn as you move. 
4. Finish drawing by releasing the mouse. 
Notes: 

1. After drawing you remain in the selected tool; note that the object is not selected.  
2. To change colors of selected object select new color in the color toolbar. 
3. Clicking the right mouse button sets the object automatically to select mode and 

cancels the continuity of the last operation. 
4. Double-click on Object toolbar as Trigger, Alarm, Slider, Media or, Dynamic open 

its definition dialog. 
Object Selection/Deselection 
Choose the Selection Tool to select any object (for size or move operations). 

1. To select several objects, start from an empty point in the Image, press and hold 
left mouse button, drag a rectangle around the objects you wish to select. 

2. You add an object to existing selection by left-clicking the mouse while holding 
down the Shift key. 

3. Deselect objects by pressing left mouse button on empty space of Image. 
4. To deselect last used menu item Edit Select Deselect last. 
5. Clicking the right mouse button sets the object automatically to select mode and 

cancels the move operation. 
Aligning Objects 
Whenever you select more than one object, one of the selected objects is marked with 8 
hollow handles. These handles cannot be used to move or resize the object, their sole 
purpose is to mark the object. 
The marked object is the first object selected. Whenever you use an alignment tool (any of 
the 10 alignment tools), all objects are aligned or resized according to the position or size 
of the marked object. 
To make another object the marked or first object 
1. Deselect all (through the menu or by clicking an empty spot) 
2. Select the desired object, by clicking it.  
3. Add the other objects to the selection by holding the shift key pressed while selecting. 
This works with both single select (click) and multi-select (drag). 
Moving/Scaling 

1. Scale by selection of object and handles 
2. To move an object press left mouse button down on object and drag 
3. To copy object move/scale it with Ctrl key pressed. 

Object Sensitive Menus 
1. Press the right mouse button on any object in the Image. The object is selected 

and a pop up menu appears. 
2. For general Image menu click in empty space in the Image. The pop up menu 

deselects previously selected objects. 
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Edit / Find    
Using the find option you can find and Goto an object that matches the search text. This 
feature is available in Edit mode only. The Find command opens the Find Dialog box while 
the Find next searches for the next occurrence of the last search string. 
For more information about the Image Find capabilities refer to Image Find Option 

 
 

 
 

   

 
 
 

 
 

Edit / Find Next 
The Find command opens the Find Dialog box while the Find next searches for the next 
occurrence of the last search string. 
For more information about the Image Find capabilities refer to Image Find Option 

 
 

 
 

   

 
 

 
 
 

Line Types 
The application enables you to define lines with different widths and types for objects that 
include lines as part of their shape. This option is available for all objects, except text and 
pipes.  
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The application provides the Line type button on the Image toolbar, to quickly access this 
option. 
The following line widths are supported: 1, 2, 4, 6, 8 and 10 pixels. 
The following line types are supported:  
Solid lines 
Dashed lines 
Dotted lines  
Alternating dashed and dotted lines 
Alternating dashed and double-dotted lines 
 
To specify the line width/type 
1. Select the line you want to modify. 
2. Select the Line type button on the Image toolbar, or select LineStyle from the Edit menu 
to display a dropdown menu from which you can select the required line width/type. 
 

 
 

 
 

   

 
 

 
 
 

Edit / Operations 
Use the Operations menu command to perform editing and animation operations on your 
Image. 
The Operations menu includes various commands that enable you to change the position 
and dimensions of objects by using the move, rotate, scale and delete options.  
You can modify the object's attributes by using the change color, fill, toggle fill, segment. 
You can also send an object back or forward by using the back to front and send to back 
tools. 
In addition, the Operations menu command allows you to animate your Image by using the 
trigger tool, Dynamic Trigger definition, alarm and alarm definition. 
 
The Operations sub-menu consists of the following options: 
Move  
Rotate 
Copy/AttributesHLP_WZ2EDT_CPYATTR  
Delete  
Bring to Front 
Send to BackHLP_WZ2EDT_OPERATIONS_SENT_BACK 
Change ColorHLP_WZ2EDT_MODIFY 
Cancel Override ColorHLP_WZ2EDT_OPERATIONS_CANCEL_OVERCOLOR 
Toggle FillHLP_WZ2EDT_FILL 
Cancel Override PatternHLP_WZ2EDT_OPERATIONS_CANCEL_OVERPATTERN 
GroupHLP_WZ2EDT_SEGMENT 
UngroupHLP_WZ2EDT_SEGMENT 
TriggerHLP_DLG_WZ2_GINDEF 
Remove TriggerHLP_WZ2EDT_OPERATIONS_REMOVE_TRIGGER 
DynamicHLP_DLG_WZ2_DYN 
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Cancel DynamicHLP_WZ2EDT_OPERATIONS_CANCEL_DYNAMIC 
AlarmHLP_DLG_WZ2_ALT 
Remove AlarmHLP_WZ2EDT_OPERATIONS_REMOVE_ALERT 

 
 

 
 

   

 
 

 
 
 

Edit / Select 
Use this option to select or deselect objects within the image. 
You can choose to: 
Select - select an object. 
Deslect Last - deselect the last selected object. 
Deselct All - deselect all selected objects. 

 
 

 
 

   

 
 
 

 
 

Edit Properties 
Select Edit Properties in the Edit menu, or select an object and then right click to open a 
pop up menu and select Edit Properties.  
This dialog box has the following options: 
Objects List This section displays a tree of the object according to hierarchy. 
Object Properties This section shows the object selected from the Objects List. 
Definition  This button when clicked is used to modify dynamic tag parameters and is only 
available for objects such as button, alarm or text. It is not available that are defined as 
basic objects. 
Attributes This button when clicked is used to modify an objects color line and color fill. 
Trigger This button when clicked opens the Trigger Definition dialog box. 
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Edit / Set Background Color   
The Set Image Background feature enables you to set the image background color. 
To set the Background color 
1. Go to Image menu, select the Edit Option and there the Set Background color. 
2. Select a color, press OK and the background of your image will display the color you 
chose.  
OR 
Press the Set Background Color Icon from the Image main menu. 

 
 

 
 

   

 
 
 

 
 

Edit/Get Colors and Save Colors 
The application enables you to get colors, i.e., import a color palette, or save colors, which 
means saving the colors you defined in your image file. 
The *. pal file contains the 16 toolbox colors as well as the additional 16 custom colors 
from the color dialog box. Once you define or customize your colors you can save them in 
a *.pal file. To retrieve or get the colors you have saved, use the Get Colors option. 
To retrieve colors from a saved color palette 
Select Get Colors from the Edit menu. 
The Open dialog box opens, where you can select the colors from a *.pal file. 
To save a color palette 
Select Save Colors from the Edit menu. 
The Save As dialog box opens, where you can save your colors to a *.pal file. 

Note: If the image file name and *.pal file name are the same, the *.pal 
file is loaded automatically. The user can continue to work with his 
customized palette every time he opens an image. 
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Fast Actions  
Note: Fast actions are Web enabled. 
   
Fast Actions are pre-defined macros, that you can attach to a trigger, enabling you to 
easily execute routine operations.  
 
To define Fast Action triggers: 
1. Click the Fast Action button on the Trigger Object Definition dialog box. The List of 
available Fast Actions dialog box is displayed. 
2. Select the Fast Action you want to attach to the trigger: 
CloseActiveImage  used to close the opened Image file. 
CloseChart  used to close a specified Chart file. 
CloseEventSummary  used to close a specified Events Summary.  
CloseImage  used to close a specified Image file. 
GotoUrl after this trigger option is defined for an Image object when the object is clicked it 
will jump to the defined URL.* 
LoadAnnFile  used to open a specified Events Summary Profile file or an Event Summary 
file. * 
LoadHtmlPage  used to load a specified HTML page. * 
LoadImage  used to open a specified Image file, window and zone. 
LoadPictureFile  used to open a specified image window. * 
LoadRecipe   used to load the recipe to apply its tag values to the image 
LoadTrendFile  used to open a specified trend file. * 
LockTagsValues used to open the Tag Value Lock window where you can lock / unlock 
tags and change the locked tags definitions. 
OpenScheduler  used to jump from the Image to the Internet Scheduler 
SaveRecipe  used to save the recipe tag values to the image 
Change Tag Context used to change the context of the current window 
LoadLayout load the selected layout and apply the selected context to each the windows 
LoadHistory load the history viewer with the selected context 
CloseHistory close the selected history viewer 
 
 
 
3. Click OK to define the selected Fast Action parameter.  
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Note: * indicates that when Load in the same window (Web only) is checked a new page in 
the Explorer is not opened, however the current page is changed to the selected one.ck 
OK to define the selected Fast Action Parameters. 

 
 

 
 

   

 
 

 
 
 

File / Exit    
Select this item to close the current window.  
If you made changes to the image, but did not save the file, you will be prompted to either 
save the changes you made or discard them. 

 
 

 
 

   

 
 
 

 
 

Import   
You can import or load an Image file that has been saved as ASCII file into the Image 
Window. 
This file can then be viewed and edited. 
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File / Insert    
The Insert file option allows you to insert an existing Image file, into an existing Image 
Window. 

 
 

 
 

   

 
 

 
 
 

File / Print    
Select this item to print the current view. 

 
 

 
 

   

 
 
 

 
 

File / Save   
Select this item to save the current image and window settings (position, mode etc.) 
Selecting the Save option opens the Save As dialog box, prompting you to specify a file 
name. The dialog box displays the image files default folder and default image files 
extension (*.VIM). 
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File / Save as   
Select this item to save the current image window file under a new file type:VIM, ASCII, 
BITMAP 

 
 

 
 

   

 
 

 
 
 

The Image File Menu 
The Image File menu provides the user with the basic operations of the Image window: 
File / Save Select this item to save the current image window file with its original name.  
File / Save as Select this item to save the current image window file with a new name.  
File/InsertThe Insert file option allows you to insert an existing Image File, into an existing 
Image Window. 
File/Import You can import or load an Image file that has been saved as ASCII file into the 
Image Window. This file can then be viewed and edited. 
File/Attach to The File Attach to menu allows you to attach an Image (*.VIM) to an existing 
Window. This replaces the Image inside the Window. The VIM file is modified to reflects 
this change. Common Open Dialog lets you select the Attach VIM (actually the Image is 
what is attached).  
File/Print Select this item to print the current view. 
File/Exit Select this item to close the current window.  
If you made changes to the image, but did not save the file, you will be prompted to either 
save the changes you made or discard them.  

 
 

 
 

   

 
 

 
 
 

File / Attach to    
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The File Attach to menu allows you to attach an Image (*.VIM) to an existing Window. 
This replaces the Image inside the Window. The VIM file is modified to reflects this change. 
The Common Open dialog box enables you to select the Attach VIM (the Image). The 
Image title changes to something like attached to c:\APPLIC\APPL\2.VIM. 

 
 

 
 

   

 
 

 
 
 

Filled Circle Tool    
To draw a filled circle 
1.From the Drawings Toolbar, click on the circle tool  
2.Position the mouse pointer where you want to start drawing. 
3.Drag to form the circle. 
4.Release mouse button. 

 
 

 
 

   

 
 
 

 
 

Filled Ellipse Tool   
To draw a filled ellipse 
1. From the Drawings toolbar, click on the ellipse tool.  
2. Position the mouse pointer where you want to start drawing. 
3. Drag to form the ellipse. 
4. Release mouse button. 
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Filled Orthogonal Polygon Tool   
To draw a filled orthogonal polygon 
1. From the Drawing Toolbar, click on the closed filled orthogonal polygon tool  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right button and the last point will automatically be connected to the start point, 
closing the polygon. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 

 
 

 
 

   

 
 

 
 
 

Filled Polygon Tool    
To draw a filled polygon 
1. From the Drawings toolbar, click on the filled polygon tool.  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right button and the last point will automatically be connected to the start point, 
closing the polygon. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 
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Filled Closed Arc Tool   
To draw a filled closed arc 
1. From the Drawings toolbar, click on the filled closed arc tool  
2. Position the mouse pointer where you want to start drawing. 
3. Drag to end point. 
4. Release mouse button. 
5. Move the mouse to the desired radius point and left-click the mouse button. 

 
 

 
 

   

 
 
 

 
 

Filled Round-cornered Rectangle or Square Tool   
To draw a filled round-cornered rectangle or square 
1. From the Drawings toolbar, click the round filled round-cornered rectangle tool.  
2. Position the mouse pointer where you want to start drawing. 
3. Drag diagonally. 
4. Release mouse button. 
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Find 
Find and go to an object that matches the next search. 

 
 

 
 

   

 
 

 
 
 

Options / Styles Definition   
This dialog box is used to define font styles for the image text.  
To define a new style 
1. Select Styles Definition from the Options menu of the Image Window. The Styles 
Definition dialog box opens 
2. Click the Add button to open the Style Properties dialog box where you can define the 
new style properties. 
3. Click the Close button when done. 
To change the definition of an existing style 
1. Select a style from the list 
2. Click the Properties button. The Style Properties dialog box opens. 
3. Change the style attributes: size and effect and activate the OK button. 
To Remove a style 
1. Select a style from the list 
2. Click the Remove button. 
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Filled Rectangle or Square    
To draw a filled rectangle or square 
1. From the Drawings toolbar, click the filled rectangle tool.  
2. Position the mouse pointer where you want to start drawing. 
3. Drag diagonally. 
4. Release mouse button. 

 
 

 
 

   

 
 

 
 
 

Style Properties    
Use this dialog to define a new style or edit an existing style. 
To define a new style: 
1. Select the Styles Definition option from the Options Menu.  
2. Click the Add button. The Style Properties dialog box opens. 
3. Type the style name in the Style name field. 
4. Select the font from the Font list. 
5. Define the font attributes: size and effects (bold, italic, underline, strikethrough). 
6. Click OK to save your changes and return to the Font Styles Definition dialog box.  
The new style you defined now appears in the list of styles. 

Note that on the Web only Bold and Italic effects apply. The dialog box 
opens with Underlined and Strikethrough disabled. 

 
 

 
 

   

 
 
 

 
 

Edit / Get Colors and Save Colors    
The application enables you to get colors, i.e., import a color palette, or save colors, which 
means saving the colors you defined in your image file. 
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The *. pal file contains the 16 toolbox colors as well as the additional 16 custom colors 
from the color dialog box. Once you define or customize your colors you can save them in 
a *.pal file. To retrieve or get the colors you have saved, use the Get Colors option. 
To retrieve colors from a saved color palette 
Select Get Colors from the Edit menu. The Open dialog box opens, where you can select 
the colors from a *.pal file. 
To save a color palette 
Select Save Colors from the Edit menu. The Save As dialog box opens, where you can 
save your colors to a *.pal file. 

Note: If the image file name and *.pal file name are the same, the *.pal 
file is loaded automatically. The user can continue to work with his 
customized palette every time he opens an image. 

 
 

 
 

   

 
 

 
 
 

GoTo Zone 
The Goto Zone dialog box enables you to easily jump to any of the zones you defined. 

 
 

 
 

   

 
 
 

 
 

Gradient Styles 
 

 

Line left to right 

 

Line right to left 

 

Line top to bottom 
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Line bottom to top 

 

Line left-top to right-bottom 

 

Line left-bottom to right-top 

 

Line right-top to left-bottom 

 

Line right-bottom to left-top 

 

Line2 left and right to center 

 

Line2 center to left and right 

 

Line2 top and bottom to center 

 

Line2 center to top and bottom 

 

Line2 left-top and right-bottom to center 

 

Line2 center to left-top and right-bottom 

 

Line2 right-top and left-bottom to center 

 

Line2 center to right-top and left-bottom 

 

Angle to left-top 

 

Angle to left-bottom 

 

Angle to right-top 

 

Angle to right-bottom 

 

Angle from left-top 

 

Angle from left-bottom 

 

Angle from right-top 

 

Angle from right-bottom  
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Rectangle to center 

 

Rectangle from center 

 

Ellipse to center 

 

Ellipse from center  

 

Cone from left 

 

Cone from right 

 

Cone from top 

 

Cone from bottom 

 
 

 
 

   

 
 
 

 
 

GoTo 
This dialog box is used to enter the coordinates of the location to which you want to jump 
to in the image. You can jump to any position in the image, whether or not that position is 
defined as a zone. 
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Defining Grid Parameters    
Select the Grid Setup item to define a grid for the image.  
A grid is a rectangular array of points that appears in the image background and can be 
used to place objects at exact coordinates in the image. 
 
To define the image grid setup 
1. Select Grid Setup from the Modes menu. 
 Or, Click the Grid Setup tool located on the main toolbar. 
 The Grid Setup dialog box opens. 
2. Define the Grid step units type: 
 World - The grid step will be set to the drawing space, so that when the zoom level is 
changed, the visible distance between grid points also changes accordingly, together with 
the other geometrical objects in the image.  
 Pixels - The grid step is set to the screen pixels, so that whatever the zoom level, the 
distance between the grid points will remain the same, even though the object sizes visibly 
change. 
3. Enter the grid step (in the respective units). X is the horizontal step and Y is the vertical 
step.  
4. In the Origin section, define the reference point to which all other points are relative.  
5. Click the Select Point button to select the origin point by clicking on a point in the image. 
The X and Y fields will indicate the point you selected.  
6. Click the Show button to cause the grid to appear in the image immediately, according to 
the current configuration.  
7. Click the Set button to save the grid configuration and exit the dialog box. 
The grid origin is the reference point to which all other points are relative.  
The term grid snapping refers to the movement of the cursor in the image, only in grid point 
steps (when the mouse is moved, or arrow key is pressed, the cursor will move to the next 
grid point.  

 
 

 
 

   

 
 
 

 
 

Grid Display 
To make a grid visible or hidden, click on the grid tool from the Operations Toolbar. 
You can also make the grid hidden or visible from the Image Modes Menu, Show Grid.  
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Grouping and Ungrouping   
Grouping objects combines two or more objects so you can work with them as though they 
were a single object. You can flip, rotate, and resize or scale all the objects in a group as a 
single unit. You can also change the attributes of all objects in a group at one time. For 
example, you can change the fill color to all objects in the group in a single step. 
To Group Objects 
1. Click the select tool and then drag to select the drawing objects you want to group.  
2. Click the left mouse button on the Group tool in the Objects Toolbar. 
Or 
Click Operations from the Edit menu, then click on the Group option. 
Or 
By right clicking an object and selecting the Group option. 
To UnGroup Objects 
1. Select the grouped objects. 
2. Click the right mouse button on the grouped objects and select the UnGroup option. 
Or 
Click Operations from the Edit menu, then click on the Ungroup option. 
Or 
By right clicking the grouped object and selecting the Ungroup option from the menu. 

 
 

 
 

   

 
 
 

 
 

Image Alert Fill/Line Color 
This dialog box defines the line and fill colors or the image object. 
There are two columns: 
Status where the status of the alarm is selected. This could be: 
Started 
AlarmStatus0 
AlarmStatus1 
Acked 
Ended 
Color click the arrow in the selected state’s Color field and select the relevant color  
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In this zoom the layers will always appear (even if the scaling range were not specified for 
them). 

 
 

 

 
   
 
 
 
 

In this zoom each layer will be viewed according to the scale range specified in the Layers 
Definition. 

 
 

 

 
   
 
 
 
 

Select this item to set the a new font style  
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Image Bitmap Transparency 
This dialog box is used to change color transparency of an Image bitmap.  

1. Check the Use Transparency field to activate the Selected 
Color dialog box. 

2. In the color fields define the required transparency. 

3. Click OK to save.  
 
 

 
 

   

 
 

 
 
 

Image Button Tool  
The Image button is a static object that can have normal attributes as other objects such as 
layers and colors. The main use of this object is to enable the application to contain a 
trigger object that has the same look and feel as a Windows button. 
It is also possible to define over the button object dynamic, alarm or triggers objects and 
have the same roles as any other static object. 
Defining a Button 
To define a button select the button tool on the Image Drawing toolbar. 
Selecting the Button tool changes your cursor as follows:  
Click and hold left mouse button and drag to draw a rectangle (drawn in dash line) for the 
size and location of the button. 
Releasing the mouse button will open the Button Properties dialog box: 
Type the text you want to appear on the button in the caption field. Default caption is 
button. Click OK and the button will be displayed in your Image. 
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Image Alert - Blink 
This dialog box defines the rate that image object alert blinks. 
There are two columns: 
Status where the status at which the alarm blinks is selected. This could be: 
Started 
AlarmStatus0 
AlarmStatus1 
Acked 
Ended 
Rate where the blink rate for the selected status is defined. This could be: 
Fast 
Medium 
Slow 

 
 

 
 

   

 
 

 
 
 

Copy and Paste Attributes 
This feature can be used to copy and paste both objects and text attributes. 
In an image select an object/text and then click the Copy Attributes button in the 
Operations toolbox. 
Using the tool, click on an object or text in the image. The copied attributes are pasted into 
the selected item. 
Right click anywhere in the image to end this process. 
Notes: 

1. Objects are applied by clicking each object individually. 
2. Copied attributes can only be pasted into the same object/text type. That is, 

attributes copied from text cannot be pasted into objects. 
3. The Copy Attributes button is only enabled when an object/text is selected. 
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Image Edit Menu 
The Image Edit Menu is the graphic tool of the application. It is used to create and view the 
images that enable personnel to visualize part or all of a control process. 
The Image Edit Menu includes a variety of drawing tools that make image design quick and 
easy. 
 
The Image Edit Menu consists of the following menu items: 
Edit /Undo- RedoThe Undo command reverses or deletes the last entry. Immediately after 
you undo an action, the Undo command changes to Redo, allowing you to restore what 
you reversed 
Edit/ Copy To Clipboard The Clipboard is an Operating system facility use to transfer data 
between applications. 
Edit/ Paste form Clipboard Select this item to paste objects from the Clipboard to an image 
Edit/Edit Properties Select this item to edit objects 
Edit/ Find Using the Find option you can find and Goto an object that matches the search 
text 
Edit/ Find next Find next searches for the next occurrence of the last search string. 
Edit/Align Two or more selected objects can be aligned to Right Top or Bottom. They can 
also be centered or resized Horizontally, Vertically or Both. 
Edit/Select This item is used to select objects in the image.  
Edit/Operations The Operations Menu allows you to perform editing and animation 
operations on your Image. 
DrawingsThe Drawings Menu enables you to draw and add text in your Image by using 
the Polyline, Box, Circle, Pipe, Text and Pick color tools. 
Line Type Line Type enables you to define lines with different widths and types for objects 
that include lines as part of their shape 
Set Background ColorHLP_WZ2EDT_SETBACKCOLOR  
Get Colors The Set Image Background feature enables you to set the image background 
color. 
Save ColorsHLP_WZ2EDT_SAVECOLORS  

 
 

 
 

   

 
 
 

 
 

Image Overview 
 
Application Images are dynamic graphs representations of industrial processes. Each tag 
in an industrial process can be represented by an image object, and each object can 
represent specific process values, thereby displaying a dynamic picture of the process. 
To initiate the Image window: 
1. Right click the Image file located in the Containers tree 
2. Select the "New Image" option with the left mouse button. 
OR 
Through the Pop-up menu located in the List Zone  
1. Select the Images file from the Project Tree. 
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2. Right click an existing Image or click anywhere in the List zone 
3. Choose the New Image option. 
To view the list of Image files:  
Right click Images on the All Containers tree. As a result a list of all Images is displayed. 
To set the order of fields to be displayed in the Images list: 
1. Click the Image file in the Containers tree 
2. Right click an existing Image or anywhere in the List Zone 
3. Choose the View Setting option from the menu. 
See the following: 
The Image Toolbars  
Viewing Images  

 
 

 
 

   

 
 

 
 
 

Insert Picture Tool   
1. To insert a picture file select the Insert Picture Icon from the Drawings Toolbar. 

The Select Picture Dialog box opens. 
2. Enter the file name in the File Name field and press Open. 
3. You can insert a *.Jpg or *. BMP file. 

 
 

 
 

   

 
 
 

 
 

Image Find Option 
Using the find option you can find and Goto an object that matches the search text. This 
feature is available in Edit mode only. The Find command opens the Find dialog box while 
the Find next searches for the next occurrence of the last search string. 
You can activate the Find option using the following keys: 
Find:  Ctrl F 
Find Next: F3 
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In the Find in Image option you can do the following: 
You can enter search strings up to 256 characters 
Search options are common for all Image Windows. 
Search Options  
The following is a list of the search categories and their description you can select to 
search for: 
Simple text. 
Tag name - this includes tag names in Dynamic object, Tag Value, Trigger, Text table and. 
Widgets. 
Alarm family name - as defined in alarm object. 
Trigger macro name - the name of the macro that a trigger activates. 
Trigger zone name - the name of the zone that a trigger goto 
Trigger button - any name in trigger button including title and legend on each button. 
Cluster Instance - the instance name of a cluster. 
Cluster library - the library name of cluster instance. 
Cluster object - the cluster object name as appearing in the library. 
Text table value - the current string value matches the search string. 
String tag value - the current string tag value matches the search string 
Notes:  

1. For Text table and String tag the Simple text option must be also checked. 
2. If searching for trigger zone or macro, then the search is also made in trigger 

buttons for such a match. 
3. Options can be set independently from one of the other. 

Other Search Options 
Other search options give you control of the way the actual search is made. 
Match case -- the search is made for full match of case of letters, otherwise, strings are 
compared ignoring the case. 
Whole word -- the search is made to find the exact full text, all characters are accounted 
for, otherwise, the search is made to find the occurrence of the search string inside any 
text. 
Only in visible view -- if this option is checked, the search is limited to the visible part of the 
Image inside the Window. 
Other Advanced Search Options 
Goto object -- if this option is checked the application will automatically navigate to the 
found object to bring it into the middle of the current Window; the scale will not be changed. 
Always Goto object -- checking this option causes the application to navigate to the found 
Smart Search -- checking this option will cause the search to be performed in a 
geometrical way. The Image is searched from ‘left to right’ in strips of the same size of the 
current open view. In many cases such search is more ‘intuitive’ especially if the Image is 
divided to zones with a corresponding layout. 
If this option is not checked the search is simple, meaning that the search is by the order of 
objects in the Image, from the first object created to the last one.  
Notification Message 
If a search fails a notification message is displayed with the searched string. 
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Instance Parameters 
This dialog box is used to define a cluster instance. In the Instance Name field type in the 
name of the Instance. 
A full description of Instances appears in the application documentation. 

 
 

 
 

   

 
 

 
 
 

Layers Visibility Mode 
You can override the current visibility mode and make a layer visible or hidden. 
The Layer Override Hide or Layer Override Show dialog boxes enable you to select a layer 
from the list and make it visible or hidden. 
 

o To make a layer visible 
1. From the Layers menu select Override Show. 
2. In the Layer Override Show dialog box select the layer you want to become visible. 
3. Click the Show button to make this layer always visible. 
4. Click the Clear button if you want all layers to revert to default visibility. A layer set to be 
visible (Show) is marked with a special arrowhead character. 
To hide a layer 

1. From the Layers menu select Override Hide. 
2. In the Layer Override Hide dialog box select the layer you want to become hidden. 
3. Click the Hide button to make this layer always hidden. 
4. Click the Clear button if you want all layers to revert to default visibility. A layer set 

to be hidden (Hide) is marked with a special arrowhead character. 
5. To cancel the permanent effect for all the layers, activate the Clear button.  

Notes: 

If both the Hide and Show attributes are assigned to a layer, that layer 
will be hidden. 

Layers are used to enhance the elaborating zoom effect in an image.  
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Layers / Definition  
Select the Layer Definition item to define a new layer in the image.  
Image objects are drawn in layers. Each image can contain several layers or just one layer 
(the Base layer always exists).  
Each layer in an image constitutes one part of the overall image, and each layer is 
assigned its own zoom range.  
Each image can consist of either one layer (the Base layer) or several layers.  
To define a new layer 
Select Definition from the Layers menu. The Layer Definition dialog box opens. 

 
 

 
 

   

 
 

 
 
 

Layers / Elaborate   
Select the Layers item to toggle the Elaborate Zoom on and off.  
A checkmark beside the item indicates that the Zoom is On. When the Elaborating Zoom 
made is on, each layer will be viewed according to the scale range specified in the Layer 
Definition operation. 
When the mode is off, layers will always appear (even if the current scale does not fall 
within the layer's scale range). 
To toggle the Elaborating Zoom mode on and off 
Select Elaborate On from the Layers menu. A checkmark beside the item indicates that the 
mode is active. 
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Layers / Override Hide  
Select the Override Hide item to set a layer so that it will always be hidden, despite the 
Elaborating Zoom mode setting. Any layer set to be hidden is marked with a special 
arrowhead character. 

Note that if both Hide and Show attributes are assigned to a layer, that 
layer will be hidden. 

 
 

 
 

   

 
 

 
 
 

Layers Definition    
Layers are used to enhance the elaborating zoom effect in an image. Each image can 
consist of one layer (the Base layer) or several layers. 
Layers can be viewed in the Elaborating Zoom ON or Elaborating Zoom Off mode (Layers / 
Elaborate On).  
If the Elaborating Zoom is on, each layer will be viewed in the scale range you assign when 
you define the layer. If the Elaborating Zoom is off, each layer will always appear (even if 
scaling ranges were not specified for them). 
To define a layer 
1. Select Definition from the Layers menu to open the Layer definition dialog box. 
2. Type the name of layer. 
3. In the From Scale field, specify the lower limit of the zoom level range for elaborating 
zoom. 
4. In the To Scale field, specify the upper limit of zoom level range for elaborating zoom. 
5. Click the Group button to open the Access Permission Manager dialog box opens, 
where you can assign authorized users and groups for this layer. 
6. Click the Add button to add your definition to the list of layers. 
To modify a layer 
1. Select the layer you want to modify. 
2. Change the layer various parameters. 
3. Click the Change button for the changes to take effect. 
To remove a layer 
1. Select the layer you want to delete. 
2. Click the Delete button.  
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The title that will appear on the button. 
 
 

 

 
   
 
 
 
 

LoadAnnFile 
Selecting this Fast Action opens the Define Trigger dialog box enabling you to browse and 
select the events summary file (*.ann), or the events summary profile file (*.wna) you want 
to open upon activating the LoadAnnFile trigger. 

 
 

 
 

   

 
 
 

 
 

LoadHtmlPage 
Selecting this Fast Action opens the Define Trigger dialog box enabling you to browse and 
select the Html file you want to open upon activating the LoadHtmlPage trigger. 
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Layers / Override Show 
Select this item to set a layer so that it will always be visible, despite the Elaborating 
Zoom mode setting. A layer set to be visible (show) is marked with a special arrowhead 
character. 

 
 

 
 

   

 
 

 
 
 

LoadImage 
Selecting this Fast Action opens the Define Trigger dialog box enabling you to browse and 
select the image file, window and zone you want to open upon activating the LoadImage 
trigger. 

 
 

 
 

   

 
 
 

 
 

LoadPictureFile 
Selecting this Fast Action opens the Define Trigger dialog box enabling you to browse and 
select an image file (*.vim) or a Web picture file (*.wnp) you want to open upon activating 
the LoadPictureFile trigger. 

 
 

 



Chapter 21 Image Editor 

972 

 

   

 
 

 
 
 

LoadTrendFile 
Selecting this Fast Action opens the Define Trigger dialog box enabling you to browse and 
select the chart file (*.chr) or trend file (*.wnt) you want to open upon activating the 
LoadImage trigger. 

 
 

 
 

   

 
 
 

 
 

Lock Tags Value 
The Tag Value Lock window enables you to modify the application’s tag lock definitions in 
the Image module at runtime. When this trigger next opens it will be in the mode defined 
during Trigger creation.  

To access the Tag Value Lock in an Image object, do the following: 
In the All Containers side of the Application Studio click Images and then select an image 
from the List of Images on the right side of the Application Studio. An image will open on 
your computer screen. 
Or, 
In the Quick Access bar click the Load Image icon and select the relevant image from the 
list in the Open dialog box. 
In the Image module during runtime (trigger mode) using the trigger hand click on the 
object to open the Tag Value Lock dialog box where a list of all locked/unlocked tags are 
listed. 
The Tag Value Lock trigger has the following options: 
Lock/Unlock  Where filtered tags can be locked/unlocked without exiting the dialog box. 
Each unlocked tag receives a continuous current value update. 
Print  Which prints to reports printer defined in the application. 
From Image/From Filters This toggle button moves between the From Image and From 
Filter List modes. 
Select Filters Which when clicked opens the Select Tag Filters dialog box where new Tag 
Filters can be defined, modified and added to the Selected Filters List.  

Modifying Tag Lock Values  
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The lock tag definition dialog box enables the filter tags to be both locked/unlocked. This 
dialog box also enables tag value modification READ/WRITE. 
 

 
 

 
 

   

 
 

 
 
 

Locking and Unlocking Objects 
Image objects can be locked/unlocked. Locked object cannot be moved or modified. 
To lock/unlock an image object do the following: 
Select an object. 
Right click and select lock/unlock from the popup menu. 

 
 

 
 

   

 
 
 

 
 

A macro that will be invoked whenever the button is activated.  
Note: Macro is not supported on the Web. 

 
 

 
 

   
 
 
 
 

Modes Copy On    
Select this item to toggle the Copy On mode on and off.  
To enable the Copy On mode: 
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Select Copy On from the Modes menu. In the Copy On mode, transformations do not affect 
the original objects. For example, if an object is moved, both the original and the moved 
objects will remain on the screen (the object will, in effect, be copied). If this mode is off, 
when an object is moved, only the newly-positioned object will appear.  

 
 

 
 

   

 
 

 
 
 

Modes / Edit 
Select this item to toggle the Edit Mode on and off. 
The Edit mode is used for designing and editing an image. In this mode, an image can be 
viewed and edited.  
To access the Edit Mode 
Select Edit from the Modes menu. A checkmark beside the Edit item indicates that it is 
active. Selecting the item again causes the system to revert to the Monitor Mode. 
In the Edit mode, all the image Window functions are present, including the Tools windows 
which contains the drawing and editing tools used to create and modify images. 
When the Edit Mode is activated, all the Tools available in the window will appear. 
The Tools window contains the object, the operation, the drawing and the color Tools. In 
addition, the current coordinates of the location of the cursor in the image will appear in the 
title bar of the window (or in the caption of the icon, if it was minimized).  

Note that if the Edit mode is activated without the Navigate mode, you 
will be able to edit the image, but not scroll, pan, or zoom in it.  

 
 

 
 

   

 
 

 
 
 

Media Player 

Note: Media Player is not supported on the Web. 
The Media Player enables you to play any Media file that is installed on your computer. 
Usually this object is used to play ‘AVI’ files that display some information to the operator.  
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To Define a New Media Object 
1. Select the Media tool located in the Objects Toolbar. 
2. Draw a rectangle in the initial size you wish. The Media Player Properties dialog 

box opens where you can select the Media device (file ) you wish to play. 
3. You can set the Media window to include a title bar with your own text. The Media 

device will be displayed ‘Stretched ’ to the object size. A small control bar is 
displayed at the bottom on the object with the options to Play, Stop, Pause, Fast 
Forward and Rewind. 

4. You can select and edit the object size and the location can be manipulated as any 
other object. To change the object properties double-click on it. 

 
 

 
 

   

 
 

 
 
 

Modes / Grid Show   
Select the Grid Show item to make a grid visible or hidden. 
To enable the Grid Show option 
Select Grid Show from the Modes menu. 
Or, 
Click the Grid icon on the Operations toolbar. 

 
 

 
 

   

 
 
 

 
 

The Modes Menu 
Window modes (edit, navigate) 
Select one of these items to set the operating mode of the window.  
Several image windows can appear on the screen simultaneously: Edit, Navigate thus 
enabling the operator to view and edit separate parts of the same image, or different 
images, on the same screen. 



Chapter 21 Image Editor 

976 

Trigger on When the Trigger mode is set to ON, objects defined as Trigger objects 
can be used for tag input. When this mode is OFF, no object, even one defined as a 
Trigger object, can be used for tag input. 
Copy On Select this item to toggle the Copy On mode on and off. 
Grid Setup Select this item to define a grid for the image. 
Grid Snap Select this item to toggle the Grid Snapping on and off. 
Grid Show Select this item to make a grid visible or hidden. 

 
 

 
 

   

 
 

 
 
 

Modes / Grid Setup   
Select the Grid Setup item to define a grid for the image. 
A grid is a rectangular array of points that appears in the image background and can be 
used to place objects at exact coordinates in the image.  
Selecting Grid Setup opens the Grid Setup dialog box where you can select the grid step 
unit types and coordinates, the reference point to which all other points are relative. You 
can also preview your grid definition. 

 
 

 
 

   

 
 
 

 
 

Modes / Navigate 
Select this item to toggle the Navigate mode on and off.  
Use the Navigate Mode to move through an image workspace without editing the image. 
In this mode, the displayed image can only be viewed and not navigated or edited, though 
tag input can be performed if the operator is authorized to do so and the trigger on Mode 
has been activated. 
The Tools window initially appears outside the Image Window, but can be moved to the 
new location,  
To enable the Navigation mode 
Press the Navigator Icon located in the Image main menu 
OR 
Select Navigate from the Modes menu. 
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If this mode is selected without the Edit mode, you will be able to scroll, pan, and zoom in 
the image, but not edit it.  
In addition, if the Edit mode is not activated together with this mode, the Tools window will 
not appear.  

 
 

 
 

   

 
 

 
 
 

Modes / Snap to Grid   
Select the Grid Snap item to toggle the Grid Snapping on and off.  
When grid snapping is on, the cursor will move only from point to point on the grid, without 
skipping points.  
This mode can be activated to position objects accurately in the image  
To enable the Grid Snap option 
Select Snap to Grid from the Modes menu. 
Or 
Click on the Snap to Grid icon in the Operations toolbar. 

 
 

 
 

   

 
 
 

 
 

Modes / Trigger On  
Select this item to toggle the Trigger mode on and off to enable the use of Trigger objects 
with other modes. 
When the Trigger mode is set to ON, objects defined as Trigger objects can be used for 
tag input. When this mode is OFF, no objects, even one defined as a Trigger object, can 
be used for tag input. 
When this mode is active, you can move from one trigger object to another by pressing the 
Tab key. To move in the reverse order, press the Shift and tab keys together. Note that you 
move from one object to another according to the order in which the objects were 
designed. To change the order, use the Z order tool. 
To access the Trigger ON tool  
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Press the Trigger On button located in the Image Main Menu. After you select this item, the 
cursor will appear as a white hand. Whenever the hand is placed on a trigger object, it will 
turn red. In this mode, image objects designed for tag input (trigger objects) can be 
activated.  

 
 

 
 

   

 
 

 
 
 

Modify Tag Value 
Enter a value and then click the OK button to apply it immediately to the tag. If the object is 
a string tag a text value for it can be entered in the New Tag Value field. 
 
The keypad can be used for data entry triggers of numeric types.  
Click the test button to move the keypad. After the application is closed and then reopened 
the keypad will appear in the new location.  

 
 

 
 

   

 
 
 

 
 

Modifying Text   
Use this dialog box to modify a text object. 
To modify a text object 
1. Select the text object you want to modify. 
2. Click the mouse right button and select Change Text from the popup menu displayed. 
 The Modify Text dialog box is displayed. 
 OR 
 Double click the selected object 
3. Modify your text as applicable and click OK. 
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Momentary Trigger   
A Momentary Trigger is an object that is used to change a tag value in one shot. Usually 
such operations are required for a digital tag that control a field operation that is activated 
by a high value (one 1) for a short period of time, followed by a low value (zero 0). 
The neutral way to implement such an operation is using the ‘button down’ button up’ pair 
of user actions. This operation is actually a ‘button click’ that is regarded as one operation. 
The momentary trigger operation will regard a ‘button click’ as two operations. 

Functional Description 
Following is a description of the way Momentary Trigger works: 
All tags can be used for the Momentary including string tags. 
A formula, identical to the one used in Action trigger can be assigned for Down and Up 
operation 
Any Dynamic object in an Image that should reflect the tag value change will be updated 
when the button is still pressed 
Only when the user releases the mouse left button (‘button up’) the Up formula is 
calculated and the result value will be written to the application in the same way as the 
down value 
If the user releases the button not above the trigger object the Up value will not be written  
To set and reset a bit in an Analog tag the OR and AND operations can be used. For 
example for 8 bit analog tag to set the 3rd bit use the formula ‘@ | 4’ and to reset the same 
bit use formula ‘@ & 251’. The same principal can be applied to any bit and for 16 or 32 
bits analog tags 
To define a Momentary Trigger 
1. Click the Momentary button from the Trigger Object dialog box. The Tag Input - 
Momentary Values dialog box opens. 
2. Enter the Value that the application will write to the tag when you press the left mouse in 
the Button Down Formula Field. 
3. In the Field Button Up Formula enter the value that the application will write as soon as 
you release the mouse button. For new definitions the default values are 1 and 0 for Down 
and Up respectively.  
7. Click OK to complete the operation. 
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Moving Objects   
The move operation is used to move objects from one location to another. As opposed to 
the move operation described in the section called Selection, this move operation is useful 
for long distance moving (from zone to zone, area to area, etc.), since the mouse button 
does not have to be held down while dragging the object. 
To move an object: 
1. Select one or more objects. 
2. From the Edit Menu Operations click the move option. 
3. Click on the left mouse button. The cursor changes to a bi-directional arrow. 
4. Click the left button on a starting point. 
5. Move the frame of the object(s) to the desired location and click the left button. 
6. Clicking the right mouse button sets the object automatically to select mode and cancels 
the move operation. 

 
 

 
 

   

 
 

 
 
 

Numeric Keypad 

Note: Numeric keypad is supported on the Web. 
To enable the application to support touch screens, a new type of trigger is available. In the 
Wiztune.dat file, manually set the tuning parameter 
IMG_TRG_KEYPAD = YES 
Default is NO 
Restart the application for it to take effect. 
The Key Pad is available for Data Entry triggers of numeric type. 
The keypad operates as any other numeric keypad. Press the Back button to delete one 
number back. Press Clear to erase all numbers in the field.  
You can set the location of your keypad anywhere on the screen. Press the Test button 
and you can move the keypad to any location. When you reopen the application and 
operate the keypad, it will be opened at the same location as you selected. 
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Move Object to Active Layer Used to move a selected object to the layer defined as 
active. 

• To move an object to the active layer: 
1. Select the object(s) that you want to move. 
2. From the Layers menu select Move Objects to Active Layer. 
You can select an object and then click the right mouse button on the active layer  

 
 

 
 

   

 
 
 

 
 

Options / AutoWindow  
Select this item to automatically set the image window position and zoom level, so that all 
image objects in the window will be arranged properly.  
This function can also be performed by clicking on the a button on the left side of the image 
window. 

 
 

 
 

   

 
 

 
 
 

If you select Cancel and/or Help, these buttons will be included in the panel. If you select 
Execute, you are prompted to confirm the specified action before it is executed. 
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Options / Force Dyn. Show 
Select the Force Dynamic Show item to cause a dynamic object in an image to appear, 
even if according to a Drum or Show filter (both defined in the Dynamic Parameters dialog 
box), the object is hidden. 
To define Force Dynamic show 
1. Select an object form the view 
2. Select Forch Dyn. Show from the Options menu. 
 OR 
1. Select an object from the view. 
2. Click it with the right mouse button 
3. Select the Dynamic Definition from the popup menu. 
OR 
Press the Force Dynamic icon from the Image Main Menu. 

 
 

 
 

   

 
 
 

 
 

Options / Goto    
This dialog box is used to enter the coordinates of the location to which you want to jump 
to in the image. You can jump to any position in the image, whether or not that position is 
defined as a zone. 
To jump to a specific position in the image window 
1. Select Goto from the Options menu. The Goto dialog box appears. 
2. Enter a scale level between 1 and 2048. 
3. Enter the X and Y coordinates, in drawing units. 
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Options / Window    
Select this item to zoom in to a specific part of the image.  
A window zoom is performed by marking a window in the image to be used later as the 
window. This zoom enables the operator to define what is to be included in the window. 
To zoom in to a specific part of the image: 
1.   Click on any location in the image to designate the starting point of the portion of the 
image you want to zoom in on. 
2. Click on the place where you want the end of the image portion to be.  
3. Click in the outlined box.  
 OR 
 Press the w button located in the Image scroll bar. 
 To move an outlined box, place the cursor on a box border (a multiple arrow cursor 
appears), click, and drag the box to the new position. 

 
 

 
 

   

 
 

 
 
 

Options / Goto Zone   
The Goto Zone dialog box enables you to easily jump to any of the zones you defined. 
To jump to a specified zone in an image: 
1. Select the Goto Zone item from the Options menu, or click the Goto Zone icon from the 
main menu. The Goto Zone dialog box is displayed. 
2. Select the zone you want to jump to and click the OK button, or double click the zone 
you wish to jump to. The image window will immediately be centered on the zone's central 
point and the zoom level will be adjusted to the level defined for that zone.  

Note that a pre-defined zone called Previous Zone is included in the 
zone list. This zone appears as the character <<<. You can goto this 
zone the same way as any other zone. However, if there is no zone to 
return to, the previous zone item will be disabled. 
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Options Repaint 
Select this item to redraw the current image.  
This is useful to view the results of editing operations, if they do not immediately appear on 
the screen, or to remove undesirable residues that may remain on the screen after editing.  
To Repaint  
Select the Repaint option from the Options menu. 
OR 
Press the r button from the Image scroll bar. 

 
 

 
 

   

 
 
 

 
 

Options Simulate 
Select this item to simulate variations of tag values and observe how the image is affected 
by each value.  
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Options Mark Trigger 

Note: Mark Triggers is not supported on the Web. You can mark triggers 
in Edit mode, while developing your image. 

Select this item to cause all trigger objects in the Window to be marked (or unmarked) on 
the screen.  
After you select Mark Triggers, a red hand will appear in all the trigger objects in the image.  
The Mark Triggers function will apply to any trigger object.  
Note, however, that if an object is marked (with a red hand) to indicate that it is a trigger 
object, but is dynamically or manually transformed (moved, rotated, scaled, etc.), the 
trigger mark may disappear or will not appear in its proper location. If this occurs, you can 
refresh the screen by pressing <Alt-R>.  

 
 

 
 

   

 
 

 
 
 

Options / Styles Definition 
Select this option to define a font to be use for image text objects. 

 
 

 
 

   

 
 
 

 
 

Orthogonal Pipe Tool   
To draw an orthogonal pipe 
1. From the Drawings toolbar, click on the orthogonal pipe tool. 
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right mouse button to complete the operation. 

 
 

 



Chapter 21 Image Editor 

986 

 

   

 
 

 
 
 

Orthogonal Pipe 
Orthogonal pipes are connected rectangular segments in orthogonal directions. 
(vertical, horizontal, and at 45 degrees). 

 
 

 
 

   

 
 
 

 
 

Orthogonal Polyline 
Lines drawn in orthogonal and diagonal directions (vertical, horizontal, and at 45 degrees). 

 
 

 
 

   

 
 

 
 
 

Paste form Clipboard 
Select this item to paste objects from the Clipboard to an image. The imported object will 
be placed in the current active layer. 
For a Paste from Clipboard operation, the application will paste the object first in the image 
parameter format (if the object is in that format). If the object is not in that format, the 
application will paste the object in the Metafile format. If the object is not in that format 
either the application will paste the object in the Bitmap format. If the object is not in any of 
these formats, the application will not paste the object.  
There are two ways to paste an object from the Clipboard  
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Through the Edit Menu 
1. Select an object 
2. Select the Paste from clipboard item from the Edit menu 
Through the Pop-Up Menu 
1. Right click object in the Image window 
2. From the Pop-up Menu select the Copy to clipboard 
To place an object after it has been pasted, either double-click on the point in the image 
where you want the object to appear, or click once to set the size and location of the 
image. 
If you click once, you must define the area which the object will fill by moving the outlined 
box that appears (by dragging the mouse) to the end point of the object, and clicking again.  

 
 

 
 

   

 
 

 
 
 

Pick Color Tool 
Click on the Pick Color tool in the Operations Toolbar for filling or drawing objects with the 
exact color used in a different object. 
The Pick Color Tool lets you sample colors from an area of an image to designate a new 
line color or fill color.  
To select the line or fill color using the Pick Color tool 
1. Select the drawing tool. 
2. Select the Pick Color tool, then place the dropper icon on any point in the image over the 
desired color. 
3. Draw your new object and the object fills with the selected color. 
Or  
1. To select a new line color from the Color Toolbar, left click the mouse button on the color 
you want. 
2. To select a new fill color from the Color Toolbar, right click the mouse button on the color 
you want. 
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Pipe Tool 
To draw a pipe 
1. From the Drawings toolbar, click on the pipe tool  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right mouse button to complete the operation. 

 
 

 
 

   

 
 

 
 
 

Polyline Tool    
To draw a Polyline 
1. From the Drawings toolbar, click on the Polyline tool  
2. Click the left mouse button on the start point. 
3. To connect lines, click the left mouse button on successive end points. 
4. Click the right mouse button to complete the operation. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 

 
 

 
 

   

 
 
 

 
 

Orthogonal Polyline Tool   
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To draw an orthogonal Polyline 
1. From the Drawings toolbar, click on the orthogonal polyline tool  
2. Click the left mouse button on the start point. 
3. To connect lines, click the left mouse button on successive end points. 
4. Click the right mouse button to complete the operation. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 

 
 

 
 

   

 
 

 
 
 

Remove Alarm   
This option will cancel the Alarm of an object which was previously defined as an alarm 
object. 

 
 

 
 

   

 
 
 

 
 

Rebuild Cluster Instances 
One of the big advantages of using clusters is the ability to rebuild all instances 
automatically after updating the original cluster in the library. 
In the dialog box list you can see all the instances that were placed in the current image. 
Each line contains the library name the cluster name and how many instances of the object 
were placed. 
Select the items you wish to update and press the Rebuild button. 

Notes:  
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The tags and alarms that were associated with each instance will remain 
unchanged. 

This operation will fail if there is no compatibility between the cluster in 
the library and the instances in the image. 

To select all items in the list click the <CTRL></> keys. 
 
 

 
 

   

 
 

 
 
 

Rotating Objects 
The Rotate Operation lets you turn an object or group of objects clockwise or counter 
clockwise. 
To Rotate an Object 
1. Select an object. 
2. Select Operations from the Edit menu, then select the Rotate option; or select the Rotate 
tool from the Operations toolbar.  
3. Click the left button on the rotation pivot and see the skewing handles. 
4.  Move the frame of the object around the pivot until the object is rotated to the desired 
orientation and click the left button. 
Once a starting point for the Rotate operation has been established, click the right button to 
cancel the last part of the operation. When no starting point has been established, the right 
button can be used for single object selection. 

Note:  Ellipses cannot be rotated sideways (slanted). 
 
 

 
 

   

 
 

 
 
 

Click to save the current button definition to be used later for other tags and objects. 
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Select Active Layer 
Select the active layer item to designate the active layer for which all subsequent editing 
operations will be performed. 

 
 

 
 

   

 
 
 

 
 

Select Tool 
To select an object 
1. Click the select arrow.  
2. Click on the object you want to select. 
3. To select several objects, start from an empty point in the Image, press and hold left 
mouse button, drag a rectangle around the objects you wish to select. 
4. To add an object to existing selection, left-click the mouse button while holding down the 
Shift key. 
5. Handles (small squares) appear on the corners and sides of an object's highlighting box 
when the object is selected.  
6. Use the square handles to resize and transform an object. Click on a selected object 
and the handles change to arrows which then permit you to resize an object. 
7. To move selected objects, click inside the object or bound rectangle, for a group of 
objects and, while holding the mouse button down, drag the object to the desired location. 
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First selected object is marked with 8 hollow handles.  
  

 
 

 
 

   

 
 

 
 
 

Remove Trigger  
Select the trigger object, right click, and select Remove Trigger from the pop-up menu.  
Or,  
Select the trigger object, point to Operations in the Edit menu, and select Remove Trigger. 
An arrow will mark the tag value input method that you select in the dialog box. 
Note that for the Data Entry, Smooth, Bit, and Test dialog boxes the last position of the 
dialog box will be saved (unless you clicked the Cancel button before completing the 
operation). 
This means that you can drag the dialog box to any position on the screen. Thereafter, 
whenever that dialog box is opened, it will appear in its last position. 
However, the dialog box position is relative to the window position. If the window is moved 
and then the dialog box is invoked, it will appear in the position it was last saved, relative to 
the new location of the window. 

 
 

 
 

   

 
 
 

 
 

Selecting an Object  
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To select an object: 
1. Click the select tool.  
2. Click on the object you want to select. 
3. To select several objects, start from an empty point in the Image, press and hold left 
mouse button, drag a rectangle around the objects you wish to select. 
4. To add an object to existing selection, left-click the mouse button while holding down the 
Shift key. 
5. Handles (small squares) appear on the corners and sides of an object's highlighting box 
when the object is selected.  
6. Use the square handles to resize and transform an object. Click on a selected object 
and the handles change to arrows which then permit you to resize an object. 

 
 

 
 

   

 
 

 
 
 

Send to Back   
The Send to Back option allows you to place objects in the back of your image. You can 
change the way objects overlap or lie by shifting the object to the back. Objects are placed 
with the first object you created on the bottom and the last object you created on top. You 
can shift the order of the objects by using the Bring to Front option or Send to Back option. 
To Send the object to the back 
1. Select the drawing object you want to send to the back. 
2. From the Edit menu select Operations then Send to Back. 
 The selected drawing object is placed in back of other overlapping objects. 
Or, 
Click the Send to Back tool on the Operations toolbar. 
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Simulate Range   
Use the Simulate Range dialog box to specify the upper and lower limits of the values to be 
simulated.  
The fields in this dialog box are:  
Lower Limit - Lower limit of the simulation range.  
Upper Limit - Upper limit of the simulation range.  

 
 

 
 

   

 
 

 
 
 

Slider 

Note: This feature is not supported on the web. 
Tag value sliders (widgets) can be designed and used in an Image to change and read tag 
values in a simple visual manner. The sliders can be positioned anywhere in the Image 
and will automatically reflect any change in the tag value that occurs in the field. 
The following points should be noted when working with tag value sliders: 

• Tag value sliders are system windows that operate using system controls. 
• Tag value sliders are automatically generated as trigger objects, and therefore can 

only operate in the Trigger mode. 
To design a slider: 
From the Edit menu, point to Drawings and then to Widgets.  
Select Slider from the popup menu. 
Or, 
Click the Slider tool in the Objects Toolbox. The Slider properties dialog box is displayed: 
The following fields are available: 

Station Specifies the network station to which the tag belongs. For a list 
of stations from which you can select, click on the 
arrow to the right of the field. 

Tag Specifies the tag to be associated with the slider. For a list of tags 
from which you can select, click on the arrow to the 
right of the field. 

Value Assignment  Select On Dragging to cause the value of the 
associated tag to change as the slider is dragged. 

 Select On Dropping only to cause the value of the associated tag to 
change only when you complete the dragging (release 
the mouse button) and place the slider on a specific 
value. 
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 Select On Dragging to Image, on dropping to Tag to cause the value of 
the associated tag to change and be reflected in the 
Image only as the slider is being dragged, and change 
and be written to the PLC when you complete the 
dragging (release the mouse button) and place the 
slider on a specific value. 

 Select Snap to Tick to cause the slider to snap to ticks on the value 
scale whenever it is moved, or the tag value changes 
in the field. 

Limits Select Default tag limits to cause the value scale limits to be 
those you defined for the tag in the Tag Definition 
procedure. 

 In the From/To fields you can specify the values you want for the upper 
and lower limits of the tag scale. 

 
 

 
 

   

 
 

 
 
 

Smooth Input  
This dialog box is used to set the upper and lower value limits for the Single Tag Input 
dialog when the trigger is activated.  
Lower Limit The lowest tag value that you will be able to specify in the Single Tag Input 
dialog box when the trigger is activated.  
Upper Limit The highest tag value that you will be able to specify in the Single Tag Input 
dialog box when the trigger is activated.  

 
 

 
 

   

 
 
 

 
 

String Tag 
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Tag value string displays can be used to represent tag defined as string tags, as image 
objects. Tag string objects in the image will display exact field device numeric, alphabetic 
or alphanumeric values. 
 
In this dialog box, specify the network station to which the string tag belongs, and then the 
name of the string you want to be represented in the image. To select a station or tag from 
a list of existing stations and tags, click on the arrow to the right of the field. Press OK to 
activate. 
Note that string objects on the image can also be defined as triggers, so that when the 
object is selected in the trigger mode, you will be able to enter textual values, using 
different input method. 

Note that you may use a tag template Identifier as a tag. This will enable 
the string tag display to be dependant on current image context 

 
 

 
 

   

 
 

 
 
 

Select one of these options to orient the button panel in a specific shape (Vert. for vertical, 
Horiz. for horizontal, or Rect. for rectangular). 

 
 

 

 
   
 
 
 
 

Options / Simulate  
This dialog box is used to specify tag values that you want to simulate for testing purposes. 
After dynamic objects are defined, the operator can test an object's response to different 
tag values using an application mechanism that simulates tag values without affecting the 
tag itself. 
When you simulate values, the field device will not be affected.  
To simulate tag values 
1. Select Simulate from the Options menu. The Simulate Tag Values dialog box is 
displayed. 
2. Select the station to which the tag belongs. 
3. Select the tag you want to access. 



Chapter 21 Image Editor 

997 

4. Enter the tag value to be simulated in the New Suggested Value field. The current tag 
value is displayed in the Current Simulated Value field. The value is set by clicking the 
Apply button. 
 OR 
 Use the horizontal scroll bar to immediately set and simulate the specified value. 
5. Click the Range button to specify the upper and lower range limits of the tag value to be 
simulated. 
6. Click the Exit button to quit the dialog box and leave the last set value. 

 
 

 
 

   

 
 

 
 
 

Tag Input: Bit Operation 
When the Bit method is being used and the operator clicks on a trigger object, the Tag 
Input: Bit Operation dialog box appears: 
For analog tags, the Toggle button in the dialog box will not appear, since it is only relevant 
for digital tags. 
The action button functions are: 

On Sets the tag value to 1. 

Off Sets the tag value to 0. 

Toggle Toggles between 1 and 0 for digital tags only. 

Note: If the object was defined as a string this trigger type will be 
disabled 

 
 

 
 

   

 
 
 

 
 

Text Table  
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Text Tables are used to associate tag values with pre-defined strings. Whenever a Text 
Table is defined and activated, a text string will be associated with the tag values that were 
defined in the Table. When a value changes, the corresponding string will be displayed. 
Each string table is stored in a separate file. 
To assign text tables or create new ones: 
Click the Text Table button in the Text dialog box. 
If no text table exists, the New Text Table File dialog box opens where you can specify the 
name of the text table. If a text table file already exists, the Open Text table file dialog box 
appears. Select a file from the list, or activate the New button to invoke a dialog box in 
which you can enter the name of a new text table file. 
After you specify the file you want to edit, the Text Table dialog box is displayed to specify 
the string-value relationship: 
The following options are available: 

Station Specifies the network station to which the tag belongs. 

Tag Specifies the name of the tag. 

Value Specifies the string display value. 

Text Specifies the string for the value. 

List Specifies the list of values and the strings defined for them. 

Add Adds the value-string pair to the list. 

Change Replaces the selected pair with the one specified in the entry 
boxes. 

Delete Deletes the selected pair from the list. 

Specify a tag name, the tag values, and their corresponding strings in 
the entry boxes, and add them to the list by activating the Add button. A 
value-string pair can be selected from the existing pairs list, placed in the 
entry boxes, and revised, by activating the Change button. When the 
Delete button is activated, the selected pair is removed from the list. 

Special Cases: 
If a tag value does not exist in the text table, the text field will be filled with Xs (xxxxx). 
If no text table file exists, number signs (#####) will appear in the field. 
If a communication error occurred, asterisks (*****) will appear in the field. 
If spaces are to be used in the string, enclose the string in quotation marks, for example, " 
The text ". 
Text table string files can be created or modified using your system editor. The format of 
this file is as follows: 
  Value   String 
   5  "Cycle Starting ..." 
   20  "Cycle Completed !" 

Note: Text Tables can also be used for Trigger objects when the String 
input method is active. 
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Tag Value   
The tag and its value to be displayed are both defined together with the display attributes. 
The fields in this box are: 

Station Specifies the workstation to which the tag belongs. 

Tag Specifies the tag associated with the tag value. 

Display Mode Select Dec for Decimal, Hex for Hexadecimal, or Eng for 
Engineering (powers of ten). For example, for the 
number fifteen: Dec = 15, Hex = F, and Eng = 1.5e1. 

Options In this field, select Left Justify to cause the digits in the text field 
to be justified to the left. 

Select + Prefixed to cause positive values to be preceded by a plus (+) 
sign. By default, no sign precedes positive values. 

 Select Leading Zeros to cause zeros to appear to the left of the value. 
By default, empty spaces appear to the left. 

Display Format In this field, for Digits before ".", specify the number of 
digits that will be allowed for the integer part of the 
value. 

 For Digits after ".", specify the number of digits that will be allowed for 
the fractional part of the value. 

Note that in the Hex mode, digits after the decimal point will be ignored.  

Note that you may use a tag template Id as a tag. This will enable the 
tag value display to be dependant on current image context 

 
 

 
 

   

 
 
 

 
 

The Align toolbar 
The Align toolbar enables you to align two or more selected objects. They can be aligned 
to the Left, Right, Top, or Bottom. The objects can also be centered or resized Horizontally, 
Vertically or both. 
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Text Tool 
The Text Dialog Box is used to specify a plain string or numerical value that will be 
displayed whenever a specific tag value occurs.  
To use the text tool 
1. From the Drawings toolbar, click on the Text tool. The Text dialog box is displayed.   
2. Type your text in the Text box. 
3. Click one of the following buttons for further Text definitions: 
 Tag Value - click to define the attributes for the digital text object. 
 Text Table - click to define a plain string or numerical value that will be displayed 
whenever a specific tag value occurs.  

 
 

 
 

   

 
 
 

 
 

The Colors toolbar 
The Color toolbar includes 32 colors for background and foreground color of objects. Left 
click selects the foreground or the color while right click selects the background, or fill 
color. 
Double-clicking either mouse button opens the color palette dialog, enabling you to 
customize any color. 
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The Drawings toolbar 
The Drawings toolbar contains simple drawing objects such as Line, Pipe, Box, Text, and 
Circle. Both filled and unfilled objects can be selected. The selection, text tool and button 
are also included in this toolbar. 

 
 

 
 

   

 
 

 
 
 

The Clusters Menu 
A Cluster is an object-class. Clusters can easily placed in an application and be reused as 
required. Clusters can be small or large. They can be simple, such as circles or pumps, or 
complex, such as a complete sub-application that includes tanks, pumps and valves.  
Once clusters are instantiated in an Image, they can be moved, scaled, rotated, and 
deleted in the same as any other Image object. To cancel a Cluster definition select a 
cluster object in the Image and then select Break from the Clusters menu in the Image. 
Instances cannot be defined as dynamic, as trigger, or as another cluster (no nesting of 
clusters), unless they are broken apart.  
The Clusters menu has the following options: 
Option Action  
Define  This option defines clusters and adds them to the Cluster 

Library 

Break  This option cancels a selected cluster object in the image 

Open lib  This option is used to open a library. 

Rebuild instances  This option enables instances to be built automatically 
after updating the original cluster in the library  

Basket maintenance  A basket is a tool supplying high-level engineering and 
application design. It is used to make a prototype of the 
application before actual implementation and traces the 
progress of the application development.  

Open basket  This option displays the clusters defined in a basket. On 
the right of the cluster, the number of times that the cluster 
has been used and maximum usage permitted are 
displayed. 
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The Image Drawing Tools 
The Drawings toolbar is used to draw objects in an image. 
The application includes all the tools you need to create your own graphic objects. These 
tools are found in the Drawings toolbox and include the tools listed below. If you want to 
edit any of these shapes, you can use the Edit Operations Toolbar. 
 
Select toolHLP_WZ2EDT_SELECT_TOOL  
Filled Rectangle or Square  
Unfilled Rectangle or Square  
Filled Rectangle or SquareFilled_Rectangle_or_Square  
Unfilled Round-cornered Rectangle or 
SquareUnfilled_round_cornered_rectangle_or_square_tool  
Filled Circle Tool  
Unfilled CircleHLP_WZ2EDT_CIRCLE  
Filled Ellipse Tool  
Unfilled Ellipse 
Filled Closed Arc Filled_Closed_Arc_tool 
Unfilled Closed Arc Unfilled_Closed_Arc_Tool 
Filled Orthogonal Polygon 
Unfilled OrthogonalPolygonUnfilled_orthogonal_polygon_tool 
Filled PolygonFilled_polygon_tool 
Unfilled PolygonUnfilled_polygon_tool  
Orthogonal Pipe 
PipePipe_tool 
Arc Arc_tool 
Orthogonal Polyline Orthogonal_polyline_tool 
PolylineHLP_WZ2EDT_POLYLINE  
TextHLP_DLG_WZ2_TEXT  
ButtonHLP_WZ2EDT_BUTTON_PROP  
Insert Picture  
To select a drawing tool 
1. Click in the Drawings toolbar. 
2. Click the tool you want to draw with. 
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The Image Toolbars 
The image window contains many toolbars that enable you to easily draw and animate 
your application.  
To show a toolbar 
From the View menu, click the toolbar you want to view. A check mark to the left of the 
toolbar name indicates that this toolbar is already opened. 
For more information on each toolbar, click the respective topic: 
The Fonts toolbarThe_Fonts_Toolbar  
The Align toolbarHLP_WZ2EDT_VIEW_ALIGN  
The Drawing toolbarHLP_WZ2EDT_VIEW_DRAWING  
The Objects toolbarHLP_WZ2EDT_VIEW_OBJECTS  
The Operations toolbarHLP_WZ2EDT_VIEW_OPERATIONS  
The Patterns toolbarHLP_WZ2EDT_VIEW_PATTERN  
The Color toolbarHLP_WZ2EDT_VIEW_COLOR  
The StatusHLP_WZ2EDT_VIEW_STATUSBAR  

 
 

 
 

   

 
 
 

 
 

The Image Windows 
 
Image windows are windows in which images are viewed and manipulated.  
Images are dynamic pictures through which control processes are monitored and 
supervised.  
 
An Image window can operate in one of the following modes:  
Monitor - In this mode, the image can only be viewed in the current window boundaries. 
Tag value input through trigger objects is supported (if the operator is authorized to do so).  
Navigate - In this mode, the image can only be scrolled, panned, and zoomed in and out.  
Edit - In this mode, an image can be drawn, edited, and saved. When the Edit mode is 
invoked, an auxiliary window, called the Tools window, will appear beside the Image 
window. The Tools window contains editing tools that you can use to draw or modify an 
image.  
The Image window modes can be activated by selecting a mode from the Modes menu.  
Several Image windows can be opened simultaneously on the screen, each displaying 
parts of the same image, or different images.  
In the Edit mode, each image has its own dedicated Tools window.  
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The Layers Menu 
Image objects are drawn in layers. Each image can consist of several layers or of one 
layer, the Base layer. Layers can be added, changed and deleted. 
In an image, each individual layer constitutes one part of the overall image. A complete 
image consists of all layers that belong to that image. 
Each layer is assigned a zoom range. Once created, layers can be viewed in one of two 
scaling modes; Elaborating zoom On or Elaborating Zoom Off.  
Each image layer can be assigned its own authorization levels, to enable only specific 
operators to view the layer, and each layer can be made visible or hidden using the 
visibility mode to toggle. 
The Options available in the Layers menu are: 
Elaborate ON - Select this item to toggle the Elaborate Zoom on and off.  
Active Layer - Select this item to designate the active layer for which all subsequent 
editing operations will be performed.  
Definition- Select this item to define a new layer in the image.  
Override Show - Select this item to set a layer so that it will always be visible, despite the 
Elaborating Zoom mode setting.  
Override Hide - Select this item to set a layer so that it will always be hidden, despite the 
Elaborating Zoom mode setting.  
Move Object to Active Layer 
Select the object that you want to move, and then select the Move Object to Active Layer 
menu item. 

 
 

 
 

   

 
 

 
 
 

The Objects toolbar 
The Objects toolbar allows you to define Image objects such as Alarm, Trigger, Dynamic, 
Cluster Definition, Group, Slider, Media and Scheduler 
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The Fonts Toolbar 
The Fonts toolbar allows you to set the text font style for any text object, simple, digital or 
text table. 
This toolbar includes the font name, size, direction and different text effects. 
The text can be bold, italic, underscored or strike through. 

 
 

 
 

   

 
 
 

 
 

The Options Menu 
The Option menu offers the following features: 
AutoWindow Select this item to automatically set the image window position and zoom 
level, so that all image objects in the window will be arranged properly.  
GotoSelect this item to cause the window to jump to a position and zoom level that you 
specify in the dialog box that appears.  
Goto ZoneSelect this item to cause the window to jump to an existing zone.  
Zones Definition Select this item to define Zones.  
Repaint Select this item to redraw the current image.  
Window Select this item to zoom in to a specific part of the image. 
Simulate Select this item to simulate variations of tag values and observe how the image 
is affected by each value.  
Force Dynamic Show Select this item to cause a dynamic object in an image to appear, 
even if according to a Drum or Show filter (both defined in the Dynamic Parameters dialog 
box), the object is hidden.  
Mark trigger Select this item to cause all trigger objects in the Window to be marked (or 
unmarked) on the screen.  
Styles definition Select this item to define the fonts you want to use for image text 
objects.  
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The Operations toolbar 
The Operations toolbar includes Rotate, Pick color, Active Layer, Toggle Fill, Cluster 
library, Bring to Back, Bring to Front, Delete, Grids, Snap to Grids and Copy Attributes. 

 
 

 
 

   

 
 
 

 
 

The Patterns and Gradient Toolbar 
Note: Patterns and Gradient fills are not supported on the Web. 
The Patterns toolbar contains 16 different fill patterns, including solid and transparent. The 
Image drawing patterns also support 32 gradient styles. The first color used for the 
gradient is the foreground color, while the last color used is the background color.  
Gradient fills are supported for the following objects: Text, Filled Box - Circle, and Polygon. 
Pipes do not support Gradient fills. 

Notes 

1. Gradients are not fully supported on Windows 98. Circles, 
ellipses and rounded rectangles will be drawn as rectangles. 

2. In the ILS file the gradient pattern numbers run between 100 to 
131 ordered by the above list.  

3. Bitmap fonts are not effected by the Gradient. 

4. After changing attributes of gradient objects, or moving from 
select mode, image may need refresh. 

5.  Performance may suffer when drawing large gradient surfaces 
with many steps. It is advisable that only static (background) 
object will be using the  Gradient. Dynamic over Gradient is 
possible but performance may suffer. It is also advised to do 
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development in low number of steps and later increase steps for 
run-time. 

6. To set the gradient steps use Image Properties View or in the 
Wiztune.dat file, manually set the tuning parameter 
IMG_GRAD_STEP= n). Valid values are between 2 to 255 – 
Default is 16. Re-enter Image. 

7. Transparent color will have 'unknown' effect over fill. 

8. The gradient is not affected from rotation or transformation. It is 
possible to rotate objects with Gradient but the Gradient 
orientation will not be rotated 

9. Not supported on Web. Note that if patterns are used and then 
brought to the Web, the patterns turn to solid colors. 

10. The gradient for a group works like for a pattern.  

11. It is not possible to select Gradient fill type in Dynamic definition 
Fill Type range. 

12. The gradient’s center reference point for filled polygons, 
orthogonal polygons, and filled arcs is always calculated by the 
visible parts of the objects. Therefore, when you scroll and the 
object partially disappears from view, you will notice that the 
object’s center point moves upwards away from the center. 

 
 

 
 

   

 
 
 

 
 

The Toolbar 
This toolbar is located under the Image menu and includes shortcuts to menu items such 
as Save, Print, Navigate mode, Goto Zone, Grid setup and Mark triggers. 
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The Status bar 
The Status Bar appears at the bottom of the Image Window. The Status Bar displays 
information about images, features, and procedures. 

 
 

 
 

   

 
 

 
 
 

Toggle Fill    
The Toggle Fill operation is used to fill and empty objects. The Toggle Fill tool operates as 
a toggle. 
Note that when an object is unfilled it still retains its fill attribute, which can be restored at 
any time. 
To use the Toggle Fill Tool 
1. Select an object. 
2. Click the left mouse button on the Toggle Fill tool in the Operations Toolbar. 
 Or 
 From the Edit Menu, select Operations, then click on the Toggle Fill option. 

 
 

 
 

   

 
 
 

 
 

The button panel title  
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Trigger Button Definition   

Title The button group title (optional). 

Legend A description of the buttons. In this field, any button letter can 
be highlighted for keyboard entry by prefixing it with 
the ampersand (&) character. 

Value The button value. If the object was defined as a string tag the 
value can be any numeric, alphabetic, or 
alphanumeric value. 

Zone The zone to jump to when the button is activated. This field is 
optional. After checking this option click the Zone field 
and select the relevant zone. 

Zone Navigator The Zone Navigator is a global multi image zone 
navigation window that enables you to quickly and 
efficiently navigate through image files. After checking 
this option click the Browse button to open the Zone 
Navigators dialog box and select the relevant Zone 
Navigator.  

Macro The macro to activate when the button is activated. This field is 
optional. Not applicable on the Web. 

Add The button is added to the list. 

Change The button definition is changed. 

Delete The button is deleted from the list. 

Style The button arrangement style: 

 Horiz, for horizontal rows. 

 Vert, for vertical columns. 

 Rect, for rectangular arrays. 

Optional Optional buttons (Cancel, Help and Execute). Select Execute 
to provide added user security by displaying dialog 
boxes that must be confirmed before an action is 
executed. 

Button Size Button size adjustment. 
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 Use the <arrow> keys to change the size of the example button that 
appears in the field. The <PageUp> and <PageDown> 
keys also affect the size of the example button, and 
the <Home> key changes the button back to its 
default size. 

Save The button definition is saved in a file. 

Use Enables the operator to apply files that contain tag values. The files 
must have been saved earlier with the Save button. 
Tag value files can be edited using the system editor. 

Notes 

1. A new button can be defined and added to the list by activating 
the Add button. A button can be selected from the list, its 
characteristics modified, and the revised definition saved, by 
activating the Change button. A button is deleted from the list by 
activating the Delete button. 

2. If an ampersand (&) character precedes any part of the text 
specified in the Legend field, the operator will be able to activate 
that button by pressing the <Alt> key together with character that 
follows the ampersand (the character that will be underlined). For 
example, if a button legend is specified as O&FF, the actual text 
will appear as OFF, and the operator will be able to activate that 
button by pressing the <Alt> key together with the <F> key. 

3. In the Macro field, you can specify a macro that you want to be 
activated by typing the name of the macro, or by clicking on the 
arrow to the right. When you click on the arrow, a list of 
predefined macros will appear for you to select from.  

4. If more than one operation is assigned in this dialog box, the 
operations will be performed in the following order: goto zone, tag 
assignment, run macro. If one of the operations fails, the next 
operation will not be executed. 

5. Activate the Save button and type a name. Once action buttons 
are saved for a specific object, they will appear each time the 
operator clicks on that object. Then, clicking on any button will 
apply that value to the tag. 

6. (Optional) If you selected Execute a window containing the 
button panel you defined is displayed.  

7. Click Execute to confirm and execute the action. You can also 
click Cancel to cancel the action and return to the Preset Buttons 
Definition dialog box. 

8. Note: The dialog box will disappear after a predetermined 
amount of time if you do not select any of the available options. 
The time parameter for the display of this dialog box is specified 
in the wiztune.dat file, as follows: 

TRIGGER_BUTTONS = TIMEOUT 
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The default value is 20 seconds.The maximum value is 100 seconds. 
 
 

 
 

   

 
 

 
 
 

Trigger object are objects that you can click on to cause predefined tag values to be set 
automatically or manually, cause the image to go to a predefined zone, or cause 
predefined macros to be activated. 
Any object (static, dynamic, segment) can be defined as a trigger object. However, only 
one tag value input method can be assigned per object. 

 
 

 

 
   
 
 
 
 

Trigger Objects   
Trigger object are objects that you can click on to cause pre-defined tag values to be set 
automatically or manually, cause the image to go to a pre-defined zone, or cause pre-
defined macros to be activated. 
Any object (static, dynamic, segment) can be defined as a trigger object. However, only 
one tag value input method can be assigned per object. 
The tag value input method that you select in the dialog box will be marked by an arrow. 
 
Note that you may use a tag template Id as a tag. This will enable the trigger to be 
dependant on current image context 
 
Note that for the Data Entry, Bit, Smooth, and Test, the last position of the dialog box will 
be saved (unless you activated the Cancel button before completing the operation). This 
means that you can drag the dialog box to any position on the screen, and thereafter, 
whenever that dialog box will be invoked, it will appear in its last position. 
However, the dialog box position is relative to the window position. If the window is moved 
and then the dialog box is invoked, it will appear in the position it was last saved, relative to 
the new location of the window. 
 
For Text Table objects, the String button will appear in the Input Method field instead of 
Data Entry. For Time objects, the Time button will appear in the Input Method field instead 
of Data Entry. For Date objects, the Date button will appear in the Input Method field 
instead of Data Entry.  
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To define a trigger 
1. Select the object you want to define as trigger. 
2. Right click the selected object. 
3. Select the Trigger Definition from the popup menu. 
OR 
 From the Edit menu select Operations, then click on the Trigger option. 
OR 
 From the Objects toolbar select the Trigger tool The Trigger Object Definition dialog box 
opens  
4. Select the application station to which the tag associated with the trigger object is 
attached. 
5. Select the tag associated with the trigger object, or click the browse button to open the 
Tag Definition dialog box where you can define a new tag. 
6. Select the trigger object Input Method. Several tag input methods can be used for trigger 
objects. To test an input method, tag value variations can be simulated.  
 The tag value input methods include the following: 
Action  When the operator clicks on an object, a present value is applied to the tag, or a 
pre-defined macro is activated. This method is valid for all tags and objects. 
Buttons When the operator clicks on an object, a set of buttons with present values 
appears. Activating a button causes a value to be applied to the tag, or a pre-defined 
macro to be activated. This method is valid for all analog and digital tags. 
Bit When the operator clicks on an object, On, Off, and Toggle buttons appear. This 
method is valid for all tags and objects (except string tags). 
Data Entry When the operator clicks on an object, a dialog box appears to specify a 
numerical tag value. This method is valid for all tags and objects besides Text Table 
objects. 
String The String button will appear instead of the Data Entry button. When the operator 
clicks on an object, when a Text Table that was made active for the tag associated with the 
object, will be applied. The Text table contains a list of strings corresponding to different 
tag values. 
Date The Date button will appear instead of the Data Entry button. When the operator 
clicks on an object defined as a Date/Time object, a dialog appears with the current date 
value to be modified. 
Time The Time button will appear instead of the Data Entry button. When the operator 
clicks on an object defined as a Date/Time object, a dialog appears with the current time 
value to be modified. 
Smooth When the operator clicks on an object, a dialog box appears with tag values that 
can be selected using sliders. This method is not valid for string tags.  
Momentary When the operator clicks on an object, a dialog box appears enabling the user 
to change tag value in a one short way. 
Fast Action When the operator clicks on an object, a pre-defined macro, called Fast 
Action is executed (note that Fast Action is Web enabled). 
7. Click the Set Macro button to define macros for trigger objects (note that Set Macro is 
not supported on the Web). 
8. Click the Test button to test the input method and adjust its appearance. In addition you 
can move the numeric keypad to any location on your screen. When you re-open the 
application and operate the keypad, it will be opened at the same location as you selected. 
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Trigger Macros   
Note: Trigger Macros are not supported on the Web. 
Once you have defined Trigger objects, you can define special macros to apply Trigger 
object operations. To define Trigger macros, activate the Set Macro button in the Trigger 
Object Definition dialog box. 
The fields in this dialog box are: 
Name The name of the macro. 
Description A brief description of the macro. 
Accelerator keys Alt, Ctrl, shift and function keys that can be used in combinations to 
invoke the macro. 
Confirm before execution This option is use to cause the application to prompt you to 
confirm the execution of a macro before it is executed. 
Execute when out of VP Used to cause a macro to be executed even when the trigger 
object does not appear visually in the Image window. 
Group Used to assign groups to operators for macro authorization. 

Note that trigger macros will only be executed if the Trigger mode is 
activated (by selecting the Trigger On item from the Modes menu, in the 
Image window). 

 
 

 
 

   

 
 

 
 
 

Undo/Redo    
Undo and Redo operation is available for Image drawing operations. This applies to 
actions as delete, scale, rotate and change attributes (color) of an object. 
The Undo command reverses or deletes the last entry. 
Immediately after you undo an action, the Undo command changes to Redo, allowing you 
to restore what you reversed. 
Up to 50 levels of undo/redo operations are available. 
To Undo  
1. Select object you want to undo. 
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2. Click on the Undo tool in the Image main toolbar. 
3. The action is reversed. 
You can also Undo an action by clicking the Undo option from the Operations Menu, or 
pressing Ctrl Z. 
To Redo 
1. Select the object you want to redo. 
2. Click on the Redo tool in the Image Main Menu Toolbar. 
3. Your action is restored. 
You can also Redo an action by clicking the Redo option from the Operations Menu, or 
pressing Ctrl Y. 

Notes  The Align feature does not support the Undo feature. Copying 
objects using <Ctrl C> does not support the Undo feature.  

 
 

 
 

   

 
 

 
 
 

Undo Redo 
Undo and Redo operation is available for Image drawing operations. This applies to 
actions as delete, scale, rotate and change attributes (color) of an object. 
The Undo command reverses or deletes the last entry. 
Immediately after you undo an action, the Undo command changes to Redo, allowing you 
to restore what you reversed. 
Up to 50 levels of undo/redo operations are available. 
To Undo  
1. Select object you want to undo. 
2. Click on the Undo tool in the Image main toolbar. 
3. The action is reversed. 
You can also Undo an action by clicking the Undo option from the Operations Menu, or 
pressing Ctrl Z. 
To Redo 
1. Select the object you want to redo. 
2. Click on the Redo tool in the Image Main Menu Toolbar. 
3. Your action is restored. 
You can also Redo an action by clicking the Redo option from the Operations Menu, or 
pressing Ctrl Y. 

Notes : The Align feature does not support the Undo feature. Copying 
objects using <Ctrl C> does not support the Undo feature.  
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Unfilled Closed Arc Tool    
To draw an unfilled closed arc 
1. From the Drawing Toolbar, click on the unfilled closed arc . 
2. Position the mouse pointer where you want to start drawing. 
3. Drag to end point. 
4. Release mouse button.  
5. Move the mouse to the desired radius point and left-click the mouse button. 

 
 

 
 

   

 
 
 

 
 

Unfilled Circle Tool   
• To draw an unfilled circle 

1. From the Drawings toolbar, click on the circle tool  
2. Position the mouse pointer where you want to start drawing. 
3. Drag to form the circle. 
4. Release mouse button. 
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Unfilled Orthogonal Polygon Tool   
• To draw an unfilled orthogonal polygon 

1. From the Drawings toolbar, click on the unfilled closed orthogonal polygon tool  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right button and the last point will automatically be connected to the start point, 
closing the polygon. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 

 
 

 
 

   

 
 
 

 
 

Unfilled Ellipse Tool   
• To draw an unfilled ellipse 

1. From the Drawings toolbar, click on the unfilled ellipse tool  
2. Position the mouse pointer where you want to start drawing. 
3. Drag to form the ellipse. 
4. Release mouse button. 

 
 

 
 

   

 
 
 

 
 

Unfilled Polygon Tool   
• To draw an unfilled polygon 
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1. From the drawings toolbar, click on the unfilled polygon tool  
2. Click the left mouse button on the start point. 
3. Click the left mouse button on successive end points. 
4. Click the right button and the last point will automatically be connected to the start point, 
closing the polygon. 

Tip: You can create an arc instead of a straight line by clicking on the 
line end while pressing the Shift key. The line between the last two 
points will be an arc whose radius can then be adjusted by pressing the 
left mouse button. 

 
 

 
 

   

 
 

 
 
 

Unfilled Round-cornered Rectangle or Square Tool    
• To draw a round cornered unfilled rectangle or square 

1. From the Drawings toolbar, click the round cornered rectangle tool  
2. Position the mouse pointer where you want to start drawing. 
3. Drag diagonally. 
4. Release mouse button. 

 
 

 
 

   

 
 

 
 
 

Using the Text Tool 
• To use the text tool 

1. From the Drawings toolbar, click on the text tool  
2. Enter text in the text dialog box. 
3. Press OK and the text will appear at the specified location on the screen. 
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Click to load a file that was saved with pre-defined button settings.  
 
 

 

 
   
 
 
 
 

A value that will be assigned to the tag whenever the button is activated  
 
 

 
 

   

 
 
 

 
 

Viewing Images 
 
There are several ways to view images, using several window positions and zoom levels. 
You can auto arrange all the image objects, or zoom into a specific part of the image, or 
jump to a pre-defined position and zoom level, called Zone, in the image, or define the 
coordinates within the image window you wish to jump to. 
For more information about the various image view options click the respective topic: 
AutowindowHLP_WZ2EDT_AUTOWINDOW  
Zooming into a specific part of the image 
Defining ZonesHLP_DLG_WZ2_DZONE  
Jumping to Zones  
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HLP_DLG_WZ2_HANDNAV  
 
 

 
 

   

 
 

 
 
 

Unfilled Rectangle or Square Tool  
To draw an unfilled rectangle or square 
1. From the Drawing toolbar, click the filled rectangle tool. 
2. Position the mouse pointer where you want to start drawing. 
3. Drag diagonally. 
4. Release mouse button. 

 
 

 
 

   

 
 
 

 
 

Widgets / Scheduler 
Select this option and then click in the Image windows to open the Scheduler Task 
Configuration Dialog box. 
In the Task Name field type in the name of the task or, click the arrow and select a task 
from the dropdown list. 
To attach groups, click the Groups button to open the Access Permission Manager dialog 
box where groups can be defined and given access to this module. 
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Widgets / Slider 

Note: This feature is not supported on the web. 
Tag value sliders (widgets) can be designed and used in an Image to change and read tag 
values in a simple visual manner. The sliders can be positioned anywhere in the Image 
and will automatically reflect any change in the tag value that occurs in the field. 
The following points should be noted when working with tag value sliders: 

• Tag value sliders are system windows that operate using system controls. 
• Tag value sliders are automatically generated as trigger objects, and therefore can 

only operate in the Trigger mode. 
To design a slider: 
From the Edit menu, point to Drawings and then to Widgets.  
Select Slider from the popup menu. 
Or, 
Click the Slider tool in the Objects Toolbox. The Slider properties dialog box is displayed: 
The following fields are available: 

Station Specifies the network station to which the tag belongs. For a list 
of stations from which you can select, click on the 
arrow to the right of the field. 

Tag Specifies the tag to be associated with the slider. For a list of tags 
from which you can select, click on the arrow to the 
right of the field. 

Value Assignment  Select On Dragging to cause the value of the 
associated tag to change as the slider is dragged. 

 Select On Dropping only to cause the value of the associated tag to 
change only when you complete the dragging (release 
the mouse button) and place the slider on a specific 
value. 

 Select On Dragging to Image, on dropping to Tag to cause the value of 
the associated tag to change and be reflected in the 
Image only as the slider is being dragged, and change 
and be written to the PLC when you complete the 
dragging (release the mouse button) and place the 
slider on a specific value. 

 Select Snap to Tick to cause the slider to snap to ticks on the value 
scale whenever it is moved, or the tag value changes 
in the field. 

Limits Select Default tag limits to cause the value scale limits to be 
those you defined for the tag in the Tag Definition 
procedure. 



Chapter 21 Image Editor 

1021 

 In the From/To fields you can specify the values you want for the upper 
and lower limits of the tag scale. 

 
 

 
 

   

 
 

 
 
 

A zone that will be jumped to whenever the button is activated  
 
 

 

 
   
 
 
 
 

Zone Definitions 
 
A Zone is a pre-defined position and zoom level in the image that can be jumped to, by 
selecting the Goto Zone item in the Options menu. 

 
 

 
 

   

 
 
 

 
 

A Zone Navigator window that will be opened whenever the button is activated  
  

 
 

 



Chapter 21 Image Editor 

1022 

 

   
 
 
 
 

Widgets / Media 

Note: Media Player is not supported on the Web. 
The Media Player enables you to play any Media file that is installed on your computer. 
Usually this object is used to play ‘AVI’ files that display some information to the operator.  
To Define a New Media Object 
Select the Media tool located in the Objects Toolbar.  
Draw a rectangle in the initial size you wish. The Media Player Properties dialog box opens 
where you can select the Media device (file) you wish to play. 
You can set the Media window to include a title bar with your own text. The Media device 
will be displayed ‘Stretched ’ to the object size. A small control bar is displayed at the 
bottom on the object with the options to Play, Stop, Pause, Fast Forward and Rewind. 
You can select and edit the object size and the location can be manipulated as any other 
object. To change the object properties double-click on it. 

 
 

 

 
   
 
 
 
 

Modifying a Grid 
You can determine how the grid lines appear in the grid by specifying the distance between 
adjacent grid lines. The grid lines then appear with specified intervals between them. You 
can also define the color in which the grid is displayed.  
  
To modify a grid: 
1. Select Grid Setup from the Setup menu. The Grid Setup dialog is displayed: 
2. In the Snap to tag field, select a tag from a list of available tags. The selected tag is 
referred to when determining the line spacing. 
3. In the Value Axis area, select either Each annotation to display the grid according to 
the annotations on the Value axis, or enter a value in the Spacing value field to determine 
the distance between the adjacent grid lines.  
 The Trend mechanism will check the values you enter for their validity. You can enter ? in 
the Spacing value field to view the high and low values that are valid for the current Trend 
viewer settings. 
4. In the Time axis area, select either Each annotation to display the grid according to the 
annotations on the Time axis, or enter a value in the Spacing value field to determine the 
distance between the adjacent grid points.  
5. Click in the Grid color field to display a color pallet in which you can select the grid 
color.  
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6. Click OK to close the dialog and save your settings. The application will display an error 
message if you have entered any invalid parameters. 
  
Specifying the Orientation of the Grid Axes  
In the default positioning of the grid axes, the Y axis displays tag values and the X axis 
displays time, as shown below. The Application enables you to change the orientation of 
the Value and Time axes so that the Y axis displays time and the X axis displays tag 
values.  
  
In the following Trend, the orientation of the axis has been modified so that the tag values 
are displayed on the X axis and the time on the Y axis. 
Axes orientation changes are in effect until you refresh the browser. Changes are made 
online and do not effect current grid setup and display parameters. 
  
To change the default orientation of the grid axis:  
From the Options menu, select Axis Orientation and then select Inverse Orientation. 
The grid lines are adjusted so that the tag values are displayed on the X axis and the time 
on the Y axis, as shown above.  
Note: When Inverse Orientation is selected, the Tag Setup and Time Setup options are 
disabled. 
  
To revert to the default orientation settings of the grid axis: 
From the Options menu, select Axis Orientation and then select Normal Orientation.  
The grid lines are adjusted so that the tag values are displayed on the Y axis and the time 
on the X axis 

 
 

 
 

   

 
 
 

 
 

File / New / Image 
Select this item to define a new Image window.  
After you select this item, you will be prompted to specify the name of the window you want 
to define. All names should be unique.  
The window will be created with the default Image window properties. 
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File / New 
Select this item to define new Layouts for windows.  
Layouts are sets of windows that can have different attributes, such as size, components 
(title bar, action bar, etc.), and others. 
.  

 
 

 

 
   
 
 
 
 

Image Property Trigger    
Note: Not applicable on the Web. 
This tab defines trigger objects and onmouseover properties. 
This tab holds the following fields: 
Trigger object Determines whether trigger objects are highlighted when 

selected. If this option is checked, trigger objects will be 
outlined (with dashed lines) when they are selected. The 
default option is not selected. 

Mouse pointer on triggers Determines whether the mouse pointer will be highlighted 
when it is moved on top of a trigger object in an image. The 
default option is not selected. 

Trigger small input box When checked, the input box when defining data entry for 
triggers, will be small and and will only have a field for entering 
the value.  

State Determines which trigger object is activated when overlapping 
triggers are clicked. This could be either; Top (default) or 
Bottom. 

Note: Always restart the program after updating this tab. 
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Image Property Loading    
Note: Not applicable on the Web. 
This tab determines the amount of memory available for image objects. It also 
enables/disables tag name parsing when loading images and determines the mode in 
which the image will open.  
Notes:  
1. 1. Setting the amount of memory available for image objects is not applicable on the 
Web. 
2. 2. Always restart the program after updating this tab. 
The following options are available: 
Images memory pool size Enables large images with many objects to be created, 

but allows only 10 (+-) Image windows to be open at 
one time. The lower the value, the more Image windows 
that can be opened simultaneously (they must be 
smaller in size). The value for the parameter can be set 
from 60 to 200. 

Parse each image when 
loading 

Enables or disables tag name parsing when loading in 
the Images module. Disable this option to shorten image 
load time for images that contain network tags. 
When this option is disabled network tags validity is not 
checked. Therefore, use this option after all tag 
definitions in the network station are complete. 

Open new image in Navigation 
mode 

This checkbox defines that the new image will be 
opened in Navigation mode. 

Load bitmaps in system 
memory 

By default, when you add a bitmap to an image, the 
memory it uses is stored in the memory of the graphics 
card. When adding many bitmaps to an image, the 
memory can be used up very quickly. You can choose 
to use the computer’s own memory if you choose this 
option. It will allow you to add many more bitmaps to the 
images. This option is disabled by default for backwards 
compatibility, but we recommend that you activate it for 
better performance.  

Disable automatic calibration 
of new images 

If images are developed on a machine with a given 
screen size, and then deployed on a different machine, 
they can have a different appearance (e.g. stretched). 
By default, images are automatically rescaled to avoid 
this problem. You can disable it if you want. If you do 
this, you can specify the size of the screen that you are 
using (4:3, 5:4 or 16:9) in order to find the most 
satisfactory appearance for your machine. 
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Image Property View    
Note: Not applicable on the Web. 
This tab is used to define the properties of the Image window, repaint and resolution level. 
The following options are available: 
Repaint images after editing 
operations 

When checked this field defines that an image will 
be repainted automatically after actions that may 
alter the image (such as, moving, copying) are 
performed. This option is useful in small and 
medium zones. 

Resolution factor Sets global stretching or shrinking factors 
applicable to all images. This is required to solve 
display differences caused by replacing an 
operating system, monitor or other H/W or to 
move between resolutions. 

Number of gradient color steps This field determines the number of steps used 
when drawing objects filled with gradient color. 
The default is 16. Drawing large gradient surfaces 
in many steps may be slow therefore, develop 
using few steps and then increase for run-time. 

Advanced button Displays the Image Window Attributes dialog box 
where window attributes are defined. 

Note: When changing the Resolution Factor the window remains the same size in pixels. 
However a centimeter in one image will not be a centimeter in another. The image remains 
unchanged when the value is 1. Values greater than 1 expand the image.  
To set correct application values: 
1. 1. Load the image in a PC and measure an object’s length in the image (a line will do). 
2. 2. Load the same image in another PC and measure the same object’s length. 
3. 3. Divide the first length by the second length and the result is the xx.xx value. 
4. 4. Enter the IMG_RESFACTOR with the value you found and reload the application. 
The range is 0.1<=IMG_RESFACTOR<=10. 
The default value: 1 
5. 5. Restart the application for changes to take effect. The range of the factor is 
0.1<+IMG_RESOLUTION _FACTOR<=10. 

 
 

 

 
   
 
 
 
 

Save As Layout 
Select this item to save the current layout with a new name. 
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Save Layout 
Select this item to save the current layout with its original name.  
  
If a layout already exists with that name, you will be prompted whether you want to save or 
discard the current layout.  

 
 

 

 
   
 
 
 
 

A zone is a specific area in a Application image marked for navigational purposes. Once 
defined zones can be used in go to and macro operations, to cause specific image 
sections to dill the image area of the window immediately. 
  
Zones are defined by selecting the Zones definition item from the Options menu in the 
image window. 

 
 

 

 
   
 
 
 
 

In Images, the scale represents the zoom level of the image. The smaller the scale, the 
closer the image will be (objects will be larger), and less of the total image will be visible. 
Any scale form 1 to 2048 can be assigned. At a scale of 64, each drawing unit is 0.01 mm 
on a standard monitor. 
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A segment is group of objects act as one object. Segment can be grouped, and their 
attributes can be edited the same way as any other object. Segments are defined by 
selecting the Edit/Operation/Segment menu sequence in the image window. 

 
 

 

 
   
 
 
 
 

File / New / Image 
Select this item to define a new Image file.  
After you select this item, you will be prompted to specify the name of the file you want to 
define. All names should be unique.  
The file will be created with the default Image file properties. 

 
 

 

 
   
 
 
 
 

A Graph is a tag display defined for a specific chart. Each chart can include up to 16 
graphs. Graphs can appear in the format of bars, lines, line with markers, or marker only. 
The graphs definition dialog box is invoked by selecting the Graph definition item from the 
Setup menu, in the Chat window. 
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Picture file 
Pictures is a file representing a zone in an image. Pictures are created automatically when 
saving images. 
When you Save your Image, each zone is saved in a separate file in the Application 
Picture format (WNP extension), in your pictures' directory of your Web application. 

 
 

 

 
   
 
 
 
 

A Trigger Object is any object in an image defined to execute a specific operation 
whenever it is selected. 
Trigger objects are defined by selecting the Edit/Operation/Trigger menu sequence in the 
image window, or by clicking the left button on the trigger object tool in the tools window. 

 
 

 

 
   
 
 
 
 

Basic Principles 
This section describes some of the basic concepts used for image design that should be 
understood before using the Image Editor. 
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Goto Zones 
The operator with the relevant authorization can, using the Goto Zone option, jump to any 
defined zone from anywhere in an image. The Goto Zone dialog box is used to enter the 
coordinates of the location to which to jump in the image. Any position in the image can be 
jumped to whether or not that position is defined as a zone.  

 
 

 
 

   
 
 
 
 

Layers 
An image is structured in layers. Each layer contains a part of the overall image. When the 
drawing is completed the layers can be merged. Each individual image layer can be made 
visible or hidden. Layers can be added or changed, but not removed. 

 
 

 

 
   
 
 
 
 

Printing Images 
Images are printed from the Image file menu. 

o To print an Image file: 
Select Print from the File menu. The Print dialog box is displayed: 
1.   To send the Image to a file in the bitmap format 
2.   Select the Bitmap option and specify the filename. 

 
 

 
 

   

 
 



Chapter 21 Image Editor 

1031 

 
 
 

Zone Navigator 
The Zone Navigator is a global, multi-image zone navigation window that enables you to 
quickly and efficiently navigate through a list of zones defined in the application's various 
image files. A number of navigators each of which can contain a number of zones from one 
or more different image files can be defined in the module. 

 
 

 
 

   
 
 
 
 

Zones 
Zones are predefined positions in the image window.  
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This chapter describes how to use Image animation in the application, as follows: 
Overview provides an overview of Image animation. 
Dynamic Objects provides a description of dynamic objects and describes how to define 
them. 
Alarm Objects describes how to define objects as alarm objects. 
Trigger Objects describes how to define trigger objects. 
Modifying Object Properties, describes how to modify the properties of objects in 
Images. 
Input Method Preparations describes what to do before you can use an input method. 
Trigger Macros describes how to define trigger macros. 
Tag Value Sliders describe how to design sliders. 
Media Player describes how to define media players. 
Scheduler describes how to access this feature. 
Tag Value Simulation describes how to simulate tag values in Images. 
 

 
 

 
 

  

 
 

 
 
 

Overview 

Image Animation is the process of linking Image objects created by using the Image Editor 
to a control process via tags. Refer to Chapter 9, Tags for more information about tags 
and their relation to on-going processes. 
There are two main ways to implement Image Animation: 

o     Dynamic Objects - Objects in Images are associated with tags. Any change in 
tag values causes the object to change graphically. 

o      Trigger Objects - Objects in Images are designated as triggers. When these 
objects are activated, operations, such as tag value changes, are executed 
immediately, thereby affecting the graphic presentation of the Image. 

Each of these methods is described in the following sections. 
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Edit / Operations / Dynamic 
Used to define how a dynamic object will behave in response to tag variations. 
Once an object is defined as dynamic, as the value of its associated tag varies, the object's 
shape, position, or appearance will also change.  

 
 

 
 

  
 
 
 
 

Cancel Dynamic    

This option will cancel the dynamic performance of an object that was previously defined 
as a dynamic object. It will not respond to tag variations. 

 
 

 
 

  

Dynamic Objects 

 
 
 
 
 

Dynamic Objects 
Dynamic objects are elements that change according to tag values. When a tag value 
changes, the properties of the object, such as position, size, color, and orientation change 
accordingly (there are 12 different object properties). Thus, a dynamic graphical illustration 
of plant activity can be achieved. 
Any object in an Image can be dynamically animated, including process messages. In 
addition, process messages themselves can be made to change (textually) according to 
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tag values. Values can be presented numerically, or predefined messages can be 
displayed for each specific tag value. 
In order to implement object animation, tag value ranges are denoted by start and end 
values. The current state of an object corresponds to the start value, and the final state of 
an object, after changes, corresponds to the end value. Thereafter, for any tag value, the 
object will be changed proportionally (by linear interpolation or extrapolation). 
Tag values can be further divided into sub-values that control different display attributes, 
such as colors and fill patterns. For further details see Chapter 9, Tags. 
 

 
 

 
 

  

 
 

 
 
 

Dynamic objects are objects in the image that were defined to change graphically or 
textually according to the value changes of tags with which the objects were associated. 
Dynamic objects are defined by selecting an object, and then selecting the Dynamic button 
form the Objects Bar, or right clicking them. 

 
 

 

 
  
 
 
 
 

Edit / Operations / Dynamic 
Used to define how a dynamic object will behave in response to tag variations. 
Once an object is defined as dynamic, as the value of its associated tag varies, the object's 
shape, position, or appearance will also change.  
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Dynamic Parameters   
This operation is performed to make existing Image objects dynamic. 
Select the graphic object in the Image that you wish to include in the cluster, and do one of 
the following: 

• Click the Dynamic Definition tool in the Object toolbox.  
• Right click an object and select the Dynamic Definition option from the popup 

menu. 
• From the Edit menu, point to Operation and select Dynamic. 

The Dynamic Parameters dialog box is displayed. 
The following options are available: 
Ranged Parameters Includes the following fields: 
Station: Specifies the station running the application to which the tag belongs. To select a 
station from the list of stations defined in the application network, click on the arrow to the 
right. 
Tag: Specifies the tag associated with the selected object. To select an existing tag, click 
on the arrow to the right. 
From: Specifies the minimum tag value for which the animation will occur. 
To: Specifies the maximum tag value for which the animation will occur. 
Animation  Specifies the dynamic operation to be performed on the selected object for the 
specified tag value range. The operations include the following: 
Move 1: Positional variation 1. 
Move 2: Positional variation 2. 
Scale: Scale variation. 
Rotate: Orientation variation. 
Fill: Command to fill an object. 
Show: Specifies that an object will be visible when the value is within the specified value 
range, and hidden when the value is outside that range. 
Empty: Specifies that an object will be empty when the value is within the specified value 
range. 
Multi-Range 
Parameters The following options are available: 
Station: Specifies the station running the application to which the tag belongs. To select a 
station from the list of stations defined in the application network, click on the arrow to the 
right. 
Tag: Specifies the tag associated with the selected object. To select an existing tag, click 
on the small arrow to the right. 
Animation Specifies the dynamic operation to be performed on the selected object for the 
specified tag value range. The operations include the following: 
Blink: Specifies that an object will blink when the value is within the specified value range. 
Line Color: Sets the line color of an object when the value is within one of several 
specified value ranges. 
Fill Color: Sets the fill color of an object when the value is within one of several specified 
value ranges. 
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Fill Type: Sets the internal fill pattern of an object when the value is within one of several 
specified value ranges. Not applicable on the Web. 
Drum: Sets a bit pattern so that when a tag value matches this bit mask, the 
corresponding object will be visible; otherwise it will be hidden. 
Object The selected object to which the dynamic definition will be applied. 
Options Transformation options. 
Notes: 

1. In the Dynamic Parameters dialog box an arrowhead will appear beside any button 
that has been selected. 

2. When the Dynamic Parameters dialog box appears on the screen, no dynamic 
object animation will occur in the Image, although tag values will be updated. As 
soon as the dialog box is closed (when the OK or Cancel button is activated), all 
dynamic objects in the Image will be graphically updated. 

3. Several transformation and range parameters can be set for one object, each 
dependent on its associated tag value. The final appearance of an object will be 
the result of all the relevant transformations. However, if any one transformation is 
applied more than once, only the last application will be effective. 

4. Dynamic objects cannot be nested or grouped. 
5. When defining dynamic object attributes in the Dynamic Parameters dialog box, 

you can right-click to cancel the current operation. 
6. Note that you may use a tag template identidier as a tag. This will enable the 

trigger to be dependant on the current image’s tag context. 
 
 

 
 

  

 
 
 

 
 

Dynamic Object Definition 
This operation is performed to make existing Image objects dynamic. 

o To create a dynamic object: 
Select the graphic object in the Image that you wish to include in the cluster, and do one of 
the following: 
Click the Dynamic Definition button in the Object toolbox.  
Or, 
Right click an object and select the Dynamic Definition option from the popup menu. 
Or, 
From the Edit menu, point to Operation and select Dynamic. The Dynamic Parameters 
dialog box is displayed. 
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The following options are available: 

Ranged 
Parameters 

Includes the following fields: 
Station: Specifies the station running the application to which the tag 
belongs. To select a station from the list of stations defined in the 
application network, click on the arrow to the right. 
Tag: Specifies the tag associated with the selected object. To select an 
existing tag, click on the arrow to the right. Tag templates are 
supported (see the chapter on tag templates). 
From: Specifies the minimum tag value for which the animation will 
occur. 
To: Specifies the maximum tag value for which the animation will 
occur. 

Animation  

Specifies the dynamic operation to be performed on the selected 
object for the specified tag value range. The operations include the 
following: 
Move 1: Positional variation 1. See Move. 
Move 2: Positional variation 2. 
Scale: Scale variation. See Scale. 
Rotate: Orientation variation. See Rotate. 
Fill: Command to fill an object. See Fill Region. Show: Specifies that 
an object will be visible when the value is within the specified value 
range, and hidden when the value is outside that range. 
Empty: Specifies that an object will be empty when the value is within 
the specified value range. 
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Multi-Range 
Parameters    

The following options are available: 
Station: Specifies the station running the application to which the tag 
belongs. To select a station from the list of stations defined in the 
application network, click on the arrow to the right. 
Tag: Specifies the tag associated with the selected object. To select an 
existing tag, click on the small arrow to the right.  

Animation 

Specifies the dynamic operation to be performed on the selected 
object for the specified tag value range. The operations include the 
following: 
Blink: Specifies that an object will blink when the value is within the 
specified value range. 
Line Color: Sets the line color of an object when the value is within one 
of several specified value ranges. 
Fill Color: Sets the fill color of an object when the value is within one of 
several specified value ranges. 
Fill Type: Sets the internal fill pattern of an object when the value is 
within one of several specified value ranges. Not applicable on the 
Web. 
Drum: Sets a bit pattern so that when a tag value matches this bit 
mask, the corresponding object will be visible; otherwise it will be 
hidden. 

Object    The selected object to which the dynamic definition will be applied. 

Options    Transformation options. 

Notes: 
In the Dynamic Parameters dialog box an arrowhead will appear beside any button that 
has been selected. 
When the Dynamic Parameters dialog box appears on the screen, no dynamic object 
animation will occur in the Image, although tag values will be updated. As soon as the 
dialog box is closed (when the OK or Cancel button is activated), all dynamic objects in the 
Image will be graphically updated. 
Several transformation and range parameters can be set for one object, each dependent 
on its associated tag value. The final appearance of an object will be the result of all the 
relevant transformations. However, if any one transformation is applied more than once, 
only the last application will be effective. 
Dynamic objects cannot be nested or grouped. 
When defining dynamic object attributes in the Dynamic Parameters dialog box, you can 
right-click to cancel the current operation. 
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Dynamic Transformation   
This dialog box is used to change the default characters available for the Dynamic object. 
To perform dynamic object transformation operations, click the Option button on the 
Dynamic Parameters dialog box. The Options dialog box will appear.  
  
Hand Mode 
If this option is selected, the transformation parameters (such as Move, Scale and Rotate) 
will be defined numerically instead of graphically.  
  
Fixed Fill Area 
If this option is selected, the fill region will be set to the image instead of being attached to 
the transformed object. 
Note: Fixed Fill area is not supported on the Web. 
  
Fixed Scale Reference Point 
If this option is selected, the scale reference point will be set to the image instead of being 
attached to the transformed object.  
Note: Fixed Scale Reference Point is not supported on the Web. 
  
Fixed Rotate Reference Point 
If this option is selected, the rotate reference point will be set to the image instead of being 
attached to the transformed object. 
Note: Fixed Rotate Reference Point is not supported on the Web.  
  
Rotate Clockwise 
If this option is selected, the rotation will be performed in the clockwise direction, instead of 
counter-clockwise.  
  
Sample when out of VP  
In the application, dynamic objects that do not visually appear in the image window are not 
sampled. However, if an object was transformed using the dynamic move, resize, or rotate 
options, and after the transformation that object receives tag values that cause it to move 
outside the image window, you can use the sample when out of Window option to cause 
the object to be sampled.  
  

 
 

 

 
  
 
 
 
 

Optimizing Dynamic Object Performance 
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Dynamic updating in the Image is one of the most important operations in the Image. When 
a dynamic object changes its state, such as in tag changes or blink times, the Image 
redraws the object. This process is complex and uses a large amount of computer 
resources that should be optimized to run as fast as possible.  
To optimize your dynamic object performance use the following guidelines when designing 
your Image:  

o    Avoid putting too many fast changing dynamic elements in one zone.  
o    Minimize the size of fast changing dynamic objects. 
o    Avoid spreading fast changing dynamic elements out over the zone. 
o    Avoid putting other dynamic objects in the immediate surroundings of fast 

changing dynamics. 
o    Keep fast changing dynamic objects as simple as possible. Do not make a fast 

blink over a complex cluster or group. 
Each of the dynamic object attributes is described in the following sections. 

 
 

 
 

  
 
 
 
 

Dynamic Colors / Patterns    
Some attributes that can be applied to a dynamic objects are divided into several tag value 
ranges. These attributes include Blink, Line/Fill Color, Fill type, and Drum. 
Each Low and High value specifies a range to which the respective sample color/pattern 
will be applied.  
The color or pattern is changed by clicking on the sample color/pattern and then selecting 
the desired color or pattern from the options below.  
The ranges should be specified in ascending order. 

 
 

 

 
  
 
 
 
 

Move 
When the Move 1 button is activated, the Dynamic Parameters dialog box is temporarily 
disabled and the Editor enters the Move mode. When an object is moved to the location 
corresponding to the End Value parameter, the dialog box reappears for further setting. 
If the Hand mode is active, instead of moving the object, the operator enters the movement 
coordinates in the Move 1 dialog box. (See Transformation Options ). 



Chapter 22 Image Animation 

1044 

 
The following options are available:  

X Factor 
X    Specifies a horizontal change in drawing units (with a 
scale of 64, each unit being 1/100 mm), per unit change in 
the tag value. 

Y Factor    
Y Specifies a vertical change in drawing units (with a scale 
of 64, each unit being 1/100 mm), per unit change in the 
tag value. 

An animation feature enables the movement to reflect the combined value of two tags. To 
implement this feature, specify a new tag name or use the current tag name in the 
Dynamic Parameters dialog box, activate the Move 2 button, and specify the coordinates 
for the second tag in the Move 2 dialog that appears. 
The final position of an object is derived from the sum of the coordinates of each individual 
position. For example, diagonal movement can be obtained through the combination of one 
tag with a horizontal position parameter, and another tag with a vertical position parameter. 
 

 
 

 
 

  

 
 

 
 
 
Dynamic Hand Move    
Numeric move parameters: When the Move 1 button is activated, the Dynamic Parameters 
dialog box is temporarily disabled and the Editor enters the Move mode. When the Hand 
Mode is active (has to be activated in the Option button located in the dynamic parameter 
dialog box) the operator enters the movement coordinates in the dialog box: 
X Factor   
The factor of change along the horizontal axis (in Drawing Units) per unit change in the tag 
value.  
Y Factor  
The factor of change along the vertical axis (in Drawing Units) per unit change in the tag 
value.  
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Rotate 
When the Rotate button is activated, the Dynamic Parameters dialog box is temporarily 
disabled and the Editor enters the Rotate mode (see Chapter 20, Introduction to the 
Image Module and Chapter 21, Image Editor). When the object is rotated to the 
orientation corresponding to the End Value parameter, the dialog box reappears for further 
setting. 
Note:     If the start point is identical to the end point, clicking on a rotation point will rotate 
the object 360 degrees. 
If the Hand mode is active, instead of rotating the object, the operator enters the rotation 
parameters in the Rotate dialog box: 

  
The following options are available: 

Angle    Specifies the rotation angle in degrees, per unit change in 
the tag value. 

Reference 
Point 

Specifies the X and Y coordinates of the rotation axis. The 
default coordinates are those of the lower left corner of the 
bounded segment rectangle. 

The rotation axis can be made to relate to the Image or the object itself, by specifying the 
required parameter in the Options dialog box (which is accessed by clicking the Options 
button in the Dynamic Parameters dialog box). 
Note:     Rotation from the Start orientation to the End orientation will be in the counter-
clockwise direction, unless otherwise specified in the Options dialog box. 
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Dynamic Hand Rotate   
Numeric rotate parameters: When the Rotate button is activated, the Dynamic Parameters 
dialog box is temporarily disabled and the Editor enters the Rotate mode. When the Hand 
mode is activated (activation by pressing the Options button located in the Dynamic 
Parameter dialog box and then pressing the move button), the operator enters the rotation 
parameters in the dialog box: 
Angle 
The angle change (in degrees) per unit change in the tag value.  
Reference Point 
Rotation reference point coordinates (in Drawing Units).  

 
 

 
 

  
 
 
 
 

Scale 
When the Scale button is activated, the Dynamic Parameters dialog box is temporarily 
disabled and the Editor enters the Scale mode. When an object is scaled to the size 
corresponding to the End Value parameter, the dialog box reappears for further setting. 
If the Hand mode is active, instead of sizing the object, the operator enters the scaling 
parameters in the Scale dialog box. 

 
The following options are available: 

X Factor Specifies the horizontal scaling in drawing units, per unit change in the 
tag value. 

Y Factor Specifies the vertical scaling in drawing units, per unit change in the tag 
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value. 

Reference 
Point 

Specifies the X and Y coordinates. The default coordinates are those of 
the lower left corner of the rectangle bounding object. 

The scaling reference point can be made to relate to the Image or the object itself, by 
specifying the required parameter in the Options dialog which is activated by clicking the 
Options button in the Dynamic Parameters dialog box.  

 
 

 
 

  

 
 

 
 
 
Dynamic Hand Scale   
Numeric size parameters 
When the scale button is activated, the Dynamic Parameter dialog box is temporarily 
disabled and the Editor enters the Scale mode. When the hand mode is activated 
(activation is done through the Options button located in the Dynamic Parameters dialog 
box), the operator enters the scaling parameters in the dialog box: 
X Factor 
The factor of change along the horizontal axis (in Drawing Units) per unit change in the tag 
value.  
Y Factor 
The factor of change along the vertical axis (in Drawing Units) per unit change in the tag 
value 
Reference Point 
Scaling reference point coordinates (in Drawing Units).  
  

 
 

 
 

  
 
 
 
 

Fill Region 
Like other object elements, the fill region of an object can vary according to the tag value, 
and is set according to the Start and End values. 
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When the Fill button is activated, the Dynamic Parameters dialog box will be moved 
temporarily to the background and a half-filled box icon will be attached to the cursor. Click 
the left button and drag the mouse to the Start Value area. Click the left button again to fill 
the End Value area. Click the right button to abort the operation. When the Fill operation is 
complete, the Dynamic Parameters dialog box will return to the foreground for further 
specifications. 
The filling reference point can be made to relate to the Image or the object itself by 
specifying the required parameter in the Options dialog box. 

 
 

 
 

  
 
 
 
 

Dynamic Fill Type    
Some attributes that can be applied to a dynamic objects are divided into several tag value 
ranges. These attributes include Blink, Line/Fill Color, Fill type, and Drum.  

Note that Fill Type is not supported on the Web. 
Each Low and High value specifies a range to which the respective sample color/pattern 
will be applied.  
In the low and high value entry specify the value range for which the pattern you selected 
will be active. Then select a pattern for the range you specified, by clicking on the arrow to 
the right of the pattern field. You can move from field to field by pressing the Tab key on 
the keyboard. 

 
 

 
 

  

 
 
 

 
 

Show/Empty 
The Show and Empty attributes can be applied globally for an entire tag range, as follows: 

Empty Object 
When the Empty button is clicked, the object will be empty for the 
given value range, and filled when outside that range (if the object is 
defined as a filled object). 

Show 
Object    

When the Show button is activated, the object will be visible for the 
given value range, and hidden when outside that range. 
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For each global setting, if you use a range in which the first value is greater than the 
second, the opposite effect will occur (the object will be hidden) for the range specified.  
For example, if you use the range 10-4.9 for each of the settings, the following will occur: 

o    The object will be filled for any value from 5 to 10. 
o    The object will be hidden for any value from 5 to 10. 

You can select Force Dynamic Show from the Options menu in the Image window to cause 
a dynamic object in an Image to always appear, even if that object is currently hidden in 
accordance with a Show Object specification.  
Or, you can click on the Force Dynamic Show icon in the Image toolbar. 
In addition, note that the lower value must be a value within the range of show values, for 
the hidden option to operate (such as 10-4.9 described above). 

 
 

 
 

  

 
 

 
 
 

Fill Colors and Types 
Some attributes that can be applied to dynamic objects are divided into several tag value 
ranges. These attributes include Blink, Line Color, Fill Color, Fill Type and Drum. Each of 
these attributes is described in the following paragraphs. 
Dynamic colors and patterns can be applied to objects by activating the Line Color, Fill 
Color or Fill Type button. 

 
 

 

 
  
 
 
 
 

Colors 
Click the Line or Fill Color button to display the following dialog box: 
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In the Low Value and High Value entry boxes, specify the value range for which the color 
you select will be active. Then, select a color for the range you specified, by clicking on the 
arrow to the right of the color field. You can move from field to field by pressing the <Tab> 
key. 
Note:    Each range should be specified in ascending order. No overlapping is allowed. 
For values that are not included in the ranges you specified, the object will maintain its 
original attributes. 

 
 

 
 

  
 
 
 
 

Types 
Note:     This feature is not supported on the web. 
The Fill Type button when clicked opens the following dialog box: 
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Follow the instructions for Colors to complete this dialog box. 
 

 
 

 
 

  

 
 

 
 
 

Dynamic Object Blinking 
o To define a dynamic object to blink: 

Click the Blink button in the Dynamic Parameters dialog box. The following dialog is 
displayed: 
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The following fields are available: 

Low Value Specifies the minimum tag value for which the dynamic 
object will blink. 

High 
Value 

Specifies the maximum tag value for which the dynamic 
object will blink. 

Rate    

Specifies the amount of time that the dynamic object will 
appear on the screen, then disappear, then reappear, and 
so on. The value for Rate can be Fast, Medium or Slow. To 
select a rate, click on the arrow to the right of the field, or 
move to the field and use the up and down arrow keys to 
select an option. 

  
  
  
In the Tuning Parameters and in the WIZTUNE.DAT file (see Wiztune User Guide), the 
IMG_BLINKRATES parameter defines the blinking rate values for dynamic objects. The 
format of this parameter is: 
IMG_BLINKRATES=fast medium slow 
The values you specify for fast, medium, and slow are in milliseconds, and can be from 
100 (1/10 second) to 30,000 (30 seconds). If you specify a value that exceeds these limits, 
the application will automatically apply the maximum or minimum values instead. 
The default is IMG_BLINKRATES=500 1000 2000. 
Note:    You can also use commas (,) to separate the values.  
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Dynamic Object Blinking   
To define a dynamic object to blink, activate the Blink button in the Dynamic Parameters 
dialog box. 
For Low, specify the minimum tag value for which the dynamic object will blink.  
For High, specify the maximum tag value for which the dynamic object will blink.  
For Rate, specify the amount of time that the dynamic object will appear on the screen, 
then disappear, then reappear, and so on. The value for Rate can be Fast, Medium, or 
Slow.  
To select a rate, click on the arrow to the right of the field, or move to the field and use the 
up and down arrow keys to select an option.  
In the WIZTUNE.DAT file, the IMG_BLINKRATES parameter defines the blinking rate 
values for dynamic objects. The format of this parameter is:  
IMG_BLINKRATES=fast medium slow  
The values you specify for fast, medium, and slow are in milliseconds, and can be from 
100 (1/10 second) to 30,000 (30 seconds). If you specify a value that exceeds these limits, 
the application will automatically apply the maximum and minimum values instead.  
The default values are: IMG_BLINKRATES=500, 1000, 2000.  

Note that you can also use commas (,) to separate the values.  
 
 

 
 

  
 
 
 
 

The values you specify for fast, medium and slow are in milliseconds and can be from 50 
(1/20 second) to 30000 (30 seconds). If you specify a value that exceeds these limits, the 
Application will automatically apply the maximum and minimum values instead. 
It is recommended to increase the values for this option, if it is anticipated that a large 
number of dynamic objects on the screen will b updated at once. 

 
 

 

 
  
 
 
 
 

Drum Pattern 
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An object can be made visible when its associated tag value matches a specified bit 
pattern. The bit pattern can include Don't Care bits, which are bits that will be considered 
matches no matter what their actual values may be. 

o To assign a Drum Pattern: 
Click the Drum button to open the Drum Tag Definition: 

  
A bit pattern is entered as a sequence of zeroes, ones, or asterisks (*) that represent Don't 
Care bits. 
For example, using the pattern in the dialog box above,  
the value 0101101100011010001101110111010 matches the pattern,  
while the value 0101101100011010001101110110110 does not. 
If a tag value matches the specified bit pattern, the object will be made visible; otherwise it 
will be hidden. 
If several objects are associated with the same tag, each object requires its own pattern, 
so that each pattern will control the visibility of a different object. 
This tool can be used to capture several discrete states within a single analog tag. For 
example, a device can at any time be in the On, Off, Idle or Fail state, whereby each state 
is represented by a different bit in an analog tag. A bit pattern can be defined for each 
object that represents a state, and as the device changes states, its current state will be 
reflected in the Image by the respective object. 
If a tag value matches several patterns (due to the Don't Care bits), any object associated 
with those patterns will be made visible. 
Note:    You can select Force Dynamic Show from the Options menu in the Image window 
to cause a dynamic object in an Image to appear always, even if that object is currently 
hidden according to a Drum Pattern specification. 

 
 

 
 

  
 
 
 
 

Dynamic Drum Tag Definition  
An object can be made visible when its associated tag value matches a specified bit 
pattern. The bit pattern can include don't care bits, which are bits that will be considered 
matches no matter what their actual values may be. 
When the tag will have a value that matches the pattern, the object will be visible; 
otherwise, it will be hidden.  
The bit pattern is entered as 0, 1 or *, where * is a Don't Care value (0 or 1).  
For example, the pattern ***....**0 would cause the object to be visible only if the tag value 
is even.  



Chapter 22 Image Animation 

1055 

To assign a Drum Pattern 
1. Select an object in the image. 
2. Select the Dynamic Definition button from the Objects Toolbar (To make the object 
dynamic). 
3. Activate the Drum button from the Dynamic parameter dialog box. 

Note that you can select the Force Dynamic Show item from the 
Options menu in the image window to cause a dynamic object in an 
image to appear always. 

 
 

 
 

  

 
 

 
 
 

Transformation Options 
o To perform dynamic object transformation operations: 

Click the Options button to open the Options dialog box. 

 
The following options are available: 

Hand Mode    
When this option is selected, the operator will be able to enter 
numerical values for the Move, Scale, default, they are defined 
graphically in the Image. 

Fixed Fill Area 
When this option is selected, fill area borders will be fixed to their 
position in the Image. By default, the borders are bound to the object. 
Not applicable on the Web. 
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Fixed Scale 
Reference 
Point 

When this option is selected, the scale reference point is fixed to its 
position in the Image. By default, the point is bound to the object. Not 
applicable on the Web. 

Fixed Rotate 
Reference 
Point 

When this option is selected, the rotation axis is fixed to its position in 
the Image. By default, the axis is bound to the object. Not applicable on 
the Web. 

Rotate 
Clockwise 

When this option is selected, the rotation will be performed in the 
clockwise direction. By default, the direction is counter-clockwise. 

Sample when 
out of window 

When this option is selected, transformed dynamic objects that no 
longer appear in the Image window will still be sampled. This option is 
described on the next page. 

If multiple transformations are to be performed on the same object, they will be performed 
in the following order: Move, Scale and Rotate. This order affects the location of fill area 
borders, rotation axes, and scaling reference points when they are not fixed to a position in 
the Image. 
 

 
 

 
 

  

 
 

 
 
 

Sample when out of Window 
In the application, dynamic objects that do not visually appear in the Image window are not 
sampled. However, if an object was transformed using the dynamic move, resize, or rotate 
options, and after the transformation that object receives tag values that cause it to move 
outside the Image window, you can use the Sample when out of Window option to cause 
the object to be sampled. 
If this option is not selected, transformed objects that no longer appear in the Image 
window will not be sampled. 
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Dynamic Text 
In an Image tag values can be displayed as one of the following dynamic text object types: 

o     Property / Tag value 
o     Text Table display (each value causes a pre-defined string to be displayed) 

To define a dynamic text display: 

Click on the  button in the Drawings toolbox to open the Text dialog box: 

 
To enter regular text, click the left button in the Text field. Regular text is described in more 
detail in Chapter 20, Introduction to the Image Module and Chapter 21, Image Editor. 
The following description refers to dynamic text only. 
The fields that relate to dynamic text in the dialog box are as follows: 

Text    This field is used only for regular (non-dynamic) text in the Image.  

Property/Tag 
Value 

For any property display (It encloses previous version options, which 
were: Tag Value, Date/Time/String) 

Text Table For the display of text, according to predefined tag values. 

 
 
 

 
 

  

 
 
 

 
 

Property/Tag value 
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o To define display for tag and property values: 
Click the Tag value button. The Tag Value dialog box is displayed: 

 
The “Property/tag” and its value to be displayed are both defined together with the display 
attributes. 
The fields in this box are: 

Station Specifies the workstation to which the "Property/tag" belongs. 

Tag    Specifies the “Property/tag” associated with the tag value. See Display 
any object property in text object 

“Property 
type” Group 

The property type determines how to display your text. Possibilities 
depend on tag/property’s type. For an unknown name, all types are 
available. For a string object, only the “String” button is enabled. For 
numeric tag/property, all options except “String” will be enabled.  
Date The tag value will determine the display of the number of days from 
1/1/1980. The limitation date is up to the value of 21203 (18-Jan-2038) 
(18-01-38 on the Image). 
Time The tag value will determine the display of the number of minutes 
since midnight. 
Time with Seconds The tag value will determine the display of the 
number of minutes and seconds from midnight. 
String 
“String display” can be used to represent tags and properties defined as 
string. String objects in the Image will display exact field device numeric, 
alphabetic, or alphanumeric values. 
Specify the network station to which the string tag belongs, and then the 
name of the string tag you want to be represented in the Image. To 
select a station or tag from a list of existing stations and tags, click on 
the arrow to the right of the field. 
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String tag objects in the Image can also be defined as triggers. When the 
object is selected in the Trigger mode, you will be able to enter textual 
values using different input methods. (See Trigger Object Definition). 
Note: String Tags are not supported in the RePlay module. 

Display Mode 

This group of option is only available if you select “Numeric” display. 
Select Dec for Decimal, Hex for Hexadecimal, or Eng for Engineering 
(powers of ten). For example, for the number fifteen: Dec = 15, Hex = F, 
and Eng = 1.5e1. 

Options    

This group of option is only available if you select “Numeric” display.  
In this field, select Left Justify to cause the digits in the text field to be 
justified to the left. 
Select + Prefixed to cause positive values to be preceded by a plus (+) 
sign. By default, no sign precedes positive values. 
Select Leading Zeros to cause zeros to appear to the left of the value. 
By default, empty spaces appear to the left. 

Display 
Format 

This group of option is only available if you select “Numeric” display. 
In this field, for Digits before ".", specify the number of digits that will be 
allowed for the integer part of the value. 
For Digits after ".", specify the number of digits that will be allowed for 
the fractional part of the value. 

Note: The created text object can also be defined as a dynamic object. Thus, both the 
display contents and appearance can be made to change in accordance with tag value 
changes. 
The Digits before "." and Digits after "." fields may cause actual tag values to appear 
incorrectly. For example, if you specified 2 for the Digits before "." field, and the actual tag 
value is 115, only 15 will be displayed. 
To prevent confusion with decimal numbers, the application automatically precedes 
hexadecimal numbers with 0x. Therefore, take into account that you need space for two 
extra characters before the displayed value. For example: 65,355 in decimal = FFFF in 
hexadecimal. To indicate that FFFF is in hexadecimal, you must define six characters, 
0xFFFF. 
 

Display any object property in text object 

Presentation 
  This new feature allows to display any Object Oriented object property.  

   

Access means 
  We have access to this new feature from a text object inside an image.  

   

Description 
  The use is exactly the same as before, except that you can select any Object Oriented 
object property.  
  Note: an object property is not considered as a tag, so when a property is changed by the 
user, the image will not be advertising that a property changed. So the user needs to 
change zone, or reopen the image or change the scale to view the new property.  
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How To 
  To select an object property, first select a text object and then click on the "Property/Tag 
value..." button:  

    
 
And then on the "..." button:  

    
 
The object property selector is then displayed and you can select the property you want 
like shown on the following picture: 
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MultiState in Image 

Presentation 
In the image a multi-state tag is only considered as a numeric tag. To display its string 
value, we need to open the object property selector, choose the multi-state tag and select 
the property "State text" of this tag.  

Description 
When the user wants to use the numeric value of a multi-state tag, nothing is changed as it 
is considered as a numeric tag. He can use it in a dynamic object, a trigger, a cluster, a 
date/time object...  

How to 
If the user wants to display a string value according to the numeric value of the multi-state 
tag, he first needs to select a text object. Then he just has to click on the "Property/Tag 
value..." button and on the "..." button to display the object property selector. And then he 
has to choose the "StateText" property of a multi-state tag, as shown on the following 
picture:  

   



Chapter 22 Image Animation 

1062 

 
 
 

 
 

  

 
 

 
 
 

Text Table 
Text Tables are used to associate tag values with predefined strings. When a Text Table is 
defined and activated, a text string will be associated with the tag values defined in the 
Table. When a value changes, the corresponding string will be displayed. Each string table 
is stored in a separate file. 

o To assign text tables or create new ones: 
Click the Text Table button in the Text dialog box. 
If no text table exists, the New Text Table File dialog box opens where you can specify the 
name of the text table. 
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If a text table file already exists, the Open Text table file dialog box appears: 

 
Select a file from the list (or click the New button to open the New Text Table dialog box). 
The Text Table dialog box is displayed where you can specify the string-value relationship: 

 
The following options are available: 

Station Specifies the network station to which the tag belongs. 
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Tag Specifies the name of the tag. 

Value Specifies the string display value. 

Text    Specifies the string for the value. 

List    Specifies the list of values and the strings defined for them. 

Add    Adds the value-string pair to the list 

Change Replaces the selected pair with the one specified in the 
entry boxes. 

Delete    Deletes the selected pair from the list. 

Specify a tag name, the tag values, and their corresponding strings in the entry boxes, and 
add them to the list by clicking the Add button. A value-string pair can be selected from the 
existing pairs list, placed in the entry boxes, and revised, by activating the Change button. 
When the Delete button is clicked, the selected pair is removed from the list. 
Special Cases: 

o     If a tag value does not exist in the text table, the text field will be filled with Xs 
(xxxxx). 

o     If no text table file exists, number signs (#####) will appear in the field. 
o     If a communication error occurred, asterisks (*****) will appear in the field. 

If spaces are to be used in the string, enclose the string in quotation marks, for example, " 
The text ". 
Text table string files can be created or modified using your system editor. The format of 
this file is as follows: 

Value String 

5 "Cycle Starting ..." 

20 "Cycle Completed !" 

Note:     Text Tables can also be used for Trigger objects (see Trigger Object Definition) 
when the String input method is active. 
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Set Date and Time   
When the date method is being used (the object was defined for date display as a 
Dynamic Text) and the operator clicks on the object, the Set Date dialog box appears. 
After the new date is entered, the date display object will immediately be updated. 
When the time method is being used (the object was defined for time display) and the 
operator clicks on the object, the following dialog box appears: 
Note that if the time display was not defined as Time with Seconds, the seconds place will 
not appear in this dialog box. 
After the new time is entered, the time display object will immediately be updated. 

 
 

 
 

  

 
 

 
 
 

Display property Object 
Presentation 

  In the image, when one object contains an Object Oriented object, we can display this 
property object by right clicking on the object (in trigger mode). If the object contains 
custom actions, a menu is displayed when the user right clicks on it. At the bottom of this 
sub menu, "Object Property Display" is shown and allows the user to access the object 
property dialog, as shown on the following picture:  

   

 
   

How to 
• Create an object in the image (for example a filled box)  
• Assign to this object a dynamic definition with a long name which references a tag  
• Click on trigger on (to be in trigger mode in the image)  
• Right click on this object, you will get the following window:  
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Note: if an object contains several Object Oriented names (in the trigger and dynamic 
definition of an object, in a cluster, ...), the first Object Oriented name found is displayed. 
 

 
 

 
 

  

Dynamic Alarms 

 
 
 
 
 

Alarm Objects 
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An Image object can be associated with an alarm, so that the alarm will affect the way the 
object behaves. Such objects are called alarm objects. (See Chapter 15, Alarms for 
further information) 
An alarm object can be defined to blink, show, hide, or change colors when the alarm is 
active, provide textual assistance when selected, and enable alarm acknowledgment. 

o To define an object as an alarm object: 
Select an object in the Image and activate the Alarms Definition button in the toolbox (or 
right click on the object and select Alarm Definition). The Alarm Object Definition dialog box 
is displayed: 

 
The following options are available: 

Station    The network station to which the alarm belongs. For a list of defined 
stations click on the arrow to the right of the field. 

Alarm Family 

The family of alarms to be associated with the object. The name you 
specify must be the name of a family of alarms that was, or will be, 
defined in the system. (You can specify the name of an alarm family that 
was not yet defined in the Alarm Definition module. Although, at some 
point, it must be defined.) 
For a list of defined alarm families click the arrow to the right of the field. 
You can also use a ? and a * wildcard to enable you to quickly define 
family filters. 
The maximum number of names that you can specify is 65535. 
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Alarm Filter 

You can associate an alarm filter with the object. In this case, instead of 
the behaviour of the object being based solely on the family of the alarm, 
you can use an alarm filter. This is a more flexible approach to filtering 
the behaviour. In addition, it allows you to use the # symbols to change 
the filter that is used by changing the context of the image. 

Show Object 
When    

Select Always to cause the object to appear in the Image constantly. If 
you select this option, you must also select an Animation. 
Select Alarm Family Active to cause the object to appear in the Image 
only when the alarm condition is true. 
Select Alarm Family not Active to cause the object to appear in the 
Image only when the alarm condition is false. If you select this option, 
both the Animation and Trigger Function fields will be disabled. 

Animation 

The following options are available:  
Blink: Click to define the blink parameters for the object. The Image 
Alarm - Blink dialog box is displayed.  

 
Fill height: 188px;" width=204 height=188 border=0>  
Select the alarm status option you want and the color to be associated 
with that status.  

 

Active alarms can be either; Started (unacked, unended), Acked (and 
unended), or Ended (but unacked). For example, you can define the 
object to be red when the alarm is started, green when it is acked, and 
its default color when it is ended. 
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 Line " >  

Trigger 
Function 

Select Acknowledge to cause the alarm associated with the object to be 
acknowledged whenever the object is selected in the Trigger mode. 
Select Acknowledge with confirm to prompt the operator before 
acknowledging the alarm. 
Select Assist to cause the help file of the alarm associated with the 
object to appear whenever you select the object in the Image. 
Select Assist + Ack button to cause the help file of the alarm to appear 
with an additional acknowledge button. For more information about alarm 
help files, see the Event Summaries chapter. 
Select None for no trigger function. 
If the No Alarm option is selected in the Show Object When field, the 
Trigger Function field will be disabled 

 

Notes: 
If an object was already defined as an alarm object, and you access the 
Alarm Object dialog box for that object, the dialog box will appear with 
the options you selected. If you change the definition (select different 
options) and then activate the OK button, the new definition will replace 
the previous definition. 
Several objects can be selected together in the Image for alarm object 
definition. If an object within the group you selected was already defined 
as an alarm object, the group definition will replace the single object's 
definition. 
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Miscellaneous 
Alarm Objects 
The Application supports alarm object attributes in a browser. They are defined in the 
Alarm Object Definition dialog  
The Application now supports the following alarm object attributes in a browser: 
Blink 
Specifies that an object will blink when the value is within the specified value range. 
Fill color 
Sets the fill color of an object when the value is within one of several specified value 
ranges. 
Line color 
Sets the line color of an object when the value is within one of several specified value 
ranges. 
Acknowledge 
Causes the alarm associated with the object to be acknowledged whenever the object is 
selected in the Trigger mode. 
Acknowledge with confirm 
Prompts the operator before acknowledging the alarm  
Assist 
Provides textual assistance when the object is selected. 
Remote users should create an HTML file with the same name as the assist file and save it 
in the directory which contains the application’s HTML files. When the alarm object is 
activated, the HTML file is opened together with the assist file. 
Accessing Images with Layers 
The Application supports the use of layers in Images that are remotely accessed. Users 
can access specific layers of an Image according to group authorization. 
Note: Remember that Images accessed remotely have only scale. 

 
 

 
 

  

 
 
 

 
 
Alarm Object Blink   
In this dialog box, select the alarm status option you want and the blink rate to be 
associated with that status.  
Active alarms can be either; Started (unacked, unended), Acked (and unended), or Ended 
(but unacked).  
In the Alarm Object definition box select the Blink option. 
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Alarm Object Color 
In this dialog box, select the alarm status option you want and the color to be associated 
with that status. 
Active alarms can be either, Started (unacked, unended), Acked (and unended), or Ended 
(but unacked).  

 
 

 
 

  

Trigger Objects 

 
 
 
 
 

Trigger Objects 
Trigger objects are objects that you can click on to cause predefined tag values to be set 
automatically or manually, cause the Image to go to a predefined zone, or cause 
predefined macros to be activated. 
Any trigger object included in a segment will function the same as when it is not included in 
a segment. For more information about segments, see Chapter 21, Image Editor. Several 
tag input methods can be used for trigger objects. To test an input method, tag value 
variations can be simulated.  
The tag value input methods include the following: 

Action 
When the operator clicks on an object, a preset value is applied to the tag, 
or a predefined macro is activated. This method is valid for all tags and 
objects. 
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Buttons    

When the operator clicks on an object, a set of buttons with preset values 
appears. Clicking a button causes a value to be applied to the tag, or a 
predefined macro to be activated. This method is valid for all analog and 
digital tags (not for string tags). 

Bit    
When the operator clicks on an object, ON, OFF, and Toggle buttons 
appear. This method is valid for all tags and objects (except string tags. For 
analog tags, the Toggle buttons will not appear. 

Data 
Entry    

When the operator clicks on an object, a dialog box appears to specify a 
numerical tag value. This method is valid for all analog and digital tags (not 
for string tags). 

String    

When the operator clicks on an object, a Text Table or a multi-state that 
was made active for the tag associated with that object, will be applied. The 
Text Table or the multi-state contains a list of strings corresponding to 
different tag values. This method is valid for all multi-state tags (when 
selecting the 'State Text' property of a multi-state tag) and Text Table 
objects. 

Date When the operator clicks on an object defined as a Date/Time object, a 
dialog box appears with the current date value to be modified. 

Time    When the operator clicks on an object defined as a Date/Time object, a 
dialog box appears with the current time value to be modified. 

Smooth    
When the operator clicks on an object, a dialog box appears with tag values 
that can be selected using sliders. This method is valid for all analog and 
digital tags (not for string tags). 

 
 
 

 
 

  

 
 

 
 
 

Trigger Objects   
Trigger object are objects that you can click on to cause pre-defined tag values to be set 
automatically or manually, cause the image to go to a pre-defined zone, or cause pre-
defined macros to be activated. 
Any object (static, dynamic, segment) can be defined as a trigger object. However, only 
one tag value input method can be assigned per object. 
The tag value input method that you select in the dialog box will be marked by an arrow. 
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Note that you may use a tag template Id as a tag. This will enable the trigger to be 
dependant on current image context 
 
Note that for the Data Entry, Bit, Smooth, and Test, the last position of the dialog box will 
be saved (unless you activated the Cancel button before completing the operation). This 
means that you can drag the dialog box to any position on the screen, and thereafter, 
whenever that dialog box will be invoked, it will appear in its last position. 
However, the dialog box position is relative to the window position. If the window is moved 
and then the dialog box is invoked, it will appear in the position it was last saved, relative to 
the new location of the window. 
 
For Text Table objects, the String button will appear in the Input Method field instead of 
Data Entry. For Time objects, the Time button will appear in the Input Method field instead 
of Data Entry. For Date objects, the Date button will appear in the Input Method field 
instead of Data Entry.  
 
To define a trigger 
1. Select the object you want to define as trigger. 
2. Right click the selected object. 
3. Select the Trigger Definition from the popup menu. 
OR 
 From the Edit menu select Operations, then click on the Trigger option. 
OR 
 From the Objects toolbar select the Trigger tool The Trigger Object Definition dialog box 
opens  
4. Select the application station to which the tag associated with the trigger object is 
attached. 
5. Select the tag associated with the trigger object, or click the browse button to open the 
Tag Definition dialog box where you can define a new tag. 
6. Select the trigger object Input Method. Several tag input methods can be used for trigger 
objects. To test an input method, tag value variations can be simulated.  
 The tag value input methods include the following: 
Action  When the operator clicks on an object, a present value is applied to the tag, or a 
pre-defined macro is activated. This method is valid for all tags and objects. 
Buttons When the operator clicks on an object, a set of buttons with present values 
appears. Activating a button causes a value to be applied to the tag, or a pre-defined 
macro to be activated. This method is valid for all analog and digital tags. 
Bit When the operator clicks on an object, On, Off, and Toggle buttons appear. This 
method is valid for all tags and objects (except string tags). 
Data Entry When the operator clicks on an object, a dialog box appears to specify a 
numerical tag value. This method is valid for all tags and objects besides Text Table 
objects. 
String The String button will appear instead of the Data Entry button. When the operator 
clicks on an object, when a Text Table that was made active for the tag associated with the 
object, will be applied. The Text table contains a list of strings corresponding to different 
tag values. 
Date The Date button will appear instead of the Data Entry button. When the operator 
clicks on an object defined as a Date/Time object, a dialog appears with the current date 
value to be modified. 
Time The Time button will appear instead of the Data Entry button. When the operator 
clicks on an object defined as a Date/Time object, a dialog appears with the current time 
value to be modified. 
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Smooth When the operator clicks on an object, a dialog box appears with tag values that 
can be selected using sliders. This method is not valid for string tags.  
Momentary When the operator clicks on an object, a dialog box appears enabling the user 
to change tag value in a one short way. 
Fast Action When the operator clicks on an object, a pre-defined macro, called Fast 
Action is executed (note that Fast Action is Web enabled). 
7. Click the Set Macro button to define macros for trigger objects (note that Set Macro is 
not supported on the Web). 
8. Click the Test button to test the input method and adjust its appearance. In addition you 
can move the numeric keypad to any location on your screen. When you re-open the 
application and operate the keypad, it will be opened at the same location as you selected. 

 
 

 
 

  

 
 

 
 
 

Trigger Object Definition 
o To define trigger objects:  

Select the required object and do one of the following to display the Trigger Object 
Definition dialog box: 
Click the Trigger Definition tool in the Objects toolbox. 
Or 
Right click and select Trigger from the popup menu. 
Or 
Select Trigger from the Edit Operations menu. 
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For Time objects, the Time button will appear in the Input Method field instead of Data 
Entry. For Date objects, the Date button will appear in the Input Method field instead of 
Data Entry.  
The following fields are available: 

Station    Specifies the station to which the tag belongs. 

Tag    Specifies the tag associated with the object. Tag templates 
are supported (see the chapter on tag templates). 

Input 
Method 

The value input methods described above: Data Entry 
Value, Action, Smooth Variation, Buttons, Bit, 
Momentary. 

Set Macro Activate to define macros for trigger objects. (Not 
applicable on the Web). 

Test    Activate to test the input method and adjust its appearance. 

Any object (static, dynamic, segment) can be defined as a trigger object. However, only 
one tag value input method can be assigned per object. 

o To cancel a trigger definition: 
Select the trigger object, right click, and select Remove Trigger from the pop-up menu.  
Or,  
Select the trigger object, point to Operations in the Edit menu, and select Remove Trigger. 
An arrow will mark the tag value input method that you select in the dialog box. 
Note:     For the Data Entry, Smooth, Bit, and Test dialog boxes the last position of the 
dialog box will be saved (unless you clicked the Cancel button before completing the 
operation). This means that you can drag the dialog box to any position on the screen. 
Thereafter, when the dialog box is opened, it will appear in its last position. However, the 
dialog box position is relative to the window position. If the window is moved and then the 
dialog box is invoked, it will appear in the position it was last saved, relative to the new 
location of the window. 
 

 
 

 
 

  

 
 
 

 
 

Action Definition   
Click the Action button in the Trigger Object Definition dialog box. The Action Definition 
dialog box is displayed. 
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1. In the Formula field you can use any of the following formats: 

@tag op val 

val op @tag 

val 

@tag 
Where @ alone is the current tag, tag is the name of any tag, op is any valid 
operator including operators +,-, /, *, % (percent denotes modulus, as in C 
programming language), &, |, or ^ (bitwise AND, inclusive OR and exclusive OR). 
Val is any numerical value. 

2. Either a Zone or Zone Navigator can be added. Do either: 

• Check the Zone checkbox and then in the Zone field click the 
arrow and select the relevant zone or, type in the relevant 
zone. 

Or, 

• Check the Zone Navigator checkbox and then in the Zone 
Navigator field click the Browse button. The Zone Navigator 
dialog box opens. Select the relevant Zone Navigator and 
click OK to save and return to the Action Definition dialog 
box. 

3. To add a macro, click the Macro field and select the relevant 
macro.  

4. Click OK to confirm your definitions and to exit this dialog 
box. 

Note: If more than one operation is assigned in this dialog box, the 
operations will be performed in the following order: goto zone, tag 
assignment, run macro. If one of the operations fails, the next operation 
will not be executed. 

 
 

 
 

  

 
 
 

 
 

Action Definition   
Click the Action button in the Trigger Object Definition dialog box. The Action Definition 
dialog box is displayed. 

1. In the Formula field you can use any of the following formats: 

@tag op val 

val op @tag 
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val 

@tag 
Where @ alone is the current tag, tag is the name of any tag, op is any valid 
operator including operators +,-, /, *, % (percent denotes modulus, as in C 
programming language), &, |, or ^ (bitwise AND, inclusive OR and exclusive OR). 
Val is any numerical value. 

2. Either a Zone or Zone Navigator can be added. Do either: 

• Check the Zone checkbox and then in the Zone field click the 
arrow and select the relevant zone or, type in the relevant 
zone. 

Or, 

• Check the Zone Navigator checkbox and then in the Zone 
Navigator field click the Browse button. The Zone Navigator 
dialog box opens. Select the relevant Zone Navigator and 
click OK to save and return to the Action Definition dialog 
box. 

3. To add a macro, click the Macro field and select the relevant 
macro.  

4. Click OK to confirm your definitions and to exit this dialog 
box. 

Note: If more than one operation is assigned in this dialog box, the 
operations will be performed in the following order: goto zone, tag 
assignment, run macro. If one of the operations fails, the next operation 
will not be executed. 

 
 

 
 

  

 
 
 

 
 

Momentary Trigger   
A Momentary Trigger is an object that is used to change a tag value in one shot. Usually 
such operations are required for a digital tag that control a field operation that is activated 
by a high value (one 1) for a short period of time, followed by a low value (zero 0). 
The neutral way to implement such an operation is using the ‘button down’ button up’ pair 
of user actions. This operation is actually a ‘button click’ that is regarded as one operation. 
The momentary trigger operation will regard a ‘button click’ as two operations. 

Functional Description 
Following is a description of the way Momentary Trigger works: 
All tags can be used for the Momentary including string tags. 
A formula, identical to the one used in Action trigger can be assigned for Down and Up 
operation 
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Any Dynamic object in an Image that should reflect the tag value change will be updated 
when the button is still pressed 
Only when the user releases the mouse left button (‘button up’) the Up formula is 
calculated and the result value will be written to the application in the same way as the 
down value 
If the user releases the button not above the trigger object the Up value will not be written  
To set and reset a bit in an Analog tag the OR and AND operations can be used. For 
example for 8 bit analog tag to set the 3rd bit use the formula ‘@ | 4’ and to reset the same 
bit use formula ‘@ & 251’. The same principal can be applied to any bit and for 16 or 32 
bits analog tags 
To define a Momentary Trigger 
1. Click the Momentary button from the Trigger Object dialog box. The Tag Input - 
Momentary Values dialog box opens. 
2. Enter the Value that the application will write to the tag when you press the left mouse in 
the Button Down Formula Field. 
3. In the Field Button Up Formula enter the value that the application will write as soon as 
you release the mouse button. For new definitions the default values are 1 and 0 for Down 
and Up respectively.  
7. Click OK to complete the operation. 

 
 

 
 

  

 
 

 
 
 

Momentary Trigger     
A Momentary Trigger is an object that is used to change a tag value in one-shot. Usually 
such operations are required for a digital tag that controls a field operation that is activated 
by a high value (one 1) for a short period of time, followed by a low value (zero 0). 
 
The way to implement such operation is using the ‘button down’ button up’ pair of user 
actions. This operation is actually a ‘button click’ that is regarded as one operation. The 
momentary trigger operation will regard a ‘button click’ as two operations. 
Functional Description 
Following is a description of the way Momentary Trigger works: 

• All tags can be used for the Momentary including string tags 
• A formula, identical to the one used in Action trigger, can be assigned for Down 

and Up operation 
• Any Dynamic object, in an Image, that should reflect the tag value change will be 

updated, while the button is still pressed 
• Only when the user releases the mouse left button ( ‘button up’ ) the Up formula is 

calculated and the result value will be written in the same way as the down value. 
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• If the user releases the button in a place not above the trigger object the Up value 
will not be written 

• To set and reset a bit in an Analog tag the OR and AND operations can be used. 
For example for 8 bit analog tag to set the 3rd bit use the formula ‘@ | 4’ and to 
reset the same bit use formula ‘@ & 251’. The same principal can be applied to 
any bit and for 16 or 32 bits analog tags 

To define a Momentary Trigger 
1. Select the object you wish to define as a Momentary Trigger. 
2. Click the left mouse button on the Trigger Definition tool in the Objects Toolbar. 
 Or, 
 Click on the Trigger option in the Edit Menu Operations Menu. The Trigger Object 
Definition Dialog box opens. 
3. Press the Momentary button and the Tag Input Momentary Values dialog box opens. 
4. Enter the Value that the Application will write to the tag when you press the left mouse in 
the Button Down Formula Field. 
5. In the Field Button Up Formula enter the value that the Application will write as soon as 
you release the mouse button. For new definitions the default values are 1 and 0 for Down 
and Up respectively.  
6. Click OK to complete the operation. 

 
 

 
 

  

 
 
 

 
 

Trigger Button Definition   

Title The button group title (optional). 

Legend A description of the buttons. In this field, any button letter can 
be highlighted for keyboard entry by prefixing it with 
the ampersand (&) character. 

Value The button value. If the object was defined as a string tag the 
value can be any numeric, alphabetic, or 
alphanumeric value. 

Zone The zone to jump to when the button is activated. This field is 
optional. After checking this option click the Zone field 
and select the relevant zone. 

Zone Navigator The Zone Navigator is a global multi image zone 
navigation window that enables you to quickly and 
efficiently navigate through image files. After checking 
this option click the Browse button to open the Zone 
Navigators dialog box and select the relevant Zone 
Navigator.  
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Macro The macro to activate when the button is activated. This field is 
optional. Not applicable on the Web. 

Add The button is added to the list. 

Change The button definition is changed. 

Delete The button is deleted from the list. 

Style The button arrangement style: 

 Horiz, for horizontal rows. 

 Vert, for vertical columns. 

 Rect, for rectangular arrays. 

Optional Optional buttons (Cancel, Help and Execute). Select Execute 
to provide added user security by displaying dialog 
boxes that must be confirmed before an action is 
executed. 

Button Size Button size adjustment. 

 Use the <arrow> keys to change the size of the example button that 
appears in the field. The <PageUp> and <PageDown> 
keys also affect the size of the example button, and 
the <Home> key changes the button back to its 
default size. 

Save The button definition is saved in a file. 

Use Enables the operator to apply files that contain tag values. The files 
must have been saved earlier with the Save button. 
Tag value files can be edited using the system editor. 

Notes 

1. A new button can be defined and added to the list by activating 
the Add button. A button can be selected from the list, its 
characteristics modified, and the revised definition saved, by 
activating the Change button. A button is deleted from the list by 
activating the Delete button. 

2. If an ampersand (&) character precedes any part of the text 
specified in the Legend field, the operator will be able to activate 
that button by pressing the <Alt> key together with character that 
follows the ampersand (the character that will be underlined). For 
example, if a button legend is specified as O&FF, the actual text 
will appear as OFF, and the operator will be able to activate that 
button by pressing the <Alt> key together with the <F> key. 

3. In the Macro field, you can specify a macro that you want to be 
activated by typing the name of the macro, or by clicking on the 
arrow to the right. When you click on the arrow, a list of 
predefined macros will appear for you to select from.  

4. If more than one operation is assigned in this dialog box, the 
operations will be performed in the following order: goto zone, tag 
assignment, run macro. If one of the operations fails, the next 
operation will not be executed. 
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5. Activate the Save button and type a name. Once action buttons 
are saved for a specific object, they will appear each time the 
operator clicks on that object. Then, clicking on any button will 
apply that value to the tag. 

6. (Optional) If you selected Execute a window containing the 
button panel you defined is displayed.  

7. Click Execute to confirm and execute the action. You can also 
click Cancel to cancel the action and return to the Preset Buttons 
Definition dialog box. 

8. Note: The dialog box will disappear after a predetermined 
amount of time if you do not select any of the available options. 
The time parameter for the display of this dialog box is specified 
in the wiztune.dat file, as follows: 

TRIGGER_BUTTONS = TIMEOUT 

The default value is 20 seconds.The maximum value is 100 seconds. 
 
 

 
 

  

 
 

 
 
 

Smooth Input  
This dialog box is used to set the upper and lower value limits for the Single Tag Input 
dialog when the trigger is activated.  
Lower Limit The lowest tag value that you will be able to specify in the Single Tag Input 
dialog box when the trigger is activated.  
Upper Limit The highest tag value that you will be able to specify in the Single Tag Input 
dialog box when the trigger is activated.  
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Trigger Object Definition 
o To define trigger objects:  

Select the required object and do one of the following to display the Trigger Object 
Definition dialog box: 
Click the Trigger Definition tool in the Objects toolbox. 
Or 
Right click and select Trigger from the popup menu. 
Or 
Select Trigger from the Edit Operations menu. 

 
For Time objects, the Time button will appear in the Input Method field instead of Data 
Entry. For Date objects, the Date button will appear in the Input Method field instead of 
Data Entry.  
The following fields are available: 

Station    Specifies the station to which the tag belongs. 

Tag    Specifies the tag associated with the object. Tag templates 
are supported (see the chapter on tag templates). 

Input 
Method 

The value input methods described above: Data Entry 
Value, Action, Smooth Variation, Buttons, Bit, 
Momentary. 

Set Macro Activate to define macros for trigger objects. (Not 
applicable on the Web). 

Test    Activate to test the input method and adjust its appearance. 

Any object (static, dynamic, segment) can be defined as a trigger object. However, only 
one tag value input method can be assigned per object. 

o To cancel a trigger definition: 
Select the trigger object, right click, and select Remove Trigger from the pop-up menu.  
Or,  
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Select the trigger object, point to Operations in the Edit menu, and select Remove Trigger. 
An arrow will mark the tag value input method that you select in the dialog box. 
Note:     For the Data Entry, Smooth, Bit, and Test dialog boxes the last position of the 
dialog box will be saved (unless you clicked the Cancel button before completing the 
operation). This means that you can drag the dialog box to any position on the screen. 
Thereafter, when the dialog box is opened, it will appear in its last position. However, the 
dialog box position is relative to the window position. If the window is moved and then the 
dialog box is invoked, it will appear in the position it was last saved, relative to the new 
location of the window. 
 

 
 

 
 

  

 
 

 
 
 

Remove Trigger  
Select the trigger object, right click, and select Remove Trigger from the pop-up menu.  
Or,  
Select the trigger object, point to Operations in the Edit menu, and select Remove Trigger. 
An arrow will mark the tag value input method that you select in the dialog box. 
Note that for the Data Entry, Smooth, Bit, and Test dialog boxes the last position of the 
dialog box will be saved (unless you clicked the Cancel button before completing the 
operation). 
This means that you can drag the dialog box to any position on the screen. Thereafter, 
whenever that dialog box is opened, it will appear in its last position. 
However, the dialog box position is relative to the window position. If the window is moved 
and then the dialog box is invoked, it will appear in the position it was last saved, relative to 
the new location of the window. 

 
 

 
 

  

Custom Actions 

 
 



Chapter 22 Image Animation 

1084 

 
 
 

Custom Actions 
All objects in an image can be assigned to perform custom actions: a program external to 
the application. To assign custom actions for an object, right-click on the object while you 
are working in development mode. On the drop-down menu that appears, you will see an 
option to define custom actions. If you select this option, the following dialog box will 
appear: 
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From this dialog box, you can choose the programs that you want to call, and, for each of 
them, a set of parameters that you want to send to the program. 
 
These programs will be called via a right-click on the object during runtime. If there are 
several programs defined, a drop-down menu will allow you to choose which program to 
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call. If there is only a single program, you can choose to launch it directly after a right-click 
by selecting the option “Start Action without display menu”. 
 

How to define custom actions 
For each program that you want to call, you must give it a Title (this is the name that will 
appear when you do the right-click). 
The “Command” is the actual program that will be launched. Use the button “…” to help 
you to find it if you need to. 
You can send a set of parameters to each of the custom actions you define: 

o     A User-defined string (type the string in the text box below the list of 
parameters), 

o     The tag names of all the tags associated with the object 
o     The position of the object (measured in screen coordinates). 

 
The format of the string that is sent to the external program is the following: 
Application.exe –tagnames:TAGNAME1,TAGNAME2,TAGNAME3 –coords:X,Y <userstr> 
Note that there are no spaces between the tag names, and that the user-defined string 
(userstr) is a free-form string. Notice is that there is a space between the user-defined 
string and any of the other parameters.  
You can add the parameters in any order you like. Use the up and down buttons to change 
the order of the parameters. For each custom action that you define, use the “Add” button 
to add it to the list. You can “Modify” each program, or “Remove” it from the list. If only one 
program is defined for the object, you can use the “Start action without displaying menu” 
option to launch the program without the drop-down menu appearing when you do a right-
click on the object during runtime. 
 

External File Access in Web Images 

Presentation 
External file access is now supported in Web Images.  

Access means 
Use the standard ways to create custom actions  

Description 
The command parameter should be a valid URL accessible from internet.  

How To 
• Open the custom actions dialog  
• Set a name for this action  
• Enter the URL in the command parameter  
• click the OK button 
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Custom Actions 
You can use this dialog box to send a command to one or several programs external to the 
application. You can choose a set of parameters to send to the programs. 
These programs will be called via a right-click on the object during runtime. If there are 
several programs defined, a drop-down menu will allow you to choose which program to 
call. If there is only a single program, you can choose to launch it directly after a right-click. 
 
You can create the programs in the following way: 
 
For each program that you want to call, you must give it a Title (this is the name that will 
appear when you do the right-click). 
 
The "Command" is the actual program that will be launched. Use the button "…" to help 
you to find it if you need to. 
 
For each program you can send a set of parameters: A User-defined string (type the string 
in the text box below the list of parameters), the tag names of all the tags associated with 
the object and the position on the screen of each of the associated tags (the position is 
measured in image coordinates). 
 
The format of the string that is sent to the program is the following (remember that they can 
be in any order): 
 
Application.exe –tagnames:TAGNAME1,TAGNAME2,TAGNAME3 –coords:X,Y <userstr> 
 
Note that there are no spaces between the tag names, and that the user-defined string 
(userstr) is a free-form string. The only thing to notice is that there is a space between the 
string and any of the other parameters.  
 
You can add the parameters in any order you like. Use the up and down buttons to change 
the order of the parameters.  
 
For each program, use the "Add" button to add it to the list. You can "Modify" each 
program, or remove it from the list. 
 
As for the parameters, use the up and down buttons to change the order in which they will 
appear in the drop-down menu following a right-click on the object. 
 
If only one program is defined for the object, use the "Start action without displaying menu" 
option to launch the program without the drop-down menu appearing. 
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Global Custom Actions 
Note that the first option on this dialog box is to use “Global Custom Actions”. Global 
custom actions are useful when you want to call the same set of actions for many objects. 
This option is selected by default. In this case, all other options are deactivated. In order to 
customise the actions for a particular object, uncheck this box and you have access to all 
other fields. 

How to define Global Custom Actions 
On the “Triggers” section of the “Image Properties” dialog box, there is a button “Define 
Global Custom Actions for Images”. If you press this button, you will see a dialog box that 
is identical to the one shown above. Use this dialog box to define the custom actions that 
will be presented to the user by default when they define a custom action for an object. 
  
  

 
 

 
 

  
 
 
 
 

Tooltips 

For each object in an image, you can define a tooltip that will be shown when the user 
moves the mouse over the object during runtime. To define a tooltip, right-click on the 
object in development mode. On the menu that appears, select the “Tooltips” option. This 
will launch the following dialog box: 
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You can select to show one or more of: 

o     The names of each tag used by the object 
o     The description of each of the tags 
o     The driver number of each of the tags 
o     A free-form string of your choosing 

Note that if you decide to add a tooltip to a cluster, then you may have very large tooltips 
displayed. 
 
 

 
 

 
 

  

 
 
 

 
 

Defining Tooltips 

 
This dialog box will allow you to assign tooltips to objects in the image. You can define the 
tooltips while developing the application, but they will only be activated during runtime. 
The following options are available and you can choose any combination of the options. 
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You can choose to display either the tag name, tag description, its address or a text string 
of your own choosing.  
 
Note that if you have several tags associated with a single object, you will see these 
options for each tag attached to the object. 

 
 

 
 

  

Modifying Object 

Properties 

 
 
 
 
 

Modifying Object Properties  
You can quickly access any object, group of objects or a cluster object and modify the 
object properties.  
This option is especially useful when editing cluster objects. You can select a cluster object 
and edit any of its objects without ungrouping the whole cluster.  
This option enables you to: 

o    Modify trigger definitions and text. 
o    Modify dynamic tag definitions. 
o    Modify basic object attributes such as the line color, the fill color and the active 

layer. 
This option does not enable you to add or remove objects from an Image, or modify the 
shape of the object, for example, its size or type. 

o To modify object properties: 
Click on a single object to select it or click on each required object while holding down the 
shift key, then right click and select Edit Properties from the popup menu.  
A dialog box similar to the following is displayed. In this dialog box, a cluster object is 
selected: 
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The Object List on the left displays a hierarchical structure, or tree, of the objects, which 
comprise the cluster. The tree displays object types as folders under which objects of that 
type are contained. For example, dynamic objects are displayed in the Dynamic folder. The 
Object List can be configured to display different objects types. 
The application enables you to locate items according to specified strings and to replace 
simple text or tag names.  
Each object selected in the Object List is viewed in the Object Properties area on the right 
of the dialog box.  
The following options are available in the Edit Properties dialog box: 

Definition 

Enables you to modify dynamic tag parameters. This option is available for 
objects with a definition such as a button, or an alarm. It is also available for 
text. It is not available for objects that are only defined with basic object 
attributes such as color or line type.  

Attributes Enables you to modify the line color, the fill color and the active layer. 

Trigger  
Displays the standard Trigger Object Definition dialog box in which you 
can modify trigger definitions. This option is available for objects with a 
trigger definition. 

 
 

 
 

  
 
 
 
 

Modifying Dynamic Tag Parameters  
The application enables you to access the tag parameters specified for dynamic properties 
and modify them. This option does not enable you to re-define options such as Animation, 
for example, change Blink to Line Color. 

o To modify dynamic tag parameters:  
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Select the Definition button in the Edit Properties dialog box to display the Dynamic Object 
dialog box. This dialog box is similar in functionality to Dynamic Parameters.  

 
o To Modify the Range Parameters: 

1.   Click the arrow to the right of the Range Parameters area and select the required 
operation from the popup list. A dynamic type that is not defined will appear in parenthesis. 
If you select an undefined type, the Tag Properties, and From and To options are disabled.  
2.   Enter to and from values in the To and From fields to modify the maximum and 
minimum tag values. 
3.   Click Apply to save your changes. 
4.   Click the arrow to the right of the Station field and select the required station. 
5.   Click the arrow to the right of the Tag field and select the required tag. 

o To Modify the Animation options: 
1.   Click the Animation button in the Multi-Range Parameters area to display a dialog in 
which you can modify the action defined in the Multi Range Parameters field. For example, 
Blink. 
2.   Click the arrow to the right of the Station field and select the required station. 
3.   Click the arrow to the right of the Tag field and select the required tag. 
4.   Click OK to save your changes and close the dialog box. 

 
 

 
 

  
 
 
 
 

Modifying Basic Object Attributes  
The application provides quick access, through one dialog box to three options that are 
usually defined separately during Image object definition.  
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Using the new Object Attributes dialog box, you can modify line and fill color and change 
the active layer of an object. The application does not support modifications to line types 
and fonts, nor enable access to transparent colors.  

o To modify basic object attributes: 
1.   Select the Attributes button in the Edit Properties dialog box to display the Object 
Attributes dialog box: 

     
2.   Click the Line color button to display the standard Color dialog box in which you can 
modify the line color. 
3.   Click the Fill Color button to display the standard Color dialog box in which you can 
modify the fill color.  
4.   Click the Active Layer button to open the Select Active Layer dialog box in which you 
can change the layer from a list of available layers. 
5.   Click the Move to Active button to Move to the active image layer. 
6.   Check the Lock checkbox to lock this object. A locked image and its definitions cannot 
be moved or modified. 
7.   Click OK to close the dialog box and save changes. 

 
 

 
 

  

 
 

 
 
 

Filtering the Edit Properties 
The Edit Properties dialog box, in addition to providing access to the object edit options, 
displays a flexible Object List that provides a number of features that enable you to: 

o     Specify the object folders that appear in the Object List. Object folders are used 
to display the object types that comprise the specified cluster.  
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o     Locate items in the Object List by specifying a string and running a match. This 
is useful when the Object List contains many objects and you want to quickly 
locate the ones you require. 

o     Find and replace simple text or tag names in the Object List. 
o To filter folder types: 

1.    From the Edit menu, choose Select. The Select Objects dialog box is displayed: 
 

 
    
2.    Select the object type you want to display in the Object List. You can choose from the 
following: 

o     Dynamic Object 
o     Alarm Object 
o     Trigger Objects 
o     Cluster Object 
o     Group Object 
o     Simple Objects 

3.    Click OK to close the dialog box and save changes. 
4.    (Optional) You can display all the available folder types by choosing Select All from the 
Edit menu of the Edit Properties dialog. This overwrites your previously defined options. (It 
also reselects all the options in the Select Objects dialog box.) 

o To locate items in the object list: 
1.    From the Edit menu of the Edit Properties dialog box, select Find. The Find dialog box 
is displayed: 
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2.    In the Find what field, enter the object you want to locate, for example, circle.  
3.    Enter one of the following to define the string by which the object is located: 

o     Simple text 
o     Tag name 
o     Alarm family 
o     Trigger button 
o     Trigger macro 
o     Trigger zone 

4.    Select Match case or Match whole word to define your search criteria.  
5.    The application searches the Object List for a match and selects the object when 
found. A message is displayed if the object is not found.  
6.    (Optional) Select Find Next from the Edit menu or press F3 to continue searching the 
tree for the next match. 

o To find and replace text:  
1.    From the Edit menu of the Edit Properties dialog box, select Replace. The Replace 
dialog box is displayed: 

     
2.    Select Simple text in the Option to Replace area. 
3.    Enter the text you want to search for in the Find What field, or click the arrow to the 
right of the field to select text from a list of available text objects. 
4.    Enter the replacement text in the Replace With field, or click the arrow to the right of 
the field to select replacement text from a list of available text objects. 
5.     Click Find Next to locate the text. Click Replace to continue the find and replace 
operation, or click the Replace All button to automatically find and replace all matching 
objects. You can also click Find Next again to simply find the next text object without 
replacing the currently selected text. 
6.    Click Cancel to stop the find and replace and close the dialog box. 

o To find and replace tags:  
1.    From the Edit menu of the Edit Properties dialog box, select Replace. The Replace 
dialog box is displayed. 
2.    Select Tag name in the Option to Replace area. 
3.    Enter the tag you want to search for in the Find What field, or click the arrow to the 
right of the field to select a tag from a list of available tags. 
4.    Enter the name of the replacement tag and the station, in which it is found, in the 
Replace With field, or click the arrows to the right of the fields and select replacement tags 
and their stations from lists of available tags and stations. 
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5.    Click Find Next. The tag is located. Click Replace to continue the find and replace 
operation, or click the Replace All button to automatically find and replace all matching 
tags. You can also click Find Next again to simply find the next tag without replacing the 
currently selected tag. 
6.    Click Cancel to stop the find and replace and close the dialog box. 
 

 
 

 
 

  

Input Method 

Preparations 

 
 
 
 
 

Input Method Preparations 
The following sections describe the steps you need to take before you can use an input 
method. 

 
 

 
 

  

 
 
 

 
 

Action Buttons 
Before using use the Buttons input method first define the action buttons.  

o To define action buttons: 
Click the Buttons button in the Trigger Object Definition dialog box. The Preset Buttons 
Definition dialog box is displayed: 
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The following options are available: 

Title The button group title (optional). 

Legend    A description of the buttons. In this field, any button letter can be highlighted 
for keyboard entry, by prefixing it with the ampersand (&) character. 

Value    The button value. If the object was defined as a string tag the value can be 
any numeric, alphabetic, or alphanumeric value. 

Zone    The zone to jump to when the button is activated. This field is optional. After 
checking this option click the Zone field and select the relevant zone. 

Zone 
Navigator 
   

The Zone Navigator is a global multi image zone navigation window that 
enables you to quickly and efficiently navigate through image files. After 
checking this option click the Browse button to open the Zone Navigators 
dialog box and select the relevant Zone Navigator.  

Macro    The macro to activate when the button is activated. This field is optional. 
Not applicable on the Web. 

Add    The button is added to the list. 

Change    The button definition is changed. 
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Delete The button is deleted from the list. 

Style    

The button arrangement style: 
Horiz, for horizontal rows. 
Vert, for vertical columns. 
Rect, for rectangular arrays. 

Optional    
Optional buttons (Cancel, Help and Execute). Select Execute to provide 
added user security by displaying dialog boxes that must be confirmed 
before an action is executed. 

Button 
Size    

Button size adjustment. 
Use the <arrow> keys to change the size of the example button that 
appears in the field. The <PageUp> and <PageDown> keys also affect the 
size of the example button, and the <Home> key changes the button back 
to its default size. 

Save    The button definition is saved in a file. 

Use 
Enables the operator to apply files that contain tag values. The files must 
have been saved earlier with the Save button. Tag value files can be edited 
using the system editor. 

A new button can be defined and added to the list by clicking the Add button. A button can 
be selected from the list, its characteristics modified, and the revised definition saved, by 
activating the Change button. A button is deleted from the list by clicking the Delete button. 
If an ampersand (&) character precedes any part of the text specified in the Legend field, 
the operator will be able to activate that button by pressing the <Alt> key together with 
character that follows the ampersand (the character that will be underlined). For example, if 
a button legend is specified as O&FF, the actual text will appear as OFF, and the operator 
will be able to activate that button by pressing the <Alt> key together with the <F> key  
In the Macros field a macro that you want to be activated can be specified by typing the 
name of the macro, or by clicking on the arrow to the right. When you click on the arrow, a 
list of predefined macros will appear for you to select from. 
Note:     If more than one operation is assigned in this dialog box, the operations will be 
performed in the following order: goto zone, tag assignment, run macro. If one of the 
operations fails, the next operation will not be executed. 

o To save a button definition: 
Click the Save button and type a name. Once action buttons are saved for a specific 
object, they will appear each time the operator clicks on that object. Then, clicking on any 
button will apply that value to the tag. 
1.    (Optional) If you selected Execute a window containing the button panel you defined is 
displayed.  
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2.    Click Execute to confirm and execute the action. You can also click Cancel to cancel 
the action and return to the Preset Buttons Definition dialog box. 
Note:     The dialog box will disappear after a predetermined amount of time if you do not 
select any of the available options. The time parameter for the display of this dialog box is 
specified in the wiztune.dat file, as follows: 
TRIGGER_BUTTONS = TIMEOUT 
Note:     The default value is 20 seconds. The maximum value is 100 seconds. 
 

 
 

 
 

  

 
 

 
 
 

Action 
To use the Action input method first define an Action formula.  

o To define an action formula: 
Click the Action button in the Trigger Object Definition dialog box. The Action Definition 
dialog box is displayed: 



Chapter 22 Image Animation 

1100 

 
1.    In the Formula field you can use any of the following formats: 
@tag op val 
val op @tag 
val 
@tag 
Where @ alone is the current tag, tag is the name of any tag, op is any valid operator 
including operators +,-, /, *, % (percent denotes modulus, as in C programming language), 
&, |, or ^ (bitwise AND, inclusive OR and exclusive OR). Val is any numerical value. 
Note:    Do not insert spaces between ‘@’ and the tag name 
2.    Either a Zone or Zone Navigator (see Zone Navigator on page 21-44 of Chapter 21, 
Image Editor) can be added. Do either: 
Check the Zone checkbox and then in the Zone field click the arrow and select the relevant 
zone or, type in the relevant zone. 
Or, 
Check the Zone Navigator checkbox and then in the Zone Navigator field click the Browse 
button. The Zone Navigator dialog box opens. Select the relevant Zone Navigator and click 
OK to save and return to the Action Definition dialog box. 
3.    To add a macro, click the Macro field and select the relevant macro.  
4.    Click OK to confirm your definitions and to exit this dialog box. 
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String Tags 
If the tag associated with the object was defined as a string tag you can enter any 
character string in the Formula field, including a blank string (no characters). The Formula 
edit field can have up to 55 characters only. 
If the formula begins with the character (@) the Image interprets the rest of the string as a 
tag. If you want to see the character (@) typed, place a space before it. The tag in the 
formula can also be of a numerical type. In this case, the value is converted to a string and 
written to a string tag. 
In addition, you can enter a zone to jump to, or a macro to activate, whenever that object is 
selected. 
In the Macro field, you can specify a macro that you want to be activated by typing the 
name of the macro, or by clicking on the arrow to the right. When you click on the arrow, a 
list of predefined macros will appear for you to select from. 
Note:    If more than one operation is assigned in this dialog box, the operations will be 
performed in the following order: goto zone, tag assignment, run macro. If one of the 
operations fails, the next operation will not be executed. 

 
 

 
 

  
 
 
 
 

Smooth Variation Range 
To use the Smooth input method to specify tag values to be applied online you must first 
define the variation range. 

o To define the smooth variation range: 
Click the Smooth button in the Trigger Object Definition dialog box. The Tag Input - 
Smooth Range dialog box appears: 

 
Enter values for the upper and lower range limits. These values will be used as the range 
within which values can be selected to apply to the tag. 
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Momentary Trigger 
A Momentary Trigger is an object that is used to change a tag value in a single action. 
Usually such operations are required for a digital Tags that controls a field operation which 
is activated by a high value (one 1) for a short period of time, followed by a low value (zero 
0). 
The neutral way to implement such an operation is by using the button down button up pair 
of user actions. This operation is actually a button click that is regarded as one operation. 
The Momentary trigger operation will regard a button click as two operations. 
All tags can be used for the Momentary, trigger, including string tags.  
The following is a description of the way Momentary Trigger operates: 

o     All tags can be used for the Momentary, including string tags. 
o     A formula, identical to the one used in the Action trigger, can be assigned for 

button down button up operations. 
o     Any Dynamic object in an Image, that should reflect the tag value change will be 

updated, while the button is still pressed. 
o     Only when the user releases the mouse left button (button up) the Up formula is 

calculated and the result value will be written to WizPro, in the same way as the 
Down value. 

o     If the user releases the button in a place not above the trigger object, the Up 
value will not be written.  

o     To set and reset a bit in an Analog tag, the OR and AND operations can be 
used. For example, for 8 bit analog tag to set the 3rd bit use the formula '@ | 4'. To 
reset the same bit, use formula '@ & 251'. The same principal can be applied to 
any bit and for 16 or 32 bits analog tags. 

o To define a Momentary Trigger 
1.    Select the object you wish to define as a Momentary Trigger. 
2.    Click the Trigger Definition tool in the Objects Toolbox or right click and select Trigger 
Definitions. The Trigger Object Definition dialog box appears. 
3.    Click the Momentary button and the Tag Input - Momentary Values dialog box is 
displayed.  

 
4.    Enter the Value that the application will write to the tag when you click the left mouse 
in the Button Down Formula field. 
5.    In the field Button Up Formula enter the value that the application will write as soon as 
you release the mouse button. For new definitions, the default values are 1 and 0 for Down 
and Up respectively.  
6.    Press OK to complete the operation. 
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Input Method Testing 
After you select an input method and make the necessary definitions, you can test the 
action that will occur whenever you click on the trigger object. The test that you perform will 
access the particular input method dialog box. 

o To test an input method: 
Click the Test button in the Trigger Object Definition dialog box. A dialog box opens for 
the Input method (excluding the Action method). The dialog box is placed in a default 
location on the screen, but can be moved by placing the cursor on the Title bar, clicking, 
and dragging the box to any location. The new location will be recorded and the dialog box 
will thereafter appear in the new location, relative to the Image window lower-left corner. 
The following sections describe each of the tag value input method operations in more 
detail. 

 
 

 

 
  
 
 
 
 

Data Entry Value 
When the Data Entry Value method is used and the operator clicks on a trigger object, the 
Modify Tag Value dialog box appears: 
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Enter a value and click the OK button to apply it immediately to the tag. 
Note:    If the object is a string tag object enter a textual value in the New Tag Value field. 

 
 

 
 

  

 
 

 
 
 

Touch Screen Support 
This trigger can be used to enable the application to support touch screens. In the 
Wiztune.dat file (See WizTune User Guide), manually set the tuning parameter:  
IMG_TRG_KEYPAD = YES 
Default is NO 
Restart the application for it to take effect. 
The Key Pad is available for Data Entry triggers of numeric type. The Enter Value dialog 
box opens. 

     
Note:    This keypad is not supported in browser. 
The keypad operates as any other numeric keypad. Click the Back button to delete one 
number back. Click Clear to erase all numbers in the field.  
You can set the location of your keypad anywhere on the screen by clicking the Test button 
and moving the keypad to any location. When you reopen the application and operate the 
keypad, it will be opened at the same location as you selected. 
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Smooth Variation 
When the Smooth Variation method is used and the operator clicks on a trigger object the 
Single Tag Input dialog box is displayed: 

 
The following options are available: 

New New tag value (numerical). 

Suggest    Slider for suggested values. 

Set Slider for tag values. 

Apply Applies the value to the tag. 

 
 

 

 
  
 
 
 
 

Bit 
When the Bit method is used and the operator clicks on a trigger object, the Tag Input: Bit 
Operation dialog box appears: 
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The Toggle button is only displayed for digital tags.  
The action button functions are: 

On    Sets the tag value to 1. 

Off    Sets the tag value to 0. 

Toggle    Toggles between 1 and 0 for digital tags only. 

Note:    If the object was defined as a string this trigger type will be disabled. 
 
 

 
 

  
 
 
 
 

Buttons 
If the Buttons method is used when the operator clicks on a trigger object, a dialog box will 
open the predefined buttons. Each button represents a different value. When a button is 
activated, its corresponding value is immediately applied to the tag. 
The following is an example of a Button dialog box: 
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See Action Buttons   for further details.  
 

 
 

 
 

  

 
 

 
 
 

String 
When the String method is used (a Text Table was defined for a trigger object) and the 
operator clicks on the object the Modify Tag by String dialog box is displayed: 
Note:    To use the String input method, a string must first be defined by activating the Text 
table button in the Text dialog box. In the Modify Tag dialog box select a predefined string 
from the list. The values corresponding to the string you selected will immediately be 
applied to the tag. 

 
 

 

 
  
 
 
 
 

Date 
When the Date method is being used and the operator clicks on the object, the Set Date 
dialog box is displayed. After the new date is entered, the date display object will 
immediately be updated. 
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Time 
When the Time method is being used (the object was defined for time display and the 
operator clicks on the object, the Set Time dialog box is displayed. 
Note:    If the time display was not defined as Time with Seconds, the seconds box will not 
appear in this dialog box. 
After the new time is entered, the time display object will immediately be updated. 

 
 

 
 

  

Trigger Macros 

 
 
 
 
 

Trigger Macros 
Note:     This feature is not supported on the web. 
Once you have defined Trigger objects, you can define special macros (keys or key 
combinations) to apply Trigger object operations. For more information about Macros see 
Chapter 35, Macros. 

o To define Trigger macros: 
Click the Set Macro button in the Trigger Object Definition dialog box. The Trigger Macro 
Definition dialog box is displayed: 

 
The following options are available: 

Name Specifies the name of the macro. 

Description Specifies a brief description of the macro. 
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Accelerator Keys Alt, Ctrl, Shift, and Function keys that can be used in combinations 
to invoke the macro. 

Confirm Before 
Execute    

Causes the application to prompt you to confirm the execution of a 
macro before it is executed. 

Execute when out 
of VP 

Causes a macro to be executed even when the trigger object does 
not appear visually in the Image window. 

Group    Used to assign groups to operators for macro authorization. 

Note:     Trigger macros will only be executed if the Trigger mode is activated (by selecting 
Trigger On from the Modes menu, in the Image). 
 

 
 

 
 

  

 
 

 
 
 

Trigger Macros   
Note: Trigger Macros are not supported on the Web. 
Once you have defined Trigger objects, you can define special macros to apply Trigger 
object operations. To define Trigger macros, activate the Set Macro button in the Trigger 
Object Definition dialog box. 
The fields in this dialog box are: 
Name The name of the macro. 
Description A brief description of the macro. 
Accelerator keys Alt, Ctrl, shift and function keys that can be used in combinations to 
invoke the macro. 
Confirm before execution This option is use to cause the application to prompt you to 
confirm the execution of a macro before it is executed. 
Execute when out of VP Used to cause a macro to be executed even when the trigger 
object does not appear visually in the Image window. 
Group Used to assign groups to operators for macro authorization. 

Note that trigger macros will only be executed if the Trigger mode is 
activated (by selecting the Trigger On item from the Modes menu, in the 
Image window). 
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Marking Trigger Objects 
o To mark trigger objects on the screen: 

Select Mark Triggers from the Options menu in the Image.  
Or,  
Select the mark trigger toggle from the Image toolbar. After you select this item, a red-
colored hand will appear in all the trigger objects in the Image.  

o To unmark the objects: 
Reselect Mark Triggers. If the Trigger On mode is active, the hand cursor that appears will 
turn red when you click and hold the button down, and move the cursor within the borders 
of the object. When you leave the object borders (while still holding the button down), the 
hand will turn white.  
Note:    The <Spacebar> can be used to simulate the mouse button. 
The Mark Triggers function will apply to any object. However, if an object is marked (with a 
red hand) to indicate that it is a trigger object, but that object is dynamically or manually 
transformed (moved, rotated, scaled, etc.), the trigger mark may disappear, or will not 
appear in its correct location. If this happens, you can press <ALT+R>, or click on the <r> 
button in the Image window, to redraw the Image. The hand will then appear in its proper 
location. 
Specify YES for the Trigger tab in the Image Properties dialog box to highlight trigger 
objects (outlined with dashed lines) when you click on the object and hold the mouse 
button down. The default for this parameter is NO.  
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Options Mark Trigger 

Note: Mark Triggers is not supported on the Web. You can mark triggers 
in Edit mode, while developing your image. 

Select this item to cause all trigger objects in the Window to be marked (or unmarked) on 
the screen.  
After you select Mark Triggers, a red hand will appear in all the trigger objects in the image.  
The Mark Triggers function will apply to any trigger object.  
Note, however, that if an object is marked (with a red hand) to indicate that it is a trigger 
object, but is dynamically or manually transformed (moved, rotated, scaled, etc.), the 
trigger mark may disappear or will not appear in its proper location. If this occurs, you can 
refresh the screen by pressing <Alt-R>.  

 
 

 
 

  

Widgets 

Media Player 

 
 
 
 
 

Media Player 
Note: Not supported on the Web. 
The Media Player enables you to play any Media file that is installed on your computer. 
Usually this object is used to play ‘AVI’ files that display some information to the operator.  
To Define a New Media Object 

1. Select the Media tool located in the Objects Toolbar. 

2. Draw a rectangle in the initial size you wish. 

3. The Media Player Properties dialog opens where you can 
select the Media device (file) you wish to play. 

4. You can set the Media window to include a title bar with your 
own text. 

The Media device will be displayed ‘Stretched ’ to the object size. Small control bar is 
displayed at the bottom on the object with the options to Play, Stop, Pause, Fast Forward 
and Rewind. 
You can select and edit the object size and the location can be manipulated as any other 
object. To change the object properties double-click on it. 
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Media Player 

Note: Media Player is not supported on the Web. 
The Media Player enables you to play any Media file that is installed on your computer. 
Usually this object is used to play ‘AVI’ files that display some information to the operator.  
To Define a New Media Object 

1. Select the Media tool located in the Objects Toolbar. 
2. Draw a rectangle in the initial size you wish. The Media Player Properties dialog 

box opens where you can select the Media device (file ) you wish to play. 
3. You can set the Media window to include a title bar with your own text. The Media 

device will be displayed ‘Stretched ’ to the object size. A small control bar is 
displayed at the bottom on the object with the options to Play, Stop, Pause, Fast 
Forward and Rewind. 

4. You can select and edit the object size and the location can be manipulated as any 
other object. To change the object properties double-click on it. 

 
 

 
 

  

 
 

 
 
 

Media Player Info 

Note: Media Player is not supported on the Web. 
The Media Player enables you to play any Media file that is installed on your computer. 
Usually this object is used to play ‘AVI’ files that display some information to the operator.  
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Media Player 
Note:    This feature is not supported on the web. 
The Media Player enables you to play any Media file that is installed on your computer. 
Usually this object is used to play .AVI files that display some information to the operator.  

o To define a new media object: 
1.   Select the Media button from the Objects Toolbox. 
2.   Draw a rectangle in the initial size you wish. 
3.   The Media Player Properties dialog box opens where you can select the Media device 
(file) you wish to play. 
4.   You can set the Media window to include a title bar with your own text. 

 
The Media device will be displayed Stretched to the object size. A small control bar is 
displayed at the bottom on the object with the options to Play, Stop, Pause, Fast Forward 
and Rewind. 
You can select and edit the object size and the location can be manipulated as any other 
object. To change the object properties, double-click on it. 
Note:    A Media Player cannot be grouped with other image objects. 

 
 

 
 



Chapter 22 Image Animation 

1114 

  
 
 
 
 

Specify the file that is to be used by the media player. 
 
 

 
 

  

 
 
 

 
 

If the "Has title" is checked, then in the title field specify the title bar to be included Media 
window. 

 
 

 
 

  

Slider 
 
 
 
 
 

Tag Value Sliders 
Note:     This feature is not supported on the web. 
Tag value sliders (widgets) can be designed and used in an Image to change and read tag 
values in a simple visual manner. The sliders can be positioned anywhere in the Image 
and will automatically reflect any change in the tag value that occurs in the field. 
The following is an example of a slider: 

 
The following points should be noted when working with tag value sliders: 

o     Tag value sliders are system windows that operate using system controls. 
o     Tag value sliders are automatically generated as trigger objects, and therefore 

can only operate in the Trigger mode. 
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o To design a slider: 
From the Edit menu, point to Drawings and then to Widgets.  
Or, 
Select Slider from the popup menu. 
Or, 
Click the Slider button in the Objects Toolbox. The Slider properties dialog box is 
displayed: 
 

 
 
The following fields are available: 
 

Station 
Specifies the network station to which the tag belongs. For a list of 
stations from which you can select, click on the arrow to the right of 
the field. 

Tag    
Specifies the tag to be associated with the slider. For a list of tags 
from which you can select, click on the arrow to the right of the 
field. Tag templates can be used with sliders. 
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Value Assignment  

Select On Dragging to cause the value of the associated tag to 
change as the slider is dragged. 
Select On Dropping only to cause the value of the associated tag 
to change only when you complete the dragging (release the 
mouse button) and place the slider on a specific value. 
Select On Dragging to Image, on dropping to Tag to cause the 
value of the associated tag to change and be reflected in the 
Image only as the slider is being dragged, and change and be 
written to the PLC when you complete the dragging (release the 
mouse button) and place the slider on a specific value. 
Select Snap to Tick to cause the slider to snap to ticks on the value 
scale whenever it is moved, or the tag value changes in the field. 

Limits 

Select Default tag limits to cause the value scale limits to be those 
you defined for the tag in the Tag Definition procedure. 
In the From/To fields you can specify the values you want for the 
upper and lower limits of the tag scale. 

 
 
 

 
 

  

 
 

 
 
 

Slider 
Note: Not supported on the Web. 
Tag value sliders can be designed and used in an image to change and read tag values in 
a simple visual manner. The sliders can be positioned anywhere in the image and will 
automatically reflect any change in the tag value that occurs in the field. 
The following points should be noted when working with tag value sliders: 

• Tag value sliders are system windows that operate using system controls. 
• Tag value sliders are automatically generated as trigger objects, and therefore can 

only operate in the Trigger mode.  
To design a slider, select the Slider item from the Edit Drawings Widgets menu, or click on 
the Slider tool in the Objects Toolbar. The Slider Properties dialog box appears. 
The fields in this box are: 
Station The application network station to which the tag belongs. For a list of stations 

from which you can select, click on the arrow to the right of the field. 

Tag The tag to be associated with the slider. For a list of tags from which you can 
select, click on the arrow to the right of the field. 
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Value 
Assignment 

Select On Dragging to cause the value of the associated tag to change as the 
slider is dragged. 
Select On Dropping only to cause the value of the associated tag to change 
only when you complete the dragging (release the mouse button) and place 
the slider on a specific value. 
Select On Dragging to Image, On Dropping to Entire System to cause the 
value of the associated tag to change and be reflected in the image only as the 
slider is being dragged, and change and be written to the PLC when you 
complete the dragging (release the mouse button) and place the slider on a 
specific value. 

Styles Select Snap to Increment to cause the slider to snap to ticks on the value 
scale whenever it is moved or the tag value changes in the field. 

Limits Select Default Tag Limits to cause the value scale limits to be those you 
defined for the tag in the Tag Definition procedure. For further information see 
Tags. In the From/To fields you can specify the values you want for the upper 
and lower limits of the tag scale. 

 
 

 
 

  

 
 

 
 
 

Slider 

Note: This feature is not supported on the web. 
Tag value sliders (widgets) can be designed and used in an Image to change and read tag 
values in a simple visual manner. The sliders can be positioned anywhere in the Image 
and will automatically reflect any change in the tag value that occurs in the field. 
The following points should be noted when working with tag value sliders: 

• Tag value sliders are system windows that operate using system controls. 
• Tag value sliders are automatically generated as trigger objects, and therefore can 

only operate in the Trigger mode. 
To design a slider: 
From the Edit menu, point to Drawings and then to Widgets.  
Select Slider from the popup menu. 
Or, 
Click the Slider tool in the Objects Toolbox. The Slider properties dialog box is displayed: 
The following fields are available: 

Station Specifies the network station to which the tag belongs. For a list 
of stations from which you can select, click on the 
arrow to the right of the field. 
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Tag Specifies the tag to be associated with the slider. For a list of tags 
from which you can select, click on the arrow to the 
right of the field. 

Value Assignment  Select On Dragging to cause the value of the 
associated tag to change as the slider is dragged. 

 Select On Dropping only to cause the value of the associated tag to 
change only when you complete the dragging (release 
the mouse button) and place the slider on a specific 
value. 

 Select On Dragging to Image, on dropping to Tag to cause the value of 
the associated tag to change and be reflected in the 
Image only as the slider is being dragged, and change 
and be written to the PLC when you complete the 
dragging (release the mouse button) and place the 
slider on a specific value. 

 Select Snap to Tick to cause the slider to snap to ticks on the value 
scale whenever it is moved, or the tag value changes 
in the field. 

Limits Select Default tag limits to cause the value scale limits to be 
those you defined for the tag in the Tag Definition 
procedure. 

 In the From/To fields you can specify the values you want for the upper 
and lower limits of the tag scale. 

 
 

 
 

  

 
 
 

 
 

Slider Info 

Note: This feature is not supported on the web. 
Tag value sliders (widgets) can be designed and used in an Image to change and read tag 
values in a simple visual manner. The sliders can be positioned anywhere in the Image 
and will automatically reflect any change in the tag value that occurs in the field. 

 
 

 
 

  

Scheduler Task 
Configuration 
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Scheduler 
The Internet based Scheduler enables you to easily create daily or weekly task orientated 
schedules remotely.  
Before the Scheduler is accessed the Scheduler module must first be enabled in the 
Station Properties dialog box. 
Access to the Scheduler is through password only. The user authorization rights defined in 
the application's User Management module are also relevant for this module.  
Once accessed the user can schedule or modify operations for any workstation. For more 
information see Chapter 31, Scheduler. 
Note:     The user name and password are case sensitive. 

o To access the Scheduler through the Image module: 
Access through the Image module can only be made if tasks have previously been defined 
in the Scheduler.  
1.    In the Image module when in Edit mode click the Scheduler icon in the Options 
toolbox. The clock icon with an arrow attached to it will replace your mouse arrow. 
2.    Draw an object. The Scheduler Task Configuration dialog box opens.  

 
3.    Click the arrow in the Task Name field and select a task from the list. 
4.    If relevant, click the Groups button and define access permission to the selected task 
and then click OK. A clock object will appear in the Image window.  
5.    Move to Trigger On mode and then click the clock object with the Trigger hand. The 
Scheduler Login page opens.  
6.    Type in your User Name and Password and then click the Login button. The selected 
task page opens in the Scheduler site. 
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Station Properties - Scheduler 
  
The Internet based Scheduler enables you to easily create daily or weekly task orientated 
schedules remotely. Being both task and time orientated the Scheduler can be used to 
create unlimited tasks, actions and states. Tasks can be modified, enabled/disabled and 
have many states attached to them. An unlimited number of actions, which are basic 
operations, can be attached to each task.  
Before the Scheduler is accessed the Scheduler module must first be enabled in the 
Station Properties dialog box. 
To enable the Scheduler module: 
1. 1. In the All Containers side of the Application Studio right click the application’s name to 
open the Station Properties dialog box. 
1. 2. Using the arrow, scroll and open the Scheduler tab. 
1. 3. Check the Enable Scheduler checkbox and then click OK to actually define this 
option. 
1. 4. Restart the application. 
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Scheduler Task Configuration 
1. In the Task field either type in the name of the task or, click the arrow and select 

one from the list. 
2. To enable group access to this task, click the Task button and select the relevant 

group from the Access Permission Manager dialog box. 
3. Click OK to save. 

 
 

 
 

  

 
 

 
 
 

Tag Value Simulation 

After dynamic objects are defined, the operator can test an object's response to different 
tag values using an application mechanism that simulates tag values without affecting the 
tag itself. See Chapter 9, Tags for more information on tags. 

o To simulate tag values: 
Select Simulate from the Options menu. The Simulate Tag Values dialog box appears: 

 
The following options are available: 

Station Specifies the application network station to which the tag belongs. 

Tag Specifies the tag to be simulated. 

Current Simulated 
Value Specifies the value being used for simulation. 

New Suggested 
Value 

Suggested simulation value. Enter a value or move the slider 
below. Extreme left is the lower range limit, extreme right is the 
upper range limit. 
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Exit Exits the simulation. 

Apply Applies the suggested value. 

Range Range of simulation values for the slider. 

After the required value is specified simulate in the New Suggested Value field and activate 
the Apply button, the value you specified will be simulated, and any dynamic or trigger 
object associated with that tag will be affected accordingly. 
Note:    This tool is not prioritary. The tag value simulated can be overridden by the tag 
sampling process if the communication is enabled.The real tag value will be displayed in 
the image, but not refreshed in the Simulating Tag Values dialog box. 

o To set the simulation range: 
1.    Activate the Range button in the Simulate Tag Value dialog box. The following 
Simulating Tag Values: Range dialog box is displayed: 
 

 
 
2.    Enter the range limits. The scroll bar in the Simulate Tag Values dialog box will 
immediately be adjusted to the new range.  
 
 

 
 

 
 

  

 
 

 
 
 

Options / Simulate  

This dialog box is used to specify tag values that you want to simulate for testing purposes. 
After dynamic objects are defined, the operator can test an object's response to different 
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tag values using an application mechanism that simulates tag values without affecting the 
tag itself. 
When you simulate values, the field device will not be affected.  
To simulate tag values 
1. Select Simulate from the Options menu. The Simulate Tag Values dialog box is 
displayed. 
2. Select the station to which the tag belongs. 
3. Select the tag you want to access. 
4. Enter the tag value to be simulated in the New Suggested Value field. The current tag 
value is displayed in the Current Simulated Value field. The value is set by clicking the 
Apply button. 
 OR 
 Use the horizontal scroll bar to immediately set and simulate the specified value. 
5. Click the Range button to specify the upper and lower range limits of the tag value to be 
simulated. 
6. Click the Exit button to quit the dialog box and leave the last set value. 

 
 

 
 

  

 
 

 
 
 

Simulate Range   

Use the Simulate Range dialog box to specify the upper and lower limits of the values to be 
simulated.  
The fields in this dialog box are:  
Lower Limit - Lower limit of the simulation range.  
Upper Limit - Upper limit of the simulation range.  

 
 

 
 

  

Other Topics 
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Date Field Summary    
In this dialog box, you can view a list of all the fields defined in your report. In addition, you 
can add, change, and delete fields online.  
  
To access the field summary option: 
1. 1. Select the Report file from the Containers tree. If a report already exists click it and 
press the summary button 
 OR 
1. 2. If there are no reports available, right click the report file and select the add new 
report 
1. 3. Click the Summary button 
  
To add a new field to the report 
1. Activate a Type button 
2. Define the field in the dialog box that will appear, 
3. Specify the field number (the number must be specified for the Add operation) 
4. Activate the Add button in this dialog box. The new field will appear in the field list.  
  
Note that to define a field with the same attributes as another field, simply select the field 
you want to copy (by highlighting it), change the field number, and activate the Add button.  
  
To change an existing field definition, 
1. Select the field that you want to change from the list (by highlighting it) 
2.  Activate the field type button that you want, to redefine the field attributes.  
3. After you complete the modification, activate the Change button.  
To delete a field from the list, 
1. Select the field that you want to delete (by highlighting it) 
2. Activate the Delete button. 
  
Note that you should not delete any field that exists in the current report on the screen. If 
you do, the report will not be generated properly, when you use the report command.  

 
 

 

 
  
 
 
 
 

Date Format Dialog Box 
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You can set the date style and date separator in the Date Format tab of the Station 
Properties dialog box. 
The following options are available: 
Date style  Specifies a date style from a list of predefined date styles. Listed below are the 
Date styles: 
DDMMYY  
MMDDYY  
YYMMDD  
DDMMYYYY  
MMDDYYYY  
YYYYMMDD 
Date separator  Specifies a date separator from a predefined list of date separator styles. 
The Date separator files are: 
/ (slash) 
. (dot) 
(dash) 
? ? To Set Date Format 
1. 1. From the Date Style list select a predefined date style. 
1. 2. From the Date Separator list select the way you want the date to be separated. 
1. 3. Click OK key to enter your selection. 
When loading for the first time, the application sets default values for these parameters 
using country code, defined in Control Panel ðRegional Settings. 
The table below lists the default values in the application for different countries. 

Country Date Style Date Separator 
USA MMDDYY / (slash) 

Japan  YYMMDD / (slash) 

Netherlands  DDMMYY / (dash) 

Denmark DDMMYY / (dash) 

Germany DDMMYY . (dot) 

Austria DDMMYY . (dot) 

Russia DDMMYY . (dot) 

All others DDMMYY / (slash) 
 
 

 

 
  
 
 
 
 

Date Style List  
Used to define the Date style.  
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Application's predefined date styles: 
DDMMYY  
MMDDYY  
YYMMDD  
DDMMYYYY  
MMDDYYYY  
YYYYMMDD  
  
Application's date separators 
/ (slash) 
. (dot) 
(dash) 

 
 

 
 

  
 
 
 
 

The Elaborated Zoom is a technique used in Application images to obtain detailed 
views of specific plant or facility sections. 
When the Elaborating Zoom mode is on each layer in the image will be viewed according 
to the scale range specified in the Layer definition procedure. When the mode is off, the 
layer will appear in the image, even if the scale range were not defined for them. 

 
 

 

 
  
 
 
 
 

Image Property - Dynamic    
Note: Not applicable on the Web. 
Used to determine the blinking rate values for dynamic objects. 
The values you specify for fast, medium and slow are in milliseconds and can be from 50 
(1/20 second) to 30000 (30 seconds). If you specify a value that exceeds these limits, the 
Application will automatically apply the maximum and minimum values instead. 
 
It is recommended to increase the values for this option, if it is anticipated that a large 
number of dynamic objects on the screen will b updated at once 
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Cluster / Define (Dynamic Object) 
When selecting an object associated with tags or alarms, the following dialog box 
appears:(the object was defined as a dynamic or trigger object): 
To define a cluster of a dynamic object 
1. Type the name of the cluster (up to 15 characters) in the Name field. 
2. Enter the name of the library in which the cluster will be placed, or select an existing 
library from the drop-down list. 
3. Type a brief description (up to 40 characters) in the Description field. 
4. Check the Add new library to the Cluster folder checkbox, to add the new library you 
create to the global Cluster folder (this will enable other applications to use the new library 
you create). 
5. Click the Tags button to change the original definition of the tag, so that a new tag will be 
generated upon cluster instantiation in the image. 
The Tag Definition (Cluster) dialog box opens. In the Tag Definition dialog box, you can 
use special tokens to enable customized tag creation and identification upon object 
Instantiation. These tokens can be used in the Tag Name, Address, and Description fields 
to enable customized tag attribute generation.  
 In the Tag Definition dialog box only the tags that are associated with the cluster objects 
will appear in the tags list. Only the Change button will be enabled. To change the current 
definition of the tag and cause a new tag to be generated upon cluster Instantiation, 
activate the Change button to invoke the Tag Specification dialog box.  
 Note that you can also access the Tag Specification dialog by double-clicking on a line in 
the list.   
6. Click the Find button to search for an existing tag from the list.  
7. Check the Define each object when instantiating checkbox to enable changing the 
definitions of the tags upon instantiation in the image. 
The Linked Tags and List Box 
This list box contains a list of tags associated with the object you selected, and the type of 
the object with which the tags are associated. The object types are marked with special 
letters, enclosed in brackets (<>), as follows:  
D for dynamic  
G for trigger  
A for alarm (Not applicable on the Web). 
W for widgets (tag value sliders)  
T for text table  
N for digital, date/time, and string displays  
t for dynamic text tables  
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n for dynamic digital, date/time, and string displays.  
 

Note: To indicate the connection between the selected line in the list 
box, and the corresponding graphical object, there is an arrow in the 
Objects View window (in the right hand side of the list box) from the left 
top corner of the window to the middle of the object.  

The Clusters Menu 
 

 
 

  

 
 

Dynamic Drum Tag Definition  
An object can be made visible when its associated tag value matches a specified bit 
pattern. The bit pattern can include don't care bits, which are bits that will be considered 
matches no matter what their actual values may be. 
When the tag will have a value that matches the pattern, the object will be visible; 
otherwise, it will be hidden.  
The bit pattern is entered as 0, 1 or *, where * is a Don't Care value (0 or 1).  
For example, the pattern ***....**0 would cause the object to be visible only if the tag value 
is even.  
To assign a Drum Pattern 
1. Select an object in the image. 
2. Select the Dynamic Definition button from the Objects Toolbar (To make the object 
dynamic). 
3. Activate the Drum button from the Dynamic parameter dialog box. 

Note that you can select the Force Dynamic Show item from the 
Options menu in the image window to cause a dynamic object in an 
image to appear always. 
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